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1 | INTRODUCTION 

I. OVERVIEW 

Welcome to the ATG REsource® Title and Closing Production System. 

ATG teamed up with award-winning software developer RamQuest® and created ATG REsource – our 
new title and closing production system. 

II. ABOUT THE SOFTWARE 

ATG REsource is Internet based, comprehensive, intuitive, and easy to use. Using this product, members 
or ATG employees can easily enter all title and closing data through a simple order entry format. It 
produces RTF (Rich Text Format) documents that permit integration with Microsoft Word®. According to 
members using ATG REsource, the following features are the most beneficial: 

 integrates all aspects of the real estate transaction; 

 shares transaction data with all parties to the transaction; 

 provides screens designed with a logical work flow and offers simplified data entry and retrieval; 

 produces all documents necessary for real estate transactions; 

 reconciles your escrow accounts; 

 provides pre-designed reports; and 

 maintains an Agent list of lenders, Realtors®, attorneys, and any other repeat customers or contacts.  

III. THE ASP ADVANTAGE 

The Application Service Provider (ASP) environment allows ATG to have ATG REsource on offsite that 
are monitored 24/7 and backed up daily. Members access and run ATG REsource through the Internet, 
minimizing the need to load software on their office computers. Any upgrades are made automatically on 
the ATG server with seamless transitions for our members. 

IV. SYSTEM REQUIREMENTS 

A. Operating System:  

1. Required 

ATG REsource is a true 32/64-bit Windows application that requires Windows NT, 2000, 
XP, Vista, or Windows 7 operating system. 

2. Recommended 

Windows XP Professional, Windows Vista, or Windows 7 

B. Processor and Monitor:  

1. Required 

Personal computer with a Pentium II 333 processor or higher, 128MB RAM, and 200MB 
free disk space. Under this configuration, the system will function but may perform more 
slowly than you desire. 

2. Recommended 

Pentium II 400 processor (or higher) with 256MB or more RAM and a 17” monitor. 

C. Internet Access: 

Minimum 56KB modem and Internet access required. We recommend cable, T1, or DSL Internet 
access for higher volume members. A satellite connection to the Internet may not work. 
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V. ATG SOFTWARE HELPDESK 

A. Software Support  

You are one of the many ATG members who has completed REsource training and is now using 
our software to issue ATG commitments, policies, and other documents for real estate 
transactions. To assist you in your daily use of REsource, we offer the ATG Software HelpDesk, 
staffed by our Software Support Specialist, who can identify and solve problems, assist with 
procedural matters, and guide you through the many features of ATG REsource via Terminal 
Server Session. See Software HelpDesk contact information under “Questions,” below. 

B. Terminal Server Session 

This remote-control feature allows an ATG employee to steer you through various REsource 
screens and data fields as if he or she were sitting next to you, controlling your mouse. During 
this session, our employee is on the phone, talking you through the process, stopping to clarify or 
answer questions at your pace. Members who have already experienced Terminal Server Sessions 
report that they are more helpful and productive than telephone support alone. 

C. Additional Services 

ATG REsource users have access to the following services and information from the HelpDesk: 

 Technical support; 

 Software training schedules; 

 Software upgrades; and 

 Information about ATG REsource. 

 View and/or download this information from its website equivalent on the Member section of 
our website, www.atgf.com. 

D. Questions? 

Contact the ATG REsource HelpDesk at 888.776.4420 or atgresource@atgf.com. You may also 
contact a Member Services Representative, 800.252.0402. 
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VI. SOFTWARE INSTALLATION 

A. Terminal Services and ATG REsource Connection Setup 

1. Log in at www.atgf.com with your user name and password. 

2. Under ATG Member Attorneys, click View ATG REsource User’s Information. 

3. Scroll down to Downloads to download setup files and instructions for Shortcut to 
REsource Remote Desktop 

 
4. Click the Download Now link and save it to your desktop. 

B. Remote Print and Simplify Printing (ScrewDrivers) Setup 

(If you are connected to the Terminal Server, disconnect by selecting Start > Log Off [User]. 

1. Log in at www.atgf.com with your user name and password. 

2. Under ATG Member Attorneys, click View ATG REsource User’s Information. 

3. Scroll down to Downloads to download setup files and instructions for Remote Print 
and Simplify Printing (ScrewDrivers). 

4. Follow instructions for setup of both applications. 
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VII. LOGGING ON 

Log on to Windows 

After completing the REsource installation, an icon will be 
created on your desktop. To access REsource: 

A. Double-click the REsource icon. 

A new terminal server window will open and the Log 
on to Windows dialog box will appear. 

B. Enter your User Name and Password and enter 
ATGF in the Log on to box. 

The password is case sensitive; use lower case letters.  

C. Click OK. 

VIII. RESOURCE DESKTOP 

A. Notice that your desktop is now behind the REsource desktop.  

B. To return to your own desktop 
without closing your REsource 
session, hover over the top of the 
screen until a tab will appears and 
click the Minimize button.  

C. To reopen your REsource session, 
click the REsource button on your 
task bar (along the bottom of the 
screen). 

D. To log out of your REsource session, 
click Start and select Log Off [Use Name]. 

IX. COMPLETE CLOSING ENTERPRISE 

A. To begin, double-click the Complete Closing Enterprise icon  on the REsource 
desktop. 

 

Complete Closing 
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From Complete Closing, you can prepare the Commitment, HUD-1 Settlement Statement, Checks 
for Disbursement, Policies, Endorsements, and most Closing Documents.  

B. Tool Buttons 

 
Hover the cursor over any button; a tag will appear identifying the function of that button. 

Buttons and functions: 

 
Order Entry: General information is entered for the file such as buyer, seller, lender, and property. 

 Speed HUD: Produces the HUD-1 Settlement Statement. 

 
Commitment/Policy Preparation: Used to enter information for Schedules A and B of the 
Commitment and Policies. 

 
Print Documents: Used to print documents. 

 
Check Writing: Creates receipts and disbursements based on the HUD-1 Settlement Statement 
and prints checks. 

 
Commercial Settlement Statement: (Currently not in use.) 

 Invoices: (Currently not in use.) 

 PaperlessCloser Web Publishing: Manages published documents and authorized users. 

 File Scan: (Currently not in use.) Use the File Attachment Utility (see below). 

 Displays the Current File Number. 

 
Lookup File Number: Locate a file by file number. 

 
Search for File by Legal Description: Locate a file by legal description or address. 

 
Search for File by Buyer/Seller: Searches for a file using the Buyer’s or Seller’s Name. 

 Jump to File: Opens a file by entering the exact file number/name. 

 
Super Search: Searches for one file or a group of files based upon similar information such as file 
open and closed dates, buyer/seller, property location, or loan information.  

 Closing Market: (Currently not in use.) 

 
Add File Number: Creates a new File. 

 
Close: Closes Complete Closing Enterprise. 

 NOTE: All functions listed above are accessible by using the File, Data Entry, or ATGF 
Extensions drop-down menus. 
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C. ATGF Extensions  

 Prepare Transfer Tax Documents: Prepares state, county and city transfer declaration forms for 
Illinois. 

 Special Check Print: Allows authorized users to locally print approved checks from ATG’s escrow 
account for closings. 

 User/File Tracker: Identifies the user in a file. 

 File in Use: Closes out the file. 

 Member Orders: (Currently not in use.) 

 Order Search by Member: Searches and displays files by Member File Number, Buyer/Seller, File 
Number, and Closing Date. 

 File Attachment Utility: Stores scanned searches, title documents, and Closing Protection Letters. 

 ATG Services: Calculates ATG premiums and consumer fees for policies, endorsements, and 
other services. Information from ATG Services is used in the Invoice for Title Charges, HUD-1 
Settlement Statement, and Accounting Information Schedule. 

 

D. Navigating 

Complete Closing responds just like any other Windows-based application.  

 <Tab>: Moves to the next field. 

 Left-Click: Moves to the field. 

 Right-Click: Displays drop-down menu. 

E. Control Commands  

Control Commands may also be used: 

 <Ctrl>+<L>: Looks up Agent (Lender Realtor, Attorney, Buyer, Seller, Payee on HUD). 

 <Ctrl>+<E>: Edit or View Agent (Lender Realtor, Attorney, Buyer, Seller, Payee on HUD). 

 <Insert>: Inserts a Buyer or Seller, Property, New Note, New Line in the HUD. 

 <Ctrl>+<Delete>: Deletes a Buyer or Seller, Property, Note, Line in the HUD. 

 <F6>: Inserts Current Date. 

 <Ctrl>+<C>: Copy text. 

 <Ctrl>+<X>: Cut text. 

 <Ctrl>+<V>: Paste text. 

 <Ctrl>+<Z>: Undo. 

 Commitment/Policy Tabs 

– <Ctrl>+<G>: Displays Full Screen. 

– <Ctrl>+<N>: Inserts Numbered Paragraphs (Special Exceptions). 

– <Ctrl>+<F2>: Initiates Spell Check. 

– <Ctrl>+<D>: Inserts Degree Sign. 

– <Ctrl>+<P>: Print (Current Tab) 
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F. Resizing Windows 

Occasionally, you may wish to resize the window or move it to fit the screen better. 

 Adjust the size of the windows by using the Minimize,  Maximize,  and Restore  
buttons located in the upper right corner, or double-click the Title Bar of the currently 
displayed window. 

 Adjust the location of a window by dragging and dropping the Title Bar. 

G. Opening and Closing Windows 

 Use the Close button  to close a window.  

 Click the button or drop-down menu to open a window. 

 NOTE: Do not open multiple data entry windows concurrently. Doing so will prevent data 
updates.  

H. Help Files 

In addition to this manual, help is available on all data entry screens by pressing <F1>, by 
clicking the Help button  located on data entry windows, or by clicking the Help menu. 

I. File Locking 

1. Security has been added to REsource to prevent multiple users from accessing the same 
file at the same time. File Locking affects all data entry menus including Order Entry, 
HUD, Commitment/Policy, and Check Writing. 

2. This message will appear if you are attempting to gain access to a file that another user 
currently has open: 

 
3. You may access all data entry menus for a file that another user is working on, but the 

file will be Read-Only. 

4. You may also: 

a. print documents for a file that is in read-only mode; or 

b. select another file and try the read-only file again at a later time. 

5. It is very important that you exit an active file when finished. You can either go to 
another file or return to the REsource desktop. Closing Complete Closing when not in use 
will also free up the file. 

6. If you need immediate access to the file, you may contact the user or the ATG REsource 
Help desk at 888.776.4420. 

 REMINDER: When logging off of your REsource session do not use the X button at the top 
of the screen. To logoff, click the Start button  at the bottom left of your screen, 
select Logoff,  and click Logoff at the prompt. 

 
 

[User Name] 
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2 | LOOKING UP AN EXISTING FILE 

Instructions for locating an existing file by File Number, Buyer/Seller Name, Member File Number, or Property 
Information. 

I. LOOK UP AN EXISTING FILE 

A. The File # field  displays the current file. Complete Closing always opens 
with the last file worked on before logging off. Before you begin working on a file, make sure 
that the correct file number displays in the File # field in the toolbar. You can retrieve an existing 
file using any of the following methods: 

1. Order Search by Member 

Click the Order Search by Member button  to search files by Member File Number, 
Buyer/Seller, File Number, and Closing Date. 

2. Lookup File Number 

Click the Lookup File Number button  to search by File Number, Closing Date, 
Department, Escrow Bank, or Person. 

3. Search by Legal Description  

Click the Search by Legal Description button  to search by Legal Description, 
Address, City, or Number (Acreage). 

4. Search by Buyer/Seller  

Click the Search by Buyer/Seller button  to search by Buyer or Seller name. 

5. Jump to File 

Click the Jump to File button  to open another file by entering the exact File Number. 

6. Super Search  

Click the Super Search button  to search for one or several files based upon variables 
such as file open and close dates, buyer/seller, property, and loan information. A printed 
report of the search results is also available. 

7. File Menu 

Click the File menu: The nine (9) most recently opened files appear at the bottom of the 
File menu. This is a shortcut to retrieve a recent file. 

8. Tax ID Search  

Search for a file by the Permanent Index Number or Tax ID Number. 

B. After you locate a file using one of these methods, you can edit the order, prepare the 
commitment or policy, print documents, create the invoice, complete the HUD-1 Settlement 
Statement, or write checks. 

II. ORDER SEARCH BY MEMBER  

The Order Search by Member function searches and sorts files by several fields, including Member File 
Number, Buyer/Seller, and Closing Date. 

A. Access the Order Search by Member by clicking the Search Orders by Member button;  or 
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B. Select Member Search from the ATGF Extensions menu. 

 
 

 

 
C. Click the Order Status Filter to view files by Open/New, Closed, or Cancelled files, or click All 

to view all files. 

D. Enter the Member Number (Region 0 users only; ATG staff). 

E. To sort files by any category, such as Seller or Member File Number, click once on the category 
and the files will be re-sorted alphabetically or numerically. 

F. To open a file, highlight the file and click the Open Selected button  located at the 
lower left corner. 

III. SEARCH FOR A FILE BY FILE NUMBER 

A. This option allows you to look up a file by the File Number, Escrow Bank, or Closing Date. Use 
one of the following methods to access the lookup: 

1. Click the Lookup File Number button.  

2. Select the Locate File option from the File menu.  

3. Press <Alt>+<F>, then <L>. The Find File dialog box displays. 

 
4. Enter all or part of the file number. 

Search Orders 
by Member 

ATGF Extensions > 
Member Search 

Filter 
Sort Data Fields 

Open Selected File 
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B. Files are sorted by File Number. You can use the Search By drop-down list at the bottom of the 

screen to select Close Date, Department, Escrow Bank, or Person as your search criteria.  

C. Begin entering the file number (or the selected “search by” information) in the Search 
Characters field. As you enter, files matching your search criteria will display. 

D. Select the desired file and then click OK.  The selected file number displays in the 
File # field. 

IV. SEARCH FOR A FILE BY LEGAL DESCRIPTION OR ADDRESS 

A. This option allows you to search for a file by property information, including the Legal 
Description, Address, City, or Survey Number (acreage). To access the property search, use one 
of these methods: 

1. Click the Search for File by Legal Description button  on the toolbar. 

2. Select the Locate File by Prop option on the File menu. 

3. Press <Alt>+<F>, then <O>. 

 
B. Properties are listed by Legal Description, but you can use the Search By drop-down list at the 

bottom of the screen to select Address, City, or Number (Acreage), as your search criteria.  

C. Begin entering the Legal Description (or the selected “Search By” information) in the Search 
Characters field. As you enter, files matching your search criteria will display. 

D. Select the desired file and then click OK.  The selected file number displays in the 
File # field. 

Search Characters 

Search By 

Search Characters 

Search By 
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V. SEARCH FOR A FILE BY BUYER/SELLER NAME 

A. This option allows you to search for a file by Buyer or Seller name. To access the Search for 
Buyer/Seller screen, use one of these methods: 

1. Click the Search for File by Buyer/Seller button.  

2. Select the Locate File by Buyer/Seller option on the File menu. 

3. Press <Alt>+<F>, then <B>. 

 
B. Enter the Name (last name first) in the Name Filter field, then click the Apply Filter button 

 to display all the files in which the name appears as a Buyer (on the left) and as a 
Seller (on the right).  

C. Select the desired file and then click the Select button.  The selected File Number 
displays in the File # field.  Click the Close button  to begin 
working on the selected file. 

VI. SEARCH FOR A FILE OR A GROUP OF FILES BASED UPON GENERAL FILE INFORMATION 

The Super Search feature allows for customizable searches. A printed report of search results is also 
available. 

A. Click the Super Search button  or select Super Search from the File menu. 

B. Enter desired search criteria and click the Search button.  

Search for File by Buyer/Seller 

Search Characters 

Select file 
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1. Main tab: Allows you to enter general information about the order. 

2. Loan/Misc. tab: Allows you to enter Loan and Miscellaneous information about an order 
or range of orders.  

3. Property tab: Allows you to enter Property information. 

4. Web/Commit tab: Allows you to enter Commitment/Policy and PaperlessCloser 
information. 

5. Agent Searches tab: Allows you to search for Agents. 

6. Buyer/Seller tab: Allows you to search for Buyers and Sellers. 

C. Printing Reports 

To print a report of the search results, select the Print tab. 

EXAMPLE: To print a list of closings during a specific time period: 

1. Select a beginning Closing Date. 

2. Select an ending Closing Date. 

3. Click the Search tab. 

4. Click the Print tab to display the document.  

5. Click the Print button  to print on paper. 

6. Additionally, results can be saved as a PDF, Excel, or Word document by clicking the 
corresponding button. 
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VII. SEARCH FOR A FILE BY THE TAX ID NUMBER (PIN OR TAX KEY) 

A. To search for a file by the Tax ID Number (Permanent Index Number or PIN), click the Add File 
Number button  or select New File from the File menu, even though a new file is not needed. 

 
 

Tax ID Search Form 

 

B. Enter all or part of the Tax ID Number and click the Search button.  Similar Tax ID 
Numbers, if any, will display.  

1. Click the Cancel  button to abandon a new file entry or Tax ID search. 

2. Click the Create New button  to create a new file; or, 

3. Highlight the desired file and click the Open Selected button  to open an 
existing file. 

  

File > 
New File 

Add File Number 
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[NOTES] 
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3 
Getting Started 

 
 

 



3 | GETTING STARTED 

I. CREATING A NEW FILE 

A. To create a new file, click the Add File Number button  located on the toolbar or select New 
File from the File menu. 

 

Tax ID Search Form 

 
The purpose of the Tax ID search is to prevent duplicate orders and to determine if your office 
has previously insured this property using REsource. 

B. Enter all or part of the Tax ID Number (Permanent Index Number or PIN or Tax Key Number) 
and click the Search button.  Similar Tax ID Numbers, if any, will display.  

1. Click the Create New button  to create a new file; or 

2. Click a displayed file and click the Open Selected button  to open an 
existing file; or 

3. Click the Cancel button  to abandon a New File entry or Tax ID search. 

File > 
New File 

Add File Number 
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4. The Enter New File window opens after clicking the Create New button  
on the Tax ID Search Form.  

 
a. Type of Order 

Click Type of Order and select the Type of Order by clicking the drop-down 
arrow.  

i. None specified at this time 

ii. Title Services (Title Services Complete or Title Services Support) 

iii. Search Only 

iv. Regional 

v. Commercial 

vi. Commitment 

b. Branch 

For regional members only. 

c. Title Unit  

Leave blank. 

d. Escrow Unit 

Leave blank. 

5. Click the Calculate Next Number button.  

REsource automatically creates the File Number, which is based on the current year, your 
member number, and consecutively numbered files. It is important to use the Calculate 
Next Number button to ensure proper file numbering. The File Number assigned by 
Complete Closing will also be used as the Commitment and Policy numbers. 

6. Click OK to create the new file. 
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II. AGENT/VENDOR LIST 

A. Instructions for using the Agent/Vendor List 

1. The Agent/Vendor list is a complete record of all individuals or organizations entered in 
the database. It includes lenders, Realtors, search providers, attorneys, HUD-1 Settlement 
Statement payees, buyers, and sellers. It contains the individual’s or company’s name, 
address, city, state, zip code, phone number, fax number, category, contact individual’s 
first and last names, friendly name, e-mail address, Web site address, Notes, and region.  

2. All individuals or organizations associated with a transaction must first be entered into 
the Agent/Vendor list. The individual or organization will be stored in the database for 
future use with any other transactions. 

3. The following is a list of data fields that use information stored in the Agent/Vendor list: 

a. Search Provider 

b. Realtor 

c. Attorney  

d. Lender 

e. Mortgage Broker 

f. Place of Closing 

g. Home Inspector 

h. Pest Inspector 

i. Member 

j. Recording Office 

k. Surveyor  

l. None 

m. All Payee fields on the HUD 

B. Access the Agent/Vendor List 

To access an agent from the Agent/Vendor list, use any of the following options: 

1. With the cursor in the data field, press <Ctrl>+<L> to display the Select Agent dialog 
and search for an existing record or enter a new agent; or 

2. With the cursor in the data field, right-click and select Lookup Agent to display the 
Select Agent dialog; or 

3. Enter the first few letters of the name for an existing record. If there is just one match, the 
program will enter the ID and name. If there is more than one match, it will display the 
matching entries so you can select one. If there are no matches, it will display the Select 
Agent dialog with the closest match. You can select from this list or click New Agent to 
enter a new record; or 

4. Enter the Agent/Vendor ID Number for an existing record. 
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C. Searching for an Agent 

1. To Select an Agent from the Agent/Vendor list, enter the Agent/Vendor’s name in the 
Search Characters field. Closest matches will display. Highlight the desired Agent and 
click OK. 

 
 

 

2. The Agent Lookup is context sensitive. An Agent lookup on the Lender data field will 
produce a list of Lenders; a lookup on the Realtor field will produce a list of Realtors. 
The type of Agent can be changed by clicking the Filter drop-down list.  The Agent 
list is also filtered by Region.  

In the Region field, use the drop-down list  to toggle between regions. The drop-down 
list options are: 

a. Region Zero 

Only agents created in Region Zero (agents created by ATG) display. You may 
use these agents for your files but you cannot edit these agents. 

b. Your Selected Region 

Only agents created in your Region display. These are agents that you have 
created; they can be edited. 

c. Both Regions 

Agents in both Region Zero and your Region display. 

3. Click Search By to change the search criteria. Agents are listed by name (first name then 
last name for individuals), but you can use the Search By drop-down list  at the bottom 
of the screen to change your search criteria. Other search criteria include Address, City, 
and Friendly Name. Friendly Name is listed by last name. For example, agent John Smith 
will be listed alphabetically by “John Smith” when the Search By selected is Name, and 
“Smith John” when the Search By selected is Friendly Name. 

Search Characters 

Add New Agent Filter by type Filter by Region 

Search By 
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D. Searching for Agent/Vendors using Super Search 

 
The addition of Super Search to the Agent Lookup screen allows users to find agents by 
additional criteria such as address, phone or fax number, contact name, etc. 

1. The Super Search function can be turned on or off by toggling the Super Search 

(open)/(close) buttons.   

2. Type the criteria to search; in this example, “Wells Fargo” and the Contact name, “Amy.” 

3. Click the Search button. The search results display below. Click OK to use the agent. 

 
E. One Time Use Agent  

The One Time Use Agent function allows users to modify an Agent that is not in his or her 
Region for one time use only. The advantage of this function is that a new Agent does not have to 
be created. 

1. Select the agent using the Lookup Agent function. 

2. Right-click on the agent and select Enter as One Time Use Agent. 

 
Notice that a new Agent ID number will be created and the existing ID number will 
appear in the name. 
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3. Right-click again and select View/Edit Agent to edit the agent. 

 
4. The Agent displays in the Agent/Vendor List and you are can edit this agent and use it 

one time only. 

 
F. Organizing Agent/Vendors; Parent/Child Agents 

1. Agents can now be organized within relationships. An agent can be created representing 
one company (Parent) and several additional agents (Child) can be created listing various 
locations or contacts. 

2. To create a relationship for an agent: 

a. Go to Data Entry>Agent List or press <Ctrl>+<A>. 

 
b. Click the Insert New Agent button  to add a new agent. 

c. Complete the New Agent information 
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d. Click the Choose Agent Parent button  and search 
for the Parent Agent to associate with the Child Agent. 

Parent Agents will appear in yellow in the Agent Lookup. 

 

e. Click the Show Contacts button  to view all Agents associated with the 
Parent agent. 

 
G. Additional Agent/Vendor Features 

 

 
Insert New Agent: Adds a new agent. 

 
Locate Agent: Lookup by agent name. 

 
Delete Current Agent: Deletes unused agents only. 

 
Lookup Agent by Number: Lookup by Agent ID Number. 

 
Archive Agent: Archive/un-achieve agents. 

 
Copy and Archive Agent: Makes a copy of an agent and then archives the agent. 

 
Display Agent Change Log: Lists changes to the agent. 

 
Recover Deleted Agent 
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H. Adding a New Agent 

1. To add an Agent to the Agent/Vendor List, click the Insert New Agent button.  

 
2. Complete Closing assigns a sequential ID number to each Agent. Enter the Name, 

Address, Phone, Fax, and Contact information, if known. 

3. Select the Category (type) for this Agent: 

a. Attorney; 

b. Home Inspector; 

c. Lender; 

d. Misc. 1; 

e. Misc. 2; 

f. Mortgage Broker; 

g. Pest Inspector; 

h. Place of Closing; 

i. Realtor; 

j. Recording Office; 

k. Search Provider; or 

l. Surveyor. 

 NOTE: Always select the proper category for each agent. Agents without a 
category will be difficult to find. 

4. Click OK when finished. (Not all fields are required.) 
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III. EDITING AN AGENT 

A. Right-click in a data entry field that uses the Agent/Vendor List and select Edit Agent or press 
<Ctrl>+<E>.  

B. Click the Edit Agent button  to edit the information. 

 
 NOTE: Editing an Agent will affect all files that use that Agent. Do not change the name of 

an agent unless it is mistyped. Instead, add a new Agent. Agents can be edited only by the 
Region that created them.  

IV. ORDER ENTRY 

When a new file is created, Complete Closing automatically opens the Order Entry screen. The Order 
Entry screen can also be accessed at any time to work on or view an existing file by clicking the Order 
Entry button  or the Data Entry > Order Entry menu.  

 
The Order Entry tab contains several sub-tabs: Main, Buyer/Seller, Loan, and Property. The data 
entered in Order Entry is used throughout program.  

A. Main Tab 

The Main tab contains basic information about the order, including Order Status, Escrow and 
Closing Information, Prior Policy Information, Critical File Dates, Sale Price, etc. Several items 

Edit Agent  
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will contain default information such as the Status of the file, Title Company, Underwriter, 
Escrow Bank, Date the file is opened, and the Member information.  

1. Closer 

Select the drop-down list to display a list of all available agents. If you are a member 
closer, select Member Closer. If ATG is providing a closer, leave this field blank. ATG 
will enter the Closer when the closing is assigned. If the Closing Agent is Member 
Closer, then the To fields of the 1100 section and the Section H-Settlement Agent of the 
HUD-1 Settlement Statement will print the member’s name. 

2. Status 

a. New 

Initial order status. 

b. Opened  

An order changes from “New” to “Opened” when you begin work in the 
Commitment/Policy and HUD preparation screens. 

c. Closed  

An order for which a policy has been issued. 

d. Cancelled 

An order that has been cancelled before it is completed. 

e. Template  

This option allows you to create a type of order template that you can use for 
similar orders. 

f. Old 

This status is assigned by REsource to files that previously existed when a 
company updates its programs and converts the old files to the new system. 

g. On Hold 

This status is used for orders that are waiting on certain tasks to be completed.  

3. Escrow Bank 
The bank account in which the escrow funds are kept. An ID number is assigned to each 
account and displays in the drop-down list field when an order is initially created 

4. Place of Closing 

This information will default to the member’s office. If ATG is conducting the closing, 
the Closing Services Department can update the place of closing. 

5. Search Provider 

Select the Search Provider from the Agent/Vendor List by any of the following 
methods: 

 NOTE: For detailed information about using the Agent/Vendor List, see the 
Agent/Vender section in this manual. 

a. Press <Ctrl>+<L> to search or add a new name to the list. 

b. Right-click and select Lookup Agent to search or add a new name to the list. 

c. Enter an ID Number or partial Name and press <Tab>.  
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d. When you click either field, the two fields change to a single field where you can 
enter a valid ID Number or the first few letters of a Name, so that the field 
populates with the matching name in the database or offers suggestions if there 
are several matches. 

6. Order Category 

a. Title Services 

This designation is for those members participating in either the Title Services 
Support or the Title Services Complete programs. 

b. Search Only 

This designation is for those members who prepare commitments and policies 
themselves and ATG conducts the search. 

c. Regional 

This designation is for those members associated with a regional company. 

d. Commercial 

This designation is for those members who prepare commitments and policies 
themselves for a commercial transaction. 

e. Select Services/Commercial 

This designation is for those members participating in either the Title Services 
Support or the Title Services Complete programs for a commercial transaction. 

f. HUD Only 

This designation is for those members who are only preparing the HUD and not 
writing title. 

g. Traditional 

This designation is for those members who obtain and review search, determine 
insurability, prepare commitment, conduct closing, handle payoffs, record 
documents, conduct Later Date search, and type and deliver final policies. 

7. Service  

a. Owner 

Cash transaction. 

b. Title Guar 

Do not use. 

c. Mortgagee 

Refinance transaction. 

d. Simultaneous 

Buy/Sell where both an Owner’s Policy and Loan Policy will be issued. This is 
set by default. 

e. Const Loan 

Construction loan. 

f. Other 

Letter Report only – no title issued. 
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8. Prior Policy Information 

If a prior policy is available, the following fields must be completed: 

a. Prior Policy Number 

Enter the number of the prior policy. 

b. Prior Policy Amount 

Enter the Amount of Coverage from the prior policy. 

c. Date of Prior Policy 

Enter the Effective Date from the prior policy. 

d. Prior Policy Code 

Select the name of the title company who issued the prior policy by clicking the 
drop-down arrow  to display a list of title companies. 

9. Plant 

Title Plant; leave blank. The ATG Search Department will select Title Plant as Landata, 
Chicago Title, or Other. 

10. Critical Dates 

a. File Opened 

The date the file is created will appear in the File Opened field. 

b. Commitment Due 

This default date is seven (7) days after the open date. You can select a different 
date if you need the commitment sooner or if you are preparing the commitment 
yourself. 

c. Closing Date 

Date of closing. 

d. Confirm Date 

This date indicates that the ATG Closing Services Department has confirmed the 
closing date with the lender (Chicago Area Closings only). 

e. Need Search 

This default date is five (5) business days from the date the file was opened. You 
can enter a different date if you are preparing your own search, have contracted 
with a search provider other than ATG, or need an ATG search sooner than the 
default date (five business days). 

f. Closing Time 

Time of closing. 

11. Member File # 

Enter your own File Number, if any (optional). 

12. Sale Price 

Enter the Sale Price. Do not use dollar signs ($) or commas; they will automatically 
populate. 
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13. Notes 

Any pertinent information can be entered in a Note, and you may have multiple Notes for 
a file.  

a. Click the Add New Note button  to create a new Note. The date will appear 
automatically. 

b. Click the Delete Current Note button  to delete a Note. 

c. Click the Display All Notes button  to display or print all the Notes in this 
file. 

d. Click the View Selected Note button  to display the entire Note that is 
highlighted.  

e. Click the Edit and View Selected Note button  to display the entire Note that 
is highlighted. A confirmation message will appear. Click OK to edit the data in 
this expanded work area. 

f. Click the Publish/Unpublish Note to PaperlessCloser button  to publish or 
unpublish the selected Note. 

14. Using Templates to Copy a File; Using a Template for Order Entry  

The Use Template feature will copy all Order Entry data, except the Sale Price, Earnest 
Money, and Loan Amount, from an existing file or from a template file. There is also a 
Use Template feature to copy the Commitment and Policy data from an existing file or 
from a template file.  

 NOTE: It is recommended that you use the Use Template feature prior to adding 
data to the file. Two confirmation messages will display upon selecting Use 
Template, indicating that any data previously entered in the Order Entry tabs will 
be deleted and replaced with the data from the selected existing file. 

a. Create a new file. If this file is for the purpose of creating a second HUD-1 
Settlement Statement or a second Commitment, type the existing file number 
followed by “–A.” Do not use the Calculate Next Number button unless this is a 
new file. 

b. Click the Order Entry button  or the Data Entry menu to access Order 
Entry. 

 

Use Template 
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c. From the Order Entry> Main tab, click the Use Template button. 
 

d. Click OK on the confirmation prompts that indicate the selected template will 
override any data entered in the Order Entry tabs. 

e. The Select Template screen opens. 

 
f. You may: 

i. Select a file that is a template; or 

ii. Click the All Orders button  to list all of your files. 

g. Select the file that you want by either double-clicking the file or clicking once on 
the file to highlight it and clicking OK. 

The Order Entry data from the existing file will now appear in the new file. 

 NOTE: The Sale Price, Earnest Money, and Loan Amount will not be copied 
from the existing file. In addition, you must go to the ATG Services screen 
to select services and calculate rates. 

B. Buyer/Seller Tab  

The Buyer/Seller tab contains two sub-tabs, one for the Buyers and one for the Sellers. 
Unlimited Buyers’ and Sellers’ names and information may be entered for each file. Use the 
Business Name field for corporations, trusts, or estates and use the Nm1 and Nm2 fields for 
individuals’ names. 

 

Buyers/Sellers 

Edit Buyer/Seller 

All Orders 
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1. Buyers Sub-Tab 

a. Click the Insert New Buyer/Seller button  to begin entering the Buyer name. 

i. Buyer Name 

Enter the complete names of the Buyers, including middle initials. If the 
Buyer is a corporation, estate, or a trust, enter the name in the Business 
Name field. 

ii. Marital Status 

Select Buyer’s marital status, if known.  

iii. Buyer Address 

Enter the Buyer’s address, if known. 

iv. Buyer Realtor 

Enter the Buyer’s Realtor, if any. 

v. Buyer Attorney 

Select the Buyer’s attorney. 

b. Multiple Buyers are added by clicking the Insert New Buyer/Seller button.  
Married Buyers can be entered in the Nm1 and Nm2 fields. For unmarried 
Buyers, use the Insert New Buyer/Seller button  to add each name to a 
separate window. 

c. To edit Buyer information, click the Edit Buyer/Seller button.  

2. Sellers Sub-Tab 

 

a. Click the Insert New Buyer/Seller button  to begin entering the Seller name. 

i. Seller Name 

Enter the complete names of the Sellers, including middle initials. If the 
Seller is a corporation, estate, or a trust, enter the name in the Business 
Name field. 

ii. Marital Status 

Select the Seller’s marital status, if known.  
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iii. Seller Address 

Enter the Seller’s address, if known. 

iv. Listing Agent 

Enter the Seller’s Realtor, if any. 

v. Seller Attorney 

The Seller Attorney will default to the member’s name. If the member’s 
name is a title company name, change the member’s name to the actual 
attorney’s name. 

b. Multiple Sellers are added by clicking the Insert New Buyer/Seller button.  
If Sellers are not married, click the Insert New Buyer/Seller button  to add 
the next Seller.  

c. To edit Seller information, click the Edit Buyer/Seller button.  

3. Override Signature Block 

REsource automatically creates signature lines for the Buyer and Seller on several closing 
documents, based on the Name fields in the Buyer/Seller tab in Order Entry. The 
Override Signature Block allows the user to modify signatures on all documents 
containing a signature block. 

a. Select the Buyer/Seller tab and enter the Name. 

b. Click the Override Signature Block button.  

 
c. Type a line, then enter the name, and click OK. 

The new signature will appear on all documents containing a signature block. 

4. Entry of 1099S Information and Allocation 

a. REsource assumes the reportable amount is the purchase price that is entered as 
the Sale Price in the Main tab of Order Entry. For a single or married couple as 
Seller, the purchase price will be shown as 100% allocated to the Seller. That 
information is shown in the lower right hand corner of the Seller screen in Order 
Entry. 

Edit Buyer/Seller 
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b. For a single or married couple Seller, 100% of the proceeds are attributed to that 
Seller. For multiple Sellers, the program equally divides the proceeds among 
those Sellers. If a second Seller (Jones) is added to this file, the proceeds will be 
divided equally between Mary Seller and John Jones. Please note that you must 
enter each Seller’s Social Security Number (SSN) or Federal Tax ID Number in 
the Tax ID data field. For federal tax reporting purposes, married couples are 
generally treated as one taxpayer, requiring only one SSN. To allocate the 
proceeds between spouses, make each spouse a separate Seller.  

 
c. You can change the percentages to unequal amounts in one of these ways after 

you have marked the Override Auto 1099 Proceeds Distribution for each 
Seller: 

i. Enter a different percentage in the Allocation % field. The program will 
then calculate the Allocation Amount as the entered percentage of the 
Sale Price. Repeat this procedure for each seller. 

ii. If you want to allocate specific amounts rather than on a percentage 
basis, delete the number from the Allocation % field and enter the 
specific amount in the Allocation Amount field for each Seller. 

iii. To make sure you balance for multiple Sellers, you can also click the 
View All Buyers/Sellers button  to display the Buyer/Seller Work 
Area. The program displays a window listing all the Sellers, along with 
the Percentage and Amount of the Proceeds for each, the total Sale Price, 
Allocation, and Balance. To change the allocations, check the Override 
Auto 1099 Proceeds Distribution box, and then enter percentages for 
each Seller. As you do so, the program adjusts the Allocation and 
Balance figures, so that you can see if your balance is zero when you are 
finished.  

Allocation %/Amount 

View All Buyers/Sellers 

Do Not Generate 1099 
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iv. By default, the Do Not Generate 1099 checkbox is checked. If the 

transaction is not exempt from reporting, you must uncheck the 
checkbox. If either property or services are being received as part of the 
transaction, select the Receive Prop or Services checkbox. 

 NOTE: The Sellers’ proceeds checks in Check Writing will 
automatically calculate based upon the allocation for each individual 
Seller. 

v. If you have general questions about 1099S reporting requirements, 
contact the ATG Underwriting Department at 800.252.0402. The 1099S 
information packet is available for download from www.atgf.com or by 
calling the ATG Order Department at 800.252.0402, extension 2114. 

C. Loan Tab 

The Loan tab contains Lender Information, Sale Price, Earnest Money, and the Loan Amount. 

 
1. Sale Price 

Enter the Sale Price. Do not use dollar sign ($) or commas. 

2. Earnest Money 

Enter the earnest money. Do not use dollar sign ($) or commas. 

a. After entering the Earnest Money amount, the Earnest Money dialog box 
displays.  

Override Auto 1099 Proceeds Distribution 
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b. Select the radio button corresponding to the party holding the earnest money. 

 
c. Earnest Money Deducted from Realtor Check 

Upon selecting Seller’s Realtor or Buyer’s Realtor is holding earnest money, a 
prompt will ask if the earnest money should be deducted from the Realtor’s 
commission. 

 NOTE: The Realtor holding the earnest money must be entered in the Buyer 
or Seller tab. 

 
3. Loan Amount 

Enter the Loan Amount. If the Loan Amount is not known, enter an estimate of the loan 
amount. Do not use dollar signs ($) or commas. 

4. Owner’s Policy Liability Override and Loan Policy Liability Override 

If the amount of coverage on the Owner’s Policy or Loan Policy is not equal to the Sale 
Price or the loan amount, enter the values in the Liability Override field. 

5. Mortgage Broker 

For informational purposes, you may enter the Mortgage Broker, if any. 

6. Loan Information 

a. Lender 

Select the Lender from the Agent list. Add the lender, if necessary. 

i. See the Agent/Vendor List section in this manual for additional 
information about adding lenders. 

ii. If the Seller is providing financing, click the Select the Lender to be the 
Seller button  to display the Seller’s name as the Lender. 

b. Loan Number 

Provided by the Lender; enter if known. This information will carry over to the 
HUD-1 Settlement Statement. 

c. Mort. Ins. Case No. 

Provided by the Lender; add if applicable. 
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d. Monthly P&I 

Enter the amount of the monthly principal and interest payment. This information 
is required on the page 3 of the HUD-1 Settlement Statement. 

e. Interest Rate 

Enter the interest rate of the mortgage. This information is required on the page 3 
of the HUD-1 Settlement Statement. 

7. 2nd Loan Information 

If there is a second Lender, enter the amount of the second loan and select the second 
lender in the 2nd Loan Information section. 

 NOTE: If there is a second loan, select the document, POL Commitment A 
Schedule 2 Mtgs. from the Print Document list. 

D. Property Tab 

Select the Property tab to enter information about the property. 

 
1. Tax ID (PIN) 

Enter the PIN (Permanent Index Number/Parcel Index Number), using dashes. 

 NOTE: For properties with multiple Tax ID Numbers, click the Insert New 
Property button  and enter the next Tax ID number in the PIN field. If multiple 
properties are being insured, enter the full address and Tax ID number for each 
property. 

2. Subdivision 

Subdivision names are stored in a table and are searchable. Begin entering the 
Subdivision Name. If the subdivision has been previously entered, it will appear in the 
drop-down list. If the name does not appear, add it by pressing <Ctrl>+<Enter>. The 
Subdivision Name is generally found within the Legal Description. If the property is a 
condominium, enter the Name of the Condominium as the Subdivision Name. 

3. Block 

Enter the Block Number. The Block Number is generally found in the Legal Description. 
For condominium property, enter the Unit Number in the Block field and edit the Brief 
Legal Description accordingly. 

Set Property Address to Buyer’s or Seller’s Address 
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4. Lot 

Enter the Lot Number. The Lot Number is generally found in the Legal Description.  

5. County 

Enter the first few letters of the county where the property is located to display a drop-
down list of counties. Select the desired county. 

 NOTE: The County is required for calculation of the ATG premium. 

6. Township 

Enter the first few letters of the Township to display a drop-down list of townships. 
Select the desired township. 

7. Override Legal 

For Section Ground Legal Description, check the Override Auto Legal box. Enter Legal 
Description as Section No., Township, Range, Quarter Section, County Name. 

 
8. Address 

To auto fill the Street Address with that of the Buyer or Seller, click the Set the Property 
Address to the Buyer’s Address button  or the Set the Property Address to the 
Seller’s Address button  located at the top right. Otherwise, enter the property 
address. 

9. The Tax Sale Date, Tax Redemption Date, and Taxes Redeemed Date fields are used 
by ATG. 
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4 | ATG® SERVICES 

The ATG Services screen has two functions. The first is to select services that are required for each transaction 
and the second is to calculate all title-related fees automatically for the Invoice for Title Charges, Closing 
Statement, HUD-1 Settlement Statement, Check Writing, and Accounting Information Schedule (AIS). It is 
important that all services and any revisions to services be entered on this screen prior to preparing the Invoice for 
Title Charges, Closing Statement, HUD-1 Settlement Statement, Check Writing, and the AIS. Fees for services 
are based upon several factors such as: 

 Location of the property (state, county, and city) 

 Purchase price 

 Loan amount 

 Search Provider 

The above information must be entered in the Order Entry section of Complete Closing Enterprise before 
selecting services.  

I. EDIT SERVICES 

A. To edit or select Services from the ATG Edit Services screen, click the Edit Services button  
or select Edit Services from the ATGF Extensions menu or press <Alt>+<E>. 

 
B. The ATG Services Summary window displays all services and charges thus far selected.  

 

Edit Services Edit Services 

Edit/Select Charges 
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II. ATG SERVICES WINDOW 

A. Click the Edit/Select Charges button  to select additional services. 

1. The ATG Services screen contains tabs for Title Prep, Endorsements, Closing, Search 
Services, Rec-Misc, and Commercial, and totals are shown on the right. Each tab will 
have checkboxes for selecting various services. 

2. Select title services and transaction information by clicking the appropriate checkbox. 

3. When services are selected, customary fees will automatically populate the ATG column, 
the Buyer column, or the Seller column. 

 
 NOTE: When finished entering or editing services on the ATG Services screen, you 

must click the Update HUD button  prior to closing the ATG Services 
screen. This will ensure that all ATG and consumer charges appear on the Invoice, 
Closing Statement, HUD-1 Settlement Statement, and AIS. 

The Update HUD button  pulls all fees from the ATG Services screen to 
the Invoice for Title Charges, Closing Statement, HUD-1 Settlement Statement, and 
AIS. 

4. Click the Close button  to close Edit Services. 

Update HUD 
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5. Overriding Standard Fees 

a. Standard Consumer Fee 

i. To override the Standard Consumer Fee or the party liable for payment 
(Buyer or Seller), double-click the Amount field. The Consumer 
Charge Override dialog box displays. 

 
ii. Enter the desired amount in the Buyer Charge or Seller Charge field () 

and click OK. Do not use dollar signs ($) or commas. 

Wisconsin Members: Since rates are filed in Wisconsin and there is a rate 
range from minimum charge to maximum charge, you will have to 
override the default amount for the consumer on every transaction. 
Because of the rate range, REsource is unable to determine what you 
may be charging on any given transaction and therefore, the charge 
displayed will be an average between maximum rate and minimum rate. 

b. Standard Underwriting Fee  

i. To override the Standard Underwriting Fee, double-click the Amount 
field. The Special Rate dialog box displays. 

 
ii. Enter the desired amount in the Special Rate field and click OK. Do not 

use dollar signs ($) or commas. 

iii. Enter the Authorization number, if any. 

 NOTE: Special Rates for underwriting premiums must be authorized 
by ATG Staff Attorneys. 

 NOTE: All overridden amounts will appear in bright blue. 
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B. ATG Services Tabs 

1. Title Prep Tab 

a. Title Prep 

Title Prep refers to Pre and/or Post-Closing clerical services provided by ATG 
on behalf of the member. These services are also known as Title Services Support 
and Title Services Complete. 

 
i. Title Services Complete 

Pre- and Post-closing processing provided by ATG. 

ii. Title Services Support 

Post-closing processing provided by ATG. 

iii. Loan Modification 

An update of a Loan Policy.  

iv. GRU  

Gap Risk Update. 

b. Prior Type 

Select the Prior Type of policy, if any. An Owner’s Policy, Loan Policy, or a 
Commitment is acceptable prior title evidence. 

 NOTE: Mid America Title Insurance Company’s policies and commitments 
will not be accepted as prior title evidence. 

i. No Prior Policy 

No prior policy is available. 

ii. ATG Prior Policy 

ATG previously insured the property. 
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iii. Contract Conversion 

A Contract Purchaser’s policy was issued by ATG and now an Owner’s 
Policy will be issued vesting title in the names of the contract purchasers. 

iv. Abstract 

An abstract has been surrendered for credit as prior title evidence. 

v. Non-ATG Prior 

A title company other than ATG previously insured the property. 

c. Property Type 

Select the Property Type by selecting the appropriate radio button. If the 
property type is unknown, leave blank. 

i. Residential 

1-4 units. 

ii. Commercial 

Buildings, Stores, Apartment buildings with seven (7) or more units, and 
Mixed-Use. 

iii. Vacant 

Unimproved property. 

d. Transaction Type 

Select the Transaction Type by selecting the appropriate radio button. If 
unknown, leave blank. 

i. Buy/Sell 

A transaction where there is a Buyer, Seller, and a Lender. 

ii. Refinance 

A transaction where the owner of the property is obtaining a new 
Mortgage. Selecting this transaction type will recalculate the Loan Policy 
consumer charge and ATG’s fee.  

iii. Installment Contract 

A transaction where the Buyer and Seller enter into an Agreement for 
Deed. 

iv. New Construction 

A transaction insuring previously unimproved property. 

v. Cash 

A transaction where there is no Lender. 
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2. Endorsements Tab 

Select all endorsements indicated by the type of transaction or required by the lender. The 
underwriting fees due ATG and consumer fees, if any, will display in the ATG, Buyer, 
or Seller columns, and will be included in the totals. Consumer charges for endorsements 
will appear on the Invoice for Title Charges, the HUD-1 Settlement Statement, and the 
AIS.  

Select required endorsements, if any, by clicking the checkbox. 

 
 NOTE: Endorsements that are required but not listed on the ATG Services screen 

must be added in the Miscellaneous tab. 

3. Closing Tab 

Select the type of Closing Services, if any.  
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 NOTE: Selecting Closing Services from the ATG Services screen ensures that the 
proper fees appear on the Invoice and HUD-1. Schedule Chicago area closings with 
the Closing Services Department at 312.372.1585 or chi_closing@atgf.com. 

a. Closing 

i. Full Closing 

ATG acts as the escrow agent by providing a closer, HUD-1 Settlement 
Statement, and the checks for disbursement. The fee for this service will 
calculate automatically based upon the purchase price. 

ii. After Hours Fee 

Applies to closings scheduled before 8:00 a.m., after 5:00 p.m., or any 
time on Saturday or Sunday. 

iii. Checks and HUD Only 

ATG provides checks and the HUD-1, but not an independent closer. 

iv. CPL Lender 

The fee to ATG for issuance of the Closing Protection Letter to the 
Lender. 

v. CPL Borrower 

The fee to ATG for issuance of the Closing Protection Letter to the 
Borrower. 

vi. CPL Seller 

The fee to ATG for issuance of the Closing Protection Letter to the 
Seller. 

vii. Dry Closing (ATG Chicago area closings) 

A fee will be assessed in the event of an unfunded transaction. 

viii. E-Mail Package Fee 

The fee to the party downloading and printing the lender’s mortgage 
documents  

ix. Member Closer 

The member has an approved closer that provides settlement services. 
The Settlement Agent on the HUD-1 Settlement will print the member’s 
name and address. 

x. Member Closer Admin Fee 

The fee to ATG from member closers in the Chicago area. 

xi. Multiple Loan Closing 

The additional fee for closing more than one mortgage for a single 
transaction, 

xii. Room Only 

The closing takes place at an ATG office; however, ATG will not 
provide settlement services. 
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xiii. Tax Payment 

An ATG charge for paying real estate taxes for property located in the 
Chicago area. 

xiv. Water Payment 

An ATG charge for paying water bills for property located in the City of 
Chicago. 

 NOTE: Deed and money closings and § 1031 (Starker) exchanges 
must be scheduled through the Closing Services Department. 

b. Other Fees 

i. Escrow Fee 

The fee for ATG’s Escrow Department or the member to hold an escrow. 

ii. Regional Package 

Used by Regional Companies only (Regions 6000-9000). 

iii. Mortgage Compliance Certificate 

The fee for obtaining the mortgage compliance certificate through the 
Anti-Predatory Lending Data base. 

iv. Mortgage Exemption Certificate 

The fee for obtaining the mortgage compliance exemption through the 
Anti-Predatory Lending Database. 

4. Search Tab 

 
a. Certified Copies 

b. Initial Full w/o Prior 

Initial Full Search (20-year search) without prior title evidence. This includes one 
Later Date search. 
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c. Initial Full w/Prior 

Initial Full Search with prior title evidence. This includes one Later Date Search. 

d. J & L Search Only 

A search of Buyer/Seller names only. 

e. Location Note 

Locates the insured premises (Single Family Residence, Unit No., etc.). Used to 
complete the Location Endorsement. 

f. Lot Update 

Used when generating a title commitment from a master policy. 

g. Minutes of Foreclosure 

An initial full search on property as a part of the foreclosure process. 

h. Record Owner 

A search to determine the owner of the property. 

i. Redemptions 

An estimate from the county for unpaid taxes. 

j. Rush Search 

For an additional fee, the search will be completed within three (3) days. 

k. Tax and Assessment Only 

l. Tax Bill Only 

m. Tract 

n. UCC Filing 

o. UCC Recording 

p. UCC Release 

q. Water Certificate 

The City of Chicago requires a final meter reading and paid water bill prior to 
closing. Contact the ATG Search Department to order a Water Certificate. 

r. Zoning Certification 

The City of Chicago requires an inspection of residential property prior to 
closing. To order a Zoning Certificate, contact the ATG Search Department at 
312.752.1994 or Chi_Search@atgf.com. 

 NOTE: An application is available in the Print Documents menu (DOC 
Water & Zoning Application). Payment for the Water and Zoning 
Certification is due in advance. 

s. 24 Month Chain of Title 

A list of any deeds of record for the previous 24 months on the insured property 

t. Non ATG Search 

ATG use only. 

u. Later Date Search 

Add or delete Later Date Search fees. 
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5. Rec-Misc (Recording-Miscellaneous) Tab  

Recording and miscellaneous fees will appear on the Invoice for Title Charges, Closing 
Statement (seller only), and the HUD-1 Settlement Statement. Click the Rec-Misc tab to 
enter recording fees and miscellaneous fees.  

 
a. Recordings 

Click the checkboxes to select documents.  

Recording fees will calculate for the following Illinois counties: Cook, DuPage, 
Kane, Lake, McHenry, and Will. For all other counties, or to override the 
automatic calculation, double-click the Buyer or Seller column to display the 
Consumer Charge Override dialog box. 

b. Miscellaneous fees will be added to the Invoice for Title Charges, Closing 
Statement, and the HUD-1 Settlement Statement. Miscellaneous items can be 
directed to HUD-1 Settlement Statement in either Additional Title Services 
(rolling up to line 1101) or to the 1300 section. 

i. Click the Add Misc button  to add miscellaneous fees. 
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ii. Enter a description of the fee in the Service Name field. 

iii. Select either Additional Title Services Item or HUD 1300 section 

iv. Enter the amount in either the Borrower or Seller field. 

v. Click OK. 

6. Commercial/Other Tab  

Select endorsements that may be required for commercial property.  

Click the appropriate checkboxes to select required endorsements. The ATG 
underwriting premium and the suggested consumer fees will display in the ATG and 
Buyer or Seller column. 

 
 NOTE: When entering or editing services on the ATG Services screen, you must 

click the Update HUD button  prior to closing the ATG Services screen. 
This will ensure that all ATG and consumer charges appear on the Invoice, Closing 
Statement, HUD-1 Settlement Statement, and AIS. 
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5 | COMMITMENT PREPARATION 

I. SCHEDULE A 

A. Preparing Schedule A of the Commitment 

1. To enter/edit information on the Commitment, click the Commitment/Policy 
Preparation button  or select Commitment/Policy/Binder from the Data Entry 
menu.  

 
 

Commitment Schedule A 

 
2. Enter the Effective Date or click the calendar and select a date. 

3. Enter an Effective Time, if any. 

 NOTE: The Commitment Number field auto-populates with the File Number. The 
Policy Numbers will also auto-populate with the File Number followed by “-01.” 
Commitments and policy jackets are printed in REsource. Pre-printed serialized 
jackets are no longer used. 

4. Enter the Issue Date and Issue Time – the date and time the Commitment will be issued. 

Data Entry > 
Commitment/ 
Policy/Binder 

Commitment/Policy Preparation 
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5. Following are several text-editing options. These options are available by selecting the 
buttons indicated or by right-clicking in the text area. 

 
 

 

 
Spell Check: Checks spelling in text area. 

 
Lookup Standard Language Items: Contains a library of Special Exceptions. For a list of Standard 
Language, see the Standard Language Section of this manual. 

 
Pull Field from Complete Closing: Copies exceptions and Legal Descriptions from other files. 
(See a detailed explanation of this feature on page 6 of this section.) 

 
Expand Work Area: Enlarges text entry area. 

 
All Options: Includes all text formatting options. 

 
Build Document Prompt: Not in use at this time. 

 
Insert Names from Order Entry: Inserts the buyer, seller, or lender names from Order Entry. 

Right-Click in text area Drop-down menu displays all text-editing functions. 
 

Spell Check 

Lookup Standard 
Language Items 

Pull Field from 
Complete Closing 

Expand Work Area 

All Options 

Right-click for 
Drop-down 
M  

Insert name from 
Order Entry 

Build Document Prompt 
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B. Owner Insured 

1. Enter the Buyer, Seller, and Lender names in the corresponding tabs in Order Entry. 

 
2. Each of the Suppress Names checkboxes will be checked. This setting allows the names 

of the Buyer, Seller, and Lender to pull from the Order Entry tabs. 

3. With the Owner Insured sub-tab open, click the Insert Owner Name(s) in Text Box 
button.  

4. The Buyer name will display in the text area. This name will appear as shown as the 
Proposed Insured for the Owner’s Policy on the Commitment. You may edit, if 
necessary.  

 
 NOTE: If the names of the Buyer, Seller, or Lender are misspelled, or to add middle 

initials or suffixes such as “Jr.” or “Sr.,” edit the name in Order Entry. Then delete 
the name and click the Insert Owner Name(s) in Text Box button  to pull in the 
corrected name. This will ensure that the name will appear properly on other 
documents. 

Suppress Names Suppress Names Suppress Names 

Insert Owner Name(s) in Text Box 

Owner Insured 
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C. Mortgagee Insured 

1. Select the Mortg. Insured sub-tab. The Mortgagee Insured text area displays. 

 

2. Click the Insert Mortg. Insured Name(s) in Text Box button  to display the 
Lender’s name. You may edit the Lender’s name to include “its successors and/or 
assigns” or other language as directed by the Lender. 

D. Mortgagee Borrower 

1. Select the Mortg. Borrower sub-tab. The Mortgagee Borrower text area displays. 

 

2. Click the Insert Mortg. Insured Name(s) in Text Box button  to display the Buyer’s 
name. You may edit the name if necessary. 

Insert Mortg. 
Insured Name(s) in 
Text Box 

Mortg. Insured 

Insert Mortg. Borrower 
Name(s) in Text Box 

Mortg. Borrower 
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E. Current Title Holder 

1. Select the Current Title Holders sub-tab. The Current Title Holder text area displays. 

 

2. To insert the Seller names, click the Insert Seller Names button.  

3. To insert the Buyer name as the Current Title Holder, used for refinance or second 
mortgage transactions, click the Insert Buyer Names button.  

F. Legal Description 

1. Entering the Legal Description 

a. Select the Legal Desc. sub-tab. The Legal Description text area displays. 

 
b. Enter Legal Description in the text area. 

c. To check spelling, click the Spell Check button.   

2. Copying the Legal Description from another REsource file. 

a. To copy the Legal Description from another REsource file, click the Pull Field 
from Complete Closing button.  A list of REsource files displays. 

b. Select the desired file by double-clicking the file name or number. The Insert 
Field From Database window opens. 

Insert Buyer 
 

Current Title Holders 

Insert Seller Names 

Legal Description 
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c. Scroll down to CommitPolicy and click the Plus (+) to view all data within.  

 
d. Continue to scroll down to Legal Description. Highlight Legal Description and 

click OK. The Legal Description from the selected file will be copied into the 
current file. 

3. Copying the Legal Description from another word processing application into REsource. 

a. Open Word or WordPerfect and open the file containing the desired text.  

b. Highlight the desired text, and select Copy or press <Ctrl>+<C>. 

c. Minimize word processor. 

d. Open REsource and navigate to the Legal Description window found in the 
Commitment/Policy tab. 

e. Place the cursor where you want the text and either right-click or click the All 
Options button  and select Paste as Text or press <Ctrl>+<T> to insert text. 

 NOTE: Do not paste text without using the Paste as Text feature. Doing so 
will cause the text to copy as an image that cannot be edited and will greatly 
expand the size of the file. 
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G. Interest in the Land  

The default for Interest in Land is set to Fee Simple. To change the interest, click in the Interest 
in Land field and enter the Type of Interest, such as “Contract Purchaser” or “Leasehold.” 
Changing the Interest in Land field will change the language of the commitment and/or policies. 
Do not use the text area of the More Int In Land sub-tab. 

 
H. Two Mortgages on the Commitment Schedule A 

1. Go to Order Entry and select the Loan tab. Under 2nd Loan Information, enter the 
Loan Amount and Lender name and close Order Entry. 

2. Open the Commitment/Policy and select the 2nd Mortg. Insured tab. 

 

3. Click the Insert Mortg. Insured Name(s) in Text Box button.  The second Lender’s 
name will display. You may edit the Lender’s name to include “its successors and/or 
assigns” or other language as directed by the Lender. 

4. To print, select the ATG Pkg. Commitment 2 Mortgs. 06 package. 

Interest In Land 
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II. SCHEDULE B 

A. Preparing Schedule B of the Commitment 

1. To enter/edit information on the commitment, click the Commitment/Policy 
Preparation button  or select Commitment/Policy from the Data Entry menu.  

 
2. Select the Sched B tab. The Sched B, Sched B Req, Exceptions, and Notes to Closer 

sub-tabs display below. 

 
 NOTE: For the purposes of creating an ATG Commitment for Illinois property, use 

only the Exceptions sub-tab to enter Special Exceptions.  

For property in Wisconsin, use the Sched B Req. sub-tab to create a Schedule B-I 
and use the Exceptions sub-tab to create a Schedule B-II. 

a. Schedule B 

Not for use with ATG commitments (all states) 

However, if ATG is the search provider, the Chain of Title is entered in the 
Schedule B sub-tab. Some of the items listed in the Chain of Title that you 
determine need to appear on the Commitment Schedule B can be copied to the 
Exception sub-tab. Only exceptions added to the Exception sub-tab will appear 
on the printed Commitment Schedule B. 

 TIP: To copy and paste: 

– Highlight the text and press <Ctrl>+<C>. 

– Open the Exceptions sub-tab, place the cursor where the text should 
appear and press <Ctrl>+<V>. 

b. Schedule B Requirements 

For Wisconsin property only. This sub-tab is used to produce Schedule B-I for 
the Commitment. 

For Illinois property: This sub-tab is not used.  

Data Entry > 
Commitment/ 
Policy/Binder Commitment/Policy Preparation 

Schedule B 

Sub-tabs 
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c. Exceptions 

Enter all Special Exceptions here (all states). 

d. Notes to Closer 

Used to note endorsements that have been approved for issuance with the 
Owner’s Policy or Loan Policy. 

3. Select the Exceptions sub-tab to enter Special Exceptions. The Exceptions text area will 
display. 

 
 

 
Spell Check: Checks spelling in text area. 

 
Lookup Standard Language Items: Contains a library of Special Exceptions. For a list of Standard 
Language, see the Standard Language Section of this manual. 

 
Pull Field from Complete Closing: Copies exceptions and Legal Descriptions from other files. 

 
Expand Work Area: Enlarges text entry area. 

 
All Options: Includes all text formatting options. 

 
Build Document Prompt: Not in use at this time. 

Right-Click in text area Drop-down menu displays all text-editing functions. 
 

B. Selecting Standard Language Exceptions from the Standard Language Library 

1. To select standard language exceptions, click the Lookup Standard Language Items 
button.  The Select Standard Language Items window opens.  

2. Begin entering the Category name or click the Category drop-down arrow  to view all 
categories and then select the desired category. Each category contains a group of related 
exceptions that will display on the left side of the window. 

3. To select exception language, double-click the desired exception or click once on the 
exception and click the right arrow button  to move the exception to the right side.  

Spell Check 

Lookup Standard 
Language Items 

Pull Field from 
Complete Closing 

Expand Work Area 

All Options 

Exceptions 
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 NOTE: Several exceptions may be selected at one time. For a list of all Standard 
Language, see the Standard Language Entries section in this manual. To create your 
own Standard Language, see the Creating Standard Language section in this manual. 

 

4. Click OK  when finished selecting exceptions. 

5. If the selected exception contains specific information, such as documents numbers, 
dates, or names, a prompt will display. Enter the necessary information and either press 
<Enter> or click OK. The exception and the information will then be merged into the 
Schedule B Exception. 

C. Standard Language Lookup 

The Standard Language Lookup contains enhanced searching capabilities and new options for 
organizing standard language. 

1. Searching for Standard Language by Category and Description 

Although you can see the names of all Standard Language categories, only Region 0 and 
your region’s Standard Language entries will be available. Below are two examples. 
Figure 1 is a Region 0 Category, so all of the exceptions will display and are available for 
use. Figure 2 is not Region 0 and not the user’s region, so no exceptions in that category 
will display. 

Figure 1 
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Figure 2 

 
2. Searching for Standard Language Using a Key Word 

a. The key word search allows users to search through Categories and Descriptions 
for exceptions containing a key word. To search all Descriptions in a category, 
select the Category and enter a key word in the Search field and click the 
Partial Description Search button.  

A list of matching Descriptions in that Category will display 

 
b. To search all categories, enter a key word in the Search field and click the View 

All Categories button.  

A list of matching Descriptions in all Categories will display 
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c. To search for more Descriptions containing the key word, click the Partial 
Description Search button  and the View All Categories button.  

A list of matching partial Descriptions in all Categories will display 

 
3. Excluding Exceptions from the Final Policy 

To exclude exceptions on the Owner’s Policy or Loan Policy, highlight the text and click 
one of the Mark Selected Text buttons. 

 

a.  Mark Selected Text for Inclusion on all Policies (Black). 

b.  Mark Selected Text for Inclusion on Owner’s Policy Only (Blue). 

c.  Mark Selected Text for Inclusion on Loan Policy Exclusion from 
Owner’s Policy (Fuchsia). 

d.  Mark Selected Text for Exclusion from All Policies (Olive). 

4. Copying Special Exceptions from another REsource File 

a. To copy exceptions from another REsource file: 

i. Click the Pull Field from Complete Closing button.  A list of 
REsource files displays. 

ii. Select the desired file by double-clicking the file name. The Insert Field 
From Database window opens. 

Mark selected text for exclusion 
on policies 
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iii. Scroll down to the CommitPolicy folder and click on the Plus (+) to 
view all data within.  

 
b. To copy from a Commitment:  

Continue to scroll down to Exception. Highlight Exception and click OK. The 
exceptions from the selected file will be copied into the current file. 

c. To copy from an Owners’ Policy: 

Continue to scroll down to OwnerSchedB. Highlight OwnerSchedB and click 
OK. The exceptions from the selected file will be copied into the current file. 

d. To copy from a Loan Policy: 

Continue to scroll down to MortgSchedB. Highlight MortgSchedB and click 
OK. The exceptions from the selected file will be copies into the current file. 

e. To copy Exceptions from another word processing application into REsource: 

i. Open Word or WordPerfect and open the file containing the desired text.  

ii. Highlight the desired text, and select Copy or press <Ctrl>+<C>. 

iii. Minimize word processor. 

iv. Open REsource and navigate to the Exception window found in the 
Commitment/Policy tab. 

v. Place the cursor where you want the text and either right-click or click 
the All Options button  and select Paste as Text or press  
<Ctrl>+<T> to insert text. 

 NOTE: Do not copy text without using the Paste as Text feature. 
Doing so will cause the text to copy as an image that cannot be 
edited and will greatly expand the size of the file. 
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5. Notes to Closer/Notes for Information 

The Notes to Closer sub-tab can be used to specify which endorsements have been 
approved for issuance with the Owner’s Policy or Loan Policy. 

 
a. Select the Notes to Closer sub-tab. The text area displays. 

b. Enter the Notes relating to this file or click the Lookup Standard Language 
Items button  and select Notes for Information from the Category menu. 

III. INVOICE FOR TITLE CHARGES; PROCEDURE AND DOCUMENTS 

Several Invoice for Title Charges documents are available in REsource. The Invoice documents pull fees 
directly from the ATG Edit Services screen. Recording fees and miscellaneous items have been added to 
ATG Edit Services to produce a complete Invoice document. 

Prior to printing an Invoice, all title and related charges must be entered in the Edit Services  area. 
Please refer to instructions in this manual for completing the ATG Edit Services. 

A. Invoice Printing 

To print an Invoice: 

1. Click the Print Documents button. . 

2. Click the drop-down arrow  in the Category field and select Invoice for Title 
Charges to view all invoice documents; or 
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3. Scroll down the list of documents to select one of the available Invoice documents: 

 
a. Doc Inv 2010 BO Chicago Area 

For use with the three page 2010 HUD-1 Settlement Statement Breakout of title 
charges. 

b. Doc Inv 2010 NBO Chicago Area 

For use with the three page 2010 HUD-1 Settlement Statement No Breakout of 
Title Charges. 

c. Doc Inv 2010 BO Sep Srch 

For use with the three page 2010 HUD-1 Settlement Statement Breakout of Title 
Charges and Separate Search Fee. 

d. Doc Inv 2010 NBO Sep Srch 

For use with the three page 2010 HUD-1 Settlement Statement No Breakout of 
Title Charges and Separate Search Fees. 

e. Doc Inv for Title BO Chicago Area 

For use with the two page HUD-1 Settlement Statement Breakout of Title 
Charges. 

f. Doc Inv for Title NBO Chicago Area 

For use with the two page HUD-1 Settlement Statement No Breakout of title 
Charges. 

g. Doc Inv for Title BO Sep Srch 

For use with the two page HUD-1 Settlement Statement Breakout of Title 
Charges and Separate Search Fee. 

h. Doc Inv for Title NBO Sep Srch 

For use with the two page HUD-1 Settlement Statement No Breakout of Title 
Charges and Separate Search Fees. 

i. Doc Invoice Services REFI 2010 

For use with the three page 2010 HUD-1 Settlement Statement Refinance 
Invoice, Breakout of Title Charges. 
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j. Doc Invoice Services REFI 2010 NBO 

For use with the three page 2010 HUD-1 Settlement Statement Refinance 
Invoice, No Breakout of Title Charges. 

k. Doc Invoice Services REFI 

For use with the two page HUD-1 Settlement Statement Refinance Invoice, 
Breakout of Title Charges. 

l. Doc Invoice Services REFI NBO 

For use with the two page HUD-1 Settlement Statement Refinance Invoice, No 
Breakout of Title Charges 

 NOTE: All selected services and fees on the ATG Edit Services screen will 
populate the Invoice documents and the HUD-1 Settlement Statement. 
Therefore, when updating fees for title charges, endorsements, recording 
fees, and other miscellaneous fees, it is recommended that the ATG Edit 
Services screen be updated rather than editing fees on the HUD-1.  

Also, remember to click the Update HUD button  before closing 
ATG Edit Services. 

B. Custom Invoices 

1. Consumer Fees 

REsource computes consumer fees for the Owner’s Policy and Loan Policy, 
Endorsements, Search Fees, and Closing Fees based upon the location of the property. 
However, your individual pricing for these services may differ from the default 
calculations. To request custom consumer pricing, please contact your Member Services 
Representative. 

2. Municipal Transfer Taxes 

REsource computes municipal transfer taxes and populates the fee on both the Invoice for 
Title Charges and the HUD-1 Settlement Statement. To request that municipal transfer 
taxes not appear on your Invoice for Title Charges, please contact your Member Services 
Representative. 

C. Separate Search Fees on the Invoice and HUD-1 Settlement Statement 

Follow the instructions below if search fees are not part of the total title charge (Downstate 
Illinois only). 

1. Select the Search Provider in the Main tab of Order Entry or, if the member provided 
the search, enter the Member Number. This will create a disbursement for search fees to 
the search provider or to the member. 

2. Go to the Edit Services screen and click the Search tab. 

3. Check the Initial Full w Prior or Initial Full wo Prior checkbox. 

4. Double-click the Buyer or Seller column to display the Consumer Charge Override 
dialog box. 

5. Enter the amount of the search in the Buyer or Seller Charge field and click OK. 

6. If ATG does not provide search, double-click the ATG column, enter “0” in the Special 
Rate field, and click OK.  

7. To add a Later Date Search Fee, click the Add Later Date button  and 
double-click Open Date to display the Later Date Search dialog box. Enter the Later 
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Date Search Fee in the Buyer or Seller column and click OK. The search fee will be a 
separate line item. 

8. Select either the Doc Inv 2010 BO Sep Srch, Doc Inv for Title BO Sep Srch, or Doc 
Inv 2010 NBO Sep Srch/Doc Inv for Title NBO Sep Srch: No breakout of title 
charges and separate search fees. 
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6 | PRINTING RESOURCE® DOCUMENTS 

I. SELECT DOCUMENTS TO PRINT 

A. To print REsource documents, click the Print Documents button  located on the top toolbar 
or select Utilities > Print/Create Documents. 

 
B. Select documents to print by entering the prefix (see complete list of documents listed below) in 

the Search Characters dialog box or use the Scroll Bar or press <Page Down>. Then, either 
double-click the document name or click once on the document name and click the Select 
Document button  to move the selected document to the Print list on the right. A single 
document or several documents may be selected for printing. 

Additionally, documents may be selected for printing by using the Category function. The 
Category function groups documents by type. To select a document using the Category function, 
click the drop-down  in the Category field to view a list of document types. Select the type of 
document, and then select the desired document. 

 

Search Characters 

Scroll Bar 

Print List 

Category 

Exact and Contains 

Category 
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C. Searching for a Document using Exact and Contains 

1. The Exact and Contains radio buttons allow a search for a document name by using a 
keyword. 

2. Select the Exact radio button  and enter a keyword in the Search field to search 
for the exact name of the document. 

 NOTE: Use the document prefix. 

3. Select the Contains radio button  and enter a keyword in the Search field. For 
example, typing “deed” in the Search field will display all document with the word 
“deed” as a part of the document name. 

D. Documents can be filtered by using the Category drop-down.  Groups of 
documents types such as Affidavit, Commitment, Deeds, etc. are listed. The Exact and Contains 
search also works within Categories. 

E. The Sort by State checkbox  lists the documents by state.  

Select the state from the Filter by State drop-down  to display 
documents available in a state. 
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II. PRINTING A RESOURCE DOCUMENT 

To select document(s) to print, highlight the document(s) and either double-click the document name or 
click the Select Document button  to move the document(s) to the Print Document list on the right. 

 

A. Clear Selections  clears all selected documents from the Print list. 

B. Delete Current Selection Only  clears only the highlighted document from the Print list. 

C. Print Documents  prints all selected documents. 

Wisconsin Members: Select Wisconsin Documents from the Category drop-down to display all 
common Wisconsin forms. Documents highlighted in teal are packages; following them are 
individual documents. Only Wisconsin-specific and common documents are listed. If you require 
an endorsement that is not listed, select the Endorsement category. 
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III. DOCUMENT VIEWER 

File data merges with the documents selected to print and displays in the Document Viewer. From the 
viewer, documents can be printed or saved locally as Word or PDF documents. 

 

A.  Prints current or all documents. 

B.  Sends current or all document(s) to Word.  

C.  Converts current or all document(s) to PDF.  

 NOTE: Although you can edit documents before you print, we recommend that you do not 
change any data. Instead, return to Complete Closing and make appropriate data changes in 
the data entry field. Otherwise, the data changes in your document will not be reflected in 
Complete Closing or in future documents.  

IV. SAVING A DOCUMENT LOCALLY 

A. Windows XP Operating System 

When a document appears in the Document Viewer, select Send To or Send All To and then 
select Word, Outlook, or PDF 

B. Windows Vista or Windows 7 Operating System 

Select File > Save As or File > Save Current as PDF. Select your desired local drive and folder. 

Click sub-tabs to 
view documents. 
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V. PROMPTS TAB  

A. When a document containing a prompt is selected to print, the user will enter the answer at the 
prompt and the answer will appear in the document. The answer is then saved in the Prompts tab. 
If the document is reprinted, the prompt will not display again.  

B. The Prompts tab is used to edit or view answers entered in a prompt. The Prompts tab displays a 
list of previously printed documents that contain answers to prompts.  

 NOTE: The Prompts tab displays only if a document containing a prompt has been printed 
and the prompt was answered. 

C. To edit the answers to a prompt in a previously printed document: 

1. Select the Prompts tab. 

2. Click the Plus button in front of the document. The answer appears in green. 

3. Click in the green data field and enter the new answer. 

4. When finished, click the Print Documents tab and select the document(s) to print. The 
document will now contain the new answer. 

D. To delete the data in a prompt: 

1. Right-click the green answer and select Delete or press <Ctrl>+<Del>.  

2. If the data in a prompt has been deleted, you will receive a new prompt the next time the 
document is selected to print. 
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VI. DOCUMENT HISTORY 

The Display Change Log button,  located at the bottom left corner, displays a history of any changes 
that have been made to a prompt. 

 
VII. ADDITIONAL FEATURES 

A.  Select Document: Double-click or click the Select icon to move the document to the print list 
on the right  

B.  Clear Selections: Clears all documents in the print list on the right. 

C.  Delete Current Selection Only: Clears only selected documents in the print list on the right. 

D.  Print Documents: Selected documents open in the Document Viewer and can be 
printed, saved locally, or sent by e-mail as an attachment. 

E.  Print w/o View: Selected documents are sent directly to the printer without 
displaying in the Document Viewer. 

F.  Publish to PaperlessCloser: Selected documents are available in PaperlessCloser. 

VIII. PRINT DOCUMENTS LIST 

A. Following is a list of all documents located in the Print Documents list. 
ATG Order Confirmation 

ATG Pkg. Closing Docs 

ATG Pkg. Closing Docs 2 

ATG Pkg. Commit 06 2010 Invoice 

ATG Pkg. Commitment 06 

ATG Pkg. Loan Pol 06 

ATG Pkg. Loan Policy 

ATG Pkg. Loan Policy Indiana 

ATG Pkg. One Loan Policy 2 Mortgages 

ATG Pkg. One Loan Policy 2 mortgages 06 

ATG Pkg. Owner’s Pol 06 

ATG Pkg. Two Loan Policies 2 Mortgs. 06 

ATG Pkg. WI Closing Docs. 

ATG Pkg. WI Loan Pol 06 

ATG Pkg. WI Owner’s Pol 06 

ATG Pkg. Commitment 2 Mortgs. 06 

ATG PO Member Policy Transmittal 

ATG PO OH Title Policy Transmittal 

ATG Receipts and Disb 

ATG Wire Instructions Champaign 

ATG Wire Instructions Chicago 

ATG Wire Instructions Commercial 

ATG_Owner’s Policy_Package 2006 

DOC 1099S Blank 

DOC 1099S Document 

DOC Accounting Info Services 

Doc Additional Title Charges 

DOC Affidavit in Lieu of Survey 

DOC Affidavit No New Improvements 

DOC Affidavit of Identity 

Doc Affidavit of Title 

DOC Agency Escrow Agreement 

DOC Agency Escrow Member Closer 

DOC ALTA Statement 

DOC ATG 24 Mo Conv Chain of Title 

DOC ATG 24 Mo Inv Conv Chain of Title 

DOC ATG FAC 

Doc ATG Fax 

DOC ATG Payoff Loan 1 - Champaign 

DOC ATG Payoff Loan 1- Chicago 

DOC ATG Payoff Loan 2- Champaign 

DOC ATG Payoff Loan 2- Chicago 
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DOC ATG Search Invoice 

DOC ATG Search Invoice Champaign 

DOC ATG Search Invoice Window 

Doc ATG Search Request 

DOC Bill of Sale 

Doc Bill of Sale Corp 

Doc Bill of Sale LLC 

DOC Buyer Policy Transmittal 

DOC Buyer Pre Closing Instructions 

DOC Cert No Info Reporting Blank 

DOC Certificate of Release (ATG Only) 

DOC Certificate of Release (Member) 

DOC Certification No Info Reporting 

DOC Chicago Transfer Declaration (New) 

DOC Closing Info Request Lender 

DOC Closing Info Request Member 

DOC Closing Statement 

DOC Construction Escrow Package 

DOC Cook County Transfer Dec (New) 

DOC CPL 

DOC CPL (Champaign) 

DOC CPL (Chicago) 

DOC Deed Corp Warranty 

DOC Deed Indiv to Corporate 

DOC Deed LLC Warranty 

DOC Deed Trust Quit Claim 

DOC Deed Trust Warranty 

DOC Deed Trustee’s 

DOC Deed-Administrator’s 

DOC Deed-Executor’s 

DOC Deed-Quitclaim 

DOC Deed-Special Warranty 

DOC Deed-Warranty Indiv-Indiv 

DOC Deed-Warranty Tenants in Common 

DOC Deed-Warranty-Joint Tenancy 

DOC Deed-Warranty-Tenancy by Entirety 

DOC Directions to Invest Funds 

DOC Disclosure Attorney Title Agent 

DOC Disclosure from Services 

DOC Disclosure from Services-Refi 

DOC Disclosure of Radon Hazard 

DOC Errors & Omissions Champaign 

DOC Errors & Omissions Chicago 

DOC Escrow Statement 

DOC Fax Cover 

DOC First Lien Letter 

DOC Foreign Transferor Affidavit-Entity 

DOC Foreign Transferor Affidavit-Indiv 

DOC Grantor/Grantee Statement 

DOC HUD Signature BLANK 

DOC HUD-1a Buyer’s Settlement Statement 

DOC Indemnity Agreement 

DOC Initial CPI 

DOC Initial CPI Regional 

DOC Initial CPI Instructions 

DOC Initial CPI NLT 

DOC Initial Search Report 

DOC Initial Search Report Metro East 

DOC Inv 2010 BO Chicago Area 

DOC Inv 2010 BO Sep Search 

DOC Inv 2010 NBO Chicago Area 

DOC Inv 2010 NBO Sep Search 

DOC Inv For Title BO Chicago Area 

DOC Inv for Title BO Sep Search 

DOC Inv For Title NBO Chicago Area 

DOC Inv For Title NBO Sep Search 

DOC Invoice Services REFI 

DOC Invoice Services REFI NBO 

DOC Joint Tenancy Affidavit 

DOC Later Date Search Report 

DOC Later Date Search Request 

DOC Later Date Search Request-Notesw 

DOC Legal Description 

DOC Lender Closing Transmittal 

DOC Lender Policy Transmittal 

DOC Letter Invoice 

DOC Letter Report 

DOC Loan Modification Invoice 

DOC Member 1st Loan Payoff From Check 

DOC Member 24 Mo Conv Chain of Title 

DOC Member 24 Mo Inv Conv Chain of Title 

DOC Member 2nd Loan Payoff From Check 

DOC Member Closer Transmittal 

DOC Member in Good Standing 

DOC Member Loan Policy Transmittal 

DOC Member Owner’s Policy Transmittal 

DOC Member Order Confirmation 

DOC Member Payoff Manual Loan 

DOC Notarial Record 

DOC Notes for Information 
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DOC Order Information Request 

DOC Owner’s Policy Transmittal 

DOC Payoff Request Letter 

DOC Personal Information Affidavit 

DOC Personal Undertaking 

DOC Personal Undertaking (Gap) 

DOC Power of Attorney Il Short From 

DOC Privacy Notice 

DOC PTax 

DOC SB1167 Borrower Exemp Affidavit 

DOC SB1167 Borrower List of Notices 

DOC SB1167 Closer Compliance Checklist 

DOC SB1167 Closer Exempt Checklist 

DOC SB1167 Lender Exempt Affidavit 

DOC Solicitation of Taxpayer ID 

DOC Survey Request 

DOC Tenancy Entirety Affidavit 

DOC Water and Zoning Application 

DocsCC_ATGHH1 

END Against Loss - Encroachment 

END Against Loss Liens/Encumb 

END Arbitration Modification 

END Balloon Mortgage 1 

END Commercial EPL 

END Comprehensive 1 

END Construction Loan Disbursement 

END Contiguity 1 

END Cross Liability 

END Date Down 1 

END Date Down 2 

END Encroachment Note 

END EPL (Indiana) 

END EPL (Wisconsin) 

END Estate Planning Conveyance 

END Form E 

END Future Advances 

END Gap Coverage 

END Gap Undertaking Commercial 

END Homestead 

END Inflation 

END Inst Contract Purchaser’s “A” 

END Inst Contract Purchaser’s “B” 

END Legal Description 

END Owner’s Comprehensive 

END Owner’s Comp 1B Commercial 

END P.I.N. 

END Restrictions 3 

END Revolving Credit 1 

END Revolving Credit 2 

END Std Exception Waiver 1 

END Std Exception Waiver 2 

END Survey 

END USA 

END Usury 

END06 Access-Direct/ALTA 17 

END06 Access-Indirect/ALTA 17.1 

END06 Assign-Date Down/ALTA 10.1 

END06 Assignment/ALTA 10 

END06 Comprehensive 1 

END06 Condominium/ALTA 4 

END06 Condominium2/ALTA 4.1 

END06 EPL/ALTA 8.1 

END06 First Loss-Multiple/ALTA 20 

END06 Fut Adv-Knowl/ALTA 14.1 

END06 Fut Adv-LOC/ALTA 14.2 

END06 Fut Adv-Priority/ALTA 14 

END06 Fut Adv-Rev Mort/ALTA 14.3 

END06 Leasehold-Loan/ALTA 13.1 

END06 Leasehold-Owner/ALTA 13 

END06 Location-Map/ALTA 22.1 

END06 Location/ALTA 22 

END06 Mezzanine Finance/ALTA 16 

END06 Mfd Hous-Con-Loan/ALTA 7.2 

END06 Mfd Hous-Con-Owner/ALTA 7.1 

END06 Mfd Hous/ALTA 7 

END06 Mortgage Mod/ALTA 11 

END06 Multiple Mortgage 

END06 NonImput-Add Insured/ALTA 15.1 

END06 NonImput-Full Equity/ALTA 15 

END06 NonImput-Part Equity/ALTA 15.2 

END06 PUD/ALTA5 

END06 PUD2/ALTA 5.1 

END06 REM-Improv-Owner/ALTA 9.2 

END06 REM-Improv-Owner/ALTA 9.5 

END06 REM-Loan/ALTA 9.3 

END06 REM-Unimp-Owner/ALTA 9.1 

END06 REM/ALTA 9 

END06 REM/Unimp-Owner/ALTA 9.4 

END06 Street Assessment/ALTA 1 

END06 Subdivision 
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END06 Tax Parcel-Multiple/ALTA 18.1 

END06 Tax Parcel-Single/ALTA 18 

END06 Truth-In-Lending/ALTA 2 

END06 Utility Facility 

END06 Var Rate Mortgage/ALTA 6 

END06 Var Rate Mortgage/ALTA 6.2 

END06 Zoning-Improved/ALTA 3.1 

END06 Zoning-Unimproved/ALTA 3 

MEO 24 Month Search Invoice 

MEO 24 Month Search Report 

MEO Buyer Policy Transmittal 

MEO Closing Info Request Member 

MEO Closing Info Request Lender 

MEO Escrow statement 

MEO Initial Search Report Metro East 

MEO Later Date Search Report 

MEO Lender Policy Transmittal 

MEO Member Policy Transmittal 

MEO Search Invoice 

MEO Wire Instructions 

NEW 05-09-19 Commit Prep Instruct 

NEW 05-09-19 DFI Compliance HUD.rtf 

NEW 05-09-19 HUD 1200-1300 

NEW 05-10-03 File Tracker 

NEW 05-10-03 Services 

NEW 05-10-03 Single Payee 

NEW 05-10-03 Void Change 

NEW 05-10-07 Illinois Transfer Tax-Invoice 

NEW 06-02-09 1099 Update 

NEW 06-05-22 New 1099S Form 

NEW 06-07-01 New Documents 

NEW 06-11-06 HUD and Check Writing 
Access 

NEW 06-12-11 Request a Closing 

NEW 06-12-13 1099 Reporting 

NEW 07-02-08 2006 ALTA Forms 

New 08-04-28 Transfer Tax Application 

New 09-04-28 Closing Statement 

NEW 09-11-09 SpeedHUD 

NLT Att Inv 2010-Rockford 

NLT Att Inv-Rockford 

NLT Commitment Schedule A 

NLT CPL Rockford 

NLT CPL-Belvidere 

NLT CPL-Crystal Lake 

NLT Directions to Invest Funds 

NLT Fax Cover 

NLT Initial Search Report Crystal Lake 

NLT Initial Search Report Rockford 

NLT Invoice Search Only 

POL Construction Loan 

POL Notes for Information 

POL06 Commitment A Schedule 

POL06 Commitment A Schedule 2 Mtgs 

POL06 Commitment B Schedule 

POL06 Commitment Cover 

POL06 Loan Cover 

POL06 Loan Sched A 2 Mortgages 

POL06 Loan Schedule A 

POL06 Loan Schedule A 2nd 

POL06 Loan Schedule B 

POL06 Loan Schedule B 2nd 

POL06 Loan Schedule B, Part II 

POL06 Loan Short Form Policy 

POL06 Owner Cover 

POL06 Owner Schedule A 

POL06 Owner Schedule B 

Power of Attorney 

RESB Package 

Tonner Closing Package 

WI Aff - Affidavit of Title 

WI Aff - Deed Correction 

WI Aff - Judgments and Liens 

WI Aff - Lien and Possession (ALTA) 

WI Aff - Personal Information 

WI Aff - Signature Affidavit 

WI ATG - 2006 Short Form Loan 

WI ATG Pkg - 2006 Commitment 

WI ATG Pkg - 2006 Loan Policy 

WI ATG Pkg - 2006 Owners Policy 

WI ATG Pkg - Closing Documents 

WI ATG Pkg - GAP 

WI Deed - Condominium 

WI Deed - Guardian’s 

WI Deed - Personal Representative’s 

WI Deed - Quit Claim 

WI Deed - Special Warranty 

WI Deed - Trustee’s 

WI Deed - Warranty Form 1 

WI Deed - Warranty Form 2 
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WI Docs - Accounting Info Services 

WI Docs - Certification No Reporting 

WI Docs - Condominium Certificate 

WI Docs - Const Loan Disbursement 

WI Docs - CPL 

WI Docs - Escrow Agreement 

WI Docs - Informed Consent 

WI Docs - Initial Search Report 

WI Docs - Invoice 

WI Docs - Land Contract 

WI Docs - Land Contract Condominium 

WI Docs - Personal Undertaking 

WI Docs - Privacy Statement 

WI Docs - Satisfaction of Mortgage 

WI Docs - Special Assess/Tax Report 

WI End - Comprehensive 

WI End - Date Down 1 

WI End - Date Down 2 

WI End - GAP 

WI End 06 - EPL 

WI End 06 - Location 

WI End 06 - REM 

WI Homestead Affidavit 

WI Member - Nova Title Short Form Pkg 

WI Title Services Order Confirmation 

 NOTE: Documents are added to REsource upon request or as needed. To request a new 
document, contact a Member Representative or the HelpDesk and provide a sample of the 
document. 

B. REsource Documents  

REsource documents are organized by prefix.  

1. ATG 

Groupings or packages of related documents 

2. DOC 

Closing Documents, Affidavits, Powers of Attorney, Invoices, Transfer Documents 

3. END 

Endorsements 

4. NEW 

Instructions or announcements regarding new release information in REsource 

5. POL 

Commitment and Policy Schedules and Jackets 

6. WI 

Wisconsin Documents 
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7 | HUD-1 SETTLEMENT STATEMENT 

The 2010 HUD Settlement Statement is used to enter all the information necessary to produce a HUD-1 
Settlement Statement. There are two versions of the HUD-1 in REsource version 6.5. They are called the 2010 
HUD and the Speed HUD. The 2010 HUD conforms to the new RESPA Rules in effect January 1, 2010. The 
Speed HUD can only be used for cash or commercial transactions or transactions closed prior to January 1, 2010 
or if the loan application was taken prior to January 1, 2010.  

Files opened after March 26, 2010, default to the 2010 HUD. 

I. DATA REQUIRED 

As with the HUD in previous versions of REsource, specific data must be entered in Order Entry and 

ATG Edit Services  for title charges to appear on the 2010 HUD or the Speed HUD.  

The following process should be followed for either HUD. 

A. Required data in Order Entry: 

1. Sale Price* 

2. Loan Amount* 

3. Interest Rate (required for the GFE) 

4. Principal & Interest (required for the GFE)  

5. Earnest Money, including who is holding the earnest money and if it should be deducted 
from the commission 

6. Property Address, including County* 

*Required data prior to opening ATG Edit Services 

B. Required data in ATG Edit Services:   

1. Endorsements 

2. Closing Services 

3. Search Services 

4. Recording Fees  

5. Miscellaneous entries, if any 

II. TO CHANGE THE TYPE OF HUD 

A. Close all open windows 

B. Click Utilities >Additional Fields. 
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C. Enter “Y” or “N” in the Use HUD 2010 field and close. 

 
 IMPORTANT NOTE: Any data entered in the previous HUD will not pull through to the 

new HUD; therefore, it must be re-entered. Also, any services selected in the ATG Edit 
Services menu  must be re-selected. You must go back to ATG Edit Services  and re-
select all services after changing the HUD type. 

III. INVOICE FOR TITLE CHARGES 

There are now two types of invoices available; one for the 2010 HUD and one for the Speed HUD. You 
must use the invoice based upon the type of HUD. 

A. 2010 HUD Invoice 

1. Doc Invoice 2010 BO Chicago Area 

2. Doc Invoice 2010 NBO Chicago Area 

3. Doc Invoice 2010 BO Separate Search 

4. Doc Invoice 2010 NBO Separate Search 

B. Speed HUD Invoice 

1. DOC Inv For Title BO Chicago area 

2. DOC Inv For Title NBO Chicago area 

3. DOC Inv For Title BO Sep Search 

4. DOC Inv For Title NBO Sep Search 

IV. FILE LOCKING 

File locking has been added to prevent multiple users from entering data at the same time to the same file. 
To insure that you are leaving your current file available for other users, either log out of REsource or 
select the Temporary File option  from the REsource menu bar.  

V. HUD SETTLEMENT STATEMENT SCREEN 

A. The 2010 HUD layout is similar to a printed HUD document. There are three tabs: Page One, 
Page Two, and Page Three (GFE).  

 
 

Task Bar 

Use 2010 HUD 
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B. To assist you in navigating quickly within the 2010 HUD screen, there are a number of toolbar 
buttons, identified below. The figure below identifies all of the buttons on the 2010 HUD screen. 
The Expand All Sections  and Contract All Sections  buttons are only visible on the 
Page Two tab. 

 

 

 

 
           

 

 

 

 

1. Print HUD Statement   

a. Click this button to view/print the entire HUD.  

b. To print only the Buyer’s HUD or Seller’s HUD directly to the printer, click the 
drop-down arrow on the Print HUD button,  and select from the drop-
down list. 

 

2. Publish the HUD Statements to PaperlessCloser  

a. Click this button to publish HUD to PaperlessCloser.  

b. To publish only the Buyer’s HUD or Seller’s HUD, click the drop-down arrow  
on the Publish HUD Statement to PaperlessCloser button and select from the 
drop-down list. 

 

3. Use a Template  

Click this button if a HUD template has been defined with appropriate defaults for this 
HUD. 

4. Switch to HUD-1  

Click this button to Switch to HUD-1.  

5. Switch to HUD-1A  Not in use at this time. 

Click this button to change the HUD to a simplified 1-A format. This form displays only 
borrower/lender information and the form has some different sub-tabs, as well as blocked 
access to other tabs. You can only enter information into the tabs/fields that pertain to 
buyer or borrower. 

HUD-1 Addendum 

Refresh 

Jump to Section 

HUD Change Log 

Lock/Unlock 

3rd Party Payee 

WARNING: Proration 
Override Exists. 

WARNING: Sale Price/ 
Loan Amount Changed. HUD Status Help Lender Breakdown 

Use HUD-1/1A 

Use Template 

Print Preview HUD 

Print HUD 

Publish HUD 

Title Services Report 

GFE Bucket Allocation 
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6. Paid by Other Parties  

Click this button to pull up the Paid By screen in any section of the HUD that requires 
designating a party to pay a fee for the buyer or seller. This feature is not recommended. 
For further assistance, please contact the REsource HelpDesk. 

7. Show Lender Breakdown Report  

Click this button to preview the Lender Breakdown Report. The report shows the 
expected loan amount and the lender’s check amount before creating Receipts and 
Disbursements in Check Writing. 

8. Lock/Unlock the HUD 

a. Click the Lock button  to lock the HUD so it cannot be altered.  

b. Click the Unlock button  to edit the HUD.  

When you lock or unlock the HUD, a confirmation message displays. Click Yes to 
confirm and continue. 

9. Navigation 

a. Use the shortcut keys or the Jump to Next Section button  (located on the 
toolbar) to move through the 2010 HUD. Click the button to move to the next 
HUD section or click the drop-down arrow to display the Navigation drop-down 
list to move to desired HUD section by clicking on number on the list.  

 
b. Move through the fields on the 2010 HUD by pressing <Tab> key on your 

keyboard or by clicking your mouse on the desired line or section. 

c. When text is too long to be displayed in full, an ellipsis (…) appears at the end of 
the displayed text. The text can be viewed by rolling the mouse over the 
truncated text. 

d. Read-only fields are indicated with shading. Some information in the shaded 
areas can be overridden. 

10. Recalculation 

Click the Refresh button  to recalculate all items on the HUD. 
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11. Current Status of the HUD 

Click the Status drop-down  to change the status of the 
HUD.  

 WARNING: This Warning button  will display if the Sale price or Loan Amount 
has changed. Return to ATG Edit Services to auto-calculate premiums. (Uncheck 
and recheck closing fee.) 

C. Buttons within the HUD 

Within the 2010 HUD, there are several buttons that may display, depending on the section in 
which your cursor is placed. 

All buttons and icons offer hints as to their functionality when you hold your cursor over the 
button/icon. 

1. Add New Line to the HUD.  

When you click this button, a new line is placed at the end of the selected section. 
Available in Page Two tab only.  

2. Delete a line in the HUD.  

Click Yes to the delete prompt. Available in Page Two tab only. 

3. Insert New Line into the HUD.  

When you click this button, a new line is inserted above the line in which your cursor is 
placed. If you try to insert a line in an inappropriate place, an error message will appear. 
Available in Page Two tab only. 

4. Set Override  

When you click this button, the override is applied. The particular override depends on 
the section of the HUD in which it is used. Available in Page Two tab only. 

5. Set Partial Override  

When you click this button, the partial override is applied. Available in Page Two tab 
only. 

6. Clear Override  

When you click this button, the full or partial override is cleared. Available in Page Two 
tab only. 

7. Calendar  

Click to open and make date selection. 

D. Additional Icons  

These additional icons may appear on the 2010 HUD: 

 
Payee missing. Displays on a line to remind you that a payee has not been entered for that 
line. 

 
Debit/Credit. Displays on a line that is a debit/credit.  

 

If you enter a payee in a debit/credit line, the debit/credit no longer displays. 
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E. 2010 HUD Page One  

1. Page One Tab: Sections 100-500  

The Page One tab contains: 

a. Type of Loan 

Click the appropriate check box. 

b. Funding Date 

Enter the date the loan is funded (disbursed). 

c. Status 

Select the current HUD Status from the drop-down list. 

d. Property Location, Borrower, Seller, Sale Price, Earnest Money, Lender 
Information (including Loan and Mortgage Ins Case Numbers) 

Entered and edited in Order Entry. 

e. Settlement Information and Date 

Entered and edited in Order Entry. 

f. Sections 100a, 100b, 200a, 200b, 400a, 400b, 500a, 500b 

These tabs automatically import data from entries in Sections 700-1300. 

2. Enter Additional Line Items:  

a. Click on or <Tab> to the blank line(s) available and enter an Item Description. 

b. Press <Tab>. The POC checkbox appears. 

c. Select this checkbox and enter POC Code, if applicable, and press <Tab>. 

 NOTE: If this checkbox is not selected, it disappears when <Tab> is pressed 
again. 

d. If more lines are needed, use Section 1300 or the Edit Payoff button.  For 
more information on editing payoffs, please refer to the Edit Payoff 
documentation. 

100a: 

 
Maximum number of lines: 105 
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200a:  

 
Maximum number of lines: 209 

3. Section 200a  

a. Complete Closing inserts amounts for Lines 201 and 202 from the information 
entered in the Loan tab in Order Entry. 

i. The description for Line 201 can be changed by typing over the existing 
text. 

ii. To change the Earnest Money amount, go to the Loan tab in Order 
Entry. 

b. Enter Debit/Credit: 

Double click the D/C checkbox and it will copy the item and amount to the 
corresponding line. 

 NOTE: Marking an “X” in the POC field will apply a credit to the Loan 
Amount. 

c. This section also displays the party holding the earnest money, as entered in the 
Order Entry screen, Loan tab, and allows you to change it, if necessary, by 
selecting another option. Click the Expand this Section button located in the 200 
section toolbar to view or edit who is holding the earnest money. 

200b:  

 
Maximum number of lines: 219 
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4. Lines 210, 211/510, 511 

a. Tax Prorations 

i. Click the Prorations dialog button  in the toolbar located to the right 
of the Adjustments for items unpaid by seller section. 

 
(1) The Flex Prorations dialog box opens. 

(2) Enter the Proration Date or check Use Closing Date. 

(3) Click Edit. 

 
(4) Check the Override dates and amount checkbox. 

(5) Click Next. 

 
(6) Payment: Not Yet Due 

(7) Enter the Amount of the tax proration. 
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(8) Click Next. 

 
(9) Enter the dates of the tax proration. 

 
(10) Click Finish. 

Repeat this process for each tax period by moving to the next line. Click 
Close when finished. 

 NOTE: You must click the Refresh button  to display tax 
amounts. 

 NOTE: As with all lines on page one of the HUD, such as tax 
payments disbursed at closing, use the Expand This Section button 

 from the toolbar  located to the right of each section. 

5. Lines 300-303 

Complete Closing automatically updates and calculates these fields. 

 
6. Section 400 

400a: 

 
Maximum number of lines: 405 

 
ATG RESOURCE® User Manual Page 7-9 
© ATG (5/15) 



400b: 

 
Maximum number of lines: 416 

7. Section 500a: Reductions in Amount Due to Seller 

In Section 500a, Complete Closing Line 502, Settlement Charges to Seller is a total of 
charges to Seller from Sections 700 through 1300. Additional lines can be added as 
disbursement or credit items on the Seller side by entering information on Lines 507-509. 
You can also use the Edit Payoff button  to add payoff information as an addendum 
to Section 1300. 

 
Maximum number of lines: 509 

500b: 

 
Maximum number of lines 519 

8. Lines 600-603: Cash at Settlement From/To Seller 

Complete Closing automatically updates and calculates these fields. 
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F. 2010 HUD Page Two  

The Expand All Sections button  must be selected when working on page 2 of the 2010 
HUD. 

 
 

 
1. To enter a negative figure anywhere on the HUD, begin the number with a minus sign (-), 

Negative numbers are displayed in parentheses (###). 

2. Leave all Account Code fields blank. 

3. Additional lines of information can be inserted after the last line in any section of the 
Page Two tab (Sections 700-1300, except 1000) or use the toolbar  
located at the top right of each section. 

a.  Add a line.  

b.  Delete a line. 

c.  Insert a line.  

d.  Override/Clear Override.  

e.  Enter Paid by Other Parties.  

4. Sections 800-1000 

The following codes are used in the POC (Paid Outside of Closing) column within the 
HUD: 

a. “X” to withhold funds from the loan amount; 

b. “B” if the Buyer pays outside of closing; 

c. “S” if the Seller pays outside of closing; 

d. “L” if the Lender pays outside of closing; 

e. “Y” for lender-paid closing costs. 

 NOTE: The code “X” can be used on page one of the HUD for credits to the buyer. 

Expand All Sections Contract All Sections 
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5. Section 700: Broker’s Commission 

a. Line 700: Total amount of commission. 

b. Lines 701-702: Enter the payee(s). 

c. Line 703: Actual amount of commission disbursed. 

 
 NOTE: Commission percentage no longer prints on the 2010 HUD 

document.  

d. Earnest Money 

When entering Earnest Money in the Order Entry/Loan screen, the user will 
receive a pop-up window displaying, “Who is Holding the Earnest Money?” 

i. You must enter the Seller’s Realtor in the Seller tab of Order Entry 
and the Buyer’s Realtor in the Buyer tab of Order Entry for the 
correct calculation of commission and Earnest money to occur 
automatically.  

 
ii. If either Seller’s Realtor or Buyer’s Realtor is selected, a Confirm 

dialog will appear asking if the earnest money amount should be 
deducted from the Realtor’s commission check. 

 
(1) If you select “Yes,” the amount withheld will appear on the 

HUD in Section 700 as a disclosure line.  

When this happens, the system will also place the Earnest 
Money on Line 201 and on Line 506 as a Debit/Credit item for 
the Buyer and Seller. (See RESPA directive.) 
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(2) If you select “No,” the amount will appear on Line 507 as 
“(EMD $ 00.00 Disbursed as Proceeds).” 

 
6. Section 800: Items Payable in Connection with Loan 

a. For all items in Section 800, the payee defaults to the first lender. It is not 
necessary to enter a payee in the Payee column unless you want to change it to a 
different payee.  

 NOTE: Switch to the Expand All view  in this section to more easily use 
the Clear Override button.  

 
b. In Section 800, items are listed by the lender mainly from GFE #3. POC items 

are still handled the same. 

i. 801 Breakout Charges 

(1) The 801 Breakout Charges feature allow items included in line 
801 to be broken out in Check Writing but not disclosed on the 
HUD. To breakout charges for Line 801 and not disclose them 
on the HUD, select the 801 Breakout Charges screen  
located in the 800 toolbar . 

(2) On the 801 Breakout Charges screen, enter fees that are 
payable to other parties. In Check Writing, the items entered 
here are deducted from the disbursed check paid to the payee on 
Line 801. 

(3) In this example, the total amount on Line 801 is $1,000.00 to 
ABC Lender. However out of that total amount, $100.00 should 
be disbursed to Document Preparer, Inc., and $100.00 should be 
disbursed to Mortgage 1 Network.  

(4) In Check Writing, the amount to ABC Lender will be $800.00 
and separate checks will be created to Document Preparer Inc. 
for $100.00 and Mortgage 1 Network for $100.00. 
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(5) Additionally, the code “Y” in the Who POC field will add the 
amount to the lender’s funds and create a check to the payee in 
Check Writing. And, the code “X” in the Who POC field will 
deduct the amount from the Lender’s funds in Check Writing. 

 
(6) The Origination Charges Report prints an itemized list of fees 

that are included on Line 801. To print the Origination Charges 
Report click the Print  button located on the 801 Breakout 
Charges screen. 

ii. Lines 801 and 802 display the amounts outside the columns with their 
total displayed on Line 803. 

(1) Payees, along with POC X, must be placed on Lines 801 and 
802, as the check for these lines come from that field and not 
from Line 803.  

(2) Yield Spread and Broker Fee are no longer displayed as a 
single line item. The amount is rolled into Line 802. 

(a) It will be a positive number if the buyer is paying points. 

(b) It will be a negative for any credit from the lender to the 
buyer, including the Yield Spread. (See RESPA 
Directive.) 

iii. Additional Lines Dialog 

 
You can add new lines to this section. When you do, an Additional 
Lines dialog appears, giving you the option to select a GFE #3 item 
(inside the column), a General Line item (inside the column), or a 
Disclosure line for information as needed (outside the column). 

7. Section 900: Items Required by Lender to be Paid in Advance 

Enter the daily interest charge or a percentage and the 2010 HUD will calculate the 
amount per day. Click the Set Line 901 Override button  or press <Ctrl>+<O> to 
override the read only information in the Paid From Borrower’s Fund at Settlement 
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column. Click the Clear Line 901 Override button  or press <Ctrl>+<O> to remove 
the overridden information in Line 901. 

a. Line 901: Interest  

Enter the beginning and ending dates for interest using the Calendar button  
or entering the year in two-digit format. 

 
b. Lines 902 and 903: Mortgage and Homeowner’s Insurance Premiums 

i. Premium amounts entered in these lines will transfer the monthly amount 
to Lines 1001 and 1002. 

ii. Select the MIP checkbox on Line 902 when a Lump Sum MIP payment 
is made at settlement. The line should read ‘“MIP for Life of Loan.” (See 
RESPA Directive.) Lines 901 and 903 come from the GFE #10 and #11, 
respectively. 

8. Section 1000: Reserves Deposited with Lender 

 
ALL numbers will be outside the column except for Line 1001, which is a roll-up line 
totaling all of the items in Section 1000. Line 1001 comes from the GFE #9. The number 
of months, the monthly amount, and the total for that line roll-up to Line 1001. POCs are 
also on a per line basis in this section. Click the Override button  or press 
<Ctrl>+<O> to override this section. 

9. Section 1100: Title Charges 

 
a. Line 1101 is a roll-up line of items that are from the GFE #4. Line 1103 is also 

referenced by the GFE #5, which includes Lines 1102, 1104, additional lines, 
and any lines added that are directed by GFE #4. 

i. The fees for the Owner’s Policy and Loan Policy plus endorsements and 
other title-related services selected in ATG Edit Services populate the 
Premium Information screen and additional fees, such as a 24-month 
Chain of Title and other miscellaneous items, populate the Additional 
Title Services screen. All fees also populate the assigned HUD lines. 
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 REMINDER: Select all services, including endorsements, closing 
services, recording fees, etc., in ATG Edit Services to automatically 
populate the HUD. 

ii. Premium Information 

(1) To obtain premium information, click the Premium 
Information button  in the toolbar  
located at the top right of Section 1100. 

Sample Premium Information from ATG Edit Services 

 
(2) Services displayed in the Premium Information screen 

populate from the ATG Edit Services screen. Edits should be 
made in the ATG Services screen. 

(3) Click the Print button  to print an itemization of services 
listed in the Premium Information screen. 

iii. Additional Title Services 

(1) The Additional Title Services screen allows you to enter 
additional charges on Line 1101. Amounts entered in the 
Borrower column display in Borrower column on Line 1101 
and amounts entered in the Seller column display in Seller 
column on Line 1101. By default, the payee will populate with 
the payee from Line 1101; however, different payees can be 
selected and Check Writing will create separate checks. 

(2) Select all items in Edit Services.  All selected services will 
populate the Additional Title Services window except those 

items that populate the Premium Information  or the 1200 
section of the HUD.  

 NOTE: Miscellaneous items entered in the Edit Services 
screen populate Section 1300 of the HUD or the Additional 
Title Services screen. 
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(3) To open the Additional Title Services screen, click the 
Additional Title Services button  located on the toolbar

 in Section 1100. 

(4) Enter the payees for items that populate from Services. 

(5) To add items manually, use the plus  button to add 
items and the minus button  to delete items. Enter the 
description, payee, and amount for each item. Click OK when 
finished. 

 
(6) The Title Services Report prints an itemized list of fees that are 

included on Line 1101. To print the Title Services Report, click 
the Print button  located in the Additional Title Services 
screen. 

b. Line 1102: Settlement or Closing Fee 

Line 1102 displays the Settlement and Closing Fee and rolls up to Line 1101. 
Select either Full Closing or Member Closer in ATG Edit Services. The 
closing fee will calculate based on the sale price and populates Line 1102. 

c. Line 1103: Owner’s Title Insurance 

i. The Owner’s title insurance fees can be shown in the Buyer or Seller 
column, depending on the GFE provided by the lender. By default, the 
Owner’s title insurance fees appear in the Buyer column.  

ii. If the Owner’s title insurance fee is a GFE #5 item, it should remain in 
the Buyer column. A corresponding credit will automatically appear in 
Sections 200 and 500 on page 1 of the HUD. 

 
iii. If the Owner’s title insurance fee is not on the lender’s GFE, it can be 

placed in the Seller column. 

 
ATG RESOURCE® User Manual Page 7-17 
© ATG (5/15) 



iv. To override the party responsible for payment of the Owner’s title 
insurance fee, click the Premium button  on the Section 1100 toolbar 

 and change the Who Pays override to Seller Pays 
– Non GFE Item. 

 
 NOTE: You must then override Line 1103 to remove the Owner’s title 

insurance fee from the Buyer column and enter the Owner’s title insurance 
fee manually in Seller Column. 

d. Line 1104: Lender’s Title Insurance; displays outside the column. 

e. Lines 1103 and 1104 auto fill if the Premiums calculator is used. If not, press 
<Ctrl>+<O> or click the Override button  to manually enter the amounts.  

f. Lines 1105 and 1106 display the total premium, including endorsements. 

g. Lines 1107 and 1108 display the Agent portion and the Underwriter’s portion, 
respectively. The lines auto-populate if ATG Edit Services has been utilized. To 
override, press <Ctrl>+<O> or click the Override button.  

 
h. Additional Lines 

 
When a new line is added to this section, an Additional Lines dialog appears, 
providing the option to select: 

i. GFE #4: items will appear outside the column and roll up to Line 1101; 

ii. GFE #5: items will appear outside the column and rolls up to Line 1103; 

iii. General Line: items will appear inside the column and do not roll up to 
either line; or  

iv. Disclosure: line will allow for typing data for informational purposes 
only.  

 
Page 7-18 ATG REsource® User Manual 
 © ATG (5/15) 



i. Premiums 

Click the Premiums button to view the Owner’s and Loan Policy premiums. 
Complete Closing pulls figures based on your rates that were calculated in ATG 
Edit Services. Premiums are based on sale price, loan amount, and county of the 
property entered in Order Entry. 

j. Endorsements 

Select endorsements in ATG Edit Services. 

10. Section 1200: Government Recording and Transfer charges  

 
a. Recording Fees 

i. All Buyer recording fees roll up to Line 1201, which is also referenced 
by GFE #7. Additional Fields can be used for calculating the page count 
totals for Line 1202. 

ii. Recording fees, if entered in ATG Edit Services, populate the 
appropriate HUD lines. They can also be entered manually. Be sure to 
enter the correct payee. 

b. Transfer Taxes 

i. Appropriate State, County, and Municipal transfer taxes populate the 
HUD on Lines 1204, 1205, 1211, and 1212. 

ii. State and County transfer taxes populate as Seller charges by default. 
They may be moved to the Buyer column by deleting the amounts in the  
Seller column.  

c. Line 1203 is a roll-up line including the total of all taxes, also from GFE #8. 

d. Additional Lines 
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When a new line is added to this section, an Additional Lines dialog appears, 
providing the option to select Recording Charge (outside the column and 
included on Line 1201), Transfer Tax (outside the column and included on Line 
1203), or General HUD Line (inside the column and not included on Lines 1201 
or 1203). 

11. Section 1300: Additional Charges 

a. Use Section 1300 to enter miscellaneous additional charges. 

 
b. Line 1301 (GFE #6) totals of all GFE #6 items. These line items are displayed 

outside the column. 

 

 
c. Additional Lines 

General Lines can be added that print inside the column and do not roll up. For 
each line added, specify the type of line desired. 

d. Section 1400 

Section 1400 shows the total charges from Line 103 (Section J) and Line 502 
(Section K). 

G. GFE Bucket Allocation 

1. The GFE Bucket Allocation screen allows you to designate GFE lines on Page 2 to the 
appropriate section/bucket on Page 3. The items that display in this screen are HUD lines 
labeled as GFE from Page 2 paid for by the borrower, plus any amounts that are shown 
as POC paid by or on behalf of the borrower. 

2. Sections 900, 1000, 1100, and 1200 pull rollup lines to this screen and Sections 800 and 
1300 pull itemized lines to the screen. 

 NOTE: Lines 801, 802, 803, 1201, 1203, 1001, 901, and 903 do not display in the 
GFE Bucket Allocation screen. These lines are required and automatically display 
on Page 3 in the designated section determined by RESPA. 

3. To open the GFE Bucket Allocation screen, click the GFE Bucket Allocation button 
 located on the main toolbar.  

 
The button is highlighted in yellow to alert you when items need to be allocated to the 
appropriate section on Page 3. 

 
Page 7-20 ATG REsource® User Manual 
 © ATG (5/15) 



 
4. Select the appropriate bucket for each item by clicking the drop-down arrow in the 

Bucket column. The choice is either 10% Tolerance (Bucket 2) or Can Change (Bucket 
3).  

5. When finished: 

a. Click OK to move the items from the Allocation screen to Page 3; 

b. Click Apply to move the items from the Allocation screen to Page 3 and keep 
the screen open; or 

6. Click Cancel to exit the screen without saving changes. 

H. Page 3 

 
Each section of Page 3 has a toolbar that allows a line to be added, deleted, inserted, or 

overridden.  Hover over the title bar to activate the toolbar. 

GFE/HUD Comparison Input Form 
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1. The first section is for Charges That Cannot Increase from the GFE. 

 
a. When opening page 3, the HUD-1 column automatically populates Lines 801, 

802, 803, and 1203. 

b. You must enter the amounts in the Good Faith Estimate column. These amounts 
should be the same as the amounts shown in the HUD-1 column. 

2. The next section is for Charges That in Total Cannot Increase More Than 10%. 

 
a. HUD line items populate the amount in the last column. Line 1201 is an 

automatic line. 

b. Lines can be added by clicking the line number, tabbing down, and entering 
another HUD line number, which will fill in the description and the HUD 
amount. Charges listed on the GFE must be added manually. 

c. Lines can also be added using the toolbar that appears when the mouse is moved 
to the right of the HUD-1 column heading.  

 
d. The totals appear at the bottom of the section along with the Increase between 

GFE and HUD-1 Charges, shown as both a dollar amount and a percentage, 
showing if the increase is within tolerance. You will then need to make the 
necessary adjustments. 

3. The third section is used for Charges That Can Change.  

 
a. Lines 1001, 901, and 903 are required lines and populate automatically. 

b. You must enter the GFE amount.  

c. Lines can be added by clicking the line number, tabbing down, and entering 
another HUD line number, which will fill in the description and the HUD 
amount. You will need to add the charges listed on the GFE. 

d. Lines can also be added using the toolbar that appears when the mouse is moved 
to the right of the HUD-1 column heading.  

 
4. The fourth section is used for Loan Terms Info for HUD-1/HUD-1A Form. 

a. The Initial Loan Amount, Loan Term, and Initial Interest Rate automatically 
populate from the Order Entry/Loan screen. All other amounts must be entered 
manually. 

b. Yes/No Drop-downs 

i. Selecting Yes activates a series of sub-fields that must be filled in. 
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ii. Subfields are inactive (greyed out) when No is selected.  

 

 
I. HUD-1 Addendum 

1. Use the Addendum screen to itemize or breakdown charges referenced on the HUD-1, 
such as seller paid closing costs or to comply with VA requirements. 

a. To open the Addendum screen, click the HUD Addendum button  on the 
main toolbar. 

b. Enter a description in the Description of Charges field, itemized on this 
addendum, such as the HUD line number and/or the description from the HUD 
line you are itemizing. The number of addendums for this order displays. 

c. To add charges from the HUD-1, enter the HUD Line Number. The amount and 
description automatically populates based on the HUD-1 amount.  

 NOTE: The HUD-1 Amount field is read-only and cannot be changed. 

d. Enter the HUD line number or description of the item that is part of the grouped 
charge or credit. 

e. Enter the amount of the item in the Addendum Amount field. Continue entering 
items as necessary. 
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2. Use the  button to add a new addendum and the  button to delete 
the current addendum. Enter a Description and Addendum Amount for each item. Click 
OK when finished. 

 
3. The HUD-1 Addendum prints an itemized report that displays all charges that are 

included in the Addendum screen. When multiple addendums exist on an order, the 
report separates the charges with the description entered in the Description of Charges 
field. The report displays the Buyers and Sellers, Property, Place of Settlement, HUD 
Line Number (if applicable), Description, Addendum Amount, and Total. 

4. Click the Print button  located in the HUD-1 Addendum screen to display the 
addendum in the Print Preview screen, where it can be printed, saved, or emailed. 

J. Navigation 

To assist you in navigating the HUD Settlement screen, there are a number of toolbar buttons 
and hotkeys (keyboard shortcuts). The online help also provides assistance as you work within 
the program. 

1. Toolbar Buttons 

 

 
Prints HUD directly to printer 

 
Preview HUD 

 
Publish HUD to PaperlessCloser 

 
Use a Template 

 
Switch to HUD-1 

 
Switch to HUD-1A 

 
Enter Paid by Other Parties 

 
Show Lender Loan Breakdown 

 
Display HUD Change Log 

 
Lock this HUD 
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Unlock this HUD 

 
Jump to Next Section 

 
Expand All Sections The Expand All Sections and Contract All 

Sections buttons are only visible on the Page Two 
tab.  

Contract All Sections 

 
Help 

 
Refresh 

 
Title Services Report 

 
GFE Bucket Allocation 

 
HUD-1 Addendum 

 
Current Status of the HUD 

 
Sale Price or Loan Amount has changed. Check Premiums. 

 No Valid Proration Date has been Specified 

 

2. Hotkeys 

HOTKEY DESCRIPTION 

<↑> Go to previous line. The Up arrow moves the cursor up one line at a time. 

<↓> Go to next line. In the sections that allow lines to be added or deleted, 
pressing the Down Arrow on the last line causes a new line to be inserted (or 
deleted if the current line is completely blank). 

<Ctl>+<→> Go to the next field within the current line 

<Ctl>+<←> Go to the previous field within the current line.  

<Insert> Inserts a new line before the current line, where applicable. This applies only 
to the sections where lines can be added or deleted on page two. 

<Ctl>+<Del> Deletes the current line, where applicable. This applies only to sections 
where lines can be added or deleted. 

<Ctl>+<Home> Go to the first section of the current page.  

<Ctl>+<End> Go to the last section on the current page of the HUD.  

<Ctl>+<D> Toggle the Debit/Credit checkbox, where applicable. This works even when 
the checkbox itself is not visible (if the line has the debit/credit feature). 

<Ctl>+<K> Toggle between normal and expanded view of a given section (if the section 
has an expanded view). Page Two is considered a full section. Toggle on or 
off the Account Code column and working fields on page two. It is 
suggested that this be toggled on at all times for processing. 

<Ctl>+<N> 
or 
<Page Down> 

Jump to the next section (within the current page). 
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HOTKEY DESCRIPTION 

<Ctl>+<P> 
or 
<Page Up> 

Jump to the previous section (within the current page). 

<Tab> 
or 
<Shift>+<Tab> 

Press <Tab> to go to the next field within the current section. If at the end of 
the line, press <Tab> to go to the first field on the next line. If at the end of 
the last line, press <Tab> to insert a new line (in the dynamic sections on 
page two) or go to the first field on the first line of the section. Press 
<Shift>+<Tab> to go to the previous field. 

<Ctl>+<T> Opens the prorations dialog in Sections 100b, 200b, 400b, and 500b. 

<Ctl>+<O> Set/clear overrides in Sections 700, 800, 900, 1000, 1100, and 1200. In 
Sections 800, 900, 1100, and 1200, this applies only to the current line. In 
Sections 700 and 1000, it applies to the entire section.  

<Ctl>+<R> Opens the Premiums dialog in Section 1100. 

<Ctl>+<Alt>+<P> POC Information screen in Section 1200, which allows for POC on 1201, 
1202, and 1203 line items. 

 

VI. RESPA DIRECTIVES 

A. RESPA Directive for Items being Paid by Seller that was Included on the GFE 

1. If a seller pays for a charge that was included on the GFE, the charge should be listed in 
the borrower’s column on page 2 of the HUD-1. 

2. The charge is then offset on page 1 of the HUD-1 in the 204-209/506-509 sections with a 
debit/credit line item. 

3. If someone other than the seller is paying a charge that was included on the GFE, that too 
is shown in the borrower’s column with an offsetting credit on page 1. 

B. RESPA Directive Concerning Yield Spread/Broker Fees  

Indirect payments from a lender to a mortgage broker may not be disclosed as POC, and must be 
included as a credit on Line 802. 

C. RESPA Directive for Line 902 

If a lump sum mortgage insurance premium paid as settlement is included on Line 902, a note 
should indicate that the premium is for the life of the loan. 

D. RESPA Directive for Loan Terms 

The lender must provide this information in a format that permits the settlement agent to simply 
enter the necessary information in the appropriate spaces, without the settlement agent having to 
refer to the loan documents themselves. 

VII. SPEED HUD SETTLEMENT STATEMENT OVERVIEW 

A. The Speed HUD Settlement Statement is only used for cash or commercial transactions. For all 
other transactions, the 2010 HUD Settlement Statement must be used. Since all new files (opened 
after March 26, 2010) default to the 2010 HUD, it is necessary to select the Speed HUD for cash 
or commercial transactions. 

B. To change a 2010 HUD to a Speed HUD: 

1. Close all other data entry menus. 
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2. Click Utilities > Additional Fields. 

 
3. Enter “N” in the Use HUD 2010 field and close. 

 

4. Click the Speed HUD button.  The Speed HUD opens. 

 IMPORTANT NOTE: Any data entered in the previous HUD will not populate the 
new HUD; therefore, it must be re-entered.  

5. Go to ATG Edit Services and select all title services. 

6. Go to the Speed HUD and enter fees. 

The Speed HUD is used to enter all the information necessary to produce a HUD-1 
Settlement Statement. The Speed HUD layout is similar to a printed HUD document. 
The Speed HUD utilizes data that has been previously entered in Order Entry and ATG 
Edit Services together with the new data entered directly in the sections of the HUD. 
This data is then used to create receipts (deposits) and disbursements (checks) in the 
Check Writing module. Check Writing continuously updates checks and deposits as 
changes are made to the HUD. The calculation of many HUD items such as title charges, 
transfer taxes, and government fees and their subsequent disbursements (checks) are 
automatically performed based on information already entered in Order Entry and ATG 
Edit Services.  

VIII. SPEED HUD SETTLEMENT STATEMENT SCREEN 

A. Use one of the following three methods to access the Speed HUD: 

1. Click the HUD Settlement Statement button drop-down arrow  and select the 
Speed HUD button.  

2. Select Data Entry >Speed HUD from the menu bar. 
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3. Press <Alt>+<D>, then <P>. 

The Speed HUD screen displays: 

 
B. Tabs 

There are two tabs: Page One and Page Two.  

1. Page One 

The Page One tab contains: 

a. Type of Loan: Click the appropriate checkbox. 

b. Funding Date: Enter the date the loan is funded (disbursed). 

c. Status: Select the current HUD Status from drop-down list. 

d. Property Location, Borrower, Seller, Sale Price, Earnest Money, Lender 
Information (including Loan and Mortgage Ins Case Numbers): Entered and 
edited in Order Entry. 

e. Settlement Information and Date: Entered and edited in Order Entry. 

f. Sections 100a, 100b, 200a, 200b, 400a, 400b, 500a, 500b. 

2. Page Two 

a. The Page Two tab contains Settlement Charges. 

b. Additional lines can be inserted after the last line in most sections of the Page 
Two tab (Sections 700-900 and 1100-1300).  

i. To add new lines of information: 

(1) Move the cursor to the last column in the last line in the section 
in which you want to add a new line and press <Tab>. Complete 
Closing will create a new HUD line, numbered sequentially after 
the last existing one. 

(2) Position the cursor in the first column of the last HUD item and 
press the <↓> key. 

ii. To delete a manually-added line:  
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(1) Click anywhere in the line and press <Ctrl>+<Delete>; or 

(2) Right-click and select Delete Line, then click Yes to confirm. 

c. Every HUD line item, except Debit/Credit items, must include a payee. Use the 
Agent list to enter a Payee in the To field. (Every payee comes from the Agent 
list.) The Payee button  appears to the left of the column when no payee has 
been selected.  

d. Leave all Account Code fields blank. 

e. To enter a negative figure anywhere on the HUD, begin the number with a minus 
sign (-). Complete Closing displays negative numbers in parentheses (####). 

C. Navigation 

1. Use the hotkeys or the Jump to Next Section button  to move through the Speed 
HUD.  

2. Jump to Next Section Button  

Click the button to move to the next HUD section or click the drop-down arrow to 
display the navigation drop-down list and select the desired section number. 

  
D. Hotkeys 

1. Right-click any field to see the hotkeys (keyboard shortcuts) available for that field. 

2. Speed HUD hotkeys include: 

HOTKEY FUNCTION 

<Ctrl>+<L> Lookup agent. 

<Ctrl>+<E> View/Edit agent. 

<Ctrl>+<Delete> Deletes a manually entered line; This only applies to Page Two sections of 
the HUD  

<Ctrl>+<Home> Move to the first section on the current page of the HUD. 

<Ctrl>+<End> Move to the last section on the current page of the HUD. 

<Ctrl>+<D> Toggle the Debit/Credit checkbox, where applicable. Note that this works 
even when the checkbox itself is not visible, if the line has the debit/credit 
feature. 

<Ctrl>+<K> Toggle between normal and expanded view of a given section, if the section 
has an expanded view. 
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HOTKEY FUNCTION 

<Ctrl>+<N>, 
<Ctrl>+<P>, 
<Page Up>, 
<Page Down> 

Jump to the next or previous section within the current page. 

<Tab> Insert new line or move to the next control within the current section. 

<↑> 
<↓> 

Move to the next or previous line. 

<Ctrl>+<→>, 
<Ctrl>+<←> 

Move to the next or previous field within the current line. 

<Insert> Inserts a new line before the current line; This only applies to Page Two 
sections of the HUD where lines can be added or deleted. 

<Ctrl>+<O> Overrides the information in the read-only fields. The overrides in each 
section work differently. 

<Alt>+<O> Switches the screen to Page One. 

<Alt>+<T> Switches the screen to Page Two. 
 

3. Move through the fields on the Speed HUD by pressing <Tab> or by clicking on the 
desired line or section. 

4. When text is too long to be displayed in full, an ellipsis (…) appears at the end of the 
displayed text. The text can be viewed by rolling the mouse over the truncated text. 

5. Read-only fields are indicated with shading. Some information in the shaded areas can be 
overridden. 

E. Expanding and Collapsing a Section 

1. Many sections of the Page One tab can be expanded. Use the Expand button  in the 
section toolbar to expand that section. Additional columns, buttons, and/or fields display, 
depending on the section. <Ctrl>+<K> also toggles the section between normal and 
expanded views. 

2. For example, to expand Section 100a, click the Expand button.  The section expands 
to display Payee, as shown below. Where applicable, the POC field also displays. 

HUD Section Expanded 
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3. To return the section to its collapsed original format, click the Collapse button.  

HUD Section Contracted 

 
4. Sections on the Page Two tab can be expanded and collapsed at one time. To expand all 

sections at once, click the Expand All Sections button  on the toolbar or right-click to 
display the menu and select Expanded View.  

5. To contract the page, click the Contract All Sections button  or right-click to display 
the menu and select Expanded View. 

F. Toolbar 

To assist you in navigating the Speed HUD, there are a number of toolbar buttons, identified 
below. The Expand All Sections  and Contract All Sections  buttons are only visible on 
the Page Two tab. 

 

 

 

 

 
 

 

 

1. Print HUD-1 Settlement Statements  

a. Click the Print HUD button  to print the entire HUD.  

b. To print only the Buyer’s HUD or Seller’s HUD, click the drop-down arrow on 
the Print HUD button  and select from the drop-down list. 

2. Preview HUD Statements  

Click the Preview HUD button  to preview the HUD prior to printing. To preview 
only the Buyer’s HUD or Seller’s HUD prior to printing, click the drop-down arrow on 
the Preview HUD button and select from the drop-down list. 

3. Publish to PaperlessCloser 

Click the Publish to PaperlessCloser button.  To publish only the Buyer’s HUD or 
Seller’s HUD, click the drop-down arrow on the Publish HUD button and select from the 
drop-down list. 

4. Switch to HUD-1 

Click the Switch to HUD-1 button.   

Print HUD 

Preview HUD 

Publish HUD 

Use Template 

Select Prorations System 

Use HUD-1A 

3rd Party Payee 

Lender Breakdown 

Lock/Unlock 

Jump to Section 

Expand All Sections 

Contract All Sections 

Help HUD Status 

WARNING: Proration 
Override Exists. 
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5. Switch to HUD-1A 

Click the Switch to HUD-1A button  to change the HUD to a simplified 1-A format. 
This form displays only borrower/lender information and the form has some different 
sub-tabs, as well as blocked access to other tabs. You can only enter information into the 
tabs/fields that pertain to buyer or borrower. 

6. Lock/Unlock the HUD 

a. Click the Lock HUD button  so the HUD cannot be altered.  

b. To edit the HUD, click the Unlock HUD button.   

c. When you lock or unlock the HUD, a confirmation message displays. Click Yes 
to confirm and continue. 

7. Tax Proration and Override System  

Defaults to Standard/Full override. Please leave as is this allows for manual entry of dates 
and amounts for tax prorations.  

8. Use a Template 

Click the Template button  if a HUD template has been defined with appropriate 
defaults for this HUD. 

9. Paid by Other Parties 

Click the Paid by Other Parties button  to pull up the Paid By screen in any section 
of the HUD that requires designating a party to pay a fee for the buyer or seller.  

 NOTE: This feature is not recommended. For further assistance, please contact the 
REsource HelpDesk. 

10. Show Lender Breakdown Report 

Click the Show Lender Breakdown Report button.  The report shows the expected 
loan amount and the lender’s check amount before creating Receipts and Disbursements 
in Check Writing. 

11. Jump to Next Section 

a. Click the Jump to Next Section button  to move to the next HUD section 
or click the drop-down arrow to the right of the button to display the Navigation 
drop-down list. 

12. Expand/Collapse All Sections. Available in Page Two tab only. 

Expand or collapse all sections in page two at one time.  

a. To expand all sections at once, click the Expand All Sections button  or 
right-click to display the menu and select Expanded View.  

b. To collapse all sections at once, click the Contract All Sections button  or 
right-click to display the menu and select Contracted View. 

13. Current Status of the HUD 

Click the Status drop-down  to change the status of the 
HUD.  
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G. Buttons within the HUD 

Within the Speed HUD, there are several buttons that may display, depending on the section in 
which your cursor is placed. 

 NOTE: All buttons offer hints as to their function when you hover the cursor over the button. 

 
Add New Line: Click this button to place a new line at the end of the selection. Available in Page 
Two tab only.  

 Delete a Line: Click this button and click Yes to the delete prompt. Available in Page Two tab only. 

 
Insert New Line: Click this button to insert a new line above the line in which the cursor is placed. If 
you try to insert a line in an inappropriate place, an error message will appear. Available in Page 
Two tab only. 

 
Set Override: Click this button to apply the override. The particular override depends on the section 
of the HUD in which it is used. Available in Page Two tab only. 

 Set Partial Override: Click this button to apply the partial override. Available in Page Two tab only. 

 Clear Override: Click this button to clear the full or partial override. Available in Page Two tab only. 

 Date Selection: Click this button to make a date selection. 

 

H. Additional Buttons 

These additional buttons that may appear on the Speed HUD: 

 
Payee missing. Displays on a line to remind you that a payee has not been 
entered for that line. 

 
Debit/Credit. Displays on a line that is a debit/credit.  

 

 NOTE: If you enter a payee in a debit/credit line, the debit/credit no longer displays. If you 
enter a debit/credit in a line, the payee no longer displays. 

I. Page One Tab 

1. Sections 100-500  

These lines automatically import data from entries in Sections 700-1300. 

2. Enter Additional Line Items:  

a. Click on or <Tab> to the blank line(s) available and enter an item description. 

b. Press <Tab>. The POC checkbox appears. 

c. Select this checkbox and enter POC Code, if applicable, and press <Tab>. 

 NOTE: If this checkbox is not selected, it disappears when <Tab> is pressed 
again. 

d. If more lines are needed, use Section 1300 or the Edit Payoff button.  For 
more information on editing payoffs, please refer to the Edit Payoff 
documentation. 
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100a: 

 
Maximum number of lines: 105 

100b: 

 
Maximum number of lines: 116 

200a:  

 
Maximum number of lines: 209 

3. Section 200a 

a. Complete Closing inserts amounts for Lines 201 and 202 from the information 
entered in the Loan tab in Order Entry. 

i. The description for Line 201 can be changed by typing over the existing 
text.  

ii. To change the Earnest Money amount, go to the Loan tab in Order 
Entry. 

b. Enter Debit/Credit: 

Double click the D/C checkbox and copy the item and amount to the 
corresponding line. 

 NOTE: Marking an “X” in the POC field will apply a credit to the Loan 
Amount. 
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c. This section also displays the party holding the earnest money, as entered in the 
Order Entry screen, Loan/Misc tab, and allows you to change it, if necessary, 
by selecting another option. 

200b:  

 
Maximum number of lines: 219 

4. Lines 300-303 

Complete Closing automatically updates and calculates these fields. 

 

400a: 

  
Maximum number of lines: 405 

400b: 

 
Maximum number of lines: 416 

5. Section 500a: Reductions in Amount Due to Seller 

In Section 500a, Complete Closing Line 502, Settlement Charges to Seller, is a total of 
charges to Seller from Sections 700 through 1300. Additional lines can be added as 
disbursement or credit items on the Seller side by entering information on Lines 507-509. 
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You can also use the Edit Payoff button  to add payoff information as an addendum 
to Section 1300. 

 
Maximum number of lines: 509 

 
500b maximum number of lines; 519 

6. Lines 600-603: Cash at Settlement From/To Seller 

Complete Closing automatically updates and calculates these fields.  

 
J. Page Two Tab 

1. Sections 700-1300 

a. Adding Lines 

i. Up to 99 lines can be added to each section.  

ii. Click the Add Line button  or <Tab> through the last line.  

iii. Click the Insert Line button  or press <Insert>. 

b. Deleting Lines 

i. Click the Delete Line button ; or 

ii. Right-click and select Delete from the menu; or 

iii. Press <Ctrl>+<Delete>. 

2. Section 700: Broker’s Commission 
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a. Override the sale price, on which the commission is based, on Line 700 by 
typing over the amount. Clear the commission information by clicking the Clear 
Commission Price Override button  or pressing <Ctrl>+<O>. 

b. A change in the sale amount is indicated by a change in color on Line 700. 

c. Line 700: Total Sales/Broker’s Commission based on …  

i. The sale price reflects the amount on this line in Order Entry. 

ii. If the commission is based on a different amount, this figure can be 
overridden by typing over the amount. Commission can also be assigned 
to the Realtor on Line 700. The total commission is also displayed. 

3. Section 800: Items Payable in Connection with Loan 

a. For all items in Section 800, the payee defaults to the first lender. It is not 
necessary to enter a payee in the Payee column unless you want to change it to a 
different payee.  

 NOTE: If necessary, click the Expand All button  in this section to more 
easily use the Clear Override button.  

b. Lines 801 and 802 

i. Overrides 

(1) Override information in Lines 801 and 802 by typing over the 
amounts. 

(2) Clear overridden information by clicking the Clear Override 
button  or pressing <Ctrl>+<O>.  

(3) Information in these lines is only considered overridden if you 
enter a percentage and an amount, causing a discrepancy in the 
calculations. If no percentage is entered, a dollar amount can be 
entered without the system considering it overridden.  

(4) An override in the amount is indicated by a change in color. 

 
ii. POC (Paid Outside of Closing) Codes 

(1) Codes 

(a) B: Buyer 

(b) S: Seller 

(c) L: Lender 

(d) X: Held from Draft 

(e) Y: Yield Spread  
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(2) Instructions 

(a) Enter POC Codes and amounts directly in the Speed 
HUD screen.  

(b) For any charge items that the lender is withholding from 
the loan amount, enter “X”. This charge is automatically 
compensated for when the receipts and disbursements 
are created in Check Writing by subtracting the POC 
amount from the total loan amount (deposit). 

(c) Other options for this field include “L” to indicate that 
the item was paid outside of closing by the lender or “Y” 
to indicate a yield spread paid by the lender to a broker. 
When “Y” is entered, Complete Closing increases the 
expected loan deposit by that dollar amount and creates a 
check in receipts and disbursements. 

 NOTE: “Y”, “L”, “B”, and “S” are only allowed 
when a dollar amount has been entered in the POC 
Amount column. “X” is only allowed when a dollar 
amount is entered in the Paid from 
Borrower/Seller Settlement Fund column. 

4. Section 900: Items Required by Lender to be Paid in Advance 

Enter the daily interest charge or a percentage and the Speed HUD will calculate the 
amount. Use the Set Line 901 Override button  or press <Ctrl>+<O> to override the 
read only information in the Paid From Borrower’s Fund at Settlement column. Click 
the Clear Line 901 Override button  or press <Ctrl>+<O> to remove the 
overridden information in Line 901. 

a. Line 901: Interest  

Enter the beginning and ending dates for interest using the Calendar button  or 
entering the year in two-digit format. 

 
b. Lines 902 and 903: Mortgage and Hazard Insurance Premiums 

Premium amounts entered in these lines will transfer the monthly amount to 
Lines 1001 and 1002.  

5. Section 1000: Reserves Deposited with Lender 

 
 NOTE: The Payee and POC fields in this section do not appear on the printed HUD. 
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a. Lines 1001-1009  

The information on Lines 1001-1009 can be overridden clicking the Set to 
Partial Override button  or by pressing <Ctrl>+<O>. Totals are 
automatically calculated, based on the number of months and the amount. (This 
is the preferred method.)  

b. Line 1011: Aggregate Reserve Adjustment 

To enter a negative amount for a credit, begin the number with a minus sign (-). 
Negative numbers are displayed in parentheses (####). Use POC Code “X” if 
amount is to be added to the deposit from the lender. 

6. Section 1100: Title Charges 

 
a. After completing the ATG Edit Services screen, Section 1100 will auto-fill the 

Amounts and Payees. It is critical that all services and any revisions are entered 
in ATG Edit Services not only for HUD items, but also for creation of 
appropriate checks. 

b. Lines 1106 and 1107 

Buyer and Seller Attorney information is populated from the Buyer and Seller 
tabs in Order Entry. A separate disbursement to the member is created. 

 NOTE: Lines 1109 and 1110 are for information only; they are not rolled 
into the HUD totals. 

K. Section 1200: Government Recording and Transfer Charges 

 
1. Override the information in Lines 1201, 1202, and 1203 by clicking the Override This 

Line button  or by pressing <Ctrl>+<O> and typing over the existing 
information. To clear overridden information, click the Clear Override for This Line 
button  or by pressing <Ctrl>+<O>. 

 NOTE: The cursor must be in the line you want to override or clear before using 
these buttons. An override is indicated by a change of color in the line item 
description. 
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2. Lines 1202, 1203, and 1204 are automatically calculated and inserted in the Borrower 
and Seller columns, based upon the County, City, and State in the Property screen. 

3. POC Information 

a. Click the POC button.  

 
b. Enter POC amounts and Who codes (“B,” “S,” “L”) for each desired line item 

and click OK to save. 

c. Enter “$0” in the Seller column for both Lines 1202 and 1203. 

d. POC is now activated and is indicated by a change of color in these lines. 

e. The printed HUD will print with POC details. 

f. To edit, change the HUD lines first and then open the POC window. 

L. Section 1300: Additional Settlement Charges 

Use Section 1300 to enter miscellaneous additional charges. 

 
M. Line 1400: Total Settlement Charges 

Line 1400 shows the total charges from Line 103, Section J and Line 502, Section K. 

IX. TWO MORTGAGES 

If there are two mortgages, a new file must be created. To save time, a copy of the existing file can be 
made. 

A. Copying Files 

To copy a REsource file, it is necessary to create a second file. To create a second REsource file: 

1. Click the Add New File Number button or select File > New File-No Suggest from the 
menu bar. 

2. Enter the Tax ID Number. Click the Search button and the Create New button. 

3. The Enter New File screen displays. 

4. In the Enter a New File Number field, enter the original file number followed by “-A”. 

 EXAMPLE:  

– Original file number: 100900101481 

– New duplicate file: 100900101481-A 
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5. Select the Region (member number). 

6. Click OK.  

The new file number displays in the File # field  and Order Entry 
opens. 

 
B. Using a Template for Order Entry  

The Use Template feature copies Order Entry data from an existing file. (There is also a Use 
Template feature to copy Commitment and Policy data from an existing file or from a template 
file.) 

 
 NOTE: It is recommended that you use the Template feature prior to adding data to the new 

file. Two confirmation messages will display upon selecting Use Template, indicating that 
any data already entered for the new file in Order Entry will be deleted and replaced with 
the data from the file selected as the template.  

1. Click the Order Entry button or click Data Entry on the menu bar to access Order 
Entry.  

2. From the Main tab in Order Entry, click the Use Template button.  

3. Click OK on the confirmation prompts that indicate the selected template will override 
any data entered in Order Entry.  

The Select Template window appears.  
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4. Click the All Orders button to list all of your files.  

 
5. Enter the original file number in the Search Characters field. 

6. Double-click the desired file number. 

 
7. The data from the existing file will now appear in the new file.  

 IMPORTANT NOTE: The Sale Price, Earnest Money, and Loan Amount will 
not be copied from the existing file. After adding the Sale Price, Earnest Money, 
and Loan Amount to the new file, you must go to ATG Edit Services to select 
services.  

X. LENDER BREAKDOWN REPORT  

A. To preview the Lender Loan Breakdown report, click the Show Lender Loan Breakdown 
button.  The report shows the expected loan amount and the lender’s check amount before 
creating Receipts and Disbursements in Check Writing. 

All Orders 

Search Characters 
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B. To print the report click on the Print button.  

XI. 1099S REAL ESTATE TAX REPORTING 

A. The following documents are available for printing with the HUD and should be used with all 
transactions, as applicable: 

1. HUD Signature Page 

2. Substitute Form 1099S Proceeds from Real Estate  

or 

3. Certification for No Information Reporting on the Sale or Exchange of Principal 
Residence 

4. Receipts and Disbursement Summary 

B. Printing HUD Documents 

1. When either Print HUD button  is clicked on the toolbar, printing prompts will 
appear. 

 
2. To print only the first two pages of the Speed HUD, click OK.  

3. To print any remaining documents, change the “Y” to “N” and click OK. 

4. Speed HUD and 2010 HUD printing prompts: 

a. Print Signature Page (Y or N)  

b. Print 1099S (Y or N) 
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c. Print Certificate for No 1099S Reporting (Y or N) 

d. Print Receipts and Disbursement Summary (Y or N) 

 NOTE: Receipts and Disbursements must be created and/or updated in 
Check Writing first. (For details, please refer to the Check Writing section 
in this manual). 

5. 2010 HUD printing prompts: 

a. Is this file being closed by a Member Closer (Y or N) 

b. Hide Reminder CPL and Anti Predatory Lending (Y or N) 

c. Print first three pages of HUD and 1101 Detail Only (Y or N) 

 
C. Reporting 1099S Information to the IRS Using REsource 

1. To generate the 1099S form and 1099 reports, it is necessary to enter the Social Security 
number of the first seller listed in the Seller tab. 

2. If no 1099S is required on the transaction because the sale is an exempt transaction under 
IRS Regulations, the seller’s Social Security number is not required to be entered in 
REsource. To confirm that the sale is exempt, the Certification for No Information 
Reporting on the Sale or Exchange of a Principal Residence (DOC Cert of No Reporting) 
must be printed, filled in, and signed by all sellers (both the husband and wife) per the 
form’s instructions. If that form confirms the sale is an exempt transaction, you must 
check the Do Not Generate 1099 box and maintain the Certification in your files.  

 
3. For additional information about 1099 reporting, go to www.atgf.com and click ATG 

Member Attorneys > Get Underwriting Assistance > Underwriters’ Bulletin Index 
(1996-2008). In the list of archived documents, scroll down to 2003 and select 1099 Real 
Estate Tax Reporting. If you have additional questions, contact the ATG Underwriting 
Department. 

Do Not Generate 1099 

Tax ID/Social Security No. 
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D. Edit Payoffs 

1. Click the Edit Payoffs button  to enter an unlimited amount of Buyer or Seller payoffs 
available in Sections 100a, 500a, and 1300. 

 
2. Payoff information is calculated according to the following: 

a. Formulas: 

i. Payoff Amount Calculation (Formula 1): 
Principal Balance + Interest Amount + Sum of Additional Charges 

ii. Payoff Amount Calculation (Formula 2): 
Principal Balance + Sum of Additional Charges 

iii. Payoff Amount Calculation (Formula 3): 
Principal Balance + (Per Diem x Interest Period)  
+ Sum of Additional Charges 

iv. Payoff Amount Calculation (Formula 4): 
Principal Balance + [(Interest Rate x Principal Balance) ÷ Annual Days] + 
Sum of Additional Charges 

b. Exceptions 

i. If the interest amount is overridden, Formula 1 is used. 

ii. If only the principal balance and/or additional charges are entered, 
Formula 2 is used. 

iii. If there are no Interest From and Interest Thru Dates, but the Interest 
Rate or Per Diem fields are filled in, Formula 2 is used. 

iv. If none of the above is true, and you check the Override check box next 
to the Per Diem field, then Formula 3 is used. If the Override check box 
next to the Per Diem field is not checked, then Formula 4 is used. 
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8 | CHECK WRITING 

I. CREATING RECEIPTS AND DISBURSEMENTS 

Check Writing creates all receipts (deposits) and all disbursements (checks) directly from the data 
entered in the HUD-1 Settlement Statement and prints checks for disbursement. Check writing does 
allow for manual changes to receipts and disbursements and always indicates the status of the file, i.e., In 
Balance, Out of Balance, Deposits Posted, and Checks Cleared. Each disbursement displays a detailed 
account by HUD line number and a detailed ledger is available to print. 

Additionally, REsource has a robust escrow reconciliation module that makes reconciliation quick and 
accurate. It is highly recommended that each transaction be reconciled and your escrow account 
reconciled on a monthly basis.  

Contact a Member Services Representative to order check stock or for additional information using the 
Escrow Accounting module of REsource. 

A. To access Check Writing, click the Check Writing button  or select Utilities > Check 
Writing from the menu bar. 

 
 

B. To create the Receipts and Disbursements from the HUD, click the Create Receipts and 
Disbursements button  in the top left corner. This function brings all HUD-1 items into the 
Deposits and Checks tabs. 

II. DEPOSITS TAB 

A. The Check Writing screen has two tabs, one for Deposits (receipts) and one for Checks 
(disbursements). 

 

 

Deposits/Check
 

Check Writing 

Utilities > 
Check Writing 

Create Receipts and 
Disbursements 
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B. Once Receipts and Disbursements have been created, all changes that are made on the HUD will 
automatically update Receipts (checks) and Disbursements (deposits).  

 NOTE: It is important that when making changes to the HUD, you click the Refresh button 
 of the HUD and then close the HUD prior to going into Check Writing.  

C. If any Lender items under Who POC in the HUD screen are marked with an “X,” Section 800, 
900, or 1000 tabs are to be deducted from the Loan Amount (lender draft). Complete Closing 
automatically compensates for this charge when it creates the Receipts and Disbursements. It also 
adjusts the Receipts and Disbursements to account for any “L” or “Y” entries in these tabs. 

D. In the shaded area at the bottom of the screen, Complete Closing keeps a running balance of the 
status of the account. The Pre-Disbursement Balance must match the Scheduled 
Disbursements in order to balance. When this occurs, this area displays in a light shade of green. 
If these amounts are out of balance, this area displays in turquoise and the amount will display in 
Anticipated Dep/Balance. If the file is in balance and all Deposits have been dated and posted, 
this area will display in yellow. 

 NOTE: Checks can be written against anticipated deposits before the account is in balance, 
as long as there is enough money deposited for this file to cover them. However, use this 
option with caution because it can cause serious accounting problems. 

 
E. Some of the options in the Check Writing window may be restricted by security settings. 

Options that may be restricted include: 

1. the number of days the checks and deposits can be predated and postdated; 

2. whether an individual can change or delete a deposit; 

3. whether an individual can undo, delete, and/or stop/void a check; and 

4. converting a check to a wire.  

F. Checks and Deposits can be entered manually in these tabs but Complete Closing can create 
Receipts and Disbursements automatically from items entered in the HUD-1 Settlement 
Statement.  

G. If the Earnest Money amount entered in the Order Entry > Loan tab specifies the title company 
as holding these funds, the first time this screen is opened, the only entry in it will be a posted 
Deposit in your account for the Earnest Money. Use this feature with caution. 

In Balance 
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H. The process can now begin of verifying the deposits and checks to be written, making 

adjustments, and adding manual deposits and checks as needed.  

1. To assist with the process, click the Receipts and Disbursements Ledger button.  
The report will display on the screen and may be printed for a preliminary register as a 
worksheet. When you have completed printing all checks, click the Receipts and 
Disbursements Ledger button to print a final ledger. 

2. If mistakes have been made in receipt and/or disbursement records, or there are have 
been significant changes to the HUD-1 Settlement Statement since you created the 
receipts and disbursements from it, you can choose to delete the receipts and 
disbursements and start over again. To do so, click the Delete Receipts and 
Disbursements button.  This option clears all the receipts and disbursements 
generated from the HUD-1 Settlement Statement. It does not delete the Earnest Money or 
manual entries you have made. 

 NOTE: All Receipts and Disbursements cannot be deleted if check(s) have been 
printed. However, individual unprinted checks or individual un-booked deposits can 
be deleted.  

I. If one or more checks are printed, the Delete All Receipts and Disbursements button  will 
not delete all receipts and disbursements. 

J. However, un-booked deposits and unprinted checks may individually be deleted by using the 
Delete button.  

K. To edit printed checks, use Undo or Void. 

L. If a change is made to the HUD-1 Settlement Statement after one or more checks have been 
printed, then the Checks and Deposits will automatically recalculate in Check Writing. 

 NOTE: Only the checks affected by the changes made will recalculate, including manually 
created checks, e.g., Splits, Payee changes, etc. 

Out of Balance 

Receipts and Disbursements 
Ledger and Summary 
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1. If a change is made to the HUD-1 and all deposits have been dated and posted, then 
Checks and Deposits will not automatically recalculate. The following informational 
prompt will display: 

 
2. You must manually adjust Checks and Deposits to reflect the changes to the HUD-1 

Settlement Statement. 

 
M. Complete Closing displays all the current deposits on the Deposits tab in a scrolling window on 

the right side with the Description, Payor, and Amount for each. To select an item, either click 
anywhere in the Description to highlight it, or use the Navigation buttons  at the 
top of the window to move from one deposit to another. 

N. For the selected deposit, Complete Closing also displays the Description, Amount, Payor, 
Deposit Date, Type of Funds, and Expected Wire date (if applicable) in editable fields on the 
left side of the window. When indicated that the Type of Funds is “Wire,” a Wire Number field 
appears below the Type of Funds drop-down box. Make any needed changes to deposits using 
these fields. You will need to change the amount of an item if the check you receive is different 
from the expected amount. You may also need to change the checks on the Checks tab to 
compensate. Only enter the date when the receipt is actually deposited, since a date entry 
indicates to the program that the receipt is received and in the bank. When your changes are 
complete, click the Post Current Deposit button.  

O. To add a deposit, click the Create button.  The program creates a new blank line in the 
display window on the right and is ready for your entries in the fields at the left. Enter the 
Description, Amount, Payor, Deposit Date, Type of Funds, and Expected Wire date (if 
applicable). Complete Closing automatically creates and displays a Transaction ID to the right 
of the Deposit Date field. You can either post the deposit immediately or wait until an 
appropriate later date. 

P. To delete a deposit, click the Delete button.  

Q. Money can also be transferred to and from an interest-bearing investment account. 

Navigation buttons 
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III. CHECKS TAB 

A. Complete Closing displays all the current checks on the Checks tab in a scrolling window on the 
right with the Payee, Amount, and, when the check is printed, the Check Number, Date, and 
Bank fields are completed. To select a check to view and edit charge items, either double-click 
anywhere in the Payee field to highlight and select it, or use the Navigation buttons 

 at the top of the window to move from one check to another. 

 

B. When using the Navigation buttons  to select a check, it will not display as 
highlighted in the Payee display window on the right. To confirm that the correct check is 
selected, make sure that the Payee name is displayed under Pay To on the left. 

C. For the selected check, Complete Closing displays a scrollable list of all disbursement items 
included in the check amount. For each item, it displays the HUD-1 Line Number, Description, 
Amount, and Acct (account) number, if assigned. Highlight any of these fields to make changes 
to an item. If the amount is changed, it will be reflected in the total check Amount displayed on 
the right and above the Disbursements list. 

 NOTE: HUD-1 Settlement Statement Line; Amounts deducted from member check includes: 
premiums, Illinois Policy Tax, and search fees will appear in parentheses. Please refer to the 
ATG Fees and Transfer check for details. 

 NOTE: Changes cannot be made to check amounts directly. Changes must be made through 
the items in the Disbursements list (left hand side). You can, however, delete an entire 
check. Doing so will automatically delete all the disbursement items attached to it. 

D. To add another item for the current check, press <↓> or <Tab> repeatedly until the program 
creates a new blank line at the bottom of the Disbursement list. Then, enter the Line Number, 
Description, and Amount. If an item does not have a Line Number, leave blank. Changes can 
also be made to any of the existing items by entering new data. To delete an item, use the Del 
Line button.  

E. When finished adding an item or adjusting current items, click the Post Changes to Current 
Check button  or press <Tab> to post the change. 

F. Change Payee Information 

1. The Change Payee Information feature allows you to manually change the payee name 
and/or address for a specific check, without having to utilize the Agent or Buyer/Seller 
lists. A copy feature is also included to copy existing information and to make minor 
changes from this screen. 

a. Select the Checks tab and select the desired check. 

Displays details of check selected in 
Disbursement list. Click to view and/or edit. 

Select check and double-click Payee to 
move to Disbursement list (left side). 
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b. Click the Change Payee Information button  to display the Manual Payee 
screen. 

c. Enter the Payee Name and Address (optional); click OK. 

 

2. Use the Change Payee button  to change the name of the payee. When you 
select this option, the Select Payee Option screen displays. Choose which list the payee 
from: Buyer/Seller, Agent, or Manual. The Select Payee Option window also displays 
when the New button  is selected. 

 
a. Buyer/Seller 

Displays the Buyer/Seller Agent List. 

b. Agent 

Displays the Agent List. 

c. Manual 

Same as Manual Change Payee (above). 

d. Buyer From Order 

Automatically inserts the Buyer name from the file as the payee. 

e. Seller From Order 

Automatically inserts the Seller name from the file as the payee. 

3. This screen also offers these options for adding and adjusting checks manually and for 
printing checks. 

a. New 

Creates a new check. Use this option to add a new check to the list. (To add a 
new item for an existing check, use the method explained above for adding 

Change Payee info 
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disbursement items.) When you select this option, the Select Payee Option 
screen displays; please see above. The program displays the new name above the 
disbursements list and is ready for you to enter a HUD Line number, 
Description, Amount, and Acct (Account) number. Once you enter an item, the 
new check displays in the Check window on the right. You can continue to add 
as many items as necessary for the new check. 

b. Del Line 

Deletes the selected line(s) from the Disbursement list on the left. The amount 
of the check is adjusted to reflect the deletion. If the item you delete is the only 
item for the current check, the check is also deleted from the Check window on 
the right. To select more than one item to delete, first click to highlight the first 
item, then hold down <Ctrl> when you click each additional item. 

c. Split 

Splits the selected item(s) in the Disbursement list into a separate check for the 
same payee. Use this option if your payee needs separate checks for different 
items. Before you click the Split button,  select the item(s) in the 
Disbursement list to go on a separate check. To select more than one item, first 
click to highlight the item, then hold down <Ctrl> when you click each 
additional item. Complete Closing will create a second entry in the Check 
window for the payee with the selected items associated with it. 

Use the Navigation buttons  to move through the list of 
checks. 

d. Print 

To print all checks, click the Print All Checks button  at the top of the Check 
Writing window. 

To print individual checks, highlight the checks and click the Print Selected 
Checks button.  

Before you click the Print button, select the check(s) in the Checks window. If 
you choose to print before the account is in balance, do so with caution because it 
could create a serious accounting problem. When you select Print, a window will 
display with the Starting Check Number and Date of Check. You can change 
either of these. You also have the option of selecting a wire or no paper copy (if 
you just need to assign a check number but not actually print) or transferring the 
funds to another file. After the checks are printed, Complete Closing will display 
the check number and date for each check. 

e. Undo 

Use this option if you experience a problem with your printer or check paper that 
prevents the checks from printing properly. Before clicking the Undo button, 

 select the check(s) in the Checks window. Complete Closing 
removes the check numbers and date from each payee for the checks, so that you 
can reprint them. This option may be restricted by your Security settings. To 
undo all checks, use the Undo All button.   

f. Void 

Voids a check. Use this option only if you have printed a check and need to 
physically void it. Do not use this option to undo check printing. Before clicking 
the Void button,  select the check(s) in the Checks window. This 
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option highlights the selected payee entry in red and automatically creates a new 
check line with the same payee in the same amount as the voided check(s). 

g. Delete 

Deletes the selected check entries. Use this option if you need to remove an 
unprinted check from the list. Before clicking the Delete button,  
select the check(s) in the Checks window. 

h. Hold 

Use this option if you are printing checks as a group with the Print All Checks 
button  and you want to hold one or more selected checks. Before you click 
this button, select the check(s) in the Checks window. Held check(s) will be 
highlighted in grey. To un-hold, select the check(s) and click the Hold button. 

 
i. Undo All 

Use this option if you experience problems with your printer or check paper that 
prevents checks from printing properly. Complete Closing removes the check 
numbers and dates from all the checks so that you can reprint them. To undo only 
one or more selected checks, use Undo. This option may not be available, based 
upon your security.   

j. Stop Pay 

Use this option if you are stopping payment on a check. Before clicking the Stop 
Pay button,  select the check(s) in the Checks window. This option 
highlights the selected payee entry in blue and creates a new duplicate of the 
record without a check number or date. Use this duplicate entry to make needed 
modifications to the check. When you issue the modified check, date it with 
today’s date. The Book Balance Report in the Escrow Account program will 
show a negative check (credit) on the date the check is stopped. The reissued 
check will display as a debit on the date it is issued. 

k. Wire Funds 

Use this option to denote that the disbursement was a wire. Select the Transfer 
button  and assign a wire number  
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G. To move one or more disbursement items from one payee to another or for combining separate 
payments into one check to one payee: 

1. Select the first disbursement. 

2. To select additional disbursement items, press <Ctrl>. 

3. Press and hold the left mouse button, and drag the mouse to the right until the desired 
check is highlighted and checked. 

4. Release the mouse button. 
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9 | ESCROW ACCOUNTING 

I. INTRODUCTION 

The Complete Closing Enterprise Escrow Accounting program works with Complete Closing Enterprise 
to enable you to reconcile monthly escrow account bank statements and to prepare the three components 
of the monthly Three-Way Balance. You can also verify deposits, review checks and deposits, edit checks 
and deposits, review files with escrow account balances, review files with investment account balances, 
and administer investment accounts. 

To access the Complete Closing Escrow Accounting module, click the Complete Closing Escrow 

Accounting icon  on the REsource Desktop. 

 
 

 
Each of the key functions is available from the toolbar, as well as from the drop-down menus. In addition, 
the drop-down menus provide access to other reports. 

Prior to your first reconciliation, create a new file in REsource for the purpose of entering other 
disbursements and receipts, such as bank charges or earned interest, that appear on your bank statement 
but are not specific to a transaction. The Control file that you create in REsource for this purpose should 
be named Bank ###. (The “###” corresponds to your Escrow Bank number in REsource.) 

In this REsource Control file, enter any deposits in the Deposit tab and enter any bank fees in the Check 
tab of Check Writing. Change Bank Fees entered in the Check tab to a Wire and book the deposit. This 
can also be accomplished in Complete Closing Escrow Accounting. See Using a Control File in the 
Control Files section of this chapter for additional information. 

Additionally, if your existing REsource escrow account has not been reconciled using Complete Closing 
Escrow Accounting, it is advisable to open a new escrow account at your bank. When your new account 
and checks are ready, contact the REsource Help Desk and a new REsource Escrow Account Number will 
be assigned to you. By default, all new files will be opened using the new REsource Escrow Account 
Number. When you receive your first bank statement from your new account, contact the REsource Help 
Desk for assistance completing your first reconciliation. 
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II. ESCROW ACCOUNTING BUTTONS 

The Escrow Accounting buttons are described below: 

 
Bank Reconciliation: Click this button to reconcile your monthly bank statement with each of your escrow 
accounts. 

 
Book Balance: Click this button to prepare a book balance report for the selected escrow account and date. 
The report includes cleared and outstanding checks and deposits. 

 
Escrow Trial Balance: Click this button to prepare an escrow trial balance for the selected escrow account 
and date. This report includes all files with a balance and all files out of balance as of the date of the 
reconciliation, as well as escrow memos entered in Check Writing. 

 
Reconciled Bank Balance: Click this button to prepare a reconciled bank balance report for the selected 
escrow account and date. This report includes all outstanding checks and deposits. 

 
Three-Way Summary: Click this button to prepare a summary report for the book balance, escrow trial 
balance, and reconciled bank balance for the selected escrow account. 

 
Escrow Check Wizard: Click this button to open the Escrow Check Wizard, which helps you identify and fix 
problems with checks in Complete Closing Enterprise. 

 
Verify Deposits: Click this button to open the Verify Deposits screen, which displays a list of all unverified 
deposits and deposit slips. To verify a deposit or deposit slip, select the line and click the Verify Selected 

Deposits button.  
 NOTE: Verifying deposits and deposit slips is useful in preventing changes being made to the deposits 

after they are posted. Users cannot make changes to deposits or deposit slips once they are verified in 
Escrow Accounting. 

 
Check Browser: Click this button to open the Check Browser screen, which displays all checks for the 
selected escrow bank. You can also search for checks by file number, check number range, amount range, 
date range, voided/valid status, and/or clearance status. 
To make a change to a check, double-click the check to open the Check Editor screen. From there, you can 
change the file number, check number, and date, void/unvoid the check, apply it, or remove it from a finalized 
reconciliation. 
 NOTE: Changes made here are reflected on the Checks tab of the Check Writing screen, as well as 

the reconciliation. 

 
Deposit Browser: Click this button to open the Deposit Browser screen, which displays all deposits and 
deposit slips for the selected escrow bank. You can also search for deposits by file number, amount range, 
date range, voided/valid status, and/or cleared/outstanding status. 
To make a change to a deposit, double-click deposit to open the Deposit Editor screen. From there, you can 
change the file number, deposit date, type of funds, payor, and deposit description, add to a deposit slip, 
clear the deposit slip, verify the deposit, and apply it to or remove it from a finalized reconciliation. 
 NOTE: Changes made here are reflected on the Deposits tab of the Check Writing screen, as well as 

the reconciliation. 

 
Quick Check Entry: Click this button to open the Check Editor screen, where you can add any unrecorded 
checks to a file without exiting Escrow Accounting and opening Complete Closing. 

 
Quick Deposit Entry: Click this button to open the Deposit Editor screen, where you can add any 
unrecorded deposits to a file without exiting Escrow Accounting and opening Complete Closing. 

 
Current Escrow Trial Balance Browser: Click this button to open the Current ETB screen, which displays 
the file number, total receipts, disbursements, account balance, last date of activity, and escrow memos for 
the selected escrow account. 

 
Active Investment Accounts: Click this button to open the Open Investment Accounts screen. This 
screen lists the file number, total receipts, disbursements, and account balance for each file having an open 
investment account. 

 
Expected Wires: Click this button to open the Expected Wires, which displays all expected wires. From 
there, the file number, payor, amount, description, expected wire date, and bank can be edited. You can also 
accept the wires from this screen, which creates a deposit with the current date. 

 
Close: Click this button to close Escrow Accounting. 
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III. BANK RECONCILIATION 

A. To open the Bank Reconciliation screen, use one of the following methods: 

1. Click the Bank Reconciliation button;  

2. Select Tools > Reconciliation from the menu bar; or 

3. Press <Alt>+<T>, then <R>. 

The screen displays the most recent reconciliation conducted. To search for another one, click the 
Locate Reconciliation button.  

B. To create a new reconciliation, click the New Reconciliation button.  The program extracts all 
unreconciled receipts and disbursements through the selected end date for all files in Complete 
Closing Enterprise. All outgoing wires and checks are displayed on the left side of the screen and 
all incoming wires and deposits are displayed on the right side. New reconciliations are described 
under Starting a New Reconciliation in this section of the manual. 
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C. The fields on the Bank Reconciliation screen are described below: 

FIELD DESCRIPTION 

Disbursements The left side of the screen displays each disbursement, with the Number, Check 
Date, Payee, and Amount. A new reconciliation lists all unreconciled disbursements 
through the date of the reconciliation. These items are listed with Transfers and Wires 
in date order, followed by checks in order by check number. 
To clear a disbursement, click once on the line, which highlights the line and marks it 
as “cleared.” Clicking the line a second time un-clears the disbursement. 

Receipts The right side of the screen lists each receipt, with the Transaction ID, Date, 
Description, and Amount. A new reconciliation lists all unreconciled receipts through 
the date of the reconciliation. 
To clear a receipt, click once on the line, which highlights the line and marks it as as 
“cleared.” Clicking the line a second time un-clears the receipt. 

Beginning 
Balance 

The beginning balance that you entered when you created the new reconciliation using 

the New Reconciliation button.  

Auto Recalc Select this checkbox to automatically recalculate the totals each time a change is 
made. 
If the Auto Recalc check box is not selected, the Calculator button displays for 
manual recalculation. 

Account Name The name assigned to the account is displayed after the Auto Recalc checkbox. The 
name is defined from the Escrow Accounts Bank Name in Complete Closing 
Supervisor. 

Thru Date The closing date of the bank statement entered when you created the new 

reconciliation using the New Reconciliation button.  

Cleared Disb The total dollar amount of the disbursements you have cleared by clicking and 
highlighting them. 

Cleared Rec The total dollar amount of the receipts you have cleared by clicking and highlighting 
them. 

Ending Bank 
Bal 

The ending balance of the bank statement entered when you created the new 

reconciliation using the New Reconciliation button.  

Other Disb If you are using a REsource Bank file (Control file) to enter other disbursements, such 
as bank fees, do not use this function.  

Other Rec If you are using a REsource Bank file (Control file) to enter other receipts, such as a 
deposit or interest, do not use this function.  

Your Ending 
Bal 

The ending balance for all receipts and disbursements you have marked as reconciled. 

Total Disb The sum of Cleared Disb and Other Disb. 

Total Rec The sum of Cleared Rec and Other Rec. 

Difference The difference between the Ending Bank Bal and Your Ending Bal. When this figure 
is Zero (0), the entire lower area of the screen is highlighted with a yellow background. 
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D. The buttons on the Bank Reconciliation screen are described below: 

 
New Recon: Click this button to start a new reconciliation. For more information on starting a new 
reconciliation, see Starting a New Reconciliation. 

 
Options: Click this button to display options to be used with individual checks or deposits. For more 
information, see Bank Reconciliation Options below. 

 
Print Reconciliation Ledger: Click this button to display and print the ledger. You will have the 
option to Print Only Marked Items or Print All Items. After you make your selection, the report is 
displayed in the Print Preview screen, where it can be printed or saved. 
The Bank Recon Ledger includes details on each check and disbursement, including the 
information from the Bank Reconciliation screen, as well as each item’s file number and account 
balance figures that appear at the bottom of the Bank Reconciliation screen. Use the 
Reconciliation Ledger to help resolve any discrepancies between your bank statement and the 
Complete Closing Enterprise receipts and disbursements. 

 
Locate Recon: Click this button to locate an existing recon by scrolling through the list or entering 
search criteria to jump to the closest match. When you locate the reconciliation you want, highlight it 
and click OK. 

 
Refresh: Click this button to refresh the screen. 

 
Finalize Reconciliation: Click this button to finalize reconciliation. Finalize reconciliation only after 
your ending balance matches the bank ending balance. If these balances do not match, the program 
asks you to confirm your request to finalize the reconciliation. Once the reconciliation is finalized, 
“Final Reconciliation” is displayed in the title area of the Bank Reconciliation screen. 
 NOTE: Reports will not calculate correctly without finalizing the recon. 
 WARNING: This action cannot be reversed. 

 
Help: Click this button or press <F1> for additional information. 

 
Close: Click this button to close the screen and save your changes. 

 

E. Bank Reconciliation Options 

To display options available on the Bank Reconciliation screen, click the Options button.  
Available options include: 

OPTION DESCRIPTION 

Select All 
Checks 

Selects and highlights all checks in the Checks display. You may want to use this 
option if all, or nearly all, checks displayed match the bank statement and are ready for 
reconciliation. (If a small number are not listed on the bank statement, you could select 
all checks and then select only those that are outstanding.) 

Select Range 
of Checks 

Allows you to select a range of checks by entering the beginning and ending check 
numbers. 

Unselect All 
Checks 

Shows all checks in the Checks display as outstanding. You may want to select this 
option if you have made a number of mistakes in the reconciliation process and you 
want to start over again. 

Select All 
Deposits 

Selects and highlights all deposits in the Deposits display. You may want to use this 
option if all, or nearly all, deposits displayed match the bank statement and are ready 
for reconciliation. (If a small number are not listed on the bank statement, you could 
select all deposits and then select only those that are outstanding.) 

Unselect All 
Deposits 

Shows all deposits in the Deposits display as outstanding. You may want to select this 
option if you have made a number of mistakes in the reconciliation process and you 
want to start over again. 
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OPTION DESCRIPTION 

Clear Current 
Check to 
Other Recon 

If a check was missed from a previous reconciliation, highlight it in the Check display 
and then select this option. The Find Other Recon screen opens, allowing you to select 
the recon to which the check is to be added. 
 WARNING: This option affects the balance of both the current recon and the recon 

the check is being added to. If you are adding a check to a recon that has already 
been finalized, each of the three-way reports needs to be run again to verify that 
the ending balance is correct. 

Clear All 
Marked 
Checks to 
Other Recon 

If a number of checks were missed from a previous reconciliation, highlight them in the 
Check display and then select this option. The Find Other Recon screen opens, 
allowing you to select the recon to which the checks are to be added. 
 WARNING: This option affects the balance of both the current recon and the recon 

the checks are being added to. If you are adding checks to a recon that has 
already been finalized, each of the three-way reports needs to be run again to 
verify the ending balance is correct. 

Clear Current 
Deposit to 
Other Recon 

If a deposit was missed from a previous reconciliation, highlight it in the Deposit display 
and then select this option. The Find Other Recon screen opens, allowing you to select 
the recon to which the deposit is to be added. 
 WARNING: This option affects the balance of both the current recon and the recon 

the deposit is being added to. If you are adding a deposit to a recon that has 
already been finalized, each of the three-way reports needs to be run again to 
verify the ending balance is correct. 

Clear All 
Marked 
Deposits to 
Other Recon 

If a number of deposits were missed from a previous reconciliation, highlight them in the 
Deposit display and then select this option. The Find Other Recon screen opens, 
allowing you to select the recon to which the deposits are to be added. 
 WARNING: This option affects the balance of both the current recon and the recon 

the deposits are being added to. If you are adding deposits to a recon that has 
already been finalized, each of the three-way reports needs to be run again to 
verify the ending balance is correct. 

Unclear 
Marked 
Checks 

Select this option to show all checks associated with the recon as outstanding. This 
feature is commonly used in deleting the finalized recon and starting over. 
 NOTE: This option is available only on finished reconciliations (those finalized 

using the Finalized Reconciliation button ). 

Unclear 
Marked 
Deposits 

Select this option to show all deposits associated with the recon as outstanding. This 
feature is commonly used in deleting the finalized recon and starting over. 
 NOTE: This option is available only on finished reconciliations (those finalized 

using the Finalized Reconciliation button ). 

Delete 
Reconciliation 

Select this option if you created the reconciliation in error and want to delete it. 
 NOTE: The recon can only be deleted once you have finalized the recon, selected 

checks and all deposits, and marked them as outstanding. 
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IV. STARTING A NEW RECONCILIATION 

Follow these steps to create and balance a new reconciliation: 

A. Click the Bank Reconciliation button or select Tools > Reconciliation. 

The Bank Reconciliation screen opens. 

B. Click the New Reconciliation button.  

The New Reconciliation screen opens. 

 
C. From the Bank drop-down, select the escrow account. The Bank drop-down list displays only 

region-specific banks (i.e., Region 1 users see only Region 1 banks). 

D. From your bank statement, enter the Through Date. Enter the date or click the Calendar button 
 to select a date. 

E. Enter the Beg(inning) Balance and End(ing) Balance as reported on the bank statement. If this is 
your first reconciliation, the End(ing)Balance should be 0 (Zero). 

F. Click OK to create a new reconciliation or click Cancel to exit. 

The program then displays all un-reconciled receipts and disbursements from files in Complete 
Closing Enterprise through the Through Date. 

 
G. Begin comparing the bank statement items with the checks and receipts displayed. To mark an 

item as reconciled, click on the item, which highlights the line and adds it to the Cleared Rec or 
Cleared Disb totals at the bottom of the screen. If you have marked an item in error, unmark it by 
clicking it again. You can also use the options available by clicking the Options button  to 
mark and unmark items. 

H. Continue marking items until your Ending Balance matches the Bank Ending Balance. 
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I. If you find discrepancies between the bank statement and your receipts and disbursements, return 
to Complete Closing Enterprise to investigate and make corrections.  

J. Manual Adjustments 

1. Use the REsource Control file created for manual adjustments (Bank ###). Manual 
adjustment entries are used for items that do not pertain to a file in Complete Closing, 
such as interest, wire fees, sweep account entries, etc. See Control File in this section of 
the manual for details. 

2. To enter manual adjustments, either: 

a. Return to Complete Closing Enterprise, open the Control File and go to Check 
Writing. Enter any deposits, such as interest, in the Deposit tab and any bank 
fees in the Checks tab. Be sure to book the deposits and change the checks to 
wires. 

or 

b. Open Quick Check Entry  or Quick Deposit Entry from the Tools menu in 
Compete Closing Escrow Accounting. Enter manual adjustments to your Control 
file (Bank ####). For more information on using Quick Check Entry and 
Quick Deposit Entry see Adding or Adjusting Checks and Deposits in this 
section of the Manual. 

K. When the Ending Balance matches the Bank Ending Balance and the Difference appears as 
Zero (0), the lower area of the screen is highlighted in yellow. When the balances are different, 
the lower part of the screen is shaded gray. 

L. To finalize your balanced reconciliation, click the Finalize Reconciliation button.  

 WARNING: Once you finalize a recon, it is time consuming to reverse. Please call the 
REsource Help desk for assistance. 

V. THREE-WAY BALANCE 

Complete Closing Enterprise performs a full three-way balance of the escrow accounts set up in Complete 
Closing Enterprise. The Three-Way Balance components listed below are described in the following 
sections. 

A. Book Balance 

B. Escrow Trial Balance 

C. Reconciled Bank Balance 

 NOTE: Each of the Three-Way Balance components needs to be completed prior to completing the 
full Three-Way Balance. 
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VI. BOOK BALANCE 

A. The Book Balance is the first of the three components of Three-Way Balancing. The Book 
Balance contains the following information for a specified escrow account and date range. 

1. Beginning Book Balance 

+ all receipts dated in the month, whether reconciled or not. 

− all disbursements dated in the month, whether reconciled or not. 

2. Ending Balance 

Represents the beginning balance, plus all receipts, minus all disbursements. 

Request the Book Balance after you have completed the account’s Bank Reconciliation for that 
month. The final Book Balance for an escrow account must match the Escrow Trial Balance 
and the Reconciled Bank Balance. 

B. To run the Book Balance Report: 

1. Click the Book Balance button,  or select Reports > Book Balance (#1) or press  
<Alt>+<R>, then <B>. 

The Book Balance screen opens: 

 
2. From the Select Bank drop-down, select the escrow bank. 

 NOTE: The Select Bank drop-down displays only region specific banks (i.e., Region 
1 users see only Region 1 banks). 

3. Enter the Starting Date or click the Calendar button  to select the date. This should 
be the first day of the month you are currently reconciling. 

4. Enter the Ending Date or click the Calendar button  to select the date. This should be 
the last day of the month you are currently reconciling. 

5. For the Beginning Book Balance, enter the Ending Book Balance for the previous 
month. If this is the first month reconciling a new account, enter “0” (zero). 

6. Click OK or click Cancel to exit the Book Balance screen. 

7. The Book Balance report displays with the beginning balance you entered, details on all 
receipts and all disbursements, and the calculated ending balance. Depending on settings 
in Complete Closing Supervisor, the report may include the closing agent’s initials next 
to the file number. From there, print the report by clicking the Print button  or save 
the report by clicking the Save button.  To adjust the display size, use the Zoom 
buttons. 
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VII. ESCROW TRIAL BALANCE 

A. The Escrow Trial Balance is the second of the three components of the Three-Way Balance. 
The Escrow Trial Balance displays the following items for the selected escrow account and date: 

Every file with a non-zero balance, with its: 

1. Total Receipts balance; 

2. Total Disbursements balance; 

3. Total Account balance; 

4. Last Activity Date; 

5. Escrow Memo (if entered on the Check Writing screen). 

B. Use the Escrow Trial Balance after you have completed the month’s Bank Reconciliation for 
an account. The final Bank Total for an escrow account must match the Book Balance and the 
Reconciled Bank Balance. 

C. To run the Escrow Trial Balance Report: 

1. Click the Escrow Trial Balance button,  or select Reports > Escrow Trial Balance 
(#2), or press <Alt>+<R>, then <E>. 

The Escrow Trial Balance screen opens: 

 
2. From the Select Bank drop-down, select the escrow bank. 

 NOTE: The Select Bank drop-down displays only region specific banks (i.e., Region 
1 users see only Region 1 banks). 

3. Enter the Thru Date or click the Calendar button  to select a date. This should be the 
last day of the month you are currently reconciling 

4. Click OK or click Cancel to exit the Escrow Trial Balance screen. 

The Escrow Trial Balance report displays with the file number, receipts, disbursements, 
last activity date, balance, and any escrow memos entered in Check Writing. Depending 
on settings in Complete Closing Supervisor, the report may include the closing agent’s 
initials next to the file number. From there, print the report by clicking the Print button 

 or save the report by clicking the Save button.  To adjust display size, use the 
Zoom buttons. 
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VIII. RECONCILED BANK BALANCE 

A. The Reconciled Bank Balance is the third of the three components of the Three-Way Balance. 
The Reconciled Bank Balance displays the following information for the selected escrow 
account and ending date: 

1. Beginning Book Balance 

2. Deposits in-transit (not yet reconciled), with the Date, Transaction ID, File Number, 
Description, and Amount. 

3. Outstanding Checks (not yet reconciled), with the Check Number, Date, File Number, 
Payee, and Amount. 

4. The Reconciled Bank Balance, representing the beginning balance, plus all deposits in-
transit, minus all outstanding checks. 

 NOTE: You must finalize the Bank Reconciliation for the selected escrow account 
for a given month before you can run this report. The Adjusted Reconciled Bank 
Balance (which includes other receipts and other disbursement entries) must match 
the Book Balance and the Escrow Trial Balance. 

B. To create a Reconciled Bank Balance: 

1. Click the Reconciled Bank Balance button,  or select Reports > Reconciled Bank 
Balance, or press <Alt>+<R>, then <R>.  

The Reconciled Book Balance screen opens: 

 
2. From the Select Bank drop-down, select the escrow bank. 

 NOTE: The Select Bank drop-down displays only region specific banks (i.e., Region 
1 users see only Region 1 banks). 

3. Enter the End Date or click the Calendar button  to select the date. This should be 
the last day of the month you are currently reconciling. 

4. Click OK or Cancel to exit the Reconciled Bank Balance screen. 

The Reconciled Book Balance report displays. From there, print the report by clicking 
the Print button  or save the report by clicking the Save button.  To adjust the 
display size, use the Zoom buttons. 
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IX. THREE-WAY SUMMARY 

The Three-Way Summary provides a summary of the components of the Three-Way Balance. The 
Three-Way Summary includes: 

REPORT NAME DESCRIPTION 

Book Balance The Book Balance Report is the previous month’s Ending Balance plus the Total 
Deposits, minus the Total Disbursements. 

Escrow Trial Balance  Escrow Trial Balance Total 

Reconciled Bank Balance The Reconciled Bank Balance report is the Bank Ending Balance plus the Total 
Deposits in-transit, minus the Total Outstanding Checks. 

 

X. OUTSTANDING CHECKS; RECONCILED BANK BALANCE 

A. Use the Three-Way Summary report to verify your Book Balance Total, Escrow Trial 
Balance Total, and Reconciled Bank Balance all match. If they do not, investigate and correct 
the discrepancies. See Investigating Discrepancies for more information. 

 NOTE: Before running the Three-Way Summary report, you must complete the Bank 
Reconciliation, Book Balance, Escrow Trial Balance, and Reconciled Bank Balance for 
the previous month of the selected escrow account. 

B. To create a Three-Way Summary: 

1. Click the Three-Way Summary button,   or select Reports > Three-Way 
Summary, or press <Alt>+<R>, then <T>. 

The Three-Way Summary screen opens: 

 
2. From the Select Bank drop-down, select the escrow bank. 

 NOTE: The Select Bank drop-down displays only region specific banks (i.e., Region 
1 users see only Region 1 banks). 

3. Click OK or Cancel to exit the Three-Way Summary screen. 

The Monthly Three-Way Reconciliation report is displayed. From there, print the 
report by clicking the Print button  or save the report by clicking the Save button.  
To adjust the display size, use the Zoom buttons. 
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XI. FULL THREE-WAY WITH SUMMARY 

A. The Full Three-Way with Summary option allows you to make one request to prepare the Book 
Components Balance, Escrow Trial Balance, and Reconciled Bank Balance of the Three-
Way Balance, along with the Three-Way Summary. This option saves the steps of requesting 
and processing each report separately. 

B. To run the Full Three-Way with Summary report: 

1. Select Reports > Full Three-Way with Summary, or press <Alt>+<R>, then <F>. 

The Book Balance screen opens. 

2. From the Select Bank drop-down, select the escrow bank. 

 NOTE: The Select Bank drop-down displays only region specific banks (i.e., Region 
1 users see only Region 1 banks). 

3. Enter the Starting Date or click the Calendar button  to select a date, which should 
be the first day of the month you are currently reconciling. 

4. Enter the Ending Date or click the Calendar button  to select a date, which should be 
the last day of the month you are currently reconciling. 

5. For the Beginning Book Balance, enter the Ending Book Balance for the previous 
month. 

6. Click OK or click Cancel to exit the Book Balance screen. 

The Full Three-Way Monthly report is displayed. Print the report by clicking the Print 
button  or save the report by clicking the Save button.  To adjust the display size, 
use the Zoom buttons. 
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XII. VERIFYING DEPOSITS 

Verifying deposits and deposit slips prevents changes being made to the deposits after they are posted. 
Users cannot make changes to deposits or deposit slips once they are verified in Escrow Accounting.  

 NOTE: This is an optional feature and is not required or intended to replace reconciling your 
monthly bank statement. Verifying deposits does not replace reconciling deposits. 

A. To open the Verify Deposits screen, use one of these methods: 

1. Click the Verify Deposits button;  

2. Select Tools > Verify Deposit; or 

3. Press <Alt>+<T>, then <V>.Please use the screen shot provided 

 
B. Verify Deposits Screen 

1. Use the Verify Deposits screen to verify deposits that have been entered either in 
Complete Closing Enterprise or directly into the Escrow Accounting program. 

2. The Verify Deposits screen includes the following information: 

a. All individual deposits that have not yet been verified. 

b. Deposit slip totals for all items deposited together on one deposit slip that have 
not yet been verified. To help you with your verification, the following 
information is provided for each deposit: 

i. File Number 

ii. Dep(osit) Date 

iii. Transaction Number 

iv. Description (purpose) of the deposit 

v. Amount of deposit 

vi. Deposit Slip 

vii. Bank Number 

viii. File’s branch 

3. To verify more than one deposit at a time, use the <Ctrl> key to select multiple deposits. 
Click the Verify Selected Deposits button  to complete the verification. The verified 
deposits no longer appear in the list. 
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XIII. ADDING OR ADJUSTING CHECKS AND DEPOSITS 

A. To add checks and deposits, use Quick Check Entry and Quick Deposit Entry. 

B. To modify existing checks and deposits, use Check Browser and Deposit Browser. 

XIV. CHECK EDITOR 

A. To open the Check Editor screen, use one of these methods: 

1. Click the Quick Check Entry button;  

2. Select Tools > Quick Check Entry;  

3. Click the Edit button from the Check Browser screen; or 

4. Press <Alt>+<T>, then <K>. 

 
B. The Check Editor screen allows you to enter new checks. The options are described below: 

OPTION DESCRIPTION 

Lookup File 
Number 

Click the Lookup File Number button  to display the Select File Number screen 
where the file number is selected. 

Open Complete 
Closing 
Enterprise 

Click the Open Complete Closing Enterprise button  to open Complete Closing 
Enterprise with the file number of the current check selected. 

Number Enter or add a check number. Enter the check number in the Number field. 

Wire Click the Wire button  to convert the check to a wire.  
 NOTE: Based on security settings applied by your administrator, this button may 

not be accessible. 

Delete Check Click the Delete Check button  to delete a check.  
 NOTE: Based on security settings applied by your administrator, this button may 

not be accessible. 

Insert New 
Check 

Click the Insert New Check button  to save the check and start a new one. 
Available only from Quick Check Entry. 

Date Enter the date in MM/DD/YY format or click the Calendar button  to select a date. 
 NOTE: You may not be allowed to pre/postdate checks beyond the allowable 

range as defined in CCSupervisor by your System Administrator. 
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OPTION DESCRIPTION 

Select a New 
Payee 

Click the Select a New Payee button  to display the Payee screen. From there, 
select either Agent or Buyer/Seller to search for a payee. A list of agents or 
buyers/sellers appears that allows you to search for all names entered as 
agents/vendors or buyers/sellers for any order in the Complete Closing Enterprise 
database. Use the drop-down list to sort the list by one of the column headings. 

Total Amount Enter a check amount. Edit checks using the Check Browser. The amount cannot be 
changed. Enter new checks using the Quick Check Entry option, entering a 
monetary figure. Do not include the dollar sign ($) in your entry. 

Void Date Add or change a void date. Enter the date in MM/DD/YY format or lick the Calendar 

button  to select a date. If you leave the field blank, the check will not expire. 

Reconciliation Select a new reconciliation date from the drop-down list or leave the field blank to 
have no reconciliation date. 

OK Click the OK button  to complete the request. 

Cancel Click the Cancel button  to exit the screen without saving changes. 

 

XV. DEPOSIT EDITOR 

A. To open the Deposit Editor screen, use one of these methods: 

1. Click the Quick Deposit Entry button;  

2. Select Tools > Quick Deposit Entry; 

3. Click the Edit button from the Deposit Browser screen; or 

4. Press <Alt>+<T>, then <T>. 
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B. The Deposit Editor screen allows you to enter new deposits. The options are described below: 

OPTION DESCRIPTION 

Lookup File 
Number 

Click the Lookup File Number button  to display the Select File Number 
screen, where the file number is selected. 

Open Complete 
Closing Enterprise 

Click the Open Complete Closing Enterprise button  to open Complete 
Closing Enterprise with the file number of the current deposit selected. 

Deposit Date Enter the date in MM/DD/YY format or click the Calendar button  to select a 
date. 
 NOTE: You may not be allowed to pre/postdate deposits beyond the allowable 

range as defined in CCSupervisor by your System Administrator. 

Delete Deposit Click the Delete Deposit button  to delete a deposit. 
 NOTE: Based on security settings applied by your administrator, this button 

may not be accessible. 

Insert New Deposit Click the Insert New Deposit button  to save the deposit and start a new one. 
Available only from Quick Deposit Entry. 

Type Funds From the Type (of) Funds drop-down, select Cash, Cashier’s Check, Certified 
Check, Check, Direct Deposit, Money Order, Transfer, or Wire. 
 NOTE: Depending on settings in CCSupervisor, Wire may not be an option. 

Payor Enter the new name in the Payor field. 

Amount Enter a monetary figure. Do not include the dollar sign ($) in your entry. 

Received By Automatically populates with system user name when screen is completed. 

Description Enter a description of the deposit. For example, “Earnest money.” 

Clear Slip Click the Clear Slip button  to remove a deposit from a deposit slip 
record. The Deposit Slip field becomes blank. 

Reconciliation Select a new reconciliation date from the drop-down list or leave the field blank to 
have no reconciliation date. 
If this deposit is part of a deposit slip, it cannot be associated with another 
reconciliation and this field is grayed out. 

Deposit Slip If the deposit was one item on a deposit slip, a deposit slip number can be added 
by selecting it from the Deposit Slip drop-down list. To help you identify deposit 
slips, the list displays an ID Number, Deposit Date, and Bank Account. 
If a deposit slip exists for this item, it cannot be associated with another 
reconciliation and the deposit date cannot be changed. Clearing this field enables 
the Reconciliation and Deposit Date fields. 

Verified Enter in the date or click the Calendar button to select a date. 

Transfer Slip If the EFER was one item on a transfer slip, you can add to a transfer slip number 
by selecting it from the Transfer Slip drop-down list. To help you identify transfer 
slips, the list displays an ID Number, Branch, Bank, Transfer Date, Amount, 
Date Verified, and Verified By. 
If a transfer slip exists for this item, it cannot be associated with another 
reconciliation and the transfer date cannot be changed. Clearing this field, enables 
the Reconciliation and Deposit Date fields. 

OK Click the OK button  to complete the request. 

Cancel Click the Cancel button  to exit the screen without saving changes. 
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XVI. INVESTIGATING DISCREPANCIES 

A. When you find discrepancies between your bank statement and your credits and disbursement 
records in the Bank Balance or among the three components of the Three-Way Balance, you 
must investigate and reconcile these differences. Here are some of the steps to take: 

1. Make sure that each file in Complete Closing Enterprise has the correct escrow account 
assigned to it. Problems frequently occur when file transactions are recorded with the 
wrong escrow account. 

2. Make sure that each check and deposit has been recorded with the correct date. Typical 
entry errors include recording a check or deposit with the wrong month or wrong year. 

3. Make sure that you entered the Beginning Date on the Bank Reconciliation as the next 
calendar date following the previous month’s ending date. This will ensure that no dates 
will be left unaccounted for in the reconciliation process. 

4. Make sure that you entered the Ending Date of the bank statement as the ending date on 
the Bank Reconciliation and Three-Way Balance components. 

5. For bank balance discrepancies, use the Check Browser and Deposit Browser to try to 
find a check or deposit for the amount of the discrepancy. If there is not one check or 
deposit for the amount, look for two or more checks or deposits that add up to the amount 
of the discrepancy. For more information, see Check Browser and Deposit Browser in 
this section of the manual. 

6. If a check or deposit appears in the bank statement but not in the Bank Reconciliation 
screen, look for the item in the Check Browser or Deposit Browser to see if it was 
recorded for the wrong date or wrong escrow account. Also check to see if a check has 
been recorded but never disbursed. 

7. If a check or deposit appears in your Bank Reconciliation screen but not on the bank 
statement, check to see if it was recorded for the wrong date or wrong escrow account. 

8. Note that voided checks appear as negative checks (credits) in the Book Balance on the 
date they were voided. When a voided check is reissued, it appears as a debit on the date 
it is reissued. 

B. After you have identified the cause of a problem, fix the error with the Check Editor or Deposit 
Editor. Return to the Bank Reconciliation scree6n to fix the error there or rerun the appropriate 
Three-Way Balance component. 

XVII. CHECK BROWSER 

A. Check Browser helps you locate checks that need to be adjusted to balance your escrow 
accounting records. Access any check entered through Complete Closing Enterprise or directly in 
the Escrow Accounting program using one or more search criteria. 

B. To open the Check Browser screen, use one of the following methods: 

1. Click the Check Browser  button;  

2. Select Tools > Check Browser; or 

3. Press <Alt>+<T>, then <C>. 
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C. To search for a group of checks, select any or all of the criteria below. For any field you leave 

blank, the search is unrestricted for that criterion. 

OPTION DESCRIPTION 

Voided Status From the Voided Status drop-down, select one of the following: Voided, Checks Only, 
Non-voided Checks Only, or All Checks. 

Clearance 
Status 

From the Clearance Status drop-down, select one of the following: Cleared Checks 
Only, Un-cleared Checks Only, or All Checks. 

Bank From the Bank drop-down, select the bank account you want to search or select all 
banks to make the search unrestricted by bank account. 

File # To search for a specific file number, enter it in the File # field. 

Number To search for a range of check numbers, enter the beginning and ending numbers of the 
range. To search for a single check number, enter the number in the first Number field. 

Amount To search for a range of amount figures, enter the low and high amounts. To search for 
an exact amount, enter that figure in the first Amount field. The decimal point is optional 
for whole dollars. Do not include the Dollar Sign ($) in your entry. 

Date To search for a range of check dates, enter the beginning and ending dates. To search 
for an exact check date, enter the date in the first Date field or click the Calendar button 

 to select a date. 

Apply Enter your search criteria in the top portion of the screen and click the Apply button 

 for the results. 

Navigation 
Arrows 

Use the Navigation Arrows  to scroll through the 
list. 

Close Click the Close button  to save your changes and close the screen. 
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D. After you have retrieved one or more checks, you can browse and select the check(s) that you 
want to modify. To select more than one check, hold down the <Ctrl> key as you click each one. 
Edit selected checks using the following buttons: 

BUTTON FUNCTION 

 
Date: Click this button to change the check date. 
 NOTE: You may not be allowed to pre/postdate checks beyond the allowable range 

as defined in CCSupervisor by your System Administrator. 

 
Void/Unvoid: Click this button to void or unvoid a check or change the void date. 

 
Recon: Click this button to change the reconciliation date or remove date from 
reconciliation. 

 
Payee: Click this button to change the payee name. 

 
Bank: Click this button to change the bank account.  
 NOTE: If the order for which you want to change the escrow account has a deposit 

that is part of a deposit slip and that deposit slip has more than one deposit on it, you 
cannot change the Escrow Account. 

 
Delete: Click this button to delete the check. 

 
Edit: Click this button to open the Check Editor screen and edit the selected check. You 
can change the File Number, Check Number, Check Date, Void Date, and/or 
Reconciliation Date. 
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XVIII. DEPOSIT BROWSER 

A. The Deposit Browser helps you locate deposits or deposit slips that need to be adjusted to 
balance your escrow accounting records. Access any deposit entered through Complete Closing 
Enterprise or directly in the Escrow Accounting program by using one or more search criteria. 

B. To open the Deposit Browser screen, use one of the following methods: 

1. Click the Deposit Browser button;  

2. Select Tools > Deposit Browser; or 

3. Press <Alt>+<T>, then <D>.  

 
C. To search for a group of deposits, select any or all of the criteria below. For any field you leave 

blank, the search is unrestricted for that criterion. 

OPTION DESCRIPTION 

Amount To search for a range of amount figures, enter the low and high amounts. To search for 
an exact amount, enter that figure in the first Amount field. The decimal point is optional 
for whole dollars. Do not include the Dollar Sign ($) in your entry. 

Date To search for a range of deposit dates, enter the beginning and ending dates. To search 
for an exact deposit date, enter the date in the first Date field or click the Calendar 

button  to select a date. 

File Number To search for a specific file number, enter it in the File Number field. 

Bank From the Bank drop-down, select the bank account you want to search or select all 
banks to make the search unrestricted by bank account. 

Navigation 
Arrows 

Use the Navigation Arrows  to scroll through the 
list. 

Clearance 
Status 

From the Clearance Status drop-down, select one of the following: Cleared Deposits 
Only, Uncleared Deposits Only, or All Deposits. 

Apply Enter your search criteria in the top portion of the screen and click the Apply button 
 for the results. 

 
ATG RESOURCE® User Manual Page 9-21 
© ATG (5/15) 



D. After you have retrieved one or more deposits, browse and select the check(s) that you want to 
modify. To select more than one deposit, hold down the <Ctrl> key as you click each one. Edit 
selected deposits by using the following buttons: 

BUTTON FUNCTION 

 
Deposit Date: Click this button to change the deposit date. 
 NOTE: You may not be allowed to pre/postdate deposits beyond the allowable 

range as defined in CCSupervisor by your System Administrator. 

 
Verified Date: Click this button to change the verified date. 

 
Recon Date: Click this button to change the reconciliation date or remove date from 
reconciliation. 

 
Bank: Click this button to change the bank account. 
 NOTE: If the order that you want to change the Escrow Account for has a deposit 

that is part of a deposit slip and that deposit slip has more than one deposit on it, 
you cannot change the Escrow Account. 

 
Delete: Click this button to delete the deposit. 

 
Edit: Click this button to open the Deposit Browser screen and edit the selected 
deposit. You can change the File Number, Deposit Date, Type of Funds, Payor, 
Amount, Description, Reconciliation Date, Deposit Slip, and/or Verified Date. 

 

XIX. CURRENT ESCROW TRIAL BALANCE BROWSER 

A. The Current Escrow Trial Balance (ETB) Browser enables you to review all files with an open 
escrow account balance. This review makes it possible for you to monitor open files that may 
require attention. 

B. To open the Current Escrow Trial Balance (ETB) Browser screen, use one of the following 
methods: 

1. Click the Current ETB Browser button;  

2. Select Tools > Current ETB Browser; or 

3. Press <Alt>+<T>, then <E>. 

C. When you open the Current ETB screen, you must first select the bank account from the Select 
Bank screen. From the Select Bank for ETB drop-down, select the bank and click OK.  
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The Current ETB screen opens: 

 
D. Sort items by clicking the column heading. Sorting by the Last Escrow Activity column shows 

the oldest open files first. Sorting by the Account Balance allows you to prioritize files by size of 
outstanding balance. Select the Show Files with Memos only check box to see only files with 
escrow memos. Edit the memo by double-clicking the field. 

E. Color is used on line items to indicate the state the order is in. Gray indicates a file that has been 
locked from all changes. Light green indicates a file that has been locked from escrow changes. 

XX. OPEN INVESTMENT ACCOUNTS 

A. The Open Investment Accounts screen enables you to review files with an open investment 
account. You can limit the display to accounts belonging to a single branch or show all branches. 
Use this screen to monitor files for which funds are currently in an investment account, view 
details on an individual account, and/or to make adjustments to it. 

B. To open the Open Investment Accounts screen, use one of the following methods: 

1. Click the Active Investment Accounts button;  

2. Select Tools > Investment Accounts; or 

3. Press <Alt>+<T>, then <I>. 

 
C. The Open Investment Accounts screen opens for all branches. To display accounts for a 

particular branch, select the branch from the Branch drop-down. To display accounts for a 
particular region, select the region from the Region drop-down. Based on your user settings 
defined by your System administrator, you may only view regions you are assigned to. 

 
ATG RESOURCE® User Manual Page 9-23 
© ATG (5/15) 



D. Sort items by clicking the column heading. Sorting by the Last Activity column shows the oldest 
open files first. Sorting by the Account Balance allows you to prioritize attention to files based 
on size of outstanding investment balance. 

E. The buttons on the Open Investment Accounts and the Investment Account for File # screens 
are described below: 

BUTTON FUNCTION 

 
Edit/View Selected: Click this button to open the Investment Account for File # 
screen to view or edit the information. 

 
Print: Click this button to print a list of investment accounts. 

 
Print Open Investment Accounts for Date Range: Click this button to open the Date 
Selection for Open Balances screen. Enter the date you want the report to show 

balances for by entering a date or by clicking the Calendar button  to select a date. 

 

XXI. INVESTMENT ACCOUNT FOR FILE # 

A. The Investment Account for File # screen opens when you select a file number from the Open 
Investment Accounts screen. This screen allows you to review details of all transactions in the 
investment account for the selected file, modify an account transaction, or add or delete a 
transaction on the account. 

 
B. The buttons on the Investment Account for File # screen are described below: 

BUTTON FUNCTION 

 
Transfer All: Click this button to transfer funds back to the escrow account. 

 
Transfer Part: Click this button and fill in the amount of money to transfer back to the 
escrow account. 

 
Create New Investment Account: Click this button to add a new investment account. 

 
Delete Investment Account: Click this button to delete the current investment account. 

 
Create Deposit: Click this button to enter a new deposit. 

 
Delete Deposit: Click this button to delete the selected deposit. 
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XXII. CHANGE ESCROW ACCOUNT FOR A FILE 

This screen allows you to change the escrow account you are using for a file. 

A. Select Tools > Change Escrow Account for a File. 

B. Click the Lookup GF Number button.   

C. The Select File Number screen opens. 

D. Select the file number and click OK. 

The file number appears in the File Number field, the current escrow account displays in the 
Current Escrow Account field, and the total checks and deposits currently in this file are 
displayed. 

E. From the New Escrow Acct drop-down, select the new escrow account number. 

1. If any of the deposits and checks listed have actually been deposited in or issued out of 
the original escrow account, you may want to keep them associated with the original 
account for better tracking. If so, select the Keep Deposits/Checks with Original 
Escrow Account checkbox. 

2. If you select the Keep Deposits/Checks with Original Escrow Account checkbox, two 
more checkboxes display. Select the Create a Deposit in New Account for Account 
Balance and Create a Transfer Debit in Original Escrow Account to New Account if 
you want to create a tracking record of transfer to the new account. 

F. Click OK to complete the escrow account change. 

 NOTE: If the order for which you want to change the Escrow Account has a deposit that is part of a 
deposit slip and that deposit slip has more than one deposit on it, you cannot change the Escrow 
Account. 

XXIII. EXPECTED WIRES 

A. The Expected Wires screen lists all deposits entered in Complete Closing with “Wire” 
designated as the Type of Funds. For each anticipated wire, it lists the File Number, Payor, 
Amount, Description, Expected Date, Bank, and Escrow Unit. 

B. To open the Expected Wires screen, use one of the following methods: 

1. Click the Expected Wires button;  

2. Select Tools > Expected Wires; or 

3. Press <Alt>+<T>, then <W>. 
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C. The buttons on the Expected Wires screen are described below: 

BUTTON FUNCTION 

 
Accept Selected: Click this button to accept the currently-selected wire(s) as received, 
using the date displayed in Deposit Date field. 

 
Edit Selected Deposit: Click this button to open the Deposit Editor screen. From there, 
you can make modifications to the deposit. 

 
Add New Deposit: Click this button to open the Deposit Editor button to add a new 
deposit. 

 
Print Expected Deposit List: Click this button to display and print the list of anticipated 
wire deposits. 

 
Delete Selected Deposit: Highlight the line and click this button to delete the entry. 

 
Close: Click this button to exit the Expected Wires screen. 

 
Deposit Date: This date is the date used for accepted deposits. The default is the current 
date; you can change it by entering a new date or by clicking the Calendar button to 
select a date. 

 

XXIV. ACCOUNTING CODES 

Not Available for REsource Users 

XXV. ACTIVITY HISTORY 

A. The Activity History can be useful when investigating discrepancies.  

B. To access the Activity History screen, select Tools > Activity History.  

C. From this screen, you can search by File Number, Date Range, and/or Person. Each check or 
deposit record stores the Action Date/Time, Type, Action, Person, File #, Amount, Check 
Number, Item Date, and Payee. Click the Print button  to view and print the results of the 
search. 

XXVI. ESCROW ROUNDING FIX 

A. Use the Escrow Rounding Fix utility to fix amounts on deposits, checks, orders, and deposit 
slips that may have been rounded incorrectly. This may help you balance if your numbers are off 
by only a few cents. 

B. To open the Escrow Rounding Fix screen, select Tools > Escrow Problem Fix or press 
<Alt>+<T>, then <F>. When you run this option, the system automatically fixes amounts and 
displays the results on the screen. 
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XXVII. OTHER ESCROW ACCOUNTING REPORTS 

Several additional reports are available from the Reports menu. 

A. Deposits for a Date Range 

1. The Deposits for a Date Range report provides details on all deposits made to an escrow 
account within a defined date range. Deposits are included whether they have been 
reconciled or not. For each deposit, the report displays the Date, Transaction ID, File 
Number, Description, and Amount. It also calculates the total for all receipts. 

This report may be useful for investigating discrepancies in your Bank Reconciliation or 
the Three-Way Balance components. 

2. To run the report: 

a. Select Reports > Deposits for a Date Range or press <Alt>+<R>, then <D>. 

 
b. From the Select Bank drop-down, select the escrow account. 

 NOTE: The Bank drop-down list displays only region-specific banks (i.e., 
Region 1 users see only Region 1 banks). 

c. Enter the Starting Date or click the Calendar button  to select a date. 

d. Enter the Ending Date or click the Calendar button  to select a date. 

e. Click OK to run the report or click Cancel to exit the screen without saving 
changes. 

 

3. To print the report, click the Print button.  To adjust the display size, use the Zoom 
buttons. 
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B. Checks for a Date Range 

1. The Checks for a Date Range report provides details on all checks issued from an 
escrow account within a defined date range. Checks are included whether they have been 
reconciled or not. For each check, the report displays the Check Number, Date, File 
Number, Payee, and Amount. It also calculates the total for all issued checks. 

This report may be useful for investigating discrepancies in your Bank Reconciliation or 
the Three-Way Balance components. 

2. To run the report: 

a. Select Reports > Checks for a Date Range or press <Alt>+<R>, then <C>. 

 
b. From the Select Bank drop-down, select the escrow account. 

 NOTE: The Bank drop-down list displays only region-specific banks (i.e., 
Region 1 users see only Region 1 banks). 

c. Enter the Starting Date or click the Calendar button  to select a date. 

d. Enter the Ending Date or click the Calendar button  to select a date. 

e. Click OK to run the report or click Cancel to exit without saving changes. 

 

3. To print the report, click the Print button.  To adjust the display size, use the Zoom 
buttons. 
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C. Absolute Checks for a Date Range 

1. The Absolute Checks for a Date Range report provides the same information as the 
Checks for a Date Range report, but does not include any voided checks within the 
defined date range. 

2. To run this report: 

a. Select Reports > Absolute Checks for a Date Range or press <Alt>+<R>, then 
<A>. 

 
b. From the Select Bank drop-down, select the escrow account. 

 NOTE: The Bank drop-down list displays only region-specific banks (i.e., 
Region 1 users see only Region 1 banks). 

c. Enter the Starting Date or click the Calendar button  to select a date. 

d. Enter the Ending Date or click the Calendar button  to select a date. 

e. Click OK to run the report or click Cancel to exit without saving changes. 

 

3. To print the report, click the Print button.  To adjust the on-screen display to a larger 
size, click any of the Zoom buttons. 
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D. Voided Checks for a Date Range 

1. The Voided Checks for a Date Range report displays all checks from the designated 
escrow bank within a defined date range. For each check, the report lists the Check 
Number, Date, File Number, Payee, and Amount. It also calculates the total for all 
checks voided during the reporting period. 

This report may be useful for investigating discrepancies in your Bank Reconciliation or 
the Three-Way Balance components. Voided checks appear as a negative check (credit) 
in the Book Balance for the month they were voided. (When you reissue a voided check, 
you do so with the current date, so the reissue may appear in a different reconciliation 
from the voided check.) 

2. To run this report: 

a. Select Reports > Voided Checks for a Date Range or press <Alt>+<R>, then 
<V>. 

 
b. From the Bank drop-down, select the escrow account. 

 NOTE: The Bank drop-down list displays only region-specific banks (i.e., 
Region 1 users see only Region 1 banks). 

c. Enter the Starting Date or click the Calendar button  to select a date. 

d. Enter the Ending Date or click the Calendar button  to select a date. 

e. Click OK to run the report or click Cancel to exit without saving changes. 

 

3. To print the report, click the Print button.  To adjust the display size, use the Zoom 
buttons. 
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E. File Balance Query 

1. The File Balance Query report provides information on all checks written and all 
deposits made on an individual file. Total file balance and book balance amounts display 
at the bottom of the report. 

For checks, the report displays the Check Date, Check Number, Payee, Cleared, 
Disbursed, and Undisbursed. If you select the Include The Check Lines check box on 
the Select File screen, the report also displays each Line Item Number, Amount, and 
Description. 

For deposits, the report displays the Deposit Date, Transaction Number, Payor, 
Cleared, Received, Receivable, and Description. 

2. To run this report: 

a. Select Reports > File Balance Query or press <Alt>+<R>, then <Q>. 

 

b. Enter a file number or click the Lookup File Number button  to select a file 
from the Select File Number screen. 

c. Select the Include The Check Lines check box to include all of the Line Item 
Numbers, Amounts, and Descriptions for each check paid to each payee. Do 
not check this option if you want the report to only include the total amount paid 
to each payee. 

d. Click OK to run the report or click Cancel to exit without saving changes. 

 

3. To print the report, click the Print button.  To adjust the display size, use the Zoom 
buttons. 

F. Open Invoices 

Not Available for REsource Users 
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G. Bad Deposit Slip Report 

1. The Bad Deposit Slip report displays all orders with one or both of the following 
problems: 

a. The deposit slip contains a deposit with a date later than the date of the deposit 
slip. 

b. Any of the deposits on the deposit slip contain a bank that does not match the 
bank on the deposit slip. 

 NOTE: The incorrect information is bold and underlined on the report. 

2. To run the Bad Deposit Slip report: 

Select Reports > Bad Deposit Slip or press <Alt>+<R>, then <S>. 

 
XXVIII. ESCROW CHECK WIZARD 

Please contact the REsource Help Desk if your check numbering is not correct. 

XXIX. CONTROL FILES 

A. Using a Control File  

Prior to your first reconciliation, create a new file in REsource for the purpose of entering other 
disbursements and receipts, such as bank charges or earned interest, that appear on your bank 
statement but are not specific to a transaction. The Control file that you create in REsource for 
this purpose should be named Bank ###. (The “###” corresponds to your Escrow Bank number 
in REsource.) 

In this REsource Control file, enter any deposits in the Deposit tab and enter any bank fees in the 
Check tab of Check Writing. Bank fees entered in the Check tab should be changed to a Wire 
and the deposit should be booked. This can also be accomplished from Complete Closing Escrow 
Accounting. 

B. Creating a Control File 

1. Open Complete Closing Enterprise. 

a. Select File > New File - No Suggest.  

 
  

 
Page 9-32 ATG REsource® User Manual 
 © ATG (5/15) 



b. The Tax ID Search Form window opens. 

i. Enter any letters in the Enter Tax ID Number box. 

ii. Click Search. 

iii. Click Create New. 

 
c. In the Enter a New File Number field, type Bank ### (replacing ### with your 

Escrow Bank Number, e.g., Bank 897). 

 
d. Click OK. 

2. Open Check Writing. 

a. Create a deposit in the amount of your initial deposit when your account was 
opened. Enter any other deposits, such as earned interest. Be sure to date and 
book deposits. 
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b. Create any disbursements, such as bank fees, in the Check tab. Be sure to change 
checks to wires. 

 
c. To change a check to a wire: 

i. Click the Transfer button. 

 
ii. Check the Wire Transfer(s) check box. 

 
Once the Control file is created, receipts and disbursements can be added in Complete Closing 
Escrow Accounting. 

C. Add a Disbursement to the Control File.  

1. Open Complete Closing Escrow Accounting. 

 

2. Click the Quick Check Entry button  to open the Check Editor. 

 
3. Enter the name of your Control file in the File # field. 

4. To change the check to a wire, click the Turn Check to a Wire button.  

5. Enter the Date, Amount, and Payee. 

6. Apply the receipt to a Reconciliation, if necessary.  

7. Click OK.  
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D. Add a receipt to the Control file. 

1. Open Complete Closing Escrow Accounting. 

2. Click the Quick Deposit Entry button  to open the Deposit Editor.  

 
3. Enter the name of your Control file in the File # field. 

4. Enter the Deposit Date, Type of Funds, Payor, Amount, and Description. 

5. Apply the deposit to a Reconciliation, if necessary.  

6. Click OK. 

XXX. ESCROW ACCOUNTING BEST PRACTICES 

A. If your existing REsource escrow account has not been reconciled using Complete Closing 
Escrow Accounting, it is advisable to open a new Escrow Account at your bank. When your new 
account and checks are ready, contact the REsource Help Desk to have a new REsource Escrow 
Account number assigned to you. By default, all new files will be opened using the new 
REsource Escrow Account number. When you receive the first bank statement for your new 
account, contact the REsource Help Desk for assistance in completing your first reconciliation.  

B. Segregate duties so reconciliation is not performed by an escrow trust account signatory or 
approver of bank transactions. If you are the individual responsible for reconciliation, contact the 
REsource Help Desk for an update to your security. 

C. Perform a Three-Way Reconciliation at least monthly. 

D. Use the Current Escrow Trial Balance Browser tool in CC Escrow Accounting daily to 
monitor files with an open escrow account balance.  

E. The most common causes of out-of-balance situations are un-posted deposits and incorrect 
deposit dates. Always use the actual date of the deposit before posting the deposit. 

F. Use the REsource Control file for entering your bank fees or interest rather than the Other 
Receipts and Disbursements feature in the Bank Reconciliation screen. 

G. For assistance, contact the REsource Help Desk at 888.776.4420 or atgresource@atgf.com.  
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10 | POLICY PREPARATION 

I. SCHEDULE A OF THE OWNER’S POLICY AND LOAN POLICY 

The information for the Schedule A of the policies is imported from the Commitment Schedule A tab. 
Therefore, prior to preparing the policies, edit the Insured or the Legal Description in the Commitment 
Schedule A tab. To edit the Amount of Insurance, return to the Order Entry > Loan tab. 

A. To enter/edit information for the Owner’s or Loan Policy, click the Commitment/Policy 
Preparation button  or select Data Entry > Commitment/Policy/Binder from the menu bar.  

 
 

 

 

Commitment Schedule A 

 
B. Review the information displayed in the sub-tabs (Owner Insured, Mortg. Insured, Current 

Title Holders, and Legal Desc) and edit if necessary. The information in these tabs is used for 
the policies. 

C. The information for Schedule B of the policies is imported from the Commitment > Schedule 
B > Exceptions tab. Therefore, prior to preparing the policies, edit Special Exceptions in the 
Commitment > Schedule B > Exceptions tab.  

D. The following is an illustration of the Commitment > Schedule B > Exceptions tab. These are 
the exceptions that were raised on the commitment. The Schedule B exceptions that appeared on 
the commitment will automatically appear on the policies, unless those exceptions were marked, 
“Do not delete waived Schedule B exceptions.” Instead, use the Mark Selected Text feature 
described below. 

Data Entry > 
Commitment/Policy/Binder 

Commitment/Policy 
Preparation 
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1. To enter/edit information for the Owner’s Policy or Loan Policy, click the 
Commitment/Policy Preparation button  or select Commitment/Policy/Binder 
from the Data Entry menu.  

2. Select the Schedule B tab and then the Exceptions sub-tab. 

3. To include or exclude an exception on the Owner’s Policy or Loan Policy, highlight the 
exception and click one of the Mark Selected Text buttons. 

Commitment Schedule B> Exception Tab 

 

4.  Mark Selected Text for Inclusion on all Policies (Black). By default, all exceptions 
will be black for inclusion on the final policy. 

5.  Mark Selected Text for Inclusion on Owner’s Policy Only (Blue). 

6.  Mark Selected Text for Inclusion on Loan Policy/Exclusion from Owner  
Policy (Pink). 

7.  Mark Selected Text for Exclusion from All Policies (Olive). 

II. OWNER’S POLICY – SCHEDULE B  

Instructions for preparing Schedule B of the Owner’s Policy: 

A. To prepare the Owner’s Policy and/or Loan Policy, select the Policy tab. 

 

Policy Numbers 
Policy Date 
(Effective Date) 

Mark selected text for exclusion or 
inclusion on policies (Olive Text) 
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B. The Owner’s and Loan Policy Numbers will automatically display. Policy numbers are the same 
as the File Number and the Commitment Number followed by “-01.”  

 NOTE: Policy jackets are printed in REsource. Pre-printed serialized jackets are no longer 
used. 

C. Enter the Effective Date or click the Fill in Date Using Calendar button.   

D. Enter the Policy Time, if known. 

E. All selected (not marked) exceptions from the Commitment > Schedule B > Exceptions tab will 
automatically appear unmarked in the Owner Schedule B sub-tab and the Mortg. Schedule B 
sub-tab the first time that the Policy tab is selected.  

F. Add or edit exceptions or select language from the Lookup Standard Language Items 
button,  as required. 

 

G. To start over, use the Clear and Pull Commitment for Both Owner and Mortgagee button.  
This will delete all exceptions entered in both the Owner Sched B and Mortgagee Sched B tabs 
and import the exceptions from the commitment again.  

 NOTE: Any new exceptions should be added after the original exceptions have been 
imported from the commitment. 

  

Owner Sched B Mortg. Sched B 

Clear and Pull Commitment for 
Both Owner and Mortgagee 
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III. SCHEDULE B PART II 

The Mortg. Sched B II sub-tab is used only if there is a second (subordinate) mortgage to insure or to 
reflect other matters over which the lien of the insured mortgage has priority.  

A. Select the Mortg. Sched B II sub-tab. The Mortgage Schedule B Part II text area will display. 

 
B. The Schedule B Part II language will automatically print on the Schedule B Part II document. 

Click the Lookup Standard Language Items button  to select the mortgage exception 
language, or other matters that may be required in this section. 

C. Remember that all exceptions raised under the Schedule B Part II must also be included on the 
Owner’s Policy Schedule B. Exceptions should be copied from the Mortg. Sched B Part II sub-
tab to the Owner Sched B sub-tab. Please follow the instructions below to copy the Schedule B 
Part II to Schedule B of the Owner’s Policy. 

1. After entering the Schedule B Part II language, highlight the text. 

2. Press <Ctrl>+<C> to copy the text. 

3. Select the Owner Sched B sub-tab. 

4. Place the cursor in the desired text area and press <Ctrl>+<V> to paste the text.  

5. When printing the Loan Policy, remember also to print the Loan Policy Schedule B Part 
II document, if required, and include with the Loan Policy. 

IV. INSURED MORTGAGE  

Instructions for completing the Insured Mortg sub-tab. 

A. Select the Insured Mortg sub-tab. The Insured Mortgage text area displays. 

B. Enter the new mortgage exception, if any, or click the Lookup Standard Language Items 
button.  Select Mortgage from the Category drop-down list, select the New Mortgage 
Exception, and answer the prompts. 

C. The new mortgage exception will automatically appear on the Loan Policy Schedule A. 

Mortg. Sched B II 
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D. The new mortgage exception will not automatically appear on the Owner’s Policy Schedule B. 

Please follow the instructions below to copy the new mortgage exception to the Schedule B of the 
Owner’s Policy. 

1. After entering the new mortgage exception in the Insured Mortg sub-tab, highlight the 
text. 

2. Press <Ctrl>+<C> to copy the text. 

3. Select the Owner Sched B sub-tab. 

4. Place the cursor under the Real Estate Tax exception and press <Ctrl>+<V> to paste the 
text.  

5. Press the <Ctrl>+<N> to add the bullet.  

V. TITLE VESTED IN  

Instructions for completing the Title Vested In sub-tab: 

A. Select the Title Vested In sub-tab. The Title Vested In text area will display to display.  

 

B. Click the Insert Buyer/Seller button  to import the Name(s) of Buyer or Seller. 

Insured Mortg. 

Title Vested In 

Insert Buyer/ Seller Names 
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VI. PRINTING THE OWNER’S POLICY AND LOAN POLICY 

Several document packages are available from the Print Document list. The packages contain all of the 
individual documents commonly issued with the policies. 

The packages appear in blue. Select the ATG Pkg. Mortgagee Pol 06 to print the Loan Policy or the 
ATG Pkg. Owner Pol 06 to print the Owner’s Policy. 
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11 | TWO MORTGAGES, ONE LOAN POLICY 

When there are two mortgages given on the same property at the time of closing, the lender will require that either 
two separate Loan Policies are issued insuring each mortgage or that both mortgages are insured on one Loan 
Policy. Always check with the lender, prior to closing, to determine specific requirements. Follow the instructions 
below to prepare one Loan Policy insuring two mortgages. (The next chapter addresses preparing two Loan 
Policies – one for each mortgage). 

I. POLICY PREPARATION 

To prepare a Loan Policy insuring two mortgages, prepare the Owner’s Policy and Loan Policy following 
all instructions listed in the Policy Preparation section of this manual, and then do the following. 

A. Go to Order Entry and select the Loan tab. Under 2nd Loan Information, enter the Loan 
Amount and Lender name. Close Order Entry. 

 

B. Click the Commitment/Policy Preparation button  or select Commitment/Policy/Binder 
from the Data Entry menu.  

C. Under the Cmt Sched A tab, select the 2nd Mortg. Insured sub-tab. 

2nd Loan Information 
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D. Click the Insert Mortg. Insured Name(s) in Text Box button  to insert the Second 
Mortgagee’s name(s). 

 
1. Select the Commitment > Schedule B > Exceptions sub-tab to select exceptions for 

inclusion in or exclusion from the policies. 

2. Select the Policy > 2nd Ins Mortg. Desc. sub-tab. 

 

3. Click the Lookup Standard Language Items button.  From the Category drop-
down, select Mortgage. From the resulting list, select New 2nd Mortgage. This exception 
will insert the names of the buyers, second lender name, and second loan amount. Enter 
the recording information at the prompts. 

4. Copy and paste the second mortgage description into the text box under the Owner 
Sched B sub-tab. The first mortgage description must also be copied into the text box 
under the Owner Sched B sub-tab. 

2nd Mortg. Insured 

Policy 

2nd Ins. Mortg. Desc. 

Insert Mortg. Insured 
Name(s) in Text Box 
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 TIP: To copy and paste: 

– Highlight the second mortgage description and press <Ctrl>+<C>. 

– Select the Mortg. Schedule B II sub-tab, place the cursor in the text entry area, 
and press <Ctrl>+<V>. 

II. PRINTING THE LOAN POLICY INSURING TWO MORTGAGES 

A. Click the Print/Create Document button.  

B. Under Print Documents, select ATG Pkg. One MPA 2 Mortgages 06. 

C. The following documents are contained in this package: 

1. Loan Policy Cover 

2. Schedule A (listing both mortgages) 

3. Schedule B 

4. Endorsements: 

a. Environmental Protection Lien (EPL) 

b. Comprehensive 

c. Location 

d. Multiple Mortgage 

 NOTE: The Multiple Mortgage Endorsement deletes the policy provisions regarding priority of the 
insured mortgage, paragraph 6 of the insuring provisions, and substitutes a new insuring provision 
that sets forth the priority between the two insured mortgages. In order to issue the Multiple Mortgage 
Endorsement, the mortgage documents themselves should state a priority between the mortgages 

 
 

 
ATG RESOURCE® User Manual Page 11-3 
© ATG (5/15) 



 

 

 

 
 

 
 

12 
Two Mortgages,  

Two Loan Policies 
 

 
 

 

 



12 | TWO MORTGAGES, TWO LOAN POLICIES 

I. POLICY PREPARATION 

When there are two mortgages given on the same property at the time of closing, the lender(s) will require 
that either two separate Loan Policies be issued insuring each mortgage or that both mortgages be insured 
on one Loan Policy. Always check with the lender, prior to closing, to determine specific requirements. 
Follow the instructions below to prepare two Loan Policies insuring each of the two mortgages. (The 
preceding section addresses preparing one Loan Policy for both mortgages.) 

To prepare two separate Loan Policies, prepare the Owner’s Policy and Loan Policy following all 
instructions listed in the Policy Preparation section of this manual, and then do the following: 

A. Go to Order Entry and select the Loan/Misc tab. Under 2nd Loan Information, enter the Loan 
Amount and Lender name. Close Order Entry. 

 

B. Click the Commitment/Policy Preparation button  or select Commitment/Policy/Binder 
from the Data Entry menu.  

C. Under the Cmt Sched A tab, select the 2nd Mortg. Insured sub-tab. 

 

2nd Loan Information 

2nd Mortg. Insured 
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D. Click the Insert Mortg. Insured Name(s) in Text Box button  to insert the Second 
Mortgagee’s name(s). 

E. Select the Commitment > Schedule B > Exceptions sub-tab to select exceptions for inclusion in 
or exclusion from the policies. 

F. Select the Policy tab. 

 
1. Enter the second Loan Policy number in the 2nd Mortg. Policy Number field. The policy 

number should be the same as the file number followed by “–A.” 

2. Select the 2nd Mortg. Sched B sub-tab. 

3. Click the Create Sched B from 1st Policy button.  The Schedule B exception from 
the first Mortg. Sched B sub-tab and the first Insured Mortg sub-tab will be copied into 
the text box under the 2nd Mortg. Sched B sub-tab. 

 

Policy 

2nd Mortg. Sched B 

2nd Mortg. Policy Number 

2nd Ins. Mortg. Desc. 

Create Sched B from 1st Policy 

2nd Insured Mortg. Desc. 
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G. Select the 2nd Ins. Mortg. Desc sub-tab. 

H. Click the Lookup Standard Language Items button.  From the Category drop-down, select 
Mortgage. From the resulting list, select New 2nd Mortgage. This exception will insert the 
names of the buyers, second lender name, and second loan amount. Enter the recording 
information at the prompts. 

 
I. Copy and paste the second mortgage description into the text box under the Mortg. Schedule 

B II sub-tab. The first mortgage description must also be copied into the text box under the 
Owner Sched B sub-tab. 

 TIP: To copy and paste: 

– Highlight the second mortgage description and press <Ctrl>+<C>. 

– Select the Mortg. Schedule B II sub-tab, place the cursor in the text entry area, and press 
<Ctrl>+<V>. 

J. Copy and paste the second mortgage description into the text box under the Owner Sched B tab. 
The first mortgage description must also be copied into the text box under the Owner Sched B 
sub-tab. 

II. PRINTING THE LOAN POLICY INSURING TWO MORTGAGES 

A. Click the Print/Create Document button.  

B. Under Print Documents, select ATG Pkg. Two MPAs 2 Mortgs. 06. 

The following documents are contained in this package: 

1. First Loan Policy 

a. Loan Policy Cover 

b. Schedule A 

c. Schedule B 

d. Schedule B Part II 

e. Environmental Protection Lien (EPL) and Comprehensive Endorsements are 
included on the Schedule A of the Loan Policy. 

2nd Ins. Mortg. Desc 
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2. Second Loan Policy 

a. Loan Policy Cover 

b. Schedule A 

c. Schedule B 

d. Environmental Protection Lien (EPL) and Comprehensive Endorsements are 
included on the Schedule A of the Loan Policy. 

III. PRINTING THE OWNER’S POLICY AND/OR LOAN POLICY 

A. Click the Print/Create Document button  located on the toolbar. 

B. Select either the ATG Pkg. Owner’s Pol 06 and ATG Pkg. Mortgagee Pol 06 package 
documents or click Category and select Owner’s Policy 2006 or Mortgagee Policy 2006 for a 
list of all documents.  
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13 | MISCELLANEOUS 

I. FILE ATTACHMENT UTILITY 

The File Attachment Utility is used to store scanned documents such as an ATG Initial Search Report, 
Later Date Search Report, Closing Protection Letters, Closing Packages, copies of the issued 
commitment, policies, signed ALTA Statement, Accounting Information Schedule, and affidavits 
submitted to ATG. Documents that have been scanned are attached to the REsource file by ATG and are 
available to view or print. 

A. Click the File Attachment Utility button  or select Attachments from the ATGF Extensions 
menu to access scanned document images.  

 
B. Double-click the desired group of documents.  

 

File Attachment  

 
C. Click the Zoom drop-down menu to select a preset magnification. 

D. Click the page navigation arrows  to move to a different page. 

ATGF Extensions > 
Attachments 

File Attachment Utility 
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E. Click the Print button to print the document. 

 NOTE: To print a document from the Attached File Manager, highlight the document 
and click the Print button on the toolbar or click the File menu to print all or selected 
pages of the image. 

 
F. Highlight your local printer from the Select Printer list. 

G. Select the page range and click OK. 

 
II. CREATE CUSTOM STANDARD LANGUAGE 

A. The Standard Language feature enables you to create custom special exception language. Many 
exceptions have already been created for your use; see the Standard Language Entries section of 
this manual for a complete listing. 

B. Standard language exceptions can be simple text or can include user prompts for data entry and/or 
insert field values from Complete Closing.  

C. To start the Standard Language program, click the Standard Language Entry icon  on 
the REsource Desktop. 

REsource Desktop 

 
Standard Language Entry 
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Standard Language 

 
D. Standard Language is organized by Category and then by Description for easy access. 

Members are asked to create a new Category using their Member Number as the name of the 
Category, and enter all their exceptions in that one Category. Many exceptions or groups of 
exceptions can be entered within a Category. 

E. Creating custom Standard Language 

1. Create custom Standard Language by clicking the New Category button.   

 
2. Enter a name of the Category (member number). 

3. Enter a descriptive name for the exception in the Description field and click OK. 

Category 

Description 

New Category 
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4. Click inside the text area and enter the exception. Be sure to insert the bullet () by 

pressing <Ctrl>+<N>. Right-click inside the text area for additional text editing options 
such as Spell Check. 

5. To add additional exceptions to this Category, click the Add New Entry button.   

6. Enter a new descriptive name for the exception in the Description field and begin 
entering the next exception. Many exceptions can be added to the Category. 

7. Use the Navigation buttons  to view all exceptions in the Category.  

F. Instructions for Creating User Prompts 

Prompts directing the user to enter information, such as a Document Number or Date, can be 
inserted into an exception when the Standard Language is selected in Complete Closing. When 
the Insert Prompt option is selected, the user defines the prompt, such as “Enter the document 
number of the mortgage” or “Enter the recording date of the assignment.” The user also selects 
the type of data and the format of the data such as a date, with the month spelled out. Follow the 
instructions below to insert prompts into your standard language.  

1. Click the Insert Prompt button.   

 
2. Select the Type of Prompt. 

Insert Prompt 

 
Page 13-4 ATG REsource® User Manual 
 © ATG (5/15) 



3. Enter a user prompt in the Prompt for User field. 

4. Click OK. 

The code will be embedded in the text of the exception. When this exception is selected from the 
Lookup Standard Language in Compete Closing’s Commitment Sched B > Exceptions sub-
tab, the user prompt will display. When the user enters a response, the response is inserted in the 
exception. 

G. Instructions for Inserting Fields 

Additionally, all REsource data, such as Seller/Buyer Names, can be imported into Standard 
Language. This option enables the data from any field to be inserted into an exception 
eliminating the need to re-enter data already entered in Complete Closing. Follow the instructions 
below to insert a field into a Standard Language exception. In this example, the exception for 
possible judgments will import the names of the Seller. 

1. Click the Insert Field from Table button.   

 
2. Click the Plus (+) in front of the folder that contains the needed information. The folders 

correspond to the tabs in Complete Closing. In this example, click the Seller 
Information folder. 

3. Click the Seller Formal Name so that it becomes highlighted.  

4. Click OK. 

5. The Seller name will now be coded into this exception. To check the exception, open 
Complete Closing and select a file. Click the Commitment/Policy Preparation button, 

 select the Sched B tab and then the Exceptions sub-tab. Click the Lookup Standard 
Language Items button, select the [Your Name] Category and double-click the 
newly created exception. The exception will appear in the text area complete with the 
Seller name. 

H. Edit Standard Language 

1. To edit Standard Language, close Complete Closing and return to the Standard 

Language program by clicking the Standard Language icon  on the REsource 
desktop.  

2. Locate your Category by clicking the Lookup Category button.  

Insert Field from 
Table 
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3. Using the Navigation buttons,  locate the exception language. 

4. The language will display in the text area available for editing. 

 NOTE: Only Standard Language created in your region can be edited. Standard 
Language created in a region can only be viewed by users in that region. In addition, 
please refrain from adding standard language to existing categories created by ATG 
as these may be updated from time to time. 

III. ORGANIZATIONAL FEATURES 

Standard Language items can be organized into packages (groups of standard language). Codes can be 
assigned to Standard Language items instead of descriptions. 

A. Packages 

1. Packages, which group exceptions together, can be created within existing categories. In 
the example below, a package was created called “Standard Residential.” Two common 
residential exceptions were placed in the package. 

 
2. To create a Standard Language Package: 

a. Select Standard Language Entry  from the REsource 
Desktop. 

b. Select File > Setup Packages. 

 
c. Click the Create New Package  button.  

 
 
Page 13-6 ATG REsource® User Manual 
 © ATG (5/15) 



d. Name your package and enter the same name in the Package Category field. 

e. Select the exceptions from the list. 

f. Close when finished. 

B. Codes 

Codes can now be associated with Standard Language items and the codes can then be used 
when looking up Standard Language. To enter a Code for a Standard Language item: 

1. Select Standard Language Entry from the REsource Desktop.  

2. Create a new Standard Language item or select an existing item. 

3. Enter the Code, usually a combination of letters and/or numbers, in the Code field and 
close. 

 
4. The Standard Language item can be located by changing the Search By field from 

Description to Code while in the Standard Language Lookup. 

 
IV. PAPERLESSCLOSER 

A. Placing an Order  

1. Login: Go to http://resource.atgf.com. 

Enter your User Name and Password in the login screen. Do not use a dash (-) in your 
password.  

 HINT: PaperlessCloser uses the same user name and password as the ATG website. 

 
2. Browser Settings (Internet Explorer) 

a. Click Tools > Pop-up Blocker > Turn Off Pop-up Blocker. 
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b. Click Tools > Internet Options > Security. Select Trusted Sites and click the 
Sites button. Add http://*.atgf.com to the trusted zone. 

3. From the Lobby, click the New Order link. 

 

 
4. Click Use single order entry form. 

 
5. All data entry sections will open. Complete all required fields. 

 

 

 

 

 
Page 13-8 ATG REsource® User Manual 
 © ATG (5/15) 

http://*.atgf.com/


 

 

 

 

 

 NOTE: Use only numbers when entering Sale Price, Earnest Money, and Loan 
Amount. 

 
6. Using the Search feature: 

a. The Lender, Mortgage Broker, and Buyer’s Attorney sections contain a 

Search button . 

b. Click the Search button before entering information in the fields. 

c. Enter the search criteria (“ABC Lender” in this example). 

d. Click the Search button. The search results display at the bottom of the screen. 
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e. Click the Add To Order link in front of the desired agent. 

 
f. The Search screen closes and the information populates the section in which the 

search was initiated. 

 NOTE: If the agent is not found, click the Add New button, complete the 
form, and click the Add New button. The Search screen closes and the 
information populates the screen in which the search was initiated. 

7. Saving using the Add Button  

a. The Seller, Buyer, and Property sections contain an Add button, located at the 
bottom of each section.    

 NOTE: To save the data entered in each of these sections, you must click the 
Add button. If the Add button is not clicked, the Seller, Buyer, and 
Property information will not be saved. 

b. The data will now be displayed at the bottom of the section and the data entry 
fields will be cleared. 

 
8. To enter multiple Sellers, Buyers, or Properties, click the Add button after entering each 

new item. 

9. Use the Clear Form button  to delete all data in that section. 

10. To remove saved information, check the checkbox and click the Remove 
button. . 
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11. Click the Submit Order button  at the bottom of the page. The Property 
Information dialog opens. 

 
12. Complete the Property Information, including the Property Type, Search Provider, and 

Order Category. 

 NOTE: The order must contain a property Address, County, State, and, if possible, 
a Tax ID number (Permanent Index Number). 

13. Click the Add Property button.  The Services page displays. 

 
14. Select the desired services. Typical services include: 

a. Search – No Prior or Search – With Prior; 

b. Endorsements, if known; 

c. Type of Property and Transaction Type; 

d. Full Closing, unless your office is authorized to close. 

15. Click the Submit Services button  when finished. 

 
ATG RESOURCE® User Manual Page 13-11 
© ATG (5/15) 



16. Click Continue. 

 
17. Your order is now complete and the File Number displays. 

. 

18. Click the Return to Lobby button  to continue or to logoff. 

 
B. Checking the Status of an Order 

1. From the Lobby, click the desired File Number. 

 
2. From the Conference Room select File Status. 
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3. The File Status displays. 

 
C. Printing a Published Document 

1. The Print Document option allows one or more documents in the list of current 
documents to be printed. 

2. To print a document: 

a. From the Lobby, click the desired file number. 

b. From the Conference Room, select Documents. 

c. Select the check box next to each document you want to print. 

d. Click the Print button. 

 
e. The document will display in the selected format. 

f. Select File > Print to print the document. 
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D. Printing a Scanned Document 

1. From the Lobby, click the desired File Number. 

2. From the Conference Room, select Scanned Documents. 

3. Select the check box next to each document you want to print. 

4. Select Scanned Documents. 

 
5. Select the desired scanned document from the list and select Open from the Download 

menu. 

 
E. Using a Template to Create an Order 

1. Once a template is saved, the template can be used for future orders that have common 
elements, such as the Lender, Buyer/Seller, Property, and other selectable information. 

2. To create a template: 

a. From the Lobby, navigate to the New Order page. A blank order form displays. 

b. Select the Single order entry form link. 

c. Complete the information that will remain the same such as the Lender, 
Buyer/Seller, Property, and other selectable information. 

d. When finished, click the Save as Template button  at the 
bottom of the page. 

e. Enter a name for the template and click Save. 

 
3. To use a template: 

a. From the Lobby, navigate to the New Order page. A blank order form displays. 

b. Select the Single order entry form link. 

c. Click the Use a saved template link. 
The Select an Order Template screen opens. 

d. Select a template from the Select a Template drop-down. 

 
e. Click the OK button. The template displays as a new order. 
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f. Complete the remaining information and click Submit.  

i. Prior Policies should be faxed to 312.224.0330 and should include the 
REsource file number. 

ii. You will receive an e-mail notification upon placing your order. 

iii. Please call the REsource Helpdesk at 888.776.4420 with questions. 

F. Preparing a Seller’s Closing Statement  

1. Opening the Closing Statement 

a. Select the desired file in the PaperlessCloser Lobby. 

b. Select Closing Statement 

 
c. The Closing Statement page displays. 

 
 

 
d. The Closing Statement will populate with information contained in the file. To 

update the Closing Statement with the latest information, click the Resync 
REsource Data button.  The Closing Statement will 
populate and recalculate with the updated information, if any. 
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2. Entering and Editing Data 

a. Double-click the row of the desired line item to enter and/or edit data. The Editor 
window opens. 

 
b. The Description/Item of any line may be changed, if desired. 

c. Enter the payee’s name, if any, in the Payee field. 

d. Enter the amount in the Buyer Credits field (Seller charge) or Seller Credits 
field (Buyer charge). Do not type dollar signs ($) or commas (,); they will auto-
fill. 

e. Click Update to save or Cancel to exit line editing. 

3. Adding Title Charges and Miscellaneous Charges 

a. Right click inside the row of a line item to display options. 

 
b. Select add Title Charge to add an item to the Title Charges category or select 

add Misc Charge to add an item to the Miscellaneous Category. The Add 
Closing Statement Item menu opens. 

 
c. Enter the item description in the Description field. 

d. Enter the payee’s name, if any, in the Payee field. 

e. Enter the amount in the Buyer Credits field (Seller charge) or Seller Credits 
field (Buyer charge). Do not type dollar signs ($) or commas (,); they will auto-
fill. 

f. Click the Save or Cancel button.  

4. Removing Items 

a. Right click on the line item to be removed to display options. 

 
b. To remove an unused or unwanted line item in its entirety, select remove item.  
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5. Saving Changes 

Click the Save Changes button  on the toolbar to save changes. 

This button MUST be selected prior to exiting the Closing Statement; otherwise, ALL 
data entered will be LOST. 

6. Printing 

To print the Closing Statement, click the Print button  on the toolbar. 

7. Submitting the Completed Closing Statement via Email (Chicago Area Only) 

To send the completed Closing Statement to the ATG Closing Services department, click 
the Complete – Submit to Closing Services button.  

8. Exiting Closing Statement 

To exit the Closing Statement and return to the PaperlessCloser Lobby, click the return 
to file lobby button  on the toolbar. 

G. Requesting a Closing Using PaperlessCloser 

1. To request a closing using PaperlessCloser: 

a. Select the desired file in the PaperlessCloser Lobby  

b. Select Schedule Closing. 
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c. The ATG-Assisted Closing Request page opens. 

 

 
i. Closing information 

 
(1) Requested Date and Time 

Entering the closing date will indicate to ATG Closing Services 
that you have requested a closing. 

(a) Date (Required) 

To enter the closing date, click in the Date field. A 
calendar will display. Select the closing date. 

(b) Time (Required) 

To enter the closing time, click in the Time field. A list 
of times will display. Select the closing time. 

 NOTE: The requested closing date must be entered and 
saved. If the requested closing date is not entered and saved, 
the closing request cannot be processed. 

(2) Lender Confirmed Date and Time 

Date and time the lender confirmed the closing. 
 
Page 13-18 ATG REsource® User Manual 
 © ATG (5/15) 



(3) Miscellaneous (Misc) 

(a) RESPA, Checks, Package 

To select the party responsible for the preparation of the 
HUD-1 Settlement Statement, Checks for Disbursement, 
and Loan Package Pickup, click the drop-down arrow 

 at the end of each field. The available choices are 
ATG and the Member. 

(b) Search Provider 

Select the Search Provider by clicking the drop down 
arrow 

(c) Date Taken 

Current date 

(4) Notes 

Add any additional information, if any. 

(5) Click the Save button.  

ii. Place of Closing 

(1) The place of closing will populate with the member’s address by 
default. 

 

(2) To change the place of closing, click the pencil icon.  The 
Change Place Of Closing dialog box displays. 

 
(3) Begin typing the location in the Lookup field. Several choices 

will display. For an ATG closing office, begin your search with 
the letters “ATG.” 

(4) Select the location of the closing and click the Save or Cancel 
button.  
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iii. Contact Loan 1 and 2; Contact Broker 

(1) The Lender information is populated with the information 
contained in the file. 

 

(2) The Lender can be changed by clicking the pencil icon.  The 
Lender Contact dialog box opens. 

 
(3) Enter the Lender Contact name, Company name, and Phone 

and Fax numbers.  

(4) Click the Save or Cancel button.  

(5) To add a second lender or mortgage broker, use the Contact 
Loan 2 or Contact Broker tab. Enter the information and click 
the Save or Cancel button.   

iv. Buyer’s Attorney  

(1) The Buyer’s Attorney information is populated with the 
information contained in the file. 

 
(2) The Buyer’s Attorney can be changed by clicking the pencil 

icon.  The Buyer’s Attorney dialog box opens. 
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(3) Enter the Buyer’s Attorney name, Address, Phone, and Fax 
numbers.  

(4) Click the Save or Cancel button.  

v. Additional Closing Information 

The data contained in the Property, Member, Buyer, Seller, and 
Seller’s Attorney sections is pulled from the order information. If any of 
this information is incorrect, use the Note field to type corrections.  

 

 

 

 
2. File Status 

There are five status levels assigned to each closing: 

a. None 

The closing has not been requested; no closing date has been entered in the ATG-
Assisted Closing Request page. 

b. Requested 

ATG has received and is processing the closing request. Entering a closing date 
and time will automatically change the closing status to requested. 

c. Approved 

ATG has confirmed the closing with all parties. The assigned closer’s name 
assigned RESPA Operator’s name will display in the Status box. 

d. Cancelled 

The closing has been cancelled by the member or by the lender. To cancel a 
closing, contact the Closing Services Department. 
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e. File Locked 

i. Twenty-four (24) hours prior to the closing, the file will be locked 
automatically. Any changes to the closing information displayed on the 
ATG-Assisted Closing Request page will require a call to the ATG 
Closing Services Department. 

 
3. Notes 

a. Add additional notes, if any 

 

b. Click the Save button.  

4. Print 

To print a summary of the Closing Request click the Print button.  

 
V. ILLINOIS REAL ESTATE TRANSFER DECLARATION 

Instructions for Preparing the Illinois PTAX-203 

Complete Closing prepares, saves, and prints the PTAX, Cook County, and Chicago Transfer 
Declarations. Necessary information regarding the transaction must be entered in the Order Entry tab, 
including Buyer/Seller Name and Address, Buyer/Seller Attorney Name and Address, Property 
Address, PIN(s) (Tax ID Number), County, Township and Purchase Price. In addition, enter the full 
Legal Description in Commitment Schedule A > Legal Description. 

A. Click the Prepare Transfer Tax Documents button  on the toolbar or select Utilities > ATG 
Transfer Tax. 

 
 Prepare Transfer Tax 

Documents 

Utilities>ATG 
Transfer Tax 

Print 
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1. Click File > Open and select Illinois PTAX-203. 

 
2. The PTAX-203 data entry form displays. 

 
B. Parcel Information 

1. Parcel No.  

Enter the Parcel Number (PIN/Tax ID). If the Tax ID number has been entered in 
Order Entry, this field will auto-fill. 

 NOTE: The data in the PTAX form will not be saved without a Parcel No. 

2. Lot Size 

Enter the Lot Size. 

3. County 

Enter the County of the property. If the County has been entered in Order Entry, this 
field will auto-fill. 

 NOTE: The Transfer Tax amounts will not calculate without a County. 

 
ATG RESOURCE® User Manual Page 13-23 
© ATG (5/15) 



4. Township 

Select the Township from the drop-down list. If the Township has been entered in 
Order Entry, this field will auto-fill. 

C. Deed Information 

1. Deed Type 

Select the Deed Type by selecting the appropriate check box. 

2. Deed Date  

Select the Month from the drop-down list and enter the Year. 

D. Property Type 

1. Current Use 

Select the Current Use by selecting the appropriate check box. 

2. Intended Use 

Select the Intended Use by selecting the appropriate check box. 

E. Changes to the Property 

Select Changes to the Property, if any, and enter Date of Change. 

F. Transaction Information 

Select relevant Transaction Information, if any. 

G. Miscellaneous 

Select Miscellaneous items, if any. 

H. Transfer Taxes 

The consideration (purchase price), if entered in the Order Entry tab, will populate the 
Consideration field and calculate the amount of the State and County Tax. The consideration 
may also be manually entered in this field. 

I. Exemption Information 

If the transaction is exempt from tax, click the appropriate Exemption checkbox. 

J. Homestead Exemptions 

Enter relevant Homestead Exemptions, if any. 

K. Seller Forwarding Address 

Enter the Forwarding Address of the Seller. 

L. Print County Tax Form 

M. Save 

Saves the current information. 

N. Close & Print 

Saves the current information, closes the form, opens the Print Document menu, and pre-selects 
the PTAX document. 

O. Cancel 

Abandons any manual entries and closes the form. 
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P. PTAX-203-A 

In addition to the PTAX-203 form, the PTAX-203-A will automatically print for non-residential 
property with a value above $1,000,000. To enter additional information, the PTAX-203 must be 
open. Click File > Open > PTAX-203-A. 

 
Q. PTAX-203-B 

1. In addition to the PTAX-203 form, the PTAX-203-B can be printed when transferring a 
beneficial interest in real property without using a deed or trust document. 

2. To enter the necessary information, the PTAX-203 must be open. Click File > Open > 
PTAX-203-B. 

 
VI. INSTRUCTIONS FOR PREPARING COOK COUNTY TRANSFER DECLARATION 

A. From the Transfer Tax window, click File > Open and select Cook County Transfer 
Declaration. 

 

 
B. Parcel No. 

Enter Parcel No. (PIN/Tax ID). If Tax ID has been entered in Order Entry, this field will auto-
fill. 
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C. Property Type 

Select the Property Type. 

D. Deed Information 

Select Date deed was delivered or recorded from the drop-down list. 

E. Interest Transferred 

Select the Interest Transferred from the drop-down list. 

F. Exemption Information 

If the transaction is exempt from tax, click the appropriate Exemption checkbox. 

G. Save  

Saves the current information. 

H. Close & Print 

Saves the current information, closes the form, and opens the Print Document menu. 

I. Cancel 

Abandons any manual entries and closes the form. 

VII. INSTRUCTIONS FOR PREPARING CITY OF CHICAGO TRANSFER DECLARATION 

A. From the Transfer Tax window, click File > Open and select Chicago Transfer Declaration.  

 

 
B. Parcel No. 

Enter Parcel No. (PIN/Tax ID). If Tax ID has been entered in Order Entry, this field will auto-
fill. 
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C. Property Address 

Property Address displays. Select and drag address parts to corresponding boxes or enter 
information directly into boxes. 

D. Property Type 

Select the Property Type by selecting the appropriate check box. 

E. Certifications 

Select the applicable radio buttons for Building Registration and Zoning Compliance. 

F. Deed Information 

Select Date deed was delivered or recorded from the drop-down list. If previously entered in 
Cook County Declaration, this will auto-fill. 

G. Interest Transferred 

Select applicable check box for Interest Transferred. 

H. Consideration other than Cash/Price Contingent on Future Event 

Select applicable check box and enter data in text box. These items will print on the addendum 
page. 

I. Buyer/Seller Exemptions 

If the transaction is exempt from tax, click the appropriate Exemption checkbox. By doing so, 
the applicable tax amounts will automatically zero out. 

J. Miscellaneous 

Seller and Buyer Attorneys Names (including addresses) will auto fill from Order Entry. Drag 
and drop names into corresponding boxes or enter names directly in boxes. 

K. Additional Information 

Select the appropriate checkboxes, if applicable. 

L. Transfer Taxes 

Tax amounts for Buyer and Seller automatically calculate based upon the sale price. 

M. Save  

Saves the current information. 

N. Close & Print 

Saves the current information, closes the form, and opens the Print Document menu. 

O. Cancel 

Abandons any manual entries and closes the form. 

VIII. COPYING A RESOURCE FILE 

Generally, if there is a first and a second new mortgage, the lender may require any of the following: two 
commitments, two HUD-1 Settlement Statements, and/or two Loan Policies.  

A. To copy a REsource file, it is necessary to create a second file. Follow the steps listed below to 
create a second REsource file: 

1. Click the Add New File Number button  or select New File > No Suggest from the 
File menu. 
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2. Enter the Tax ID Number. Click the Search button  and the Create New 
button.  

3. The Enter New File screen opens. 

 
4. Click the File Number field and enter the original file number followed by “–A.” 

 EXAMPLE:  

– Original file number: 100900101481 

– New duplicate file: 100900101481-A 

5. Click OK. 

The Order Entry tab displays. 

B. Using a Template for Order Entry  

The Use Template feature will copy all Order Entry data from an existing file or from a 
template file. There is also a Use Template feature to copy the commitment and policy data from 
an existing file or from a template file.  

 NOTE: It is recommended that you use the Template feature prior to adding data to the file. 
Two confirmation messages will display upon selecting Use Template, indicating that any 
data previously entered in the Order Entry tabs will be deleted and replaced with the data 
from the selected existing file. 

1. Click the Order Entry button  or the Data Entry menu to access Order Entry. 

 

Use Template 
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2. From the Order Entry > Main tab, click the Use Template button.  

3. Click OK on the confirmation prompts that indicate the selected template will override 
any data entered in the Order Entry tabs. 

The Select Template window opens. 

 
4. You may: 

a. Select a file that is a template; or 

b. Click the All Orders button  to list all of your files. 

5. Select the file that you want by either double-clicking the file name or clicking the file 
name once to highlight it and clicking OK. 

The data from the existing file will now appear in the new file. 

 NOTE: The Sale Price, Earnest Money, and Loan Amount will not be copied from 
the existing file. You must also go to the ATG Services screen to select services and 
calculate rates. . 

C. Using a Template for the Commitment/Policy 

1. To copy the commitment/policy data from an existing file into a new file, click the 
Commitment/Policy button  or select Commitment/Policy/Binder from the Data 
Entry menu.  

2. Click the Use Template button.  

 NOTE: It is recommended that you use the Template feature prior to adding data to 
the Commitment/Policy tabs. Two confirmation messages will display upon 
selecting Use Template, indicating that any data previously entered in the 
Commitment/Policy tabs will be deleted and replaced with the data from the 
selected existing file. 

3. Click OK on the confirmation prompts that indicate the selected template will override 
any data entered in the Commitment/Policy tabs. 

All Orders 
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The Select Template window opens. 

 
4. You may:  

a. Select a file that is a template; or 

b. Click the All Orders button  to list all your files. 

5. Select the file that you want by either double-clicking the file name or clicking once on 
the file name to highlight it and clicking OK. 

6. The data from the existing file will now appear in the new file. 

Use Template 

All Orders 

 
Page 13-30 ATG REsource® User Manual 
 © ATG (5/15) 



IX. REQUESTING CLOSING PROTECTION LETTERS (CPL) USING RESOURCE® 

For Illinois closings on or after January 1, 2011, Closing Protection Letters (CPLs) must be prepared and 
issued by ATG to the lender, borrower, and seller for all transactions where either the member or ATG 
provides settlement services.  

CPLs may also be requested from PaperlessCloser or from the ATG website, www.atgf.com, or by calling 
800.252.0402. 

The fees for issuance of the CPLs, payable to ATG, are as follows: 

TYPE LENDER BUYER/BORROWER SELLER 

Buy/Sell with Financing 25.00 25.00 50.00 

Buy/Sell Cash 0 25.00 50.00 

Refinance 25.00 50.00 0 
 

A. Requesting a CPL Using REsource 

The CPL can be requested from REsource prior to closing. The following information should be 
entered in the REsource file prior to requesting the CPL: Buyer, Seller, Lender, and Property.  

1. Select the file requiring the CPL. 

2. Go to the Utilities menu. 

3. Select Request IL CPL. 

 

 

4. The file information will populate the order form. Complete all remaining information. 

 

 
ATG RESOURCE® User Manual Page 13-31 
© ATG (5/15) 

http://www.atgf.com/


5. Click the Submit Request for CPL button located at the bottom of the form. 

 
6. The completed CPLs will reside in the File Attachment Utility and will be available to 

print. 

B. Printing the CPL 

1. Click the File Attachment Utility button  located on the toolbar. 
 

2. Select the CPL you wish to print. 

 
3. The CPL displays. 

 

4. Click the Print button  to print. 
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C. Alternative Print Option: 

1. Click the File Attachment Utility button  located on the toolbar. 
 

2. Highlight the CPL you wish to print. 

 
3. Click the Print button on the toolbar of the Attached File Manager. 

4. The CPL displays. Click the Print button  to print. 

 
D. Resubmitting a Request for a CPL 

1. Select the file requiring the CPL and make any changes to the REsource file. 

2. Go to the Utilities menu and select Request IL CPL. 

3. Choose one of the action items and click the Submit Request button.  

 
E. Additional ATG REsource Information 

CPLs in the ATG Edit Services screen  will automatically populate for each file and populate 
the Invoice for Title Charges, HUD, CheckWriting, and Accounting Information Schedule. 
Be sure to select the correct Transaction Type in Services. 
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1. ATG Edit Services 

 
2. Commitment Schedule B, Section I, Requirements 

The following language will automatically populate the Commitment Schedule B, 
Section I, Requirements:  

8. Per Illinois law, for closings on or after 1/1/11, Closing Protection 
Letters will be issued by ATG to the parties to the transaction if it is 
closed by ATG or its approved title insurance agent. 

9. If you are a lender, your ATG Closing Protection Letter will be valid 
only if you receive it in one of the following two ways: (1) as an 
email from the domain “@atgf.com,” or (2) as a fax from a fax 
number that is in the range 312-224-0195 thru 312-224-0395 or 217-
403-7400 thru 217-403-7459. 

3. Invoice for Title Charges 

The CPL fees will populate the second page of the Invoice for Title Charges. 
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4. 2010 HUD 

a. The CPL fees will populate the Additional Title Services window and will 
appear on Line 1101. To view, click the Additional Title Services button  
on the 1100 toolbar. .  

 
5. CheckWriting 

In CheckWriting, an automatic disbursement, payable to “ATG Fees and Transfers,” 
will be created for the CPL fees. 

 
F. Accounting Information Schedule 

The Accounting Information Schedule will reflect the CPL fees in the Premium Information 
section. 

 
 

For questions, please call the ATG REsource Help Desk, 888.776.4420 
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[NOTES] 
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14 | STANDARD LANGUAGE ENTRIES 

ACCESS 

No Access: Policy  

Notwithstanding the insuring clauses of this policy, ATG does not insure against any loss or damage by 
reason of lack of access to and from the land.  

Restrictions  

Subdivision restrictions, easements, and building setback lines as may be disclosed on the recorded Plat 
of Subdivision or of public record, if any.  

No Access: Commitment  

The public records do not show any means of ingress or egress to or from the land, and, by reason thereof, 
this commitment and our policy, if and when issued, should not be construed as insuring against any loss 
or damage by reason of lack of access to and from the land.  

ADVISORY REPORT  

Advisory Report  

This is not a title policy, guarantee, or opinion of title and it is not binding upon Attorneys’ Title Guaranty 
Fund, Inc. This advisory report must be examined and the information contained herein verified by a 
member attorney prior to execution. Upon execution by a member attorney or authorized signatory, this 
exception shall be rendered null and void.  

ASSOCIATION: UNINCORPORATED  

Charter/Bylaws: Commitment  

A certified copy of the charter and amendments thereto, if any, and of the bylaws of {PR,"Enter the name 
of the association.",ST1,1}, an unincorporated association, should be furnished, and this Commitment is 
subject to such forth exceptions, if any, as may then be deemed necessary.  

Resolution: Commitment  

Upon a conveyance or mortgage of the land, a certified copy of a resolution passed by the members of the 
party in title, or acquiring title, authorizing the execution or acceptance of the instrument of conveyance 
or execution of the mortgage should be furnished, together with a certificate by the custodian of records 
establishing (1) the identity of the president and secretary of the association; (2) proof of proper notice of 
the meeting to consider the question of conveying or mortgaging the land was given to all members; (3) 
the number of members present at such meeting; and (4) the number of “ayes” and “nays” voted on such 
question.  

ATG  

Underwriting Approval  

This commitment, and any policies committed for thereunder, is subject to approval by the Underwriting 
Department of Attorneys’ Title Guaranty Fund, Inc., and is subject to such further and additional 
exceptions as may be required by it.  

ATG REQUIREMENTS  

Access Endorsement  

In order to issue an Access Endorsement on the final policy, we must be provided with a survey of the 
property, dated within the previous six months, showing that the property abuts a physically open public 
way or a private way of which the property has legal access.  
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Contiguity 4 Endorsement  

In order to issue the Contiguity Endorsement 4, we must be provided with a survey of the property, dated 
within the previous six months, showing that all parcels listed on Schedule A constitute a single tract of 
land with no gaps or gores between any parcels.  

Creditors’ Rights Endorsement  

In order to issue the Creditors’ Rights Endorsement on the final Loan Policy, approval must be obtained 
from an ATG underwriter. Please call {PR,"Enter name and telephone number of ATG 
underwriter:",ST1,1} for additional requirements.  

Direct Operations  

Payment and release of record of the mortgage(s) set forth as exception number(s) {PR,"Enter exception 
number(s) for mortgage(s) to be released",ST1,1}.  

We must be advised in writing of the name of anyone not referred to in this commitment who will obtain 
an interest or who will make a loan on the land. We may make additional requirements or exceptions 
relating to the interest or loan.  

In order to provide full ALTA coverage on the Loan Policy for residential property, we must be provided 
with a fully executed and notarized ALTA Statement (ATG Form 3004) and Affidavit in Lieu of Survey 
(ATG Form 3001). The policy will be subject to such additional matters disclosed by these documents.  

Survey Endorsement  

In order to issue a Survey Endorsement on the final policy, we must be provided with a survey of the 
property, dated within the previous six months, showing all parcels as described on Schedule A.  

Zoning 3.0 Endorsement  

In order to issue a Zoning 3.0 Endorsement on the final policy, approval must be obtained from an ATG 
underwriter. Please call {PR,"Enter name and telephone number of ATG underwriter:",ST1,1} for 
additional requirements.  

Zoning 3.1 Endorsement  

In order to issue a Zoning 3.1 Endorsement on the final policy, we must be provided with a survey of the 
property, dated within the previous six months, that includes all of the land contained in Schedule A, 
shows the location of all buildings on the land, and that indicates the area, width, and depth of the land, 
the floor space area of the buildings on the land, the location of the buildings in relation to any setback 
requirements, the height of the buildings, and if additional coverage for parking is required, the number 
and location of all parking spaces, including any handicapped or other special use parking. In addition, 
approval must be obtained from an ATG underwriter. Please call {PR,"Enter name and telephone number 
of ATG underwriter:",ST1,1} for additional requirements.  

Standard Exception Waiver  

To waive Standard Exception No. 1 ("Right or claims of parties in possession not shown by the public 
records") from the Owner’s Policy, furnish ATG with an ALTA Statement and a land survey made in 
accordance with the "Minimum Standard Detail Requirements for Land Title Surveys" as adopted by 
ALTA/ACSM, made within six months of the date of this commitment. In addition to matters disclosed 
by the ALTA Statement, the following will appear in lieu of Standard Exception No.1, unless satisfactory 
disposition thereof is otherwise made:  

"Rights of public or quasi-public utilities, if any, in the land."  

 NOTE: To establish the nonexistence of such rights, obtain a letter from the official of 
the municipality in charge of water mains, sewers, etc., such as the village engineer, 
stating that there are no water mains, sewers, etc., in the said land.  

"Existing leases and tenancies, and rights of tenants thereunder, and those claiming by, through, 
or under those tenants." 
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 NOTE: All existing unrecorded leases affecting the land should be produced for ATG’s 
inspection, and this commitment is subject to such further exceptions, if any, as may be 
deemed necessary. If there are no unrecorded leases affecting the land, provide an 
affidavit to this effect by the owner of the land.  

To waive Standard Exception No. 2 ("Encroachments, overlaps, boundary line disputes, and any matters 
that would be disclosed by an accurate survey and inspection of the premises.") from the Owner’s policy, 
furnish ATG with a land survey made in accordance with the "Minimum Standard Detail Requirements 
for Land Title Surveys" as adopted by ALTA/ACSM, made within six months of the date of this 
commitment, and this commitment is subject to such further exceptions, if any, as may then be deemed 
necessary.  

To waive Standard Exception No. 3 ("Easements, or claims of easements, not shown by the public 
records") from the Owner’s Policy, supply ATG with a survey in compliance with the requirements noted 
in Standard Exception No. 2 above. In addition to matters disclosed by the survey, the following 
exceptions will appear in lieu of the Standard Exception No. 3 unless satisfactory disposition thereof is 
otherwise made:  

"Rights of public or quasi-public utilities, if any, in the land."  

 NOTE: To establish the nonexistence of such rights, comply with the requirements as set out 
under Standard Exception No. 1, above.  

To waive Standard Exception No. 4 ("Any lien or right to a lien, for services, labor, or materials 
heretofore or hereafter furnished, imposed by law and not shown by the public records") from the 
Owner’s Policy, furnish ATG with the following:  

(a) An ALTA Statement, or its equivalent, executed by all parties holding title to the land during 
the six months preceding the date of the policy and the purchasers, if any;  

(b) Satisfactory evidence of the payment in full of the cost of furnishing services, labor, and 
materials in connection with any improvement made on the land within six months of the date of 
the policy;  

(c) Satisfactory indemnification, as may be required.  

In order to waive Standard Exception No. 5 (“Taxes or special assessments that are not shown as existing 
liens by the public records”), a current special assessment search must be provided.  

Commercial Real Estate Broker Lien  

Information should be furnished establishing whether any written agreement has been entered into by and 
between any party or broker for the purposes of buying, selling, leasing, or otherwise conveying any 
interest in the land described herein; and, if any such agreement has been entered into, satisfactory 
evidence should be furnished establishing that the compensation agreed upon in such agreement has been 
paid and the broker’s lien, or right to a lien, for such amount has been extinguished. In the event the 
evidence is not furnished, our policy or policies, when issued, will be subject to the following exception:  

"Any lien, or right to a lien, imposed by law under the provisions of the Commercial Real 
Estate Broker Lien Act, and not shown in the public records, for compensation agreed 
upon by a broker and the broker’s client or customer under the terms of a written 
agreement entered into for the purposes of buying, selling, leasing, or otherwise 
conveying any interest in the land described in Schedule A." 

Property Manager Lien  

Furnish ATG with an affidavit by the owner stating that there is no property manager for the insured 
premises. In the absence thereof, provide a waiver of lien by the property manager covering the date of 
recording of the deed and mortgage to the Insured. If the affidavit or waiver of lien is not furnished, the 
final policies will contain the following exception:  
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"Rights of a property manager, if any, to a statutory lien on the premises for its property 
manager’s fee." 

ATTORNEYS’ TITLE GUARANTY FUND, INC.  

24 month Chain of Title Disclaimer  

Disclaimer: This 24 month Chain of Title alone may not be used as the basis for the issuance of an ATG 
commitment or policy. The liability of Attorneys’ Title Guaranty Fund, Inc., in connection with this 
search report is limited to actual damages arising out of an error contained herein but in no event shall 
said liability exceed $100.00.  

Taxes: Five Years  

Taxes for the year {PR,"Enter the last year that taxes were paid (‘YYYY’).",IN1,1} and thereafter:  

First installment {PR,"Enter the previous year (‘YYYY’).",IN1,1} taxes, in the amount of {PR,"Enter 
amount of the 1st installment prior year taxes.",CU1,2}, is {PR,"Enter whether ‘PAID,’ ‘UNPAID AND 
DUE,’ ‘NOT YET DUE AND PAYABLE.’",ST1,3}. Second installment {PR,"Enter the previous year 
(‘YYYY’)",IN1,8} taxes, in the amount of {PR,"Enter amount of 2nd installment prior year 
taxes.",CU1,4}, is {PR,"Enter whether ‘PAID,’ ‘UNPAID AND DUE,’’NOT YET DUE AND 
PAYABLE.’",ST1,5}.  

Taxes for the year 2008, in the amount of {PR,"Enter amount of 2008 taxes",CU1,13}, are {PR,"Enter 
whether ‘PAID’, ‘SOLD’, REDEEMED’; include dates",ST1,16}. Taxes for the year 2007, in the amount 
of {PR,"Enter amount of 2007 taxes",CU1,19}, are {PR,"Enter whether ‘PAID’, ‘SOLD’, 
‘REDEEMED’; include dates",ST1,15}. Taxes for the year 2006, in the amount of {PR,"Enter amount of 
2006 taxes",CU1,11}, are {PR,"Enter whether ‘PAID’, ‘SOLD’, REDEEMED’; include dates",ST1,14}. 
Taxes for the year 2005, in the amount of {PR,"Enter amount of 2005 taxes",CU1,9}, are {PR,"Enter 
whether ‘PAID’, ‘SOLD’, ‘REDEEMED’; include dates",ST1,10}.  

Taxes for the year {PR,"Enter the current year (YYYY).",IN1,6} are not yet due and payable.  

Permanent Index No. {DB,Property,TaxID,SN1}  

EXEMPTIONS: {PR,"Enter Type of Exemption & Amount",ST1,17} 

TOWNSHIP: {PR,"Enter Township Name or Numbers",ST1,19} 

LOT SIZE/ACREAGE: {PR,"Enter Lot Size or Acreage",ST1,18} 

ACCESS: {PR,"Enter Yes and Name of Access Road OR Enter No",ST1,20}  

Taxes: Madison L/D  

Taxes for the year {PR,"Enter the last year that taxes were paid (‘YYYY’).",IN1,1} and thereafter:  

First installment 2009 taxes, in the amount of {PR,"Enter the amount of 1st installment of tax",CU1,2} is 
{PR,"PAID, UNPAID AND DUE 07/07/2010, OR SOLD",ST1,3}. Second installment 2009 taxes, in the 
amount of {PR,"Enter the amount of 2nd installment of tax",CU1,4}, is {PR,"PAID, UNPAID AND 
DUE 09/07/2010, OR SOLD",ST1,5}. Third installment 2009 taxes, in the amount of {PR,"Enter the 
amount of 3rd installment of tax",CU1,6} is {PR,"PAID, UNPAID AND DUE 10/07/2010 OR 
SOLD",ST1,7}. Fourth installment 2009 taxes, in the amount of {PR,"Enter the amount of 4th installment 
of tax",CU1,8}, is {PR,"PAID, UNPAID AND DUE 12/07/2010, OR SOLD",ST1,9}.  

Taxes for the year {PR,"Enter the current year",ST1,10} are not yet due and payable.  

Permanent Index No. {DB,Property,TaxID,SN1}  

EXEMPTIONS: {PR,"Enter the exemptions on the property",ST1,11}  

Taxes: Five Years (Not Out)  

Taxes for the year {PR,"Enter the last year that taxes were paid (‘YYYY’).",IN1,1} and thereafter:  
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First installment {PR,"Enter the previous year (‘YYYY’).",IN1,1} taxes, in the amount of {PR,"Enter 
amount of the 1st installment prior year taxes.",CU1,2}, is {PR,"Enter whether ‘PAID,’ ‘UNPAID AND 
DUE,’ ‘NOTYET DUE AND PAYABLE.’",ST1,3}. Second installment {PR,"Enter the previous year 
(‘YYYY’)",IN1,8} taxes, in the amount of {PR,"Enter amount of 2nd installment prior year 
taxes.",CU1,4}, is {PR,"Enter whether ‘PAID,’ ‘UNPAID AND DUE,’’NOT YET DUE AND 
PAYABLE.’",ST1,5}.  

Taxes for the year 2006, in the amount of {PR,"Enter amount of 2006 taxes",CU1,13}, are {PR,"Enter 
whether ‘PAID’, ‘SOLD’, REDEEMED’; include dates",ST1,16}. Taxes for the year 2005, in the amount 
of {PR,"Enter amount of 2005 taxes",CU1,19}, are {PR,"Enter whether ‘PAID’, ‘SOLD’, 
‘REDEEMED’; include dates",ST1,15}. Taxes for the year 2004, in the amount of {PR,"Enter amount of 
2004 taxes",CU1,11}, are {PR,"Enter whether ‘PAID’, ‘SOLD’, REDEEMED’; include dates",ST1,14}. 
Taxes for the year 2003, in the amount of {PR,"Enter amount of 2003 taxes",CU1,9}, are {PR,"Enter 
whether ‘PAID’, ‘SOLD’, ‘REDEEMED’; include dates",ST1,10}.  

Taxes for the year {PR,"Enter the current year (YYYY).",IN1,6} are not yet due and payable.  

Permanent Index No. {DB,Property,TaxID,SN1}  

EXEMPTIONS: {PR,"Enter Type of Exemption & Amount",ST1,17} TOWNSHIP: {PR,"Enter 
Township Name or Numbers",ST1,19}  

LOT SIZE/ACREAGE: {PR,"Enter Lot Size or Acreage",ST1,18} 

ACCESS: {PR,"Enter Yes and Name of Access Road OR Enter No",ST1,20}  

BANKRUPTCY  

Creditor’s Rights  

The right of a creditor, trustee or debtor in possession to sell the entire property in the event of a 
bankruptcy of any co-tenant of the land.  

Statutory Powers  

Statutory rights, powers, and duties of the Trustee in Bankruptcy in the bankruptcy proceeding filed by 
{PR,"Enter name(s) of person filing bankruptcy",ST1,1} on {PR,"Enter date of bankruptcy 
filing",DT2,2}, in the Federal District Court for the {PR,"Enter name (i.e., Central) of bankruptcy 
court.",ST1,3} District of Illinois in Case No. {PR,"Enter case number of bankruptcy",ST1,4}, notice of 
which was recorded on {PR,"Enter date of recording of bankruptcy notice",DT2,5}, as Document No. 
{PR,"Enter recorded document number",ST1,6}.  

Statutory Powers (Wisconsin) 

Statutory rights, powers, and duties of the Trustee in Bankruptcy in the bankruptcy proceeding filed by 
{PR,"Enter name(s) of person filing bankruptcy",ST1,1} on {PR,"Enter date of bankruptcy 
filing",DT2,2}, in the Federal District Court for the {PR,"Enter name (i.e., Western) of bankruptcy 
court.",ST1,3} District of Wisconsin in Case No. {PR,"Enter case number of bankruptcy",ST1,4}, notice 
of which was recorded on {PR,"Enter date of recording of bankruptcy notice",DT2,5}, as Document No. 
{PR,"Enter recorded document number",ST1,6}.  

CHAMPAIGN  

Urbana Sewer Benefit Tax  

This property is subject to assessment by the City of Urbana with respect to the Sewer Benefit Tax. Non-
payment may create a lien against the real estate.  

Note: There is presently no outstanding lien of record on the property.  

Champaign Sanitary Sewer  

This property is subject to assessment by the City of Champaign for a Sanitary Sewer Fee. Non-payment 
may create a lien against the real estate.  
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Note: There is presently no outstanding lien of record on the property.  

Urbana& Champaign Sanitary District  

This property is part of the Urbana & Champaign Sanitary District and as such is subject to assessment 
therein, and the user charge. Nonpayment may create a lien against the real estate.  

Note: There is presently no outstanding lien of record on the property.  

Roads and Highways  

Rights of the public, the State of Illinois, and the municipality in and to that part of the premises in 
question taken or used for roads or highways.  

Minerals  

This Commitment, and any policy issued subsequent thereto, does not insure title to any minerals 
underlying premises in question. Title to those minerals was not included in this examination.  

Drainage District  

The premises fall within the boundaries of the Drainage District and are subject to assessment therein. An 
annual maintenance assessment may be included with the real estate tax bill.  

Urbana Recycling Tax  

This property is subject to assessment by the City of Urbana with respect to the Recycling Tax. Non-
payment may create a lien against the real estate.  

Note: There is presently no outstanding lien of record on the property.  

Mineral Estate  

All rights and easements in favor of the owner of the mineral estate or of any party claiming by, through, 
or under said estate.  

CO-OWNERSHIP  

Co-ownership: Creditor’s Rights  

The right of a creditor, trustee, or debtor in possession to sell the entire property in the event of a 
bankruptcy of any co-tenant of the land.  

Co-ownership: Partition  

Rights of co-tenants to partition, contribution, and possession.  

Co-ownership: Tax Sale  

The right of the United States government to sell the entire property to enforce a tax lien against any co-
tenant of the land.  

Fractional Interest  

Rights of co-tenants to partition, contribution, and possession.  

The right of the United States government to sell the entire property to enforce a tax lien against any co-
tenant of the land.  

The right of a creditor, trustee, or debtor in possession to sell the entire property in the event of a 
bankruptcy of any co-tenant of the land.  

COMMERCIAL PROPERTY  

Gap  

Loss or damage by reason of there being recorded in the public records any deeds, mortgages, lis pendens, 
liens, or other title encumbrances subsequent to the Commitment date and prior to the effective date of the 
final Policy.  
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Commercial Broker Lien  

Information should be furnished establishing whether any written agreement has been entered into by and 
between any party or broker for the purposes of buying, selling, leasing, or otherwise conveying any 
interest in the land described herein; and, if any such agreement has been entered into, satisfactory 
evidence should be furnished establishing that the compensation agreed upon in such agreement has been 
paid and the broker’s lien, or right to a lien, for such amount has been extinguished. In the event the 
evidence is not furnished, our policy or policies, when issued, will be subject to the following exception:  

"Any lien, or right to a lien, imposed by law under the provisions of the Commercial Real Estate 
Broker Lien Act, and not shown in the public records, for compensation agreed upon by a broker 
and the broker’s client or customer under the terms of a written agreement entered into for the 
purposes of buying, selling, leasing, or otherwise conveying any interest in the land described in 
Schedule A." 

Commercial: Standard Exception No. 1  

To waive Standard Exception No. 1 (“Right or claims of parties in possession not shown by the public 
records”) from the Owner’s Policy, furnish ATG with an ALTA Statement and a land survey made in 
accordance with the "Minimum Standard Detail Requirements for Land Title Surveys" as adopted by 
ALTA/ACSM, made within six months of the date of this commitment. In addition to matters disclosed 
by the ALTA Statement, the following will appear in lieu of Standard Exception No.1, unless satisfactory 
disposition thereof is otherwise made:  

"Rights of public or quasi-public utilities, if any, in the land."  

 NOTE: To establish the nonexistence of such rights, obtain a letter from the official of 
the municipality in charge of water mains, sewers, etc., such as the village engineer, 
stating that there are no water mains, sewers, etc., in the said land.  

"Existing leases and tenancies, and rights of tenants thereunder, and those claiming by, through, 
or under those tenants." 

 NOTE: All existing unrecorded leases affecting the land should be produced for ATG’s 
inspection, and this commitment is subject to such further exceptions, if any, as may be 
deemed necessary. If there are no unrecorded leases affecting the land, provide an 
affidavit to this effect by the owner of the land.  

Commercial: Standard Exception No. 2  

To waive Standard Exception No. 2 (“Encroachments, overlaps, boundary line disputes, and any matters 
that would be disclosed by an accurate survey and inspection of the premises”) from the Owner’s Policy, 
furnish ATG with a land survey made in accordance with the "Minimum Standard Detail Requirements 
for Land Title Surveys" as adopted by ALTA/ACSM, made within six months of the date of this 
commitment, and this commitment is subject to such further exceptions, if any, as may then be deemed 
necessary.  

Commercial: Standard Exception No. 3  

To waive Standard Exception No. 3 (“Easements, or claims of easements, not shown by the public 
records”) from the Owner’s Policy, supply ATG with a survey in compliance with the requirements noted 
in Standard Exception No. 2, above. In addition to matters disclosed by the survey, the following 
exceptions will appear in lieu of the Standard Exception No. 3, unless satisfactory disposition thereof is 
otherwise made:  

(a) Rights of public or quasi-public utilities, if any, in the land.  

 NOTE: To establish the non-existence of such rights, comply with the requirements as set out 
under Standard Exception No. 1, above.  

 
ATG RESOURCE® User Manual Page 14-7 
© ATG (5/15) 



Commercial: Standard Exception No. 4  

To waive Standard Exception No. 4 (“Any lien, or right to a lien, for services, labor, or materials 
heretofore or hereafter furnished, imposed by law, and not shown by the public records”) from the 
Owner’s Policy, furnish ATG with the following:  

(a) An ALTA Statement, or its equivalent, executed by all parties holding title to the land during 
the six months preceding the Date of Policy and the purchasers, if any;  

(b) Satisfactory evidence of the payment in full of the cost of furnishing services, labor, and 
materials in connection with any improvement made on the land within six months of the Date of 
Policy;  

(c) Satisfactory indemnification, as may be required.  

Commercial: Standard Exception No. 5  

In order to waive Standard Exception No. 5 (“Taxes or special assessments that are not shown as existing 
liens by the public records”), a current special assessment search must be provided.  

Any endorsement requested by an Insured or proposed Insured must be approved by ATG.  

Leases and Tenancies  

Existing leases and tenancies, and rights of tenants thereunder, and those claiming by, through, or under 
those tenants.  

Property Manager Lien  

Rights of a property manager, if any, to a statutory lien on the premises for its property manager’s fee.  

 NOTE: Furnish ATG with an affidavit by the owner stating that there is no property manager for 
the insured premises. In the absence thereof, provide a waiver of lien by the property manager 
covering the date of recording of the deed and mortgage to the Insured.  

Standard Exceptions 1-5  

Rights or claims of parties in possession not shown by the public records.  

Encroachments, overlaps, boundary line disputes, and any matters that would be disclosed by an accurate 
survey and inspection of the premises.  

Easements, or claims of easements, not shown by the public records.  

Any lien, or right to a lien, for services, labor, or material heretofore or hereafter furnished, imposed by 
law, and not shown by the public records; and  

Taxes or special assessments that are not shown as existing liens by the public records.  

Broker’s Lien  

Rights or claims of parties in possession not shown by the public records.  

Encroachments, overlaps, boundary line disputes, and any matters that would be disclosed by an accurate 
survey and inspection of the premises.  

Easements, or claims of easements, not shown by the public records.  

Any lien, or right to a lien, for services, labor, or material heretofore or hereafter furnished, imposed by 
law and not shown by the public records; and  

Taxes or special assessments that are not shown as existing liens by the public records.  

Commercial Broker Lien (Wisconsin) 

Information should be furnished establishing whether any written agreement has been entered into by and 
between any party or broker for the purposes of buying, selling, leasing, or otherwise conveying any 
interest in the land described herein; and, if any such agreement has been entered into, satisfactory 
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evidence should be furnished establishing that the compensation agreed upon in such agreement has been 
paid and the broker’s lien, or right to a lien, for such amount has been extinguished. In the event the 
evidence is not furnished, our policy or policies when issued will be subject to the following exception:  

"Any lien, or right to a lien, imposed by law under the provisions of Wisconsin Stat. 
779.32, and not shown in the public records, for compensation agreed upon by a broker 
and the broker’s client or customer under the terms of a written agreement entered into 
for the purposes of buying, selling, leasing, or otherwise conveying any interest in the 
land described in Schedule A. " 

Variations between Record and Measured Bearings  

Variation between record and measured bearings, angles, or distances, as shown on the survey dated 
{PR,"Date of Survey",ST1,1}, and prepared by {PR,"Surveyor Name",ST1,2}, known as Order/Job No. 
{PR,"Order/Job. Number",ST1,3}.  

CONDOMINIUM CONVERSION  

Additional Parcels (Wisconsin) 

The developer has reserved the right to add additional property to that which has been submitted under 
the Wisconsin Condominium Ownership Act by the Declaration recorded as Document {PR,"Additional 
Property: Enter condo declaration document number",ST1,1}, and, in the event of any such addition, to 
reallocate percentage interests in the common elements. For further particulars, see the Declaration.  

Condominium Conversion (Wisconsin) 

Furnish ATG with a certificate, executed and acknowledged by the Secretary of the Board of 
Managers/Directors, stating that there are no unpaid assessment liens arising by reason of the nonpayment 
of assessments as per the Condominium Declaration.  

Terms, provisions, covenants, conditions, and options in, rights and easements established by the 
Declaration of Condominium Ownership recorded {PR,"Enter date of Condominium Declaration 
recording.",DT2,1}, as Document No. {PR,"Enter Document number.",ST1,4}, as amended from time to 
time.  

Furnish ATG with a certificate, executed and acknowledged by the Secretary of the Board of 
Managers/Directors, stating that compliance has been made by the owners with the provisions of the 
Condominium Declaration or that said provisions relating to preemptive rights have been duly waived by 
the Board of Managers/Directors and the rights of the Board thereunder have terminated.  

Limitations and Conditions Imposed by the Wisconsin Condominium Ownership Act.  

Any deed conveying a unit in a conversion condominium must contain one of the following statements:  

"The tenant of Unit * has waived or has failed to exercise the right of first refusal."  

or  

"The tenant of Unit * has no right of first refusal."  

Any lien, or right to a lien, for services, labor, or material heretofore or hereafter furnished, imposed by 
law, and not shown by the public records, including, without limiting the generality of the foregoing, liens 
or rights to a lien arising from contracts in connection with the construction of improvements or 
conversion of the existing building or buildings on the land to a condominium.  

This commitment is subject to the approval of the condominium declaration and plat by the Underwriting 
Department of ATG.  

This commitment is subject to:  

(a) Encroachments or other matters, if any, disclosed by an examination of the condominium plat, 
when placed of record.  
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(b) Defects or other exceptions, if any, disclosed by an examination of the condominium 
declaration, when placed of record.  

(c) Such additional exceptions, if any, as may be disclosed upon a search of the public records 
covering the period after the effective date of this commitment and through the date of recording 
of the condominium declaration and plat.  

Additional Parcels  

The developer has reserved the right to add additional property to that which has been submitted to the 
Condominium Property Act by the Declaration recorded as Document {PR,"Additional Property: Enter 
condo declaration document number",ST1,1}, and, in the event of any such addition, to reallocate 
percentage interests in the common elements. For further particulars, see the Declaration. 

Condominium Conversion  

Furnish ATG with a certificate, executed and acknowledged by the Secretary of the Board of Managers, 
stating that there are no unpaid assessment liens arising by reason of the nonpayment of assessments as 
per the Condominium Declaration.  

Terms, provisions, covenants, conditions, and options in, rights and easements established by the 
Declaration of Condominium Ownership recorded {PR,"Enter date of Condominium Declaration 
recording.",DT2,1}, as Document {PR,"Enter Document number.",ST1,4}, as amended from time to 
time.  

Furnish ATG with a certificate, executed and acknowledged by the Secretary of the Board of Managers, 
stating that compliance has been made by the owners with the provisions of the Condominium 
Declaration or that said provisions relating to preemptive rights have been duly waived by the Board of 
Managers and the rights of the Board thereunder have terminated.  

Limitations and conditions imposed by the Illinois Condominium Property Act. 

Any deed conveying a unit in a conversion condominium must contain one of the following statements: 

"The tenant of Unit * has waived or has failed to exercise the right of first refusal.  

or  

"The tenant of Unit * has no right of first refusal."  

Any lien, or right to a lien, for services, labor, or material heretofore or hereafter furnished, imposed by 
law, and not shown by the public records, including, without limiting the generality of the foregoing, liens 
or rights to a lien arising from contracts in connection with the construction of improvements or 
conversion of the existing building or buildings on the land to a condominium.  

This commitment is subject to the approval of the condominium declaration and plat by the Underwriting 
Department of ATG.  

This commitment is subject to:  

(a) Encroachments or other matters, if any, disclosed by an examination of the condominium plat, 
when placed of record.  

(b) Defects or other exceptions, if any, disclosed by an examination of the condominium 
declaration, when placed of record.  

(c) Such additional exceptions, if any, as may be disclosed upon a search of the public records 
covering the period after the effective date of this commitment and through the date of recording 
of the condominium declaration and plat.  
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CONDOMINIUM  

Assessments  

Furnish ATG with a certificate, executed and acknowledged by the Secretary of the Board of Managers, 
stating that there are no unpaid assessment liens arising by reason of the nonpayment of assessments as 
per the Condominium Declaration.  

Condominium: Commitment  

Terms, provisions, covenants, conditions, and options contained in, and rights and easements established 
by the Declaration of Condominium Ownership recorded {PR,"Enter date of Condominium Declaration 
recording.",DT2,1}, as Document No. {PR,"Enter Document number.",ST1,4}, as amended from time to 
time.  

Limitations and conditions imposed by the Illinois Condominium Property Act.  

Furnish ATG with a certificate, executed and acknowledged by the Secretary of the Board of Managers, 
stating that compliance has been made by the owners with the provisions of the Condominium 
Declaration or that said provisions relating to preemptive rights have been duly waived by the Board of 
Managers and the rights of the Board thereunder have terminated.  

Furnish ATG with a certificate, executed and acknowledged by the Secretary of the Board of Managers, 
stating that there are no unpaid assessment liens arising by reason of the nonpayment of assessments as 
per the Condominium Declaration.  

Condominium: Policy  

Terms, provisions, covenants, conditions, and options in, rights and easements established by the 
Declaration of Condominium Ownership recorded {PR,"Enter date of Condominium Declaration 
recording.",DT2,1}, as Document {PR,"Enter Document number.",ST1,4}, as amended from time to 
time.  

Limitations and conditions imposed by the Illinois Condominium Property Act.  

Declaration  

Terms, provisions, covenants, conditions, and options in, rights and easements established by the 
Declaration of Condominium Ownership recorded {PR,"Enter date of Condominium Declaration 
recording.",DT2,1}, as Document {PR,"Enter Document number.",ST1,4}, as amended from time to 
time.  

Legal Description: Parking  

Parcel 2:  

The exclusive right to the parking space number {PR,"Condo Legal: Enter parking space 
number:",ST1,1}, a limited common element (“LCE”), as delineated on the Plat of Survey, and the rights 
and easements for the benefit of Unit {PR,"Condo Legal: Enter the condominium unit number:",ST1,2}, 
as set forth in the Declaration of Condominium; the Grantor reserves to itself, its successors, and assigns, 
the rights and easements as set forth in the Declaration for the remaining land described therein.  

Legal Description: Unit  

Parcel 1:  

Unit {PR,"Condo Legal: Enter condominium unit number:",ST1,1} in the {PR,"Condo Legal: Enter the 
condominumname:",ST1,2} Condominium as depicted on the Plat of Survey of the following described 
real estate:  

{PR,"Condo Legal: Enter base legal description:",ST2,3}  

which Plat of Survey is attached as Exhibit “{PR,"Condo Legal: Enter the Exhibit letter or number of 
thePlat:",ST1,4}” to the Declaration of Condominium Ownership, recorded {PR,"Condo Legal: Enter 
date of recording of condo declaration:",DT2,5}, in the Office of the Recorder of Deeds of {PR,"Condo 
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Legal: Enter county of recorded declaration:",ST1,6} County, {DB,Property,State,NO}, as Document 
Number {PR,"Condo Legal: Enter document number of declaration:",ST1,7}, as amended from time to 
time, together with its undivided percentage interest in the common elements, in {RP,6} County, 
{DB,Property,State,NO}.  

New Condominium  

Furnish ATG with a certificate, executed and acknowledged by the Secretary of the Board of Managers, 
stating that there are no unpaid assessment liens arising by reason of the nonpayment of assessments as 
per the Condominium Declaration.  

Terms, provisions, covenants, conditions, and options in, rights and easements established by the 
Declaration of Condominium Ownership recorded {PR,"Enter date of Condominium Declaration 
recording.",DT2,1}, as Document {PR,"Enter Document number.",ST1,4}, as amended from time to 
time.  

Furnish ATG with a certificate, executed and acknowledged by the Secretary of the Board of Managers, 
stating that compliance has been made by the owners with the provisions of the Condominium 
Declaration or that said provisions relating to preemptive rights have been duly waived by the Board of 
Managers and the rights of the Board thereunder have terminated.  

Limitations and conditions imposed by the Illinois Condominium Property Act.  

New Condominium: First Deed Out  

Grantor also hereby grants to the Grantee, its successors, and assigns, such rights and easements 
appurtenant to the above described real estate, the rights and easements for the benefit of said property set 
forth in the Declaration of Condominium, and Grantor reserves to itself, its successors, and assigns, the 
rights and easements set forth in said Declaration for the benefit of the remaining property described 
therein.  

This deed is also subject to all rights, easements, covenants, conditions, restrictions, and reservations 
contained in said Declaration the same as though the provisions of said Declaration were recited and 
stipulated at length herein.  

Preemptive Rights  

Furnish ATG with a certificate, executed and acknowledged by the Secretary of the Board of Managers, 
stating that compliance has been made by the owners with the provisions of the Condominium 
Declaration or that said provisions relating to preemptive rights have been duly waived by the Board of 
Managers and the rights of the Board thereunder have terminated.  

Statute  

Limitations and conditions imposed by the Illinois Condominium Property Act.  

Assessments (Wisconsin) 

Furnish ATG with a certificate, executed and acknowledged by the Secretary of the Board of 
Managers/Directors, stating that there are no unpaid assessment liens arising by reason of the nonpayment 
of assessments as per the Condominium Declaration.  

Condominium: Commitment (Wisconsin) 

Terms, provisions, covenants, conditions, and options in, rights and easements established by the 
Declaration of Condominium Ownership recorded {PR,"Enter date of Condominium Declaration 
recording.",DT2,1}, as Document No. {PR,"Enter Document number.",ST1,4}, as amended from time to 
time.  

Limitations and conditions imposed by the Wisconsin Condominium Ownership Act.  

Furnish ATG with a certificate, executed and acknowledged by the Secretary of the Board of 
Managers/Directors, stating that compliance has been made by the owners with the provisions of the 
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Condominium Declaration or that said provisions relating to preemptive rights have been duly waived by 
the Board of Managers/Directors and the rights of the Board thereunder have terminated.  

Furnish ATG with a certificate, executed and acknowledged by the Secretary of the Board of 
Managers/Directors stating that there are no unpaid assessment liens arising by reason of the nonpayment 
of assessments as per the Condominium Declaration.  

Condominium: Policy (Wisconsin) 

Terms, provisions, covenants, conditions, and options in, rights and easements established by the 
Declaration of Condominium Ownership recorded {PR,"Enter date of Condominium Declaration 
recording.",DT2,1}, as Document No. {PR,"Enter Document number.",ST1,4}, as amended from time to 
time.  

Limitations and conditions imposed by the Wisconsin Condominium Ownership Act.  

Legal Description: Unit (Wisconsin) 

Parcel 1:  

Unit {PR,"Condo Legal: Enter condominium unit number:",ST1,1} in the {PR,"Condo Legal: Enter the 
condominium name:",ST1,2} Condominium as depicted on the Plat of Survey of the following described 
real estate:  

{PR,"Condo Legal: Enter base legal description:",ST2,3}  

which Plat of Survey is attached as Exhibit “{PR,"Condo Legal: Enter the Exhibit letter or number of 
thePlat:",ST1,4}” to the Declaration of Condominium Ownership, recorded {PR,"Condo Legal: Enter 
date of recording of condo declaration:",DT2,5}, in the Office of the Register of Deeds of {PR,"Condo 
Legal: Enter county of recorded declaration:",ST1,6} County, {DB,Property,State,NO}, as Document 
Number {PR,"Condo Legal: Enter document number of declaration:",ST1,7}, as amended from time to 
time, together with its undivided percentage interest in the common elements, in {RP,6} County, 
{DB,Property,State,NO}.  

New Condominium (Wisconsin) 

Furnish ATG with a certificate, executed and acknowledged by the Secretary of the Board of 
Managers/Directors, stating that there are no unpaid assessment liens arising by reason of the nonpayment 
of assessments as per the Condominium Declaration.  

Terms, provisions, covenants, conditions, and options in, rights and easements established by the 
Declaration of Condominium Ownership recorded {PR,"Enter date of Condominium Declaration 
recording.",DT2,1}, as Document No. {PR,"Enter Document number.",ST1,4}, as amended from time to 
time.  

Furnish ATG with a certificate, executed and acknowledged by the Secretary of the Board of 
Managers/Directors, stating that compliance has been made by the owners with the provisions of Article 
{PR,"Article Number",IN1,3} of the Condominium Declaration or that said provisions relating to 
preemptive rights have been duly waived by the Board of Managers/Directors and the rights of the Board 
thereunder have terminated.  

Limitations and conditions imposed by the Wisconsin Condominium Ownership Act.  

Preemptive Rights (Wisconsin) 

Furnish ATG with a certificate, executed and acknowledged by the Secretary of the Board of 
Managers/Directors, stating that compliance has been made by the owners with the provisions of the 
Condominium Declaration or that said provisions relating to preemptive rights have been duly waived by 
the Board of Managers/Directors and the rights of the Board thereunder have terminated.  

Statute (Wisconsin) 

Limitations and conditions imposed by the Wisconsin Condominium Ownership Act.  
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CONSTRUCTION  

Construction Loan Policy Held Open  

ATG has been requested to delay issuance of the final policy or policies committed for hereunder after the 
proposed Insured acquires of record the estate or interest or mortgage in the land due to construction of 
improvements on the land. ATG hereby agrees to delay issuance of the final policy or policies subject to 
the following conditions:  

1. If ATG has agreed to delete Special Exception 1 from this Commitment, the final policy or 
policies will be subject to defects, liens, encumbrances, adverse claims, or other matters, if any, 
created, first appearing in the public records, or attaching subsequent to the date the proposed 
Insured acquires for value of record the estate or interest or mortgage thereon covered by this 
Commitment.  

2. If the delay in issuing the final policy or policies extends beyond six months from the Effective 
Date of this commitment, all liability and obligations of ATG hereunder shall cease and 
terminate.  

3. Upon completion of construction, ATG must be provided final Owner’s and General 
Contractor’s Sworn Statements (ATG Form 3018, or Forms 3018-A and 3018-B) and Final 
Waiver of Lien (ATG Form 3005), in a form acceptable to ATG, from all entities supplying 
materials, labor, or services to the land. In addition, ATG must be provided an Indemnity 
Agreement (Construction-Mechanic’s Liens) (ATG Form 3006) signed by the owner(s) and 
general contractor(s).  

4. If Standard Exceptions 1, 2, or 3 are to be removed from the final policy or policies, ATG must 
be provided with a current ALTA Statement (ATG Form 3004) and a survey acceptable to ATG 
of the land and all improvements thereon.  

5. If any endorsements or other additional coverage were committed for the final policy or 
policies, all inspections, undertakings, affidavits, or other documentation, and all other 
requirements to issue the endorsements or additional coverage must be updated to include the 
Date of Policy.  

6. The payment to ATG of recording, search, examination, underwriting, endorsement, or other 
fees as may be required to issue the final policy or policies.  

Commitment  

ATG must be provided with properly executed sworn contractors’ statements, sub-contractors’ 
statements, and final lien waivers along with proof of proper disbursements of any loan proceeds used for 
the improvement of the land, or the policy or policies, when issued, will be subject to the following 
exceptions:  

"(a) Any lien, or right to a lien, for services, labor, or materials, heretofore or hereafter furnished, 
imposed by law, and not shown by the public records.  

"(b) Consequences of the failure of the lender to pay out properly the whole or any part of the 
loan secured by the mortgage described in Schedule A as affecting: (i) the validity of the lien of 
the mortgage; and (ii) the priority of the lien of the mortgage over any other right, claim, lien, or 
encumbrance that has or may become superior to the lien of the mortgage before the 
disbursement of the entire proceeds of the loan." 

COOPERATIVES  

Coop: Bylaws  

Terms, provisions, covenants, rights, and options contained in the bylaws of the Cooperative and any 
other instrument that governs the management, use, or occupancy of the land, including, but not limited 
to, rights of refusal, consent provisions, and provisions relating to the levying and enforcement of 
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assessments and special assessments, and any pledges of, or liens upon, the capital stock, and the 
consequences of the enforcement thereof.  

Coop: Commitment  

ATG should be furnished with the following items, and this commitment is subject to such further 
exceptions as then may be deemed necessary:  

(a) A copy of the cooperative corporate bylaws and any other instruments that govern the 
management, use, or occupancy of the land;  

(b) An executed copy of the original lease creating title to the leasehold estate described in 
Schedule A, together with all assignments thereof, if any;  

(c) A written statement from the Board of Directors of the cooperative corporation that authorizes 
and consents to the lease, assignment, or mortgage to be insured, and to any transfer or mortgage 
to be insured, and to any transfer or pledge of stock related thereto;  

(d) A written statement from the Board of Directors of the cooperative corporation that there are 
no unpaid assessments, special assessments, or other charges with respect to the leasehold to be 
insured, and that there has been no default under the terms of the lease. This statement must cover 
the period that includes the recording date of the lease, assignment, or mortgage to be insured.  

CORPORATIONS: DOMESTIC  

Active  

The certificate of authority of {PR,"Enter name of Illinois Corporation.",ST1,1} to do business in Illinois 
issued by the Secretary of State should be produced, and in default thereof, the policy or policies to be 
issued will contain the following exception: “Consequences, if any, that may result because of the failure 
of the party in title to the estate or interest in the land described in Schedule A to comply with the 
applicable ‘doing business’ laws of the State of Illinois.” 

Upon a conveyance or mortgage of the land provide a certified copy of proper resolutions, passed by the 
stockholders and directors of the party in title, authorizing the execution of the deed of conveyance or 
mortgage.  

Franchise tax in favor of the State of Illinois against {PR,"Enter name (foreign or Illinois) 
ofcorporation.",ST1,1}, a corporation existing under the laws of the State of {PR,"Enter name of state 
where corporation was chartered.",ST1,2}.  

Dissolved  

{PR,"Enter name of dissolved Illinois corporation.",ST1,3}, an Illinois corporation, was dissolved on 
{PR,"Enter date of dissolution of Illinois corporation.",DT2,4}. We note the following with respect 
thereto and this Commitment is subject to the following exceptions:  

(1) Rights of the creditors of said corporation including the United States of America;  

(2) Right, title, and interest of the stockholders/members of said corporation and those claiming 
under them.  

(3) Franchise tax in favor of the State of Illinois.  

Active (Wisconsin) 

The certificate of authority of {PR,"Enter name of Wisconsin Corporation.",ST1,1} to do business in 
Wisconsin issued by the Department of Financial Institutions should be produced, and in default thereof, 
the policy or policies to be issued will contain the following exception:·“Consequences, if any, that may 
result because of the failure of the party in title to the estate or interest in the land described in Schedule A 
to comply with the applicable ‘doing business’ laws of the State of Wisconsin.”  

 
ATG RESOURCE® User Manual Page 14-15 
© ATG (5/15) 



Upon a conveyance or mortgage of the land, provide a certified copy of proper resolutions, passed by the 
stockholders and directors of the party in title, in conformance with the laws of the State of Wisconsin, 
authorizing the execution of the deed of conveyance or mortgage.  

Franchise tax in favor of the State of Wisconsin against {PR,"Enter name (foreign or Wisconsin) of 
corporation.",ST1,1}, a corporation existing under the laws of the State of {PR,"Enter name of state 
where corporation was chartered.",ST1,2}.  

Dissolved (Wisconsin) 

{PR,"Enter name of dissolved Wisconsin corporation.",ST1,3}, a Wisconsin corporation, was dissolved 
on {PR,"Enter date of dissolution of Wisconsin corporation.",DT2,4}. We note the following with respect 
thereto and this Commitment is subject to the following exceptions:  

(1) Rights of the creditors of said corporation including the United States of America;  

(2) Right, title, and interest of the stockholders/members of said corporation and those claiming 
under them.  

(3) Franchise tax in favor of the State of Wisconsin, against {PR,"Name of Corporation",ST1,3}, 
a Wisconsin corporation.  

CORPORATIONS: FOREIGN  

Foreign: Certificate of Authority (Wisconsin) 

The certificate of authority of {PR,"Enter name of foreign Corporation.",ST1,1} to do business in 
Wisconsin issued by the Department of Financial Institutions should be produced, and in default thereof, 
the policy or policies to be issued will contain the following exception: “Consequences, if any, that may 
result because of the failure of the party in title to the estate or interest in the land described in Schedule A 
to comply with the applicable ‘doing business’ laws of the State of Wisconsin.”  

Foreign: Dissolved (Wisconsin) 

{PR,"Enter name of dissolved foreign corporation.",ST1,1}, a corporation of {PR,"Enter state where 
dissolved foreign corporation was formed.",ST1,2}, was dissolved by {PR,"Who (i.e., 
members/stockholders/State) dissolved the foreign corporation?",ST1,3}, on {PR,"Enter date of foreign 
corporate dissolution.",DT2,4}. We note the following with respect thereto and this Commitment is 
subject to the following exceptions: 

(1) Rights of the creditors of said corporation, including the United States of America.  

(2) Statutory conditions and limitations, if any, imposed by the laws of the State of {RP,2} upon 
conveyances by the successors in title to the real estate of said corporation.  

(3) Franchise tax in favor of the State of Wisconsin against {RP,1}, a corporation of {RP,2}.  

We should be furnished a duly certified list of all of the successors in title to the real estate of said 
corporation and this Commitment is subject to such further exceptions, if any, as may then be deemed 
necessary. 

Foreign: Not for Profit (Wisconsin) 

A certified copy of the charter and amendments thereto, if any, and of the bylaws of the corporation in 
title should be furnished, and this Commitment is subject to such further exceptions, if any, as may then 
be deemed necessary. Upon a conveyance or mortgage of the land, a certified copy of proper resolutions, 
passed by the stockholders and directors of the party in title, in conformity with the laws of the State of 
{PR,"Enter State of foreign incorporation.",ST1,1}, authorizing the execution of the deed of conveyance 
or mortgage should be furnished.  

The certificate of authority of {PR,"Enter name of foreign Corporation.",ST1,2} to do business in 
Wisconsin issued by the Department of Financial Institutions should be produced, and in default thereof, 
our policy will contain the following exception:  
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"Consequences, if any that may result because of the failure of the party in title to the estate or 
interest in the land described in Schedule A to comply with the applicable ‘doing business’ laws 
of the State of Wisconsin."  

Foreign: Certificate of Authority  

The certificate of authority of {PR,"Enter name of foreign Corporation.",ST1,1} to do business in Illinois, 
issued by the Secretary of State, should be produced, and in default thereof, the policy or policies to be 
issued will contain the following exception: 

"Consequences, if any, that may result because of the failure of the party in title to the estate or 
interest in the land described in Schedule A to comply with the applicable ‘doing business’ laws 
of the State of Illinois." 

Foreign: Charter  

A certified copy of the charter and amendments, if any, and of the bylaws of {PR,"Enter name of foreign 
Corporation",ST1,1}, should be furnished, and this Commitment is subject to such further exceptions, if 
any, as may then be deemed necessary.  

Foreign: Dissolved  

{PR,"Enter name of dissolved foreign corporation.",ST1,1}, a corporation of {PR,"Enter state where 
dissolved foreign corporation was formed.",ST1,2}, was dissolved by {PR,"Who (i.e., 
members/stockholders/State) dissolved the foreign corporation?",ST1,3}, on {PR,"Enter date of foreign 
corporate dissolution.",DT2,4}. We note the following with respect thereto and this Commitment is 
subject to the following exceptions: 

(1) Rights of the creditors of said corporation, including the United States of America.  

(2) Statutory conditions and limitations, if any, imposed by the laws of the State of {RP,2} upon 
conveyances by the successors in title to the real estate of said corporation.  

(3) Franchise tax in favor of the State of Illinois against {RP,1}, a corporation of {RP,2}.  

We should be furnished a duly certified list of all of the successors in title to the real estate of said 
corporation and this Commitment is subject to such further exceptions, if any, as may then be deemed 
necessary.  

Foreign: Not for Profit  

A certified copy of the charter and amendments thereto, if any, and of the bylaws of the corporation in 
title should be furnished, and this Commitment is subject to such further exceptions, if any, as may then 
be deemed necessary.· Upon a conveyance or mortgage of the land, a certified copy of proper resolutions, 
passed by the stockholders and directors of the party in title in conformity with the laws of the State of 
{PR,"Enter State of foreign incorporation.",ST1,1}, authorizing the execution of the deed of conveyance 
or mortgage should be furnished.  

The certificate of authority of {PR,"Enter name of foreign Corporation.",ST1,2} to do business in Illinois, 
issued by the Secretary of State, should be produced, and in default thereof, our policy will contain the 
following exception:  

"Consequences, if any, that may result because of the failure of the party in title to the estate or interest in 
the land described in Schedule A to comply with the applicable ‘doing business’ laws of the State of 
Illinois."  

CORPORATIONS: MISCELLANEOUS 

Hospital: Hill-Burton Act  

Rights of the United States of America and the State of Illinois, or either of them, to recover any public 
funds advanced under the provisions of one or more of various federal statutes relating to health care or 
the Illinois Hospital Construction Act.  
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Municipal: Conveyance  

Upon a conveyance or mortgage of the land, we should be supplied with satisfactory proof of compliance 
with the provisions of the Illinois Compiled Statutes regarding sale or lease of land by a municipal 
corporation, as well as a copy of the ordinance approving the conveyance of the land, and this 
Commitment is subject to such further exceptions, if any, as may then be deemed necessary.  

Not-for-Profit: Resolution  

Upon a conveyance or mortgage of the land, a certified copy of proper resolutions passed by the members 
and directors of the party in title authorizing the execution of the deed of conveyance or mortgage, 
together with a properly certified copy of the bylaws of said corporation, should be furnished.  

Religious: Resolution  

Upon any conveyance or mortgage of said land, a certified copy of the bylaws and a resolution passed by 
the members of the party in title authorizing the execution of the instrument of conveyance or mortgage 
should be furnished, together with a certificate by the custodian of records establishing: (1) the names of 
all person selected members of the board of trustees at the last election; (2) the form of notice for the 
election; (3) the total number of members entitled to vote on corporate matters; (4) proper notice of the 
meeting to consider the questions of conveying or mortgaging the land was given to all members; (5) the 
number of members present at such meeting; and (6) the number of the "ayes" and "nays" voted on such 
question.  

University: Higher Education Act  

Rights of the United States of America to recover any public funds advanced under the provision of the 
Higher Education Facilities Act of 1963.  

DECEDENTS  

Deceased Joint Tenant  

We should be supplied with satisfactory evidence establishing the death, the testacy or intestacy, the 
status of tenancy at time of death, and the value of the estate of {PR,"Insert name of deceased joint tenant 
here.",ST1,1}, deceased; and this commitment is subject to such further exceptions, if any, as may then be 
deemed necessary.  

General  

A satisfactory table of the heirship and proof of the death, testacy or intestacy, and of the value of the 
estate of {PR,"Enter name of deceased person.",ST1,1}, deceased, should be furnished, and this 
Commitment is subject to such further exceptions, if any, as may then be deemed necessary.  

Claims against the estate of {PR,"Enter name(s) of Decedent(s).",ST1,1}, deceased.  

Federal and Illinois Estate Taxes that may be charged against the estate of {PR,"Enter name of deceased 
person.",ST1,1}.  

Statutory rights, powers, and duties of the personal representative of the decedent if and when appointed.  

Miscellaneous  

Proceedings pending in the Circuit Court of {PR,"Enter name of County.",ST1,1} County entitled Estate 
of {PR,"Enter name of deceased person.",ST1,2}, deceased, under Case No. {PR,"Enter 
casenumber.",ST1,3}.  

Right of any person to demand formal proof of the will or to contest the will of {PR,"Enter name of 
deceased person.",ST1,1}, deceased, within the time provided by the Probate Act.  

Statutory rights of {PR,"Enter name of surviving spouse.",ST1,1}, surviving spouse of the decedent, to 
renounce the will of deceased and take statutory share.  

Power of sale conferred upon {PR,"Enter name of Executor.",ST1,1}, Executor, by terms of the will of 
{PR,"Enter name of deceased person.",ST1,2}, deceased.  
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Right, title and interest of {PR,"Enter names of person(s) taking under the will.",ST1,1}, devisee(s) under 
the unproven will of {PR,"Enter the name of the deceased person.",ST1,2}, deceased.  

Personal Representative Commitment  

This Commitment is made on the assumption that title to the land is to be derived through a conveyance 
by {PR,"Enter name of estate personal representative.",ST1,1}, the personal representative, pursuant to 
the power of sale conferred under the last will and testament of {PR,"Enter name of 
deceasedperson.",ST1,2}, deceased.  

If title is to be derived through a deed by one other than the personal representative of the estate of 
{PR,"Enter name of deceased person.",ST1,1}, deceased, during the pendency of said proceeding, a 
proper order should be entered divesting said personal representative of the rights and powers granted 
under the Probate Act or an instrument of distribution and release should be recorded pursuant to the 
Probate Act.  

Sale: Court-Ordered Sale  

Order entered on {PR,"Enter date of court order.",DT2,1}, in the proceeding entitled Estate of {PR,"Enter 
name of deceased person.",ST1,2}, Deceased, Case No. {PR,"Enter case number.",ST1,3}, providing that 
the land be sold as provided in said order.  

Sale: Independent Representative  

If the conveyance is to be made pursuant to the provisions of the Probate Act regarding sale by the 
independent representative, the conveyance should so recite.  

Sale: Power of Sale in Will  

Any conveyance of the land by the personal representative should recite that it is executed pursuant to the 
power and authority vested in the personal representative by the last will of {PR,"Enter name of deceased 
person.",ST1,1}, deceased. In addition, the personal representative should file the bond required by the 
Probate Act.  

Sale: Purchaser’s Interest  

Right, title, and interest of {PR,"Enter name of purchaser.",ST1,1}, purchaser of the land as disclosed by 
court order entered in the proceedings entitled Estate of {PR,"Enter name of deceased person.",ST1,2}, 
Deceased, Case No. {PR,"Enter case number.",ST1,3}.  

General (Wisconsin) 

A satisfactory table of the heirship and proof of the death, testacy or intestacy, and of the value of the 
estate of {PR,"Enter name of deceased person.",ST1,1}, deceased, should be furnished, and this 
commitment is subject to such further exceptions, if any, as may then be deemed necessary.  

Claims against the estate of {PR,"Enter name(s) of Decedent(s).",ST1,1}, deceased.  

Federal and Wisconsin Estate Taxes, that may be charged against the estate of {PR,"Enter name of 
deceased person.",ST1,1}.  

Statutory rights, powers, and duties of the personal representative of the decedent if and when appointed.  

MSU Decedents Exceptions  

A satisfactory table of heirship and proof of the death, testacy and intestacy, and of the value of the estate 
of {PR,"name of decedent",ST1,1}, deceased, should be furnished; and this commitment is subject to 
such further exceptions, if any, as may then be deemed necessary.  

Claims against the estate of {PR,"name of decedent",ST1,2}, deceased.  

Federal and Illinois Estate Taxes, which may be charged against said estate.  

Statutory rights, powers, and duties of the personal representative of said decedent, if and when 
appointed. 
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No Probate  

Decedent*, owner of the property, died testate *, leaving a will filed with the * Circuit Clerk on *. In 
connection therewith, the following is noted: 

(A) A satisfactory table of the heirship and of the value of the estate of *, deceased, should be furnished, 
and this commitment is subject to such further exceptions, if any, as may then be deemed necessary; 

(B) Expenses of administration and claims against the estate of *, deceased; 

(C) Federal and Illinois Estate Taxes, which may be charged against said estate; 

(D) Statutory rights, powers, and duties of the personal representative of said decedent, if and when 
appointed; 

(E) Legacies created by the Will; 

(F) If the property is to be conveyed by devisees under the will under the Illinois. 

Small Estate Act, it will be necessary that such grantors execute a Personal Undertaking satisfactory to 
ATG, a copy of which is furnished herewith.  

DEEDS  

Illinois Notary Requirements  

Any document purporting to convey title to residential real property in Cook County, Illinois, must 
comply with the requirements of the Illinois Notary Public Act (5 ILCS 312/1-101, et seq.), and, 
specifically, the requirements of Section 3-102 of the Act requiring that a Notarial Record be made.  

Chain of Title  

Last Deed of Record: Warranty Deed dated *, and recorded *, as Document *, from *, grantor, to *, 
grantee.  

DISABLED PERSON  

General (Wisconsin) 

Proceedings pending in the Circuit Court of {PR,"Enter name of County.",ST1,1} County entitled Estate 
of {PR,"Enter name of disabled person.",ST1,2}, a disabled person, under Case No. {PR,"Enter disabled 
person’s case number.",ST1,3}.  

Any conveyance of the land must be made by the guardian of the Estate of {PR,"Enter name of disabled 
person.",ST1,1}, a disabled person, pursuant to a proper order entered in Case No. {PR,"Enter minor’s 
case number.",ST1,2} and such conveyance should recite that the same is executed pursuant to a proper 
order entered in Case No. {RP,2} ordering the conveyance and should recite therein the full consideration 
for which it is given. In addition, the guardian should file any bond required by Section 880.13 of the 
Wisconsin Statutes.  

Statutory right, powers, and duties of the guardian of the Estate of {PR,"Enter name of 
disabledperson.",ST1,1}, a disabled person.  

General  

Proceedings pending in the Circuit Court of {PR,"Enter name of County.",ST1,1} County entitled Estate 
of {PR,"Enter name of disabled person.",ST1,2}, a disabled person, under Case No. {PR,"Enter disabled 
person’s case number.",ST1,3}.  

Any conveyance of the land must be made by the guardian of the Estate of {PR,"Enter name of disabled 
person.",ST1,1}, a disabled person, pursuant to a proper order entered in Case No. {PR,"Enter minor’s 
case number.",ST1,2} and such conveyance should recite that the same is executed pursuant to a proper 
order entered in Case No. {RP,2} ordering the conveyance and should recite therein the full consideration 
for which it is given. In addition, the guardian should file the bond required by the Probate Act.  
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Statutory right, powers, and duties of the guardian of the Estate of {PR,"Enter name of disabled 
person.",ST1,1}, a disabled person.  

DIVORCE  

Child Support: Lien  

Child support judgment filed against {PR,"Insert name of person(s) who received judgment 
here.",ST1,1}, in Case No. {PR,"Insert Case number here.",ST1,2} in the Circuit Court of {PR,"Insert 
name of County here.",ST1,3} County, Illinois, a memorandum of which was recorded on {PR,"Insert 
date the judgment was recorded here.",DT2,4}, as Document No. {PR,"Insert Document number 
here.",ST1,5}.  

Dissolution: Proceedings  

Dissolution of marriage proceedings filed by {PR,"Insert name of Plaintiff here.",ST1,1} against 
{PR,"Insert name of Defendant here.",ST1,2} in the Circuit Court of {PR,"Insert name of County 
here.",ST1,3} County as case {PR,"Insert Case number here.",ST1,4}.  

NOTE: No examination of these proceedings has been made, and upon examination, this commitment, 
and any policies committed for thereunder, shall be subject to such other and further exceptions as may 
then be deemed necessary.  

Wisconsin Child Support: Lien  

Child support judgment filed against {PR,"Insert name of person(s) who received judgment 
here.",ST1,1}, in Case No. {PR,"Insert Case number here.",ST1,2} in the Circuit Court of {PR,"Insert 
name of County here.",ST1,3} County, Wisconsin, a memorandum of which was recorded on {PR,"Insert 
date the judgment was recorded here.",DT2,4}, as Document No. {PR,"Insert Document number 
here.",ST1,5}.  

DOWNSTATE TRAIN  

DTD LTD.  

Encroachment: Adverse  

Adverse encroachment of {PR,"what encroaches",ST1,1} from {adjoining property, public property} 
from the {north, south} onto the subject property by approximately {PR,"how much encroaches",ST1,2} 
feet as disclosed by survey dated * and prepared by *.  

EASEMENTS  

Dedicated Road (Wisconsin) 

Rights of the public, the State of Wisconsin, and the municipality in and to so much of the land dedicated 
for road purposes by instrument dated {PR,"Insert date of document.",DT2,1} and recorded {PR,"Insert 
date of recording.",DT2,2} as Document No. {PR,"Insert Document number.",ST1,3}.  

Drainage Easements  

Rights of way for drainage ditches, feeders, laterals, and underground pipe or tile, if any.  

Building Setback  

A {PR,"# of feet",ST1,1} foot building line from the {PR,"Front, back, or side",ST1,2} line of the 
property as shown on the recorded plat of said subdivision.  

Dedicated Road  

Rights of the public, the State of Illinois, and the municipality in and to so much of the land dedicated for 
road purposes by instrument dated {PR,"Insert date of document.",DT2,1}, and recorded {PR,"Insert date 
ofrecording.",DT2,2}, as Document No. {PR,"Insert Document number.",ST1,3}.  
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Insured Parcel 2  

Terms, provisions, and conditions relating to the easement described as Parcel 2 contained in the 
instrument creating such easement.  

Rights of the adjoining owner or owners to the concurrent use of the easement described as Parcel 2.  

Prescriptive: Party Driveway  

A {PR,"Enter # of Feet",IN3,1}-foot party driveway located on the property described in Schedule A and 
the land {PR,"Direction",ST1,2} and adjoining and all rights ensuing thereunder in favor of said 
adjoining land.  

Prescriptive: Party Wall  

Rights of adjoining property owners in and to the {PR,"Direction",ST1,1} wall of the 
{PR,"Improvement",ST1,2} located on the property described in Schedule A hereof.  

Prescriptive: General  

Easement in favor of the public and quasi-public utilities and the municipality over the {PR,"Enter 
location here, i.e., North, South, East or West",ST1,1} and {PR,"Enter distance in feet here",IN3,2} feet 
of the property as evidenced by poles, conduits, sewers, etc.  

Standard Language  

Easement for {PR,"Enter the purpose of the easement.",ST1,1} as set forth in {PR,"Describe the 
document creating the easement.",ST1,2} dated {PR,"Enter the date of the easement.",DT2,3} and 
recorded {PR,"Enter the date the easement was recorded.",DT2,4} as Document {PR,"Enter Document 
number.",ST1,7}, from {PR,"Enter name(s) of person(s) granting easement.",ST1,8} to {PR,"Enter 
name(s) of person(s) receiving easement.",ST1,9}.  

Termination: Senior Lienholder  

The easement created by instrument dated {PR,"Enter date of document.",DT2,1} and recorded 
{PR,"Enter date document was recorded.",DT2,2} as Document No. {PR,"Enter Document 
number.",ST1,3} was not executed by {PR,"Enter name of missing lender.",ST1,6} a senior lienholder on 
the servient tenement. In the absence of such execution or other consent to the creation of the easement, 
this commitment, and all policies issued pursuant hereto, shall be subject to the consequences of such 
absence of lienholder execution or consent.  

ENCROACHMENTS  

Adjoining Land: Lot Line  

A survey discloses an encroachment by {PR,"Describe the building or structure that is 
encroaching.",ST1,1} located on the property to the {PR,"Enter direction (North, South, etc.) of 
encroachment.",ST1,2} and adjoining onto the insured premises by approximately {PR,"Enter number of 
feet of encroachment.",IN1,3} feet.  

Insured Land: Building Line  

A survey discloses an encroachment of the {PR,"Describe the encroaching structure.",ST1,1} over the 
{PR,"Enter direction (North, South, etc.).",ST1,2} building line by {PR,"Enter number of feet of 
encroachment.",IN1,3} feet.  

Insured Land: Easement  

A survey discloses that the {PR,"Describe the structure that is encroaching.",ST1,1} located upon the 
insured premises encroaches onto the utility easement located on the {PR,"Enter direction (North, South, 
etc.).",ST1,2} of the land by {PR,"Enter number of feet of the encroachment.",IN1,3} feet.  
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Insured Land: Lot Line  

A survey discloses that the {PR,"Describe the structure encroaching.",ST1,1} located upon the insured 
premises encroaches upon the property {PR,"Enter direction (North, South, etc.) of 
encroachment.",ST1,2} and adjoining by {PR,"Enter number of feet of encroachment.",IN1,3} feet.  

ENVIRONMENTAL  

General: Environmental Lien  

Environmental lien filed by {PR,"Enter name of entity filing the environmental lien.",ST1,1} against 
{PR,"Enter name of entity that environmental lien was filed against.",ST1,2} on {PR,"Enter date that 
environmental lien was filed.",DT2,3} as Document No. {PR,"Enter environmental document 
number.",ST1,4}, in the office of the Recorder of {PR,"Enter County where environmental lien was 
recorded.",ST1,7} County, Illinois, in the sum of {PR,"Enter amount of environmental lien in dollars and 
cents.",CU1,8}.  

Wisconsin RPTA: Fact Exception  

The fact, as disclosed by the liens recorded {PR,"Enter date of recording of environmental lien.",DT2,1}, 
as Document No. {PR,"Enter Document number of recorded environmental lien.",ST1,2}, in the Office of 
the Register of Deeds of {PR,"Enter name of County where environmental lien was recorded.",ST1,5} 
County, Wisconsin, that some violation of environmental protection laws may have or has occurred which 
may affect the land.  

Wisconsin General: Environmental Lien  

Environmental lien filed by {PR,"Enter name of entity filing the environmental lien.",ST1,1} against 
{PR,"Enter name of entity that environmental lien was filed against.",ST1,2} on {PR,"Enter date that 
environmental lien was filed.",DT2,3} as Document No. {PR,"Enter environmental document 
number.",ST1,4} in the office of the Register of Deeds of {PR,"Enter County where environmental lien 
was recorded.",ST1,7} County, Wisconsin, in the sum of {PR,"Enter amount of environmental lien in 
dollars and cents.",CU1,8}.  

Wisconsin RPTA: RPTA Document  

Environmental disclosure document for transfer of real property dated {PR,"Enter date environmental 
document was created.",DT2,1}, and recorded {PR,"Enter date environmental document 
wasrecorded.",DT2,2}, as Document No. {PR,"Enter environmental Document number.",ST1,3}, in the 
Register of Deeds of {PR,"Enter name of County where environmental document was recorded.",ST1,6} 
County, Wisconsin.  

ESTATE  

MEO  

Mortgage Electronic Registration Systems (MERS)  

Mortgage Electronic Registration Systems, Inc., acting solely as nominee for taxes. 

The lien of taxes for the year 2008 and thereafter. P.I.N.:  

- First Installment 2008 taxes, in the amount of $*, have been paid. 

- Second Installment 2008 taxes are not yet due or payable.  

2009 General real estate taxes are not yet due or payable.  

Plat  

Easements for public utilities and drainage and building setback lines as shown on the Plat of 
Subdivision. Covenants, Conditions, and Restrictions as shown on the Plat of Subdivision.  
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PUD  

This property is located in a planned unit development that has a homeowner’s association. Quarterly, 
monthly, or yearly association dues are assessed. A letter from the association or management company 
stating that all dues are paid and that all requirements have been met will be needed at closing.  

Plat  

Easements for public utilities and drainage and building setback lines as shown on the Plat of 
Subdivision.  

Covenants, Conditions, and Restrictions as shown on the Plat of Subdivision.  

CHAIN OF TITLE *** We have searched the records of the Recorder of Deeds for a period in excess of 
24 months from the date of this commitment and have confirmed that the current owners, Mark A. 
Borders and Kimberly B. Borders, acquired title to the subject premises by Warranty Deed dated March 
28, 2001, and recorded April 10, 2001, as Document No.2001R0021911, in McHenry County, Illinois.  

Chain  

**CHAIN OF TITLE** We have searched the records of the Recorder of Deeds for a period in excess of 
12 months from the date of this commitment and have confirmed that the current owner *, obtained title 
to the subject property by Deed dated *, and recorded *, as Document No. *, in * County, Illinois.  

EXCEPTIONS  

Name Affidavit  

Attorneys’ Title will require a Personal Name Affidavit executed by {PR,"Type Individual’s Full 
Name",ST1,1}, and this Commitment remains subject to further such exceptions.  

Supervisor’s Resolution  

Building Lines as set by Board of Supervisors Resolution adopted June 6, 1966, and recorded in Book 
2017 on page 13.  

Monroe  

Rights of the public, the municipality, and State of Illinois in and to that portion of the land taken or used 
for roadway purposes, if any. Rights of the public or quasi-public utility companies in and to any portion 
of the land used for utility purposes. Rights of way for drainage ditches, feeders, tiles and laterals, if any.  

Subject to building lines, easements, and restrictions, if any, of record. No search has been made of the 
coal, oil, gas or other mineral title, and our policy, if and when issued, will except the coal, oil, gas and 
other mineral title, and all rights and easements in favor of the estate of said coal, oil, gas, and other 
minerals.  

NOTE FOR INFORMATION: The recording of any deed hereunder is contingent upon approval by 
Department of Mapping and Platting of Monroe County, Illinois as to compliance with the Plat Act.  

Metro East Office  

Rights of the public, the State of Illinois, township, county, and the municipality in and to that part of the 
land shown on Schedule A, taken, used, or dedicated for road or highway purposes. Rights of the public 
or quasi-public utility companies in and to any portion of the land used for utility purposes. Tax liens 
created by Special Area Ordinances not searched or insured. Rights of way for drainage ditches, feeders, 
tiles, and laterals, if any. Subject to building lines, easements and restrictions, if any, of record.  

Financing statements, if any, not certified to by abstracter. If any document referenced herein contains a 
covenant, condition, or restriction, which violates 42 USC (c), such covenant, condition, or restriction, to 
the extent of such violation, is hereby deleted.  

Except coal, oil, gas, and other mineral title, and all rights and easements in favor of the estate of said 
coal, oil, gas, and other minerals excepted or reserved in prior conveyances. NOTE: No search has been 
made of the coal, oil, gas or other mineral title.  
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NOTE FOR INFORMATION: Attention is directed to ordinance and regulations relating to connections, 
charges, and liens for use of any public sewerage, water, or other utility system serving the land referred 
to herein. We call your attention to the fact that all sewer and utility bills should be obtained from the 
offices supplying the service. We indicate only recorded liens.  

NOTE FOR INFORMATION: The recording of any deed hereunder is contingent upon approval by 
Department of Mapping and Platting of {PR,"Type Name of County",ST1,1} County, Illinois, as to 
compliance with the Plat Act.  

St. Clair  

Rights of the public, the municipality, and State of Illinois in and to that portion of the land taken or used 
for roadway purposes, if any.  

Rights of the public or quasi-public utility companies in and to any portion of the land used for utility 
purposes.  

Rights of way for drainage ditches, feeders, tiles, and laterals, if any.  

Subject to building lines, easements, and restrictions, if any, of record.  

No search has been made of the coal, oil, gas, or other mineral title, and our policy, if and when issued, 
will except the coal, oil, gas, and other mineral title, and all rights and easements in favor of the estate of 
said coal, oil, gas, and other minerals.  

NOTE FOR INFORMATION: Attention is directed to ordinance and regulations relating to connections, 
charges, and liens for use of any public sewerage, water, or other utility system serving the land referred 
to herein. We call your attention to the fact that all sewer and utility bills should be obtained from the 
offices supplying the service. We indicate only recorded liens.  

NOTE FOR INFORMATION: The recording of any deed hereunder is contingent upon approval by 
Department of Mapping and Platting of St. Clair County, Illinois, as to compliance with the Plat Act.  

BUILDING SETBACK 

Building Setback 

A {PR,"Enter Number of feet",ST1,1} foot building line from the {PR,"Enter direction",ST1,2} line of 
the property as shown on the Plat.  

FORECLOSURE  

Mortgage: Foreclosure Deed Interest (Wisconsin) 

Right, title, and interest of {PR,"Enter name of person receiving deed.",ST1,1}, under a sheriff’s (judge’s) 
deed dated {PR,"Enter date of deed.",DT2,2}, and recorded {PR,"Enter date deed was recorded.",DT2,3}, 
as Document No. {PR,"Enter Document number.",ST1,4} and issued pursuant to judgment of foreclosure 
entered {PR,"Enter date judgment of foreclosure was entered.",DT2,7}, in the case filed by {PR,"Enter 
name(s) of Plaintiff.",ST1,8}, and against {PR,"Enter name(s) of Defendant.",ST1,9}, in the Circuit Court 
of {PR,"Enter name of County.",ST1,10} County, Wisconsin, Case No. {PR,"Enter case 
number.",ST1,11}, and all persons claiming thereunder.  

Post Lis Pendens  

We have examined the proceeding in Case No.{PR,"Insert Case Number.",ST1,4} in the Circuit Court of 
Peoria County, Illinois, to foreclose the lien recorded as Document {PR,"Insert Document 
number.",ST1,4}, and note the following:  

A. Right of any interested party to have set aside, modified or reversed the Judgments or orders entered in 
said case;  

B. Right of any party served by publication, or of any person claiming under said party to appear and be 
heard in regard to the judgments and orders entered in said case within the time allowed by law;  
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C. Right, if any, by reason of military service, or of any person interested in the subject matter of the 
proceeding to redeem from the sale held pursuant to the judgment entered in said case within the time 
permitted by the Soldiers’ and Sailors’ Civil Relief Act;  

D. Right of the United States of America to redeem the land from any sale held pursuant to the judgment 
by reason of any federal lien, which may presently or hereafter appear of record within the time permitted 
by law;  

E. Consequences of any failure to comply with the laws of the State of Illinois, which specify the 
conditions under which the holder of the certificate of sale is entitled to obtain a Deed conveying title to 
the land described in schedule C hereof;  

F. Rights of the Purchaser of the land at a sale held pursuant to the judgment entered in said case, and of 
all persons claiming thereunder; relative thereto, we note the right of Bank One, N.A., Purchaser of the 
land at said sale. We find no certificate of sale of Record.  

G. A proper Notice of foreclosure has been recorded as Document {PR,"Insert Document 
number.",ST1,4};  

H. Defects or additional information, if any;  

None  

Post Lis Pendens (Wisconsin) 

We have examined the proceeding in Case No.{PR,"Insert Case Number.",ST1,4} in the Circuit Court of 
{PR,"Name of County",ST1,4}, Wisconsin, to foreclose the lien recorded as Document {PR,"Insert 
Document number.",ST1,4}, and note the following:  

A. Right of any interested party to have set aside, modified, or reversed the judgments or orders entered in 
said case;  

B. Right of any party served by publication, or of any person claiming under said party to appear and be 
heard in regard to the judgments and orders entered in said case within the time allowed by law;  

C. Right, if any, by reason of military service, or of any person interested in the subject matter of the 
proceeding to redeem from the sale held pursuant to the judgment entered in said case within the time 
permitted by the Soldiers’ and Sailors’ Civil Relief Act;  

D. Right of the United States of America to redeem the land from any sale held pursuant to the judgment 
by reason of any federal lien, which may presently or hereafter appear of record within the time permitted 
by law;  

E. Consequences of any failure to comply with the laws of the State of Wisconsin, which specify the 
conditions under which the purchaser is entitled to obtain a Deed conveying title to the land described in 
schedule C hereof;  

F. Rights of the Purchaser of the land at a sale held pursuant to the judgment entered in said case, and of 
all persons claiming thereunder; {PR,"Name of Purchaser and any conditions of judgment",ST1,5}. 

G. A proper Notice of Foreclosure has been recorded as Document {PR,"Insert Document 
number.",ST1,4};  

H. Defects or additional information, if any; {PR,"List any defects",ST1,6}  

FORECLOSURE  

Mortgage: Certificate of Sale Interest  

Right, title, and interest of {PR,"Enter name of purchaser.",ST1,1}, under a certificate of sale dated 
{PR,"Insert date of certificate of sale.",DT2,2}, and recorded {PR,"Insert date of recording.",DT2,3,} as 
Document No. {PR,"Insert Document number.",ST1,4}, and issued pursuant to judgment of foreclosure 
entered {PR,"Insert date of foreclosure judgment.",DT2,7} in the case filed by {PR,"Insert name(s) of 
Plaintiff.",ST1,8}, and against {PR,"Insert name(s) of Defendant.",ST1,9}, in the Circuit Court of 
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{PR,"Insert name of County.",ST1,10} County, Illinois, Case No. {PR,"Insert case number.",ST1,11}, 
and all persons claiming thereunder.  

Mortgage: Foreclosure Deed Interest  

Right, title, and interest of {PR,"Enter name of person receiving deed.",ST1,1}, under a sheriff’s (judge’s) 
deed dated {PR,"Enter date of deed.",DT2,2}, and recorded {PR,"Enter date deed was recorded.",DT2,3}, 
as Document No. {PR,"Enter Document number.",ST1,4}, and issued pursuant to judgment of 
foreclosure entered {PR,"Enter date judgment of foreclosure was entered.",DT2,7}, in the case filed by 
{PR,"Enter name (s) of Plaintiff.",ST1,8}, and against {PR,"Enter name(s) of Defendant.",ST1,9}, in the 
Circuit Court of {PR,"Enter name of County.",ST1,10} County, Illinois, Case No. {PR,"Enter case 
number.",ST1,11}, and all persons claiming thereunder.  

Mortgage: Minutes of Foreclosure  

In order that we may insure title after completion of any proceeding brought to foreclose, the lien of the 
mortgage/trust deed noted at Schedule B No. {PR,"Enter Schedule B foreclosed mortgage 
ExceptionNo.",IN1,1} and recorded as Document No. {PR,"Enter foreclosed mortgage lien recorded 
Documentnumber.",ST1,2}, we note the following and this commitment is subject to:  

a. Our policy, when issued, will be subject to direct attack upon the judgments and orders entered in the 
proceeding.  

b. Our policy, when issued, will be subject to any right or asserted right of a creditor, trustee, or debtor in 
possession in bankruptcy to avoid a transfer of title by sheriff’s deed or otherwise pursuant to Title 11 
U.S.C.(Bankruptcy) or any creditor’s rights law or state insolvency law.  

c. Upon the filing of the complaint, a proper Notice of Foreclosure (Lis Pendens) under Section 151503 of 
the Code of Civil Procedure must be recorded in the Recorder’s Office of {PR,"Enter name of County 
where property is located.",ST1,3} County, Illinois. After July 1, 2008, for property located in Cook 
County, a Certificate of Service must be simultaneously recorded with the Notice of Foreclosure 
affirming that a copy of the Notice was filed with the Department of Financial and Professional 
Regulation. In addition, pursuant to Public Act 95-961, beginning January 1, 2009, for all residential 
foreclosure actions filed, the plaintiff must attach the Homeowner Notice set forth in the Act to the 
summons. The Homeowner Notice must be in at least 12 point type and in English and Spanish.  

d. The following persons are necessary parties to any such proceeding:  

(1) Mortgagor (or successor in interest), the record owner, as a party defendant. If a mortgagor is 
deceased, the personal representative of the decedent, if one has been appointed, or a special 
representative appointed on behalf of the decedent pursuant to 735 ILCS 5/13-209, must be 
named as party defendant.  

(2) Mortgagee (or successor in interest), as party plaintiff. e. The following persons must be made parties 
defendant to the foreclosure if it is desired that the interests be barred by the proceeding:  

(1) All parties acquiring rights in the premises subsequent to the date of this commitment and 
prior to a recorded Notice of Foreclosure (Lis Pendens).  

(2) Any person other than those herein named known to the Plaintiff or the Plaintiff’s attorney to 
have or claim an interest in the premises.  

(3) All persons in possession of any part of the premises in question and all persons whose rights 
would be disclosed by an inspection of the premises.  

(4) Second mortgagees, judgment lienors, etc., by reason of Exception No. {PR,"Enter Schedule 
B Exception numbers of other lienors.",IN1,10}.  

(5) United States of America by reason of Exception No. {PR,"Enter Schedule B Exception number for 
tax lien, if appropriate.",IN1,4}.  

NOTE: Compliance should be had with the provisions of Section 2410 of the Federal Judicial Code, 28 
U.S.C.A., and in connection therewith the following information is furnished:  
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The Notice of tax lien noted at Exception No. {RP,4} was filed by the District Director of Internal 
Revenue, at {PR,"Enter name of city where IRS office is located.",ST1,5}, Illinois, against {PR,"Enter 
name of person against whom tax lien is made.",ST1,6} in the office of the Recorder of Deeds of 
{PR,"Enter name of County where tax lien is recorded.",ST1,7} County, Illinois, on {PR,"Enter date 
when tax lien was recorded.",DT2,8} as Document No.{PR,"Enter Document number of tax 
lien.",ST1,9}.  

NOTE: Attention is directed to the provisions in Section 2410 of the Federal Judicial Code requiring that 
any action to foreclose a mortgage naming the United States as a party under the Section "must seek a 
judicial sale." In the event a sale is not sought in the contemplated proceeding, such proceeding will not 
affect the rights of the United States noted at Exception No. {RP,4} and the United States should not be 
made party thereto. In addition, we note the consequences of liens, if any, in favor of the United States 
that appear of record after the date of this Commitment.  

NOTE: If it is known that any of the parties listed herein are deceased, their heirs, or devisees should be 
made parties by name, if known, and, if unknown, by the name and description of "UNKNOW NHEIRS 
OR DEVISEES OF" such deceased person or persons. If it is not known or cannot be ascertained whether 
any of said necessary parties be living or dead, then such parties should be made parties by name, and 
such persons as would be their heirs or devisees should also be made parties to the proceeding as 
"UNKNOWN OWNERS." In this connection, we direct your attention to Section 2-413 of the Code of 
Civil Procedure.  

NOTE: In the event that there are any persons who are necessary parties to the contemplated proceeding, 
but the names of such persons are unknown and unascertainable, then, and in that event only, such 
persons should be made parties under the description of "UNKNOWN OWNERS," unless the contrary is 
herein indicated.  

NOTE: The proceeding will not affect the standard exceptions nor the exceptions noted in Schedule B at 
Nos. *; and our policy, when issued, will be subject to such exceptions unless satisfactory disposition 
thereof is otherwise made.  

FORGERY  

Forgery  

Right, title, and interest of {PR,"grantor of deed recorded",ST1,1}, purported grantor in the deed recorded 
{PR,"date of recording",ST1,2} as Document Number {PR,"document number",ST1,3}. 

 NOTE: This exception maybe waived only by an ATG Staff Attorney. 

HOMESTEAD 

Spouse’s interest  

Rights and interest of the spouse, if any, of title holder or person(s) taking title named in Schedule "A." 

NOTE: The present marital status of the Grantors herein named must be disclosed in any subsequent 
Deed of conveyance and/or Mortgage ATG is asked to insure, and their spouses, if any, must join in the 
execution of said Instruments in order to release any homestead rights.  

INSTALLMENT CONTRACT  

Contract Terms  

Terms, conditions, and covenants of installment contract (or agreement for Warranty Deed) between 
{PR,"Enter name of Installment Contract Seller(s).",ST1,1} and {PR,"Enter name(s) of Installment 
Contract Purchaser.",ST1,2}, dated {PR,"Enter date of Installment Contract.",DT2,3}, and recorded 
{PR,"Enter date Installment Contract was recorded.",DT2,4} as Document {PR,"Enter Document 
number.",ST1,7}.]  

Contract Not Recorded  
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Consequences, if any, by reason of the failure to record either the Agreement for Deed or a memorandum 
thereof.  

JUDGMENTS  

Possible Judgments  

We find judgments, liens, and matters of record involving a person or persons whose names are similar to 
{PR,"Enter name of possible judgment debtor",ST1,1}. Relative thereto, a Personal Information Affidavit 
(ATG Form 3008) establishing the identity of the above described person must be supplied in order to 
facilitate the exclusion, if possible, of those items.  

Recorded Judgment  

[Transcript][Certified copy][Memorandum] of judgment recorded on {PR,"Insert date judgment was 
recorded here.",DT2,1} as Document No. {PR,"Insert Document number here.",ST1,2}, for judgment 
rendered on {PR,"Insert date of judgment here.",DT2,5}, in the {PR,"Insert name of court (circuit, 
appellate, etc.) here.",ST1,6} court of {PR,"Insert name of County here.",ST1,7} County, in favor of 
{PR,"Insert name(s) of winning person(s) here.",ST1,8} against {PR,"Insert name(s) of losing person(s) 
here.",ST1,9}, in the amount of {PR,"Insert amount of judgment here in dollars and cents.",CU1,10}.  

L.L.C.  

Series L.L.C.  

Terms, provisions, and limitations of the certificate of designation and Operating Agreement of 
{PR,"Name of series LLC",ST1,1}, a series of an Illinois limited liability company. The Articles of 
Organization and the Operating Agreement establishing the limited liability company of {PR,"name of 
master LLC",ST1,2}, an Illinois limited liability company, together with all amendments thereto, properly 
identified in writing by all of the members as being the terms and provisions of the articles and agreement 
under which the limited liability company acquired and holds title or held title should be furnished and 
this commitment is subject to such further exceptions, if any, as may then be deemed necessary. The 
certificate of designation and Operating Agreement establishing {PR,"name of seriesLLC",ST1,3}, 
should be furnished; and this Commitment is subject to such further exceptions, if any, as may then be 
deemed necessary. A Certificate of Good Standing for {PR,"name of master LLC",ST1,4}, issued by the 
Secretary of State, should be produced, and in default thereof, the final policy or policies will contain the 
following exception: "Consequences, if any, that may result by reason of the failure of the party in title to 
the estate or interest in the land described in Schedule A to comply with the applicable "doing business" 
laws of the State of Illinois." Upon a conveyance or mortgage of the land, a certified copy of the proper 
resolutions authorizing the execution or mortgage by {PR,"name of series LLC",ST1,5}, a series of an 
Illinois limited liability company, should be produced to ATG for examination, and this Commitment, 
and any Policies committed for thereunder, are subject to such further exceptions as may then be deemed 
necessary.  

General (Wisconsin) 

Terms, provisions, and limitations of the Articles of Organization and Operating Agreement for 
{PR,"Enter name of Limited Liability Company.",ST1,1}, a limited liability company.  

The Articles of Organization and the Operating Agreement establishing the limited liability company of 
{PR,"Enter name of Limited Liability Company.",ST1,1} together with all amendments thereto, properly 
identified in writing by all the members as being the terms and provisions of the articles and agreement 
under which the limited liability company acquired and holds title or held title, should be furnished and 
this commitment is subject to such further exceptions, if any, as may then be deemed necessary.  

A Certificate of Good Standing issued by the Department of Financial Institutions should be produced, 
and in default thereof, the final policy or policies will contain the following exception:  

"Consequences, if any, that may result by reason of the failure of the party in title to the estate or interest 
in the land described in Schedule A to comply with the applicable ‘doing business’ laws of the State of 
Wisconsin."  
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Upon a conveyance or mortgage of the land, a certified copy of the proper resolutions authorizing the 
execution of the deed or mortgage by {PR,"Enter the name of the Limited Liability Company.",ST1,1}, a 
Wisconsin limited liability company, should be produced to ATG for examination, and this commitment, 
and any policies committed for thereunder, are subject to such further exceptions as may then be deemed 
necessary.  

General (Illinois) 

Terms, provisions and limitations of the Articles of Organization and Operating Agreement for 
{PR,"name ofLLC",ST1,1}, an Illinois limited liability company.  

The Articles of Organization and the Operating Agreement establishing the limited liability company of 
{PR,"name of LLC",ST1,2}, together with all amendments thereto, properly identified in writing by all 
the members as being the terms and provisions of the articles and agreement under which the limited 
liability company acquired and holds title or held title, should be furnished; and this Commitment is 
subject to such further exceptions, if any, as may then be deemed necessary.  

A Certificate of Good Standing issued by the Secretary of State should be produced, and in default 
thereof, the final policy or policies will contain the following exception:  

"Consequences, if any, that may result by reason of the failure of the party in title to the estate or interest 
in the land described in Schedule A to comply with the applicable ‘doing business’ laws of the State of 
Illinois."  

Upon a conveyance or mortgage of the land, a certified copy of the proper resolutions authorizing the 
execution of the deed or mortgage by {PR,"name of LLC",ST1,3}, an Illinois limited liability company, 
should be produced to ATG for examination, and this commitment, and any policies committed fort 
hereunder, are subject to such further exceptions as may then be deemed necessary.  

Foreign L.L.C.  

The following exceptions will appear on all policies issued pursuant to this commitment except to the 
extent the same are cleared to ATG’s satisfaction.  

A certified copy of the Articles of Organization and the Operating Agreement, if any, of {PR,"Enter the 
Name of the Foreign L.L.C.",ST1,1} should be furnished for examination, and this commitment shall be 
subject to such further exceptions as may then be deemed necessary.  

Terms, provisions, and limitations of the Articles of Organization and the Operating Agreement of 
{RP,1}, a limited liability company of the state of {PR, "Enter the State where Foreign L.L.C. was 
formed",ST1,2}.  

Upon a conveyance or mortgage of the land, ATG must be furnished with a certified copy of proper 
resolutions, passed by the members and managers of the party in title, in conformity with the laws of the 
State of {RP,2}, authorizing the execution of the deed of conveyance or mortgage of the land; and  

The certificate of authority of {RP,1}, to do business in Illinois issued by the Secretary of State must be 
furnished to ATG for examination, and in default thereof, the final policy or policies will contain the 
following exception:  

"Consequences, if any, that may result by reason of the failure of the party in title to the estate or interest 
in the land described in Schedule A to comply with the applicable ‘doing business’ laws of the State of 
Illinois."  

LEASEHOLDS  

Unrecorded Easements, Covenants, etc.  

Subject to any unrecorded easements, covenants, conditions or restrictions, as well as any building line 
restrictions not of record.  

NOTE: This exception will be waived by either of the following: 
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(a) copy of an existing survey with an affidavit of no new improvements, which shall be submitted to 
ATG; or 

(b) Affidavit in Lieu of Survey, which shall be submitted to ATG. If neither is submitted to ATG, this 
exception will not be waived and will remain on the final title policy.  

Recorded Lease  

Memorandum of Lease dated {PR,"Insert date of lease agreement here.",DT2,1} and recorded 
{PR,"Insert date the lease agreement was recorded here.",DT2,2}, as Document {PR,"Insert Document 
number here.",ST1,5} by and between {PR,"Insert name(s) of Lessor.",ST1,6,}, Lessor and {PR,"Insert 
name(s) of Lessee here.",ST1,7},Lessee.  

Subordination of Lease  

Subordination Agreement dated {PR,"Insert date of subordination agreement here.",DT2,1} and recorded 
{PR,"Insert date the subordination agreement was recorded here.",DT2,2} as Document {PR,"Insert 
Document number here.",ST1,5}, made by {PR,"Insert name(s) of persons making agreement 
here.",ST1,6}, and given to {PR,"Insert name(s) of persons receiving agreement here.",ST1,7}.  

Unrecorded Leases  

Existing unrecorded leases and tenancies and all rights thereunder of the lessees and tenants and of any 
person claiming by, through, or under the lessees.  

LIBRARY  

MERS  

Mortgage Electronic Registration Systems, Inc., acting solely as nominee for  

LIEN/LIS PENDENS  

Minutes of Foreclosure - Mechanics’ Lien  

In order that we may insure title after completion of any proceeding brought to foreclose a mechanics’ 
lien in favor of *, we note the following and this commitment is subject to:  

a. Our policy when issued will be subject to direct attack upon the judgments and orders entered in the 
proceeding.  

b. Our policy, when issued, will be subject to any right or asserted right of a creditor, trustee, or debtor in 
possession in bankruptcy to avoid a transfer of title by sheriff’s deed or otherwise pursuant to Title 11 
U.S.C.(Bankruptcy) or any creditor’s rights law or state insolvency law.  

c. Upon the filing of the complaint, a proper Lis Pendens under Section 2-1901 of the Code of Civil 
Procedure must be recorded in the Recorder’s Office of * County, Illinois.  

d. The following persons are necessary parties to any such proceeding:  

(1) * (or successor in interest) as party plaintiff.  

(2) *, the record owner(s), as party/ies defendant. 

e. The following persons must be made parties defendant to the foreclosure if it is desired that their 
interests be barred by the proceeding:  

(1) All parties acquiring rights in the premises subsequent to the date of this commitment and 
prior to a recorded Lis Pendens.  

(2) Any person other than those herein named known to the Plaintiff or the Plaintiff’s attorney to 
have or claim an interest in the premises. 

(3) All persons in possession of any part of the premises in question and all persons whose rights 
would be disclosed by an inspection of the premises. 

(4) * by reason of exceptions *, inclusive.  
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(5) All persons in the chain of contracts between the plaintiff and the owner(s), and all persons 
who have or may assert liens under the Illinois Mechanics’ Lien Act (770 ILCS 60/0.01, et seq.) 
against the land.  

NOTE: If it is known that any of the parties listed herein are deceased, their heirs or devisees should be 
made parties by name, if known, and, if unknown, by the name and description of "UNKNOWNHEIRS 
OR DEVISEES OF" such deceased person or persons. If it is not known or cannot be ascertained whether 
any of said necessary parties be living or dead, then such parties should be made parties by name, and 
such persons as would be their heirs or devisees should also be made parties to the proceeding as 
"UNKNOWN OWNERS." In this connection, we direct your attention to Section2-413 of the Code of 
Civil Procedure.  

NOTE: In the event that there are any persons whose claims or interests are not disclosed by a document 
recorded at the time a proper lis pendens under Section 2-1901 of the Code of Civil Procedure has been 
recorded, such persons should be named and made parties under the description "UNKNOWN 
NECESSARY PARTIES." In this connection, we direct your attention to Section 2-413 of the Code of 
Civil Procedure.  

NOTE: In the event that there are any persons who are necessary parties to the contemplated proceeding, 
but the names of such persons are unknown and unascertainable, then, and in that event only, such 
persons should be made parties under the description of "UNKNOWN OWNERS," unless the contrary is 
herein indicated.  

NOTE: The proceeding will not affect the standard exceptions nor the exceptions noted in Schedule B at 
*, inclusive; and our policy, when issued, will be subject to such exceptions unless satisfactory 
disposition thereof is otherwise made.  

General Lien Exception  

Notice of {PR,"Liens: Enter the type of lien (e.g., ‘Illinois Income Tax’):",ST1,1} lien in favor of 
{PR,"Liens: Enter the entity who filed the lien:",ST1,3} and against {PR,"Liens: Enter the entity against 
whom the lien was filed:",ST1,2} in the sum of {PR,"Liens: Enter the amount of the lien:",CU1,4}, and 
recorded on {PR,"Liens: Enter the recording date of the lien:",DT2,5}, as Document Number {PR,"Liens: 
Enter the document number of the recorded lien:",ST1,6}.  

Mechanic’s Liens  

Mechanics’ lien filed by {PR,"Insert name of person or company filing the lien here.",ST1,1} against 
{PR,"Insert the person(s) against whom the lien was filed here.",ST1,2} on {PR,"Insert the date the lien 
was filed here.",DT2,3}, as Document No. {PR,"Insert the Document number here.",ST1,6} in the office 
of the Recorder of {PR,"Insert name of the county where the lien was recorded here.",ST1,7} County, 
Illinois, in the sum of {PR,"Insert the amount of the lien here.",CU1,8}.  

Proceedings Examination  

NOTE: No examination of these proceedings has been made, and upon examination, this commitment, 
and any policies committed for thereunder, shall be subject to such other and further exceptions as may 
then be deemed necessary.  

Proceedings: Lis Pendens  

Lis Pendens Notice dated {PR,"Insert date of lis pendens here.",DT2,1} filed by {PR,"Insert name of 
person(s) filing the lis pendens here.",ST1,2} against {PR,"Insert name(s) of persons receiving the lis 
pendens here.",ST1,3} in Case No. {PR,"Insert case number here.",ST1,4} in the Circuit Court of 
{PR,"Insert name of County here.",ST1,5} County, Illinois, and recorded on {PR,"Insert date of recording 
here.",DT2,6}, as Document No. {PR,"Insert Document number here.",ST1,9}.  

NOTE: No examination of these proceedings has been made, and upon examination, this commitment, 
and any policies committed for thereunder, shall be subject to such other and further exceptions as may 
then be deemed necessary.  
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General Lien Exception (Wisconsin) 

Notice of {PR,"Liens: Enter the type of lien (e.g., ‘Wisconsin Income Tax’):",ST1,1} lien in favor of 
{PR,"Liens: Enter the entity who filed the lien:",ST1,3} and against {PR,"Liens: Enter the entity against 
whom the lien was filed:",ST1,2} in the sum of {PR,"Liens: Enter the amount of the lien:",CU1,4}, and 
recorded on {PR,"Liens: Enter the recording date of the lien:",DT2,5}, as Document Number {PR,"Liens: 
Enter the document number of the recorded lien:",ST1,6}.  

Mechanics’ Liens (Wisconsin) 

Mechanics’ lien filed by {PR,"Insert name of person or company filing the lien here.",ST1,1} against 
{PR,"Insert the person(s) against whom the lien was filed here.",ST1,2} on {PR,"Insert the date the lien 
was filed here.",DT2,3}, as Document Number {PR,"Insert the Document number here.",ST1,6}, in the 
office of the Register of {PR,"Insert name of the county where the lien was recorded here.",ST1,7} 
County, Wisconsin, in the sum of {PR,"Insert the amount of the lien here.",CU1,8}.  

Building Code Violation  

Lis Pendens dated {PR,"Enter date of Lis Pendens notice:",DT2,1}, and recorded {PR,"Enter date Lis 
Pendens Notice was recorded:",DT2,2}, as Document Number {PR,"Enter document number of recorded 
Lis Pendens notice",ST1,3}, entitled {PR,"Enter Plaintiff’s name on Lis Pendens Notice:",ST1,4} v. 
{PR,"Enter Defendant’s name on Lis Pendens Notice:",ST1,5}, Case No. {PR,"Enter Case Number on 
Lis Pendens Notice:",ST1,6}, in the Circuit Court of {PR,"Enter County of pending court 
proceeding:",ST1,7}.  

Note: We have not made an examination of these proceedings, and this commitment, and any policies 
committed for thereunder, are subject to such further exceptions as may be deemed necessary.  

The fact, as evidenced by the notice recorded as Document Number {RP,3}, that a violation of any law, 
ordinance, or governmental regulation (including but not limited to building and zoning laws, ordinances, 
or regulations) restricting, regulating, prohibiting, or relating to (i) the occupancy, use, or enjoyment of 
the land; (ii) the character, dimensions, or location of any improvement now or hereafter erected on the 
land; (iii) a separation in ownership or a change in the dimensions or area of the land or any parcel of 
which the land is or was a part, has, or may have occurred.  

Proceedings: Lis Pendens (Wisconsin) 

Lis Pendens Notice, dated {PR,"Insert date of lis pendens here.",DT2,1}, filed by {PR,"Insert name of 
person(s) filing the lis pendens here.",ST1,2} against {PR,"Insert name(s) of persons receiving the lis 
pendens here.",ST1,3} in Case No. {PR,"Insert case number here.",ST1,4}, in the Circuit Court of 
{PR,"Insert name of County here.",ST1,5} County, Wisconsin, and recorded on {PR,"Insert date of 
recording here.",DT2,6}, as Document No. {PR,"Insert Document number here.",ST1,9}.  

NOTE: No examination of these proceedings has been made and, upon examination, this commitment, 
and any policies committed for thereunder, shall be subject to such other and further exceptions as may 
then be deemed necessary.  

METRO EAST OFFICE 

Subdivision Restriction, Building Line, Easement 

Restriction contained, dated*, and recorded* as Document No. *. 

A * foot building line, running along the * line of said lot, as shown in the Plat of Subdivision. 

A * foot easement, running along the * line of said lot, as shown in the Plat of Subdivision. 

Exceptions for Construction Loan Policy  

Rights or claims of parties in possession not shown by the public records.  

Encroachments, overlaps, boundary line disputes, and any matters that would be disclosed by an accurate 
survey and inspection of the premises. Easements, or claims of easements, not shown by the public 
records. Taxes or special assessments that are not shown as existing liens by the public records.  
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Deed of Conveyance  

Execution of deed of conveyance from {PR,"Name of Grantor",ST1,1} to {PR,"Name of 
Grantee",ST1,2},  

MINOR’S ESTATES  

General (Wisconsin) 

Proceedings pending in the Circuit Court of {PR,"Enter name of County.",ST1,1} County entitled Estate 
of {PR,"Enter name of minor.",ST1,2}, a minor, under Case No. {PR,"Enter minor’s case 
number.",ST1,3}.  

Any conveyance of the land must be made by the guardian of the Estate of {PR,"Enter name of 
minor.",ST1,1}, a minor, pursuant to a proper order entered in Case No. {PR,"Enter minor’s case 
number.",ST1,2} and such conveyance should recite that the same is executed pursuant to a proper order 
entered in Case No. {RP,2}, ordering the conveyance and should recite therein the full consideration for 
which it is given. In addition, the guardian should file any bond required by the court under Section 
880.13 of the Wisconsin statutes.  

Statutory right, powers, and duties of the guardian of the Estate of {PR,"Enter name of minor.",ST1,1}, a 
minor.  

General  

Proceedings pending in the Circuit Court of {PR,"Enter name of County.",ST1,1} County entitled Estate 
of {PR,"Enter name of minor.",ST1,2}, a minor, under Case No. {PR,"Enter minor’s case 
number.",ST1,3}.  

Any conveyance of the land must be made by the guardian of the Estate of {PR,"Enter name of 
minor.",ST1,1}, a minor, pursuant to a proper order entered in Case No. {PR,"Enter minor’s case 
number.",ST1,2} and such conveyance should recite that the same is executed pursuant to a proper order 
entered in Case No. {RP,2} ordering the conveyance and should recite therein the full consideration for 
which it is given. In addition, the guardian should file the bond required by the Probate Act.  

Statutory right, powers, and duties of the guardian of the Estate of {PR,"Enter name of minor.",ST1,1}, a 
minor.  

MISCELLANEOUS  

1099  

Pursuant to the Tax Reform Act of 1986; Title 1, Subtitle C; Section 1521 requires the Settlement Agent 
to report real estate transactions. Relative thereto, we note the following and require: 

A. We must be furnished at closing with the tax identification of the recipients of any or all of the net 
proceeds of the transaction.  

B. Failure to comply will result in a 20 percent holdback to be deposited with the Internal Revenue 
Service pursuant to the aforesaid act.  

Cover Date  

This commitment should be updated to cover the recording date of the {PR,"Enter name of the recorded 
document",ST1,1}, and this commitment is subject to such further exceptions as may then be deemed 
necessary. 

Break in Chain of Title  

{PR,"Enter name of recipient of wild deed.",ST1,1} obtained title by mesne (intervening) conveyances 
from {PR,"Enter name of grantor in wild deed.",ST1,2}. We find no title in {RP,2}. This should be 
explained, and this commitment, and any policies committed for thereunder, shall be subject to such 
further exceptions as may then be deemed necessary.  
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Policy: Duplicate Policy  

This duplicate policy is issued to replace Policy No. {PR,"Insert lost or destroyed policy 
numberhere.",ST1,1}, that was lost or destroyed. It is understood that this duplicate policy evidences the 
liability of Attorneys’ Title Guaranty Fund, Inc., under its original policy and that such liability is not 
increased nor diminished by reason of issuance of this duplicate policy.  

Schedule B Part II  

SCHEDULE B, PART II  

In addition to the matters set forth in Part I of this schedule, the title to the estate or interest described or 
referred to in Schedule A is subject to the following matters, but ATG insures that such matters are 
subordinate to the lien or charge of the mortgage upon said estate or interest:  

Mortgage dated {PR,"Enter date of mortgage.",DT2,7}, and recorded {PR,"Enter mortgage recording 
date.",DT2,7}, as Document No. {PR,"Enter recorded mortgage document number.",ST1,6}, executed by 
{PR,"What are the borrowers name(s)?",ST1,6} and given to {PR,"Enter name of existing 
lender.",ST1,5} to secure a note in the amount of {PR,"Enter existing mortgage amount.",CU1,7}, and 
such other sums as provided therein.  

Agent Fee  

Effective September 1, 2003, and pursuant to the Amendment to the Title Insurance Act, a Fee of $3.00 
will be added to each policy issued and listed on the HUD-1 as an Illinois Title Insurance Agent 
Registration Fee.  

Section 3607 USC  

(but omitting any such covenant or restriction based on race, color, religion, sex, handicap, familial status 
or national origin unless and only to the extent that said covenant (A) is exempt under Chapter 42, Section 
3607 of the United States Code or (B) relates to handicap but does not discriminate against handicapped 
persons)  

Spouse  

Rights and interest of the spouse, if any, of title holder or person(s) taking title named in Schedule A. 
Note: The present marital status of the grantors herein named must be disclosed in any subsequent deed of 
conveyance and/or mortgage ATG is asked to insure, and their spouses, if any, must join in the execution 
of said instruments in order to release any homestead rights.  

Policy Tax  

Pursuant to the Illinois Title Insurance Act (215 ILCS 155/1, et seq.), a fee of $3.00 is imposed for each 
policy issued by a title insurance agent. This fee will be charged to the party or parties ordering the title 
insurance policy or policies.  

Forgery  

Right, title, and interest of {PR,"Name of Grantor(s) in deed less than 12 months old",ST1,1}, purported 
grantor in the deed recorded {PR,"Date deed was recorded",DT2,2}, as Document No. {PR,"Document 
No. of deed",ST1,3}.  

Note: This exception may be waived only with approval from an ATG staff attorney  

MOBILE HOME  

Mobile Home: Commitment  

ATG must be provided with the following information in order to ascertain if a mobile home or any other 
component housing unit is an integral part of the land:  

(a) Whether ownership of both the mobile home or component housing unit and the land are in 
the same person;  
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(b) Whether there is an intention to dedicate the mobile home or component housing unit for the 
exclusive purpose of a permanently located dwelling area;  

(c) Whether the motor vehicle registration of the mobile home or component housing unit has 
been properly cancelled;  

(d) Whether the mobile home or component housing unit is being taxed in conjunction with the 
land as a single parcel of real property;  

(e) Whether the permanent affixation of the mobile home or component housing unit to the land 
has been fully effected. This affixation entails, among other factors, the following actions:  

(1) removal of axles and wheels from the mobile home or component housing unit; 

(2) setting of the mobile home or component housing unit upon a permanent foundation; 

(3) connection of the mobile home or component housing unit to a sewer system and 
public utilities; 

(4) compliance with any other statutory requirements.  

(f) Whether any lien, security interest, or encumbrance affecting the mobile home or component 
housing unit and shown in the title registration, bill of sale, or certificate of sale, has been 
properly cancelled;  

(g) A U.C.C. Financing Statement search;  

(h) The effect of applicable U.C.C. state law in regard to an out-of-state purchase of a mobile 
home or component housing unit.  

MORTGAGE  

Assignment of Mortgage  

Assignment of Mortgage from {PR,"Enter name of original lender",ST1,1} to {PR,"Enter name of lender 
receiving assignment.",ST1,2} dated {PR,"Enter the date of the assignment",DT2,5}, and recorded 
{PR,"Enter recording date of assignment",DT2,5}, as Document No. {PR,"Enter Document number of 
Assignment.",ST1,3}, which assigns the Mortgage recorded as Document No. {PR,"Enter Document No 
of assigned Mortgage",ST1,4}.  

Assignment of Rents  

Assignment of Rents dated {PR,"Enter date of Assignment of Rents.",DT2,1} and recorded {PR,"Enter 
date Assignment of Rents was recorded.",DT2,2} as Document No. {PR,"Enter recorded Document 
number of Assignment of Rents.",ST1,5} executed by {PR,"Enter name(s) of person granting the 
Assignment of Rents.",ST1,6} and given to {PR,"Enter name of lender receiving the Assignment of 
Rents.",ST1,7}.  

Financing Statement  

Financing Statement (UCC-1) dated {PR,"Enter date of UCC statement.",DT2,1}, and recorded 
{PR,"Enter date the UCC statement was recorded.",DT2,2}, as Document No. {PR,"Enter recorded 
Document number of the UCC statement.",ST1,3}, made by {PR,"Enter name(s) of person giving the 
UCCstatement.",ST1,6}, as Debtor, and given to {PR,"Enter name(s) of lender/entity receiving the 
UCCstatement.",ST1,7}, as Secured Party.  

Mortgage Signing  

All parties in title or taking title must execute the mortgage that ATG is being asked to insure. If any party 
in title does not execute said mortgage, lender will take subject to the outstanding ownership interest of 
said non-executing party.  
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Subordination Agreement  

Subordination Agreement dated {PR,"Enter date of Subordination Agreement.",DT2,1}, and recorded 
{PR,"Enter date the Subordination Agreement was recorded.",DT2,2}, as Document No. {PR,"Enter 
recorded Document number of agreement.",ST1,5}, made by {PR,"Enter name(s) of person/entity giving 
theSubordination.",ST1,6} and given to {PR,"Enter the name(s) of person/entity receiving 
Subordination.",ST1,7}, which subordinates the Mortgage recorded as Document No.{PR,"Doc No for 
affected Mtg",ST1,6}.  

Trust Deed  

Trust Deed dated {PR,"Enter date of Trust Deed.",DT2,1}, and recorded {PR,"Enter date the Trust Deed 
was recorded.",DT2,2}, as Document No. {PR,"Enter recorded Document number.",ST1,5} executed by 
{PR,"Enter name(s) of person granting the Trust Deed.",ST1,6} and given to {PR,"Enter the name(s) of 
the lender receiving the Trust Deed.",ST1,7} to secure a note in the amount of {PR,"Enter the dollar 
amount of the Trust Deed.",CU1,8}, and such other sums as provided therein.  

Mortgage (WFAC)  

Mortgage (with future advance clause), dated {PR,"Date of Mortgage",DT2,1} and recorded {PR,"Date 
ofRecording",DT2,2}, as Document No. {PR,"Recorded Document No.",ST1,3}, executed by 
{PR,"Names ofMortgagors",ST1,4}, and given to {PR,"Name of Mortgagee",ST1,5}, to secure a note in 
the amount of {PR,"Amount of Mortgage",CU1,6}, and such other sums as provided therein.  

Titleholder’s Mortgage  

Mortgage dated {PR,"Enter Date of Mortgage",DT2,1}, and recorded {PR,"Enter date mortgage was 
recorded",DT2,2}, as Document No. {PR,"Enter Document No. of mortgage",ST1,3}, executed by 
{DB,CommitPolicy,CurrentHolders,NO}, and given to {PR,"Enter Name of mortgagee",ST1,5}, to 
secure a note in the amount of {PR,"Enter amount of mortgage",CU1,6}, and such other sums as provided 
therein.  

Existing Mortgage  

Mortgage dated {PR,"Enter Date of Mortgage",DT2,1}, and recorded {PR,"Enter date mortgage was 
recorded",DT2,2}, as Document No. {PR,"Enter Document No. of mortgage",ST1,3}, executed by 
{PR,"Enter name(s) of Mortgagor(s)",ST1,4}, and given to {PR,"Enter Name of mortgagee",ST1,5}, to 
secure a note in the amount of {PR,"Enter amount of mortgage",CU1,6}, and such other sums as provided 
therein.  

New Mortgage  

Mortgage dated {PR,"Date of Mortgage",DT2,1}, and recorded {PR,"Date of Recording",DT2,2}, as 
Document No. {PR,"Document Number",ST1,3}, executed by {DB,CommitPolicy,MortBorrower,NO}, 
and given to {DB,CommitPolicy,MortInsured,NO}, to secure a note in the amount of 
{DB,Main,LoanAmount,CU1}, and such other sums as provided therein.  

Revolving Line of Credit  

Revolving Line of Credit Mortgage dated {PR,"Enter Date of Mortgage",DT2,1}, and recorded 
{PR,"Enter date mortgage was recorded",DT2,2}, as Document No. {PR,"Enter Document No. of 
mortgage",ST1,3}, executed by {PR,"Enter name(s) of Mortgagor(s)",ST1,4}, and given to {PR,"Enter 
Name of mortgagee",ST1,5}, to secure a note in the amount of {PR,"Enter amount of mortgage",CU1,6}, 
and such other sums as provided therein.  

Modification or Extension Agreement  

Subject to a Modification and Extension of Mortgage Agreement dated {PR,"Enter date of Modification 
or Extension Agreement",DT2,1}, and recorded on {PR,"Enter date Modification or Extension 
Recorded",DT2,2}, as Document No. {PR,"Type Document Number",ST1,3}. Said Agreement modifies 
and/or extends the mortgage dated {PR,"Enter date of Original Mortgage",DT2,8}, and recorded 
{PR,"Enter Recording date of OriginalMortgage",DT2,5}, as Document No. {PR,"Type Document 
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Number of Original Mortgage",ST1,6}, from {PR,"TypeMortgagor(s)",ST1,7} to {PR,"Type 
Mortgagee",ST1,8}.  

New Second Mortgage  

Mortgage dated {PR,"Date of Mortgage",DT2,3}, and recorded {PR,"Date Mortgage was 
recorded",DT2,3}, as Document No. {PR,"Document number",ST1,3}, executed by 
{DB,CommitPolicy,MortBorrower,NO}, and given to {DB,CommitPolicy,MortInsured2,NO}, to secure 
a note in the amount of {DB,Main,LoanAmount2,CU1}, and other such sums as provided therein.  

MERS (Champaign)  

Mortgage Electronic Registration Systems, Inc., acting solely as nominee for MORTGAGE EXCEPT  

Modification  

Modification of Mortgage dated {PR,"Dated",DT2,2} and recorded {PR,"recorded date",DT2,2} as 
Document No. {PR,"document number",ST1,3}, between {PR,"Morgagee",ST1,4} and 
{PR,"Bank",ST1,5}, relating to Mortgage Document No. {PR,"Mortgage Document Number",ST1,6}.  

MUNICIPALITIES  

Addison  

The Recording of any Deed or other instrument of conveyance of the land is subject to real estate transfer 
tax levied by THE CITY OF ADDISON. As of the date of this commitment, Addison tax rate is $2.50 per 
$1,000.00, payable by the Buyer before closing. All Deeds presented to ATG for recording must have the 
appropriate transfer tax stamps affixed thereto, or be marked "EXEMPT" by the Municipality, together 
with the applicable transfer declaration or exemption form.  

Note: If Property is exempt from stamps, a $25.00 exemption fee is required.  

Aurora  

The Recording of any Deed or other instrument of conveyance of the land is subject to real estate transfer 
tax levied by THE CITY OF AURORA. As of the date of this commitment, Aurora tax rate is $3.00 per 
$1,000.00, payable by the Seller before closing. All Deeds presented to ATG for recording must have the 
appropriate transfer tax stamps affixed thereto, or be marked "EXEMPT" by the Municipality, together 
with the applicable transfer declaration or exemption form.  

Note: If Property is exempt from stamps, a $25.00 exemption fee is required.  

Bartlett  

The Recording of any Deed or other instrument of conveyance of the land is subject to real estate transfer 
tax levied by the VILLAGE OF BARTLETT. As of the date of this commitment, Bartlett tax rate is $3.00 
per $1,000.00, payable by the Seller before closing. All Deeds presented to ATG for recording must have 
the appropriate transfer tax stamps affixed thereto, or be marked "EXEMPT" by the Municipality, 
together with the applicable transfer declaration or exemption form. The town of Bartlett requires the 
water bill be paid prior to closing.  

Bensenville  

The town of Bensenville requires a property inspection prior to closing.  

Berwyn  

The Recording of any Deed or other instrument of conveyance of the land is subject to real estate transfer 
tax levied by the TOWN OF BERWYN. As of the date of this commitment, Berwyn tax rate is $10.00 per 
$1,000.00, payable by the Seller before closing. All Deeds presented to ATG for recording must have the 
appropriate transfer tax stamps affixed thereto, or be marked "EXEMPT" by the Municipality, together 
with the applicable transfer declaration or exemption form. The town of Berwyn also requires a 
Certificate of Occupancy and requires the water bill be paid prior to closing.  

Note: If Property is exempt from stamps, a $25.00 exemption fee is required.  
 
Page 14-38 ATG REsource® User Manual 
 © ATG (5/15) 



Bolingbrook  

The Recording of any Deed or other instrument of conveyance of the land is subject to real estate transfer 
tax levied by the VILLAGE OF BOLINGBROOK. As of the date of this commitment, Bolingbrook tax 
rate is $3.75 per $1,000.00, payable by the Buyer and Seller before closing. All Deeds presented to ATG 
for recording must have the appropriate transfer tax stamps affixed thereto, or be marked "EXEMPT" by 
the Municipality, together with the applicable transfer declaration or exemption form.  

Note: If Property is exempt from stamps, a $25.00 exemption fee is required.  

Buffalo Grove  

The Recording of any Deed or other instrument of conveyance of the land is subject to real estate transfer 
tax levied by the VILLAGE OF BUFFALO GROVE. As of the date of this commitment, Buffalo Grove 
tax rate is $3.00 per $1,000.00 payable by the Seller before closing. All Deeds presented to ATG for 
recording must have the appropriate transfer tax stamps affixed thereto, or be marked "EXEMPT" by the 
Municipality, together with the applicable transfer declaration or exemption form.  

Note: If Property is exempt from stamps, a $25.00 exemption fee is required.  

Carol Stream  

The Recording of any Deed or other instrument of conveyance of the land is subject to real estate transfer 
tax levied by the VILLAGE OF CAROL STREAM. As of the date of this commitment, Carol Stream tax 
rate is $3.00 per $1,000.00, payable by the Seller before closing. All Deeds presented to ATG for 
recording must have the appropriate transfer tax stamps affixed thereto, or be marked "EXEMPT" by the 
Municipality, together with the applicable transfer declaration or exemption form.  

Cicero  

The Recording of any Deed or other instrument of conveyance of the land is subject to real estate transfer 
tax levied by the VILLAGE OF CICERO. As of the date of this commitment, Cicero tax rate is $10.00 
per $1,000.00, payable by the Seller before closing. All Deeds presented to ATG for recording must have 
the appropriate transfer tax stamps affixed thereto, or be marked "EXEMPT" by the Municipality, 
together with the applicable transfer declaration or exemption form. The town of Cicero requires the 
water bill be paid prior to closing.  

NOTE: If property is exempt from stamps, a $25.00 exemption fee is required.  

Des Plaines  

The Recording of any Deed or other instrument of conveyance of the land is subject to real estate transfer 
tax levied by the VILLAGE OF DES PLAINES. As of the date of this commitment, Des Plaines tax rate 
is $2.00 per $1,000.00, payable by the Seller before closing. All Deeds presented to ATG for recording 
must have the appropriate transfer tax stamps affixed thereto, or be marked "EXEMPT" by the 
Municipality, together with the applicable transfer declaration or exemption form.  

Elgin  

No fee due City of Elgin. All money due City of Elgin must be paid in full before issuance of Elgin 
Transfer Stamps.  

Elk Grove  

The Recording of any Deed or other instrument of conveyance of the land is subject to real estate transfer 
tax levied by the VILLAGE OF ELK GROVE. As of the date of this commitment, Elk Grove tax rate is 
$3.00 per $1,000.00, payable by the Seller before closing. All Deeds presented to ATG for recording must 
have the appropriate transfer tax stamps affixed thereto, or be marked "EXEMPT" by the Municipality, 
together with the applicable transfer declaration or exemption form. NOTE: If Property is exempt from 
stamps, a $25.00 exemption fee is required.  
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Elmhurst  

The Recording of any Deed or other instrument of conveyance of the land is subject to real estate transfer 
tax levied by the CITY OF ELMHURST. As of the date of this commitment, Elmhurst tax rate is $1.50 
per $1,000.00, payable by the Seller before closing. All Deeds presented to ATG for recording must have 
the appropriate transfer tax stamps affixed thereto, or be marked "EXEMPT" by the Municipality, 
together with the applicable transfer declaration or exemption form.  

Elmwood Park  

The Recording of any Deed or other instrument of conveyance of the land is subject to real estate transfer 
tax levied by the VILLAGE OF ELMWOOD PARK. As of the date of this commitment, Elmwood Park 
tax rate is $5.00 per $1,000.00, payable by the Seller before closing. All Deeds presented to ATG for 
recording must have the appropriate transfer tax stamps affixed thereto, or be marked "EXEMPT" by the 
Municipality, together with the applicable transfer declaration or exemption form.  

NOTE: If Property is exempt from stamps, a $25.00 exemption fee is required.  

Elmwood Park also requires a property inspection prior to closing.  

Glen Ellyn  

The Recording of any Deed or other instrument of conveyance of the land is subject to real estate transfer 
tax levied by the VILLAGE GLEN ELLYN. As of the date of this commitment, Glen Ellyn tax rate is 
$3.00 per $1,000.00, payable by the Seller before closing. All Deeds presented to ATG for recording must 
have the appropriate transfer tax stamps affixed thereto, or be marked "EXEMPT" by the Municipality, 
together with the applicable transfer declaration or exemption form.  

NOTE: If Property is exempt from stamps, a $25.00 exemption fee is required.  

Evanston  

The Recording of any Deed or other instrument of conveyance of the land is subject to real estate transfer 
tax levied by the VILLAGE OF EVANSTON. As of the date of this commitment, Evanston tax rate is 
$5.00 per $1,000.00, payable by the Seller before closing. All Deeds presented to ATG for recording must 
have the appropriate transfer tax stamps affixed thereto, or be marked "EXEMPT" by the Municipality, 
together with the applicable transfer declaration or exemption form.  

NOTE: If Property is exempt from stamps, a $25.00 exemption fee is required.  

Franklin Park  

The Recording of any Deed or other instrument of conveyance of the land is subject to real estate transfer 
tax levied by the TOWN OF FRANKLIN PARK. As of the date of this commitment, Franklin Park is 
$25.00 or more, depending on type of property, payable by the seller.  

NOTE: If property is exempt from stamps, a $25.00 exemption fee is required.  

Hanover Park  

The Recording of any Deed or other instrument of conveyance of the land is subject to real estate transfer 
tax levied by the VILLAGE OF HANOVER PARK. As of the date of this commitment, Hanover Park tax 
rate is $3.00 per $1,000.00, payable by the Seller before closing. All Deeds presented to ATG for 
recording must have the appropriate transfer tax stamps affixed thereto, or be marked "EXEMPT" by the 
Municipality, together with the applicable transfer declaration or exemption form.  

NOTE: If Property is exempt from stamps, a $25.00 exemption fee is required.  

Harwood Heights  

The Recording of any Deed or other instrument of conveyance of the land is subject to real estate transfer 
tax levied by the VILLAGE OF HARWOOD HEIGHTS. As of the date of this commitment, Harwood 
Heights’ tax rate is $10.00 per $1,000.00, payable by the Buyer before closing. All Deeds presented to 
ATG for recording must have the appropriate transfer tax stamps affixed thereto, or be marked 
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"EXEMPT" by the Municipality, together with the applicable transfer declaration or exemption form. The 
Village of Harwood Heights also requires a property inspection prior to closing.  

NOTE: If Property is exempt from stamps, a $25.00 exemption fee is required.  

Hoffman Estates  

The Recording of any Deed or other instrument of conveyance of the land is subject to real estate transfer 
tax levied by the VILLAGE OF HOFFMAN ESTATES. As of the date of this commitment, Hoffman 
Estates tax rate is $3.00 per $1,000.00 payable by the Seller before closing. All Deeds presented to ATG 
for recording must have the appropriate transfer tax stamps affixed thereto, or be marked "EXEMPT" by 
the Municipality, together with the applicable transfer declaration or exemption form.  

NOTE: If Property is exempt from stamps, a $10.00 exemption fee is required.  

Joliet  

The Recording of any Deed or other instrument of conveyance of the land is subject to real estate transfer 
tax levied by THE CITY OF JOLIET. As of the date of this commitment, Joliet tax rate is $3.00 per 
$1,000.00, payable by the Seller before closing. All Deeds presented to ATG for recording must have the 
appropriate transfer tax stamps affixed thereto, or be marked "EXEMPT" by the Municipality, together 
with the applicable transfer declaration or exemption form.  

Note: If Property is exempt from stamps, a $25.00 exemption fee is required.  

Maywood  

The Recording of any Deed or other instrument of conveyance of the land is subject to real estate transfer 
tax levied by the VILLAGE OF MAYWOOD. As of the date of this commitment, Maywood tax rate is 
$4.00 per $1,000.00, payable by the Seller before closing. All Deeds presented to ATG for recording must 
have the appropriate transfer tax stamps affixed thereto, or be marked "EXEMPT" by the Municipality, 
together with the applicable transfer declaration or exemption form.  

Morton Grove  

The Recording of any Deed or other instrument of conveyance of the land is subject to real estate transfer 
tax levied by the VILLAGE OF MORTON GROVE. As of the date of this commitment, Morton Grove 
tax rate is $3.00 per $1,000.00, payable by the Seller before closing. All Deeds presented to ATG for 
recording must have the appropriate transfer tax stamps affixed thereto, or be marked "EXEMPT" by the 
Municipality, together with the applicable transfer declaration or exemption form.  

Mount Prospect  

The Recording of any Deed or other instrument of conveyance of the land is subject to real estate transfer 
tax levied by the VILLAGE OF MOUNT PROSPECT. As of the date of this commitment, Mount 
Prospect tax rate is $3.00 per $1,000.00, payable by the Buyer before closing. All Deeds presented to 
ATG for recording must have the appropriate transfer tax stamps affixed thereto, or be marked 
"EXEMPT" by the Municipality, together with the applicable transfer declaration or exemption form.  

The City of Mount Prospect also requires any outstanding water bills to be paid prior to closing.  

Naperville  

The Recording of any Deed or other instrument of conveyance of the land is subject to real estate transfer 
tax levied by the CITY OF NAPERVILLE. As of the date of this commitment, Naperville tax rate is 
$3.00 per $1,000.00, payable by the Buyer before closing. All Deeds presented to ATG for recording 
must have the appropriate transfer tax stamps affixed thereto, or be marked "EXEMPT" by the 
Municipality, together with the applicable transfer declaration or exemption form.  

NOTE: If property is exempt from stamps, a $25.00 exemption fee is required.  
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Niles  

The Recording of any Deed or other instrument of conveyance of the land is subject to real estate transfer 
tax levied by the VILLAGE OF NILES. As of the date of this commitment, Niles tax rate is $3.00 per 
$1,000.00, payable by the Buyer before closing. All Deeds presented to ATG for recording must have the 
appropriate transfer tax stamps affixed thereto, or be marked "EXEMPT" by the Municipality, together 
with the applicable transfer declaration or exemption form. The village of Niles also requires a Certificate 
of Occupancy prior to closing.  

NOTE: If property is exempt from stamps, a $25.00 exemption fee is required.  

Oak Park  

The Recording of any Deed or other instrument of conveyance of the land is subject to real estate transfer 
tax levied by the VILLAGE OF OAK PARK. As of the date of this commitment, Oak Park tax rate is 
$8.00 per $1,000.00, payable by the Seller before closing. All Deeds presented to ATG for recording must 
have the appropriate transfer tax stamps affixed thereto, or be marked "EXEMPT" by the Municipality, 
together with the applicable transfer declaration or exemption form.  

NOTE: If property is exempt from stamps, a $25.00 exemption fee is required.  

Park Ridge  

The Recording of any Deed or other instrument of conveyance of the land is subject to real estate transfer 
tax levied by the City of Park Ridge. As of the date of this commitment, Park Ridge transfer tax is $2.00 
per $1,000.00, payable by the Seller before closing. The declaration form should be submitted at least five 
(5) business days before closing. The City of Park Ridge also requires a property inspection prior to 
closing.  

River Forest  

The Recording of any Deed or other instrument of conveyance of the land is subject to real estate transfer 
tax levied by the VILLAGE OF RIVER FOREST. As of the date of this commitment, River Forest tax 
rate is $.50 per $1,000.00, payable by the Seller before closing. All Deeds presented to ATG for recording 
must have the appropriate transfer tax stamps affixed thereto, or be marked "EXEMPT" by the 
Municipality, together with the applicable transfer declaration or exemption form. River Forest also 
requires a property inspection prior to closing.  

River Grove  

The Recording of any Deed or other instrument of conveyance of the land is subject to real estate transfer 
tax levied by the VILLAGE OF RIVER GROVE. As of the date of this commitment, River Grove tax 
rate is $50.00, payable by the Seller before closing.  

The Village of River Grove requires mandatory inspection and review of the original deed or document of 
transfer regarding property located within the Village. In addition, the Village of River Grove mandates 
that all title reports reflect the requirement of obtaining a transfer stamp on the original deed or document 
of transfer. Section 5 of the ordinance states, "Any person, firm or corporation convicted of participating 
in a sale or transfer of real estate in violation of this ordinance shall be fined not less than $500.00 for 
each offense."  

Rolling Meadows  

The Recording of any Deed or other instrument of conveyance of the land is subject to real estate transfer 
tax levied by the TOWN OF ROLLING MEADOWS. As of the date of this commitment, Rolling 
Meadows tax rate is $3.00 per $1,000.00, payable by the Seller before closing. All Deeds presented to 
ATG for recording must have the appropriate transfer tax stamps affixed thereto, or be marked 
"EXEMPT" by the Municipality, together with the applicable transfer declaration or exemption form.  

NOTE: If property is exempt from stamps, a $25.00 exemption fee is required.  
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Romeoville  

The Recording of any Deed or other instrument of conveyance of the land is subject to real estate transfer 
tax levied by THE CITY OF ROMEOVILLE. As of the date of this commitment, Romeoville tax rate is 
$3.50 per $1,000.00, payable by the Buyer before closing. All Deeds presented to ATGATG for recording 
must have the appropriate transfer tax stamps affixed thereto, or be marked "EXEMPT" by the 
Municipality, together with the applicable transfer declaration or exemption form.  

Note: If Property is exempt from stamps, a $25.00 exemption fee is required.  

Schaumburg  

The Recording of any Deed or other instrument of conveyance of the land is subject to real estate transfer 
tax levied by the VILLAGE OF SCHAUMBURG. As of the date of this commitment, Schaumburg tax 
rate is $1.00per $1,000.00 payable by the Seller before closing. All Deeds presented to ATG for recording 
must have the appropriate transfer tax stamps affixed thereto, or be marked "EXEMPT" by the 
Municipality, together with the applicable transfer declaration or exemption form.  

NOTE: If property is exempt from stamps, a $25.00 exemption fee is required.  

Skokie  

The Recording of any Deed or other instrument of conveyance of the land is subject to real estate transfer 
tax levied by the TOWN OF SKOKIE. As of the date of this commitment, Skokie tax rate is $3.00 per 
$1,000.00, payable by the Seller before closing. All Deeds presented to ATG for recording must have the 
appropriate transfer tax stamps affixed thereto, or be marked "EXEMPT" by the Municipality, together 
with the applicable transfer declaration or exemption form.  

NOTE: If property is exempt from stamps, a $25.00 exemption fee is required.  

Stone Park  

By Stone Park Municipal Ordinance, a transfer tax has been imposed upon the sale of real property 
located within the municipality; therefore, all deeds presented to this company for recording must have 
the appropriate transfer tax stamps affixed thereto, or be marked "exempt" by the municipality, together 
with the applicable Transfer Declaration or Exemption form.  

NOTE: The Stone Park Transfer Tax rate is $2.00 per $500.00.  

Streamwood  

The Recording of any Deed or other instrument of conveyance of the land is subject to real estate transfer 
tax levied by the VILLAGE OF STREAMWOOD. As of the date of this commitment, Streamwood tax 
rate is $3.00 per $1,000.00, payable by the Seller before closing. All Deeds presented to ATG for 
recording must have the appropriate transfer tax stamps affixed thereto, or be marked "EXEMPT" by the 
Municipality, together with the applicable transfer declaration or exemption form.  

NOTE: If property is exempt from stamps, a $25.00 exemption fee is required.  

Wheaton: General  

Note for Information: The land described in Schedule A lies within the corporate limits of the City of 
Wheaton. The land is subject to real estate transfer tax of $2.50 per $1,000.00 of consideration. The 
transfer tax is the responsibility of the Buyer according to ordinance and should be affixed to the deed 
prior to closing.  

Note for Information: Pursuant to City of Wheaton Ordinance 193, the Seller must pay the water bill 
current to closing in order for Purchaser to obtain the City of Wheaton transfer tax stamp.  

Wheaton Tax  

The Recording of any Deed or other instrument of conveyance of the land is subject to real estate transfer 
tax levied by THE CITY OF WHEATON. As of the date of this commitment, Wheaton tax rate is $2.50 
per $1,000.00, payable by the Buyer before closing. All Deeds presented to ATG for recording must have 
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the appropriate transfer tax stamps affixed thereto, or be marked "EXEMPT" by the Municipality, 
together with the applicable transfer declaration or exemption form.  

Note: If Property is exempt from stamps, a $25.00 exemption fee is required.  

Wheeling Transfer Certificate  

Compliance must be made with Section 15.38 of the Wheeling Municipal Code regarding the issuance of 
a Real Estate Transfer Certificate prior to the recording of a Deed of Conveyance.  

Woodridge  

The Recording of any Deed or other instrument of conveyance of the land is subject to real estate transfer 
tax levied by the VILLAGE OF WOODRIDGE. As of the date of this commitment, Woodridge tax rate is 
$2.50 per $1,000.00, payable by the Seller before closing. All Deeds presented to ATG for recording must 
have the appropriate transfer tax stamps affixed thereto, or be marked "EXEMPT" by the Municipality, 
together with the applicable transfer declaration or exemption form.  

NOTE: If property is exempt from stamps, a $25.00 exemption fee is required.  

Note: If Property is exempt from stamps, a $25.00 exemption fee is required.  

MUNICIPALITY  

Chicago: Water and Zoning  

By ordinance of the City of Chicago, the recording or filing of any deed or other instrument of 
conveyance is subject to prior water and zoning certification. Relative thereto, all deeds submitted to 
ATG for recording must be accompanied by the appropriate transfer tax and declaration.  

Chicago: Building Registration  

Pursuant to Chapter 13.10 of the Municipal Code of Chicago, if the building on the land contains four or 
more residential units, a Certificate of Registration, or a receipt from the Department of Buildings, 
showing that the building being transferred has been registered with the City of Chicago, must be attached 
to the transfer tax declaration.  

Inspection  

By ordinance of the City/Village of {DB,Property,City,NO}, the recording or filing of any deed or other 
instrument of conveyance is subject to prior approval by an appropriate officer of the municipality for 
property within the municipality limits. Relative thereto, all deeds submitted to ATG for recording must 
be accompanied by the appropriate certification or exemption.  

Tax  

By ordinance of the City/Village of {DB,Property,City,NO}, the recording or filing of any deed or other 
instrument of conveyance is subject to real estate transfer taxes imposed by the municipality for property 
located within the municipality imposed. Relative thereto, all deeds submitted to ATG for recording must 
be accompanied by the appropriate transfer tax and declaration.  

Transfer Tax Exemption  

Any instrument conveying the subject property that is exempt from the transfer tax must have the 
appropriate municipal transfer tax form, transfer tax stamp, if required, and grantor/grantee statement, 
with the appropriate exemption language, affixed to the instrument prior to recording.  

NLT BELVIDERE  

Requirements  

a) Warranty Deed from {PR,"seller’s name",ST1,1} to {PR,"buyer’s name",ST1,2}.  

b) Mortgage from {PR,"buyer’s name",ST1,3} to {PR,"lender name",ST1,4} to secure a debt in the 
amount of {PR,"loan amount",CU1,5}.  
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c) Payment and release of the mortgage recorded as Document No. {PR,"doc number",IN1,6}  

Condominium: Commitment 4  

Furnish ATG with a certificate, executed and acknowledged by the Secretary of the Board of Managers, 
stating that there are no unpaid assessment liens arising by reason of the nonpayment of assessments as 
per the Condominium Declaration.  

NLT ROCKFORD: EXCEPTIONS 

Setback/Easement  

A {PR,"distance in feet of Building setback",ST1,1}-foot building setback line from the {PR,"direction of 
setbackline",ST1,2} line of the property, and a {PR,"distance in feet of easement",ST1,3}-foot line from 
the {PR,"direction of easement",ST1,4} line of the property, for the purpose of a utility easement, as 
disclosed on said recorded Plat.  

Restrictions/Setback Generic  

Restrictions, set-backs, and easements according to public record.  

Deed of Conveyance  

{PR,"Enter type of Deed (Warranty, Quitclaim, etc.).",ST1,6} Deed, dated {PR,"Enter date of 
Deed.",DT2,1}, and recorded {PR,"Enter date the Deed was recorded.",DT2,2}, as Document No. 
{PR,"Enter recorded Document number.",ST1,5}, executed by {PR,"Enter name(s) of person granting 
theDeed.",ST1,6}, and given to {PR,"Enter the name(s) of the person receiving the Deed.",ST1,7}.  

Tract Search Disclaimer  

Disclaimer: This Chain of Title alone may not be used as the basis for the issuance of an ATG 
commitment or policy. The liability of Attorney’s Title Guaranty Fund, Inc., in connection with this 
search report is limited to actual damages arising out of an error contained herein but in no event shall 
said liability exceed {PR,"amount charged for search",CU1,1}.  

Lis Pendens  

Lis Pendens Notice dated {PR,"Insert date of lis pendens here.",DT2,1} filed by {PR,"Insert name of 
person(s) filing the lis pendens here.",ST1,2} against {PR,"Insert name(s) of persons receiving the lis 
pendens here.",ST1,3} in Case No. {PR,"Insert case number here.",ST1,4} in the Circuit Court of 
{PR,"Insert name of County here.",ST1,5} County, Illinois, and recorded on {PR,"Insert date of recording 
here.",DT2,6}, as Document No. {PR,"Insert Document number here.",ST1,9}.  

Mortgage  

Mortgage dated {PR,"Date of Mortgage",DT2,7}, and recorded {PR,"Date mortgage was 
recorded",DT2,6}, as Document No. {PR,"Document No. of mortgage",ST1,3}, from {PR,"Name of 
borrower(s)",ST1,4}, given to {PR,"Name of lender",ST1,5}, its successors and/or assigns, to secure a 
debt in the amount of {PR,"Mortgageamount",CU1,6}, and other such sums as provided therein.  

Real Estate Taxes  

Taxes for the year {PR,"Year of taxes NOT paid",ST1,1} and thereafter: 

First installment of {PR,"Year of 1st installment ",IN1,8} taxes, in the amount of {PR,"amount of 1st 
installment",CU1,3}, is {PR,"Current status of 1st installment of taxes: PAID, etc.",ST1,4} and due 
6/4/10; 

Second installment of {PR,"Year of 2nd installment",IN1,8} taxes, in the amount of {PR,"amount of 2nd 
installment",CU1,6}, is {PR,"Current status of 2nd installment: PAID, etc.",ST1,7} and due 9/3/10; 

Totaling {PR,"Total of 1st & 2nd Installment",CU1,8}. 

2008 and prior years taxes appear to be paid in full.  

Taxes for the year 2010 are not yet due or payable.  
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PIN: {DB,Property,TaxID,NO}  

Restrictions  

Provisions detailed in Covenants, Conditions, and Restrictions for {PR,"Subdivision name",ST1,1}, 
which document was dated {PR,"date of restrictions",DT2,2}, and recorded {PR,"date restrictions were 
recorded",DT2,3}, as Document No. {PR,"Document No. of restrictions",ST1,4}; but omitting therefrom 
any covenant or restriction based on race, color, religion, sex, handicap, familial status, or national origin.  

Judgment: Same Name  

We find judgments, liens, and matters of record involving a person or persons whose names are similar to 
{PR,"Enter name of possible judgment debtor",ST1,1}. Relative thereto, a Personal Information Affidavit 
(ATG Form 3008) establishing the identity of the above described person must be supplied in order to 
facilitate the exclusion, if possible, of those items.  

Judgment  

Judgment rendered on {PR,"Insert date of judgment here",DT2,1} in the {PR,"Insert name of court 
(circuit, appellate, etc.) here",ST1,2} Court of {PR,"Insert name of county here",ST1,3} County, in favor 
of {PR,"insert name(s) of winning person(s) here",ST1,4} against {PR,"insert name(s) of losing person(s) 
here",ST1,5}, in the amount of {PR,"insert amount of judgment here in dollars and cents",CU1,6}.  

Agreement for Deed: New  

Consequences, if any, by reason of failure to record either the Agreement for Deed or a memorandum 
thereof.  

Agreement for Deed: Close-Out Recorded  

Terms and conditions of that Agreement for Deed, dated {PR,"date of AG D",DT2,1}, and recorded on 
{PR,"date AGD was recorded",DT2,2}, as Document No. {PR,"Document No. of AG D",ST1,3}.  

Agreement for Deed: Close-Out Unrecorded  

Terms and Conditions of an unrecorded Agreement for Deed, dated {PR,"Date of AG D",DT2,1}, by and 
between {DB,SellerInfo,Name1First,NO} {DB,SellerInfo,Name1MI,NO} 
{DB,SellerInfo,Name1Ext,NO} and {DB,SellerInfo,Name2First,NO} {DB,SellerInfo,Name2MI,NO} 
{DB,SellerInfo,Name2Last,NO}, as contract seller(s) and {DB,BuyerInfo,Name1First,NO} 
{DB,BuyerInfo,Name1MI,NO} {DB,BuyerInfo,Name1Last,NO} and {DB,BuyerInfo,Name2First,NO} 
{DB,BuyerInfo,Name2MI,NO} {DB,BuyerInfo,Name2Last,NO}, as contract purchaser.  

Real Estate Taxes: Sold  

{PR,"which installment or both are sold",ST1,1} installment(s) of the {PR,"Year of taxes sold",ST1,2} 
taxes have been sold and are NOT redeemed.  

Memo of Agreement for Deed  

Memorandum for Recording of Agreement for Deed, dated {PR,"Enter date of Deed.",DT2,1}, and 
recorded {PR,"Enter date the Deed was recorded.",DT2,2}, as Document No. {PR,"Enter recorded 
Document number.",ST1,5}, executed by {PR,"Enter name(s) of person granting the Deed.",ST1,6}, as 
Contract Seller(s), and given to {PR,"Enter the name(s) of the person receiving the Deed.",ST1,7}, as 
Contract Buyer(s).  

Later Date Text  

Attached is a list of items filed in the Recorder’s Office as of {PR,"Last effective date",DT2,1}, the date 
of our last search.  

Dissolution of Marriage Case  

Dissolution of marriage proceedings filed by {PR,"Insert name of Plaintiff here.",ST1,1} against 
{PR,"Insert name of Defendant here.",ST1,2} in the Circuit Court of {PR,"Insert name of County 
here.",ST1,3} County as Case No. {PR,"Insert Case number here.",ST1,4}.  
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NOTE: No examination of these proceedings has been made, and upon such examination, this 
commitment, and any policies committed for thereunder, shall be subject to such other and further 
exceptions as may then be deemed necessary.  

Corporation Dissolved  

{PR,"Enter name of dissolved Illinois corporation",ST1,1}, an Illinois corporation, was dissolved on 
{PR,"Enter date of dissolution of Illinois corporation",DT2,2}. We note the following with respect thereto 
and this Commitment is subject to the following exceptions:  

(1) Rights of the creditors of said corporation, including the United States of America;  

(2) Right, title, and interest of the stockholders/members of said corporation and those claiming under 
them.  

(3) Franchise tax in favor of the State of Illinois.  

Tax: City Ordinance Transfer Tax  

By {PR,"Name of City",ST1,1} municipal ordinance, a transfer tax has been imposed upon the sale of 
Real Property located within the municipality. Therefore, all deeds presented to this company for 
recording must have the appropriate transfer tax stamps affixed thereto, or be marked EXEMPT by the 
municipality, together with the applicable Transfer Declaration or Exemption Form.  

NOTE: Certain municipalities have requirements that must be met prior to the issuance of the aforesaid 
transfer tax stamps. Relative thereto, said municipality must be contacted as to their requirements prior to 
the purchase of any revenue stamps.  

Condominium Setback/Easement  

Setbacks and Easements according to {PR,"name of original plat",ST1,1}, recorded {PR,"date original 
plat recorded",DT2,2}, as Document No.{PR,"Document No. of original Plat",ST1,3}.  

Setbacks and Easements according to {PR,"Name of Condo Plat",ST1,4}, recorded {PR,"date condo plat 
was recorded",DT2,5}, as Document No. {PR,"Document No. of Condo Plat",ST1,6}.  

Environmental Disclosure  

Environmental disclosure document for transfer of real property, dated {PR,"Date of 
EnvironmentalDisclosure",DT2,1}, and recorded {PR,"Date Environment Disclosure was 
recorded",DT2,2}, as Document No. {PR,"Doc No. of Environment Disclosure",ST1,3}. 

Construction Commitment Exception  

ATG must be provided with properly executed sworn contractors’ statements, sub-contractors’ 
statements, and final lien waivers, along with proof of proper disbursements of any loan proceeds used for 
the improvement of the land, or the policy or policies, when issued, will be subject to the following 
exceptions:  

"(a). Any lien, or right to a lien, for services, labor, or materials, heretofore or hereafter furnished, 
imposed by law, and not shown by the public records.  

"(b). Consequences of the failure of the lender to pay out properly the whole or any part of the loan 
secured by the mortgage described in Schedule A as affecting: (i) the validity of the lien of the mortgage; 
and (ii) the priority of the lien of the mortgage over any other right, claim, lien, or encumbrance that has 
or may become superior to the lien of the mortgage before the disbursement of the entire proceeds of the 
loan."  

Lake Summerset Rest: Winnebago  

{PR,"Number of feet for Setback",ST1,1} foot Building Setback line from the {PR,"Direction of the 
setbackline",ST1,2} line of the property, as designated upon said recorded Plat.  

Easement contained in the Corrected Final Plat No. 2 of Lake Summerset reserved for and granted to 
Commonwealth Edison Company, Illinois Telephone Company, and Mid-Illinois Gas Company and their 
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respective successors and assigns within the area of Lake Summerset. Assigned to Otter Creek Lake 
Utility District by a document recorded July 5, 1978, as Document No. 1461483 found on Microfilm No. 
78-18-1078.  

Provisions contained in the Corrected Final Plat No. 2 of Lake Summerset, dated September 16, 1969, 
and recorded September 25, 1969, in Book 32 of Plats on page 262. NOTE: A breach violation of the 
above noted restrictions will not cause a forfeiture or reversion of title.  

Declaration of covenants and restrictions, dated April 30, 1969, and recorded May 7, 1969, as Document 
No.1211783, found on Microfilm No. 69-09-0319, together with provisions for assessments and liens.  

Right of First Refusal contained in declaration of covenants and restrictions, dated April 30, 1969, and 
recorded May 7, 1969, as Document No. 1211783, found on Microfilm No. 1211783, for particulars of 
which we refer to the public records.  

Easements contained in declarations of covenants and restrictions, dated April 30, 1969, and recorded 
May 7,1969, as Document No. 1211783, found on Microfilm No. 69-09-0319, for particulars of which we 
refer to the public records. Assigned to Otter Creek Lake Utility District by Document recorded July 5, 
1978, as Document No.1461483, found on Microfilm No. 78-18-1078.  

Easement created by grant dated March 29, 1978, and recorded May 10, 1978, as Document No. 
1311901, found on Microfilm No. 73-11-0344, made by the Cosmopolitan National Bank of Chicago, as 
Trustee, under Trust Agreement dated August 1, 1969, and known as Trust No. 18600, to Boise Cascade 
Home and Land Corporation and Lake Summerset Utilities Corporation. Assigned to Otter Creek Lake 
Utility District by document recorded July 5, 1978, as Document No. 1461483, found on Microfilm No. 
78-18-1078.  

Interest of Lake Summerset Association, Inc., in all oil, all other minerals of every kind and description, 
and all air rights in and upon premises in questions under deed dated April 30, 1973, and recorded May 
10, 1973, as Document No. 1311906, found on Microfilm No. 73-11-0383, made by the Cosmopolitan 
National Bank of Chicago, not personally but as Trustee under the provisions of a Trust Agreement, dated 
August 1, 1969, and known as Trust No. 18600, and under deed dated April 20, 1973, and recorded May 
10, 1973, as Document No. 1311907, found on Microfilm No. 73-11-0385, made by Boise Cascade Home 
and Land Corporation, and interest created by virtue of instrument filed May 16, 1973, as Document No. 
1312293, found on Microfilm No. 73-11-1153. Assigned to Otter Creek Lake Utility District by a 
document recorded July 5, 1978, as Document No. 1461483, found on Microfilm No. 78-18-1078.  

Declaration of Restrictions, Lake Summerset Subdivision, Stephenson and Winnebago Counties, Illinois, 
1999 amended Declaration of Restrictions, recorded December 18, 1998, as Document No. 9880054.  

Declaration: No Will No Probate  

A satisfactory table of the heirship and proof of the death, testacy or intestacy, and of the value of the 
estate of {PR,"Name of decedant",ST1,1}, deceased, should be furnished, and this Commitment is subject 
to such further exceptions, if any, as may then be deemed necessary.  

Claims against the estate of {RP,1}, deceased.  

Federal and Illinois Estate Taxes that may be charged against the estate of {RP,1}.  

Statutory rights, powers, and duties of the personal representative of the decedent, if and when appointed.  

Mortgage with Subordination  

Mortgage dated {PR,"Date of Mortgage",DT2,7}, and recorded {PR,"Date mortgage was 
recorded",DT2,6}, as Document No. {PR,"Document No. of mortgage",ST1,3}, from {PR,"Name of 
borrower(s)",ST1,4} given to {PR,"Name of lender",ST1,5}, its successors and/or assigns, to secure a 
debt in the amount of {PR,"Mortgageamount",CU1,6}, and other such sums as provided therein. This 
mortgage was subordinated to the above listed mortgage by an agreement dated {PR,"Date of 
Subordination",DT2,7}, and recorded {PR,"date subordination wasrecorded",DT2,8}, as Document No. 
{PR,"Document No. of Subordination",ST1,9}.  
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Annexation Agreement  

Provisions detailed in an Annexation Agreement dated {PR,"date of agreement",DT2,2}, and recorded 
{PR,"date agreement was recorded",DT2,3}, as Document No. {PR,"Document No. of 
agreement",ST1,4}.  

Power of Attorney  

Power of Attorney, dated {PR,"Date of POA",DT2,1}, and recorded {PR,"Date POA was 
recorded",DT2,2}, as Document No. {PR,"Doc. No. of POA",ST1,3}, from {PR,"Grantor of 
POA",ST1,4} to {PR,"Grantee of POA",ST1,5}.  

Assignment of Rents  

Assignment of Rents, dated {PR,"Date of RENTS",DT2,7}, and recorded {PR,"Date RENTS was 
recorded",DT2,6}, as Document No. {PR,"Document No. of RENTS",ST1,3}, from {PR,"Name of 
borrower(s)",ST1,4} given to {PR,"Name of lender",ST1,5}, its successors and/or assigns.  

Flood Letter  

Provisions detailed in a flood letter dated {PR,"date of flood letter",DT2,2}, and recorded {PR,"date flood 
letter wasrecorded",DT2,3}, as Document No. {PR,"Document No. of flood letter",ST1,4}.  

Restrictions on Warranty Deed  

Covenants, Conditions, and Restrictions for {PR,"Subdivision name",ST1,1}, detailed on Warranty deed 
dated {PR,"date of deed restrictions",DT2,2}, and recorded {PR,"date deed restrictions were 
recorded",DT2,3}, as Document No. {PR,"Document No. of deed restricitons",ST1,4}.  

Name Search  

At the request of the applicant, we have made a search for judgments, liens, and other matters against the 
following named persons and find none at this date, which would adversely affect title to the premises in 
question unless shown elsewhere herein:  

Condominium (PUD): Homeowners Association  

We must be furnished a letter from the {PR,"Name of Condo (PUD) association",ST1,1} Homeowner’s 
Association reciting that there are no outstanding balances nor liens by reason of the non-payment of 
special and annual assessments. Said letter must include both annual and special assessments through the 
month of closing. Letters not containing that language will not be acceptable to waive the aforesaid 
exception.  

Notice  

Provisions detailed in a Notice dated {PR,"Date of notice",DT2,1}, and recorded {PR,"Date notice 
wasrecorded",DT2,2}, as Document No. {PR,"Document No. of Notice",ST1,3}.  

Real Estate Taxes: Ogle  

Taxes for the year {PR,"Year of taxes NOT paid",ST1,1} and thereafter: 

First installment of {PR,"Year of 1st installment ",IN1,8} taxes, in the amount of {PR,"amount of 1st 
installment",CU1,3}is {PR,"Current status of 1st installment of taxes: PAID, etc.",ST1,4} and due 
6/04/10; 

Second inst. of {PR,"Year of 2nd installment",IN1,8} taxes in the amount of {PR,"amount of 
2ndinstallment",CU1,6} is {PR,"Current status of 2nd installment: PAID, etc.",ST1,7} and due 9/03/08; 

Totaling {PR,"Total of 1st & 2nd Installment",CU1,8}. 

2008 and prior years taxes appear to be paid in full. 

2010 taxes are not yet due or payable.  

PIN: {DB,Property,TaxID,NO}  
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Mortgage with Assignment  

Mortgage dated {PR,"Date of Mortgage",DT2,7}, and recorded {PR,"Date mortgage was 
recorded",DT2,6}, as Document No. {PR,"Document No. of mortgage",ST1,3} from {PR,"Name of 
borrower(s)",ST1,4}, given to {PR,"Name of lender",ST1,5}, its successors and/or assigns, to secure a 
debt in the amount of {PR,"Mortgageamount",CU1,6}, and other such sums as provided therein. This 
mortgage has been assigned to {PR,"Lender mortgage assigned to",ST1,7} by Document dated {PR,"Date 
of Assignment",DT2,8}, and recorded {PR,"Date of Assignmentrecorded",DT2,9}, as Document No. 
{PR,"Assignment Doc. No.",ST1,10}.  

Easement: Separate Recorded  

Provisions detailed in an easement dated {PR,"Date of Easement",DT2,1}, and recorded {PR,"Date 
easement was recorded",DT2,2}, as Document No. {PR,"Document No. of easement",ST1,3}, from 
{PR,"Name of person granting easement",ST1,4} to {PR,"Name of person easement was granted 
to",ST1,5}.  

Forgery Exception  

Right, title, and interest of {PR,"Name of Grantor(s) in deed less than 12 months old",ST1,1}, purported 
grantor in the deed recorded {PR,"Date deed was recorded",DT2,2}, as Document No. {PR,"Document 
No. of deed",ST1,3}.  

EPA Disclaimer  

Disclaimer: This Chain of Title alone may not be used as the basis for the issuance of an ATG 
commitment or policy. The liability of Attorney’s Title Guaranty Fund, Inc. in connection with this 
search report is limited to actual damages arising out of an error contained herein but in no event shall 
said liability exceed the charge of this report.  

This report does not make representations as to the presence of hazardous products or conditions on the 
subject property and in no way has or assumes any liability whatsoever.  

The documents listed in this report are the recorded documents that appear of record to create any fee, 
land contract interests, leasehold, environmental liens, restrictions, and covenants affecting the land, 
environmental encumbrances or easements related to environmental nature from said county, effective 
date of February 21, 2006 to a period prior to 1940; as required by the Environmental Protection Act 88-
602 State of Illinois State Senate Bill 41, Environmental Property Risk Assessments (EPRA) Standards, 
and ASTM Requirement Standards.  

Deceased: Probate, No Will  

Claims against the estate of {PR,"name of deceased",ST1,1}, deceased.  

Federal estate and Illinois estate taxes, which may be charged against the estate of {RP,1}, deceased.  

Statutory rights, powers, and duties of the Independent Executor/Administrator of the estate of {RP,1}, 
deceased.  

Decedent Estate Exception  

Subject to the rights of {PR,"name of pers rep",ST1,1}, {PR,"exec. or adm.",ST1,2} of the Estate of 
{PR,"name of decedent",ST1,3}, deceased, to sell said real estate pursuant to probate proceedings, Case 
No. {PR,"case#",ST1,4}, Circuit Court of the {PR,"Circuit #",ST1,5} Judicial Circuit, 
{PR,"county",ST1,6} County, Illinois.  

Decedents Probate General  

Proceedings pending in the Circuit Court of {PR,"Enter name of County.",ST1,1} County entitled Estate 
of {PR,"Enter name of deceased person.",ST1,2}, Deceased, under Case No. {PR,"Enter case 
number.",ST1,3}.  

Right of any person to demand formal proof of the will or to contest the will of {RP,2}, deceased, within 
the time provided by the Probate Act.  
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Statutory rights of {PR,"Enter name of surviving spouse.",ST1,1}, surviving spouse of the decedent, to 
renounce the will of deceased and take statutory share.  

Power of sale conferred upon {PR,"Enter name of Executor.",ST1,1}, executor, by terms of the will of 
{RP,2}, deceased.  

Right, title, and interest of {PR,"Enter names of person(s) taking under the will.",ST1,1}, devisee(s) 
under the unproven will of {RP,2}, deceased.  

Lien: General  

Claim for lien dated {PR,"Insert date of lien here.",DT2,1}, and recorded {PR,"Insert date the lien was 
recorded here.",DT2,2}, as Document Number {PR,"Enter recorded document number.",ST1,6} made by 
{PR,"Insert name of person(s) asserting lien here.",ST1,3}, and filed against {PR,"Insert name of 
person(s) against whom the lien is made here.",ST1,4}, in the sum of {PR,"Insert the amount of the lien 
here.",CU1,5}.  

Bankruptcy Statutory Powers  

Statutory Rights, powers, and duties of the Trustee in Bankruptcy in the bankruptcy proceeding filed by 
{PR,"Enter name(s) of person filing bankruptcy",ST1,1} on {PR,"Enter date of bankruptcy 
filing",DT2,2}, in the Federal District Court for the {PR,"Enter name (i.e., Central) of bankruptcy 
court",ST1,3}, District of Illinois, in Case No. {PR,"Enter case number of bankruptcy",ST1,4}, notice of 
which was recorded on {PR,"Enter date of recording of bankruptcy notice",DT2,5}, as Document 
Number {PR,"Enter recorded Document Number",ST1,6}.  

Condominium Declaration  

Terms, provisions, covenants, conditions, and options in, rights and easements established by the 
Declaration of Condominium Ownership recorded {PR,"Enter date of Condominium Declaration 
recording",DT2,1}, as Document Number {PR,"Enter Document Number Declaration",ST1,2}, as 
amended from time to time.  

Limitations and conditions imposed by the Illinois Condominium Property Act.  

Corporation: Certificate of Authority  

The Certificate of Authority of {PR,"Enter name of Illinois Corporation",ST1,1} to do business in Illinois 
issued by the Secretary of State should be produced, and in default thereof, the policy or policies to be 
issued will contain the following exception:  

"Consequences, if any, that may result because of the failure of the party in title to the estate or interest in 
the land described in Schedule A to comply with the applicable ‘doing business’ laws of the State of 
Illinois.  

Lien: Child Support  

Child support judgment filed against {PR,"insert name of person(s) who received judgment",ST1,1}, in 
Case No. {PR,"Insert Case number",ST1,2}, in the Circuit Court of {PR,"Insert County name",ST1,3} 
County, Illinois, a memorandum of which was recorded on {PR,"Insert date the judgment was 
recorded",DT2,4}, as Document Number {PR,"Insert Doc No.",ST1,5}.  

Easements: Dedicated Road  

Rights of the public, the State of Illinois, and the municipality in and to so much of the land dedicated for 
road purposes by instrument dated {PR,"Insert date of document road dedication",DT2,1}, and recorded 
{PR,"Insert date road dedication doc was recorded",DT2,2}, as Document Number {PR,"Insert Doc No. 
of Road dedication",ST1,3}.  

Encroachments: Adjoining Land Lot Line  

A survey discloses an encroachment by {PR,"Describe the building or structure that is 
encroaching",ST1,1}, located on the property to the {PR,"Enter direction of the encroachment",ST1,2} 
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and adjoining onto the insured premises by approximately {PR,"Enter number of feet of 
encroachment",IN4,3} feet.  

Encroachments: Insured Land Building Line  

A survey discloses an encroachment of the {PR,"Describe the encroaching structure",ST1,1} over the 
{PR,"Enter direction of the encroachment",ST1,2} building line by {PR,"Enter number of feet of 
encroachment",IN4,3} feet.  

Encroachments: Insured Land Easement  

A survey discloses that the {PR,"Describe the structure that is encroaching",ST1,1} located upon the 
insured premises encroaches onto the utility easement located on the {PR,"Enter direction of the 
encroachement",ST1,2} of the land by {PR,"Enter number of feet of the encroachment",IN4,3} feet.  

Encroachments: Insured Land Lot Line  

A survey discloses that the {PR,"Describe the structure encroaching",ST1,1} located upon the insured 
premises encroaches upon the property {PR,"Enter direction of encroachment",ST1,2} and adjoining by 
{PR,"Enter number of feet of encroachment",IN4,3} feet.  

Survey  

Survey reflecting proposed legal description of land to be insured.  

Legal  

Lot {PR,"spell out lot number",ST1,1} ({PR,"numerical lot number",ST1,2}) as designated upon the Plat 
of {PR,"subdivisionname",ST1,3}, being a Subdivision of part of the {PR,"quarter section etc",ST1,4} of 
Section {PR,"Section number",ST1,5}, in Township {PR,"Township number",ST1,6} North, Range 
{PR,"Range #",ST1,7} East, of the {PR,"which principalmeridian?",ST1,8} Principal Meridian, the Plat 
of which Subdivision is recorded in Book {PR,"Book #",ST1,9} of Plats on page {PR,"page #",ST1,10}, 
in the Recorder’s Office of * County, Illinois; situated in the County of * and State of Illinois.  

Plat Notes  

Notes as contained on the recorded Plat of Subdivision, for full particulars of which we refer to the public 
records.  

Deceased: Will No Probate  

{PR,"Name of deceased",ST1,1}, owner of the premises, died testate {PR,"Date of Death",DT2,2}, 
leaving a will filed with the {PR,"County Will was filed in",ST1,3} County Circuit Clerk on {PR,"Date 
will was filed",DT2,4}. 

In connection therewith, the following is noted: 

(A) A satisfactory table of the heirship and of the value of the estate of {RP,1}, deceased, should be 
furnished; and this commitment is subject to such further exceptions, if any, as may then be deemed 
necessary. 

(B) Expenses of administration and claims against the estate of {RP,1}, deceased. 

(C) Federal and Illinois Estate Taxes, which may be charged against said estate. 

(D) Statutory rights, powers, and duties of the personal representative of said decedent, if and when 
appointed. 

(E) Legacies created by the Will; 

(F) If the property is to be conveyed by devisees under the will under the Illinois Small Estate Act, it will 
be necessary that such grantors execute a Personal Undertaking satisfactory to ATG, a copy of which is 
furnished herewith.  
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NLT ROCKFORD: REQUIREMENTS 

Deceased: Will No Probate Requirements  

A certified copy of the death certificate of {PR,"Name of deceased",ST1,1}.  

A satisfactory Affidavit of Heirship.  

A Statement of No Claims against the estate of {PR,"Name of deceased",ST1,1}.  

Refinance: Standard  

ALTA Statement to be signed by Borrower(s).  

If any party is required to bring in more than $2,000.00 to close this property, the funds must be in 
certified form.  

Survey  

Produce accurate survey reflecting proposed legal description of land to be insured.  

Corporation Resolution  

Upon a conveyance or mortgage of the land, provide a certified copy of proper resolutions, passed by the 
stockholders and directors of the party in title, authorizing the execution of the deed of conveyance or 
mortgage.  

Standard procedures applicable in open bankruptcy Case No. {PR,"insert bankruptcy case no.",ST1,1}.  

Trust  

Copy of trust showing all signators of trust and authorizing trustee to sell subject property.  

Deceased Joint Tenant  

We should be supplied with satisfactory evidence establishing the death, the testacy or intestacy, the 
status of tenancy at time of death, and the value of the Estate of {PR,"Insert name of deceased joint 
tenant",ST1,1}, deceased; and this commitment is subject to such further exceptions, if any, as may then 
be deemed necessary.  

Deed: Quit Claim  

Quit Claim Deed from {DB,SellerInfo,Name1First,NO} {DB,SellerInfo,Name1MI,NO} 
{DB,SellerInfo,Name1Last,NO} and {DB,SellerInfo,Name2First,NO} {DB,SellerInfo,Name2MI,NO} 
{DB,SellerInfo,Name2Last,NO}, and spouses, if any, vesting fee simple interest of the subject property to 
{DB,BuyerInfo,Name1First,NO}{DB,BuyerInfo,Name1MI,NO} {DB,BuyerInfo,Name1Last,NO} and 
{DB,BuyerInfo,Name2First,NO}{DB,BuyerInfo,Name2MI,NO} {DB,BuyerInfo,Name2Last,NO}, and 
spouses, if any.  

Release of Mortgage  

Payment and Release of Mortgage recorded as Document No. {PR,"Document No of mortgage to 
bereleased",ST1,1}.  

Taxes: To Be Paid  

{PR,"which installment or both",ST1,1} installment(s) of the {PR,"year of taxes to be paid",ST1,2} taxes 
must be paid in FULL.  

REQUIREMENTS  

Requirements  

Issuer will require the following as conditions precedent to issuance of policy:  
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Deed: Agreement for Deed  

Agreement for Deed or Memorandum by and between 
{DB,SellerInfo,Name1First,NO}{DB,SellerInfo,Name1MI,NO} {DB,SellerInfo,Name1Last,NO} and 
{DB,SellerInfo,Name2First,NO}{DB,SellerInfo,Name2MI,NO} {DB,SellerInfo,Name2Last,NO}, as 
contract seller(s) and {DB,BuyerInfo,Name1First,NO} {DB,BuyerInfo,Name1MI,NO} 
{DB,BuyerInfo,Name1Last,NO} and {DB,BuyerInfo,Name2First,NO} {DB,BuyerInfo,Name2MI,NO} 
{DB,BuyerInfo,Name2Last,NO}, as contract purchaser(s) to be executed and recorded.  

Name Search  

At the request of the applicant, we have made a search for judgments, liens, and other matters against the 
following named persons and find none at this date that would adversely affect title to the premises in 
question unless shown elsewhere herein:  

Standard  

ALTA Statement to be signed by Sellers and Buyers.  

Affidavit in Lieu of Survey to be signed by Sellers.  

If any party is required to bring in total more than $50,000.00 to close this property, the funds must be 
wired into our escrow account.  

If any party is required to bring in total less than $50,000.00 to close this property, the funds must be in 
certified form.  

New Mortgage  

Mortgage terms from {DB,BuyerInfo,Name1First,NO} {DB,BuyerInfo,Name1MI,NO} 
{DB,BuyerInfo,Name1Last,NO} and {DB,BuyerInfo,Name2First,NO} {DB,BuyerInfo,Name2MI,NO} 
{DB,BuyerInfo,Name2Last,NO}, and spouses, if any, given to {DB,Lender,Name,NO}, its successors 
and/or assigns, to secure a debt in the amount of {DB,Main,LoanAmount,CU1}, and other such sums as 
provided therein.  

For Information Only  

For Information Only: 

Township is: {PR,"Enter Township",ST1,1} 

Lot size is: {PR,"Enter Lot size",ST1,2} 

Taxes reflect {PR,"Enter number of exemptions",IN2,3} exemptions: 

General Homestead Exemption = $6,000.00 

Home Improvement Exemption = {PR,"Enter amount of Home Improvement exemption",CU1,4} 

Citizen Homestead Exemption = $4,000.00 

Citizen Assessment Freeze = {PR,"Enter amount of senior assessment freeze",CU1,5}  

Street Address  

Commonly Known As:{DB,Property,Address,NO}{DB,Property,City,NO}, {DB,Property,State,NO} 
{DB,Property,Zip,NO}  

Deed: Trustee’s  

Trustee’s Deed from {PR,"Name of Trustee",ST1,1}, as Trustee under the Provisions of a Trust 
agreement dated {PR,"Date of trust",DT3,2}, known as {PR,"Name of Trust",ST1,3}, vesting fee simple 
interest of the subject property to {DB,BuyerInfo,Name1First,NO} {DB,BuyerInfo,Name1MI,NO} 
{DB,BuyerInfo,Name1Last,NO} and {DB,BuyerInfo,Name2First,NO} {DB,BuyerInfo,Name2MI,NO} 
{DB,BuyerInfo,Name2Last,NO}, and spouses, if any.  
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Deed: Warranty  

Warranty Deed from {DB,SellerInfo,Name1First,NO} {DB,SellerInfo,Name1MI,NO} 
{DB,SellerInfo,Name1Last,NO} and {DB,SellerInfo,Name2First,NO} {DB,SellerInfo,Name2MI,NO} 
{DB,SellerInfo,Name2Last,NO}, and spouses, if any, vesting fee simple interest of the subject property to 
{DB,BuyerInfo,Name1First,NO}{DB,BuyerInfo,Name1MI,NO} {DB,BuyerInfo,Name1Last,NO} and 
{DB,BuyerInfo,Name2First,NO}{DB,BuyerInfo,Name2MI,NO} {DB,BuyerInfo,Name2Last,NO}, and 
spouses, if any.  

Deed: Executor’s  

Executor’s deed from {PR,"name of executor",ST1,1}, executor of {DB,SellerInfo,BusinessName,NO}, 
conveying fee simple interest of the subject property to {DB,BuyerInfo,Name1First,NO} 
{DB,BuyerInfo,Name1MI,NO}{DB,BuyerInfo,Name1Last,NO} and {DB,BuyerInfo,Name2First,NO} 
{DB,BuyerInfo,Name2MI,NO}{DB,BuyerInfo,Name2Last,NO}, and spouses, if any.  

Release of Lien  

Payment and release of lien recorded as Document No. {PR,"Document No. of lien.",ST1,1}.  

NOTES FOR INFORMATION  

Variable Rate Mortgage Endorsement  

Variable Rate Mortgage Endorsement has been approved for issuance with the Loan Policy.  

Assumption Certificate  

An Assumption Certificate from First American Title Insurance Company has been approved for the Loan 
Policy.  

Assumption Certificate  

Comprehensive Endorsement has been approved for issuance with the Loan Policy. Environmental 
Protection Lien Endorsement has been approved for issuance with the Loan Policy. Location 
Endorsement has been approved for issuance with the Loan Policy.  

Notes for Information: Standard Loan Policy Endorsements  

Environmental Protection Lien (EPL) Endorsement has been approved for issuance with the Loan Policy 
for this transaction.  

Comprehensive Endorsement has been approved for issuance with the Loan Policy for this transaction.  

Location Endorsement has been approved for issuance with the Loan Policy for this transaction, if 
requested.  

Residential: Buy/Sell Endorsements  

Comprehensive Endorsement has been approved for issuance with the Loan Policy . Environmental 
Protection Lien Endorsement has been approved for issuance with the Loan Policy. Standard Exception 
Waiver Endorsement will be approved for issuance with the Owner’s Policy upon inspection of a current 
survey, receipt of a signed ALTA Statement, review of special assessments, and information that no one 
claims an interest in or possesses the property adversely. Inflation Endorsement has been approved for 
issuance with the Owner’s Policy.  

Condominium Endorsement  

Condominium Blanket Endorsement has been approved for issuance with the Loan Policy.  

Planned Unit Development Endorsement  

Planned Unit Development Endorsement has been approved for issuance with the Loan Policy .  

Location Endorsement  

Location Endorsement has been approved for issuance with the Loan Policy. 
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PERMANENT INDEX NUMBER:*  

FIRST INSTALLMENT OF THE 2002 TAXES $*.  

SECOND INSTALLMENT 2002 TAXES $*.  

2003 GENERAL REAL ESTATE TAXES ARE NOT YET DUE OR PAYABLE.  

PARTNERSHIPS 

Agreement: Examination  

The partnership agreement establishing the partnership of {PR,"Enter name of Partnership.",ST1,1} 
together with all amendments thereto, properly identified in writing by all the partners as being the terms 
and provisions of the agreement under which the partnership, or the partners thereof, acquired and holds 
title or held title, should be furnished and this Commitment is subject to such further exceptions, if any, as 
may then be deemed necessary. In addition, this Commitment is subject to such further exceptions, if any, 
that may be disclosed after a name search has been made for judgments and other matters against all the 
members of the partnership of {RP,1}.  

Agreement: Terms  

Terms, provisions, and limitations of the partnership agreement for {PR,"Enter name of 
Partnership.",ST1,1} partnership. 

Conveyance  

Upon a conveyance or mortgage of the land, we should be supplied with satisfactory proof of compliance 
with the terms of the agreement governing {PR,"Enter name of Partnership.",ST1,1}, a partnership, and 
this Commitment is subject to such further exceptions, if any, as may then be deemed necessary. 

Rights of Partners  

Rights of {PR,"Enter names of partners in the Partnership.",ST1,1}, partners composing the firm of 
{PR,"Enter name of Partnership.",ST1,2}, and of all persons claiming thereunder.  

Limited Partnership: Certificate  

The public records do not disclose the existence of a Certificate of Limited Partnership for {PR,"Limited 
Partnership: Enter the name of the partnership:",ST1,1}.  

Limited Partnership: Partnership Act  

Unless compliance is made with the Uniform Limited Partnership Act, this Commitment and our policy, 
if and when issued, shall be subject to the consequences of the failure to comply with the Act.  

Wisconsin Limited Partnership Act: Limited Partnership  

Unless compliance is made with the Uniform Limited Partnership Act (Chapter 179 of the Wisconsin 
statues), this Commitment and our policy, if and when issued, shall be subject to the consequences of the 
failure to comply with the Act.  

PARTY WALL  

Party Wall  

Rights of adjoining property owners in and to the {PR,"Direction",ST1,1} wall of the 
{PR,"Improvement",ST1,2} located on the property described in Schedule A hereof.  

PLAT ACT  

Plat Act  

We must be furnished a recordable Plat of Subdivision or a Survey and Exemption Affidavit in 
compliance with the provisions of the "Plat Act", 765 ILCS 205/1, and as required by the Office of 
Recorder prior to being able to record any conveyance of land less than 5 acres in area.  
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PREDATORY LENDING  

Predatory Lending Commitment  

Note for Information: The land lies within the area designated under the predatory lending database 
program (765ILCS 77/70, et seq.). A Compliance Certificate or an Exempt Certificate must be obtained 
from the Illinois Department of Financial and Professional Regulation and recorded simultaneously with 
the mortgage to be insured hereunder. If the certificates are not obtained, the policy or policies to be 
issued will be subject to the following exception: "Consequences of the failure to obtain and record a 
Certificate of Compliance or an Exempt Certificate as required pursuant to the predatory lending database 
program (765 ILCS 77/70, et seq.)".  

PROBATE ESTATES  

Standard Exceptions  

Any claims against the {DB,SellerInfo,BusinessName,SN1}, deceased.  

Federal and Illinois estate taxes, which may be charged against the {DB,SellerInfo,BusinessName,SN1}, 
deceased.  

Statutory rights, powers, and duties of the Executor of the {DB,SellerInfo,BusinessName,SN1}, 
deceased.  

Power of sale conferred upon {DB,SellerInfo,Name1First,SN1} 
{DB,SellerInfo,Name1MI,SN1}{DB,SellerInfo,Name1Last,SN1}, by the terms of the Will of {PR,"enter 
name of deceased",ST1,1}, deceased.  

Any conveyance of the land by the Executor should recite that the same is executed pursuant to the power 
and authority vested in said representative by the Last Will and Testament of {PR,"enter name of 
deceased",ST1,1}, deceased, and should recite therein the full consideration for which it is given. In 
addition, the aforesaid personal representative should file the bond required by Paragraph 12-9 of the 
Probate Act.  

RAILROADS  

Illinois Central: Rights of USA  

Right, title, and interest of the United States of America in and to any portion of the land falling within 
the mainline right-of-way of the Illinois Central Railroad Company pursuant to an Act of Congress 
approved September 20, 1850.  

REAL ESTATE TAXES  

Current (Default for All Users)  

Taxes for the year {PR,"Enter the last year that taxes were paid (‘YYYY’).",IN1,1} and thereafter:  

First installment {PR,"Enter the previous year (‘YYYY’).",IN1,1} taxes, in the amount of {PR,"Enter 
amount of the 1st installment prior year taxes.",CU1,2}, is {PR,"Enter whether ‘PAID,’ ‘UNPAID AND 
DUE,’ ‘NOTYET DUE AND PAYABLE.’",ST1,3}. Second installment {PR,"Enter the previous year 
(‘YYYY’)",IN1,8} taxes, in the amount of {PR,"Enter amount of 2nd installment prior year 
taxes.",CU1,4}, is {PR,"Enter whether ‘PAID,’ ‘UNPAID AND DUE,’’NOT YET DUE AND 
PAYABLE.’",ST1,5}. 

Taxes for the year {PR,"Enter the current year (YYYY).",IN1,6} are not yet due and payable.  

Permanent Index No. {DB,Property,TaxID,NO}  

Forfeited  

{PR,"Enter which installment (1st, 2nd, etc.) is unpaid.",ST1,1} installment {PR,"Enter the year(YYYY) 
of the forfeited taxes.",IN1,2} taxes of {PR,"Enter the amount of the forfeited taxes.",CU1,3}, not paid 
and forfeited on {PR,"Enter the date when the taxes were forfeited.",DT1,4}. 
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Sanitary Sewer District tax  

The land lies within the boundaries of the {PR,"Sanitary Sewer: Enter the name of the 
SanitaryDistrict:",ST1,1} Sanitary District and is subject to taxes thereunder.  

Sold  

{PR,"Enter which installment (First or Second, etc.) were sold.",ST1,1} installment {PR,"Enter the 
year(YYYY) of the tax sold.",IN1,2} taxes of {PR,"Enter the amount of the taxes sold.",CU1,3} not paid 
and sold on {PR,"Enter the date the taxes were sold.",DT2,4} to {PR,"Enter the name(s) of the tax 
purchaser.",ST1,5} at {PR,"Enter the amount of interest the taxes sold for.",IN1,6}%.  

Special Assessments: Special Service Area  

The land is located in Special Service Area Number {PR,"Enter number assigned to Special 
ServiceArea.",ST1,1} of the City of {PR,"Enter name of municipality.",ST1,2} and is subject to levy and 
assessment, therefor, as part of the general real estate tax bill.  

Tax Deed: Tax Deed Proceedings  

With respect to the {PR,"Enter annual, forfeiture, or scavenger.",ST1,1} tax sale of the land on 
{PR,"Enter date of tax sale.",DT2,2}, to {PR,"Enter name(s) of person/entity purchasing taxes.",ST1,3} 
[by virtue of the non-payment of the * general real estate taxes][for the non-payment of the forfeited 
general taxes for the year*][for the delinquent taxes for the years * to *], the following is noted:  

(a) The question of the willingness of ATG to insure title derived through the tax deed proceeding should 
be submitted to an underwriting attorney of ATG. 

(b) A petition in conformity with the provisions of Article 22 of the Property Tax Code (35 ILCS 200/22-
5, et seq.) should be filed in the Circuit Court of {PR,"Enter name of County.",ST1,4} County, Illinois, in 
the proceeding wherein the judgment of sale was entered and, after due notice has been given to the 
persons entitled thereto as provided in sections 22-10, 22-15, 22-20, 22-25, 22-30, and 22-40 of the 
Property Tax Code (35 ILCS 200/22-10, 200/22-15, 200/22-20, 200/22-25, 200/22-30, and 200/22-40), an 
order should be entered on said petition adjudicating that said petitioner has in all respects complied with 
the provisions of the Constitution of the State of Illinois and the Property Tax Code, entitling the 
certificate holder to a deed and ordering and directing the County Clerk to execute and deliver a deed.  

(c) The deed should be issued and filed for record within the time provided by Sections 22-85 and 22-90 
of the Property Tax Code (35 ILCS 200/22-85, and 200/22-90). 

(d) The notices and deeds issued pursuant to the proceeding should show the legal description and, where 
applicable, the permanent real estate index number. 

(e) Notice should be served on the persons set forth below in accordance with sections 22-10, 22-15, 22-
20, 22-25, 22-30, and 22-40 of the Property Tax Code (35 ILCS 200/22-10, 200/22-15, 200/22-20, 
200/22-25,200/22-30, and 200/22-40), in the manner and within the time specified therein. NOTE: In the 
event that there are any persons who should be served with notices, but the names of such persons are 
unknown and unascertainable, then, in that event only, such persons should be served with notice under 
the description of "Unknown owners or parties interested in said land or lots." 

(1) Any person, other than those herein named, known to the certificate holder or his or her attorney who 
may have, or claim to have, some interest in the land. 

(2) Unknown owners or parties interested in the land, generally. 

(3) The County Clerk of {RP,4} County, Illinois. 

(4) All persons in occupancy or actual possession of said land, which persons must be served personally. 

(5) {PR,"Enter name(s) of person holding Certificate of Sale.",ST1,5}, Certificate of Sale holder, as party 
plaintiff. 

(6) {PR,"Enter name(s) of owners of record, successors, etc.", ST1,6}, owner(s) of record, contract 
purchaser(s), etc., or successors in interest, as party (ies) defendant. 
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(7) {PR,"Enter name(s) of mortgagees, creditors, lienholders, etc.",ST1,7}, mortgagees, judgment 
creditors, lienholders, etc., by reason of Exception No(s). *. 

(8) The United States of America by reason of Exception No. *. NOTE: Compliance should be made with 
the provisions of Section 2410 of the Federal Judicial Code (28 U.S.C.) and Section 7425 of the Internal 
Revenue Code (26 U.S.C.) In connection therewith, the following information is furnished: 

The Notice of Tax Lien, noted at Exception No. *, was filed by the District Director of Internal Revenue 
at *, Illinois, against *, in the office of the Recorder of Deeds of * County, Illinois, on *, as Document 
No. *. 

NOTE: Attention is directed to the provisions in Section 2410 of the Federal Judicial Code requiring that 
any action to foreclose a lien naming the United States as a party under the Section "must seek a judicial 
sale." In the event a judicial sale is not sought in the contemplated proceeding, such proceeding will not 
affect the rights of the United States noted at Exception No(s). *, and the United States should not be 
made a party thereto. In addition, we note the consequences, if any, in favor of the United States that 
appear of record after the date of this commitment.  

[(9) The trustee in bankruptcy by reason of Exception No. *.] 

[(10) The right of redemption of the United States of America.] 

[(11) The right of redemption of the State of Illinois.] 

The real estate was last assessed for general real estate taxes to the following taxpayer: *. 

The proceedings will not affect the Standard Exceptions nor the exceptions noted in Schedule B at Nos. *, 
and the final policy or policies will be subject to such exceptions unless satisfactory disposition thereof is 
otherwise made.  

Tax Sale: Tax Deed Judgment  

We have examined the proceedings pending in the Circuit Court of {PR,"Enter name of County.",ST1,1} 
County, Illinois, in Case No. {PR,"Enter court case number.",ST1,2}, on a petition for tax deed pursuant 
to a tax sale of the land under the provisions of the Property Tax Code (35 ILCS 200/1-1, et seq.), and 
note the following: 

(a) The question of the willingness of ATG to insure title derived through the said proceedings should be 
submitted to an underwriting attorney of ATG, and this commitment, and any policies committed for 
thereunder, shall be subject to such further exceptions, if any, as may then be deemed necessary. 

(b) Right of any interested party by motion, appeal, petition, or other direct proceeding to have modified, 
set aside, or reversed the orders entered in Case No. {RP,2}, within the time allowed by law. 

(c) Right, by reason of military service, of any person interested in the subject matter of the proceedings 
in Case No.{RP,2} to redeem within the time permitted by the Soldiers’ and Sailors’ Civil Relief Act.  

Current (Wisconsin) 

The lien of taxes for the year {PR,"Enter Year",IN1,6} and thereafter. 

Parcel Identification Number: {DB,Property,TaxID,NO} Year {PR,"Enter Year",IN1,6} taxes of 
{PR,"Enter tax amount",CU1,4} are {PR,"Enter status of tax payment (paid in full, not paid, 
etc.)",ST1,8} {PR,"Enter Year",IN1,6} general real estate taxes are not yet due or payable. 

Remarks: {PR,"Enter any appropriate remarks or none",ST1,7}  

Tax Deed: Tax Deed Proceedings (Wisconsin) 

With respect to the {PR,"Enter annual, forfeiture, or scavenger.",ST1,1} tax sale of the land on 
{PR,"Enter date of tax sale.",DT2,2}, to {PR,"Enter name(s) of person/entity purchasing taxes.",ST1,3} 
[by virtue of the non-payment of the * general real estate taxes][for the non-payment of the forfeited 
general taxes for the year*][for the delinquent taxes for the years * to *], the following is noted: 
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(a) The question of the willingness of ATG to insure title derived through the tax deed proceeding should 
be submitted to an underwriting attorney of ATG. 

(b) A petition in conformity with the provisions of Wisconsin Property Tax Code should be filed in the 
Circuit Court of {PR,"Enter name of County.",ST1,4} County, Wisconsin, in the proceeding wherein the 
judgment of sale was entered, and, after due notice has been given to the persons entitled thereto, an order 
should be entered on said petition adjudicating that said petitioner has in all respects complied with the 
provisions of the Constitution of the State of Wisconsin and the Property Tax Code, entitling the 
certificate holder to a deed, and ordering and directing the County Clerk to execute and deliver a deed. 

(c) The deed should be issued and filed for record within the time provided by the Property Tax Code. 

(d) The notices and deeds issued pursuant to the proceeding should show the legal description and, where 
applicable, the permanent real estate index number. 

(e) Notice should be served on the persons set forth below in accordance with the Property Tax Code in 
the manner and within the time specified therein. NOTE: In the event that there are any persons who 
should be served with notices, but the names of such persons are unknown and unascertainable, then in 
that event only, such persons should be served with notice under the description of "Unknown owners or 
parties interested in said land or lots." 

(1) Any person, other than those herein named, known to the certificate holder or his or her 
attorney who may have or claim to have some interest in the land. 

(2) Unknown owners or parties interested in the land, generally. 

(3) The County Clerk of {RP,4} County, Wisconsin.  

(4) All persons in occupancy or actual possession of said land, which persons must be served 
personally. 

(5) {PR,"Enter name(s) of person holding Certificate of Sale.",ST1,5}, Certificate of Sale holder, 
as party plaintiff. 

(6) {PR,"Enter name(s) of owners of record, successors, etc.",ST1,6}, owner(s) of record, 
contract purchaser(s), etc. or successors in interest, as party(ies) defendant. 

(7) {PR,"Enter name(s) of mortgagees, creditors, lienholders, etc.",ST1,7}, mortgagees, judgment 
creditors, lienholders, etc., by reason of Exception No(s). *. 

(8) The United States of America by reason of Exception No. *. NOTE: Compliance should be 
made with the provisions of Section 2410 of the Federal Judicial Code (28 U.S.C.) and Section 
7425 of the Internal Revenue Code (26 U.S.C.) In connection therewith, the following 
information is furnished: 

The Notice of Tax Lien noted at Exception No. * was filed by the District Director of 
Internal Revenue at *, Wisconsin, against * in the office of the Register of Deeds of * 
County, Wisconsin *, as Document No. *. 

NOTE: Attention is directed to the provisions in Section 2410 of the Federal Judicial 
Code requiring that any action to foreclose a lien naming the United States as a party 
under the Section "… must seek a judicial sale." In the event a judicial sale is not sought 
in the contemplated proceeding, [such proceeding will not affect the rights of the United 
States noted at Exception No(s). *, and the United States should not be made a party 
thereto. In addition,] we note the consequences, if any, in favor of the United States that 
appear of record after the date of this commitment.  

[(9) The trustee in bankruptcy by reason of Exception No. *.] 

[(10) The right of redemption of the United States of America.] 

[(11) The right of redemption of the State of Wisconsin.] 

The real estate was last assessed for general real estate taxes to the following taxpayer: *. 
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The proceedings will not affect the Standard Exceptions nor the exceptions noted in 
Schedule B at Nos. *, and the final policy or policies will be subject to such exceptions 
unless satisfactory disposition thereof is otherwise made.  

Tax Sale: Tax Deed Judgment (Wisconsin) 

We have examined the proceedings pending in the Circuit Court of {PR,"Enter name of County.",ST1,1} 
County, Wisconsin, in Case No. {PR,"Enter court case number.",ST1,2}, on a petition for tax deed 
pursuant to a tax sale of the land under the provisions of the Property Tax Code, and note the following: 

(a) The question of the willingness of ATG to insure title derived through the said proceedings should be 
submitted to an underwriting attorney of ATG, and this commitment, and any policies committed for 
thereunder, shall be subject to such further exceptions, if any, as may then be deemed necessary. 

(b) Right of any interested party by motion, appeal, petition, or other direct proceeding to have modified, 
set aside, or reversed the orders entered in Case No. {RP,2}, within the time allowed by law. 

(c) Right, by reason of military service, of any person interested in the subject matter of the proceedings 
in Case No.{RP,2} to redeem within the time permitted by the Soldiers’ and Sailors’ Civil Relief Act.  

Lake County, Indiana  

The real estate tax information set out above is all that is currently available. As of May 7, 2004, the Lake 
Superior Court ruled the tax reassessment unconstitutional. This ruling is currently under appeal to the 
Indiana Supreme Court. ATG is not liable for any loss, damage, cost, or expense due to, or arising out of 
the present unavailability of accurate tax information, and this commitment, and any policies committed 
for thereunder, are subject to such further exceptions as may be deemed necessary.  

Lottery Tax Credit (Wisconsin) 

Any possible charge for reassessment of taxes pursuant to the Lottery Tax Credit.  

Rock Island  

Subject to the lien of any additional taxes for the year 2002 and thereafter, resulting from construction of 
new or additional improvements in such year, which are assessed in a subsequent year and added to a 
subsequent year’s tax bill.  

Rock Island County  

Taxes for the year {PR,"Enter the year which taxes are a lien",ST1,1} and thereafter:  

First Installment {PR,"Enter tax lien year here",ST1,2} taxes, in the amount of {PR,"Amount of 
FirstInstallment",CU1,3}, is {PR,"Enter tax status (i.e., Paid, Sold, Not Yet Due and Payable, 
",ST1,4}.Second Installment {PR,"Enter tax lien year here",ST1,9} taxes, in the amount of {PR,"Amount 
of Second Installment",CU1,5}, is {PR,"Enter tax staus",ST1,10}. Third Installment {PR,"Enter tax lien 
year here",ST1,11} taxes, in the amount of {PR,"Amount of Third Installment",CU1,6}, is {PR,"Enter tax 
status",ST1,12}. Fourth Installment {PR,"Enter tax lien year here",ST1,13} taxes, in the amount of 
{PR,"Amount of Fourth Installment",CU1,7}, is {PR,"Enter tax status",ST1,14}  

Taxes for the year {PR,"Enter current year",ST1,8} are not yet due and payable.  

Permanent Index No: {DB,Property,TaxID,NO}  

REAL TITLE  

Easements/Covenants/Utilities  

Subject to all Easements, Conditions, and Restrictions of Record.  

Terms, provisions, covenants, conditions and restrictions, easements, charges, assessments and liens 
provided in the Covenants, Conditions, and Restrictions Indenture, if any, attached to the Plat and made a 
part thereof, but omitting any Covenant, Condition, or Restriction, if any, based on race, color, religion, 
sex, handicap, familial status or national origin, unless and only to the extent that the Covenant, 
Condition, or Restriction (a) is exempt under Title 42 of the United States Code, or (b) relates to 
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handicap, but does not discriminate against handicapped persons, which does not contain a reversionary 
or forfeiture clause.  

REFINANCE/SELECT SERVICE  

Real Estate Taxes: Cook  

Note: Tax Payments should be made payable to: Cook County Collector, 118 North Clark Street, Room 
112, Chicago, Illinois 60602; Phone 312-443-5100.  

Real Estate Taxes: DuPage  

Note: Tax Payments should be made payable to: DuPage County Collector, 421 North County Farm 
Road, P.O. Box 787, Wheaton, Illinois 60189; Phone 630-682-7001; Due 6/1 & 9/1. 

Real Estate Taxes: Lake  

Note: Tax Payments should be made payable to: Lake County Collector, 18 North County Street, 
Waukegan, Illinois 60085; Phone 847-360-6363; Due 6/1 & 9/1.  

Real Estate Taxes: Kane  

Note: Tax Payments should be made payable to: Kane County Collector, 719 South Batavia Avenue, 
Geneva, Illinois 60134; Phone 630-232-3565; Due 6/1 & 9/1.  

Real Estate Taxes: McHenry 

Note: Tax Payments should be made payable to: McHenry County Collector, 2200 North Seminary 
Avenue, Woodstock, Illinois 60098; Phone 815-334-4260; Due 6/1 & 9/1.  

Real Estate Taxes: Will  

Note: Tax Payments should be made payable to: Will County Treasurer, 302 North Chicago Street, Joliet, 
Illinois 60432; Phone 815-740-4675; Due 6/1 & 9/1.  

Refinance  

Rights and interest of the spouse, if any, of title holder or person(s) taking title named in Schedule "A."  

Note: The present marital status of grantors herein named must be disclosed in any subsequent deed of 
conveyance and/or mortgage ATG is asked to insure, and their spouses, if any, must join in the execution 
of said instruments in order to release any homestead rights.  

All parties in title or taking title must execute the mortgage ATG is being asked to insure. If all parties in 
title do not execute said mortgage, the lender will take subject to any ownership interest of the non-
executing party in title.  

Subject to any unrecorded easements, covenants, conditions, or restrictions, as well as any building line 
restrictions not of record.  

Note: This exception will be waived by either of the following:  

(a) copy of an existing survey with an affidavit of no new improvements, which shall be submitted to 
ATG;  

(b) Affidavit in Lieu of Survey, which shall be submitted to ATG. If neither is submitted to ATG, this 
exception will not be waived and will remain on the final title policy.  

SANITARY DISTRICT  

Urbana & Champaign Sanitary District  

Subject property lies within the boundaries of the Urbana & Champaign Sanitary District, the City of 
{PR,"Cityof/Drainage District",ST1,1}, and is subject to all lawful orders issued and assessments levied 
in connection therewith.  
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SEARCH  

Certificate of Sale (Wisconsin) 

Right, title, and interest of {PR,"Enter name of purchaser.",ST1,1} under a certificate of sale dated 
{PR,"Insert date of certificate of sale.",DT2,2}, and recorded {PR,"Insert date of recording.",DT2,3}, as 
Document No. {PR,"Insert Document number.",ST1,4}, and issued pursuant to judgment of foreclosure 
entered {PR,"Insert date of foreclosure judgment.",DT2,7} in the case filed by {PR,"Insert name(s) of 
Plaintiff.",ST1,8} and against {PR,"Insert name(s) of Defendant.",ST1,9} in the Circuit Court of 
{PR,"Insert name of County.",ST1,10} County, Wisconsin, Case No. {PR,"Insert case number.",ST1,11}, 
and all persons claiming thereunder.  

Dedicated Road (Wisconsin) 

Rights of the public, the State of Wisconsin, and the municipality in and to so much of the land dedicated 
for road purposes by instrument dated {PR,"Insert date of document.",DT2,1}, and recorded {PR,"Insert 
date of recording.",DT2,2}, as Document No. {PR,"Insert Document number.",ST1,3}.  

Environmental Disclosure Document (Wisconsin) 

Environmental disclosure document for transfer of real property dated {PR,"Enter date environmental 
document was created.",DT2,1}, and recorded {PR,"Enter date environmental document was 
recorded.",DT2,2}, as Document No. {PR,"Enter environmental Document number.",ST1,3}, in the 
Register of Deeds Office of {PR,"Enter name of County where environmental document was 
recorded.",ST1,6} County, Wisconsin.  

Environmental Lien (Wisconsin) 

Environmental lien filed by {PR,"Enter name of entity filing the environmental lien.",ST1,1} against 
{PR,"Enter name of entity that environmental lien was filed against.",ST1,2} on {PR,"Enter date that 
environmental lien was filed.",DT2,3}, as Document No. {PR,"Enter environmental document 
number.",ST1,4}, in the office of the Register of Deeds of {PR,"Enter County where environmental lien 
was recorded.",ST1,7} County, Wisconsin, in the sum of {PR,"Enter amount of environmental lien in 
dollars and cents.",CU1,8}.  

Lien: Child Support (Wisconsin) 

Child support judgment filed against {PR,"Insert name of person(s) who received judgment 
here.",ST1,1}, in Case No. {PR,"Insert Case number here.",ST1,2}, in the Circuit Court of {PR,"Insert 
name of Countyhere.",ST1,3} County, Wisconsin, memorandum of which was recorded on {PR,"Insert 
date the judgment was recorded here.",DT2,4}, as Document No. {PR,"Insert Document number 
here.",ST1,5}.  

Lien: Mechanics’ (Wisconsin) 

Mechanics’ lien filed by {PR,"Insert name of person or company filing the lien here.",ST1,1} against 
{PR,"Insert the person(s) against whom the lien was filed here.",ST1,2} on {PR,"Insert the date the lien 
was filed here.",DT2,3}, as Document Number {PR,"Insert the Document number here.",ST1,6} in the 
office of the Register of Deeds of {PR,"Insert name of the county where the lien was recorded 
here.",ST1,7} County, Wisconsin, in the sum of {PR,"Insert the amount of the lien here.",CU1,8}.  

Lis Pendens (Wisconsin) 

Lis Pendens Notice dated {PR,"Insert date of lis pendens here.",DT2,1}, filed by {PR,"Insert name of 
person (s) filing the lis pendens here.",ST1,2} against {PR,"Insert name(s) of persons receiving the lis 
pendens here.",ST1,3} in Case No. {PR,"Insert case number here.",ST1,4}, in the Circuit Court of 
{PR,"Insert name of County here.",ST1,5} County, Wisconsin, and recorded on {PR,"Insert date of 
recording here.",DT2,6}, as Document No. {PR,"Insert Document number here.",ST1,9}.  
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Taxes: Real Estate (Wisconsin) 

The lien of taxes for the year {PR,"Insert current year",IN1,3} and thereafter. Year {PR,"Enter prior 
year",IN1,4} taxes of {PR,"Enter amount",CU1,5} are {PR,"PAID, UNPAID & DUE, NOT YET DUE & 
PAYABLE",ST1,6}. Year {PR,"Enter current year",IN1,7} are not yet due or payable.  

PIN No. {PR,"Enter PIN number for property",ST1,7}  

Commonly known as {PR,"Enter street address, city, state, and zip code for property.",ST1,8}  

Release Mortgage  

Release of Mortgage recorded {PR,"Enter Date Release Recorded",DT2,3} as Document No. {PR,"Enter 
the document number of the recorded release.",ST1,6} releasing the Mortgage recorded as Document No. 
{PR,"Enter the document number of the recorded mortgage.",ST1,6}.  

Release Lien  

Release of Lien recorded {PR,"Enter Date Release Recorded",DT2,3} as Document No. {PR,"Enter the 
document number of the recorded release.",ST1,6} releasing the Lien recorded as Document No. 
{PR,"Enter the document number of the recorded lien.",ST1,6}.  

Release Judgment  

Release of Judgment recorded {PR,"Enter Date Release Recorded",DT2,3} as Document No. {PR,"Enter 
the document number of the recorded release.",ST1,6} releasing the Judgment recorded as Document No. 
{PR,"Enter the document number of the recorded judgment.",ST1,6}.  

Later Date  

THE LATER DATE COVERS THE TIME PERIOD FROM {DB,CommitPolicy,CmtEdate,DT2}, TO 
{PR,"NEW EFFECTIVE DATE",DT2,2}. THE FOLLOWING INFORMATION APPEARS OF 
RECORD SUBSEQUENT TO THE ORIGINAL EFFECTIVE DATE OF THIS SEARCH.  

Taxes down  

ST. CLAIR COUNTY TAX INFORMATION SYSTEM CANNOT BE ACCESSED BECAUSE THEY 
ARE DOWNLOADING 2009 TAX INFORMATION. AS SOON AS THE SYTEM BECOMES 
AVAILABLE, WE WILL REVISE OUR SEARCH TO INCLUDE TAX INFORMATION.  

Release  

Release of Mortgage/Lien recorded {PR,"Enter Date Release Recorded",DT2,3}, as Document No. 
{PR,"Enter the document number of the recorded release.",ST1,6}, releasing the Mortgage/Lien recorded 
as Document No. {PR,"Enter the document number of the recorded mortgage/lien.",ST1,6}.  

Affidavit: General  

Affidavit of {PR,"Describe what kind of affidavit this is.",ST1,1} dated {PR,"What date was the affidavit 
executed?",DT2,2} and recorded on {PR,"What date was the affidavit recorded?",DT2,3}.  

Agreement: General  

Agreement for {PR,"What is the agreement for?",ST1,1} dated {PR,"What is the date of the 
agreement?",DT2,2}, and recorded {PR,"What is the date the agreement was recorded?",DT2,3}, as 
Document No. {PR,"What is the document number of the agreement?",ST1,4}  

Assignment of Rents  

Certificate of Sale  

Right, title, and interest of {PR,"Enter name of purchaser.",ST1,1} under a certificate of sale dated 
{PR,"Insert date of certificate of sale.",DT2,2}, and recorded {PR,"Insert date of recording.",DT2,3}, as 
Document No. {PR,"Insert Document number.",ST1,4}, and issued pursuant to judgment of foreclosure 
entered {PR,"Insert date of foreclosure judgment.",DT2,7} in the case filed by {PR,"Insert name(s) of 
Plaintiff.",ST1,8} and against {PR,"Insert name(s) of Defendant.",ST1,9} in the Circuit Court of 
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{PR,"Insert name of County.",ST1,10} County, Illinois, Case No. {PR,"Insert case number.",ST1,11}, 
and all persons claiming thereunder.  

Condominium Declaration  

Terms, provisions, covenants, conditions, and options in, rights and easements established by the 
Declaration of Condominium Ownership recorded {PR,"Enter date of Condominium Declaration 
recording.",DT2,1}, as Document No. {PR,"Enter Document number.",ST1,4}.  

Declaration  

Declaration of {PR,"What type of declaration is this?",ST1,1} dated {PR,"What is the date of 
thedeclaration?",DT2,2}, and recorded {PR,"What is the date the declaration was recorded?",DT2,3}, as 
Document No. {PR,"What is the Document Number of the declaration?",ST1,4}.  

Dedicated Road  

Rights of the public, the State of Illinois, and the municipality in and to so much of the land dedicated for 
road purposes by instrument dated {PR,"Insert date of document.",DT2,1}, and recorded {PR,"Insert date 
of recording.",DT2,2} as Document No. {PR,"Insert Document number.",ST1,3}.  

Deed into Trust without Powers  

The deed from {PR,"Enter name(s) of person giving deed.",ST1,1} to {PR,"Enter name(s) of person 
receiving deed.",ST1,2}, recorded {PR,"Enter date the deed was recorded.",DT2,3}, as Document No. 
{PR,"Enter recorded Document number of deed.",ST1,4}, does not disclose the terms and conditions of 
the trust. The trust agreement under which title is held, properly identified in writing by the grantor, the 
trustee, and the beneficiaries of the trust, should be submitted for examination, and this Commitment is 
subject to such additional exceptions, if any, as may then be deemed necessary.  

Deed of Conveyance  

{PR,"Enter type of Deed (Warranty, Quitclaim, etc.).",ST1,6} Deed dated {PR,"Enter date 
ofDeed.",DT2,1}, and recorded {PR,"Enter date the Deed was recorded.",DT2,2}, as Document No. 
{PR,"Enter recorded Document number.",ST1,5}, executed by {PR,"Enter name(s) of person granting the 
Deed.",ST1,6} and given to {PR,"Enter the name(s) of the person receiving the Deed.",ST1,7}.  

Deregistration  

Certificate of Deregistration dated {PR,"What was the date of the certificate of deregistration?",DT2,1}, 
and recorded {PR,"What is the date the certificate of deregistration was recorded?",DT2,2}, as Document 
No. {PR,"What is the document number of the deregistration certificate?",ST1,3} with Code of 
{PR,"Insert code of certificate of deregistration.",ST1,4}. 

Disabled Adult Case  

Proceedings pending in the Circuit Court of {PR,"Enter name of County.",ST1,1} County entitled Estate 
of {PR,"Enter name of disabled adult.",ST1,2}, a disabled adult, under Case No. {PR,"Enter Case 
number.",ST1,3}.  

Dissolution of Marriage Case  

Dissolution of marriage proceedings filed by {PR,"Insert name of Plaintiff here.",ST1,1} against  

{PR,"Insert name of Defendant here.",ST1,2} in the Circuit Court of {PR,"Insert name of County 
here.",ST1,3} County as Case No. {PR,"Insert Case number here.",ST1,4}.  

Easement  

Easement for {PR,"Enter the purpose of the easement.",ST1,1} as set forth in {PR,"Describe the 
document creating the easement.",ST1,2}, dated {PR,"Enter the date of the easement.",DT2,3}, and 
recorded {PR,"Enter the date the easement was recorded.",DT2,4}, as Document No. {PR,"Enter 
Document tnumber.",ST1,7}, from {PR,"Enter name(s) of person(s) granting easement.",ST1,8} to 
{PR,"Enter name(s) of person(s) receiving easement.",ST1,9}.  
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Environmental Disclosure Document  

Environmental disclosure document for transfer of real property, dated {PR,"Enter date environmental 
document was created.",DT2,1}, and recorded {PR,"Enter date environmental document was 
recorded.",DT2,2}, as Document No. {PR,"Enter environmental Document number.",ST1,3} in the 
Recorder’s Office of {PR,"Enter name of County where environmental document was recorded.",ST1,6} 
County, Illinois.  

Environmental Lien  

Environmental lien filed by {PR,"Enter name of entity filing the environmental lien.",ST1,1} against 
{PR,"Enter name of entity that environmental lien was filed against.",ST1,2} on {PR,"Enter date that 
environmental lien was filed.",DT2,3}, as Document No. {PR,"Enter environmental document 
number.",ST1,4}, in the office of the Recorder of {PR,"Enter County where environmental lien was 
recorded.",ST1,7} County, Illinois, in the sum of {PR,"Enter amount of environmental lien in dollars and 
cents.",CU1,8}.  

Flood Document  

Possible flood risks affecting the land and other land as disclosed by {PR,"Enter what type of recorded 
document is being reviewed.",ST1,1}, recorded {PR,"Enter date Document was recorded.",DT2,2}, as 
Document No. {PR,"Enter recorded Document number.",ST1,3}.  

Grant: General  

Grant of {PR,"What type of grant is this? Access? Easement? Etc.",ST1,1}, dated {PR,"What is the date 
of the grant?",DT2,2}, and recorded {PR,"When was the grant recorded?",DT2,3}, as Document No. 
{PR,"What is the document number of the grant?",ST1,4}.  

Installment Contract for Deed  

Terms, conditions and covenants of installment contract (or agreement for Warranty Deed) between 
{PR,"Enter name of Installment Contract Seller(s).",ST1,1} and {PR,"Enter name(s) of Installment 
ContractPurchaser.",ST1,2} dated {PR,"Enter date of Installment Contract.",DT2,3} [and recorded 
{PR,"Enter date Installment Contract was recorded.",DT2,4}, as Document No. {PR,"Enter Document 
number.",ST1,7}.]  

Lien: Chicago Transfer Tax  

Notice of lien claimed by the City of Chicago under the provisions of Section 3-33-120 of the Municipal 
Code against {PR,"Insert name of person(s) who owe the money.",ST1,1} in the sum of {PR,"Insert how 
much money they owe.",CU1,2}, which notice was recorded {PR,"Insert date the lien was 
recorded.",DT2,3}, as Document No. {PR,"Insert Document recording number.",ST1,6}. Also, every 
document transferring property in the City of Chicago must include the proper amount of transfer stamps 
or be marked exempt pursuant to one of the City of Chicago transfer tax exemptions.  

Lien: Child Support  

Child support judgment filed against {PR,"Insert name of person(s) who received judgment here.",ST1,1} 
in Case No. {PR,"Insert Case number here.",ST1,2}, in the Circuit Court of {PR,"Insert name of County 
here.",ST1,3} County, Illinois, a memorandum of which was recorded on {PR,"Insert date the judgment 
was recorded here.",DT2,4}, as Document No. {PR,"Insert Document number here.",ST1,5}.  

Lien: Federal  

Notice of lien claimed by the United States of America against {PR,"Insert name of person(s) who owes 
the money.",ST1,1} in the sum of {PR,"Insert how much money they owe.",CU1,2}, which notice was 
recorded {PR,"Insert date the lien was recorded.",DT2,3}, as Document No. {PR,"Insert recorded 
Document number.",ST1,6}.  

 
Page 14-66 ATG REsource® User Manual 
 © ATG (5/15) 



Lien: General  

Claim for lien, dated {PR,"Insert date of lien here.",DT2,1}, and recorded {PR,"Insert date the lien was 
recorded here.",DT2,2}, as Document Number {PR,"Enter recorded document number.",ST1,6} made by 
{PR,"Insert name of person(s) asserting lien here.",ST1,3} and filed against {PR,"Insert name of 
person(s)against whom the lien is made here.",ST1,4}, in the sum of {PR,"Insert the amount of the lien 
here.",CU1,5}.  

Lien: Judgment  

[Transcript][Certified copy][Memorandum] of judgment, recorded on {PR,"Insert date judgment was 
recorded here.",DT2,1}, as Document No. {PR,"Insert Document number here.",ST1,2}, for judgment 
rendered on {PR,"Insert date of judgment here.",DT2,5} in the {PR,"Insert name of court (circuit, 
appellate, etc.) here.",ST1,6} court of {PR,"Insert name of County here.",ST1,7} County, in favor of 
{PR,"Insert name(s) of winning person(s) here.",ST1,8}, against {PR,"Insert name(s) of losing person(s) 
here.",ST1,9}, in the amount of {PR,"Insert amount of judgment here in dollars and cents.",CU1,10}. 

Lien: Mechanics’  

Mechanics’ lien filed by {PR,"Insert name of person or company filing the lien here.",ST1,1} against 
{PR,"Insert the person(s) against whom the lien was filed here.",ST1,2} on {PR,"Insert the date the lien 
was filed here.",DT2,3}, and recorded {PR,"Insert the Date the Lien was Recorded",DT2,7}, as 
Document No. {PR,"Insert the Document number here.",ST1,6}, in the office of the Recorder of 
{PR,"Insert name of the county where the lien was recorded here.",ST1,7} County, Illinois, in the sum of 
{PR,"Insert the amount of the lien here.",CU1,8}.  

Lien: Mobile Home Tax  

Notice of Lien claimed by the County of {PR,"Enter name of County claiming the lien.",ST1,1} under the 
provisions of the Mobile Home Local Services Tax Act against {PR,"Enter name(s) of person who owes 
themoney.",ST1,2} in the sum of {PR,"Enter amount of money they owe.",CU1,3}, which Notice was 
recorded {PR,"Enter date the lien was recorded.",DT2,4}, as Document No. {PR,"Enter recorded 
Document number of the lien.",ST1,5}.  

Lien: Public Aid  

Notice of Lien claimed by the State of Illinois under the provisions of the Public Aid Code against 
{PR,"Insert name(s) of person who owes the money.",ST1,1}, in the sum of {PR,"Enter the amount of 
money they owe.",CU1,2}, which notice was recorded {PR,"Enter the date the lien was 
recorded.",DT2,3}, as Document No. {PR,"Enter the recorded Document number.",ST1,4}.  

Lien: State Income Tax  

Notice of lien claimed by the State of Illinois under the provisions of the Illinois Income Tax Act against 
{PR,"Insert name(s) of person who owes the money.",ST1,1}, in the sum of {PR,"Insert amount of 
money they owe.",CU1,2}, which notice was recorded {PR,"Insert date the lien was recorded.",DT2,3}, 
as Document No. {PR,"Insert Document number.",ST1,6}.  

Lien: State Sales Tax  

Notice of Lien claimed by the State of Illinois under the provisions of the Retailer’s Occupation Tax Act 
against {PR,"Enter name(s) of person who owes the money.",ST1,1}, in the sum of {PR,"Enter the 
amount of money they owe.",CU1,2}, which Notice was recorded {PR,"Enter the date the lien was 
recorded.",DT2,3}, as Document No. {PR,"Enter the recorded Document number.",ST1,4}.  

Lis Pendens  

Lis Pendens Notice, dated {PR,"Insert date of lis pendens here.",DT2,1}, filed by {PR,"Insert name of 
person(s) filing the lis pendens here.",ST1,2} against {PR,"Insert name(s) of persons receiving the lis 
pendens here.",ST1,3}, in Case No. {PR,"Insert case number here.",ST1,4}, in the Circuit Court of 
{PR,"Insert name of County here.",ST1,5} County, Illinois, and recorded on {PR,"Insert date of recording 
here.",DT2,6}, as Document No. {PR,"Insert Document number here.",ST1,9}.  
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Minor’s Estate Case  

Proceedings pending in the Circuit Court of {PR,"Enter name of County.",ST1,1} County entitled Estate 
of {PR,"Enter name of minor.",ST1,2}, a minor, under Case No. {PR,"Enter minor’s case 
number.",ST1,3}.  

Mortgage  

Mortgage, dated {PR,"Enter date of mortgage.",DT2,7}, and recorded {PR,"Date mortgage 
recorded",DT2,6}, as Document No. {PR,"Enter recorded mortgage document number.",ST1,6}, 
executed by {PR,"Enter name(s) of borrower(s).",ST1,4} and given to {PR,"Enter name of existing 
lender.",ST1,5} to secure a note in the amount of {PR,"Enter existing mortgage amount.",CU1,6}, and 
such other sums as provided therein.  

Mortgage: Assignment  

Assignment of the Mortgage, recorded as Document No. {PR,"Enter the recorded document number of 
the assigned mortgage.",ST1,6}, by {PR,"Enter name of original lender.",ST1,2} to {PR,"Enter name of 
Assignee, i.e., the new lender.",ST1,3}, dated {PR,"Enter date of assignment.",DT2,7}, and recorded 
{PR,"Enter the recording date of the assignment.",DT2,7}, as Document No. {PR,"Enter the document 
number of the recorded assignment.",ST1,6}.  

Plat of Subdivision  

Plat of {DB,Subdivision,Subdivision,NO} Subdivision, recorded {DB,Subdivision,FileDate,DT2}, as 
Document No. {DB,Subdivision,Plat,NO}.  

Power of Attorney  

Power of Attorney, dated {PR,"What was the date the POA was executed?",DT2,1}, and recorded 
{PR,"What was the date the POA was recorded?",DT2,2}, as Document No. {PR,"What was the POA 
document number?",ST1,3}.  

Probate Estate  

Proceedings pending in the Circuit Court of {PR,"Enter name of County.",ST1,1} County, entitled Estate 
of {PR,"Enter name of deceased person.",ST1,2}, Deceased, under Case No. {PR,"Enter case 
number.",ST1,3}.  

Real Estate Taxes  

Taxes for the year {PR,"Enter the previous year (YYYY).",IN1,1} and thereafter. First installment 
{RP,1} taxes, in the amount of {PR,"Enter amount of the 1st installment prior year taxes.",CU1,2}, are 
{PR,"Enter whether PAID, UNPAID & DUE, NOT YET DUE & PAYABLE.",ST1,3}. Second 
installment {PR,"Enter the previous year (YYYY)",ST1,9} taxes, in the amount of {PR,"Enter amount of 
2nd installment prior year taxes.",CU1,4}, are {PR,"Enter whether PAID, UNPAID & DUE, NOT YET 
DUE & PAYABLE.",ST1,5}. 

{PR,"Enter the current year (YYYY).",IN1,6} taxes not yet due and payable.  

PIN No. {PR,"Enter PIN number for property",ST1,7}.  

Rerecording  

Rerecording of {PR,"What kind of document is being rerecorded? ",ST1,1}, originally recorded on 
{PR,"When was the document originally recorded?",DT2,2}, as Document No. {PR,"What is the 
Document Number of the original recording?",ST1,3}, rerecorded on {PR,"What is the date the document 
was recorded?",DT2,4}, as Document No. {PR,"What is the Document no. of the rerecorded 
document?",ST1,5}.  

Sheriff’s Deed  

Right, title, and interest of {PR,"Enter name of person receiving deed.",ST1,1} under a Sheriff’s (Judge’s) 
Deed dated {PR,"Enter date of deed.",DT2,2}, and recorded {PR,"Enter date deed was 
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recorded.",DT2,3}, as Document No. {PR,"Enter Document number.",ST1,4}, and issued pursuant to 
judgment of foreclosure entered {PR,"Enter date judgment of foreclosure was entered.",DT2,7}, in the 
case filed by {PR,"Enter name(s) of Plaintiff.",ST1,8} and against {PR,"Enter name(s) of 
Defendant.",ST1,9} in the Circuit Court of {PR,"Enter name of County.",ST1,10} County, Illinois, Case 
No. {PR,"Enter case number.",ST1,11}, and all persons claiming thereunder.  

Special Assessments: None  

Special Assessments: None of Record.  

Special Assessments: Specific  

Special Assessments: {PR,"Type Special Assessment Information",ST1,1}.  

Subdivision Covenants  

Covenants, conditions, and restrictions contained in {PR,"Describe the type of document.",ST1,1}, dated 
{PR,"Enter date of covenants.",DT2,2}, and recorded {PR,"Enter recording date.",DT2,3}, as Document 
No. {PR,"Enter Document number.",ST1,6}, but omitting therefrom any covenant or restriction based on 
race, color, religion, sex, handicap, familial status, or national origin, relating to {PR,"Describe the nature 
of the restriction, if any.",ST1,7}.  

Subordination Agreement  

Subordination Agreement, dated {PR,"Insert date of subordination agreement here.",DT2,1}, and 
recorded {PR,"Insert date the subordination agreement was recorded here.",DT2,2}, as Document No. 
{PR,"Insert Document number here.",ST1,5}, made by {PR,"Insert name(s) of persons making agreement 
here.",ST1,6} and given to {PR,"Insert name(s) of persons receiving agreement here.",ST1,7}.  

Taxes: Forfeited  

{PR,"Enter which installment (1st, 2nd, etc.) is unpaid.",ST1,1} installment {PR,"Enter the year(YYYY) 
of the forfeited taxes.",IN1,2} taxes of {PR,"Enter the amount of the forfeited taxes.",CU1,3}, not paid 
and forfeited on {PR,"Enter the date when the taxes were forfeited.",DT1,4}.  

Taxes: Real Estate  

Taxes for the year {PR,"Enter the previous year (YYYY).",IN1,1} and thereafter. First installment 
{RP,1} taxes, in the amount of {PR,"Enter amount of the 1st installment prior year taxes.",CU1,2}, are 
{PR,"Enter whether PAID, UNPAID & DUE, NOT YET DUE & PAYABLE.",ST1,3}. Second 
installment {PR,"Enter the previous year (YYYY)",ST1,9} taxes, in the amount of {PR,"Enter amount of 
2nd installment prior year taxes.",CU1,4}, are {PR,"Enter whether PAID, UNPAID & DUE, NOT YET 
DUE & PAYABLE.",ST1,5}. 

{PR,"Enter the current year (YYYY).",IN1,6} taxes not yet due and payable.  

PIN No. {PR,"Enter PIN number for property",ST1,7}  

Commonly known as {PR,"Enter street address, city, state, and zip code for property.",ST1,8}  

Taxes: Sold  

{PR,"Enter which installment (1st, 2nd, etc.) were sold.",ST1,1} installment {PR,"Enter the year(YYYY) 
of the tax sold.",IN1,2} taxes of {PR,"Enter the amount of the taxes sold.",CU1,3} not paid and sold on 
{PR,"Enter the date the taxes were sold.",DT2,4} to {PR,"Enter the name(s) of the tax purchaser.",ST1,5} 
at {PR,"Enter the amount of interest the taxes sold for.",IN1,6}%.  

Township: General  

The property is located in {PR,"What is the name of the township this property is located in?",ST1,1}  

Trust Deed  

Trust Deed, dated {PR,"Enter date of Trust Deed.",DT2,1}, and recorded {PR,"Enter date the Trust Deed 
was recorded.",DT2,2}, as Document No. {PR,"Enter recorded Document number.",ST1,5}, executed by 
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{PR,"Enter name(s) of person granting the Trust Deed.",ST1,6} and given to {PR,"Enter the name(s) of 
the lender receiving the Trust Deed.",ST1,7} to secure a note in the amount of {PR,"Enter the dollar 
amount of the Trust Deed.",CU1,8}, and such other sums as provided therein.  

UCC Financing Statement  

Financing Statement (UCC-1), dated {PR,"Enter date of UCC statement.",DT2,1}, and recorded 
{PR,"Enter date the UCC statement was recorded.",DT2,2}, as Document No. {PR,"Enter recorded 
Document number of the UCC statement.",ST1,3}, made by {PR,"Enter name(s) of person giving the 
UCCstatement.",ST1,6}, as Debtor, and given to {PR,"Enter name(s) of lender/entity receiving the 
UCCstatement.",ST1,7}, as Secured Party.  

Vacated Streets and Alleys  

Reservation of easement contained in the ordinance of vacation, dated {PR,"Enter date of vacating 
ordinance.",DT2,1}, and recorded {PR,"Enter date vacating ordinance was recorded.",DT2,2}, as 
Document No. {PR,"Enter recorded Document number of vacating ordinance.",ST1,3} for the benefit of 
{PR,"Enter name(s) of person keeping easement.",ST1,6}.  

Wild Deed  

{PR,"Enter name of recipient of wild deed.",ST1,1} obtained title by mesne (intervening) conveyances 
from {PR,"Enter name of grantor in wild deed.",ST1,2}. We find no title in {RP,2}. This should be 
explained, and this commitment, and any policies committed for thereunder, shall be subject to such 
further exceptions as may then be deemed necessary.  

2005 Tax Information  

2005 Warrant Books are unavailable at this time; therefore, we cannot get updated 2005 tax information 
until further notice!  

Taxes: (Later Date)  

Taxes for the year {PR,"Enter the last year that taxes were paid (‘YYYY’).",IN1,1} and thereafter:  

First installment {PR,"Enter the previous year (‘YYYY’).",IN1,1} taxes, in the amount of {PR,"Enter 
amount of the 1st installment prior year taxes.",CU1,2}, is {PR,"Enter whether ‘PAID,’ ‘UNPAID AND 
DUE,’ ‘NOTYET DUE AND PAYABLE.’",ST1,3}. Second installment {PR,"Enter the previous year 
(‘YYYY’)",IN1,8} taxes, in the amount of {PR,"Enter amount of 2nd installment prior year 
taxes.",CU1,4}, is {PR,"Enter whether ‘PAID,’ ‘UNPAID AND DUE,’ ‘NOT YET DUE AND 
PAYABLE.’",ST1,5}.  

Taxes for the year {PR,"Enter the current year (YYYY).",IN1,6} are not yet due and payable.  

Permanent Index No. {DB,Property,TaxID,SN1}  

EXEMPTIONS: {PR,"Enter Type of Exemption & Amount",ST1,6}  

Taxes: Five Years (Madison)  

Taxes for the year {PR,"Enter the last year that taxes were paid (‘YYYY’).",IN1,1} and thereafter:  

First installment 2009 taxes, in the amount of {PR,"Enter the amount of 1st installment of tax",CU1,2}, is 
{PR,"PAID, UNPAID AND DUE 07/07/2010, OR SOLD",ST1,3}.Second installment 2009 taxes, in the 
amount of {PR,"Enter the amount of 2nd installment of tax",CU1,4}, is {PR,"PAID, UNPAID AND 
DUE 09/07/2010, OR SOLD",ST1,5}. Third installment 2009 taxes, in the amount of {PR,"Enter the 
amount of 3rd installment of tax",CU1,6}, is {PR,"PAID, UNPAID AND DUE 10/07/2010 OR 
SOLD",ST1,7}. Fourth installment 2009 taxes, in the amount of {PR,"Enter the amount of 4th installment 
of tax",CU1,8}, is {PR,"PAID, UNPAID AND DUE 12/07/2010, OR SOLD",ST1,9}.  

Taxes for the year 2008, in the amount of {PR,"Enter the 2008 tax amount",CU1,10}, are {PR,"PAID, 
SOLD OR REDEEMED AND DATE",ST1,11}. Taxes for the year 2007, in the amount of {PR,"Enter 
the 2007 tax amount",CU1,12}, are {PR,"PAID, SOLD OR REDEEMED AND DATE",ST1,13}. Taxes 
for the year 2006, in the amount of {PR,"Enter the 2006 tax amount",CU1,14}, are {PR,"PAID, SOLD 
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OR REDEEMED AND DATE",ST1,15}. Taxes for the year 2005, in the amount of {PR,"Enter the 2005 
tax amount",CU1,16}, are {PR,"PAID, SOLD OR REDEEMED AND DATE",ST1,17}.  

Taxes for the year {PR,"Enter the current year",ST1,18} are not yet due and payable.  

Permanent Index No. {DB,Property,TaxID,SN1}  

EXEMPTIONS: {PR,"Enter the exemptions on the property",ST1,19}. 

TOWNSHIP: {PR,"Enter the Township",ST1,20} 

LOT SIZE/ACREAGE: {PR,"Enter the lot size or acreage",ST1,21} 

ACCESS: {PR,"Enter the access street or road",ST1,22}  

Taxes: Madison Later Date 

Taxes for the year {PR,"Enter the last year that taxes were paid (‘YYYY’).",IN1,1} and thereafter:  

First installment 2008 taxes, in the amount of {PR,"Enter the amount of 1st installment of tax",CU1,2}, is 
{PR,"PAID, UNPAID AND DUE 08/06/2009, OR SOLD",ST1,3}. Second installment 2008 taxes, in the 
amount of {PR,"Enter the amount of 2nd installment of tax",CU1,4}, is {PR,"PAID, UNPAID AND 
DUE 10/06/2009, OR SOLD",ST1,5}. Third installment 2008 taxes, in the amount of {PR,"Enter the 
amount of 3rd installment of tax",CU1,6}, is {PR,"PAID, UNPAID AND DUE 11/06/2009 OR 
SOLD",ST1,7}. Fourth installment 2008 taxes, in the amount of {PR,"Enter the amount of 4th installment 
of tax",CU1,8}, is {PR,"PAID, UNPAID AND DUE 01/06/2010, OR SOLD",ST1,9}.  

Taxes for the year {PR,"Enter the current year",ST1,10} are not yet due and payable.  

Permanent Index No. {DB,Property,TaxID,SN1}  

EXEMPTIONS: {PR,"Enter the exemptions on the property",ST1,11}  

Letter Report (Effective Date)  

{PR,"Enter name of title company issuing letter teport",ST1,1}, has made a thorough search of the 
records at the courthouse of {PR,"Type County Name",ST1,2} County, as of {PR,"Type Effective Date 
of Search",DT2,3}, and we find the following:  

The vested owner(s) of the property is (are) {PR,"Type Name(s) of Vested Owner(s)",ST1,4}.  

Letter Report (Taxes/Assessments)  

The {PR,"Enter the last year the taxes were paid",IN1,1} tax, in the amount of {PR,"Enter full amount of 
taxes",CU1,2}, is {PR,"Enter ‘PAID’, ‘UNPAID AND DUE’, ‘SOLD’, ‘REDEEMED’",ST1,3}. All 
previous taxes have been paid.  

There are no special assessments showing open for the property referred to herein.  

Letter Report (Closing)  

This is a copy of our limited search of this title. This is not a title insurance commitment. Our liability for 
error is limited to the fee paid herefor.  

STREETS/ALLEYS  

Ordinance of Vacation  

Reservation of easement contained in the ordinance of vacation, dated {PR,"Enter date of vacating 
ordinance.",DT2,1}, and recorded {PR,"Enter date vacating ordinance was recorded.",DT2,2}, as 
Document No. {PR,"Enter recorded Document number of vacating ordinance.",ST1,3}, for the benefit of 
{PR,"Enter name(s) of person keeping easement.",ST1,6}.  
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Rights of Public  

Rights of the State of Illinois, the municipality, the public, and the adjoining landowners in and to the 
vacated {PR,"Enter ‘street’ or ‘alley’.",ST1,1} lying {PR,"Enter direction (North, South, etc.) of vacated 
alley/street.",ST1,2} and adjoining the insured land.  

Not Insured: Vacated Parcel  

This commitment, and any policy issued thereunder, shall not be construed as insuring any part of the 
vacated {PR,"Enter ‘street’ or ‘alley as appropriate.",ST1,1} lying {PR,"Enter direction (North, South, 
etc.) of the vacated land.",ST1,2} and adjoining the insured premises.  

Rights of Utilities  

Rights of public and quasi-public utilities, if any, in the vacated {PR,"Enter ‘street’ or ‘alley’ as the 
vacated land.",ST1,1} lying {PR,"Enter direction (North, South, etc.) of the vacated land.",ST1,2} and 
adjoining the insured land for the maintenance therein of poles, conduits, sewers, etc.  

Roads and Highways  

Rights of the public, the State of {DB,Property,State,NO}, the municipality, the county, and the township 
in and to that part of the premises in question taken, used, or dedicated for roads, streets, alleys, or 
highways.  

Rights of Public (Wisconsin) 

Rights of the State of Wisconsin, the municipality, the public, and the adjoining landowners in and to the 
vacated {PR,"Enter ‘street’ or ‘alley’.",ST1,1} lying {PR,"Enter direction (North, South, etc.) of vacated 
alley/street.",ST1,2} and adjoining the insured land.  

SUBDIVISIONS  

Building Setback  

A {PR,"Enter number of feet of size of setback.",ST1,1} foot building line from the {PR,"Enter direction 
(North, South, etc.) of the setback.",ST1,2} line of the property as shown on the Plat and recorded 
{PR,"Enter date of recording of Plat.",DT2,3} as Document No. {PR,"Enter Document number.",ST1,6}.  

Covenants and Restrictions  

Covenants, conditions, and restrictions contained in {PR,"Describe the type of document.",ST1,1}, dated 
{PR,"Enter date of covenants.",DT2,2}, and recorded {PR,"Enter recording date.",DT2,3}, as Document 
No. {PR,"Enter Document number.",ST1,6}, but omitting therefrom any covenant or restriction based on 
race, color, religion, sex, handicap, familial status, or national origin, relating to {PR,"Describe the nature 
of the restriction, if any.",ST1,7}.  

Covenants: Restrictions – Forfeiture  

NOTE: Instrument contains a provision for forfeiture or reversion of title in the event of breach thereof.  

Covenants: Restrictions – No Forfeiture  

NOTE: Instrument contains no provision for forfeiture or reversion of title in the event of breach thereof.  

Public Utility: General  

Easement over and upon the {PR,"Enter direction (North, South, etc.) of the easement.",ST1,1} 
{PR,"Enter number of feet of easement width onto land.",ST1,2} feet of the land for public utilities and 
drainage as shown on the Plat and recorded {PR,"Enter date of recording of easement.",DT2,3}, as 
Document No.{PR,"Enter Document number.",ST1,6}.  

Public Utility: Specific  

Easement over the {PR,"Enter the direction (North, South, etc.) of the easement.",ST1,1}{PR,"Enter the 
number of feet of the easement.",ST1,2} feet of the land for the purpose of installing and maintaining all 
equipment necessary for the purpose of serving the Subdivision and other property with telephone and 
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electric service, together with the right to overhang aerial service wires and also with right of access 
thereto and for the purpose of installation, maintenance, relocation, and removal of gas mains and 
appurtenances as granted to Illinois Bell Telephone Company, Commonwealth Edison Company, and 
Northern Illinois Gas Company, and their respective successors and assigns and as shown on the Plat of 
Subdivision and recorded {PR,"Enter date easement recorded.",DT2,3}, as Document No. {PR,"Enter 
Document number.",ST1,6}.  

SURVEY  

Exceptions  

This company should be furnished a survey of the premises insured and this commitment is subject to 
such other matters as may then appear.  

Facts that an accurate survey or personal inspection of the property disclosed or would have disclosed.  

Easements  

Easements, or claims of easements, not shown by the Public Records.  

Survey Exception: Policy  

Encroachments, overlaps, boundary line disputes, and any matters that would be disclosed by an accurate 
survey and inspection of the premises.  

Survey Exception: Commitment  

The company should be furnished a survey of the premises to be insured and this commitment is subject 
to such matters as may be disclosed.  

Standard Exceptions 1-3  

Rights or claims of parties in possession not shown by the Public Records.  

Any encroachment, encumbrance, violation, or adverse circumstance affecting the Title that would be 
disclosed by an accurate and complete land survey of the Land. The term "encroachment" includes 
encroachments of existing improvements located on the Land onto adjoining land, and encumbrances 
onto the Land of existing improvements located on adjoining land.  

Easements, or claims of easements, not shown by the Public Records.  

TRUSTS  

Land Trust  

Terms, powers, provisions, and limitations of the trust under which title to the property is held.  

Living Trusts  

A properly certified copy of the original trust agreement, under which title to the land is held, together 
with a statement in writing by the trustee that it will produce the original agreement upon request, should 
be furnished, and this commitment is subject to such further exceptions, if any, as may be deemed 
necessary.  

ATG should be advised as to whether the trust under which title to the land is held is still in force and 
effect, and this commitment is subject to such further exceptions, if any, as may be deemed necessary.  

Terms, powers, provisions, and limitations of the trust under which title to the land is held.  

UNSUBDIVIDED/VACANT  

Plat Act  

In the event any future conveyances of the premises in question would divide the subject premises into 
two or more parts, any part of which is less than five acres, compliance must be made with the Plat Act.  
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Right of Way: Roads and Highways  

Rights of the public, State of {DB,Property,State,NO}, and the municipality in and to that part of the 
premises in question taken, used, or dedicated for roads, streets, alleys, or highways.  

Right of Way: Drainage Tiles  

Rights of way for drainage tiles, ditches, feeders, and laterals.  

WATERWAYS  

Meandered Lake/River  

Rights, if any, of the United States of America, the State of Illinois, the municipality, and the public in 
and to so much of the land, if any, as may have been formed by means other than natural accretions or 
may be covered by the waters of {PR,"Enter name of lake, river, creek, or stream.",ST1,1}.  

Flood Risks  

Possible flood risks affecting the land and other land as disclosed by {PR,"Enter what type of recorded 
document is being reviewed.",ST1,1}, recorded {PR,"Enter date Document was recorded.",DT2,2} as 
Document No. {PR,"Enter recorded Document number.",ST1,3}.  

Private Rights  

Rights of the adjacent property owners in and to the free and unobstructed flow of the waters of 
{PR,"Enter name of lake, river, creek or stream.",ST1,1}, a part of which is located adjacent to or within 
the insured premises.  

Public Rights  

Rights of the United States of America, the State of Illinois, the municipality, and the public in and to that 
part of the land lying, from time to time, within the bed of {PR,"Enter name of lake, river, creek or 
stream.",ST1,1}; and the rights of other owners of land bordering on the lake in respect to the water of 
said lake.  

Public Rights (Wisconsin) 

Rights of the United States of America, the State of Wisconsin, the municipality, and the public in and to 
that part of the land lying, from time to time, within the bed of {PR,"Enter name of lake, river, creek or 
stream.",ST1,1}; and the rights of other owners of land bordering on the lake in respect to the water of 
said lake.  

Meandered Lake/River (Wisconsin) 

Rights, if any, of the United States of America, the State of Wisconsin, the municipality, and the public in 
and to so much of the land, if any, as may have been formed by means other than natural accretions or 
may be covered by the waters of {PR,"Enter name of lake, river, creek, or stream.",ST1,1}.  

WELLER CREEK  

Drainage District  

Said premises are subject to Weller Creek Drainage District, Document No. 40014. Satisfied to date, no 
annual benefit for current year.  

WISCONSIN  

Exception: Bankruptcy - Statutory Powers  

Statutory rights, powers, and duties of the Trustee in Bankruptcy in the bankruptcy proceeding filed by 
{PR,"Enter name(s) of person filing bankruptcy",ST1,1} on {PR,"Enter date of bankruptcy 
filing",DT2,2}, in the Federal District Court for the {PR,"Enter name (i.e., Western) of bankruptcy 
court.",ST1,3} District of Wisconsin in Case No. {PR,"Enter case number of bankruptcy",ST1,4}, notice 
of which was recorded on {PR,"Enter date of recording of bankruptcy notice",DT2,5}, as Document 
{PR,"Enter recorded document number",ST1,6}.  
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Exception: Trusts - Terms and Limitations  

Terms, powers, provisions, and limitations of the trust under which title to the land is held.  

Exception: Condominium Conversion Construction Loan Policy Exceptions  

Terms, provisions, covenants, conditions, and options in, rights and easements established by the 
Declaration of Condominium Ownership recorded as Document No. {PR,"Enter Document 
Number",IN1,1}, as amended from time to time, its bylaws, and association rules.  

Limitations and conditions imposed by Wisconsin Statutes Chapter 703, referred to as the Wisconsin 
Condominium Ownership Act.  

Any lien, or right to a lien, for services, labor, or material heretofore or hereafter furnished, imposed by 
law, and not shown by the public records, including, without limiting the generality of the foregoing, liens 
or rights to a lien arising from contracts in connection with the construction of improvements or 
conversion of the existing building or buildings on the land to a condominium.  

This commitment is subject to the review and approval of the condominium declaration and plat by the 
Underwriting Department of ATG.  

This commitment is subject to such additional exceptions, if any, as may be disclosed upon a search of the 
public records covering the period after the effective date of this commitment and through the date of 
recording of the condominium declaration and plat.  

Requirement: Condominium Assessment Certificate  

Furnish ATG with a certificate, executed and acknowledged by an officer or agent of the Condominium 
Association or a Director of the Executive Board, stating that the unit has no unpaid assessments for 
common area expenses or penalties, there are no condominium assessment liens, and there are no 
outstanding or contemplated special assessments.  

Furnish ATG with a certificate, executed and acknowledged by an officer or agent of the Condominium 
Association or a Director of the Executive Board stating the Condominium Association has no right of 
first refusal or the right of first refusal has been waived; that during the period of sixth months preceding 
the date hereof that no work has been done or improvements made to the common elements that could 
result in a lien being filed against the Condominium Association, except as identified in the certificate.  

Exception: New Condominium – Construction Loan Policy Exceptions  

Terms, provisions, covenants, conditions, and options in, rights and easements established by the 
Declaration of Condominium Ownership recorded, as Document No. {PR,"Enter Document 
Number",IN1,1}, as amended from time to time, its bylaws, and association rules.  

Limitations and conditions imposed by Wisconsin Statutes Chapter 703, referred to as the Wisconsin 
Condominium Ownership Act.  

This commitment is subject to the review and approval of the Condominium Declaration and plat by the 
Underwriting Department of ATG.  

This commitment is subject to such additional exceptions, if any, as may be disclosed upon a search of the 
public records covering the period after the effective date of this commitment and through the date of 
recording of the condominium declaration and plat.  

Exception: Corporation Domestic - Active 

Any delinquent income or franchise taxes that may be due and payable to the State of Wisconsin.  

Exception: Domestic Corporation - Dissolved  

{PR,"Enter name of dissolved Wisconsin corporation.",ST1,3}, a Wisconsin Corporation, was dissolved 
on {PR,"Enter date of dissolution of Wisconsin corporation.",DT2,4}. We note the following with respect 
thereto and this Commitment is subject to the following exceptions:  

(1) Rights of the creditors of said corporation, including the United States of America;  
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(2) Right, title, and interest of the stockholders/members of said corporation and those claiming under 
them.  

(3) Any delinquent income or franchise taxes that may be due and payable to the State of Wisconsin.  

Exception: Foreign Corporation - Active 

Any delinquent income or franchise taxes that may be due and payable to the State of Wisconsin.  

Exception: Foreign Corporation - Dissolved  

{PR,"Enter name of dissolved foreign corporation.",ST1,1}, a corporation of {PR,"Enter state where 
dissolved foreign corporation was formed.",ST1,2}, was dissolved by {PR,"Who (i.e., 
members/stockholders/State) dissolved the foreign corporation?",ST1,3}, on {PR,"Enter date of foreign 
corporate dissolution.",DT2,4}. We note the following with respect thereto and this commitment is 
subject to the following exceptions:  

(1) Rights of the creditors of said corporation, including the United States of America. 

(2) Statutory conditions and limitations, if any, imposed by the laws of the State of {RP,2} upon 
conveyances by the successors in title to the real estate of said corporation.  

(3) Any delinquent income or franchise taxes that may be due and payable to the State of Wisconsin.  

Exception: Disabled Person - General  

Proceedings pending in the Circuit Court of {PR,"Enter name of County.",ST1,1} County, entitled Estate 
of {PR,"Enter name of disabled person.",ST1,2}, a disabled person, under Case No. {PR,"Enter disabled 
person’s case number.",ST1,3}.  

Any conveyance of the land must be made by the guardian of the Estate of {PR,"Enter name of disabled 
person.",ST1,1}, a disabled person, pursuant to a proper order entered in Case No. {PR,"Enter minor’s 
case number.",ST1,2}, and such conveyance should recite that the same is executed pursuant to a proper 
order entered in Case No. {RP,2}, ordering the conveyance, and should recite therein the full 
consideration for which it is given. In addition, the guardian should file any bond required by Section 
880.13 of the Wisconsin Statutes.  

Statutory right, powers, and duties of the guardian of the Estate of {PR,"Enter name of disabled 
person.",ST1,1}, a disabled person.  

Exception: Decedents - General  

Claims against the estate of {PR,"Enter name(s) of Decedent(s).",ST1,1}, deceased.  

Federal and Wisconsin estate taxes that may be charged against the estate of {PR,"Enter name of 
deceased person.",ST1,1}.  

Statutory rights, powers, and duties of the personal representative of the decedent if and when appointed.  

Requirement: Environmental Lien 

Environmental lien filed pursuant to Chapter 292 of the Wisconsin Statutes by {PR,"Enter name of entity 
filing the environmental lien.",ST1,1} against {PR,"Enter name of entity that environmental lien was filed 
against.",ST1,2} on {PR,"Enter date that environmental lien was filed.",DT2,3}, as Document No. 
{PR,"Enter environmental document number.",ST1,4}, in the office of the Register of Deeds of 
{PR,"Enter County where environmental lien was recorded.",ST1,7} County, Wisconsin, in the sum of 
{PR,"Enter amount of environmental lien in dollars and cents.",CU1,8}.  

Exception: Foreclosure - Post Sheriff’s Deed  

Right, title, and interest of {PR,"Enter name of person receiving deed.",ST1,1} under a sheriff’s (judge’s) 
deed, dated {PR,"Enter date of deed.",DT2,2}, and recorded {PR,"Enter date deed was 
recorded.",DT2,3}, as Document No. {PR,"Enter Document number.",ST1,4}, and issued pursuant to 
judgment of foreclosure, entered {PR,"Enter date judgment of foreclosure was entered.",DT2,7}, in the 
case filed by {PR,"Enter name(s) of Plaintiff.",ST1,8} and against {PR,"Enter name(s) of 
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Defendant.",ST1,9} in the Circuit Court of {PR,"Enter name of County.",ST1,10} County, Wisconsin, 
Case No. {PR,"Enter casenumber.",ST1,11}, and all persons claiming thereunder.  

Requirement: Foreclosure Commitment Amount of Insurance 

The Amount of Insurance shown in paragraph 1 of Schedule A hereof must be increased in an amount 
equivalent to the full value of the subject premises before the policy will be issued. At such time, an 
additional charge will be made in conformity with the established rates.  

Requirement: Domestic L.L.C., - Active/Authority  

Furnish ATG with satisfactory evidence that the proposed deed or mortgage has been approved by a 
majority of the members of {PR,"Enter name of LLC",ST1,1}, a Wisconsin Limited Liability company, 
which approval should name the member or members authorized to execute the forgoing documents.  

Furnish ATG with a certificate of status from the Wisconsin Department of Financial Institutions 
verifying the authority to transact business in Wisconsin. The failure to produce the certificate will result 
in the policy or policies to be issued to contain the following exception: "Consequences, if any, that may 
result because of the failure of the party in title to the estate or interest in the land described in Schedule A 
to comply with the applicable ‘doing business’ laws of the State of Wisconsin."  

Requirement: General Lien 

Notice of {PR,"Liens: Enter the type of lien (e.g., ‘Wisconsin Income Tax’):",ST1,1} lien in favor of 
{PR,"Liens: Enter the entity who filed the lien:",ST1,3} and against {PR,"Liens: Enter the entity against 
whom the lien was filed:",ST1,2} in the sum of {PR,"Liens: Enter the amount of the lien:",CU1,4}, and 
recorded on {PR,"Liens: Enter the recording date of the lien:",DT2,5}, as Document Number {PR,"Liens: 
Enter the document number of the recorded lien:",ST1,6}.  

Requirement: Mechanics’ Lien 

Mechanics’ lien filed by {PR,"Insert name of person or company filing the lien here.",ST1,1} against 
{PR,"Insert the person(s) against whom the lien was filed here.",ST1,2} on {PR,"Insert the date the lien 
was filed here.",DT2,3}, as Document Number {PR,"Insert the Document number here.",ST1,6} in the 
office of the Register of {PR,"Insert name of the county where the lien was recorded here.",ST1,7} 
County, Wisconsin, in the sum of {PR,"Insert the amount of the lien here.",CU1,8}.  

Exception: Lis Pendens Proceedings  

Lis Pendens Notice, dated {PR,"Insert date of lis pendens here.",DT2,1}, filed by {PR,"Insert name of 
person(s) filing the lis pendens here.",ST1,2} against {PR,"Insert name(s) of persons receiving the lis 
pendens here.",ST1,3}, in Case No. {PR,"Insert case number here.",ST1,4}, in the Circuit Court of 
{PR,"Insert name of County here.",ST1,5} County, Wisconsin, and recorded on {PR,"Insert date of 
recording here.",DT2,6}, as Document No. {PR,"Insert Document number here.",ST1,9}.  

NOTE: No examination of these proceedings has been made and, upon examination, this commitment, 
and any policies committed for thereunder, shall be subject to such other and further exceptions as may 
then be deemed necessary.  

Exception: Minor’s Estate - General  

Proceedings pending in the Circuit Court of {PR,"Enter name of County.",ST1,1} County, entitled Estate 
of {PR,"Enter name of minor.",ST1,2}, a minor, under Case No. {PR,"Enter minor’s case 
number.",ST1,3}.  

Any conveyance of the land must be made by the guardian of the Estate of {PR,"Enter name of 
minor.",ST1,1}, a minor, pursuant to a proper order entered in Case No. {PR,"Enter minor’s case 
number.",ST1,2}, and such conveyance should recite that the same is executed pursuant to a proper order 
entered in Case No. {RP,2}, ordering the conveyance, and should recite therein the full consideration for 
which it is given. In addition, the guardian should file any bond required by the court under Section 
880.13 of the Wisconsin statutes.  
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Statutory right, powers, and duties of the guardian of the Estate of {PR,"Enter name of minor.",ST1,1}, a 
minor.  

Exception: Schedule B Part II Subordination of Mortgage  

SCHEDULE B-II, PART II  

In addition to the matters set forth in Part B-I of this schedule, the title to the estate or interest described 
or referred to in Schedule A is subject to the following matters, but ATG insures that such matters are 
subordinate to the lien or charge of the mortgage upon said estate or interest:  

Mortgage, dated {PR,"Enter date of mortgage.",DT2,7}, and recorded {PR,"Enter mortgage 
recordingdate.",DT2,7}, as Document No. {PR,"Enter recorded mortgage document number.",ST1,6}, 
executed by {PR,"What are the borrowers name(s)?",ST1,6} and given to {PR,"Enter name of existing 
lender.",ST1,5} to secure a note in the amount of {PR,"Enter existing mortgage amount.",CU1,7}, and 
such other sums as provided therein.  

Requirement: Assignment of Mortgage  

Assignment of Mortgage from {PR,"Enter name of original lender",ST1,1} to {PR,"Enter name of lender 
receiving assignment.",ST1,2}, dated {PR,"Enter the date of the assignment",DT2,5}, and recorded 
{PR,"Enter recording date of assignment",DT2,5}, as Document No. {PR,"Enter Document number of 
Assignment.",ST1,3}, which assigns the Mortgage recorded as Document No.{PR,"Enter Document No 
of assigned Mortgage",ST1,4}.  

Exception: Riparian - Meandering Lake/River  

Rights, if any, of the United States of America, the State of Wisconsin, the municipality, and the public in 
and to so much of the land, if any, as may have been formed by means other than natural accretions or 
may be covered by the waters of {PR,"Enter name of lake, river, creek, or stream.",ST1,1}.  

Exception: Riparian - Public Rights  

Rights of the United States of America, the State of Wisconsin, the municipality, and the public in and to 
that part of the land lying, from time to time, within the bed of {PR,"Enter name of lake, river, creek 
orstream.",ST1,1}; and the rights of other owners of land bordering on the lake in respect to the water of 
said lake.  

Exception: Real Estate Taxes- Installment Payments  

Taxes for the year {PR,"Enter the year that taxes are a lien (‘YYYY’).",IN1,1} and thereafter: First 
installment {PR,"Enter the current or previous year (‘YYYY’).",IN1,1} taxes, in the amount of 
{PR,"Enter amount of the 1st installment prior year taxes.",CU1,2}, is {PR,"Enter whether ‘PAID,’ 
‘UNPAIDAND DUE,’ ‘NOT YET DUE AND PAYABLE.’",ST1,3}. Second installment {PR,"Enter the 
current or previous year (‘YYYY’)",IN1,8} taxes, in the amount of {PR,"Enter amount of 2nd installment 
prior year taxes.",CU1,4}, is {PR,"Enter whether ‘PAID,’ ‘UNPAIDAND DUE,’ ‘NOT YET DUE AND 
PAYABLE.’",ST1,5}. 

Taxes for the year {PR,"Enter the current year (YYYY).",IN1,6} are not yet due and payable.  

Tax Key No. {DB,Property,TaxID,NO}  

Requirement: B1 - Deed only  

a) {PR,"Enter Type of Deed (Warranty, Personal Representative, etc.)",ST1,1} from 
{DB,SellerInfo,FormalName,NO} to {DB,BuyerInfo,FormalName,NO}.  

Note: The proposed instrument of conveyance should designate the subject property as non-homestead, 
identify the grantor/mortgagor as a single person, or be joined in by the grantor’s/mortgagor’s spouse and 
have their marital status typed thereon.  

Note: The buyer(s) should inform ATG how legal title will be held.  
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Note: A Wisconsin Real Estate Transfer Return form will need to be completed by the parties in order to 
record the conveyance document.  

Exception: Mortgage - New  

Mortgage, dated {PR,"Date of Mortgage",DT2,1}, and recorded {PR,"Date of Recording",DT2,2}, as 
Document No. {PR,"Document Number",ST1,3}, executed by {DB,CommitPolicy,MortBorrower,NO}, 
and given to {DB,CommitPolicy,MortInsured,NO}, to secure a note in the amount of 
{DB,Main,LoanAmount,CU1}, and such other sums as provided therein.  

Requirement: B1- Mortgage Only  

a) Mortgage from {DB,BuyerInfo,FormalName,NO} to {DB,Lender,Name,NO}, in the amount of 
{DB,Main,LoanAmount,CU1}.  

Exception: Existing Condominium- Construction Loan Policy Exceptions  

Terms, provisions, covenants, conditions, and options in, rights and easements established by the 
Declaration of Condominium Ownership recorded, *, as Document No. {PR,"Enter Document 
Number",IN1,1}, as amended from time to time, its bylaws, and association rules.  

Limitations and conditions imposed by Wisconsin Statutes Chapter 703, referred to as the Wisconsin 
Condominium Ownership Act.  

Requirement: Satisfaction of Existing Mortgage 

Satisfaction of Mortgage, dated {PR,"Enter Date of Mortgage",DT2,1}, and recorded {PR,"Enter date 
mortgage was recorded",DT2,2}, as Document No. {PR,"Enter Document No. of mortgage",ST1,3}, 
executed by {PR,"Enter name(s) of Mortgagor(s)",ST1,4}, and given to {PR,"Enter Name of 
mortgagee",ST1,5}, to secure a note in the amount of {PR,"Enter amount of mortgage",CU1,6}, and such 
other sums as provided therein.  

Note: Deed - Homestead Designation  

Note: The proposed instrument of conveyance should designate the subject property as non-homestead, 
identify the grantor/mortgagor as a single person, or be joined in by the grantor’s/mortgagor’s spouse and 
have their marital status typed thereon.  

Exception: Foreign Corporation - Not for Profit  

A certified copy of the charter and amendments thereto, if any, and of the bylaws of the corporation in 
title should be furnished, and this Commitment is subject to such further exceptions, if any, as may then 
be deemed necessary. Upon a conveyance or mortgage of the land, a certified copy of proper resolutions, 
passed by the stockholders and directors of the party in title in conformity with the laws of the State of 
{PR,"Enter State of foreign incorporation.",ST1,1}, authorizing the execution of the deed of conveyance 
or mortgage should be furnished.  

The certificate of authority of {PR,"Enter name of foreign Corporation.",ST1,2} to do business in 
Wisconsin issued by the Department of Financial Institutions should be produced, and in default thereof, 
our policy will contain the following exception:  

"Consequences, if any that may result because of the failure of the party in title to the estate or interest in 
the land described in Schedule A to comply with the applicable ‘doing business’ laws of the State of 
Wisconsin."  

Requirement: Foreign Corporation – Active/Authority 

Furnish ATG with a certified copy of the proper resolutions passed by the stockholders or board of 
directions authorizing the execution of the deed or mortgage, and this commitment and any policies 
committed for thereunder, are subject to such further exceptions as may then be deemed necessary.  

Furnish ATG with a certificate of status from the Wisconsin Department of Financial Institutions 
verifying the authority to transact business in Wisconsin. The failure to produce the certificate will result 
in the policy or policies to be issued to contain the following exception: "Consequences, if any, that may 
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result because of the failure of the party in title to the estate or interest in the land described in Schedule A 
to comply with the applicable ‘doing business’ laws of the State of Wisconsin."  

Requirement: Foreign Corporation – Dissolved/Authority  

Furnish ATG with a certified copy of the Articles of Dissolution that was issued by the incorporators or 
board of directors authorizing the execution of a deed to sell the corporation’s real property or furnish 
ATG with a certified list of all of the successors in title to the real estate of said corporation and this 
commitment is subject to such further exceptions, if any, as may then be deemed necessary.  

Exception: Domestic L.L.C. - Active  

Any delinquent income or franchise taxes that may be due and payable to the State of Wisconsin.  

Requirement: Domestic L.L.C. - Dissolved/Authority  

Furnish ATG with a certified copy of the Articles of Dissolution authorizing the manager(s) or member(s) 
to execute a deed to sell the LLC’s real property or furnish ATG with a certified list of all of the 
successors in title to the real estate of said LLC, and this Commitment is subject to such further 
exceptions, if any, as may then be deemed necessary.  

Exception: Foreign L.L.C. – Active  

Any delinquent income or franchise taxes that may be due and payable to the State of Wisconsin.  

Requirement: Foreign L.L.C. - Active/Authority 

Furnish ATG with a certified copy of the proper resolutions passed by the stockholders or board of 
Directions authorizing the execution of the deed or mortgage, and this commitment, any policies 
committed for thereunder, are subject to such further exceptions as may then be deemed necessary.  

Furnish ATG with a certificate of status from the Wisconsin Department of Financial Institutions 
verifying the authority to transact business in Wisconsin. The failure to produce the certificate will result 
in the policy or policies to be issued to contain the following exception: "Consequences, if any, that may 
result because of the failure of the party in title to the estate or interest in the land described in Schedule A 
to comply with the applicable ‘doing business’ laws of the State of Wisconsin."  

Note: Deed - Buyer’s Designation of Legal Title 

Note: The buyer(s) should inform ATG how legal title will be held.  

Requirement: Foreign L.L.C. - Dissolved/Authority 

Furnish ATG with a certified copy of the Articles of Dissolution authorizing the manager(s) or member(s) 
to execute a deed to sell the L.L.C.’s real property or furnish ATG with a certified list of all of the 
successors in title to the real estate of said L.L.C., and this commitment is subject to such further 
exceptions, if any, as may then be deemed necessary. 

Exception: Vacated Streets and Alleys 

Easements, if any, of the public or any school district, utility, municipality, or person, as provided in 
Section 80.32 (4) of the Statutes, for the continued use and right of entrance, maintenance, construction, 
and repair of underground structures, improvements, or service in that portion of the premises described 
in Schedule A hereof, which were formerly a part of streets and alleys now vacated.  

Requirement: Foreclosure Pending - Post Lis Pendens  

An action for mortgage foreclosure is pending in Case No. {PR,"Insert case number",ST1,1}, in the 
Circuit Court of {PR,"Insert county",ST1,2} County, Wisconsin, to foreclose the lien recorded as 
Document Number {PR,"Insert documentnumber",IN1,3}. In order to complete the sale of the premises, 
the following items must be completed:  

1. A discharge of Lis Pendens; 

2. An order dismissing the Circuit Court action; 
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3. If a judgment of foreclosure was entered, an order satisfying the judgment; 

4. If a sheriff’s sale was held, an order vacating the sheriff’s sale; 

5. If an order confirming the sheriff’s sale was entered, an order vacating the order. 

Requirement: Domestic Corporation - Active/Authority 

Furnish ATG with a certified copy of the proper resolutions passed by the stockholders or board of 
directors authorizing the execution of the deed or mortgage, and this commitment, any policies committed 
for thereunder, are subject to such further exceptions as may then be deemed necessary.  

Furnish ATG with a certificate of status from the Wisconsin Department of Financial Institutions 
verifying domestic incorporation in the State of Wisconsin. The failure to produce the certificate will 
result in the policy or policies to be issued to contain the following exception: "Consequences, if any, that 
may result because of the failure of the party in title to the estate or interest in the land described in 
Schedule A to comply with the applicable ‘doing business’ laws of the State of Wisconsin."  

Requirement: Domestic Corporation - Dissolved/Authority 

Furnish ATG with a certified copy of the Articles of Dissolution that were issued by the incorporators or 
board of directors authorizing the execution of a deed to sell the corporation’s real property or furnish 
ATG with a certified list of all the successors in title to the real estate of said corporation, and this 
commitment is subject to such further exceptions, if any, as may then be deemed necessary.  

Exception: Domestic L.L.C. - Dissolved 

{PR,"Enter name of LLC",ST1,1}, a Limited Liability Company, was dissolved by {PR,"Enter name of 
entity that dissolved this LLC",ST1,2} on {PR,"Enter date this LLC was dissolved",DT2,3}. We note the 
following with respect thereto and this Commitment is subject to the following exceptions:  

(1) Rights of the creditors of said LLC, including the United States of America.  

(2) Right, title, and interest of the members of said LLC and those claiming under them.  

(3) Any delinquent income or franchise taxes that may be due and payable to the State of Wisconsin.  

Requirement: B1 - Deed and Mortgage  

a) WARRANTY DEED from {DB,SellerInfo,FormalName,NO} to {DB,BuyerInfo,FormalName,NO}. 

Note: The proposed instrument of conveyance should designate the subject property as non-homestead, 
identify the grantor/mortgagor as a single person, or be joined in by the grantor’s/mortgagor’s spouse and 
have their marital status typed thereon.  

Note: The buyer(s) should inform ATG how legal title will be held.  

Note: A Wisconsin Real Estate Transfer Return form will need to be completed by the parties in order to 
record the conveyance document.  

b) MORTGAGE from {DB,BuyerInfo,FormalName,NO} to {DB,Lender,Name,NO}, in the amount of 
{DB,Main,LoanAmount,CU1}.  

Note: Construction Lien Affidavit  

Note: Full coverage provided by the Loan Policy is conditioned upon the return of an affidavit in a form 
acceptable to the company as to the construction liens and possession and the submission of satisfactory 
evidence in regard to existing and future special assessments from the municipality in which the subject 
premises are located. The Policy will be subject to such additional matters as the affidavit and tax search 
disclose.  

Note: Endorsements - Final Loan Policy  

NOTE: The Loan Policy, when issued, will contain the Easements, Restrictions, and Minerals 
Endorsement (ALTA Form 9; formerly known as Comprehensive Endorsement), an Environmental 
Protection Lien Endorsement (EPL; ALTA Form 8.1), and a Location Endorsement 1 (ALTA Form 22).  
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Exception: Real Estate Taxes - Single Payment  

Taxes for the year {PR,"Enter the year that taxes are a lien (‘YYYY’).",IN1,1} and thereafter: {PR,"Enter 
the current or previous year (‘YYYY’).",IN1,1} taxes in the amount of {PR,"Enter amount of prior year 
taxes.",CU1,2} are {PR,"Enter whether ‘PAID,’ ‘UNPAID AND DUE,’ ‘NOT YET DUE AND 
PAYABLE.’",ST1,3}. 

Taxes for the year {PR,"Enter the current year (YYYY).",IN1,6} are not yet due and payable.  

Tax Key No. {DB,Property,TaxID,NO}  

Exception: Rights of the Public (Roads)  

Rights of the public, State of Wisconsin, and the municipality in and to that part of the premises in 
question taken, used, or dedicated for roads or highways.  

Exception: Riparian - Highwater Mark  

Rights of the public in any portion of the subject premises lying below the ordinary highwater mark and 
in the waters of and airspace over {PR,"Name of lake/river, etc.",ST1,1}, Wisconsin.  

Requirement: Lien -Judgment Possible 

We find judgments, liens, and matters of record involving a person or persons whose names are similar to 
{PR,"Name of person with possible judgments",ST1,1}. Relative thereto, a Personal Information 
Affidavit establishing the identity of the above described person must be supplied in order to facilitate the 
exclusion, if possible, of those items.  

Note: Rental Property  

NOTE: If the property is to be used for rental purposes, compliance with or exemption from the Energy 
Efficiency Standards of the State of Wisconsin or the municipality must be obtained.  

Requirement: Foreclosure Commitment - General  

In order that we may insure title after completion of any proceeding brought to foreclose the lien of the 
mortgage noted at Schedule B-II, Exception No. {PR,"Enter Schd B-II Mortgage Exception 
number",IN1,1}, and recorded as Document No. {PR,"Insert Document Number",IN1,2}, we note the 
following and this commitment is subject to:  

Our policy, when issued, will be subject to direct attack upon the judgments and orders entered in the 
proceeding.  

Upon the filing of the complaint, a proper Notice of Foreclosure (Lis Pendens) under Section 840.10(1) of 
the Wisconsin Statutes must be recorded in the Register of Deeds of {PR,"Enter County Name",ST1,3} 
County, Wisconsin.  

The following persons are necessary parties to any such parties:  

(1) {PR,"insert name of mortgagor or successor in interest",ST1,4}, the record owner, as a party 
defendant.  

(2) {PR,"Insert name of spouse or mortgagor or successor in interest",ST1,5}, spouse of the 
record owner, as a party defendant.  

(3) {PR,"Insert name of mortgagee or successor in interest",ST1,6}, as a party plaintiff.  

d. The following persons must be made parties defendant to the foreclosure if it is desired that their 
interests be barred by the proceeding:  

(1) All parties acquiring rights in the premises subsequent to the date of this commitment and 
prior to a complete Notice of Foreclosure (Lis Pendens).  

(2) Any person other than those herein named known to the Plaintiff or the Plaintiff’s attorney to 
have or claim an interest in the premises.  
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(3) All persons in possession of any part of the premises in question and all persons whose rights 
would be disclosed by an inspection of the premises.  

(4) United States of America by reason of Schedule B-II Exception No. {PR,"Enter Schedule B-II 
exception number",IN1,7}.  

NOTE: Compliance should be had with the provisions of 28 U.S.C. § and in connection therewith the 
following information is furnished:  

The Notice of tax lien noted at Schedule B-II Exception No. {PR,"Insert Schedule B-II exception 
number",IN1,8} was filed by the District Director of Internal Revenue, at {PR,"Insert County where tax 
lien was filed",ST1,9}, Wisconsin, against {PR,"Insert name of mortgagor",ST1,10}, in the office of the 
Register of Deeds of {PR,"Insert name of County",ST1,11} County, Wisconsin, on {PR,"Date of lien 
filing",DT2,12}, as Document No. {PR,"Insert Document No. of lien",ST1,13}.  

NOTE: Attention is directed to the provisions in Section 2410 of the Federal Judicial Code requiring that 
any action to foreclose a mortgage naming the United States as a party under the Section "must seek a 
judicial sale." In the event a sale is not sought in the contemplated proceeding, such proceeding will not 
affect the rights of the United States noted at Schedule B-II and the United States should not be made 
party thereto. In addition, further exceptions will be raised for the consequences of liens, if any, in favor 
of the United States that appear of record after the date of this commitment.  

(5) Second mortgagees, judgment lienors, etc., by reason of Schedule B-II Exception No. {PR,"Insert 
Schedule B-II exception No.",ST1,14}.  

NOTE: If it is known that any of the parties listed herein are deceased, their heirs or devises should be 
made parties by name, if known, and, if unknown, by the name and description of "UNKNOWN HEIRS 
OR DEVISEES OF" such deceased person or persons. If it is not known or cannot be ascertained whether 
any of said necessary parties be living or dead, then such parties should be made parties by name, and 
such persons as would be their heirs or devisees should also be made parties to the proceeding as 
‘UNKNOWN OWNERS." In this connection, we direct your attention to Sections 807.12 and 801.11 of 
the Wisconsin Statutes. An affidavit of compliance with these sections should be provided to ATG.  

NOTE: In the event that there are any persons who are necessary parties to the contemplated proceeding, 
but the names of such persons are unknown and unascertainable, then, and in that event only, such 
persons should be made parties under the description of "UNKNOWN OWNERS", unless the contrary is 
herein indicated. An affidavit of compliance with Sections 807.12 and 801.11 of the Wisconsin Statutes 
should be provided to ATG.  

NOTE: The proceeding will not affect the standard exceptions nor the exceptions noted in Schedule B-II 
at No. {PR,"Insert Schedule B-II exception(s)",ST1,15}; and our policy when issued will be subject to 
such exceptions unless satisfactory disposition thereof is otherwise made.  

Exception: City of Milwaukee Properties  

This commitment does not insure against charges imposed by the City of Milwaukee Department of 
Neighborhood Services Residential Rental Inspection (RRI) program. This exception will be removed 
upon receipt of satisfactory proof that the property is not located in the target areas or upon delivery of an 
acceptable RRI Inspection Certificate that is currently in full force and effect. For more information, link 
to http://www.city.milwaukee.gov/DNS.  

This commitment does not insure against charges imposed by the City of Milwaukee Department of 
Neighborhood Services Vacant Building Code Registration and Maintenance program. This exception 
will be removed upon receipt of satisfactory proof that the property has been occupied at all times during 
the current calendar year; or that the property is exempt from compliance; or that the property is or was 
properly registered with all fees paid during any period of vacancy and that all maintenance requirements 
were complied with during such period. For more information, link to 
http://www.city.milwaukee.gov/DNS.  

This commitment does not insure against charges imposed by the City of Milwaukee Department of 
Neighborhood Services (DNS) for special charges pertaining to code compliance, rent withholding, fire 
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inspections, code violations/work orders, and other special charges. This exception will be removed upon 
receipt of satisfactory proof that there are no outstanding and pending special charges. A title search 
request must be made in writing to DNS. To obtain a copy of the title search request form, link to 
http://www.city.milwaukee.gov/DNS.  

Requirement: Trusts - Authority  

Furnish ATG with a properly certified copy of the original trust agreement under which title to the land is 
held, together with a statement in writing by the Trustee that it will produce the original agreement upon 
request, and this Commitment is subject to such further exceptions , if any, as may be deemed necessary.  

ATG should be advised as to whether the trust under which title to the land is held is still in force and 
effect, and this Commitment is subject to such further exceptions, if any, as may be deemed necessary.  

Requirement: Lien - Child Support  

Child support judgment filed against {PR,"Insert name of person(s) who received judgment 
here.",ST1,1}, in Case No. {PR,"Insert Case number here.",ST1,2} in the Circuit Court of {PR,"Insert 
name of County here.",ST1,3} County, Wisconsin, a memorandum of which was recorded on {PR,"Insert 
date the judgment was recorded here.",DT2,4}, as Document No. {PR,"Insert Document number 
here.",ST1,5}.  

Requirement: Decedent Estate - Personal Representative’s Authority 

A certified copy of the domiciliary letters issued by a Circuit Court of Wisconsin authorizing {PR,"Enter 
name of Personal Representative",ST1,1} to act as the personal representative over decedent’s estate with 
the power to convey decedent’s real property.  

Requirement: Lien - Judgment Recorded  

[Transcript][Certified copy][Memorandum] of judgment recorded on {PR,"Insert date judgment was 
recorded here.",DT2,1} as Document No. {PR,"Insert Document number here.",ST1,2} for judgment 
rendered on {PR,"Insert date of judgment here.",DT2,5} in the {PR,"Insert name of court (circuit, 
appellate, etc.) here.",ST1,6} Court of {PR,"Insert name of County here.",ST1,7} County, in favor of 
{PR,"Insert name(s) of winning person(s) here.",ST1,8} against {PR,"Insert name(s) of losing person(s) 
here.",ST1,9}, in the amount of {PR,"Insert amount of judgment here in dollars and cents.",CU1,10}  

Exception: Mortgage - Existing  

Mortgage dated {PR,"Enter Date of Mortgage",DT2,1}, and recorded {PR,"Enter date mortgage was 
recorded",DT2,2}, as Document No. {PR,"Enter Document No. of mortgage",ST1,3}, executed by 
{PR,"Enter name(s) of Mortgagor(s)",ST1,4}, and given to {PR,"Enter Name of mortgagee",ST1,5}, to 
secure a note in the amount of {PR,"Enter amount of mortgage",CU1,6}, and such other sums as provided 
therein.  

Exception: Mortgage - Schedule B, Part II  

SCHEDULE B, PART II  

In addition to the matters set forth in Part I of this schedule, the title to the estate or interest described or 
referred to in Schedule A is subject to the following matters, but ATG insures that such matters are 
subordinate to the lien or charge of the mortgage upon said estate or interest:  

Mortgage dated {PR,"Enter date of mortgage.",DT2,7}, and recorded {PR,"Enter mortgage 
recordingdate.",DT2,7}, as Document No. {PR,"Enter recorded mortgage document 
number.",ST1,6}, executed by {PR,"What are the borrowers name(s)?",ST1,6}, and given to 
{PR,"Enter name of existing lender.",ST1,5} to secure a note in the amount of {PR,"Enter 
existing mortgage amount.",CU1,7}, and such other sums as provided therein.  

Exception: Mortgage - Assignment  

Assignment of Mortgage from {PR,"Enter name of original lender",ST1,1} to {PR,"Enter name of lender 
receiving assignment.",ST1,2}, dated {PR,"Enter the date of the assignment",DT2,5}, and recorded 
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{PR,"Enter recording date of assignment",DT2,5}, as Document No. {PR,"Enter Document number of 
Assignment.",ST1,3}, which assigns the Mortgage recorded as Document No. {PR,"Enter Document No 
of assigned Mortgage",ST1,4}.  

Exception: Foreign L.L.C. - Dissolved  

{PR,"Enter name of LLC",ST1,1}, a Limited Liability Company, was dissolved by {PR,"Enter name of 
entity that dissolved this LLC",ST1,2}, on {PR,"Enter date this LLC was dissolved",DT2,3}. We note the 
following with respect thereto and this Commitment is subject to the following exceptions:  

(1) Rights of the creditors of said LLC, including the United States of America.  

(2) Right, title, and interest of the members of said LLC and those claiming under them.  

(3) Any delinquent income or franchise taxes that may be due and payable to the State of Wisconsin.  

Note: Deed - Transfer Tax Return Form  

Note: A Wisconsin Real Estate Transfer Return form will need to be completed by the parties in order to 
record the conveyance document.  

Requirement: Bankruptcy Trustee- Authority  

Requirement: Power of Attorney - Authority  

Furnish ATG with an executed and acknowledged Power of Attorney that is in recordable form. Said 
Power of Attorney must be reviewed by the ATG Underwriting Department prior to the execution of any 
conveyance documents.  

Exception: Bankruptcy - Creditor Rights  

The right of a creditor, trustee, or debtor in possession to sell the entire property in the event of a 
bankruptcy of any co-tenant of the land.  

Exception: Riparian -Water/Accretion/Reliction  

This policy does not insure the exact location of any portion of land created by gradual buildup of the 
shore (accretion) or the lowering of the water level (reliction), the title to land cut off by a change in the 
course of the water body (avulsion), or ownership of artificially filled lands.  
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	The Application Service Provider (ASP) environment allows ATG to have ATG REsource on offsite that are monitored 24/7 and backed up daily. Members access and run ATG REsource through the Internet, minimizing the need to load software on their office c...

	IV. System Requirements
	A. Operating System:
	1. Required
	ATG REsource is a true 32/64-bit Windows application that requires Windows NT, 2000, XP, Vista, or Windows 7 operating system.

	2. Recommended
	Windows XP Professional, Windows Vista, or Windows 7


	B. Processor and Monitor:
	1. Required
	Personal computer with a Pentium II 333 processor or higher, 128MB RAM, and 200MB free disk space. Under this configuration, the system will function but may perform more slowly than you desire.

	2. Recommended
	Pentium II 400 processor (or higher) with 256MB or more RAM and a 17” monitor.


	C. Internet Access:
	Minimum 56KB modem and Internet access required. We recommend cable, T1, or DSL Internet access for higher volume members. A satellite connection to the Internet may not work.


	V. ATG Software HelpDesk
	A. Software Support
	You are one of the many ATG members who has completed REsource training and is now using our software to issue ATG commitments, policies, and other documents for real estate transactions. To assist you in your daily use of REsource, we offer the ATG S...
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	This remote-control feature allows an ATG employee to steer you through various REsource screens and data fields as if he or she were sitting next to you, controlling your mouse. During this session, our employee is on the phone, talking you through t...
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	ATG REsource users have access to the following services and information from the HelpDesk:
	 Technical support;
	 Software training schedules;
	 Software upgrades; and
	 Information about ATG REsource.
	 View and/or download this information from its website equivalent on the Member section of our website, www.atgf.com.

	D. Questions?
	Contact the ATG REsource HelpDesk at 888.776.4420 or atgresource@atgf.com. You may also contact a Member Services Representative, 800.252.0402.


	VI. Software Installation
	A. Terminal Services and ATG REsource Connection Setup
	1. Log in at www.atgf.com with your user name and password.
	2. Under ATG Member Attorneys, click View ATG REsource User’s Information.
	3. Scroll down to Downloads to download setup files and instructions for Shortcut to REsource Remote Desktop
	4. Click the Download Now link and save it to your desktop.

	B. Remote Print and Simplify Printing (ScrewDrivers) Setup
	(If you are connected to the Terminal Server, disconnect by selecting Start > Log Off [User].
	1. Log in at www.atgf.com with your user name and password.
	2. Under ATG Member Attorneys, click View ATG REsource User’s Information.
	3. Scroll down to Downloads to download setup files and instructions for Remote Print and Simplify Printing (ScrewDrivers).
	4. Follow instructions for setup of both applications.


	VII. Logging On
	Log on to Windows
	A. Double-click the REsource icon.
	B. Enter your User Name and Password and enter ATGF in the Log on to box.
	C. Click OK.

	VIII. REsource Desktop
	A. Notice that your desktop is now behind the REsource desktop.
	B. To return to your own desktop without closing your REsource session, hover over the top of the screen until a tab will appears and click the Minimize button.
	C. To reopen your REsource session, click the REsource button on your task bar (along the bottom of the screen).
	D. To log out of your REsource session, click Start and select Log Off [Use Name].

	IX. Complete Closing Enterprise
	A. To begin, double-click the Complete Closing Enterprise icon  on the REsource desktop.
	From Complete Closing, you can prepare the Commitment, HUD-1 Settlement Statement, Checks for Disbursement, Policies, Endorsements, and most Closing Documents.
	B. Tool Buttons
	C. ATGF Extensions
	D. Navigating
	E. Control Commands
	F. Resizing Windows
	G. Opening and Closing Windows
	H. Help Files
	I. File Locking
	1. Security has been added to REsource to prevent multiple users from accessing the same file at the same time. File Locking affects all data entry menus including Order Entry, HUD, Commitment/Policy, and Check Writing.
	2. This message will appear if you are attempting to gain access to a file that another user currently has open:
	3. You may access all data entry menus for a file that another user is working on, but the file will be Read-Only.
	4. You may also:
	a. print documents for a file that is in read-only mode; or
	b. select another file and try the read-only file again at a later time.

	5. It is very important that you exit an active file when finished. You can either go to another file or return to the REsource desktop. Closing Complete Closing when not in use will also free up the file.
	6. If you need immediate access to the file, you may contact the user or the ATG REsource Help desk at 888.776.4420.
	 REMINDER: When logging off of your REsource session do not use the X button at the top of the screen. To logoff, click the Start button  at the bottom left of your screen, select Logoff,  and click Logoff at the prompt.



	2 |  Looking Up an Existing File
	I. Look Up an Existing File
	A. The File # field  displays the current file. Complete Closing always opens with the last file worked on before logging off. Before you begin working on a file, make sure that the correct file number displays in the File # field in the toolbar. You ...
	1. Order Search by Member
	Click the Order Search by Member button  to search files by Member File Number, Buyer/Seller, File Number, and Closing Date.

	2. Lookup File Number
	Click the Lookup File Number button  to search by File Number, Closing Date, Department, Escrow Bank, or Person.

	3. Search by Legal Description
	Click the Search by Legal Description button  to search by Legal Description, Address, City, or Number (Acreage).

	4. Search by Buyer/Seller
	Click the Search by Buyer/Seller button  to search by Buyer or Seller name.

	5. Jump to File
	Click the Jump to File button  to open another file by entering the exact File Number.

	6. Super Search
	Click the Super Search button  to search for one or several files based upon variables such as file open and close dates, buyer/seller, property, and loan information. A printed report of the search results is also available.

	7. File Menu
	Click the File menu: The nine (9) most recently opened files appear at the bottom of the File menu. This is a shortcut to retrieve a recent file.

	8. Tax ID Search
	Search for a file by the Permanent Index Number or Tax ID Number.


	B. After you locate a file using one of these methods, you can edit the order, prepare the commitment or policy, print documents, create the invoice, complete the HUD-1 Settlement Statement, or write checks.

	II. Order Search by Member
	The Order Search by Member function searches and sorts files by several fields, including Member File Number, Buyer/Seller, and Closing Date.
	A. Access the Order Search by Member by clicking the Search Orders by Member button;  or
	B. Select Member Search from the ATGF Extensions menu.
	C. Click the Order Status Filter to view files by Open/New, Closed, or Cancelled files, or click All to view all files.
	D. Enter the Member Number (Region 0 users only; ATG staff).
	E. To sort files by any category, such as Seller or Member File Number, click once on the category and the files will be re-sorted alphabetically or numerically.
	F. To open a file, highlight the file and click the Open Selected button  located at the lower left corner.

	III. Search for a File by File Number
	A. This option allows you to look up a file by the File Number, Escrow Bank, or Closing Date. Use one of the following methods to access the lookup:
	1. Click the Lookup File Number button.
	2. Select the Locate File option from the File menu.
	3. Press <Alt>+<F>, then <L>. The Find File dialog box displays.
	4. Enter all or part of the file number.

	B. Files are sorted by File Number. You can use the Search By drop-down list at the bottom of the screen to select Close Date, Department, Escrow Bank, or Person as your search criteria.
	C. Begin entering the file number (or the selected “search by” information) in the Search Characters field. As you enter, files matching your search criteria will display.
	D. Select the desired file and then click OK.  The selected file number displays in the File # field.

	IV. Search for a File by Legal Description or Address
	A. This option allows you to search for a file by property information, including the Legal Description, Address, City, or Survey Number (acreage). To access the property search, use one of these methods:
	1. Click the Search for File by Legal Description button  on the toolbar.
	2. Select the Locate File by Prop option on the File menu.
	3. Press <Alt>+<F>, then <O>.

	B. Properties are listed by Legal Description, but you can use the Search By drop-down list at the bottom of the screen to select Address, City, or Number (Acreage), as your search criteria.
	C. Begin entering the Legal Description (or the selected “Search By” information) in the Search Characters field. As you enter, files matching your search criteria will display.
	D. Select the desired file and then click OK.  The selected file number displays in the File # field.

	V. Search for a File by Buyer/Seller Name
	A. This option allows you to search for a file by Buyer or Seller name. To access the Search for Buyer/Seller screen, use one of these methods:
	1. Click the Search for File by Buyer/Seller button.
	2. Select the Locate File by Buyer/Seller option on the File menu.
	3. Press <Alt>+<F>, then <B>.

	B. Enter the Name (last name first) in the Name Filter field, then click the Apply Filter button  to display all the files in which the name appears as a Buyer (on the left) and as a Seller (on the right).
	C. Select the desired file and then click the Select button.  The selected File Number displays in the File # field.  Click the Close button  to begin working on the selected file.

	VI. Search for a File or a Group of Files Based upon General File Information
	The Super Search feature allows for customizable searches. A printed report of search results is also available.
	A. Click the Super Search button  or select Super Search from the File menu.
	B. Enter desired search criteria and click the Search button.
	1. Main tab: Allows you to enter general information about the order.
	2. Loan/Misc. tab: Allows you to enter Loan and Miscellaneous information about an order or range of orders.
	3. Property tab: Allows you to enter Property information.
	4. Web/Commit tab: Allows you to enter Commitment/Policy and PaperlessCloser information.
	5. Agent Searches tab: Allows you to search for Agents.
	6. Buyer/Seller tab: Allows you to search for Buyers and Sellers.

	C. Printing Reports
	To print a report of the search results, select the Print tab.
	EXAMPLE: To print a list of closings during a specific time period:
	1. Select a beginning Closing Date.
	2. Select an ending Closing Date.
	3. Click the Search tab.
	4. Click the Print tab to display the document.
	5. Click the Print button  to print on paper.
	6. Additionally, results can be saved as a PDF, Excel, or Word document by clicking the corresponding button.


	VII. Search for a File by the Tax ID Number (PIN or Tax Key)
	A. To search for a file by the Tax ID Number (Permanent Index Number or PIN), click the Add File Number button  or select New File from the File menu, even though a new file is not needed.
	B. Enter all or part of the Tax ID Number and click the Search button.  Similar Tax ID Numbers, if any, will display.
	1. Click the Cancel  button to abandon a new file entry or Tax ID search.
	2. Click the Create New button  to create a new file; or,
	3. Highlight the desired file and click the Open Selected button  to open an existing file.



	3 |  Getting Started
	I. Creating a New File
	A. To create a new file, click the Add File Number button  located on the toolbar or select New File from the File menu.
	The purpose of the Tax ID search is to prevent duplicate orders and to determine if your office has previously insured this property using REsource.

	B. Enter all or part of the Tax ID Number (Permanent Index Number or PIN or Tax Key Number) and click the Search button.  Similar Tax ID Numbers, if any, will display.
	1. Click the Create New button  to create a new file; or
	2. Click a displayed file and click the Open Selected button  to open an existing file; or
	3. Click the Cancel button  to abandon a New File entry or Tax ID search.
	4. The Enter New File window opens after clicking the Create New button  on the Tax ID Search Form.
	a. Type of Order
	Click Type of Order and select the Type of Order by clicking the drop-down arrow.
	i. None specified at this time
	ii. Title Services (Title Services Complete or Title Services Support)
	iii. Search Only
	iv. Regional
	v. Commercial
	vi. Commitment

	b. Branch
	For regional members only.

	c. Title Unit
	Leave blank.

	d. Escrow Unit
	Leave blank.


	5. Click the Calculate Next Number button.
	REsource automatically creates the File Number, which is based on the current year, your member number, and consecutively numbered files. It is important to use the Calculate Next Number button to ensure proper file numbering. The File Number assigned...

	6. Click OK to create the new file.


	II. Agent/Vendor List
	A. Instructions for using the Agent/Vendor List
	1. The Agent/Vendor list is a complete record of all individuals or organizations entered in the database. It includes lenders, Realtors, search providers, attorneys, HUD-1 Settlement Statement payees, buyers, and sellers. It contains the individual’s...
	2. All individuals or organizations associated with a transaction must first be entered into the Agent/Vendor list. The individual or organization will be stored in the database for future use with any other transactions.
	3. The following is a list of data fields that use information stored in the Agent/Vendor list:
	a. Search Provider
	b. Realtor
	c. Attorney
	d. Lender
	e. Mortgage Broker
	f. Place of Closing
	g. Home Inspector
	h. Pest Inspector
	i. Member
	j. Recording Office
	k. Surveyor
	l. None
	m. All Payee fields on the HUD


	B. Access the Agent/Vendor List
	To access an agent from the Agent/Vendor list, use any of the following options:
	1. With the cursor in the data field, press <Ctrl>+<L> to display the Select Agent dialog and search for an existing record or enter a new agent; or
	2. With the cursor in the data field, right-click and select Lookup Agent to display the Select Agent dialog; or
	3. Enter the first few letters of the name for an existing record. If there is just one match, the program will enter the ID and name. If there is more than one match, it will display the matching entries so you can select one. If there are no matches...
	4. Enter the Agent/Vendor ID Number for an existing record.

	C. Searching for an Agent
	1. To Select an Agent from the Agent/Vendor list, enter the Agent/Vendor’s name in the Search Characters field. Closest matches will display. Highlight the desired Agent and click OK.
	2. The Agent Lookup is context sensitive. An Agent lookup on the Lender data field will produce a list of Lenders; a lookup on the Realtor field will produce a list of Realtors. The type of Agent can be changed by clicking the Filter drop-down list.  ...
	In the Region field, use the drop-down list  to toggle between regions. The drop-down list options are:
	a. Region Zero
	Only agents created in Region Zero (agents created by ATG) display. You may use these agents for your files but you cannot edit these agents.

	b. Your Selected Region
	Only agents created in your Region display. These are agents that you have created; they can be edited.

	c. Both Regions
	Agents in both Region Zero and your Region display.


	3. Click Search By to change the search criteria. Agents are listed by name (first name then last name for individuals), but you can use the Search By drop-down list  at the bottom of the screen to change your search criteria. Other search criteria in...

	D. Searching for Agent/Vendors using Super Search
	The addition of Super Search to the Agent Lookup screen allows users to find agents by additional criteria such as address, phone or fax number, contact name, etc.
	1. The Super Search function can be turned on or off by toggling the Super Search (open)/(close) buttons.
	2. Type the criteria to search; in this example, “Wells Fargo” and the Contact name, “Amy.”
	3. Click the Search button. The search results display below. Click OK to use the agent.

	E. One Time Use Agent
	The One Time Use Agent function allows users to modify an Agent that is not in his or her Region for one time use only. The advantage of this function is that a new Agent does not have to be created.
	1. Select the agent using the Lookup Agent function.
	2. Right-click on the agent and select Enter as One Time Use Agent.
	Notice that a new Agent ID number will be created and the existing ID number will appear in the name.

	3. Right-click again and select View/Edit Agent to edit the agent.
	4. The Agent displays in the Agent/Vendor List and you are can edit this agent and use it one time only.

	F. Organizing Agent/Vendors; Parent/Child Agents
	1. Agents can now be organized within relationships. An agent can be created representing one company (Parent) and several additional agents (Child) can be created listing various locations or contacts.
	2. To create a relationship for an agent:
	a. Go to Data Entry>Agent List or press <Ctrl>+<A>.
	b. Click the Insert New Agent button  to add a new agent.
	c. Complete the New Agent information
	d. Click the Choose Agent Parent button  and search for the Parent Agent to associate with the Child Agent.
	Parent Agents will appear in yellow in the Agent Lookup.

	e. Click the Show Contacts button  to view all Agents associated with the Parent agent.


	G. Additional Agent/Vendor Features
	H. Adding a New Agent
	1. To add an Agent to the Agent/Vendor List, click the Insert New Agent button.
	2. Complete Closing assigns a sequential ID number to each Agent. Enter the Name, Address, Phone, Fax, and Contact information, if known.
	3. Select the Category (type) for this Agent:
	a. Attorney;
	b. Home Inspector;
	c. Lender;
	d. Misc. 1;
	e. Misc. 2;
	f. Mortgage Broker;
	g. Pest Inspector;
	h. Place of Closing;
	i. Realtor;
	j. Recording Office;
	k. Search Provider; or
	l. Surveyor.
	 NOTE: Always select the proper category for each agent. Agents without a category will be difficult to find.


	4. Click OK when finished. (Not all fields are required.)


	III. Editing an Agent
	A. Right-click in a data entry field that uses the Agent/Vendor List and select Edit Agent or press <Ctrl>+<E>.
	B. Click the Edit Agent button  to edit the information.
	 NOTE: Editing an Agent will affect all files that use that Agent. Do not change the name of an agent unless it is mistyped. Instead, add a new Agent. Agents can be edited only by the Region that created them.


	IV. Order Entry
	When a new file is created, Complete Closing automatically opens the Order Entry screen. The Order Entry screen can also be accessed at any time to work on or view an existing file by clicking the Order Entry button  or the Data Entry > Order Entry me...
	The Order Entry tab contains several sub-tabs: Main, Buyer/Seller, Loan, and Property. The data entered in Order Entry is used throughout program.
	A. Main Tab
	The Main tab contains basic information about the order, including Order Status, Escrow and Closing Information, Prior Policy Information, Critical File Dates, Sale Price, etc. Several items will contain default information such as the Status of the f...
	1. Closer
	Select the drop-down list to display a list of all available agents. If you are a member closer, select Member Closer. If ATG is providing a closer, leave this field blank. ATG will enter the Closer when the closing is assigned. If the Closing Agent i...

	2. Status
	a. New
	Initial order status.

	b. Opened
	An order changes from “New” to “Opened” when you begin work in the Commitment/Policy and HUD preparation screens.

	c. Closed
	An order for which a policy has been issued.

	d. Cancelled
	An order that has been cancelled before it is completed.

	e. Template
	This option allows you to create a type of order template that you can use for similar orders.

	f. Old
	This status is assigned by REsource to files that previously existed when a company updates its programs and converts the old files to the new system.

	g. On Hold
	This status is used for orders that are waiting on certain tasks to be completed.


	3. Escrow Bank
	The bank account in which the escrow funds are kept. An ID number is assigned to each account and displays in the drop-down list field when an order is initially created

	4. Place of Closing
	This information will default to the member’s office. If ATG is conducting the closing, the Closing Services Department can update the place of closing.

	5. Search Provider
	Select the Search Provider from the Agent/Vendor List by any of the following methods:
	 NOTE: For detailed information about using the Agent/Vendor List, see the Agent/Vender section in this manual.
	a. Press <Ctrl>+<L> to search or add a new name to the list.
	b. Right-click and select Lookup Agent to search or add a new name to the list.
	c. Enter an ID Number or partial Name and press <Tab>.
	d. When you click either field, the two fields change to a single field where you can enter a valid ID Number or the first few letters of a Name, so that the field populates with the matching name in the database or offers suggestions if there are sev...

	6. Order Category
	a. Title Services
	This designation is for those members participating in either the Title Services Support or the Title Services Complete programs.

	b. Search Only
	This designation is for those members who prepare commitments and policies themselves and ATG conducts the search.

	c. Regional
	This designation is for those members associated with a regional company.

	d. Commercial
	This designation is for those members who prepare commitments and policies themselves for a commercial transaction.

	e. Select Services/Commercial
	This designation is for those members participating in either the Title Services Support or the Title Services Complete programs for a commercial transaction.

	f. HUD Only
	This designation is for those members who are only preparing the HUD and not writing title.

	g. Traditional
	This designation is for those members who obtain and review search, determine insurability, prepare commitment, conduct closing, handle payoffs, record documents, conduct Later Date search, and type and deliver final policies.


	7. Service
	a. Owner
	Cash transaction.

	b. Title Guar
	Do not use.

	c. Mortgagee
	Refinance transaction.

	d. Simultaneous
	Buy/Sell where both an Owner’s Policy and Loan Policy will be issued. This is set by default.

	e. Const Loan
	Construction loan.

	f. Other
	Letter Report only – no title issued.


	8. Prior Policy Information
	If a prior policy is available, the following fields must be completed:
	a. Prior Policy Number
	Enter the number of the prior policy.

	b. Prior Policy Amount
	Enter the Amount of Coverage from the prior policy.

	c. Date of Prior Policy
	Enter the Effective Date from the prior policy.

	d. Prior Policy Code
	Select the name of the title company who issued the prior policy by clicking the drop-down arrow  to display a list of title companies.


	9. Plant
	Title Plant; leave blank. The ATG Search Department will select Title Plant as Landata, Chicago Title, or Other.

	10. Critical Dates
	a. File Opened
	The date the file is created will appear in the File Opened field.

	b. Commitment Due
	This default date is seven (7) days after the open date. You can select a different date if you need the commitment sooner or if you are preparing the commitment yourself.

	c. Closing Date
	Date of closing.

	d. Confirm Date
	This date indicates that the ATG Closing Services Department has confirmed the closing date with the lender (Chicago Area Closings only).

	e. Need Search
	This default date is five (5) business days from the date the file was opened. You can enter a different date if you are preparing your own search, have contracted with a search provider other than ATG, or need an ATG search sooner than the default da...

	f. Closing Time
	Time of closing.


	11. Member File #
	Enter your own File Number, if any (optional).

	12. Sale Price
	Enter the Sale Price. Do not use dollar signs ($) or commas; they will automatically populate.

	13. Notes
	Any pertinent information can be entered in a Note, and you may have multiple Notes for a file.
	a. Click the Add New Note button  to create a new Note. The date will appear automatically.
	b. Click the Delete Current Note button  to delete a Note.
	c. Click the Display All Notes button  to display or print all the Notes in this file.
	d. Click the View Selected Note button  to display the entire Note that is highlighted.
	e. Click the Edit and View Selected Note button  to display the entire Note that is highlighted. A confirmation message will appear. Click OK to edit the data in this expanded work area.
	f. Click the Publish/Unpublish Note to PaperlessCloser button  to publish or unpublish the selected Note.

	14. Using Templates to Copy a File; Using a Template for Order Entry
	The Use Template feature will copy all Order Entry data, except the Sale Price, Earnest Money, and Loan Amount, from an existing file or from a template file. There is also a Use Template feature to copy the Commitment and Policy data from an existing...
	 NOTE: It is recommended that you use the Use Template feature prior to adding data to the file. Two confirmation messages will display upon selecting Use Template, indicating that any data previously entered in the Order Entry tabs will be deleted a...
	a. Create a new file. If this file is for the purpose of creating a second HUD-1 Settlement Statement or a second Commitment, type the existing file number followed by “–A.” Do not use the Calculate Next Number button unless this is a new file.
	b. Click the Order Entry button  or the Data Entry menu to access Order Entry.
	c. From the Order Entry> Main tab, click the Use Template button.
	d. Click OK on the confirmation prompts that indicate the selected template will override any data entered in the Order Entry tabs.
	e. The Select Template screen opens.
	f. You may:
	i. Select a file that is a template; or
	ii. Click the All Orders button  to list all of your files.

	g. Select the file that you want by either double-clicking the file or clicking once on the file to highlight it and clicking OK.
	The Order Entry data from the existing file will now appear in the new file.
	 NOTE: The Sale Price, Earnest Money, and Loan Amount will not be copied from the existing file. In addition, you must go to the ATG Services screen to select services and calculate rates.



	B. Buyer/Seller Tab
	The Buyer/Seller tab contains two sub-tabs, one for the Buyers and one for the Sellers. Unlimited Buyers’ and Sellers’ names and information may be entered for each file. Use the Business Name field for corporations, trusts, or estates and use the Nm1...
	1. Buyers Sub-Tab
	a. Click the Insert New Buyer/Seller button  to begin entering the Buyer name.
	i. Buyer Name
	Enter the complete names of the Buyers, including middle initials. If the Buyer is a corporation, estate, or a trust, enter the name in the Business Name field.

	ii. Marital Status
	Select Buyer’s marital status, if known.

	iii. Buyer Address
	Enter the Buyer’s address, if known.

	iv. Buyer Realtor
	Enter the Buyer’s Realtor, if any.

	v. Buyer Attorney
	Select the Buyer’s attorney.


	b. Multiple Buyers are added by clicking the Insert New Buyer/Seller button.  Married Buyers can be entered in the Nm1 and Nm2 fields. For unmarried Buyers, use the Insert New Buyer/Seller button  to add each name to a separate window.
	c. To edit Buyer information, click the Edit Buyer/Seller button.

	2. Sellers Sub-Tab
	a. Click the Insert New Buyer/Seller button  to begin entering the Seller name.
	i. Seller Name
	Enter the complete names of the Sellers, including middle initials. If the Seller is a corporation, estate, or a trust, enter the name in the Business Name field.

	ii. Marital Status
	Select the Seller’s marital status, if known.

	iii. Seller Address
	Enter the Seller’s address, if known.

	iv. Listing Agent
	Enter the Seller’s Realtor, if any.

	v. Seller Attorney
	The Seller Attorney will default to the member’s name. If the member’s name is a title company name, change the member’s name to the actual attorney’s name.


	b. Multiple Sellers are added by clicking the Insert New Buyer/Seller button.  If Sellers are not married, click the Insert New Buyer/Seller button  to add the next Seller.
	c. To edit Seller information, click the Edit Buyer/Seller button.

	3. Override Signature Block
	REsource automatically creates signature lines for the Buyer and Seller on several closing documents, based on the Name fields in the Buyer/Seller tab in Order Entry. The Override Signature Block allows the user to modify signatures on all documents c...
	a. Select the Buyer/Seller tab and enter the Name.
	b. Click the Override Signature Block button.
	c. Type a line, then enter the name, and click OK.
	The new signature will appear on all documents containing a signature block.


	4. Entry of 1099S Information and Allocation
	a. REsource assumes the reportable amount is the purchase price that is entered as the Sale Price in the Main tab of Order Entry. For a single or married couple as Seller, the purchase price will be shown as 100% allocated to the Seller. That informat...
	b. For a single or married couple Seller, 100% of the proceeds are attributed to that Seller. For multiple Sellers, the program equally divides the proceeds among those Sellers. If a second Seller (Jones) is added to this file, the proceeds will be di...
	c. You can change the percentages to unequal amounts in one of these ways after you have marked the Override Auto 1099 Proceeds Distribution for each Seller:
	i. Enter a different percentage in the Allocation % field. The program will then calculate the Allocation Amount as the entered percentage of the Sale Price. Repeat this procedure for each seller.
	ii. If you want to allocate specific amounts rather than on a percentage basis, delete the number from the Allocation % field and enter the specific amount in the Allocation Amount field for each Seller.
	iii. To make sure you balance for multiple Sellers, you can also click the View All Buyers/Sellers button  to display the Buyer/Seller Work Area. The program displays a window listing all the Sellers, along with the Percentage and Amount of the Procee...
	iv. By default, the Do Not Generate 1099 checkbox is checked. If the transaction is not exempt from reporting, you must uncheck the checkbox. If either property or services are being received as part of the transaction, select the Receive Prop or Serv...
	 NOTE: The Sellers’ proceeds checks in Check Writing will automatically calculate based upon the allocation for each individual Seller.

	v. If you have general questions about 1099S reporting requirements, contact the ATG Underwriting Department at 800.252.0402. The 1099S information packet is available for download from www.atgf.com or by calling the ATG Order Department at 800.252.04...



	C. Loan Tab
	The Loan tab contains Lender Information, Sale Price, Earnest Money, and the Loan Amount.
	1. Sale Price
	Enter the Sale Price. Do not use dollar sign ($) or commas.

	2. Earnest Money
	Enter the earnest money. Do not use dollar sign ($) or commas.
	a. After entering the Earnest Money amount, the Earnest Money dialog box displays.
	b. Select the radio button corresponding to the party holding the earnest money.
	c. Earnest Money Deducted from Realtor Check
	Upon selecting Seller’s Realtor or Buyer’s Realtor is holding earnest money, a prompt will ask if the earnest money should be deducted from the Realtor’s commission.


	3. Loan Amount
	Enter the Loan Amount. If the Loan Amount is not known, enter an estimate of the loan amount. Do not use dollar signs ($) or commas.

	4. Owner’s Policy Liability Override and Loan Policy Liability Override
	If the amount of coverage on the Owner’s Policy or Loan Policy is not equal to the Sale Price or the loan amount, enter the values in the Liability Override field.

	5. Mortgage Broker
	For informational purposes, you may enter the Mortgage Broker, if any.

	6. Loan Information
	a. Lender
	Select the Lender from the Agent list. Add the lender, if necessary.
	i. See the Agent/Vendor List section in this manual for additional information about adding lenders.
	ii. If the Seller is providing financing, click the Select the Lender to be the Seller button  to display the Seller’s name as the Lender.

	b. Loan Number
	Provided by the Lender; enter if known. This information will carry over to the HUD-1 Settlement Statement.

	c. Mort. Ins. Case No.
	Provided by the Lender; add if applicable.

	d. Monthly P&I
	Enter the amount of the monthly principal and interest payment. This information is required on the page 3 of the HUD-1 Settlement Statement.

	e. Interest Rate
	Enter the interest rate of the mortgage. This information is required on the page 3 of the HUD-1 Settlement Statement.


	7. 2nd Loan Information
	If there is a second Lender, enter the amount of the second loan and select the second lender in the 2nd Loan Information section.
	 NOTE: If there is a second loan, select the document, POL Commitment A Schedule 2 Mtgs. from the Print Document list.


	D. Property Tab
	Select the Property tab to enter information about the property.
	1. Tax ID (PIN)
	Enter the PIN (Permanent Index Number/Parcel Index Number), using dashes.
	 NOTE: For properties with multiple Tax ID Numbers, click the Insert New Property button  and enter the next Tax ID number in the PIN field. If multiple properties are being insured, enter the full address and Tax ID number for each property.

	2. Subdivision
	Subdivision names are stored in a table and are searchable. Begin entering the Subdivision Name. If the subdivision has been previously entered, it will appear in the drop-down list. If the name does not appear, add it by pressing <Ctrl>+<Enter>. The ...

	3. Block
	Enter the Block Number. The Block Number is generally found in the Legal Description. For condominium property, enter the Unit Number in the Block field and edit the Brief Legal Description accordingly.

	4. Lot
	Enter the Lot Number. The Lot Number is generally found in the Legal Description.

	5. County
	Enter the first few letters of the county where the property is located to display a drop-down list of counties. Select the desired county.
	 NOTE: The County is required for calculation of the ATG premium.

	6. Township
	Enter the first few letters of the Township to display a drop-down list of townships. Select the desired township.

	7. Override Legal
	For Section Ground Legal Description, check the Override Auto Legal box. Enter Legal Description as Section No., Township, Range, Quarter Section, County Name.

	8. Address
	To auto fill the Street Address with that of the Buyer or Seller, click the Set the Property Address to the Buyer’s Address button  or the Set the Property Address to the Seller’s Address button  located at the top right. Otherwise, enter the property...

	9. The Tax Sale Date, Tax Redemption Date, and Taxes Redeemed Date fields are used by ATG.



	4 |  ATG® Services
	I. Edit Services
	A. To edit or select Services from the ATG Edit Services screen, click the Edit Services button  or select Edit Services from the ATGF Extensions menu or press <Alt>+<E>.
	B. The ATG Services Summary window displays all services and charges thus far selected.

	II. ATG Services Window
	A. Click the Edit/Select Charges button  to select additional services.
	1. The ATG Services screen contains tabs for Title Prep, Endorsements, Closing, Search Services, Rec-Misc, and Commercial, and totals are shown on the right. Each tab will have checkboxes for selecting various services.
	2. Select title services and transaction information by clicking the appropriate checkbox.
	3. When services are selected, customary fees will automatically populate the ATG column, the Buyer column, or the Seller column.
	 NOTE: When finished entering or editing services on the ATG Services screen, you must click the Update HUD button  prior to closing the ATG Services screen. This will ensure that all ATG and consumer charges appear on the Invoice, Closing Statement,...
	The Update HUD button  pulls all fees from the ATG Services screen to the Invoice for Title Charges, Closing Statement, HUD-1 Settlement Statement, and AIS.

	4. Click the Close button  to close Edit Services.
	5. Overriding Standard Fees
	a. Standard Consumer Fee
	i. To override the Standard Consumer Fee or the party liable for payment (Buyer or Seller), double-click the Amount field. The Consumer Charge Override dialog box displays.
	ii. Enter the desired amount in the Buyer Charge or Seller Charge field () and click OK. Do not use dollar signs ($) or commas.
	Wisconsin Members: Since rates are filed in Wisconsin and there is a rate range from minimum charge to maximum charge, you will have to override the default amount for the consumer on every transaction. Because of the rate range, REsource is unable to...


	b. Standard Underwriting Fee
	i. To override the Standard Underwriting Fee, double-click the Amount field. The Special Rate dialog box displays.
	ii. Enter the desired amount in the Special Rate field and click OK. Do not use dollar signs ($) or commas.
	iii. Enter the Authorization number, if any.
	 NOTE: Special Rates for underwriting premiums must be authorized by ATG Staff Attorneys.
	 NOTE: All overridden amounts will appear in bright blue.




	B. ATG Services Tabs
	1. Title Prep Tab
	a. Title Prep
	Title Prep refers to Pre and/or Post-Closing clerical services provided by ATG on behalf of the member. These services are also known as Title Services Support and Title Services Complete.
	i. Title Services Complete
	Pre- and Post-closing processing provided by ATG.

	ii. Title Services Support
	Post-closing processing provided by ATG.

	iii. Loan Modification
	An update of a Loan Policy.

	iv. GRU
	Gap Risk Update.


	b. Prior Type
	Select the Prior Type of policy, if any. An Owner’s Policy, Loan Policy, or a Commitment is acceptable prior title evidence.
	 NOTE: Mid America Title Insurance Company’s policies and commitments will not be accepted as prior title evidence.
	i. No Prior Policy
	No prior policy is available.

	ii. ATG Prior Policy
	ATG previously insured the property.

	iii. Contract Conversion
	A Contract Purchaser’s policy was issued by ATG and now an Owner’s Policy will be issued vesting title in the names of the contract purchasers.

	iv. Abstract
	An abstract has been surrendered for credit as prior title evidence.

	v. Non-ATG Prior
	A title company other than ATG previously insured the property.


	c. Property Type
	Select the Property Type by selecting the appropriate radio button. If the property type is unknown, leave blank.
	i. Residential
	1-4 units.

	ii. Commercial
	Buildings, Stores, Apartment buildings with seven (7) or more units, and Mixed-Use.

	iii. Vacant
	Unimproved property.


	d. Transaction Type
	Select the Transaction Type by selecting the appropriate radio button. If unknown, leave blank.
	i. Buy/Sell
	A transaction where there is a Buyer, Seller, and a Lender.

	ii. Refinance
	A transaction where the owner of the property is obtaining a new Mortgage. Selecting this transaction type will recalculate the Loan Policy consumer charge and ATG’s fee.

	iii. Installment Contract
	A transaction where the Buyer and Seller enter into an Agreement for Deed.

	iv. New Construction
	A transaction insuring previously unimproved property.

	v. Cash
	A transaction where there is no Lender.



	2. Endorsements Tab
	Select all endorsements indicated by the type of transaction or required by the lender. The underwriting fees due ATG and consumer fees, if any, will display in the ATG, Buyer, or Seller columns, and will be included in the totals. Consumer charges fo...
	Select required endorsements, if any, by clicking the checkbox.
	 NOTE: Endorsements that are required but not listed on the ATG Services screen must be added in the Miscellaneous tab.

	3. Closing Tab
	Select the type of Closing Services, if any.
	 NOTE: Selecting Closing Services from the ATG Services screen ensures that the proper fees appear on the Invoice and HUD-1. Schedule Chicago area closings with the Closing Services Department at 312.372.1585 or chi_closing@atgf.com.
	a. Closing
	i. Full Closing
	ATG acts as the escrow agent by providing a closer, HUD-1 Settlement Statement, and the checks for disbursement. The fee for this service will calculate automatically based upon the purchase price.

	ii. After Hours Fee
	Applies to closings scheduled before 8:00 a.m., after 5:00 p.m., or any time on Saturday or Sunday.

	iii. Checks and HUD Only
	ATG provides checks and the HUD-1, but not an independent closer.

	iv. CPL Lender
	The fee to ATG for issuance of the Closing Protection Letter to the Lender.

	v. CPL Borrower
	The fee to ATG for issuance of the Closing Protection Letter to the Borrower.

	vi. CPL Seller
	The fee to ATG for issuance of the Closing Protection Letter to the Seller.

	vii. Dry Closing (ATG Chicago area closings)
	A fee will be assessed in the event of an unfunded transaction.

	viii. E-Mail Package Fee
	The fee to the party downloading and printing the lender’s mortgage documents

	ix. Member Closer
	The member has an approved closer that provides settlement services. The Settlement Agent on the HUD-1 Settlement will print the member’s name and address.

	x. Member Closer Admin Fee
	The fee to ATG from member closers in the Chicago area.

	xi. Multiple Loan Closing
	The additional fee for closing more than one mortgage for a single transaction,

	xii. Room Only
	The closing takes place at an ATG office; however, ATG will not provide settlement services.

	xiii. Tax Payment
	An ATG charge for paying real estate taxes for property located in the Chicago area.

	xiv. Water Payment
	An ATG charge for paying water bills for property located in the City of Chicago.
	 NOTE: Deed and money closings and § 1031 (Starker) exchanges must be scheduled through the Closing Services Department.


	b. Other Fees
	i. Escrow Fee
	The fee for ATG’s Escrow Department or the member to hold an escrow.

	ii. Regional Package
	Used by Regional Companies only (Regions 6000-9000).

	iii. Mortgage Compliance Certificate
	The fee for obtaining the mortgage compliance certificate through the Anti-Predatory Lending Data base.

	iv. Mortgage Exemption Certificate
	The fee for obtaining the mortgage compliance exemption through the Anti-Predatory Lending Database.



	4. Search Tab
	a. Certified Copies
	b. Initial Full w/o Prior
	Initial Full Search (20-year search) without prior title evidence. This includes one Later Date search.

	c. Initial Full w/Prior
	Initial Full Search with prior title evidence. This includes one Later Date Search.

	d. J & L Search Only
	A search of Buyer/Seller names only.

	e. Location Note
	Locates the insured premises (Single Family Residence, Unit No., etc.). Used to complete the Location Endorsement.

	f. Lot Update
	Used when generating a title commitment from a master policy.

	g. Minutes of Foreclosure
	An initial full search on property as a part of the foreclosure process.

	h. Record Owner
	A search to determine the owner of the property.

	i. Redemptions
	An estimate from the county for unpaid taxes.

	j. Rush Search
	For an additional fee, the search will be completed within three (3) days.

	k. Tax and Assessment Only
	l. Tax Bill Only
	m. Tract
	n. UCC Filing
	o. UCC Recording
	p. UCC Release
	q. Water Certificate
	The City of Chicago requires a final meter reading and paid water bill prior to closing. Contact the ATG Search Department to order a Water Certificate.

	r. Zoning Certification
	The City of Chicago requires an inspection of residential property prior to closing. To order a Zoning Certificate, contact the ATG Search Department at 312.752.1994 or Chi_Search@atgf.com.
	 NOTE: An application is available in the Print Documents menu (DOC Water & Zoning Application). Payment for the Water and Zoning Certification is due in advance.

	s. 24 Month Chain of Title
	A list of any deeds of record for the previous 24 months on the insured property

	t. Non ATG Search
	ATG use only.

	u. Later Date Search
	Add or delete Later Date Search fees.


	5. Rec-Misc (Recording-Miscellaneous) Tab
	Recording and miscellaneous fees will appear on the Invoice for Title Charges, Closing Statement (seller only), and the HUD-1 Settlement Statement. Click the Rec-Misc tab to enter recording fees and miscellaneous fees.
	a. Recordings
	Click the checkboxes to select documents.
	Recording fees will calculate for the following Illinois counties: Cook, DuPage, Kane, Lake, McHenry, and Will. For all other counties, or to override the automatic calculation, double-click the Buyer or Seller column to display the Consumer Charge Ov...

	b. Miscellaneous fees will be added to the Invoice for Title Charges, Closing Statement, and the HUD-1 Settlement Statement. Miscellaneous items can be directed to HUD-1 Settlement Statement in either Additional Title Services (rolling up to line 1101...
	i. Click the Add Misc button  to add miscellaneous fees.
	ii. Enter a description of the fee in the Service Name field.
	iii. Select either Additional Title Services Item or HUD 1300 section
	iv. Enter the amount in either the Borrower or Seller field.
	v. Click OK.


	6. Commercial/Other Tab
	Select endorsements that may be required for commercial property.
	Click the appropriate checkboxes to select required endorsements. The ATG underwriting premium and the suggested consumer fees will display in the ATG and Buyer or Seller column.
	 NOTE: When entering or editing services on the ATG Services screen, you must click the Update HUD button  prior to closing the ATG Services screen. This will ensure that all ATG and consumer charges appear on the Invoice, Closing Statement, HUD-1 Se...




	5 |  Commitment Preparation
	I. Schedule A
	A. Preparing Schedule A of the Commitment
	1. To enter/edit information on the Commitment, click the Commitment/Policy Preparation button  or select Commitment/Policy/Binder from the Data Entry menu.
	2. Enter the Effective Date or click the calendar and select a date.
	3. Enter an Effective Time, if any.
	 NOTE: The Commitment Number field auto-populates with the File Number. The Policy Numbers will also auto-populate with the File Number followed by “-01.” Commitments and policy jackets are printed in REsource. Pre-printed serialized jackets are no l...

	4. Enter the Issue Date and Issue Time – the date and time the Commitment will be issued.
	5. Following are several text-editing options. These options are available by selecting the buttons indicated or by right-clicking in the text area.

	B. Owner Insured
	1. Enter the Buyer, Seller, and Lender names in the corresponding tabs in Order Entry.
	2. Each of the Suppress Names checkboxes will be checked. This setting allows the names of the Buyer, Seller, and Lender to pull from the Order Entry tabs.
	3. With the Owner Insured sub-tab open, click the Insert Owner Name(s) in Text Box button.
	4. The Buyer name will display in the text area. This name will appear as shown as the Proposed Insured for the Owner’s Policy on the Commitment. You may edit, if necessary.
	 NOTE: If the names of the Buyer, Seller, or Lender are misspelled, or to add middle initials or suffixes such as “Jr.” or “Sr.,” edit the name in Order Entry. Then delete the name and click the Insert Owner Name(s) in Text Box button  to pull in the...


	C. Mortgagee Insured
	1. Select the Mortg. Insured sub-tab. The Mortgagee Insured text area displays.
	2. Click the Insert Mortg. Insured Name(s) in Text Box button  to display the Lender’s name. You may edit the Lender’s name to include “its successors and/or assigns” or other language as directed by the Lender.

	D. Mortgagee Borrower
	1. Select the Mortg. Borrower sub-tab. The Mortgagee Borrower text area displays.
	2. Click the Insert Mortg. Insured Name(s) in Text Box button  to display the Buyer’s name. You may edit the name if necessary.

	E. Current Title Holder
	1. Select the Current Title Holders sub-tab. The Current Title Holder text area displays.
	2. To insert the Seller names, click the Insert Seller Names button.
	3. To insert the Buyer name as the Current Title Holder, used for refinance or second mortgage transactions, click the Insert Buyer Names button.

	F. Legal Description
	1. Entering the Legal Description
	a. Select the Legal Desc. sub-tab. The Legal Description text area displays.
	b. Enter Legal Description in the text area.
	c. To check spelling, click the Spell Check button.

	2. Copying the Legal Description from another REsource file.
	a. To copy the Legal Description from another REsource file, click the Pull Field from Complete Closing button.  A list of REsource files displays.
	b. Select the desired file by double-clicking the file name or number. The Insert Field From Database window opens.
	c. Scroll down to CommitPolicy and click the Plus (+) to view all data within.
	d. Continue to scroll down to Legal Description. Highlight Legal Description and click OK. The Legal Description from the selected file will be copied into the current file.

	3. Copying the Legal Description from another word processing application into REsource.
	a. Open Word or WordPerfect and open the file containing the desired text.
	b. Highlight the desired text, and select Copy or press <Ctrl>+<C>.
	c. Minimize word processor.
	d. Open REsource and navigate to the Legal Description window found in the Commitment/Policy tab.
	e. Place the cursor where you want the text and either right-click or click the All Options button  and select Paste as Text or press <Ctrl>+<T> to insert text.
	 NOTE: Do not paste text without using the Paste as Text feature. Doing so will cause the text to copy as an image that cannot be edited and will greatly expand the size of the file.



	G. Interest in the Land
	The default for Interest in Land is set to Fee Simple. To change the interest, click in the Interest in Land field and enter the Type of Interest, such as “Contract Purchaser” or “Leasehold.” Changing the Interest in Land field will change the languag...

	H. Two Mortgages on the Commitment Schedule A
	1. Go to Order Entry and select the Loan tab. Under 2nd Loan Information, enter the Loan Amount and Lender name and close Order Entry.
	2. Open the Commitment/Policy and select the 2nd Mortg. Insured tab.
	3. Click the Insert Mortg. Insured Name(s) in Text Box button.  The second Lender’s name will display. You may edit the Lender’s name to include “its successors and/or assigns” or other language as directed by the Lender.
	4. To print, select the ATG Pkg. Commitment 2 Mortgs. 06 package.


	II. Schedule B
	A. Preparing Schedule B of the Commitment
	1. To enter/edit information on the commitment, click the Commitment/Policy Preparation button  or select Commitment/Policy from the Data Entry menu.
	2. Select the Sched B tab. The Sched B, Sched B Req, Exceptions, and Notes to Closer sub-tabs display below.
	 NOTE: For the purposes of creating an ATG Commitment for Illinois property, use only the Exceptions sub-tab to enter Special Exceptions.
	For property in Wisconsin, use the Sched B Req. sub-tab to create a Schedule B-I and use the Exceptions sub-tab to create a Schedule B-II.
	a. Schedule B
	Not for use with ATG commitments (all states)
	However, if ATG is the search provider, the Chain of Title is entered in the Schedule B sub-tab. Some of the items listed in the Chain of Title that you determine need to appear on the Commitment Schedule B can be copied to the Exception sub-tab. Only...
	 TIP: To copy and paste:
	– Highlight the text and press <Ctrl>+<C>.
	– Open the Exceptions sub-tab, place the cursor where the text should appear and press <Ctrl>+<V>.

	b. Schedule B Requirements
	For Wisconsin property only. This sub-tab is used to produce Schedule B-I for the Commitment.
	For Illinois property: This sub-tab is not used.

	c. Exceptions
	Enter all Special Exceptions here (all states).

	d. Notes to Closer
	Used to note endorsements that have been approved for issuance with the Owner’s Policy or Loan Policy.


	3. Select the Exceptions sub-tab to enter Special Exceptions. The Exceptions text area will display.

	B. Selecting Standard Language Exceptions from the Standard Language Library
	1. To select standard language exceptions, click the Lookup Standard Language Items button.  The Select Standard Language Items window opens.
	2. Begin entering the Category name or click the Category drop-down arrow  to view all categories and then select the desired category. Each category contains a group of related exceptions that will display on the left side of the window.
	3. To select exception language, double-click the desired exception or click once on the exception and click the right arrow button  to move the exception to the right side.
	 NOTE: Several exceptions may be selected at one time. For a list of all Standard Language, see the Standard Language Entries section in this manual. To create your own Standard Language, see the Creating Standard Language section in this manual.

	4. Click OK  when finished selecting exceptions.
	5. If the selected exception contains specific information, such as documents numbers, dates, or names, a prompt will display. Enter the necessary information and either press <Enter> or click OK. The exception and the information will then be merged ...

	C. Standard Language Lookup
	The Standard Language Lookup contains enhanced searching capabilities and new options for organizing standard language.
	1. Searching for Standard Language by Category and Description
	Although you can see the names of all Standard Language categories, only Region 0 and your region’s Standard Language entries will be available. Below are two examples. Figure 1 is a Region 0 Category, so all of the exceptions will display and are ava...

	2. Searching for Standard Language Using a Key Word
	a. The key word search allows users to search through Categories and Descriptions for exceptions containing a key word. To search all Descriptions in a category, select the Category and enter a key word in the Search field and click the Partial Descri...
	A list of matching Descriptions in that Category will display

	b. To search all categories, enter a key word in the Search field and click the View All Categories button.
	A list of matching Descriptions in all Categories will display

	c. To search for more Descriptions containing the key word, click the Partial Description Search button  and the View All Categories button.
	A list of matching partial Descriptions in all Categories will display

	3. Excluding Exceptions from the Final Policy
	To exclude exceptions on the Owner’s Policy or Loan Policy, highlight the text and click one of the Mark Selected Text buttons.
	a.  Mark Selected Text for Inclusion on all Policies (Black).
	b.  Mark Selected Text for Inclusion on Owner’s Policy Only (Blue).
	c.  Mark Selected Text for Inclusion on Loan Policy Exclusion from Owner’s Policy (Fuchsia).
	d.  Mark Selected Text for Exclusion from All Policies (Olive).

	4. Copying Special Exceptions from another REsource File
	a. To copy exceptions from another REsource file:
	i. Click the Pull Field from Complete Closing button.  A list of REsource files displays.
	ii. Select the desired file by double-clicking the file name. The Insert Field From Database window opens.
	iii. Scroll down to the CommitPolicy folder and click on the Plus (+) to view all data within.

	b. To copy from a Commitment:
	Continue to scroll down to Exception. Highlight Exception and click OK. The exceptions from the selected file will be copied into the current file.

	c. To copy from an Owners’ Policy:
	Continue to scroll down to OwnerSchedB. Highlight OwnerSchedB and click OK. The exceptions from the selected file will be copied into the current file.

	d. To copy from a Loan Policy:
	Continue to scroll down to MortgSchedB. Highlight MortgSchedB and click OK. The exceptions from the selected file will be copies into the current file.

	e. To copy Exceptions from another word processing application into REsource:
	i. Open Word or WordPerfect and open the file containing the desired text.
	ii. Highlight the desired text, and select Copy or press <Ctrl>+<C>.
	iii. Minimize word processor.
	iv. Open REsource and navigate to the Exception window found in the Commitment/Policy tab.
	v. Place the cursor where you want the text and either right-click or click the All Options button  and select Paste as Text or press  <Ctrl>+<T> to insert text.
	 NOTE: Do not copy text without using the Paste as Text feature. Doing so will cause the text to copy as an image that cannot be edited and will greatly expand the size of the file.


	5. Notes to Closer/Notes for Information
	The Notes to Closer sub-tab can be used to specify which endorsements have been approved for issuance with the Owner’s Policy or Loan Policy.
	a. Select the Notes to Closer sub-tab. The text area displays.
	b. Enter the Notes relating to this file or click the Lookup Standard Language Items button  and select Notes for Information from the Category menu.



	III. Invoice for Title Charges; Procedure and Documents
	Several Invoice for Title Charges documents are available in REsource. The Invoice documents pull fees directly from the ATG Edit Services screen. Recording fees and miscellaneous items have been added to ATG Edit Services to produce a complete Invoic...
	Prior to printing an Invoice, all title and related charges must be entered in the Edit Services  area. Please refer to instructions in this manual for completing the ATG Edit Services.
	A. Invoice Printing
	To print an Invoice:
	1. Click the Print Documents button. .
	2. Click the drop-down arrow  in the Category field and select Invoice for Title Charges to view all invoice documents; or
	3. Scroll down the list of documents to select one of the available Invoice documents:
	a. Doc Inv 2010 BO Chicago Area
	For use with the three page 2010 HUD-1 Settlement Statement Breakout of title charges.

	b. Doc Inv 2010 NBO Chicago Area
	For use with the three page 2010 HUD-1 Settlement Statement No Breakout of Title Charges.

	c. Doc Inv 2010 BO Sep Srch
	For use with the three page 2010 HUD-1 Settlement Statement Breakout of Title Charges and Separate Search Fee.

	d. Doc Inv 2010 NBO Sep Srch
	For use with the three page 2010 HUD-1 Settlement Statement No Breakout of Title Charges and Separate Search Fees.

	e. Doc Inv for Title BO Chicago Area
	For use with the two page HUD-1 Settlement Statement Breakout of Title Charges.

	f. Doc Inv for Title NBO Chicago Area
	For use with the two page HUD-1 Settlement Statement No Breakout of title Charges.

	g. Doc Inv for Title BO Sep Srch
	For use with the two page HUD-1 Settlement Statement Breakout of Title Charges and Separate Search Fee.

	h. Doc Inv for Title NBO Sep Srch
	For use with the two page HUD-1 Settlement Statement No Breakout of Title Charges and Separate Search Fees.

	i. Doc Invoice Services REFI 2010
	For use with the three page 2010 HUD-1 Settlement Statement Refinance Invoice, Breakout of Title Charges.

	j. Doc Invoice Services REFI 2010 NBO
	For use with the three page 2010 HUD-1 Settlement Statement Refinance Invoice, No Breakout of Title Charges.

	k. Doc Invoice Services REFI
	For use with the two page HUD-1 Settlement Statement Refinance Invoice, Breakout of Title Charges.

	l. Doc Invoice Services REFI NBO
	For use with the two page HUD-1 Settlement Statement Refinance Invoice, No Breakout of Title Charges
	 NOTE: All selected services and fees on the ATG Edit Services screen will populate the Invoice documents and the HUD-1 Settlement Statement. Therefore, when updating fees for title charges, endorsements, recording fees, and other miscellaneous fees,...
	Also, remember to click the Update HUD button  before closing ATG Edit Services.



	B. Custom Invoices
	1. Consumer Fees
	REsource computes consumer fees for the Owner’s Policy and Loan Policy, Endorsements, Search Fees, and Closing Fees based upon the location of the property. However, your individual pricing for these services may differ from the default calculations. ...

	2. Municipal Transfer Taxes
	REsource computes municipal transfer taxes and populates the fee on both the Invoice for Title Charges and the HUD-1 Settlement Statement. To request that municipal transfer taxes not appear on your Invoice for Title Charges, please contact your Membe...


	C. Separate Search Fees on the Invoice and HUD-1 Settlement Statement
	Follow the instructions below if search fees are not part of the total title charge (Downstate Illinois only).
	1. Select the Search Provider in the Main tab of Order Entry or, if the member provided the search, enter the Member Number. This will create a disbursement for search fees to the search provider or to the member.
	2. Go to the Edit Services screen and click the Search tab.
	3. Check the Initial Full w Prior or Initial Full wo Prior checkbox.
	4. Double-click the Buyer or Seller column to display the Consumer Charge Override dialog box.
	5. Enter the amount of the search in the Buyer or Seller Charge field and click OK.
	6. If ATG does not provide search, double-click the ATG column, enter “0” in the Special Rate field, and click OK.
	7. To add a Later Date Search Fee, click the Add Later Date button  and double-click Open Date to display the Later Date Search dialog box. Enter the Later Date Search Fee in the Buyer or Seller column and click OK. The search fee will be a separate l...
	8. Select either the Doc Inv 2010 BO Sep Srch, Doc Inv for Title BO Sep Srch, or Doc Inv 2010 NBO Sep Srch/Doc Inv for Title NBO Sep Srch: No breakout of title charges and separate search fees.



	6 |  Printing REsource® Documents
	I. Select Documents to Print
	A. To print REsource documents, click the Print Documents button  located on the top toolbar or select Utilities > Print/Create Documents.
	B. Select documents to print by entering the prefix (see complete list of documents listed below) in the Search Characters dialog box or use the Scroll Bar or press <Page Down>. Then, either double-click the document name or click once on the document...
	Additionally, documents may be selected for printing by using the Category function. The Category function groups documents by type. To select a document using the Category function, click the drop-down  in the Category field to view a list of documen...

	C. Searching for a Document using Exact and Contains
	1. The Exact and Contains radio buttons allow a search for a document name by using a keyword.
	2. Select the Exact radio button  and enter a keyword in the Search field to search for the exact name of the document.
	 NOTE: Use the document prefix.

	3. Select the Contains radio button  and enter a keyword in the Search field. For example, typing “deed” in the Search field will display all document with the word “deed” as a part of the document name.

	D. Documents can be filtered by using the Category drop-down.  Groups of documents types such as Affidavit, Commitment, Deeds, etc. are listed. The Exact and Contains search also works within Categories.
	E. The Sort by State checkbox  lists the documents by state.
	Select the state from the Filter by State drop-down  to display documents available in a state.


	II. Printing a REsource Document
	To select document(s) to print, highlight the document(s) and either double-click the document name or click the Select Document button  to move the document(s) to the Print Document list on the right.
	A. Clear Selections  clears all selected documents from the Print list.
	B. Delete Current Selection Only  clears only the highlighted document from the Print list.
	C. Print Documents  prints all selected documents.
	Wisconsin Members: Select Wisconsin Documents from the Category drop-down to display all common Wisconsin forms. Documents highlighted in teal are packages; following them are individual documents. Only Wisconsin-specific and common documents are list...


	III. Document Viewer
	File data merges with the documents selected to print and displays in the Document Viewer. From the viewer, documents can be printed or saved locally as Word or PDF documents.
	A.  Prints current or all documents.
	B.  Sends current or all document(s) to Word.
	C.  Converts current or all document(s) to PDF.
	 NOTE: Although you can edit documents before you print, we recommend that you do not change any data. Instead, return to Complete Closing and make appropriate data changes in the data entry field. Otherwise, the data changes in your document will no...


	IV. Saving a Document Locally
	A. Windows XP Operating System
	When a document appears in the Document Viewer, select Send To or Send All To and then select Word, Outlook, or PDF

	B. Windows Vista or Windows 7 Operating System
	Select File > Save As or File > Save Current as PDF. Select your desired local drive and folder.


	V. Prompts Tab
	A. When a document containing a prompt is selected to print, the user will enter the answer at the prompt and the answer will appear in the document. The answer is then saved in the Prompts tab. If the document is reprinted, the prompt will not displa...
	B. The Prompts tab is used to edit or view answers entered in a prompt. The Prompts tab displays a list of previously printed documents that contain answers to prompts.
	 NOTE: The Prompts tab displays only if a document containing a prompt has been printed and the prompt was answered.

	C. To edit the answers to a prompt in a previously printed document:
	1. Select the Prompts tab.
	2. Click the Plus button in front of the document. The answer appears in green.
	3. Click in the green data field and enter the new answer.
	4. When finished, click the Print Documents tab and select the document(s) to print. The document will now contain the new answer.

	D. To delete the data in a prompt:
	1. Right-click the green answer and select Delete or press <Ctrl>+<Del>.
	2. If the data in a prompt has been deleted, you will receive a new prompt the next time the document is selected to print.


	VI. Document History
	The Display Change Log button,  located at the bottom left corner, displays a history of any changes that have been made to a prompt.

	VII. Additional Features
	A.  Select Document: Double-click or click the Select icon to move the document to the print list on the right
	B.  Clear Selections: Clears all documents in the print list on the right.
	C.  Delete Current Selection Only: Clears only selected documents in the print list on the right.
	D.  Print Documents: Selected documents open in the Document Viewer and can be printed, saved locally, or sent by e-mail as an attachment.
	E.  Print w/o View: Selected documents are sent directly to the printer without displaying in the Document Viewer.
	F.  Publish to PaperlessCloser: Selected documents are available in PaperlessCloser.

	VIII. Print Documents List
	A. Following is a list of all documents located in the Print Documents list.
	 NOTE: Documents are added to REsource upon request or as needed. To request a new document, contact a Member Representative or the HelpDesk and provide a sample of the document.

	B. REsource Documents
	REsource documents are organized by prefix.
	1. ATG
	Groupings or packages of related documents

	2. DOC
	Closing Documents, Affidavits, Powers of Attorney, Invoices, Transfer Documents

	3. END
	Endorsements

	4. NEW
	Instructions or announcements regarding new release information in REsource

	5. POL
	Commitment and Policy Schedules and Jackets

	6. WI
	Wisconsin Documents




	7 |  HUD-1 Settlement Statement
	I. Data Required
	As with the HUD in previous versions of REsource, specific data must be entered in Order Entry and ATG Edit Services  for title charges to appear on the 2010 HUD or the Speed HUD.
	The following process should be followed for either HUD.
	A. Required data in Order Entry:
	1. Sale Price*
	2. Loan Amount*
	3. Interest Rate (required for the GFE)
	4. Principal & Interest (required for the GFE)
	5. Earnest Money, including who is holding the earnest money and if it should be deducted from the commission
	6. Property Address, including County*
	*Required data prior to opening ATG Edit Services

	B. Required data in ATG Edit Services:
	1. Endorsements
	2. Closing Services
	3. Search Services
	4. Recording Fees
	5. Miscellaneous entries, if any


	II. To Change the Type of HUD
	A. Close all open windows
	B. Click Utilities >Additional Fields.
	C. Enter “Y” or “N” in the Use HUD 2010 field and close.
	 IMPORTANT NOTE: Any data entered in the previous HUD will not pull through to the new HUD; therefore, it must be re-entered. Also, any services selected in the ATG Edit Services menu  must be re-selected. You must go back to ATG Edit Services  and r...


	III. Invoice for Title Charges
	There are now two types of invoices available; one for the 2010 HUD and one for the Speed HUD. You must use the invoice based upon the type of HUD.
	A. 2010 HUD Invoice
	1. Doc Invoice 2010 BO Chicago Area
	2. Doc Invoice 2010 NBO Chicago Area
	3. Doc Invoice 2010 BO Separate Search
	4. Doc Invoice 2010 NBO Separate Search

	B. Speed HUD Invoice
	1. DOC Inv For Title BO Chicago area
	2. DOC Inv For Title NBO Chicago area
	3. DOC Inv For Title BO Sep Search
	4. DOC Inv For Title NBO Sep Search


	IV. File Locking
	File locking has been added to prevent multiple users from entering data at the same time to the same file. To insure that you are leaving your current file available for other users, either log out of REsource or select the Temporary File option  fro...

	V. HUD Settlement Statement Screen
	A. The 2010 HUD layout is similar to a printed HUD document. There are three tabs: Page One, Page Two, and Page Three (GFE).
	B. To assist you in navigating quickly within the 2010 HUD screen, there are a number of toolbar buttons, identified below. The figure below identifies all of the buttons on the 2010 HUD screen. The Expand All Sections  and Contract All Sections  butt...
	1. Print HUD Statement
	a. Click this button to view/print the entire HUD.
	b. To print only the Buyer’s HUD or Seller’s HUD directly to the printer, click the drop-down arrow on the Print HUD button,  and select from the drop-down list.

	2. Publish the HUD Statements to PaperlessCloser
	a. Click this button to publish HUD to PaperlessCloser.
	b. To publish only the Buyer’s HUD or Seller’s HUD, click the drop-down arrow  on the Publish HUD Statement to PaperlessCloser button and select from the drop-down list.

	3. Use a Template
	Click this button if a HUD template has been defined with appropriate defaults for this HUD.

	4. Switch to HUD-1
	Click this button to Switch to HUD-1.

	5. Switch to HUD-1A  Not in use at this time.
	Click this button to change the HUD to a simplified 1-A format. This form displays only borrower/lender information and the form has some different sub-tabs, as well as blocked access to other tabs. You can only enter information into the tabs/fields ...

	6. Paid by Other Parties
	Click this button to pull up the Paid By screen in any section of the HUD that requires designating a party to pay a fee for the buyer or seller. This feature is not recommended. For further assistance, please contact the REsource HelpDesk.

	7. Show Lender Breakdown Report
	Click this button to preview the Lender Breakdown Report. The report shows the expected loan amount and the lender’s check amount before creating Receipts and Disbursements in Check Writing.

	8. Lock/Unlock the HUD
	a. Click the Lock button  to lock the HUD so it cannot be altered.
	b. Click the Unlock button  to edit the HUD.
	When you lock or unlock the HUD, a confirmation message displays. Click Yes to confirm and continue.

	9. Navigation
	a. Use the shortcut keys or the Jump to Next Section button  (located on the toolbar) to move through the 2010 HUD. Click the button to move to the next HUD section or click the drop-down arrow to display the Navigation drop-down list to move to desir...
	b. Move through the fields on the 2010 HUD by pressing <Tab> key on your keyboard or by clicking your mouse on the desired line or section.
	c. When text is too long to be displayed in full, an ellipsis (…) appears at the end of the displayed text. The text can be viewed by rolling the mouse over the truncated text.
	d. Read-only fields are indicated with shading. Some information in the shaded areas can be overridden.

	10. Recalculation
	Click the Refresh button  to recalculate all items on the HUD.

	11. Current Status of the HUD
	Click the Status drop-down  to change the status of the HUD.
	 WARNING: This Warning button  will display if the Sale price or Loan Amount has changed. Return to ATG Edit Services to auto-calculate premiums. (Uncheck and recheck closing fee.)


	C. Buttons within the HUD
	Within the 2010 HUD, there are several buttons that may display, depending on the section in which your cursor is placed.
	All buttons and icons offer hints as to their functionality when you hold your cursor over the button/icon.
	1. Add New Line to the HUD.
	When you click this button, a new line is placed at the end of the selected section. Available in Page Two tab only.

	2. Delete a line in the HUD.
	Click Yes to the delete prompt. Available in Page Two tab only.

	3. Insert New Line into the HUD.
	When you click this button, a new line is inserted above the line in which your cursor is placed. If you try to insert a line in an inappropriate place, an error message will appear. Available in Page Two tab only.

	4. Set Override
	When you click this button, the override is applied. The particular override depends on the section of the HUD in which it is used. Available in Page Two tab only.

	5. Set Partial Override
	When you click this button, the partial override is applied. Available in Page Two tab only.

	6. Clear Override
	When you click this button, the full or partial override is cleared. Available in Page Two tab only.

	7. Calendar
	Click to open and make date selection.


	D. Additional Icons
	These additional icons may appear on the 2010 HUD:
	If you enter a payee in a debit/credit line, the debit/credit no longer displays.

	E. 2010 HUD Page One
	1. Page One Tab: Sections 100-500
	The Page One tab contains:
	a. Type of Loan
	Click the appropriate check box.

	b. Funding Date
	Enter the date the loan is funded (disbursed).

	c. Status
	Select the current HUD Status from the drop-down list.

	d. Property Location, Borrower, Seller, Sale Price, Earnest Money, Lender Information (including Loan and Mortgage Ins Case Numbers)
	Entered and edited in Order Entry.

	e. Settlement Information and Date
	Entered and edited in Order Entry.

	f. Sections 100a, 100b, 200a, 200b, 400a, 400b, 500a, 500b
	These tabs automatically import data from entries in Sections 700-1300.


	2. Enter Additional Line Items:
	a. Click on or <Tab> to the blank line(s) available and enter an Item Description.
	b. Press <Tab>. The POC checkbox appears.
	c. Select this checkbox and enter POC Code, if applicable, and press <Tab>.
	 NOTE: If this checkbox is not selected, it disappears when <Tab> is pressed again.

	d. If more lines are needed, use Section 1300 or the Edit Payoff button.  For more information on editing payoffs, please refer to the Edit Payoff documentation.

	3. Section 200a
	a. Complete Closing inserts amounts for Lines 201 and 202 from the information entered in the Loan tab in Order Entry.
	i. The description for Line 201 can be changed by typing over the existing text.
	ii. To change the Earnest Money amount, go to the Loan tab in Order Entry.

	b. Enter Debit/Credit:
	Double click the D/C checkbox and it will copy the item and amount to the corresponding line.
	 NOTE: Marking an “X” in the POC field will apply a credit to the Loan Amount.

	c. This section also displays the party holding the earnest money, as entered in the Order Entry screen, Loan tab, and allows you to change it, if necessary, by selecting another option. Click the Expand this Section button located in the 200 section ...

	4. Lines 210, 211/510, 511
	a. Tax Prorations
	i. Click the Prorations dialog button  in the toolbar located to the right of the Adjustments for items unpaid by seller section.
	(1) The Flex Prorations dialog box opens.
	(2) Enter the Proration Date or check Use Closing Date.
	(3) Click Edit.
	(4) Check the Override dates and amount checkbox.
	(5) Click Next.
	(6) Payment: Not Yet Due
	(7) Enter the Amount of the tax proration.
	(8) Click Next.
	(9) Enter the dates of the tax proration.
	(10) Click Finish.
	Repeat this process for each tax period by moving to the next line. Click Close when finished.
	 NOTE: You must click the Refresh button  to display tax amounts.
	 NOTE: As with all lines on page one of the HUD, such as tax payments disbursed at closing, use the Expand This Section button  from the toolbar  located to the right of each section.



	5. Lines 300-303
	Complete Closing automatically updates and calculates these fields.

	6. Section 400
	7. Section 500a: Reductions in Amount Due to Seller
	In Section 500a, Complete Closing Line 502, Settlement Charges to Seller is a total of charges to Seller from Sections 700 through 1300. Additional lines can be added as disbursement or credit items on the Seller side by entering information on Lines ...

	8. Lines 600-603: Cash at Settlement From/To Seller
	Complete Closing automatically updates and calculates these fields.


	F. 2010 HUD Page Two
	The Expand All Sections button  must be selected when working on page 2 of the 2010 HUD.
	1. To enter a negative figure anywhere on the HUD, begin the number with a minus sign (-), Negative numbers are displayed in parentheses (###).
	2. Leave all Account Code fields blank.
	3. Additional lines of information can be inserted after the last line in any section of the Page Two tab (Sections 700-1300, except 1000) or use the toolbar  located at the top right of each section.
	a.  Add a line.
	b.  Delete a line.
	c.  Insert a line.
	d.  Override/Clear Override.
	e.  Enter Paid by Other Parties.

	4. Sections 800-1000
	The following codes are used in the POC (Paid Outside of Closing) column within the HUD:
	a. “X” to withhold funds from the loan amount;
	b. “B” if the Buyer pays outside of closing;
	c. “S” if the Seller pays outside of closing;
	d. “L” if the Lender pays outside of closing;
	e. “Y” for lender-paid closing costs.
	 NOTE: The code “X” can be used on page one of the HUD for credits to the buyer.

	5. Section 700: Broker’s Commission
	a. Line 700: Total amount of commission.
	b. Lines 701-702: Enter the payee(s).
	c. Line 703: Actual amount of commission disbursed.
	 NOTE: Commission percentage no longer prints on the 2010 HUD document.

	d. Earnest Money
	When entering Earnest Money in the Order Entry/Loan screen, the user will receive a pop-up window displaying, “Who is Holding the Earnest Money?”
	i. You must enter the Seller’s Realtor in the Seller tab of Order Entry and the Buyer’s Realtor in the Buyer tab of Order Entry for the correct calculation of commission and Earnest money to occur automatically.
	ii. If either Seller’s Realtor or Buyer’s Realtor is selected, a Confirm dialog will appear asking if the earnest money amount should be deducted from the Realtor’s commission check.
	(1) If you select “Yes,” the amount withheld will appear on the HUD in Section 700 as a disclosure line.
	When this happens, the system will also place the Earnest Money on Line 201 and on Line 506 as a Debit/Credit item for the Buyer and Seller. (See RESPA directive.)

	(2) If you select “No,” the amount will appear on Line 507 as “(EMD $ 00.00 Disbursed as Proceeds).”



	6. Section 800: Items Payable in Connection with Loan
	a. For all items in Section 800, the payee defaults to the first lender. It is not necessary to enter a payee in the Payee column unless you want to change it to a different payee.
	 NOTE: Switch to the Expand All view  in this section to more easily use the Clear Override button.

	b. In Section 800, items are listed by the lender mainly from GFE #3. POC items are still handled the same.
	i. 801 Breakout Charges
	(1) The 801 Breakout Charges feature allow items included in line 801 to be broken out in Check Writing but not disclosed on the HUD. To breakout charges for Line 801 and not disclose them on the HUD, select the 801 Breakout Charges screen  located in...
	(2) On the 801 Breakout Charges screen, enter fees that are payable to other parties. In Check Writing, the items entered here are deducted from the disbursed check paid to the payee on Line 801.
	(3) In this example, the total amount on Line 801 is $1,000.00 to ABC Lender. However out of that total amount, $100.00 should be disbursed to Document Preparer, Inc., and $100.00 should be disbursed to Mortgage 1 Network.
	(4) In Check Writing, the amount to ABC Lender will be $800.00 and separate checks will be created to Document Preparer Inc. for $100.00 and Mortgage 1 Network for $100.00.
	(5) Additionally, the code “Y” in the Who POC field will add the amount to the lender’s funds and create a check to the payee in Check Writing. And, the code “X” in the Who POC field will deduct the amount from the Lender’s funds in Check Writing.
	(6) The Origination Charges Report prints an itemized list of fees that are included on Line 801. To print the Origination Charges Report click the Print  button located on the 801 Breakout Charges screen.

	ii. Lines 801 and 802 display the amounts outside the columns with their total displayed on Line 803.
	(1) Payees, along with POC X, must be placed on Lines 801 and 802, as the check for these lines come from that field and not from Line 803.
	(2) Yield Spread and Broker Fee are no longer displayed as a single line item. The amount is rolled into Line 802.
	(a) It will be a positive number if the buyer is paying points.
	(b) It will be a negative for any credit from the lender to the buyer, including the Yield Spread. (See RESPA Directive.)


	iii. Additional Lines Dialog
	You can add new lines to this section. When you do, an Additional Lines dialog appears, giving you the option to select a GFE #3 item (inside the column), a General Line item (inside the column), or a Disclosure line for information as needed (outside...



	7. Section 900: Items Required by Lender to be Paid in Advance
	Enter the daily interest charge or a percentage and the 2010 HUD will calculate the amount per day. Click the Set Line 901 Override button  or press <Ctrl>+<O> to override the read only information in the Paid From Borrower’s Fund at Settlement column...
	a. Line 901: Interest
	Enter the beginning and ending dates for interest using the Calendar button  or entering the year in two-digit format.

	b. Lines 902 and 903: Mortgage and Homeowner’s Insurance Premiums
	i. Premium amounts entered in these lines will transfer the monthly amount to Lines 1001 and 1002.
	ii. Select the MIP checkbox on Line 902 when a Lump Sum MIP payment is made at settlement. The line should read ‘“MIP for Life of Loan.” (See RESPA Directive.) Lines 901 and 903 come from the GFE #10 and #11, respectively.


	8. Section 1000: Reserves Deposited with Lender
	ALL numbers will be outside the column except for Line 1001, which is a roll-up line totaling all of the items in Section 1000. Line 1001 comes from the GFE #9. The number of months, the monthly amount, and the total for that line roll-up to Line 1001...

	9. Section 1100: Title Charges
	a. Line 1101 is a roll-up line of items that are from the GFE #4. Line 1103 is also referenced by the GFE #5, which includes Lines 1102, 1104, additional lines, and any lines added that are directed by GFE #4.
	i. The fees for the Owner’s Policy and Loan Policy plus endorsements and other title-related services selected in ATG Edit Services populate the Premium Information screen and additional fees, such as a 24-month Chain of Title and other miscellaneous ...
	 REMINDER: Select all services, including endorsements, closing services, recording fees, etc., in ATG Edit Services to automatically populate the HUD.

	ii. Premium Information
	(1) To obtain premium information, click the Premium Information button  in the toolbar  located at the top right of Section 1100.
	(2) Services displayed in the Premium Information screen populate from the ATG Edit Services screen. Edits should be made in the ATG Services screen.
	(3) Click the Print button  to print an itemization of services listed in the Premium Information screen.

	iii. Additional Title Services
	(1) The Additional Title Services screen allows you to enter additional charges on Line 1101. Amounts entered in the Borrower column display in Borrower column on Line 1101 and amounts entered in the Seller column display in Seller column on Line 1101...
	(2) Select all items in Edit Services.  All selected services will populate the Additional Title Services window except those items that populate the Premium Information  or the 1200 section of the HUD.
	 NOTE: Miscellaneous items entered in the Edit Services screen populate Section 1300 of the HUD or the Additional Title Services screen.

	(3) To open the Additional Title Services screen, click the Additional Title Services button  located on the toolbar in Section 1100.
	(4) Enter the payees for items that populate from Services.
	(5) To add items manually, use the plus  button to add items and the minus button  to delete items. Enter the description, payee, and amount for each item. Click OK when finished.
	(6) The Title Services Report prints an itemized list of fees that are included on Line 1101. To print the Title Services Report, click the Print button  located in the Additional Title Services screen.


	b. Line 1102: Settlement or Closing Fee
	Line 1102 displays the Settlement and Closing Fee and rolls up to Line 1101. Select either Full Closing or Member Closer in ATG Edit Services. The closing fee will calculate based on the sale price and populates Line 1102.

	c. Line 1103: Owner’s Title Insurance
	i. The Owner’s title insurance fees can be shown in the Buyer or Seller column, depending on the GFE provided by the lender. By default, the Owner’s title insurance fees appear in the Buyer column.
	ii. If the Owner’s title insurance fee is a GFE #5 item, it should remain in the Buyer column. A corresponding credit will automatically appear in Sections 200 and 500 on page 1 of the HUD.
	iii. If the Owner’s title insurance fee is not on the lender’s GFE, it can be placed in the Seller column.
	iv. To override the party responsible for payment of the Owner’s title insurance fee, click the Premium button  on the Section 1100 toolbar  and change the Who Pays override to Seller Pays – Non GFE Item.
	 NOTE: You must then override Line 1103 to remove the Owner’s title insurance fee from the Buyer column and enter the Owner’s title insurance fee manually in Seller Column.

	d. Line 1104: Lender’s Title Insurance; displays outside the column.
	e. Lines 1103 and 1104 auto fill if the Premiums calculator is used. If not, press <Ctrl>+<O> or click the Override button  to manually enter the amounts.
	f. Lines 1105 and 1106 display the total premium, including endorsements.
	g. Lines 1107 and 1108 display the Agent portion and the Underwriter’s portion, respectively. The lines auto-populate if ATG Edit Services has been utilized. To override, press <Ctrl>+<O> or click the Override button.
	h. Additional Lines
	When a new line is added to this section, an Additional Lines dialog appears, providing the option to select:
	i. GFE #4: items will appear outside the column and roll up to Line 1101;
	ii. GFE #5: items will appear outside the column and rolls up to Line 1103;
	iii. General Line: items will appear inside the column and do not roll up to either line; or
	iv. Disclosure: line will allow for typing data for informational purposes only.

	i. Premiums
	Click the Premiums button to view the Owner’s and Loan Policy premiums. Complete Closing pulls figures based on your rates that were calculated in ATG Edit Services. Premiums are based on sale price, loan amount, and county of the property entered in ...

	j. Endorsements
	Select endorsements in ATG Edit Services.


	10. Section 1200: Government Recording and Transfer charges
	a. Recording Fees
	i. All Buyer recording fees roll up to Line 1201, which is also referenced by GFE #7. Additional Fields can be used for calculating the page count totals for Line 1202.
	ii. Recording fees, if entered in ATG Edit Services, populate the appropriate HUD lines. They can also be entered manually. Be sure to enter the correct payee.

	b. Transfer Taxes
	i. Appropriate State, County, and Municipal transfer taxes populate the HUD on Lines 1204, 1205, 1211, and 1212.
	ii. State and County transfer taxes populate as Seller charges by default. They may be moved to the Buyer column by deleting the amounts in the  Seller column.

	c. Line 1203 is a roll-up line including the total of all taxes, also from GFE #8.
	d. Additional Lines
	When a new line is added to this section, an Additional Lines dialog appears, providing the option to select Recording Charge (outside the column and included on Line 1201), Transfer Tax (outside the column and included on Line 1203), or General HUD L...


	11. Section 1300: Additional Charges
	a. Use Section 1300 to enter miscellaneous additional charges.
	b. Line 1301 (GFE #6) totals of all GFE #6 items. These line items are displayed outside the column.
	c. Additional Lines
	General Lines can be added that print inside the column and do not roll up. For each line added, specify the type of line desired.

	d. Section 1400
	Section 1400 shows the total charges from Line 103 (Section J) and Line 502 (Section K).



	G. GFE Bucket Allocation
	1. The GFE Bucket Allocation screen allows you to designate GFE lines on Page 2 to the appropriate section/bucket on Page 3. The items that display in this screen are HUD lines labeled as GFE from Page 2 paid for by the borrower, plus any amounts that...
	2. Sections 900, 1000, 1100, and 1200 pull rollup lines to this screen and Sections 800 and 1300 pull itemized lines to the screen.
	 NOTE: Lines 801, 802, 803, 1201, 1203, 1001, 901, and 903 do not display in the GFE Bucket Allocation screen. These lines are required and automatically display on Page 3 in the designated section determined by RESPA.

	3. To open the GFE Bucket Allocation screen, click the GFE Bucket Allocation button  located on the main toolbar.
	The button is highlighted in yellow to alert you when items need to be allocated to the appropriate section on Page 3.

	4. Select the appropriate bucket for each item by clicking the drop-down arrow in the Bucket column. The choice is either 10% Tolerance (Bucket 2) or Can Change (Bucket 3).
	5. When finished:
	a. Click OK to move the items from the Allocation screen to Page 3;
	b. Click Apply to move the items from the Allocation screen to Page 3 and keep the screen open; or

	6. Click Cancel to exit the screen without saving changes.

	H. Page 3
	Each section of Page 3 has a toolbar that allows a line to be added, deleted, inserted, or overridden.  Hover over the title bar to activate the toolbar.
	1. The first section is for Charges That Cannot Increase from the GFE.
	a. When opening page 3, the HUD-1 column automatically populates Lines 801, 802, 803, and 1203.
	b. You must enter the amounts in the Good Faith Estimate column. These amounts should be the same as the amounts shown in the HUD-1 column.

	2. The next section is for Charges That in Total Cannot Increase More Than 10%.
	a. HUD line items populate the amount in the last column. Line 1201 is an automatic line.
	b. Lines can be added by clicking the line number, tabbing down, and entering another HUD line number, which will fill in the description and the HUD amount. Charges listed on the GFE must be added manually.
	c. Lines can also be added using the toolbar that appears when the mouse is moved to the right of the HUD-1 column heading.
	d. The totals appear at the bottom of the section along with the Increase between GFE and HUD-1 Charges, shown as both a dollar amount and a percentage, showing if the increase is within tolerance. You will then need to make the necessary adjustments.

	3. The third section is used for Charges That Can Change.
	a. Lines 1001, 901, and 903 are required lines and populate automatically.
	b. You must enter the GFE amount.
	c. Lines can be added by clicking the line number, tabbing down, and entering another HUD line number, which will fill in the description and the HUD amount. You will need to add the charges listed on the GFE.
	d. Lines can also be added using the toolbar that appears when the mouse is moved to the right of the HUD-1 column heading.

	4. The fourth section is used for Loan Terms Info for HUD-1/HUD-1A Form.
	a. The Initial Loan Amount, Loan Term, and Initial Interest Rate automatically populate from the Order Entry/Loan screen. All other amounts must be entered manually.
	b. Yes/No Drop-downs
	i. Selecting Yes activates a series of sub-fields that must be filled in.
	ii. Subfields are inactive (greyed out) when No is selected.



	I. HUD-1 Addendum
	1. Use the Addendum screen to itemize or breakdown charges referenced on the HUD-1, such as seller paid closing costs or to comply with VA requirements.
	a. To open the Addendum screen, click the HUD Addendum button  on the main toolbar.
	b. Enter a description in the Description of Charges field, itemized on this addendum, such as the HUD line number and/or the description from the HUD line you are itemizing. The number of addendums for this order displays.
	c. To add charges from the HUD-1, enter the HUD Line Number. The amount and description automatically populates based on the HUD-1 amount.
	 NOTE: The HUD-1 Amount field is read-only and cannot be changed.

	d. Enter the HUD line number or description of the item that is part of the grouped charge or credit.
	e. Enter the amount of the item in the Addendum Amount field. Continue entering items as necessary.

	2. Use the  button to add a new addendum and the  button to delete the current addendum. Enter a Description and Addendum Amount for each item. Click OK when finished.
	3. The HUD-1 Addendum prints an itemized report that displays all charges that are included in the Addendum screen. When multiple addendums exist on an order, the report separates the charges with the description entered in the Description of Charges ...
	4. Click the Print button  located in the HUD-1 Addendum screen to display the addendum in the Print Preview screen, where it can be printed, saved, or emailed.

	J. Navigation
	To assist you in navigating the HUD Settlement screen, there are a number of toolbar buttons and hotkeys (keyboard shortcuts). The online help also provides assistance as you work within the program.
	1. Toolbar Buttons
	2. Hotkeys


	VI. RESPA Directives
	A. RESPA Directive for Items being Paid by Seller that was Included on the GFE
	1. If a seller pays for a charge that was included on the GFE, the charge should be listed in the borrower’s column on page 2 of the HUD-1.
	2. The charge is then offset on page 1 of the HUD-1 in the 204-209/506-509 sections with a debit/credit line item.
	3. If someone other than the seller is paying a charge that was included on the GFE, that too is shown in the borrower’s column with an offsetting credit on page 1.

	B. RESPA Directive Concerning Yield Spread/Broker Fees
	Indirect payments from a lender to a mortgage broker may not be disclosed as POC, and must be included as a credit on Line 802.

	C. RESPA Directive for Line 902
	If a lump sum mortgage insurance premium paid as settlement is included on Line 902, a note should indicate that the premium is for the life of the loan.

	D. RESPA Directive for Loan Terms
	The lender must provide this information in a format that permits the settlement agent to simply enter the necessary information in the appropriate spaces, without the settlement agent having to refer to the loan documents themselves.


	VII. Speed HUD Settlement Statement Overview
	A. The Speed HUD Settlement Statement is only used for cash or commercial transactions. For all other transactions, the 2010 HUD Settlement Statement must be used. Since all new files (opened after March 26, 2010) default to the 2010 HUD, it is necess...
	B. To change a 2010 HUD to a Speed HUD:
	1. Close all other data entry menus.
	2. Click Utilities > Additional Fields.
	3. Enter “N” in the Use HUD 2010 field and close.
	4. Click the Speed HUD button.  The Speed HUD opens.
	 IMPORTANT NOTE: Any data entered in the previous HUD will not populate the new HUD; therefore, it must be re-entered.

	5. Go to ATG Edit Services and select all title services.
	6. Go to the Speed HUD and enter fees.
	The Speed HUD is used to enter all the information necessary to produce a HUD-1 Settlement Statement. The Speed HUD layout is similar to a printed HUD document. The Speed HUD utilizes data that has been previously entered in Order Entry and ATG Edit S...



	VIII. Speed HUD Settlement Statement Screen
	A. Use one of the following three methods to access the Speed HUD:
	1. Click the HUD Settlement Statement button drop-down arrow  and select the Speed HUD button.
	2. Select Data Entry >Speed HUD from the menu bar.
	3. Press <Alt>+<D>, then <P>.
	The Speed HUD screen displays:


	B. Tabs
	There are two tabs: Page One and Page Two.
	1. Page One
	The Page One tab contains:
	a. Type of Loan: Click the appropriate checkbox.
	b. Funding Date: Enter the date the loan is funded (disbursed).
	c. Status: Select the current HUD Status from drop-down list.
	d. Property Location, Borrower, Seller, Sale Price, Earnest Money, Lender Information (including Loan and Mortgage Ins Case Numbers): Entered and edited in Order Entry.
	e. Settlement Information and Date: Entered and edited in Order Entry.
	f. Sections 100a, 100b, 200a, 200b, 400a, 400b, 500a, 500b.

	2. Page Two
	a. The Page Two tab contains Settlement Charges.
	b. Additional lines can be inserted after the last line in most sections of the Page Two tab (Sections 700-900 and 1100-1300).
	i. To add new lines of information:
	(1) Move the cursor to the last column in the last line in the section in which you want to add a new line and press <Tab>. Complete Closing will create a new HUD line, numbered sequentially after the last existing one.
	(2) Position the cursor in the first column of the last HUD item and press the <↓> key.

	ii. To delete a manually-added line:
	(1) Click anywhere in the line and press <Ctrl>+<Delete>; or
	(2) Right-click and select Delete Line, then click Yes to confirm.


	c. Every HUD line item, except Debit/Credit items, must include a payee. Use the Agent list to enter a Payee in the To field. (Every payee comes from the Agent list.) The Payee button  appears to the left of the column when no payee has been selected.
	d. Leave all Account Code fields blank.
	e. To enter a negative figure anywhere on the HUD, begin the number with a minus sign (-). Complete Closing displays negative numbers in parentheses (####).


	C. Navigation
	1. Use the hotkeys or the Jump to Next Section button  to move through the Speed HUD.
	2. Jump to Next Section Button
	Click the button to move to the next HUD section or click the drop-down arrow to display the navigation drop-down list and select the desired section number.


	D. Hotkeys
	1. Right-click any field to see the hotkeys (keyboard shortcuts) available for that field.
	2. Speed HUD hotkeys include:
	3. Move through the fields on the Speed HUD by pressing <Tab> or by clicking on the desired line or section.
	4. When text is too long to be displayed in full, an ellipsis (…) appears at the end of the displayed text. The text can be viewed by rolling the mouse over the truncated text.
	5. Read-only fields are indicated with shading. Some information in the shaded areas can be overridden.

	E. Expanding and Collapsing a Section
	1. Many sections of the Page One tab can be expanded. Use the Expand button  in the section toolbar to expand that section. Additional columns, buttons, and/or fields display, depending on the section. <Ctrl>+<K> also toggles the section between norma...
	2. For example, to expand Section 100a, click the Expand button.  The section expands to display Payee, as shown below. Where applicable, the POC field also displays.
	3. To return the section to its collapsed original format, click the Collapse button.
	4. Sections on the Page Two tab can be expanded and collapsed at one time. To expand all sections at once, click the Expand All Sections button  on the toolbar or right-click to display the menu and select Expanded View.
	5. To contract the page, click the Contract All Sections button  or right-click to display the menu and select Expanded View.

	F. Toolbar
	To assist you in navigating the Speed HUD, there are a number of toolbar buttons, identified below. The Expand All Sections  and Contract All Sections  buttons are only visible on the Page Two tab.
	1. Print HUD-1 Settlement Statements
	a. Click the Print HUD button  to print the entire HUD.
	b. To print only the Buyer’s HUD or Seller’s HUD, click the drop-down arrow on the Print HUD button  and select from the drop-down list.

	2. Preview HUD Statements
	Click the Preview HUD button  to preview the HUD prior to printing. To preview only the Buyer’s HUD or Seller’s HUD prior to printing, click the drop-down arrow on the Preview HUD button and select from the drop-down list.

	3. Publish to PaperlessCloser
	Click the Publish to PaperlessCloser button.  To publish only the Buyer’s HUD or Seller’s HUD, click the drop-down arrow on the Publish HUD button and select from the drop-down list.

	4. Switch to HUD-1
	Click the Switch to HUD-1 button.

	5. Switch to HUD-1A
	Click the Switch to HUD-1A button  to change the HUD to a simplified 1-A format. This form displays only borrower/lender information and the form has some different sub-tabs, as well as blocked access to other tabs. You can only enter information into...

	6. Lock/Unlock the HUD
	a. Click the Lock HUD button  so the HUD cannot be altered.
	b. To edit the HUD, click the Unlock HUD button.
	c. When you lock or unlock the HUD, a confirmation message displays. Click Yes to confirm and continue.

	7. Tax Proration and Override System
	Defaults to Standard/Full override. Please leave as is this allows for manual entry of dates and amounts for tax prorations.

	8. Use a Template
	Click the Template button  if a HUD template has been defined with appropriate defaults for this HUD.

	9. Paid by Other Parties
	Click the Paid by Other Parties button  to pull up the Paid By screen in any section of the HUD that requires designating a party to pay a fee for the buyer or seller.
	 NOTE: This feature is not recommended. For further assistance, please contact the REsource HelpDesk.

	10. Show Lender Breakdown Report
	Click the Show Lender Breakdown Report button.  The report shows the expected loan amount and the lender’s check amount before creating Receipts and Disbursements in Check Writing.

	11. Jump to Next Section
	a. Click the Jump to Next Section button  to move to the next HUD section or click the drop-down arrow to the right of the button to display the Navigation drop-down list.

	12. Expand/Collapse All Sections. Available in Page Two tab only.
	Expand or collapse all sections in page two at one time.
	a. To expand all sections at once, click the Expand All Sections button  or right-click to display the menu and select Expanded View.
	b. To collapse all sections at once, click the Contract All Sections button  or right-click to display the menu and select Contracted View.

	13. Current Status of the HUD
	Click the Status drop-down  to change the status of the HUD.


	G. Buttons within the HUD
	Within the Speed HUD, there are several buttons that may display, depending on the section in which your cursor is placed.
	 NOTE: All buttons offer hints as to their function when you hover the cursor over the button.

	H. Additional Buttons
	These additional buttons that may appear on the Speed HUD:
	 NOTE: If you enter a payee in a debit/credit line, the debit/credit no longer displays. If you enter a debit/credit in a line, the payee no longer displays.

	I. Page One Tab
	1. Sections 100-500
	These lines automatically import data from entries in Sections 700-1300.

	2. Enter Additional Line Items:
	a. Click on or <Tab> to the blank line(s) available and enter an item description.
	b. Press <Tab>. The POC checkbox appears.
	c. Select this checkbox and enter POC Code, if applicable, and press <Tab>.
	 NOTE: If this checkbox is not selected, it disappears when <Tab> is pressed again.
	d. If more lines are needed, use Section 1300 or the Edit Payoff button.  For more information on editing payoffs, please refer to the Edit Payoff documentation.

	3. Section 200a
	a. Complete Closing inserts amounts for Lines 201 and 202 from the information entered in the Loan tab in Order Entry.
	i. The description for Line 201 can be changed by typing over the existing text.
	ii. To change the Earnest Money amount, go to the Loan tab in Order Entry.

	b. Enter Debit/Credit:
	Double click the D/C checkbox and copy the item and amount to the corresponding line.
	 NOTE: Marking an “X” in the POC field will apply a credit to the Loan Amount.

	c. This section also displays the party holding the earnest money, as entered in the Order Entry screen, Loan/Misc tab, and allows you to change it, if necessary, by selecting another option.

	4. Lines 300-303
	Complete Closing automatically updates and calculates these fields.

	5. Section 500a: Reductions in Amount Due to Seller
	In Section 500a, Complete Closing Line 502, Settlement Charges to Seller, is a total of charges to Seller from Sections 700 through 1300. Additional lines can be added as disbursement or credit items on the Seller side by entering information on Lines...

	6. Lines 600-603: Cash at Settlement From/To Seller
	Complete Closing automatically updates and calculates these fields.


	J. Page Two Tab
	1. Sections 700-1300
	a. Adding Lines
	i. Up to 99 lines can be added to each section.
	ii. Click the Add Line button  or <Tab> through the last line.
	iii. Click the Insert Line button  or press <Insert>.

	b. Deleting Lines
	i. Click the Delete Line button ; or
	ii. Right-click and select Delete from the menu; or
	iii. Press <Ctrl>+<Delete>.


	2. Section 700: Broker’s Commission
	a. Override the sale price, on which the commission is based, on Line 700 by typing over the amount. Clear the commission information by clicking the Clear Commission Price Override button  or pressing <Ctrl>+<O>.
	b. A change in the sale amount is indicated by a change in color on Line 700.
	c. Line 700: Total Sales/Broker’s Commission based on …
	i. The sale price reflects the amount on this line in Order Entry.
	ii. If the commission is based on a different amount, this figure can be overridden by typing over the amount. Commission can also be assigned to the Realtor on Line 700. The total commission is also displayed.


	3. Section 800: Items Payable in Connection with Loan
	a. For all items in Section 800, the payee defaults to the first lender. It is not necessary to enter a payee in the Payee column unless you want to change it to a different payee.
	 NOTE: If necessary, click the Expand All button  in this section to more easily use the Clear Override button.

	b. Lines 801 and 802
	i. Overrides
	(1) Override information in Lines 801 and 802 by typing over the amounts.
	(2) Clear overridden information by clicking the Clear Override button  or pressing <Ctrl>+<O>.
	(3) Information in these lines is only considered overridden if you enter a percentage and an amount, causing a discrepancy in the calculations. If no percentage is entered, a dollar amount can be entered without the system considering it overridden.
	(4) An override in the amount is indicated by a change in color.

	ii. POC (Paid Outside of Closing) Codes
	(1) Codes
	(a) B: Buyer
	(b) S: Seller
	(c) L: Lender
	(d) X: Held from Draft
	(e) Y: Yield Spread

	(2) Instructions
	(a) Enter POC Codes and amounts directly in the Speed HUD screen.
	(b) For any charge items that the lender is withholding from the loan amount, enter “X”. This charge is automatically compensated for when the receipts and disbursements are created in Check Writing by subtracting the POC amount from the total loan am...
	(c) Other options for this field include “L” to indicate that the item was paid outside of closing by the lender or “Y” to indicate a yield spread paid by the lender to a broker. When “Y” is entered, Complete Closing increases the expected loan deposi...
	 NOTE: “Y”, “L”, “B”, and “S” are only allowed when a dollar amount has been entered in the POC Amount column. “X” is only allowed when a dollar amount is entered in the Paid from Borrower/Seller Settlement Fund column.





	4. Section 900: Items Required by Lender to be Paid in Advance
	Enter the daily interest charge or a percentage and the Speed HUD will calculate the amount. Use the Set Line 901 Override button  or press <Ctrl>+<O> to override the read only information in the Paid From Borrower’s Fund at Settlement column. Click t...
	a. Line 901: Interest
	Enter the beginning and ending dates for interest using the Calendar button  or entering the year in two-digit format.

	b. Lines 902 and 903: Mortgage and Hazard Insurance Premiums
	Premium amounts entered in these lines will transfer the monthly amount to Lines 1001 and 1002.


	5. Section 1000: Reserves Deposited with Lender
	 NOTE: The Payee and POC fields in this section do not appear on the printed HUD.
	a. Lines 1001-1009
	The information on Lines 1001-1009 can be overridden clicking the Set to Partial Override button  or by pressing <Ctrl>+<O>. Totals are automatically calculated, based on the number of months and the amount. (This is the preferred method.)

	b. Line 1011: Aggregate Reserve Adjustment
	To enter a negative amount for a credit, begin the number with a minus sign (-). Negative numbers are displayed in parentheses (####). Use POC Code “X” if amount is to be added to the deposit from the lender.


	6. Section 1100: Title Charges
	a. After completing the ATG Edit Services screen, Section 1100 will auto-fill the Amounts and Payees. It is critical that all services and any revisions are entered in ATG Edit Services not only for HUD items, but also for creation of appropriate checks.
	b. Lines 1106 and 1107
	Buyer and Seller Attorney information is populated from the Buyer and Seller tabs in Order Entry. A separate disbursement to the member is created.
	 NOTE: Lines 1109 and 1110 are for information only; they are not rolled into the HUD totals.



	K. Section 1200: Government Recording and Transfer Charges
	1. Override the information in Lines 1201, 1202, and 1203 by clicking the Override This Line button  or by pressing <Ctrl>+<O> and typing over the existing information. To clear overridden information, click the Clear Override for This Line button  or...
	 NOTE: The cursor must be in the line you want to override or clear before using these buttons. An override is indicated by a change of color in the line item description.

	2. Lines 1202, 1203, and 1204 are automatically calculated and inserted in the Borrower and Seller columns, based upon the County, City, and State in the Property screen.
	3. POC Information
	a. Click the POC button.
	b. Enter POC amounts and Who codes (“B,” “S,” “L”) for each desired line item and click OK to save.
	c. Enter “$0” in the Seller column for both Lines 1202 and 1203.
	d. POC is now activated and is indicated by a change of color in these lines.
	e. The printed HUD will print with POC details.
	f. To edit, change the HUD lines first and then open the POC window.


	L. Section 1300: Additional Settlement Charges
	Use Section 1300 to enter miscellaneous additional charges.

	M. Line 1400: Total Settlement Charges
	Line 1400 shows the total charges from Line 103, Section J and Line 502, Section K.


	IX. Two Mortgages
	If there are two mortgages, a new file must be created. To save time, a copy of the existing file can be made.
	A. Copying Files
	To copy a REsource file, it is necessary to create a second file. To create a second REsource file:
	1. Click the Add New File Number button or select File > New File-No Suggest from the menu bar.
	2. Enter the Tax ID Number. Click the Search button and the Create New button.
	3. The Enter New File screen displays.
	4. In the Enter a New File Number field, enter the original file number followed by “-A”.
	 EXAMPLE:
	– Original file number: 100900101481
	– New duplicate file: 100900101481-A

	5. Select the Region (member number).
	6. Click OK.
	The new file number displays in the File # field  and Order Entry opens.


	B. Using a Template for Order Entry
	The Use Template feature copies Order Entry data from an existing file. (There is also a Use Template feature to copy Commitment and Policy data from an existing file or from a template file.)
	 NOTE: It is recommended that you use the Template feature prior to adding data to the new file. Two confirmation messages will display upon selecting Use Template, indicating that any data already entered for the new file in Order Entry will be dele...
	1. Click the Order Entry button or click Data Entry on the menu bar to access Order Entry.
	2. From the Main tab in Order Entry, click the Use Template button.
	3. Click OK on the confirmation prompts that indicate the selected template will override any data entered in Order Entry.
	The Select Template window appears.

	4. Click the All Orders button to list all of your files.
	5. Enter the original file number in the Search Characters field.
	6. Double-click the desired file number.
	7. The data from the existing file will now appear in the new file.
	 IMPORTANT NOTE: The Sale Price, Earnest Money, and Loan Amount will not be copied from the existing file. After adding the Sale Price, Earnest Money, and Loan Amount to the new file, you must go to ATG Edit Services to select services.



	X. Lender Breakdown Report
	A. To preview the Lender Loan Breakdown report, click the Show Lender Loan Breakdown button.  The report shows the expected loan amount and the lender’s check amount before creating Receipts and Disbursements in Check Writing.
	B. To print the report click on the Print button.

	XI. 1099S Real Estate Tax Reporting
	A. The following documents are available for printing with the HUD and should be used with all transactions, as applicable:
	1. HUD Signature Page
	2. Substitute Form 1099S Proceeds from Real Estate
	or
	3. Certification for No Information Reporting on the Sale or Exchange of Principal Residence
	4. Receipts and Disbursement Summary

	B. Printing HUD Documents
	1. When either Print HUD button  is clicked on the toolbar, printing prompts will appear.
	2. To print only the first two pages of the Speed HUD, click OK.
	3. To print any remaining documents, change the “Y” to “N” and click OK.
	4. Speed HUD and 2010 HUD printing prompts:
	a. Print Signature Page (Y or N)
	b. Print 1099S (Y or N)
	c. Print Certificate for No 1099S Reporting (Y or N)
	d. Print Receipts and Disbursement Summary (Y or N)
	 NOTE: Receipts and Disbursements must be created and/or updated in Check Writing first. (For details, please refer to the Check Writing section in this manual).

	5. 2010 HUD printing prompts:
	a. Is this file being closed by a Member Closer (Y or N)
	b. Hide Reminder CPL and Anti Predatory Lending (Y or N)
	c. Print first three pages of HUD and 1101 Detail Only (Y or N)


	C. Reporting 1099S Information to the IRS Using REsource
	1. To generate the 1099S form and 1099 reports, it is necessary to enter the Social Security number of the first seller listed in the Seller tab.
	2. If no 1099S is required on the transaction because the sale is an exempt transaction under IRS Regulations, the seller’s Social Security number is not required to be entered in REsource. To confirm that the sale is exempt, the Certification for No ...
	3. For additional information about 1099 reporting, go to www.atgf.com and click ATG Member Attorneys > Get Underwriting Assistance > Underwriters’ Bulletin Index (1996-2008). In the list of archived documents, scroll down to 2003 and select 1099 Real...

	D. Edit Payoffs
	1. Click the Edit Payoffs button  to enter an unlimited amount of Buyer or Seller payoffs available in Sections 100a, 500a, and 1300.
	2. Payoff information is calculated according to the following:
	a. Formulas:
	i. Payoff Amount Calculation (Formula 1):
	Principal Balance + Interest Amount + Sum of Additional Charges

	ii. Payoff Amount Calculation (Formula 2):
	Principal Balance + Sum of Additional Charges

	iii. Payoff Amount Calculation (Formula 3):
	Principal Balance + (Per Diem x Interest Period)  + Sum of Additional Charges

	iv. Payoff Amount Calculation (Formula 4):
	Principal Balance + [(Interest Rate x Principal Balance)  Annual Days] + Sum of Additional Charges


	b. Exceptions
	i. If the interest amount is overridden, Formula 1 is used.
	ii. If only the principal balance and/or additional charges are entered, Formula 2 is used.
	iii. If there are no Interest From and Interest Thru Dates, but the Interest Rate or Per Diem fields are filled in, Formula 2 is used.
	iv. If none of the above is true, and you check the Override check box next to the Per Diem field, then Formula 3 is used. If the Override check box next to the Per Diem field is not checked, then Formula 4 is used.





	Add New Line: Click this button to place a new line at the end of the selection. Available in Page Two tab only. 
	Delete a Line: Click this button and click Yes to the delete prompt. Available in Page Two tab only.
	Insert New Line: Click this button to insert a new line above the line in which the cursor is placed. If you try to insert a line in an inappropriate place, an error message will appear. Available in Page Two tab only.
	Set Override: Click this button to apply the override. The particular override depends on the section of the HUD in which it is used. Available in Page Two tab only.
	Set Partial Override: Click this button to apply the partial override. Available in Page Two tab only.
	Clear Override: Click this button to clear the full or partial override. Available in Page Two tab only.
	8 |  Check Writing
	I. Creating Receipts and Disbursements
	Check Writing creates all receipts (deposits) and all disbursements (checks) directly from the data entered in the HUD-1 Settlement Statement and prints checks for disbursement. Check writing does allow for manual changes to receipts and disbursements...
	Additionally, REsource has a robust escrow reconciliation module that makes reconciliation quick and accurate. It is highly recommended that each transaction be reconciled and your escrow account reconciled on a monthly basis.
	Contact a Member Services Representative to order check stock or for additional information using the Escrow Accounting module of REsource.
	A. To access Check Writing, click the Check Writing button  or select Utilities > Check Writing from the menu bar.
	B. To create the Receipts and Disbursements from the HUD, click the Create Receipts and Disbursements button  in the top left corner. This function brings all HUD-1 items into the Deposits and Checks tabs.

	II. Deposits Tab
	A. The Check Writing screen has two tabs, one for Deposits (receipts) and one for Checks (disbursements).
	B. Once Receipts and Disbursements have been created, all changes that are made on the HUD will automatically update Receipts (checks) and Disbursements (deposits).
	 NOTE: It is important that when making changes to the HUD, you click the Refresh button  of the HUD and then close the HUD prior to going into Check Writing.

	C. If any Lender items under Who POC in the HUD screen are marked with an “X,” Section 800, 900, or 1000 tabs are to be deducted from the Loan Amount (lender draft). Complete Closing automatically compensates for this charge when it creates the Receip...
	D. In the shaded area at the bottom of the screen, Complete Closing keeps a running balance of the status of the account. The Pre-Disbursement Balance must match the Scheduled Disbursements in order to balance. When this occurs, this area displays in ...
	 NOTE: Checks can be written against anticipated deposits before the account is in balance, as long as there is enough money deposited for this file to cover them. However, use this option with caution because it can cause serious accounting problems.

	E. Some of the options in the Check Writing window may be restricted by security settings. Options that may be restricted include:
	1. the number of days the checks and deposits can be predated and postdated;
	2. whether an individual can change or delete a deposit;
	3. whether an individual can undo, delete, and/or stop/void a check; and
	4. converting a check to a wire.

	F. Checks and Deposits can be entered manually in these tabs but Complete Closing can create Receipts and Disbursements automatically from items entered in the HUD-1 Settlement Statement.
	G. If the Earnest Money amount entered in the Order Entry > Loan tab specifies the title company as holding these funds, the first time this screen is opened, the only entry in it will be a posted Deposit in your account for the Earnest Money. Use thi...
	H. The process can now begin of verifying the deposits and checks to be written, making adjustments, and adding manual deposits and checks as needed.
	1. To assist with the process, click the Receipts and Disbursements Ledger button.  The report will display on the screen and may be printed for a preliminary register as a worksheet. When you have completed printing all checks, click the Receipts and...
	2. If mistakes have been made in receipt and/or disbursement records, or there are have been significant changes to the HUD-1 Settlement Statement since you created the receipts and disbursements from it, you can choose to delete the receipts and disb...
	 NOTE: All Receipts and Disbursements cannot be deleted if check(s) have been printed. However, individual unprinted checks or individual un-booked deposits can be deleted.


	I. If one or more checks are printed, the Delete All Receipts and Disbursements button  will not delete all receipts and disbursements.
	J. However, un-booked deposits and unprinted checks may individually be deleted by using the Delete button.
	K. To edit printed checks, use Undo or Void.
	L. If a change is made to the HUD-1 Settlement Statement after one or more checks have been printed, then the Checks and Deposits will automatically recalculate in Check Writing.
	 NOTE: Only the checks affected by the changes made will recalculate, including manually created checks, e.g., Splits, Payee changes, etc.
	1. If a change is made to the HUD-1 and all deposits have been dated and posted, then Checks and Deposits will not automatically recalculate. The following informational prompt will display:
	2. You must manually adjust Checks and Deposits to reflect the changes to the HUD-1 Settlement Statement.

	M. Complete Closing displays all the current deposits on the Deposits tab in a scrolling window on the right side with the Description, Payor, and Amount for each. To select an item, either click anywhere in the Description to highlight it, or use the...
	N. For the selected deposit, Complete Closing also displays the Description, Amount, Payor, Deposit Date, Type of Funds, and Expected Wire date (if applicable) in editable fields on the left side of the window. When indicated that the Type of Funds is...
	O. To add a deposit, click the Create button.  The program creates a new blank line in the display window on the right and is ready for your entries in the fields at the left. Enter the Description, Amount, Payor, Deposit Date, Type of Funds, and Expe...
	P. To delete a deposit, click the Delete button.
	Q. Money can also be transferred to and from an interest-bearing investment account.

	III. Checks Tab
	A. Complete Closing displays all the current checks on the Checks tab in a scrolling window on the right with the Payee, Amount, and, when the check is printed, the Check Number, Date, and Bank fields are completed. To select a check to view and edit ...
	B. When using the Navigation buttons  to select a check, it will not display as highlighted in the Payee display window on the right. To confirm that the correct check is selected, make sure that the Payee name is displayed under Pay To on the left.
	C. For the selected check, Complete Closing displays a scrollable list of all disbursement items included in the check amount. For each item, it displays the HUD-1 Line Number, Description, Amount, and Acct (account) number, if assigned. Highlight any...
	 NOTE: HUD-1 Settlement Statement Line; Amounts deducted from member check includes: premiums, Illinois Policy Tax, and search fees will appear in parentheses. Please refer to the ATG Fees and Transfer check for details.
	 NOTE: Changes cannot be made to check amounts directly. Changes must be made through the items in the Disbursements list (left hand side). You can, however, delete an entire check. Doing so will automatically delete all the disbursement items attach...

	D. To add another item for the current check, press <↓> or <Tab> repeatedly until the program creates a new blank line at the bottom of the Disbursement list. Then, enter the Line Number, Description, and Amount. If an item does not have a Line Number...
	E. When finished adding an item or adjusting current items, click the Post Changes to Current Check button  or press <Tab> to post the change.
	F. Change Payee Information
	1. The Change Payee Information feature allows you to manually change the payee name and/or address for a specific check, without having to utilize the Agent or Buyer/Seller lists. A copy feature is also included to copy existing information and to ma...
	a. Select the Checks tab and select the desired check.
	b. Click the Change Payee Information button  to display the Manual Payee screen.
	c. Enter the Payee Name and Address (optional); click OK.

	2. Use the Change Payee button  to change the name of the payee. When you select this option, the Select Payee Option screen displays. Choose which list the payee from: Buyer/Seller, Agent, or Manual. The Select Payee Option window also displays when ...
	a. Buyer/Seller
	Displays the Buyer/Seller Agent List.

	b. Agent
	Displays the Agent List.

	c. Manual
	Same as Manual Change Payee (above).

	d. Buyer From Order
	Automatically inserts the Buyer name from the file as the payee.

	e. Seller From Order
	Automatically inserts the Seller name from the file as the payee.


	3. This screen also offers these options for adding and adjusting checks manually and for printing checks.
	a. New
	Creates a new check. Use this option to add a new check to the list. (To add a new item for an existing check, use the method explained above for adding disbursement items.) When you select this option, the Select Payee Option screen displays; please ...

	b. Del Line
	Deletes the selected line(s) from the Disbursement list on the left. The amount of the check is adjusted to reflect the deletion. If the item you delete is the only item for the current check, the check is also deleted from the Check window on the rig...

	c. Split
	Splits the selected item(s) in the Disbursement list into a separate check for the same payee. Use this option if your payee needs separate checks for different items. Before you click the Split button,  select the item(s) in the Disbursement list to ...
	Use the Navigation buttons  to move through the list of checks.

	d. Print
	To print all checks, click the Print All Checks button  at the top of the Check Writing window.
	To print individual checks, highlight the checks and click the Print Selected Checks button.
	Before you click the Print button, select the check(s) in the Checks window. If you choose to print before the account is in balance, do so with caution because it could create a serious accounting problem. When you select Print, a window will display...

	e. Undo
	Use this option if you experience a problem with your printer or check paper that prevents the checks from printing properly. Before clicking the Undo button,  select the check(s) in the Checks window. Complete Closing removes the check numbers and da...

	f. Void
	Voids a check. Use this option only if you have printed a check and need to physically void it. Do not use this option to undo check printing. Before clicking the Void button,  select the check(s) in the Checks window. This option highlights the selec...

	g. Delete
	Deletes the selected check entries. Use this option if you need to remove an unprinted check from the list. Before clicking the Delete button,  select the check(s) in the Checks window.

	h. Hold
	Use this option if you are printing checks as a group with the Print All Checks button  and you want to hold one or more selected checks. Before you click this button, select the check(s) in the Checks window. Held check(s) will be highlighted in grey...

	i. Undo All
	Use this option if you experience problems with your printer or check paper that prevents checks from printing properly. Complete Closing removes the check numbers and dates from all the checks so that you can reprint them. To undo only one or more se...

	j. Stop Pay
	Use this option if you are stopping payment on a check. Before clicking the Stop Pay button,  select the check(s) in the Checks window. This option highlights the selected payee entry in blue and creates a new duplicate of the record without a check n...

	k. Wire Funds
	Use this option to denote that the disbursement was a wire. Select the Transfer button  and assign a wire number



	G. To move one or more disbursement items from one payee to another or for combining separate payments into one check to one payee:
	1. Select the first disbursement.
	2. To select additional disbursement items, press <Ctrl>.
	3. Press and hold the left mouse button, and drag the mouse to the right until the desired check is highlighted and checked.
	4. Release the mouse button.



	9 |  Escrow Accounting
	I. Introduction
	The Complete Closing Enterprise Escrow Accounting program works with Complete Closing Enterprise to enable you to reconcile monthly escrow account bank statements and to prepare the three components of the monthly Three-Way Balance. You can also verif...
	To access the Complete Closing Escrow Accounting module, click the Complete Closing Escrow Accounting icon  on the REsource Desktop.
	Each of the key functions is available from the toolbar, as well as from the drop-down menus. In addition, the drop-down menus provide access to other reports.
	Prior to your first reconciliation, create a new file in REsource for the purpose of entering other disbursements and receipts, such as bank charges or earned interest, that appear on your bank statement but are not specific to a transaction. The Cont...
	In this REsource Control file, enter any deposits in the Deposit tab and enter any bank fees in the Check tab of Check Writing. Change Bank Fees entered in the Check tab to a Wire and book the deposit. This can also be accomplished in Complete Closing...
	Additionally, if your existing REsource escrow account has not been reconciled using Complete Closing Escrow Accounting, it is advisable to open a new escrow account at your bank. When your new account and checks are ready, contact the REsource Help D...

	II. Escrow Accounting Buttons
	The Escrow Accounting buttons are described below:

	III. Bank Reconciliation
	A. To open the Bank Reconciliation screen, use one of the following methods:
	1. Click the Bank Reconciliation button;
	2. Select Tools > Reconciliation from the menu bar; or
	3. Press <Alt>+<T>, then <R>.
	The screen displays the most recent reconciliation conducted. To search for another one, click the Locate Reconciliation button.

	B. To create a new reconciliation, click the New Reconciliation button.  The program extracts all unreconciled receipts and disbursements through the selected end date for all files in Complete Closing Enterprise. All outgoing wires and checks are dis...
	C. The fields on the Bank Reconciliation screen are described below:
	D. The buttons on the Bank Reconciliation screen are described below:
	E. Bank Reconciliation Options
	To display options available on the Bank Reconciliation screen, click the Options button.  Available options include:


	IV. Starting a New Reconciliation
	Follow these steps to create and balance a new reconciliation:
	A. Click the Bank Reconciliation button or select Tools > Reconciliation.
	The Bank Reconciliation screen opens.

	B. Click the New Reconciliation button.
	The New Reconciliation screen opens.

	C. From the Bank drop-down, select the escrow account. The Bank drop-down list displays only region-specific banks (i.e., Region 1 users see only Region 1 banks).
	D. From your bank statement, enter the Through Date. Enter the date or click the Calendar button  to select a date.
	E. Enter the Beg(inning) Balance and End(ing) Balance as reported on the bank statement. If this is your first reconciliation, the End(ing)Balance should be 0 (Zero).
	F. Click OK to create a new reconciliation or click Cancel to exit.
	The program then displays all un-reconciled receipts and disbursements from files in Complete Closing Enterprise through the Through Date.

	G. Begin comparing the bank statement items with the checks and receipts displayed. To mark an item as reconciled, click on the item, which highlights the line and adds it to the Cleared Rec or Cleared Disb totals at the bottom of the screen. If you h...
	H. Continue marking items until your Ending Balance matches the Bank Ending Balance.
	I. If you find discrepancies between the bank statement and your receipts and disbursements, return to Complete Closing Enterprise to investigate and make corrections.
	J. Manual Adjustments
	1. Use the REsource Control file created for manual adjustments (Bank ###). Manual adjustment entries are used for items that do not pertain to a file in Complete Closing, such as interest, wire fees, sweep account entries, etc. See Control File in th...
	2. To enter manual adjustments, either:
	a. Return to Complete Closing Enterprise, open the Control File and go to Check Writing. Enter any deposits, such as interest, in the Deposit tab and any bank fees in the Checks tab. Be sure to book the deposits and change the checks to wires.
	b. Open Quick Check Entry  or Quick Deposit Entry from the Tools menu in Compete Closing Escrow Accounting. Enter manual adjustments to your Control file (Bank ####). For more information on using Quick Check Entry and Quick Deposit Entry see Adding o...


	K. When the Ending Balance matches the Bank Ending Balance and the Difference appears as Zero (0), the lower area of the screen is highlighted in yellow. When the balances are different, the lower part of the screen is shaded gray.
	L. To finalize your balanced reconciliation, click the Finalize Reconciliation button.
	 WARNING: Once you finalize a recon, it is time consuming to reverse. Please call the REsource Help desk for assistance.


	V. Three-Way Balance
	Complete Closing Enterprise performs a full three-way balance of the escrow accounts set up in Complete Closing Enterprise. The Three-Way Balance components listed below are described in the following sections.
	A. Book Balance
	B. Escrow Trial Balance
	C. Reconciled Bank Balance
	 NOTE: Each of the Three-Way Balance components needs to be completed prior to completing the full Three-Way Balance.


	VI. Book Balance
	A. The Book Balance is the first of the three components of Three-Way Balancing. The Book Balance contains the following information for a specified escrow account and date range.
	1. Beginning Book Balance
	+ all receipts dated in the month, whether reconciled or not.
	− all disbursements dated in the month, whether reconciled or not.

	2. Ending Balance
	Represents the beginning balance, plus all receipts, minus all disbursements.

	Request the Book Balance after you have completed the account’s Bank Reconciliation for that month. The final Book Balance for an escrow account must match the Escrow Trial Balance and the Reconciled Bank Balance.

	B. To run the Book Balance Report:
	1. Click the Book Balance button,  or select Reports > Book Balance (#1) or press  <Alt>+<R>, then <B>.
	The Book Balance screen opens:

	2. From the Select Bank drop-down, select the escrow bank.
	 NOTE: The Select Bank drop-down displays only region specific banks (i.e., Region 1 users see only Region 1 banks).

	3.  Enter the Starting Date or click the Calendar button  to select the date. This should be the first day of the month you are currently reconciling.
	4.  Enter the Ending Date or click the Calendar button  to select the date. This should be the last day of the month you are currently reconciling.
	5.  For the Beginning Book Balance, enter the Ending Book Balance for the previous month. If this is the first month reconciling a new account, enter “0” (zero).
	6. Click OK or click Cancel to exit the Book Balance screen.
	7. The Book Balance report displays with the beginning balance you entered, details on all receipts and all disbursements, and the calculated ending balance. Depending on settings in Complete Closing Supervisor, the report may include the closing agen...


	VII. Escrow Trial Balance
	A. The Escrow Trial Balance is the second of the three components of the Three-Way Balance. The Escrow Trial Balance displays the following items for the selected escrow account and date:
	Every file with a non-zero balance, with its:
	1. Total Receipts balance;
	2. Total Disbursements balance;
	3. Total Account balance;
	4. Last Activity Date;
	5. Escrow Memo (if entered on the Check Writing screen).

	B. Use the Escrow Trial Balance after you have completed the month’s Bank Reconciliation for an account. The final Bank Total for an escrow account must match the Book Balance and the Reconciled Bank Balance.
	C. To run the Escrow Trial Balance Report:
	1. Click the Escrow Trial Balance button,  or select Reports > Escrow Trial Balance (#2), or press <Alt>+<R>, then <E>.
	The Escrow Trial Balance screen opens:

	2. From the Select Bank drop-down, select the escrow bank.
	 NOTE: The Select Bank drop-down displays only region specific banks (i.e., Region 1 users see only Region 1 banks).

	3. Enter the Thru Date or click the Calendar button  to select a date. This should be the last day of the month you are currently reconciling
	4. Click OK or click Cancel to exit the Escrow Trial Balance screen.
	The Escrow Trial Balance report displays with the file number, receipts, disbursements, last activity date, balance, and any escrow memos entered in Check Writing. Depending on settings in Complete Closing Supervisor, the report may include the closin...



	VIII. Reconciled Bank Balance
	A. The Reconciled Bank Balance is the third of the three components of the Three-Way Balance. The Reconciled Bank Balance displays the following information for the selected escrow account and ending date:
	1. Beginning Book Balance
	2. Deposits in-transit (not yet reconciled), with the Date, Transaction ID, File Number, Description, and Amount.
	3. Outstanding Checks (not yet reconciled), with the Check Number, Date, File Number, Payee, and Amount.
	4. The Reconciled Bank Balance, representing the beginning balance, plus all deposits in-transit, minus all outstanding checks.
	 NOTE: You must finalize the Bank Reconciliation for the selected escrow account for a given month before you can run this report. The Adjusted Reconciled Bank Balance (which includes other receipts and other disbursement entries) must match the Book...


	B. To create a Reconciled Bank Balance:
	1. Click the Reconciled Bank Balance button,  or select Reports > Reconciled Bank Balance, or press <Alt>+<R>, then <R>.
	The Reconciled Book Balance screen opens:

	2. From the Select Bank drop-down, select the escrow bank.
	 NOTE: The Select Bank drop-down displays only region specific banks (i.e., Region 1 users see only Region 1 banks).

	3. Enter the End Date or click the Calendar button  to select the date. This should be the last day of the month you are currently reconciling.
	4. Click OK or Cancel to exit the Reconciled Bank Balance screen.
	The Reconciled Book Balance report displays. From there, print the report by clicking the Print button  or save the report by clicking the Save button.  To adjust the display size, use the Zoom buttons.



	IX. Three-Way Summary
	The Three-Way Summary provides a summary of the components of the Three-Way Balance. The Three-Way Summary includes:

	X. Outstanding Checks; Reconciled Bank Balance
	A. Use the Three-Way Summary report to verify your Book Balance Total, Escrow Trial Balance Total, and Reconciled Bank Balance all match. If they do not, investigate and correct the discrepancies. See Investigating Discrepancies for more information.
	 NOTE: Before running the Three-Way Summary report, you must complete the Bank Reconciliation, Book Balance, Escrow Trial Balance, and Reconciled Bank Balance for the previous month of the selected escrow account.

	B. To create a Three-Way Summary:
	1. Click the Three-Way Summary button,   or select Reports > Three-Way Summary, or press <Alt>+<R>, then <T>.
	The Three-Way Summary screen opens:

	2. From the Select Bank drop-down, select the escrow bank.
	 NOTE: The Select Bank drop-down displays only region specific banks (i.e., Region 1 users see only Region 1 banks).

	3. Click OK or Cancel to exit the Three-Way Summary screen.
	The Monthly Three-Way Reconciliation report is displayed. From there, print the report by clicking the Print button  or save the report by clicking the Save button.  To adjust the display size, use the Zoom buttons.



	XI. Full Three-Way with Summary
	A. The Full Three-Way with Summary option allows you to make one request to prepare the Book Components Balance, Escrow Trial Balance, and Reconciled Bank Balance of the Three-Way Balance, along with the Three-Way Summary. This option saves the steps ...
	B. To run the Full Three-Way with Summary report:
	1. Select Reports > Full Three-Way with Summary, or press <Alt>+<R>, then <F>.
	The Book Balance screen opens.

	2. From the Select Bank drop-down, select the escrow bank.
	 NOTE: The Select Bank drop-down displays only region specific banks (i.e., Region 1 users see only Region 1 banks).

	3. Enter the Starting Date or click the Calendar button  to select a date, which should be the first day of the month you are currently reconciling.
	4. Enter the Ending Date or click the Calendar button  to select a date, which should be the last day of the month you are currently reconciling.
	5. For the Beginning Book Balance, enter the Ending Book Balance for the previous month.
	6. Click OK or click Cancel to exit the Book Balance screen.
	The Full Three-Way Monthly report is displayed. Print the report by clicking the Print button  or save the report by clicking the Save button.  To adjust the display size, use the Zoom buttons.



	XII. Verifying Deposits
	Verifying deposits and deposit slips prevents changes being made to the deposits after they are posted. Users cannot make changes to deposits or deposit slips once they are verified in Escrow Accounting.
	 NOTE: This is an optional feature and is not required or intended to replace reconciling your monthly bank statement. Verifying deposits does not replace reconciling deposits.
	A. To open the Verify Deposits screen, use one of these methods:
	1. Click the Verify Deposits button;
	2. Select Tools > Verify Deposit; or
	3. Press <Alt>+<T>, then <V>.Please use the screen shot provided

	B. Verify Deposits Screen
	1. Use the Verify Deposits screen to verify deposits that have been entered either in Complete Closing Enterprise or directly into the Escrow Accounting program.
	2. The Verify Deposits screen includes the following information:
	a. All individual deposits that have not yet been verified.
	b. Deposit slip totals for all items deposited together on one deposit slip that have not yet been verified. To help you with your verification, the following information is provided for each deposit:
	i. File Number
	ii. Dep(osit) Date
	iii. Transaction Number
	iv. Description (purpose) of the deposit
	v. Amount of deposit
	vi. Deposit Slip
	vii. Bank Number
	viii. File’s branch


	3. To verify more than one deposit at a time, use the <Ctrl> key to select multiple deposits. Click the Verify Selected Deposits button  to complete the verification. The verified deposits no longer appear in the list.


	XIII. Adding or Adjusting Checks and Deposits
	A. To add checks and deposits, use Quick Check Entry and Quick Deposit Entry.
	B. To modify existing checks and deposits, use Check Browser and Deposit Browser.

	XIV. Check Editor
	A. To open the Check Editor screen, use one of these methods:
	1. Click the Quick Check Entry button;
	2. Select Tools > Quick Check Entry;
	3. Click the Edit button from the Check Browser screen; or
	4. Press <Alt>+<T>, then <K>.

	B. The Check Editor screen allows you to enter new checks. The options are described below:

	XV. Deposit Editor
	A. To open the Deposit Editor screen, use one of these methods:
	1. Click the Quick Deposit Entry button;
	2. Select Tools > Quick Deposit Entry;
	3. Click the Edit button from the Deposit Browser screen; or
	4. Press <Alt>+<T>, then <T>.

	B. The Deposit Editor screen allows you to enter new deposits. The options are described below:

	XVI. Investigating Discrepancies
	A. When you find discrepancies between your bank statement and your credits and disbursement records in the Bank Balance or among the three components of the Three-Way Balance, you must investigate and reconcile these differences. Here are some of the...
	1. Make sure that each file in Complete Closing Enterprise has the correct escrow account assigned to it. Problems frequently occur when file transactions are recorded with the wrong escrow account.
	2. Make sure that each check and deposit has been recorded with the correct date. Typical entry errors include recording a check or deposit with the wrong month or wrong year.
	3. Make sure that you entered the Beginning Date on the Bank Reconciliation as the next calendar date following the previous month’s ending date. This will ensure that no dates will be left unaccounted for in the reconciliation process.
	4. Make sure that you entered the Ending Date of the bank statement as the ending date on the Bank Reconciliation and Three-Way Balance components.
	5. For bank balance discrepancies, use the Check Browser and Deposit Browser to try to find a check or deposit for the amount of the discrepancy. If there is not one check or deposit for the amount, look for two or more checks or deposits that add up ...
	6. If a check or deposit appears in the bank statement but not in the Bank Reconciliation screen, look for the item in the Check Browser or Deposit Browser to see if it was recorded for the wrong date or wrong escrow account. Also check to see if a ch...
	7. If a check or deposit appears in your Bank Reconciliation screen but not on the bank statement, check to see if it was recorded for the wrong date or wrong escrow account.
	8. Note that voided checks appear as negative checks (credits) in the Book Balance on the date they were voided. When a voided check is reissued, it appears as a debit on the date it is reissued.

	B. After you have identified the cause of a problem, fix the error with the Check Editor or Deposit Editor. Return to the Bank Reconciliation scree6n to fix the error there or rerun the appropriate Three-Way Balance component.

	XVII. Check Browser
	A. Check Browser helps you locate checks that need to be adjusted to balance your escrow accounting records. Access any check entered through Complete Closing Enterprise or directly in the Escrow Accounting program using one or more search criteria.
	B. To open the Check Browser screen, use one of the following methods:
	1. Click the Check Browser  button;
	2. Select Tools > Check Browser; or
	3. Press <Alt>+<T>, then <C>.

	C. To search for a group of checks, select any or all of the criteria below. For any field you leave blank, the search is unrestricted for that criterion.
	D. After you have retrieved one or more checks, you can browse and select the check(s) that you want to modify. To select more than one check, hold down the <Ctrl> key as you click each one. Edit selected checks using the following buttons:

	XVIII. Deposit Browser
	A. The Deposit Browser helps you locate deposits or deposit slips that need to be adjusted to balance your escrow accounting records. Access any deposit entered through Complete Closing Enterprise or directly in the Escrow Accounting program by using ...
	B. To open the Deposit Browser screen, use one of the following methods:
	1. Click the Deposit Browser button;
	2. Select Tools > Deposit Browser; or
	3. Press <Alt>+<T>, then <D>.

	C. To search for a group of deposits, select any or all of the criteria below. For any field you leave blank, the search is unrestricted for that criterion.
	D. After you have retrieved one or more deposits, browse and select the check(s) that you want to modify. To select more than one deposit, hold down the <Ctrl> key as you click each one. Edit selected deposits by using the following buttons:

	XIX. Current Escrow Trial Balance Browser
	A. The Current Escrow Trial Balance (ETB) Browser enables you to review all files with an open escrow account balance. This review makes it possible for you to monitor open files that may require attention.
	B. To open the Current Escrow Trial Balance (ETB) Browser screen, use one of the following methods:
	1. Click the Current ETB Browser button;
	2. Select Tools > Current ETB Browser; or
	3. Press <Alt>+<T>, then <E>.

	C. When you open the Current ETB screen, you must first select the bank account from the Select Bank screen. From the Select Bank for ETB drop-down, select the bank and click OK.
	The Current ETB screen opens:

	D. Sort items by clicking the column heading. Sorting by the Last Escrow Activity column shows the oldest open files first. Sorting by the Account Balance allows you to prioritize files by size of outstanding balance. Select the Show Files with Memos ...
	E. Color is used on line items to indicate the state the order is in. Gray indicates a file that has been locked from all changes. Light green indicates a file that has been locked from escrow changes.

	XX. Open Investment Accounts
	A. The Open Investment Accounts screen enables you to review files with an open investment account. You can limit the display to accounts belonging to a single branch or show all branches. Use this screen to monitor files for which funds are currently...
	B. To open the Open Investment Accounts screen, use one of the following methods:
	1. Click the Active Investment Accounts button;
	2. Select Tools > Investment Accounts; or
	3. Press <Alt>+<T>, then <I>.

	C. The Open Investment Accounts screen opens for all branches. To display accounts for a particular branch, select the branch from the Branch drop-down. To display accounts for a particular region, select the region from the Region drop-down. Based on...
	D. Sort items by clicking the column heading. Sorting by the Last Activity column shows the oldest open files first. Sorting by the Account Balance allows you to prioritize attention to files based on size of outstanding investment balance.
	E. The buttons on the Open Investment Accounts and the Investment Account for File # screens are described below:

	XXI. Investment Account for File #
	A. The Investment Account for File # screen opens when you select a file number from the Open Investment Accounts screen. This screen allows you to review details of all transactions in the investment account for the selected file, modify an account t...
	B. The buttons on the Investment Account for File # screen are described below:

	XXII. Change Escrow Account for a File
	This screen allows you to change the escrow account you are using for a file.
	A. Select Tools > Change Escrow Account for a File.
	B. Click the Lookup GF Number button.
	C. The Select File Number screen opens.
	D. Select the file number and click OK.
	The file number appears in the File Number field, the current escrow account displays in the Current Escrow Account field, and the total checks and deposits currently in this file are displayed.

	E. From the New Escrow Acct drop-down, select the new escrow account number.
	1. If any of the deposits and checks listed have actually been deposited in or issued out of the original escrow account, you may want to keep them associated with the original account for better tracking. If so, select the Keep Deposits/Checks with O...
	2. If you select the Keep Deposits/Checks with Original Escrow Account checkbox, two more checkboxes display. Select the Create a Deposit in New Account for Account Balance and Create a Transfer Debit in Original Escrow Account to New Account if you w...

	F. Click OK to complete the escrow account change.
	 NOTE: If the order for which you want to change the Escrow Account has a deposit that is part of a deposit slip and that deposit slip has more than one deposit on it, you cannot change the Escrow Account.


	XXIII. Expected Wires
	A. The Expected Wires screen lists all deposits entered in Complete Closing with “Wire” designated as the Type of Funds. For each anticipated wire, it lists the File Number, Payor, Amount, Description, Expected Date, Bank, and Escrow Unit.
	B. To open the Expected Wires screen, use one of the following methods:
	1. Click the Expected Wires button;
	2. Select Tools > Expected Wires; or
	3. Press <Alt>+<T>, then <W>.

	C. The buttons on the Expected Wires screen are described below:

	XXIV. Accounting Codes
	Not Available for REsource Users

	XXV. Activity History
	A. The Activity History can be useful when investigating discrepancies.
	B. To access the Activity History screen, select Tools > Activity History.
	C. From this screen, you can search by File Number, Date Range, and/or Person. Each check or deposit record stores the Action Date/Time, Type, Action, Person, File #, Amount, Check Number, Item Date, and Payee. Click the Print button  to view and prin...

	XXVI. Escrow Rounding Fix
	A. Use the Escrow Rounding Fix utility to fix amounts on deposits, checks, orders, and deposit slips that may have been rounded incorrectly. This may help you balance if your numbers are off by only a few cents.
	B. To open the Escrow Rounding Fix screen, select Tools > Escrow Problem Fix or press <Alt>+<T>, then <F>. When you run this option, the system automatically fixes amounts and displays the results on the screen.

	XXVII. Other Escrow Accounting Reports
	Several additional reports are available from the Reports menu.
	A. Deposits for a Date Range
	1. The Deposits for a Date Range report provides details on all deposits made to an escrow account within a defined date range. Deposits are included whether they have been reconciled or not. For each deposit, the report displays the Date, Transaction...
	This report may be useful for investigating discrepancies in your Bank Reconciliation or the Three-Way Balance components.

	2. To run the report:
	a. Select Reports > Deposits for a Date Range or press <Alt>+<R>, then <D>.
	b. From the Select Bank drop-down, select the escrow account.
	 NOTE: The Bank drop-down list displays only region-specific banks (i.e., Region 1 users see only Region 1 banks).
	c. Enter the Starting Date or click the Calendar button  to select a date.
	d. Enter the Ending Date or click the Calendar button  to select a date.
	e. Click OK to run the report or click Cancel to exit the screen without saving changes.

	3. To print the report, click the Print button.  To adjust the display size, use the Zoom buttons.

	B. Checks for a Date Range
	1. The Checks for a Date Range report provides details on all checks issued from an escrow account within a defined date range. Checks are included whether they have been reconciled or not. For each check, the report displays the Check Number, Date, F...
	This report may be useful for investigating discrepancies in your Bank Reconciliation or the Three-Way Balance components.

	2. To run the report:
	a. Select Reports > Checks for a Date Range or press <Alt>+<R>, then <C>.
	b. From the Select Bank drop-down, select the escrow account.
	 NOTE: The Bank drop-down list displays only region-specific banks (i.e., Region 1 users see only Region 1 banks).
	c. Enter the Starting Date or click the Calendar button  to select a date.
	d. Enter the Ending Date or click the Calendar button  to select a date.
	e. Click OK to run the report or click Cancel to exit without saving changes.

	3. To print the report, click the Print  button.  To adjust the display size, use the Zoom buttons.

	C. Absolute Checks for a Date Range
	1. The Absolute Checks for a Date Range report provides the same information as the Checks for a Date Range report, but does not include any voided checks within the defined date range.
	2. To run this report:
	a. Select Reports > Absolute Checks for a Date Range or press <Alt>+<R>, then <A>.
	b. From the Select Bank drop-down, select the escrow account.
	 NOTE: The Bank drop-down list displays only region-specific banks (i.e., Region 1 users see only Region 1 banks).
	c. Enter the Starting Date or click the Calendar button  to select a date.
	d. Enter the Ending Date or click the Calendar button  to select a date.
	e. Click OK to run the report or click Cancel to exit without saving changes.

	3. To print the report, click the Print button.  To adjust the on-screen display to a larger size, click any of the Zoom buttons.

	D. Voided Checks for a Date Range
	1. The Voided Checks for a Date Range report displays all checks from the designated escrow bank within a defined date range. For each check, the report lists the Check Number, Date, File Number, Payee, and Amount. It also calculates the total for all...
	This report may be useful for investigating discrepancies in your Bank Reconciliation or the Three-Way Balance components. Voided checks appear as a negative check (credit) in the Book Balance for the month they were voided. (When you reissue a voided...

	2. To run this report:
	a. Select Reports > Voided Checks for a Date Range or press <Alt>+<R>, then <V>.
	b. From the Bank drop-down, select the escrow account.
	 NOTE: The Bank drop-down list displays only region-specific banks (i.e., Region 1 users see only Region 1 banks).
	c. Enter the Starting Date or click the Calendar button  to select a date.
	d. Enter the Ending Date or click the Calendar button  to select a date.
	e. Click OK to run the report or click Cancel to exit without saving changes.

	3. To print the report, click the Print button.  To adjust the display size, use the Zoom buttons.

	E. File Balance Query
	1. The File Balance Query report provides information on all checks written and all deposits made on an individual file. Total file balance and book balance amounts display at the bottom of the report.
	For checks, the report displays the Check Date, Check Number, Payee, Cleared, Disbursed, and Undisbursed. If you select the Include The Check Lines check box on the Select File screen, the report also displays each Line Item Number, Amount, and Descri...
	For deposits, the report displays the Deposit Date, Transaction Number, Payor, Cleared, Received, Receivable, and Description.

	2. To run this report:
	a. Select Reports > File Balance Query or press <Alt>+<R>, then <Q>.
	b. Enter a file number or click the Lookup File Number button  to select a file from the Select File Number screen.
	c. Select the Include The Check Lines check box to include all of the Line Item Numbers, Amounts, and Descriptions for each check paid to each payee. Do not check this option if you want the report to only include the total amount paid to each payee.
	d. Click OK to run the report or click Cancel to exit without saving changes.

	3. To print the report, click the Print button.  To adjust the display size, use the Zoom buttons.

	F. Open Invoices
	Not Available for REsource Users

	G. Bad Deposit Slip Report
	1. The Bad Deposit Slip report displays all orders with one or both of the following problems:
	a. The deposit slip contains a deposit with a date later than the date of the deposit slip.
	b. Any of the deposits on the deposit slip contain a bank that does not match the bank on the deposit slip.
	 NOTE: The incorrect information is bold and underlined on the report.


	2. To run the Bad Deposit Slip report:
	Select Reports > Bad Deposit Slip or press <Alt>+<R>, then <S>.



	XXVIII. Escrow Check Wizard
	Please contact the REsource Help Desk if your check numbering is not correct.

	XXIX. Control Files
	A. Using a Control File
	Prior to your first reconciliation, create a new file in REsource for the purpose of entering other disbursements and receipts, such as bank charges or earned interest, that appear on your bank statement but are not specific to a transaction. The Cont...
	In this REsource Control file, enter any deposits in the Deposit tab and enter any bank fees in the Check tab of Check Writing. Bank fees entered in the Check tab should be changed to a Wire and the deposit should be booked. This can also be accomplis...

	B. Creating a Control File
	1. Open Complete Closing Enterprise.
	a. Select File > New File - No Suggest.
	b. The Tax ID Search Form window opens.
	i. Enter any letters in the Enter Tax ID Number box.
	ii. Click Search.
	iii. Click Create New.

	c. In the Enter a New File Number field, type Bank ### (replacing ### with your Escrow Bank Number, e.g., Bank 897).
	d. Click OK.

	2. Open Check Writing.
	a. Create a deposit in the amount of your initial deposit when your account was opened. Enter any other deposits, such as earned interest. Be sure to date and book deposits.
	b. Create any disbursements, such as bank fees, in the Check tab. Be sure to change checks to wires.
	c. To change a check to a wire:
	i. Click the Transfer button.
	ii. Check the Wire Transfer(s) check box.


	Once the Control file is created, receipts and disbursements can be added in Complete Closing Escrow Accounting.

	C. Add a Disbursement to the Control File.
	1. Open Complete Closing Escrow Accounting.
	2. Click the Quick Check Entry button  to open the Check Editor.
	3. Enter the name of your Control file in the File # field.
	4. To change the check to a wire, click the Turn Check to a Wire button.
	5. Enter the Date, Amount, and Payee.
	6. Apply the receipt to a Reconciliation, if necessary.
	7. Click OK.

	D. Add a receipt to the Control file.
	1. Open Complete Closing Escrow Accounting.
	2. Click the Quick Deposit Entry button  to open the Deposit Editor.
	3. Enter the name of your Control file in the File # field.
	4. Enter the Deposit Date, Type of Funds, Payor, Amount, and Description.
	5. Apply the deposit to a Reconciliation, if necessary.
	6. Click OK.


	XXX. Escrow Accounting Best Practices
	A. If your existing REsource escrow account has not been reconciled using Complete Closing Escrow Accounting, it is advisable to open a new Escrow Account at your bank. When your new account and checks are ready, contact the REsource Help Desk to have...
	B. Segregate duties so reconciliation is not performed by an escrow trust account signatory or approver of bank transactions. If you are the individual responsible for reconciliation, contact the REsource Help Desk for an update to your security.
	C. Perform a Three-Way Reconciliation at least monthly.
	D. Use the Current Escrow Trial Balance Browser tool in CC Escrow Accounting daily to monitor files with an open escrow account balance.
	E. The most common causes of out-of-balance situations are un-posted deposits and incorrect deposit dates. Always use the actual date of the deposit before posting the deposit.
	F. Use the REsource Control file for entering your bank fees or interest rather than the Other Receipts and Disbursements feature in the Bank Reconciliation screen.
	G. For assistance, contact the REsource Help Desk at 888.776.4420 or atgresource@atgf.com.


	10 |  Policy Preparation
	I. Schedule A of the Owner’s Policy and Loan Policy
	The information for the Schedule A of the policies is imported from the Commitment Schedule A tab. Therefore, prior to preparing the policies, edit the Insured or the Legal Description in the Commitment Schedule A tab. To edit the Amount of Insurance,...
	A. To enter/edit information for the Owner’s or Loan Policy, click the Commitment/Policy Preparation button  or select Data Entry > Commitment/Policy/Binder from the menu bar.
	B. Review the information displayed in the sub-tabs (Owner Insured, Mortg. Insured, Current Title Holders, and Legal Desc) and edit if necessary. The information in these tabs is used for the policies.
	C. The information for Schedule B of the policies is imported from the Commitment > Schedule B > Exceptions tab. Therefore, prior to preparing the policies, edit Special Exceptions in the Commitment > Schedule B > Exceptions tab.
	D. The following is an illustration of the Commitment > Schedule B > Exceptions tab. These are the exceptions that were raised on the commitment. The Schedule B exceptions that appeared on the commitment will automatically appear on the policies, unle...
	1. To enter/edit information for the Owner’s Policy or Loan Policy, click the Commitment/Policy Preparation button  or select Commitment/Policy/Binder from the Data Entry menu.
	2. Select the Schedule B tab and then the Exceptions sub-tab.
	3. To include or exclude an exception on the Owner’s Policy or Loan Policy, highlight the exception and click one of the Mark Selected Text buttons.
	4.  Mark Selected Text for Inclusion on all Policies (Black). By default, all exceptions will be black for inclusion on the final policy.
	5.  Mark Selected Text for Inclusion on Owner’s Policy Only (Blue).
	6.   Mark Selected Text for Inclusion on Loan Policy/Exclusion from Owner  Policy (Pink).
	7.  Mark Selected Text for Exclusion from All Policies (Olive).


	II. Owner’s Policy – Schedule B
	Instructions for preparing Schedule B of the Owner’s Policy:
	A. To prepare the Owner’s Policy and/or Loan Policy, select the Policy tab.
	B. The Owner’s and Loan Policy Numbers will automatically display. Policy numbers are the same as the File Number and the Commitment Number followed by “-01.”
	 NOTE: Policy jackets are printed in REsource. Pre-printed serialized jackets are no longer used.

	C. Enter the Effective Date or click the Fill in Date Using Calendar button.
	D. Enter the Policy Time, if known.
	E. All selected (not marked) exceptions from the Commitment > Schedule B > Exceptions tab will automatically appear unmarked in the Owner Schedule B sub-tab and the Mortg. Schedule B sub-tab the first time that the Policy tab is selected.
	F. Add or edit exceptions or select language from the Lookup Standard Language Items button,  as required.
	G. To start over, use the Clear and Pull Commitment for Both Owner and Mortgagee button.  This will delete all exceptions entered in both the Owner Sched B and Mortgagee Sched B tabs and import the exceptions from the commitment again.
	 NOTE: Any new exceptions should be added after the original exceptions have been imported from the commitment.


	III. Schedule B Part II
	The Mortg. Sched B II sub-tab is used only if there is a second (subordinate) mortgage to insure or to reflect other matters over which the lien of the insured mortgage has priority.
	A. Select the Mortg. Sched B II sub-tab. The Mortgage Schedule B Part II text area will display.
	B. The Schedule B Part II language will automatically print on the Schedule B Part II document. Click the Lookup Standard Language Items button  to select the mortgage exception language, or other matters that may be required in this section.
	C. Remember that all exceptions raised under the Schedule B Part II must also be included on the Owner’s Policy Schedule B. Exceptions should be copied from the Mortg. Sched B Part II sub-tab to the Owner Sched B sub-tab. Please follow the instruction...
	1. After entering the Schedule B Part II language, highlight the text.
	2. Press <Ctrl>+<C> to copy the text.
	3. Select the Owner Sched B sub-tab.
	4. Place the cursor in the desired text area and press <Ctrl>+<V> to paste the text.
	5. When printing the Loan Policy, remember also to print the Loan Policy Schedule B Part II document, if required, and include with the Loan Policy.


	IV. Insured Mortgage
	Instructions for completing the Insured Mortg sub-tab.
	A. Select the Insured Mortg sub-tab. The Insured Mortgage text area displays.
	B. Enter the new mortgage exception, if any, or click the Lookup Standard Language Items button.  Select Mortgage from the Category drop-down list, select the New Mortgage Exception, and answer the prompts.
	C. The new mortgage exception will automatically appear on the Loan Policy Schedule A.
	D. The new mortgage exception will not automatically appear on the Owner’s Policy Schedule B. Please follow the instructions below to copy the new mortgage exception to the Schedule B of the Owner’s Policy.
	1. After entering the new mortgage exception in the Insured Mortg sub-tab, highlight the text.
	2. Press <Ctrl>+<C> to copy the text.
	3. Select the Owner Sched B sub-tab.
	4. Place the cursor under the Real Estate Tax exception and press <Ctrl>+<V> to paste the text.
	5. Press the <Ctrl>+<N> to add the bullet.


	V. Title Vested In
	Instructions for completing the Title Vested In sub-tab:
	A. Select the Title Vested In sub-tab. The Title Vested In text area will display to display.
	B. Click the Insert Buyer/Seller button  to import the Name(s) of Buyer or Seller.

	VI. Printing the Owner’s Policy and Loan Policy
	Several document packages are available from the Print Document list. The packages contain all of the individual documents commonly issued with the policies.
	The packages appear in blue. Select the ATG Pkg. Mortgagee Pol 06 to print the Loan Policy or the ATG Pkg. Owner Pol 06 to print the Owner’s Policy.


	11 |  Two Mortgages, One Loan Policy
	I. Policy Preparation
	To prepare a Loan Policy insuring two mortgages, prepare the Owner’s Policy and Loan Policy following all instructions listed in the Policy Preparation section of this manual, and then do the following.
	A. Go to Order Entry and select the Loan tab. Under 2nd Loan Information, enter the Loan Amount and Lender name. Close Order Entry.
	B. Click the Commitment/Policy Preparation button  or select Commitment/Policy/Binder from the Data Entry menu.
	C. Under the Cmt Sched A tab, select the 2nd Mortg. Insured sub-tab.
	D. Click the Insert Mortg. Insured Name(s) in Text Box button  to insert the Second Mortgagee’s name(s).
	1. Select the Commitment > Schedule B > Exceptions sub-tab to select exceptions for inclusion in or exclusion from the policies.
	2. Select the Policy > 2nd Ins Mortg. Desc. sub-tab.
	3. Click the Lookup Standard Language Items button.  From the Category drop-down, select Mortgage. From the resulting list, select New 2nd Mortgage. This exception will insert the names of the buyers, second lender name, and second loan amount. Enter ...
	4. Copy and paste the second mortgage description into the text box under the Owner Sched B sub-tab. The first mortgage description must also be copied into the text box under the Owner Sched B sub-tab.
	 TIP: To copy and paste:
	– Highlight the second mortgage description and press <Ctrl>+<C>.
	– Select the Mortg. Schedule B II sub-tab, place the cursor in the text entry area, and press <Ctrl>+<V>.




	II. Printing the Loan Policy Insuring Two Mortgages
	A. Click the Print/Create Document button.
	B. Under Print Documents, select ATG Pkg. One MPA 2 Mortgages 06.
	C. The following documents are contained in this package:
	1. Loan Policy Cover
	2. Schedule A (listing both mortgages)
	3. Schedule B
	4. Endorsements:
	a. Environmental Protection Lien (EPL)
	b. Comprehensive
	c. Location
	d. Multiple Mortgage

	 NOTE: The Multiple Mortgage Endorsement deletes the policy provisions regarding priority of the insured mortgage, paragraph 6 of the insuring provisions, and substitutes a new insuring provision that sets forth the priority between the two insured m...



	12 |  Two Mortgages, Two Loan Policies
	I. Policy Preparation
	When there are two mortgages given on the same property at the time of closing, the lender(s) will require that either two separate Loan Policies be issued insuring each mortgage or that both mortgages be insured on one Loan Policy. Always check with ...
	To prepare two separate Loan Policies, prepare the Owner’s Policy and Loan Policy following all instructions listed in the Policy Preparation section of this manual, and then do the following:
	A. Go to Order Entry and select the Loan/Misc tab. Under 2nd Loan Information, enter the Loan Amount and Lender name. Close Order Entry.
	B. Click the Commitment/Policy Preparation button  or select Commitment/Policy/Binder from the Data Entry menu.
	C. Under the Cmt Sched A tab, select the 2nd Mortg. Insured sub-tab.
	D. Click the Insert Mortg. Insured Name(s) in Text Box button  to insert the Second Mortgagee’s name(s).
	E. Select the Commitment > Schedule B > Exceptions sub-tab to select exceptions for inclusion in or exclusion from the policies.
	F. Select the Policy tab.
	1. Enter the second Loan Policy number in the 2nd Mortg. Policy Number field. The policy number should be the same as the file number followed by “–A.”
	2. Select the 2nd Mortg. Sched B sub-tab.
	3. Click the Create Sched B from 1st Policy button.  The Schedule B exception from the first Mortg. Sched B sub-tab and the first Insured Mortg sub-tab will be copied into the text box under the 2nd Mortg. Sched B sub-tab.

	G. Select the 2nd Ins. Mortg. Desc sub-tab.
	H. Click the Lookup Standard Language Items button.  From the Category drop-down, select Mortgage. From the resulting list, select New 2nd Mortgage. This exception will insert the names of the buyers, second lender name, and second loan amount. Enter ...
	I. Copy and paste the second mortgage description into the text box under the Mortg. Schedule B II sub-tab. The first mortgage description must also be copied into the text box under the Owner Sched B sub-tab.
	 TIP: To copy and paste:
	– Highlight the second mortgage description and press <Ctrl>+<C>.
	– Select the Mortg. Schedule B II sub-tab, place the cursor in the text entry area, and press <Ctrl>+<V>.


	J. Copy and paste the second mortgage description into the text box under the Owner Sched B tab. The first mortgage description must also be copied into the text box under the Owner Sched B sub-tab.

	II. Printing the Loan Policy Insuring Two Mortgages
	A. Click the Print/Create Document button.
	B. Under Print Documents, select ATG Pkg. Two MPAs 2 Mortgs. 06.
	The following documents are contained in this package:
	1. First Loan Policy
	a. Loan Policy Cover
	b. Schedule A
	c. Schedule B
	d. Schedule B Part II
	e. Environmental Protection Lien (EPL) and Comprehensive Endorsements are included on the Schedule A of the Loan Policy.

	2. Second Loan Policy
	a. Loan Policy Cover
	b. Schedule A
	c. Schedule B
	d. Environmental Protection Lien (EPL) and Comprehensive Endorsements are included on the Schedule A of the Loan Policy.



	III. Printing the Owner’s Policy and/or Loan Policy
	A. Click the Print/Create Document button  located on the toolbar.
	B. Select either the ATG Pkg. Owner’s Pol 06 and ATG Pkg. Mortgagee Pol 06 package documents or click Category and select Owner’s Policy 2006 or Mortgagee Policy 2006 for a list of all documents.


	13 |  Miscellaneous
	I. File Attachment Utility
	The File Attachment Utility is used to store scanned documents such as an ATG Initial Search Report, Later Date Search Report, Closing Protection Letters, Closing Packages, copies of the issued commitment, policies, signed ALTA Statement, Accounting I...
	A. Click the File Attachment Utility button  or select Attachments from the ATGF Extensions menu to access scanned document images.
	B. Double-click the desired group of documents.
	C. Click the Zoom drop-down menu to select a preset magnification.
	D. Click the page navigation arrows  to move to a different page.
	E. Click the Print button to print the document.
	 NOTE: To print a document from the Attached File Manager, highlight the document and click the Print button on the toolbar or click the File menu to print all or selected pages of the image.

	F. Highlight your local printer from the Select Printer list.
	G. Select the page range and click OK.

	II. Create Custom Standard Language
	A. The Standard Language feature enables you to create custom special exception language. Many exceptions have already been created for your use; see the Standard Language Entries section of this manual for a complete listing.
	B. Standard language exceptions can be simple text or can include user prompts for data entry and/or insert field values from Complete Closing.
	C. To start the Standard Language program, click the Standard Language Entry icon  on the REsource Desktop.
	D. Standard Language is organized by Category and then by Description for easy access. Members are asked to create a new Category using their Member Number as the name of the Category, and enter all their exceptions in that one Category. Many exceptio...
	E. Creating custom Standard Language
	1. Create custom Standard Language by clicking the New Category button.
	2. Enter a name of the Category (member number).
	3. Enter a descriptive name for the exception in the Description field and click OK.
	4. Click inside the text area and enter the exception. Be sure to insert the bullet (() by pressing <Ctrl>+<N>. Right-click inside the text area for additional text editing options such as Spell Check.
	5. To add additional exceptions to this Category, click the Add New Entry button.
	6. Enter a new descriptive name for the exception in the Description field and begin entering the next exception. Many exceptions can be added to the Category.
	7. Use the Navigation buttons  to view all exceptions in the Category.

	F. Instructions for Creating User Prompts
	Prompts directing the user to enter information, such as a Document Number or Date, can be inserted into an exception when the Standard Language is selected in Complete Closing. When the Insert Prompt option is selected, the user defines the prompt, s...
	1. Click the Insert Prompt button.
	2. Select the Type of Prompt.
	3. Enter a user prompt in the Prompt for User field.
	4. Click OK.
	The code will be embedded in the text of the exception. When this exception is selected from the Lookup Standard Language in Compete Closing’s Commitment Sched B > Exceptions sub-tab, the user prompt will display. When the user enters a response, the ...

	G. Instructions for Inserting Fields
	Additionally, all REsource data, such as Seller/Buyer Names, can be imported into Standard Language. This option enables the data from any field to be inserted into an exception eliminating the need to re-enter data already entered in Complete Closing...
	1. Click the Insert Field from Table button.
	2. Click the Plus (+) in front of the folder that contains the needed information. The folders correspond to the tabs in Complete Closing. In this example, click the Seller Information folder.
	3. Click the Seller Formal Name so that it becomes highlighted.
	4. Click OK.
	5. The Seller name will now be coded into this exception. To check the exception, open Complete Closing and select a file. Click the Commitment/Policy Preparation button,  select the Sched B tab and then the Exceptions sub-tab. Click the Lookup Standa...

	H. Edit Standard Language
	1. To edit Standard Language, close Complete Closing and return to the Standard Language program by clicking the Standard Language icon  on the REsource desktop.
	2. Locate your Category by clicking the Lookup Category button.
	3. Using the Navigation buttons,  locate the exception language.
	4. The language will display in the text area available for editing.
	 NOTE: Only Standard Language created in your region can be edited. Standard Language created in a region can only be viewed by users in that region. In addition, please refrain from adding standard language to existing categories created by ATG as t...



	III. Organizational Features
	Standard Language items can be organized into packages (groups of standard language). Codes can be assigned to Standard Language items instead of descriptions.
	A. Packages
	1. Packages, which group exceptions together, can be created within existing categories. In the example below, a package was created called “Standard Residential.” Two common residential exceptions were placed in the package.
	2. To create a Standard Language Package:
	a. Select Standard Language Entry  from the REsource Desktop.
	b. Select File > Setup Packages.
	c. Click the Create New Package  button.
	d. Name your package and enter the same name in the Package Category field.
	e. Select the exceptions from the list.
	f. Close when finished.


	B. Codes
	Codes can now be associated with Standard Language items and the codes can then be used when looking up Standard Language. To enter a Code for a Standard Language item:
	1. Select Standard Language Entry from the REsource Desktop.
	2. Create a new Standard Language item or select an existing item.
	3. Enter the Code, usually a combination of letters and/or numbers, in the Code field and close.
	4. The Standard Language item can be located by changing the Search By field from Description to Code while in the Standard Language Lookup.


	IV. PaperlessCloser
	A. Placing an Order
	1. Login: Go to http://resource.atgf.com.
	Enter your User Name and Password in the login screen. Do not use a dash (-) in your password.
	 HINT: PaperlessCloser uses the same user name and password as the ATG website.

	2. Browser Settings (Internet Explorer)
	a. Click Tools > Pop-up Blocker > Turn Off Pop-up Blocker.
	b. Click Tools > Internet Options > Security. Select Trusted Sites and click the Sites button. Add http://*.atgf.com to the trusted zone.

	3. From the Lobby, click the New Order link.
	4. Click Use single order entry form.
	5. All data entry sections will open. Complete all required fields.
	 NOTE: Use only numbers when entering Sale Price, Earnest Money, and Loan Amount.

	6. Using the Search feature:
	a. The Lender, Mortgage Broker, and Buyer’s Attorney sections contain a Search button .
	b. Click the Search button before entering information in the fields.
	c. Enter the search criteria (“ABC Lender” in this example).
	d. Click the Search button. The search results display at the bottom of the screen.
	e. Click the Add To Order link in front of the desired agent.
	f. The Search screen closes and the information populates the section in which the search was initiated.
	 NOTE: If the agent is not found, click the Add New button, complete the form, and click the Add New button. The Search screen closes and the information populates the screen in which the search was initiated.

	7. Saving using the Add Button
	a. The Seller, Buyer, and Property sections contain an Add button, located at the bottom of each section.
	 NOTE: To save the data entered in each of these sections, you must click the Add button. If the Add button is not clicked, the Seller, Buyer, and Property information will not be saved.
	b. The data will now be displayed at the bottom of the section and the data entry fields will be cleared.

	8. To enter multiple Sellers, Buyers, or Properties, click the Add button after entering each new item.
	9. Use the Clear Form button  to delete all data in that section.
	10. To remove saved information, check the checkbox and click the Remove button. .
	11. Click the Submit Order button  at the bottom of the page. The Property Information dialog opens.
	12. Complete the Property Information, including the Property Type, Search Provider, and Order Category.
	 NOTE: The order must contain a property Address, County, State, and, if possible, a Tax ID number (Permanent Index Number).

	13. Click the Add Property button.  The Services page displays.
	14. Select the desired services. Typical services include:
	a. Search – No Prior or Search – With Prior;
	b. Endorsements, if known;
	c. Type of Property and Transaction Type;
	d. Full Closing, unless your office is authorized to close.

	15. Click the Submit Services button  when finished.
	16. Click Continue.
	17. Your order is now complete and the File Number displays.
	18. Click the Return to Lobby button  to continue or to logoff.

	B. Checking the Status of an Order
	1. From the Lobby, click the desired File Number.
	2. From the Conference Room select File Status.
	3. The File Status displays.

	C. Printing a Published Document
	1. The Print Document option allows one or more documents in the list of current documents to be printed.
	2. To print a document:
	a. From the Lobby, click the desired file number.
	b. From the Conference Room, select Documents.
	c. Select the check box next to each document you want to print.
	d. Click the Print button.
	e. The document will display in the selected format.
	f. Select File > Print to print the document.


	D. Printing a Scanned Document
	1. From the Lobby, click the desired File Number.
	2. From the Conference Room, select Scanned Documents.
	3. Select the check box next to each document you want to print.
	4. Select Scanned Documents.
	5. Select the desired scanned document from the list and select Open from the Download menu.

	E. Using a Template to Create an Order
	1. Once a template is saved, the template can be used for future orders that have common elements, such as the Lender, Buyer/Seller, Property, and other selectable information.
	2. To create a template:
	a. From the Lobby, navigate to the New Order page. A blank order form displays.
	b. Select the Single order entry form link.
	c. Complete the information that will remain the same such as the Lender, Buyer/Seller, Property, and other selectable information.
	d. When finished, click the Save as Template button  at the bottom of the page.
	e. Enter a name for the template and click Save.

	3. To use a template:
	a. From the Lobby, navigate to the New Order page. A blank order form displays.
	b. Select the Single order entry form link.
	c. Click the Use a saved template link. The Select an Order Template screen opens.
	d. Select a template from the Select a Template drop-down.
	e. Click the OK button. The template displays as a new order.
	f. Complete the remaining information and click Submit.
	i. Prior Policies should be faxed to 312.224.0330 and should include the REsource file number.
	ii. You will receive an e-mail notification upon placing your order.
	iii. Please call the REsource Helpdesk at 888.776.4420 with questions.



	F. Preparing a Seller’s Closing Statement
	1. Opening the Closing Statement
	a. Select the desired file in the PaperlessCloser Lobby.
	b. Select Closing Statement
	c. The Closing Statement page displays.
	d. The Closing Statement will populate with information contained in the file. To update the Closing Statement with the latest information, click the Resync REsource Data button.  The Closing Statement will populate and recalculate with the updated in...

	2. Entering and Editing Data
	a. Double-click the row of the desired line item to enter and/or edit data. The Editor window opens.
	b. The Description/Item of any line may be changed, if desired.
	c. Enter the payee’s name, if any, in the Payee field.
	d. Enter the amount in the Buyer Credits field (Seller charge) or Seller Credits field (Buyer charge). Do not type dollar signs ($) or commas (,); they will auto-fill.
	e. Click Update to save or Cancel to exit line editing.

	3. Adding Title Charges and Miscellaneous Charges
	a. Right click inside the row of a line item to display options.
	b. Select add Title Charge to add an item to the Title Charges category or select add Misc Charge to add an item to the Miscellaneous Category. The Add Closing Statement Item menu opens.
	c. Enter the item description in the Description field.
	d. Enter the payee’s name, if any, in the Payee field.
	e. Enter the amount in the Buyer Credits field (Seller charge) or Seller Credits field (Buyer charge). Do not type dollar signs ($) or commas (,); they will auto-fill.
	f. Click the Save or Cancel button.

	4. Removing Items
	a. Right click on the line item to be removed to display options.
	b. To remove an unused or unwanted line item in its entirety, select remove item.

	5. Saving Changes
	Click the Save Changes button  on the toolbar to save changes.
	This button MUST be selected prior to exiting the Closing Statement; otherwise, ALL data entered will be LOST.


	6. Printing
	To print the Closing Statement, click the Print button  on the toolbar.

	7. Submitting the Completed Closing Statement via Email (Chicago Area Only)
	To send the completed Closing Statement to the ATG Closing Services department, click the Complete – Submit to Closing Services button.

	8. Exiting Closing Statement
	To exit the Closing Statement and return to the PaperlessCloser Lobby, click the return to file lobby button  on the toolbar.


	G. Requesting a Closing Using PaperlessCloser
	1. To request a closing using PaperlessCloser:
	a. Select the desired file in the PaperlessCloser Lobby
	b. Select Schedule Closing.
	c. The ATG-Assisted Closing Request page opens.
	i. Closing information
	(1) Requested Date and Time
	Entering the closing date will indicate to ATG Closing Services that you have requested a closing.
	(a) Date (Required)
	To enter the closing date, click in the Date field. A calendar will display. Select the closing date.
	(b) Time (Required)
	To enter the closing time, click in the Time field. A list of times will display. Select the closing time.

	 NOTE: The requested closing date must be entered and saved. If the requested closing date is not entered and saved, the closing request cannot be processed.
	(2) Lender Confirmed Date and Time

	Date and time the lender confirmed the closing.
	(3) Miscellaneous (Misc)
	(a) RESPA, Checks, Package


	To select the party responsible for the preparation of the HUD-1 Settlement Statement, Checks for Disbursement, and Loan Package Pickup, click the drop-down arrow  at the end of each field. The available choices are ATG and the Member.
	(b) Search Provider
	Select the Search Provider by clicking the drop down arrow
	(c) Date Taken

	Current date
	(4) Notes

	Add any additional information, if any.
	(5) Click the Save button.

	ii. Place of Closing
	(1) The place of closing will populate with the member’s address by default.
	(2) To change the place of closing, click the pencil icon.  The Change Place Of Closing dialog box displays.
	(3) Begin typing the location in the Lookup field. Several choices will display. For an ATG closing office, begin your search with the letters “ATG.”
	(4) Select the location of the closing and click the Save or Cancel button.

	iii. Contact Loan 1 and 2; Contact Broker
	(1) The Lender information is populated with the information contained in the file.
	(2) The Lender can be changed by clicking the pencil icon.  The Lender Contact dialog box opens.
	(3) Enter the Lender Contact name, Company name, and Phone and Fax numbers.
	(4) Click the Save or Cancel button.
	(5) To add a second lender or mortgage broker, use the Contact Loan 2 or Contact Broker tab. Enter the information and click the Save or Cancel button.

	iv. Buyer’s Attorney
	(1) The Buyer’s Attorney information is populated with the information contained in the file.
	(2) The Buyer’s Attorney can be changed by clicking the pencil icon.  The Buyer’s Attorney dialog box opens.
	(3) Enter the Buyer’s Attorney name, Address, Phone, and Fax numbers.
	(4) Click the Save or Cancel button.

	v. Additional Closing Information
	The data contained in the Property, Member, Buyer, Seller, and Seller’s Attorney sections is pulled from the order information. If any of this information is incorrect, use the Note field to type corrections.


	2. File Status
	There are five status levels assigned to each closing:
	a. None
	The closing has not been requested; no closing date has been entered in the ATG-Assisted Closing Request page.

	b. Requested
	ATG has received and is processing the closing request. Entering a closing date and time will automatically change the closing status to requested.

	c. Approved
	ATG has confirmed the closing with all parties. The assigned closer’s name assigned RESPA Operator’s name will display in the Status box.

	d. Cancelled
	The closing has been cancelled by the member or by the lender. To cancel a closing, contact the Closing Services Department.

	e. File Locked
	i. Twenty-four (24) hours prior to the closing, the file will be locked automatically. Any changes to the closing information displayed on the ATG-Assisted Closing Request page will require a call to the ATG Closing Services Department.


	3. Notes
	a. Add additional notes, if any
	b. Click the Save button.

	4. Print
	To print a summary of the Closing Request click the Print button.



	V. Illinois Real Estate Transfer Declaration
	Instructions for Preparing the Illinois PTAX-203
	Complete Closing prepares, saves, and prints the PTAX, Cook County, and Chicago Transfer Declarations. Necessary information regarding the transaction must be entered in the Order Entry tab, including Buyer/Seller Name and Address, Buyer/Seller Attorn...

	A. Click the Prepare Transfer Tax Documents button  on the toolbar or select Utilities > ATG Transfer Tax.
	1. Click File > Open and select Illinois PTAX-203.
	2. The PTAX-203 data entry form displays.

	B. Parcel Information
	1. Parcel No.
	Enter the Parcel Number (PIN/Tax ID). If the Tax ID number has been entered in Order Entry, this field will auto-fill.
	 NOTE: The data in the PTAX form will not be saved without a Parcel No.

	2. Lot Size
	Enter the Lot Size.
	3. County
	Enter the County of the property. If the County has been entered in Order Entry, this field will auto-fill.
	 NOTE: The Transfer Tax amounts will not calculate without a County.
	4. Township
	Select the Township from the drop-down list. If the Township has been entered in Order Entry, this field will auto-fill.

	C. Deed Information
	1. Deed Type
	Select the Deed Type by selecting the appropriate check box.

	2. Deed Date
	Select the Month from the drop-down list and enter the Year.


	D. Property Type
	1. Current Use
	Select the Current Use by selecting the appropriate check box.

	2. Intended Use
	Select the Intended Use by selecting the appropriate check box.


	E. Changes to the Property
	Select Changes to the Property, if any, and enter Date of Change.

	F. Transaction Information
	Select relevant Transaction Information, if any.

	G. Miscellaneous
	Select Miscellaneous items, if any.

	H. Transfer Taxes
	The consideration (purchase price), if entered in the Order Entry tab, will populate the Consideration field and calculate the amount of the State and County Tax. The consideration may also be manually entered in this field.

	I. Exemption Information
	If the transaction is exempt from tax, click the appropriate Exemption checkbox.

	J. Homestead Exemptions
	Enter relevant Homestead Exemptions, if any.

	K. Seller Forwarding Address
	Enter the Forwarding Address of the Seller.

	L. Print County Tax Form
	M. Save
	Saves the current information.

	N. Close & Print
	Saves the current information, closes the form, opens the Print Document menu, and pre-selects the PTAX document.

	O. Cancel
	Abandons any manual entries and closes the form.

	P. PTAX-203-A
	In addition to the PTAX-203 form, the PTAX-203-A will automatically print for non-residential property with a value above $1,000,000. To enter additional information, the PTAX-203 must be open. Click File > Open > PTAX-203-A.

	Q. PTAX-203-B
	1. In addition to the PTAX-203 form, the PTAX-203-B can be printed when transferring a beneficial interest in real property without using a deed or trust document.
	2. To enter the necessary information, the PTAX-203 must be open. Click File > Open > PTAX-203-B.


	VI. Instructions for preparing Cook County Transfer Declaration
	A. From the Transfer Tax window, click File > Open and select Cook County Transfer Declaration.
	B. Parcel No.
	Enter Parcel No. (PIN/Tax ID). If Tax ID has been entered in Order Entry, this field will auto-fill.

	C. Property Type
	Select the Property Type.

	D. Deed Information
	Select Date deed was delivered or recorded from the drop-down list.

	E. Interest Transferred
	Select the Interest Transferred from the drop-down list.

	F. Exemption Information
	If the transaction is exempt from tax, click the appropriate Exemption checkbox.

	G. Save
	Saves the current information.

	H. Close & Print
	Saves the current information, closes the form, and opens the Print Document menu.

	I. Cancel
	Abandons any manual entries and closes the form.


	VII. Instructions for Preparing City of Chicago Transfer Declaration
	A. From the Transfer Tax window, click File > Open and select Chicago Transfer Declaration.
	B. Parcel No.
	Enter Parcel No. (PIN/Tax ID). If Tax ID has been entered in Order Entry, this field will auto-fill.

	C. Property Address
	Property Address displays. Select and drag address parts to corresponding boxes or enter information directly into boxes.

	D. Property Type
	Select the Property Type by selecting the appropriate check box.

	E. Certifications
	Select the applicable radio buttons for Building Registration and Zoning Compliance.

	F. Deed Information
	Select Date deed was delivered or recorded from the drop-down list. If previously entered in Cook County Declaration, this will auto-fill.

	G. Interest Transferred
	Select applicable check box for Interest Transferred.

	H. Consideration other than Cash/Price Contingent on Future Event
	Select applicable check box and enter data in text box. These items will print on the addendum page.

	I. Buyer/Seller Exemptions
	If the transaction is exempt from tax, click the appropriate Exemption checkbox. By doing so, the applicable tax amounts will automatically zero out.

	J. Miscellaneous
	Seller and Buyer Attorneys Names (including addresses) will auto fill from Order Entry. Drag and drop names into corresponding boxes or enter names directly in boxes.

	K. Additional Information
	Select the appropriate checkboxes, if applicable.

	L. Transfer Taxes
	Tax amounts for Buyer and Seller automatically calculate based upon the sale price.

	M. Save
	Saves the current information.

	N. Close & Print
	Saves the current information, closes the form, and opens the Print Document menu.

	O. Cancel
	Abandons any manual entries and closes the form.


	VIII. Copying a REsource File
	Generally, if there is a first and a second new mortgage, the lender may require any of the following: two commitments, two HUD-1 Settlement Statements, and/or two Loan Policies.
	A. To copy a REsource file, it is necessary to create a second file. Follow the steps listed below to create a second REsource file:
	1. Click the Add New File Number button  or select New File > No Suggest from the File menu.
	2. Enter the Tax ID Number. Click the Search button  and the Create New button.
	3. The Enter New File screen opens.
	4. Click the File Number field and enter the original file number followed by “–A.”
	 EXAMPLE:
	– Original file number: 100900101481
	– New duplicate file: 100900101481-A

	5. Click OK.
	The Order Entry tab displays.


	B. Using a Template for Order Entry
	The Use Template feature will copy all Order Entry data from an existing file or from a template file. There is also a Use Template feature to copy the commitment and policy data from an existing file or from a template file.
	 NOTE: It is recommended that you use the Template feature prior to adding data to the file. Two confirmation messages will display upon selecting Use Template, indicating that any data previously entered in the Order Entry tabs will be deleted and r...
	1. Click the Order Entry button  or the Data Entry menu to access Order Entry.
	2. From the Order Entry > Main tab, click the Use Template button.
	3. Click OK on the confirmation prompts that indicate the selected template will override any data entered in the Order Entry tabs.
	The Select Template window opens.

	4. You may:
	a. Select a file that is a template; or
	b. Click the All Orders button  to list all of your files.

	5. Select the file that you want by either double-clicking the file name or clicking the file name once to highlight it and clicking OK.
	The data from the existing file will now appear in the new file.
	 NOTE: The Sale Price, Earnest Money, and Loan Amount will not be copied from the existing file. You must also go to the ATG Services screen to select services and calculate rates. .


	C. Using a Template for the Commitment/Policy
	1. To copy the commitment/policy data from an existing file into a new file, click the Commitment/Policy button  or select Commitment/Policy/Binder from the Data Entry menu.
	2. Click the Use Template button.
	 NOTE: It is recommended that you use the Template feature prior to adding data to the Commitment/Policy tabs. Two confirmation messages will display upon selecting Use Template, indicating that any data previously entered in the Commitment/Policy ta...

	3. Click OK on the confirmation prompts that indicate the selected template will override any data entered in the Commitment/Policy tabs.
	The Select Template window opens.

	4. You may:
	a. Select a file that is a template; or
	b. Click the All Orders button  to list all your files.

	5. Select the file that you want by either double-clicking the file name or clicking once on the file name to highlight it and clicking OK.
	6. The data from the existing file will now appear in the new file.


	IX. Requesting Closing Protection Letters (CPL) Using REsource®
	For Illinois closings on or after January 1, 2011, Closing Protection Letters (CPLs) must be prepared and issued by ATG to the lender, borrower, and seller for all transactions where either the member or ATG provides settlement services.
	CPLs may also be requested from PaperlessCloser or from the ATG website, www.atgf.com, or by calling 800.252.0402.
	The fees for issuance of the CPLs, payable to ATG, are as follows:
	A. Requesting a CPL Using REsource
	The CPL can be requested from REsource prior to closing. The following information should be entered in the REsource file prior to requesting the CPL: Buyer, Seller, Lender, and Property.
	1. Select the file requiring the CPL.
	2. Go to the Utilities menu.
	3. Select Request IL CPL.
	4. The file information will populate the order form. Complete all remaining information.
	5. Click the Submit Request for CPL button located at the bottom of the form.
	6. The completed CPLs will reside in the File Attachment Utility and will be available to print.

	B. Printing the CPL
	1. Click the File Attachment Utility button  located on the toolbar.
	2. Select the CPL you wish to print.
	3. The CPL displays.
	4. Click the Print button  to print.

	C. Alternative Print Option:
	1. Click the File Attachment Utility button  located on the toolbar.
	2. Highlight the CPL you wish to print.
	3. Click the Print button on the toolbar of the Attached File Manager.
	4. The CPL displays. Click the Print button  to print.

	D. Resubmitting a Request for a CPL
	1. Select the file requiring the CPL and make any changes to the REsource file.
	2. Go to the Utilities menu and select Request IL CPL.
	3. Choose one of the action items and click the Submit Request button.

	E. Additional ATG REsource Information
	CPLs in the ATG Edit Services screen  will automatically populate for each file and populate the Invoice for Title Charges, HUD, CheckWriting, and Accounting Information Schedule. Be sure to select the correct Transaction Type in Services.
	1. ATG Edit Services
	2. Commitment Schedule B, Section I, Requirements
	The following language will automatically populate the Commitment Schedule B, Section I, Requirements:

	3. Invoice for Title Charges
	The CPL fees will populate the second page of the Invoice for Title Charges.

	4. 2010 HUD
	a. The CPL fees will populate the Additional Title Services window and will appear on Line 1101. To view, click the Additional Title Services button  on the 1100 toolbar. .

	5. CheckWriting
	In CheckWriting, an automatic disbursement, payable to “ATG Fees and Transfers,” will be created for the CPL fees.


	F. Accounting Information Schedule
	The Accounting Information Schedule will reflect the CPL fees in the Premium Information section.



	14 |  Standard Language Entries
	Access
	No Access: Policy
	Notwithstanding the insuring clauses of this policy, ATG does not insure against any loss or damage by reason of lack of access to and from the land.

	Restrictions
	Subdivision restrictions, easements, and building setback lines as may be disclosed on the recorded Plat of Subdivision or of public record, if any.

	No Access: Commitment
	The public records do not show any means of ingress or egress to or from the land, and, by reason thereof, this commitment and our policy, if and when issued, should not be construed as insuring against any loss or damage by reason of lack of access t...


	Advisory Report
	Advisory Report
	This is not a title policy, guarantee, or opinion of title and it is not binding upon Attorneys’ Title Guaranty Fund, Inc. This advisory report must be examined and the information contained herein verified by a member attorney prior to execution. Upo...


	Association: Unincorporated
	Charter/Bylaws: Commitment
	A certified copy of the charter and amendments thereto, if any, and of the bylaws of {PR,"Enter the name of the association.",ST1,1}, an unincorporated association, should be furnished, and this Commitment is subject to such forth exceptions, if any, ...

	Resolution: Commitment
	Upon a conveyance or mortgage of the land, a certified copy of a resolution passed by the members of the party in title, or acquiring title, authorizing the execution or acceptance of the instrument of conveyance or execution of the mortgage should be...


	ATG
	Underwriting Approval
	This commitment, and any policies committed for thereunder, is subject to approval by the Underwriting Department of Attorneys’ Title Guaranty Fund, Inc., and is subject to such further and additional exceptions as may be required by it.


	ATG Requirements
	Access Endorsement
	In order to issue an Access Endorsement on the final policy, we must be provided with a survey of the property, dated within the previous six months, showing that the property abuts a physically open public way or a private way of which the property h...

	Contiguity 4 Endorsement
	In order to issue the Contiguity Endorsement 4, we must be provided with a survey of the property, dated within the previous six months, showing that all parcels listed on Schedule A constitute a single tract of land with no gaps or gores between any ...

	Creditors’ Rights Endorsement
	In order to issue the Creditors’ Rights Endorsement on the final Loan Policy, approval must be obtained from an ATG underwriter. Please call {PR,"Enter name and telephone number of ATG underwriter:",ST1,1} for additional requirements.

	Direct Operations
	Payment and release of record of the mortgage(s) set forth as exception number(s) {PR,"Enter exception number(s) for mortgage(s) to be released",ST1,1}.
	We must be advised in writing of the name of anyone not referred to in this commitment who will obtain an interest or who will make a loan on the land. We may make additional requirements or exceptions relating to the interest or loan.
	In order to provide full ALTA coverage on the Loan Policy for residential property, we must be provided with a fully executed and notarized ALTA Statement (ATG Form 3004) and Affidavit in Lieu of Survey (ATG Form 3001). The policy will be subject to s...

	Survey Endorsement
	In order to issue a Survey Endorsement on the final policy, we must be provided with a survey of the property, dated within the previous six months, showing all parcels as described on Schedule A.

	Zoning 3.0 Endorsement
	In order to issue a Zoning 3.0 Endorsement on the final policy, approval must be obtained from an ATG underwriter. Please call {PR,"Enter name and telephone number of ATG underwriter:",ST1,1} for additional requirements.

	Zoning 3.1 Endorsement
	In order to issue a Zoning 3.1 Endorsement on the final policy, we must be provided with a survey of the property, dated within the previous six months, that includes all of the land contained in Schedule A, shows the location of all buildings on the ...

	Standard Exception Waiver
	To waive Standard Exception No. 1 ("Right or claims of parties in possession not shown by the public records") from the Owner’s Policy, furnish ATG with an ALTA Statement and a land survey made in accordance with the "Minimum Standard Detail Requireme...
	"Rights of public or quasi-public utilities, if any, in the land."
	 NOTE: To establish the nonexistence of such rights, obtain a letter from the official of the municipality in charge of water mains, sewers, etc., such as the village engineer, stating that there are no water mains, sewers, etc., in the said land.
	"Existing leases and tenancies, and rights of tenants thereunder, and those claiming by, through, or under those tenants."
	 NOTE: All existing unrecorded leases affecting the land should be produced for ATG’s inspection, and this commitment is subject to such further exceptions, if any, as may be deemed necessary. If there are no unrecorded leases affecting the land, pro...
	To waive Standard Exception No. 2 ("Encroachments, overlaps, boundary line disputes, and any matters that would be disclosed by an accurate survey and inspection of the premises.") from the Owner’s policy, furnish ATG with a land survey made in accord...
	To waive Standard Exception No. 3 ("Easements, or claims of easements, not shown by the public records") from the Owner’s Policy, supply ATG with a survey in compliance with the requirements noted in Standard Exception No. 2 above. In addition to matt...
	"Rights of public or quasi-public utilities, if any, in the land."
	 NOTE: To establish the nonexistence of such rights, comply with the requirements as set out under Standard Exception No. 1, above.
	To waive Standard Exception No. 4 ("Any lien or right to a lien, for services, labor, or materials heretofore or hereafter furnished, imposed by law and not shown by the public records") from the Owner’s Policy, furnish ATG with the following:
	(a) An ALTA Statement, or its equivalent, executed by all parties holding title to the land during the six months preceding the date of the policy and the purchasers, if any;
	(b) Satisfactory evidence of the payment in full of the cost of furnishing services, labor, and materials in connection with any improvement made on the land within six months of the date of the policy;
	(c) Satisfactory indemnification, as may be required.
	In order to waive Standard Exception No. 5 (“Taxes or special assessments that are not shown as existing liens by the public records”), a current special assessment search must be provided.

	Commercial Real Estate Broker Lien
	Information should be furnished establishing whether any written agreement has been entered into by and between any party or broker for the purposes of buying, selling, leasing, or otherwise conveying any interest in the land described herein; and, if...

	Property Manager Lien
	Furnish ATG with an affidavit by the owner stating that there is no property manager for the insured premises. In the absence thereof, provide a waiver of lien by the property manager covering the date of recording of the deed and mortgage to the Insu...


	Attorneys’ Title Guaranty Fund, Inc.
	24 month Chain of Title Disclaimer
	Disclaimer: This 24 month Chain of Title alone may not be used as the basis for the issuance of an ATG commitment or policy. The liability of Attorneys’ Title Guaranty Fund, Inc., in connection with this search report is limited to actual damages aris...

	Taxes: Five Years
	Taxes for the year {PR,"Enter the last year that taxes were paid (‘YYYY’).",IN1,1} and thereafter:
	First installment {PR,"Enter the previous year (‘YYYY’).",IN1,1} taxes, in the amount of {PR,"Enter amount of the 1st installment prior year taxes.",CU1,2}, is {PR,"Enter whether ‘PAID,’ ‘UNPAID AND DUE,’ ‘NOT YET DUE AND PAYABLE.’",ST1,3}. Second ins...
	Taxes for the year 2008, in the amount of {PR,"Enter amount of 2008 taxes",CU1,13}, are {PR,"Enter whether ‘PAID’, ‘SOLD’, REDEEMED’; include dates",ST1,16}. Taxes for the year 2007, in the amount of {PR,"Enter amount of 2007 taxes",CU1,19}, are {PR,"...
	Taxes for the year {PR,"Enter the current year (YYYY).",IN1,6} are not yet due and payable.
	Permanent Index No. {DB,Property,TaxID,SN1}
	EXEMPTIONS: {PR,"Enter Type of Exemption & Amount",ST1,17}
	TOWNSHIP: {PR,"Enter Township Name or Numbers",ST1,19}
	LOT SIZE/ACREAGE: {PR,"Enter Lot Size or Acreage",ST1,18}
	ACCESS: {PR,"Enter Yes and Name of Access Road OR Enter No",ST1,20}

	Taxes: Madison L/D
	Taxes for the year {PR,"Enter the last year that taxes were paid (‘YYYY’).",IN1,1} and thereafter:
	First installment 2009 taxes, in the amount of {PR,"Enter the amount of 1st installment of tax",CU1,2} is {PR,"PAID, UNPAID AND DUE 07/07/2010, OR SOLD",ST1,3}. Second installment 2009 taxes, in the amount of {PR,"Enter the amount of 2nd installment o...
	Taxes for the year {PR,"Enter the current year",ST1,10} are not yet due and payable.
	Permanent Index No. {DB,Property,TaxID,SN1}
	EXEMPTIONS: {PR,"Enter the exemptions on the property",ST1,11}

	Taxes: Five Years (Not Out)
	Taxes for the year {PR,"Enter the last year that taxes were paid (‘YYYY’).",IN1,1} and thereafter:
	First installment {PR,"Enter the previous year (‘YYYY’).",IN1,1} taxes, in the amount of {PR,"Enter amount of the 1st installment prior year taxes.",CU1,2}, is {PR,"Enter whether ‘PAID,’ ‘UNPAID AND DUE,’ ‘NOTYET DUE AND PAYABLE.’",ST1,3}. Second inst...
	Taxes for the year 2006, in the amount of {PR,"Enter amount of 2006 taxes",CU1,13}, are {PR,"Enter whether ‘PAID’, ‘SOLD’, REDEEMED’; include dates",ST1,16}. Taxes for the year 2005, in the amount of {PR,"Enter amount of 2005 taxes",CU1,19}, are {PR,"...
	Taxes for the year {PR,"Enter the current year (YYYY).",IN1,6} are not yet due and payable.
	Permanent Index No. {DB,Property,TaxID,SN1}
	EXEMPTIONS: {PR,"Enter Type of Exemption & Amount",ST1,17} TOWNSHIP: {PR,"Enter Township Name or Numbers",ST1,19}
	LOT SIZE/ACREAGE: {PR,"Enter Lot Size or Acreage",ST1,18}
	ACCESS: {PR,"Enter Yes and Name of Access Road OR Enter No",ST1,20}


	Bankruptcy
	Creditor’s Rights
	The right of a creditor, trustee or debtor in possession to sell the entire property in the event of a bankruptcy of any co-tenant of the land.

	Statutory Powers
	Statutory rights, powers, and duties of the Trustee in Bankruptcy in the bankruptcy proceeding filed by {PR,"Enter name(s) of person filing bankruptcy",ST1,1} on {PR,"Enter date of bankruptcy filing",DT2,2}, in the Federal District Court for the {PR,"...

	Statutory Powers (Wisconsin)
	Statutory rights, powers, and duties of the Trustee in Bankruptcy in the bankruptcy proceeding filed by {PR,"Enter name(s) of person filing bankruptcy",ST1,1} on {PR,"Enter date of bankruptcy filing",DT2,2}, in the Federal District Court for the {PR,"...


	Champaign
	Urbana Sewer Benefit Tax
	This property is subject to assessment by the City of Urbana with respect to the Sewer Benefit Tax. Non-payment may create a lien against the real estate.
	Note: There is presently no outstanding lien of record on the property.

	Champaign Sanitary Sewer
	This property is subject to assessment by the City of Champaign for a Sanitary Sewer Fee. Non-payment may create a lien against the real estate.
	Note: There is presently no outstanding lien of record on the property.

	Urbana& Champaign Sanitary District
	This property is part of the Urbana & Champaign Sanitary District and as such is subject to assessment therein, and the user charge. Nonpayment may create a lien against the real estate.
	Note: There is presently no outstanding lien of record on the property.

	Roads and Highways
	Rights of the public, the State of Illinois, and the municipality in and to that part of the premises in question taken or used for roads or highways.

	Minerals
	This Commitment, and any policy issued subsequent thereto, does not insure title to any minerals underlying premises in question. Title to those minerals was not included in this examination.

	Drainage District
	The premises fall within the boundaries of the Drainage District and are subject to assessment therein. An annual maintenance assessment may be included with the real estate tax bill.

	Urbana Recycling Tax
	This property is subject to assessment by the City of Urbana with respect to the Recycling Tax. Non-payment may create a lien against the real estate.
	Note: There is presently no outstanding lien of record on the property.

	Mineral Estate
	All rights and easements in favor of the owner of the mineral estate or of any party claiming by, through, or under said estate.


	Co-ownership
	Co-ownership: Creditor’s Rights
	The right of a creditor, trustee, or debtor in possession to sell the entire property in the event of a bankruptcy of any co-tenant of the land.

	Co-ownership: Partition
	Rights of co-tenants to partition, contribution, and possession.

	Co-ownership: Tax Sale
	The right of the United States government to sell the entire property to enforce a tax lien against any co-tenant of the land.

	Fractional Interest
	Rights of co-tenants to partition, contribution, and possession.
	The right of the United States government to sell the entire property to enforce a tax lien against any co-tenant of the land.
	The right of a creditor, trustee, or debtor in possession to sell the entire property in the event of a bankruptcy of any co-tenant of the land.


	Commercial Property
	Gap
	Loss or damage by reason of there being recorded in the public records any deeds, mortgages, lis pendens, liens, or other title encumbrances subsequent to the Commitment date and prior to the effective date of the final Policy.

	Commercial Broker Lien
	Information should be furnished establishing whether any written agreement has been entered into by and between any party or broker for the purposes of buying, selling, leasing, or otherwise conveying any interest in the land described herein; and, if...
	"Any lien, or right to a lien, imposed by law under the provisions of the Commercial Real Estate Broker Lien Act, and not shown in the public records, for compensation agreed upon by a broker and the broker’s client or customer under the terms of a wr...

	Commercial: Standard Exception No. 1
	To waive Standard Exception No. 1 (“Right or claims of parties in possession not shown by the public records”) from the Owner’s Policy, furnish ATG with an ALTA Statement and a land survey made in accordance with the "Minimum Standard Detail Requireme...
	"Rights of public or quasi-public utilities, if any, in the land."
	 NOTE: To establish the nonexistence of such rights, obtain a letter from the official of the municipality in charge of water mains, sewers, etc., such as the village engineer, stating that there are no water mains, sewers, etc., in the said land.
	"Existing leases and tenancies, and rights of tenants thereunder, and those claiming by, through, or under those tenants."
	 NOTE: All existing unrecorded leases affecting the land should be produced for ATG’s inspection, and this commitment is subject to such further exceptions, if any, as may be deemed necessary. If there are no unrecorded leases affecting the land, pro...

	Commercial: Standard Exception No. 2
	To waive Standard Exception No. 2 (“Encroachments, overlaps, boundary line disputes, and any matters that would be disclosed by an accurate survey and inspection of the premises”) from the Owner’s Policy, furnish ATG with a land survey made in accorda...

	Commercial: Standard Exception No. 3
	To waive Standard Exception No. 3 (“Easements, or claims of easements, not shown by the public records”) from the Owner’s Policy, supply ATG with a survey in compliance with the requirements noted in Standard Exception No. 2, above. In addition to mat...
	(a) Rights of public or quasi-public utilities, if any, in the land.
	 NOTE: To establish the non-existence of such rights, comply with the requirements as set out under Standard Exception No. 1, above.

	Commercial: Standard Exception No. 4
	To waive Standard Exception No. 4 (“Any lien, or right to a lien, for services, labor, or materials heretofore or hereafter furnished, imposed by law, and not shown by the public records”) from the Owner’s Policy, furnish ATG with the following:
	(a) An ALTA Statement, or its equivalent, executed by all parties holding title to the land during the six months preceding the Date of Policy and the purchasers, if any;
	(b) Satisfactory evidence of the payment in full of the cost of furnishing services, labor, and materials in connection with any improvement made on the land within six months of the Date of Policy;
	(c) Satisfactory indemnification, as may be required.

	Commercial: Standard Exception No. 5
	In order to waive Standard Exception No. 5 (“Taxes or special assessments that are not shown as existing liens by the public records”), a current special assessment search must be provided.
	Any endorsement requested by an Insured or proposed Insured must be approved by ATG.

	Leases and Tenancies
	Existing leases and tenancies, and rights of tenants thereunder, and those claiming by, through, or under those tenants.

	Property Manager Lien
	Rights of a property manager, if any, to a statutory lien on the premises for its property manager’s fee.
	 NOTE: Furnish ATG with an affidavit by the owner stating that there is no property manager for the insured premises. In the absence thereof, provide a waiver of lien by the property manager covering the date of recording of the deed and mortgage to ...

	Standard Exceptions 1-5
	Rights or claims of parties in possession not shown by the public records.
	Encroachments, overlaps, boundary line disputes, and any matters that would be disclosed by an accurate survey and inspection of the premises.
	Easements, or claims of easements, not shown by the public records.
	Any lien, or right to a lien, for services, labor, or material heretofore or hereafter furnished, imposed by law, and not shown by the public records; and
	Taxes or special assessments that are not shown as existing liens by the public records.

	Broker’s Lien
	Rights or claims of parties in possession not shown by the public records.
	Encroachments, overlaps, boundary line disputes, and any matters that would be disclosed by an accurate survey and inspection of the premises.
	Easements, or claims of easements, not shown by the public records.
	Any lien, or right to a lien, for services, labor, or material heretofore or hereafter furnished, imposed by law and not shown by the public records; and
	Taxes or special assessments that are not shown as existing liens by the public records.

	Commercial Broker Lien (Wisconsin)
	Information should be furnished establishing whether any written agreement has been entered into by and between any party or broker for the purposes of buying, selling, leasing, or otherwise conveying any interest in the land described herein; and, if...
	"Any lien, or right to a lien, imposed by law under the provisions of Wisconsin Stat. 779.32, and not shown in the public records, for compensation agreed upon by a broker and the broker’s client or customer under the terms of a written agreement ente...

	Variations between Record and Measured Bearings
	Variation between record and measured bearings, angles, or distances, as shown on the survey dated {PR,"Date of Survey",ST1,1}, and prepared by {PR,"Surveyor Name",ST1,2}, known as Order/Job No. {PR,"Order/Job. Number",ST1,3}.


	Condominium Conversion
	Additional Parcels (Wisconsin)
	The developer has reserved the right to add additional property to that which has been submitted under the Wisconsin Condominium Ownership Act by the Declaration recorded as Document {PR,"Additional Property: Enter condo declaration document number",S...

	Condominium Conversion (Wisconsin)
	Furnish ATG with a certificate, executed and acknowledged by the Secretary of the Board of Managers/Directors, stating that there are no unpaid assessment liens arising by reason of the nonpayment of assessments as per the Condominium Declaration.
	Terms, provisions, covenants, conditions, and options in, rights and easements established by the Declaration of Condominium Ownership recorded {PR,"Enter date of Condominium Declaration recording.",DT2,1}, as Document No. {PR,"Enter Document number."...
	Furnish ATG with a certificate, executed and acknowledged by the Secretary of the Board of Managers/Directors, stating that compliance has been made by the owners with the provisions of the Condominium Declaration or that said provisions relating to p...

	Limitations and Conditions Imposed by the Wisconsin Condominium Ownership Act.
	Any deed conveying a unit in a conversion condominium must contain one of the following statements:
	"The tenant of Unit * has waived or has failed to exercise the right of first refusal."
	or
	"The tenant of Unit * has no right of first refusal."
	Any lien, or right to a lien, for services, labor, or material heretofore or hereafter furnished, imposed by law, and not shown by the public records, including, without limiting the generality of the foregoing, liens or rights to a lien arising from ...
	This commitment is subject to the approval of the condominium declaration and plat by the Underwriting Department of ATG.
	This commitment is subject to:
	(a) Encroachments or other matters, if any, disclosed by an examination of the condominium plat, when placed of record.
	(b) Defects or other exceptions, if any, disclosed by an examination of the condominium declaration, when placed of record.
	(c) Such additional exceptions, if any, as may be disclosed upon a search of the public records covering the period after the effective date of this commitment and through the date of recording of the condominium declaration and plat.

	Additional Parcels
	The developer has reserved the right to add additional property to that which has been submitted to the Condominium Property Act by the Declaration recorded as Document {PR,"Additional Property: Enter condo declaration document number",ST1,1}, and, in...

	Condominium Conversion
	Furnish ATG with a certificate, executed and acknowledged by the Secretary of the Board of Managers, stating that there are no unpaid assessment liens arising by reason of the nonpayment of assessments as per the Condominium Declaration.
	Terms, provisions, covenants, conditions, and options in, rights and easements established by the Declaration of Condominium Ownership recorded {PR,"Enter date of Condominium Declaration recording.",DT2,1}, as Document {PR,"Enter Document number.",ST1...
	Furnish ATG with a certificate, executed and acknowledged by the Secretary of the Board of Managers, stating that compliance has been made by the owners with the provisions of the Condominium Declaration or that said provisions relating to preemptive ...
	Limitations and conditions imposed by the Illinois Condominium Property Act.
	Any deed conveying a unit in a conversion condominium must contain one of the following statements:
	"The tenant of Unit * has waived or has failed to exercise the right of first refusal.
	or
	"The tenant of Unit * has no right of first refusal."
	Any lien, or right to a lien, for services, labor, or material heretofore or hereafter furnished, imposed by law, and not shown by the public records, including, without limiting the generality of the foregoing, liens or rights to a lien arising from ...
	This commitment is subject to the approval of the condominium declaration and plat by the Underwriting Department of ATG.
	This commitment is subject to:
	(a) Encroachments or other matters, if any, disclosed by an examination of the condominium plat, when placed of record.
	(b) Defects or other exceptions, if any, disclosed by an examination of the condominium declaration, when placed of record.
	(c) Such additional exceptions, if any, as may be disclosed upon a search of the public records covering the period after the effective date of this commitment and through the date of recording of the condominium declaration and plat.


	Condominium
	Assessments
	Furnish ATG with a certificate, executed and acknowledged by the Secretary of the Board of Managers, stating that there are no unpaid assessment liens arising by reason of the nonpayment of assessments as per the Condominium Declaration.

	Condominium: Commitment
	Terms, provisions, covenants, conditions, and options contained in, and rights and easements established by the Declaration of Condominium Ownership recorded {PR,"Enter date of Condominium Declaration recording.",DT2,1}, as Document No. {PR,"Enter Doc...
	Limitations and conditions imposed by the Illinois Condominium Property Act.
	Furnish ATG with a certificate, executed and acknowledged by the Secretary of the Board of Managers, stating that compliance has been made by the owners with the provisions of the Condominium Declaration or that said provisions relating to preemptive ...
	Furnish ATG with a certificate, executed and acknowledged by the Secretary of the Board of Managers, stating that there are no unpaid assessment liens arising by reason of the nonpayment of assessments as per the Condominium Declaration.

	Condominium: Policy
	Terms, provisions, covenants, conditions, and options in, rights and easements established by the Declaration of Condominium Ownership recorded {PR,"Enter date of Condominium Declaration recording.",DT2,1}, as Document {PR,"Enter Document number.",ST1...
	Limitations and conditions imposed by the Illinois Condominium Property Act.

	Declaration
	Terms, provisions, covenants, conditions, and options in, rights and easements established by the Declaration of Condominium Ownership recorded {PR,"Enter date of Condominium Declaration recording.",DT2,1}, as Document {PR,"Enter Document number.",ST1...

	Legal Description: Parking
	Parcel 2:
	The exclusive right to the parking space number {PR,"Condo Legal: Enter parking space number:",ST1,1}, a limited common element (“LCE”), as delineated on the Plat of Survey, and the rights and easements for the benefit of Unit {PR,"Condo Legal: Enter ...

	Legal Description: Unit
	Parcel 1:
	Unit {PR,"Condo Legal: Enter condominium unit number:",ST1,1} in the {PR,"Condo Legal: Enter the condominumname:",ST1,2} Condominium as depicted on the Plat of Survey of the following described real estate:
	{PR,"Condo Legal: Enter base legal description:",ST2,3}
	which Plat of Survey is attached as Exhibit “{PR,"Condo Legal: Enter the Exhibit letter or number of thePlat:",ST1,4}” to the Declaration of Condominium Ownership, recorded {PR,"Condo Legal: Enter date of recording of condo declaration:",DT2,5}, in th...

	New Condominium
	Furnish ATG with a certificate, executed and acknowledged by the Secretary of the Board of Managers, stating that there are no unpaid assessment liens arising by reason of the nonpayment of assessments as per the Condominium Declaration.
	Terms, provisions, covenants, conditions, and options in, rights and easements established by the Declaration of Condominium Ownership recorded {PR,"Enter date of Condominium Declaration recording.",DT2,1}, as Document {PR,"Enter Document number.",ST1...
	Furnish ATG with a certificate, executed and acknowledged by the Secretary of the Board of Managers, stating that compliance has been made by the owners with the provisions of the Condominium Declaration or that said provisions relating to preemptive ...
	Limitations and conditions imposed by the Illinois Condominium Property Act.

	New Condominium: First Deed Out
	Grantor also hereby grants to the Grantee, its successors, and assigns, such rights and easements appurtenant to the above described real estate, the rights and easements for the benefit of said property set forth in the Declaration of Condominium, an...
	This deed is also subject to all rights, easements, covenants, conditions, restrictions, and reservations contained in said Declaration the same as though the provisions of said Declaration were recited and stipulated at length herein.

	Preemptive Rights
	Furnish ATG with a certificate, executed and acknowledged by the Secretary of the Board of Managers, stating that compliance has been made by the owners with the provisions of the Condominium Declaration or that said provisions relating to preemptive ...

	Statute
	Limitations and conditions imposed by the Illinois Condominium Property Act.

	Assessments (Wisconsin)
	Furnish ATG with a certificate, executed and acknowledged by the Secretary of the Board of Managers/Directors, stating that there are no unpaid assessment liens arising by reason of the nonpayment of assessments as per the Condominium Declaration.

	Condominium: Commitment (Wisconsin)
	Terms, provisions, covenants, conditions, and options in, rights and easements established by the Declaration of Condominium Ownership recorded {PR,"Enter date of Condominium Declaration recording.",DT2,1}, as Document No. {PR,"Enter Document number."...
	Limitations and conditions imposed by the Wisconsin Condominium Ownership Act.
	Furnish ATG with a certificate, executed and acknowledged by the Secretary of the Board of Managers/Directors, stating that compliance has been made by the owners with the provisions of the Condominium Declaration or that said provisions relating to p...
	Furnish ATG with a certificate, executed and acknowledged by the Secretary of the Board of Managers/Directors stating that there are no unpaid assessment liens arising by reason of the nonpayment of assessments as per the Condominium Declaration.

	Condominium: Policy (Wisconsin)
	Terms, provisions, covenants, conditions, and options in, rights and easements established by the Declaration of Condominium Ownership recorded {PR,"Enter date of Condominium Declaration recording.",DT2,1}, as Document No. {PR,"Enter Document number."...
	Limitations and conditions imposed by the Wisconsin Condominium Ownership Act.

	Legal Description: Unit (Wisconsin)
	Parcel 1:
	Unit {PR,"Condo Legal: Enter condominium unit number:",ST1,1} in the {PR,"Condo Legal: Enter the condominium name:",ST1,2} Condominium as depicted on the Plat of Survey of the following described real estate:
	{PR,"Condo Legal: Enter base legal description:",ST2,3}
	which Plat of Survey is attached as Exhibit “{PR,"Condo Legal: Enter the Exhibit letter or number of thePlat:",ST1,4}” to the Declaration of Condominium Ownership, recorded {PR,"Condo Legal: Enter date of recording of condo declaration:",DT2,5}, in th...

	New Condominium (Wisconsin)
	Furnish ATG with a certificate, executed and acknowledged by the Secretary of the Board of Managers/Directors, stating that there are no unpaid assessment liens arising by reason of the nonpayment of assessments as per the Condominium Declaration.
	Terms, provisions, covenants, conditions, and options in, rights and easements established by the Declaration of Condominium Ownership recorded {PR,"Enter date of Condominium Declaration recording.",DT2,1}, as Document No. {PR,"Enter Document number."...
	Furnish ATG with a certificate, executed and acknowledged by the Secretary of the Board of Managers/Directors, stating that compliance has been made by the owners with the provisions of Article {PR,"Article Number",IN1,3} of the Condominium Declaratio...
	Limitations and conditions imposed by the Wisconsin Condominium Ownership Act.

	Preemptive Rights (Wisconsin)
	Furnish ATG with a certificate, executed and acknowledged by the Secretary of the Board of Managers/Directors, stating that compliance has been made by the owners with the provisions of the Condominium Declaration or that said provisions relating to p...

	Statute (Wisconsin)
	Limitations and conditions imposed by the Wisconsin Condominium Ownership Act.


	Construction
	Construction Loan Policy Held Open
	ATG has been requested to delay issuance of the final policy or policies committed for hereunder after the proposed Insured acquires of record the estate or interest or mortgage in the land due to construction of improvements on the land. ATG hereby a...
	1. If ATG has agreed to delete Special Exception 1 from this Commitment, the final policy or policies will be subject to defects, liens, encumbrances, adverse claims, or other matters, if any, created, first appearing in the public records, or attachi...
	2. If the delay in issuing the final policy or policies extends beyond six months from the Effective Date of this commitment, all liability and obligations of ATG hereunder shall cease and terminate.
	3. Upon completion of construction, ATG must be provided final Owner’s and General Contractor’s Sworn Statements (ATG Form 3018, or Forms 3018-A and 3018-B) and Final Waiver of Lien (ATG Form 3005), in a form acceptable to ATG, from all entities suppl...
	4. If Standard Exceptions 1, 2, or 3 are to be removed from the final policy or policies, ATG must be provided with a current ALTA Statement (ATG Form 3004) and a survey acceptable to ATG of the land and all improvements thereon.
	5. If any endorsements or other additional coverage were committed for the final policy or policies, all inspections, undertakings, affidavits, or other documentation, and all other requirements to issue the endorsements or additional coverage must be...
	6. The payment to ATG of recording, search, examination, underwriting, endorsement, or other fees as may be required to issue the final policy or policies.

	Commitment
	ATG must be provided with properly executed sworn contractors’ statements, sub-contractors’ statements, and final lien waivers along with proof of proper disbursements of any loan proceeds used for the improvement of the land, or the policy or policie...
	"(a) Any lien, or right to a lien, for services, labor, or materials, heretofore or hereafter furnished, imposed by law, and not shown by the public records.
	"(b) Consequences of the failure of the lender to pay out properly the whole or any part of the loan secured by the mortgage described in Schedule A as affecting: (i) the validity of the lien of the mortgage; and (ii) the priority of the lien of the m...


	Cooperatives
	Coop: Bylaws
	Terms, provisions, covenants, rights, and options contained in the bylaws of the Cooperative and any other instrument that governs the management, use, or occupancy of the land, including, but not limited to, rights of refusal, consent provisions, and...

	Coop: Commitment
	ATG should be furnished with the following items, and this commitment is subject to such further exceptions as then may be deemed necessary:
	(a) A copy of the cooperative corporate bylaws and any other instruments that govern the management, use, or occupancy of the land;
	(b) An executed copy of the original lease creating title to the leasehold estate described in Schedule A, together with all assignments thereof, if any;
	(c) A written statement from the Board of Directors of the cooperative corporation that authorizes and consents to the lease, assignment, or mortgage to be insured, and to any transfer or mortgage to be insured, and to any transfer or pledge of stock ...
	(d) A written statement from the Board of Directors of the cooperative corporation that there are no unpaid assessments, special assessments, or other charges with respect to the leasehold to be insured, and that there has been no default under the te...


	Corporations: Domestic
	Active
	The certificate of authority of {PR,"Enter name of Illinois Corporation.",ST1,1} to do business in Illinois issued by the Secretary of State should be produced, and in default thereof, the policy or policies to be issued will contain the following exc...
	Upon a conveyance or mortgage of the land provide a certified copy of proper resolutions, passed by the stockholders and directors of the party in title, authorizing the execution of the deed of conveyance or mortgage.
	Franchise tax in favor of the State of Illinois against {PR,"Enter name (foreign or Illinois) ofcorporation.",ST1,1}, a corporation existing under the laws of the State of {PR,"Enter name of state where corporation was chartered.",ST1,2}.

	Dissolved
	{PR,"Enter name of dissolved Illinois corporation.",ST1,3}, an Illinois corporation, was dissolved on {PR,"Enter date of dissolution of Illinois corporation.",DT2,4}. We note the following with respect thereto and this Commitment is subject to the fol...
	(1) Rights of the creditors of said corporation including the United States of America;
	(2) Right, title, and interest of the stockholders/members of said corporation and those claiming under them.
	(3) Franchise tax in favor of the State of Illinois.

	Active (Wisconsin)
	The certificate of authority of {PR,"Enter name of Wisconsin Corporation.",ST1,1} to do business in Wisconsin issued by the Department of Financial Institutions should be produced, and in default thereof, the policy or policies to be issued will conta...
	Upon a conveyance or mortgage of the land, provide a certified copy of proper resolutions, passed by the stockholders and directors of the party in title, in conformance with the laws of the State of Wisconsin, authorizing the execution of the deed of...
	Franchise tax in favor of the State of Wisconsin against {PR,"Enter name (foreign or Wisconsin) of corporation.",ST1,1}, a corporation existing under the laws of the State of {PR,"Enter name of state where corporation was chartered.",ST1,2}.

	Dissolved (Wisconsin)
	{PR,"Enter name of dissolved Wisconsin corporation.",ST1,3}, a Wisconsin corporation, was dissolved on {PR,"Enter date of dissolution of Wisconsin corporation.",DT2,4}. We note the following with respect thereto and this Commitment is subject to the f...
	(1) Rights of the creditors of said corporation including the United States of America;
	(2) Right, title, and interest of the stockholders/members of said corporation and those claiming under them.
	(3) Franchise tax in favor of the State of Wisconsin, against {PR,"Name of Corporation",ST1,3}, a Wisconsin corporation.


	Corporations: Foreign
	Foreign: Certificate of Authority (Wisconsin)
	The certificate of authority of {PR,"Enter name of foreign Corporation.",ST1,1} to do business in Wisconsin issued by the Department of Financial Institutions should be produced, and in default thereof, the policy or policies to be issued will contain...

	Foreign: Dissolved (Wisconsin)
	{PR,"Enter name of dissolved foreign corporation.",ST1,1}, a corporation of {PR,"Enter state where dissolved foreign corporation was formed.",ST1,2}, was dissolved by {PR,"Who (i.e., members/stockholders/State) dissolved the foreign corporation?",ST1,...
	(1) Rights of the creditors of said corporation, including the United States of America.
	(2) Statutory conditions and limitations, if any, imposed by the laws of the State of {RP,2} upon conveyances by the successors in title to the real estate of said corporation.
	(3) Franchise tax in favor of the State of Wisconsin against {RP,1}, a corporation of {RP,2}.
	We should be furnished a duly certified list of all of the successors in title to the real estate of said corporation and this Commitment is subject to such further exceptions, if any, as may then be deemed necessary.

	Foreign: Not for Profit (Wisconsin)
	A certified copy of the charter and amendments thereto, if any, and of the bylaws of the corporation in title should be furnished, and this Commitment is subject to such further exceptions, if any, as may then be deemed necessary. Upon a conveyance or...
	The certificate of authority of {PR,"Enter name of foreign Corporation.",ST1,2} to do business in Wisconsin issued by the Department of Financial Institutions should be produced, and in default thereof, our policy will contain the following exception:
	"Consequences, if any that may result because of the failure of the party in title to the estate or interest in the land described in Schedule A to comply with the applicable ‘doing business’ laws of the State of Wisconsin."

	Foreign: Certificate of Authority
	The certificate of authority of {PR,"Enter name of foreign Corporation.",ST1,1} to do business in Illinois, issued by the Secretary of State, should be produced, and in default thereof, the policy or policies to be issued will contain the following ex...
	"Consequences, if any, that may result because of the failure of the party in title to the estate or interest in the land described in Schedule A to comply with the applicable ‘doing business’ laws of the State of Illinois."

	Foreign: Charter
	A certified copy of the charter and amendments, if any, and of the bylaws of {PR,"Enter name of foreign Corporation",ST1,1}, should be furnished, and this Commitment is subject to such further exceptions, if any, as may then be deemed necessary.

	Foreign: Dissolved
	{PR,"Enter name of dissolved foreign corporation.",ST1,1}, a corporation of {PR,"Enter state where dissolved foreign corporation was formed.",ST1,2}, was dissolved by {PR,"Who (i.e., members/stockholders/State) dissolved the foreign corporation?",ST1,...
	(1) Rights of the creditors of said corporation, including the United States of America.
	(2) Statutory conditions and limitations, if any, imposed by the laws of the State of {RP,2} upon conveyances by the successors in title to the real estate of said corporation.
	(3) Franchise tax in favor of the State of Illinois against {RP,1}, a corporation of {RP,2}.
	We should be furnished a duly certified list of all of the successors in title to the real estate of said corporation and this Commitment is subject to such further exceptions, if any, as may then be deemed necessary.

	Foreign: Not for Profit
	A certified copy of the charter and amendments thereto, if any, and of the bylaws of the corporation in title should be furnished, and this Commitment is subject to such further exceptions, if any, as may then be deemed necessary.  Upon a conveyance o...
	The certificate of authority of {PR,"Enter name of foreign Corporation.",ST1,2} to do business in Illinois, issued by the Secretary of State, should be produced, and in default thereof, our policy will contain the following exception:
	"Consequences, if any, that may result because of the failure of the party in title to the estate or interest in the land described in Schedule A to comply with the applicable ‘doing business’ laws of the State of Illinois."


	Corporations: Miscellaneous
	Hospital: Hill-Burton Act
	Rights of the United States of America and the State of Illinois, or either of them, to recover any public funds advanced under the provisions of one or more of various federal statutes relating to health care or the Illinois Hospital Construction Act.

	Municipal: Conveyance
	Upon a conveyance or mortgage of the land, we should be supplied with satisfactory proof of compliance with the provisions of the Illinois Compiled Statutes regarding sale or lease of land by a municipal corporation, as well as a copy of the ordinance...

	Not-for-Profit: Resolution
	Upon a conveyance or mortgage of the land, a certified copy of proper resolutions passed by the members and directors of the party in title authorizing the execution of the deed of conveyance or mortgage, together with a properly certified copy of the...

	Religious: Resolution
	Upon any conveyance or mortgage of said land, a certified copy of the bylaws and a resolution passed by the members of the party in title authorizing the execution of the instrument of conveyance or mortgage should be furnished, together with a certif...

	University: Higher Education Act
	Rights of the United States of America to recover any public funds advanced under the provision of the Higher Education Facilities Act of 1963.


	Decedents
	Deceased Joint Tenant
	We should be supplied with satisfactory evidence establishing the death, the testacy or intestacy, the status of tenancy at time of death, and the value of the estate of {PR,"Insert name of deceased joint tenant here.",ST1,1}, deceased; and this commi...

	General
	A satisfactory table of the heirship and proof of the death, testacy or intestacy, and of the value of the estate of {PR,"Enter name of deceased person.",ST1,1}, deceased, should be furnished, and this Commitment is subject to such further exceptions,...
	Claims against the estate of {PR,"Enter name(s) of Decedent(s).",ST1,1}, deceased.
	Federal and Illinois Estate Taxes that may be charged against the estate of {PR,"Enter name of deceased person.",ST1,1}.
	Statutory rights, powers, and duties of the personal representative of the decedent if and when appointed.

	Miscellaneous
	Proceedings pending in the Circuit Court of {PR,"Enter name of County.",ST1,1} County entitled Estate of {PR,"Enter name of deceased person.",ST1,2}, deceased, under Case No. {PR,"Enter casenumber.",ST1,3}.
	Right of any person to demand formal proof of the will or to contest the will of {PR,"Enter name of deceased person.",ST1,1}, deceased, within the time provided by the Probate Act.
	Statutory rights of {PR,"Enter name of surviving spouse.",ST1,1}, surviving spouse of the decedent, to renounce the will of deceased and take statutory share.
	Power of sale conferred upon {PR,"Enter name of Executor.",ST1,1}, Executor, by terms of the will of {PR,"Enter name of deceased person.",ST1,2}, deceased.
	Right, title and interest of {PR,"Enter names of person(s) taking under the will.",ST1,1}, devisee(s) under the unproven will of {PR,"Enter the name of the deceased person.",ST1,2}, deceased.

	Personal Representative Commitment
	This Commitment is made on the assumption that title to the land is to be derived through a conveyance by {PR,"Enter name of estate personal representative.",ST1,1}, the personal representative, pursuant to the power of sale conferred under the last w...
	If title is to be derived through a deed by one other than the personal representative of the estate of {PR,"Enter name of deceased person.",ST1,1}, deceased, during the pendency of said proceeding, a proper order should be entered divesting said pers...

	Sale: Court-Ordered Sale
	Order entered on {PR,"Enter date of court order.",DT2,1}, in the proceeding entitled Estate of {PR,"Enter name of deceased person.",ST1,2}, Deceased, Case No. {PR,"Enter case number.",ST1,3}, providing that the land be sold as provided in said order.

	Sale: Independent Representative
	If the conveyance is to be made pursuant to the provisions of the Probate Act regarding sale by the independent representative, the conveyance should so recite.

	Sale: Power of Sale in Will
	Any conveyance of the land by the personal representative should recite that it is executed pursuant to the power and authority vested in the personal representative by the last will of {PR,"Enter name of deceased person.",ST1,1}, deceased. In additio...

	Sale: Purchaser’s Interest
	Right, title, and interest of {PR,"Enter name of purchaser.",ST1,1}, purchaser of the land as disclosed by court order entered in the proceedings entitled Estate of {PR,"Enter name of deceased person.",ST1,2}, Deceased, Case No. {PR,"Enter case number...

	General (Wisconsin)
	A satisfactory table of the heirship and proof of the death, testacy or intestacy, and of the value of the estate of {PR,"Enter name of deceased person.",ST1,1}, deceased, should be furnished, and this commitment is subject to such further exceptions,...
	Claims against the estate of {PR,"Enter name(s) of Decedent(s).",ST1,1}, deceased.
	Federal and Wisconsin Estate Taxes, that may be charged against the estate of {PR,"Enter name of deceased person.",ST1,1}.
	Statutory rights, powers, and duties of the personal representative of the decedent if and when appointed.

	MSU Decedents Exceptions
	A satisfactory table of heirship and proof of the death, testacy and intestacy, and of the value of the estate of {PR,"name of decedent",ST1,1}, deceased, should be furnished; and this commitment is subject to such further exceptions, if any, as may t...
	Claims against the estate of {PR,"name of decedent",ST1,2}, deceased.
	Federal and Illinois Estate Taxes, which may be charged against said estate.
	Statutory rights, powers, and duties of the personal representative of said decedent, if and when appointed.

	No Probate
	Decedent*, owner of the property, died testate *, leaving a will filed with the * Circuit Clerk on *. In connection therewith, the following is noted:
	(A) A satisfactory table of the heirship and of the value of the estate of *, deceased, should be furnished, and this commitment is subject to such further exceptions, if any, as may then be deemed necessary;
	(B) Expenses of administration and claims against the estate of *, deceased;
	(C) Federal and Illinois Estate Taxes, which may be charged against said estate;
	(D) Statutory rights, powers, and duties of the personal representative of said decedent, if and when appointed;
	(E) Legacies created by the Will;
	(F) If the property is to be conveyed by devisees under the will under the Illinois.
	Small Estate Act, it will be necessary that such grantors execute a Personal Undertaking satisfactory to ATG, a copy of which is furnished herewith.


	Deeds
	Illinois Notary Requirements
	Any document purporting to convey title to residential real property in Cook County, Illinois, must comply with the requirements of the Illinois Notary Public Act (5 ILCS 312/1-101, et seq.), and, specifically, the requirements of Section 3-102 of the...

	Chain of Title
	Last Deed of Record: Warranty Deed dated *, and recorded *, as Document *, from *, grantor, to *, grantee.


	Disabled Person
	General (Wisconsin)
	Proceedings pending in the Circuit Court of {PR,"Enter name of County.",ST1,1} County entitled Estate of {PR,"Enter name of disabled person.",ST1,2}, a disabled person, under Case No. {PR,"Enter disabled person’s case number.",ST1,3}.
	Any conveyance of the land must be made by the guardian of the Estate of {PR,"Enter name of disabled person.",ST1,1}, a disabled person, pursuant to a proper order entered in Case No. {PR,"Enter minor’s case number.",ST1,2} and such conveyance should ...
	Statutory right, powers, and duties of the guardian of the Estate of {PR,"Enter name of disabledperson.",ST1,1}, a disabled person.

	General
	Proceedings pending in the Circuit Court of {PR,"Enter name of County.",ST1,1} County entitled Estate of {PR,"Enter name of disabled person.",ST1,2}, a disabled person, under Case No. {PR,"Enter disabled person’s case number.",ST1,3}.
	Any conveyance of the land must be made by the guardian of the Estate of {PR,"Enter name of disabled person.",ST1,1}, a disabled person, pursuant to a proper order entered in Case No. {PR,"Enter minor’s case number.",ST1,2} and such conveyance should ...
	Statutory right, powers, and duties of the guardian of the Estate of {PR,"Enter name of disabled person.",ST1,1}, a disabled person.


	Divorce
	Child Support: Lien
	Child support judgment filed against {PR,"Insert name of person(s) who received judgment here.",ST1,1}, in Case No. {PR,"Insert Case number here.",ST1,2} in the Circuit Court of {PR,"Insert name of County here.",ST1,3} County, Illinois, a memorandum o...

	Dissolution: Proceedings
	Dissolution of marriage proceedings filed by {PR,"Insert name of Plaintiff here.",ST1,1} against {PR,"Insert name of Defendant here.",ST1,2} in the Circuit Court of {PR,"Insert name of County here.",ST1,3} County as case {PR,"Insert Case number here."...
	NOTE: No examination of these proceedings has been made, and upon examination, this commitment, and any policies committed for thereunder, shall be subject to such other and further exceptions as may then be deemed necessary.

	Wisconsin Child Support: Lien
	Child support judgment filed against {PR,"Insert name of person(s) who received judgment here.",ST1,1}, in Case No. {PR,"Insert Case number here.",ST1,2} in the Circuit Court of {PR,"Insert name of County here.",ST1,3} County, Wisconsin, a memorandum ...


	Downstate Train
	DTD Ltd.
	Encroachment: Adverse
	Adverse encroachment of {PR,"what encroaches",ST1,1} from {adjoining property, public property} from the {north, south} onto the subject property by approximately {PR,"how much encroaches",ST1,2} feet as disclosed by survey dated * and prepared by *.


	Easements
	Dedicated Road (Wisconsin)
	Rights of the public, the State of Wisconsin, and the municipality in and to so much of the land dedicated for road purposes by instrument dated {PR,"Insert date of document.",DT2,1} and recorded {PR,"Insert date of recording.",DT2,2} as Document No. ...

	Drainage Easements
	Rights of way for drainage ditches, feeders, laterals, and underground pipe or tile, if any.

	Building Setback
	A {PR,"# of feet",ST1,1} foot building line from the {PR,"Front, back, or side",ST1,2} line of the property as shown on the recorded plat of said subdivision.

	Dedicated Road
	Rights of the public, the State of Illinois, and the municipality in and to so much of the land dedicated for road purposes by instrument dated {PR,"Insert date of document.",DT2,1}, and recorded {PR,"Insert date ofrecording.",DT2,2}, as Document No. ...

	Insured Parcel 2
	Terms, provisions, and conditions relating to the easement described as Parcel 2 contained in the instrument creating such easement.
	Rights of the adjoining owner or owners to the concurrent use of the easement described as Parcel 2.

	Prescriptive: Party Driveway
	A {PR,"Enter # of Feet",IN3,1}-foot party driveway located on the property described in Schedule A and the land {PR,"Direction",ST1,2} and adjoining and all rights ensuing thereunder in favor of said adjoining land.

	Prescriptive: Party Wall
	Rights of adjoining property owners in and to the {PR,"Direction",ST1,1} wall of the {PR,"Improvement",ST1,2} located on the property described in Schedule A hereof.

	Prescriptive: General
	Easement in favor of the public and quasi-public utilities and the municipality over the {PR,"Enter location here, i.e., North, South, East or West",ST1,1} and {PR,"Enter distance in feet here",IN3,2} feet of the property as evidenced by poles, condui...

	Standard Language
	Easement for {PR,"Enter the purpose of the easement.",ST1,1} as set forth in {PR,"Describe the document creating the easement.",ST1,2} dated {PR,"Enter the date of the easement.",DT2,3} and recorded {PR,"Enter the date the easement was recorded.",DT2,...

	Termination: Senior Lienholder
	The easement created by instrument dated {PR,"Enter date of document.",DT2,1} and recorded {PR,"Enter date document was recorded.",DT2,2} as Document No. {PR,"Enter Document number.",ST1,3} was not executed by {PR,"Enter name of missing lender.",ST1,6...


	Encroachments
	Adjoining Land: Lot Line
	A survey discloses an encroachment by {PR,"Describe the building or structure that is encroaching.",ST1,1} located on the property to the {PR,"Enter direction (North, South, etc.) of encroachment.",ST1,2} and adjoining onto the insured premises by app...

	Insured Land: Building Line
	A survey discloses an encroachment of the {PR,"Describe the encroaching structure.",ST1,1} over the {PR,"Enter direction (North, South, etc.).",ST1,2} building line by {PR,"Enter number of feet of encroachment.",IN1,3} feet.

	Insured Land: Easement
	A survey discloses that the {PR,"Describe the structure that is encroaching.",ST1,1} located upon the insured premises encroaches onto the utility easement located on the {PR,"Enter direction (North, South, etc.).",ST1,2} of the land by {PR,"Enter num...

	Insured Land: Lot Line
	A survey discloses that the {PR,"Describe the structure encroaching.",ST1,1} located upon the insured premises encroaches upon the property {PR,"Enter direction (North, South, etc.) of encroachment.",ST1,2} and adjoining by {PR,"Enter number of feet o...


	Environmental
	General: Environmental Lien
	Environmental lien filed by {PR,"Enter name of entity filing the environmental lien.",ST1,1} against {PR,"Enter name of entity that environmental lien was filed against.",ST1,2} on {PR,"Enter date that environmental lien was filed.",DT2,3} as Document...

	Wisconsin RPTA: Fact Exception
	The fact, as disclosed by the liens recorded {PR,"Enter date of recording of environmental lien.",DT2,1}, as Document No. {PR,"Enter Document number of recorded environmental lien.",ST1,2}, in the Office of the Register of Deeds of {PR,"Enter name of ...

	Wisconsin General: Environmental Lien
	Environmental lien filed by {PR,"Enter name of entity filing the environmental lien.",ST1,1} against {PR,"Enter name of entity that environmental lien was filed against.",ST1,2} on {PR,"Enter date that environmental lien was filed.",DT2,3} as Document...

	Wisconsin RPTA: RPTA Document
	Environmental disclosure document for transfer of real property dated {PR,"Enter date environmental document was created.",DT2,1}, and recorded {PR,"Enter date environmental document wasrecorded.",DT2,2}, as Document No. {PR,"Enter environmental Docum...


	Estate
	MEO
	Mortgage Electronic Registration Systems (MERS)
	Mortgage Electronic Registration Systems, Inc., acting solely as nominee for taxes.
	The lien of taxes for the year 2008 and thereafter. P.I.N.:
	- First Installment 2008 taxes, in the amount of $*, have been paid.
	- Second Installment 2008 taxes are not yet due or payable.
	2009 General real estate taxes are not yet due or payable.

	Plat
	Easements for public utilities and drainage and building setback lines as shown on the Plat of Subdivision. Covenants, Conditions, and Restrictions as shown on the Plat of Subdivision.

	PUD
	This property is located in a planned unit development that has a homeowner’s association. Quarterly, monthly, or yearly association dues are assessed. A letter from the association or management company stating that all dues are paid and that all req...

	Plat
	Easements for public utilities and drainage and building setback lines as shown on the Plat of Subdivision.
	Covenants, Conditions, and Restrictions as shown on the Plat of Subdivision.
	CHAIN OF TITLE *** We have searched the records of the Recorder of Deeds for a period in excess of 24 months from the date of this commitment and have confirmed that the current owners, Mark A. Borders and Kimberly B. Borders, acquired title to the su...
	Chain
	**CHAIN OF TITLE** We have searched the records of the Recorder of Deeds for a period in excess of 12 months from the date of this commitment and have confirmed that the current owner *, obtained title to the subject property by Deed dated *, and reco...


	Exceptions
	Name Affidavit
	Attorneys’ Title will require a Personal Name Affidavit executed by {PR,"Type Individual’s Full Name",ST1,1}, and this Commitment remains subject to further such exceptions.

	Supervisor’s Resolution
	Building Lines as set by Board of Supervisors Resolution adopted June 6, 1966, and recorded in Book 2017 on page 13.

	Monroe
	Rights of the public, the municipality, and State of Illinois in and to that portion of the land taken or used for roadway purposes, if any. Rights of the public or quasi-public utility companies in and to any portion of the land used for utility purp...
	Subject to building lines, easements, and restrictions, if any, of record. No search has been made of the coal, oil, gas or other mineral title, and our policy, if and when issued, will except the coal, oil, gas and other mineral title, and all rights...
	NOTE FOR INFORMATION: The recording of any deed hereunder is contingent upon approval by Department of Mapping and Platting of Monroe County, Illinois as to compliance with the Plat Act.

	Metro East Office
	Rights of the public, the State of Illinois, township, county, and the municipality in and to that part of the land shown on Schedule A, taken, used, or dedicated for road or highway purposes. Rights of the public or quasi-public utility companies in ...
	Financing statements, if any, not certified to by abstracter. If any document referenced herein contains a covenant, condition, or restriction, which violates 42 USC (c), such covenant, condition, or restriction, to the extent of such violation, is he...
	Except coal, oil, gas, and other mineral title, and all rights and easements in favor of the estate of said coal, oil, gas, and other minerals excepted or reserved in prior conveyances. NOTE: No search has been made of the coal, oil, gas or other mine...
	NOTE FOR INFORMATION: Attention is directed to ordinance and regulations relating to connections, charges, and liens for use of any public sewerage, water, or other utility system serving the land referred to herein. We call your attention to the fact...
	NOTE FOR INFORMATION: The recording of any deed hereunder is contingent upon approval by Department of Mapping and Platting of {PR,"Type Name of County",ST1,1} County, Illinois, as to compliance with the Plat Act.

	St. Clair
	Rights of the public, the municipality, and State of Illinois in and to that portion of the land taken or used for roadway purposes, if any.
	Rights of the public or quasi-public utility companies in and to any portion of the land used for utility purposes.
	Rights of way for drainage ditches, feeders, tiles, and laterals, if any.
	Subject to building lines, easements, and restrictions, if any, of record.
	No search has been made of the coal, oil, gas, or other mineral title, and our policy, if and when issued, will except the coal, oil, gas, and other mineral title, and all rights and easements in favor of the estate of said coal, oil, gas, and other m...
	NOTE FOR INFORMATION: Attention is directed to ordinance and regulations relating to connections, charges, and liens for use of any public sewerage, water, or other utility system serving the land referred to herein. We call your attention to the fact...
	NOTE FOR INFORMATION: The recording of any deed hereunder is contingent upon approval by Department of Mapping and Platting of St. Clair County, Illinois, as to compliance with the Plat Act.


	Building Setback
	Building Setback
	A {PR,"Enter Number of feet",ST1,1} foot building line from the {PR,"Enter direction",ST1,2} line of the property as shown on the Plat.


	Foreclosure
	Mortgage: Foreclosure Deed Interest (Wisconsin)
	Right, title, and interest of {PR,"Enter name of person receiving deed.",ST1,1}, under a sheriff’s (judge’s) deed dated {PR,"Enter date of deed.",DT2,2}, and recorded {PR,"Enter date deed was recorded.",DT2,3}, as Document No. {PR,"Enter Document numb...

	Post Lis Pendens
	We have examined the proceeding in Case No.{PR,"Insert Case Number.",ST1,4} in the Circuit Court of Peoria County, Illinois, to foreclose the lien recorded as Document {PR,"Insert Document number.",ST1,4}, and note the following:
	A. Right of any interested party to have set aside, modified or reversed the Judgments or orders entered in said case;
	B. Right of any party served by publication, or of any person claiming under said party to appear and be heard in regard to the judgments and orders entered in said case within the time allowed by law;
	C. Right, if any, by reason of military service, or of any person interested in the subject matter of the proceeding to redeem from the sale held pursuant to the judgment entered in said case within the time permitted by the Soldiers’ and Sailors’ Civ...
	D. Right of the United States of America to redeem the land from any sale held pursuant to the judgment by reason of any federal lien, which may presently or hereafter appear of record within the time permitted by law;
	E. Consequences of any failure to comply with the laws of the State of Illinois, which specify the conditions under which the holder of the certificate of sale is entitled to obtain a Deed conveying title to the land described in schedule C hereof;
	F. Rights of the Purchaser of the land at a sale held pursuant to the judgment entered in said case, and of all persons claiming thereunder; relative thereto, we note the right of Bank One, N.A., Purchaser of the land at said sale. We find no certific...
	G. A proper Notice of foreclosure has been recorded as Document {PR,"Insert Document number.",ST1,4};
	H. Defects or additional information, if any;
	None

	Post Lis Pendens (Wisconsin)
	We have examined the proceeding in Case No.{PR,"Insert Case Number.",ST1,4} in the Circuit Court of {PR,"Name of County",ST1,4}, Wisconsin, to foreclose the lien recorded as Document {PR,"Insert Document number.",ST1,4}, and note the following:
	A. Right of any interested party to have set aside, modified, or reversed the judgments or orders entered in said case;
	B. Right of any party served by publication, or of any person claiming under said party to appear and be heard in regard to the judgments and orders entered in said case within the time allowed by law;
	C. Right, if any, by reason of military service, or of any person interested in the subject matter of the proceeding to redeem from the sale held pursuant to the judgment entered in said case within the time permitted by the Soldiers’ and Sailors’ Civ...
	D. Right of the United States of America to redeem the land from any sale held pursuant to the judgment by reason of any federal lien, which may presently or hereafter appear of record within the time permitted by law;
	E. Consequences of any failure to comply with the laws of the State of Wisconsin, which specify the conditions under which the purchaser is entitled to obtain a Deed conveying title to the land described in schedule C hereof;
	F. Rights of the Purchaser of the land at a sale held pursuant to the judgment entered in said case, and of all persons claiming thereunder; {PR,"Name of Purchaser and any conditions of judgment",ST1,5}.
	G. A proper Notice of Foreclosure has been recorded as Document {PR,"Insert Document number.",ST1,4};
	H. Defects or additional information, if any; {PR,"List any defects",ST1,6}


	Foreclosure
	Mortgage: Certificate of Sale Interest
	Right, title, and interest of {PR,"Enter name of purchaser.",ST1,1}, under a certificate of sale dated {PR,"Insert date of certificate of sale.",DT2,2}, and recorded {PR,"Insert date of recording.",DT2,3,} as Document No. {PR,"Insert Document number."...

	Mortgage: Foreclosure Deed Interest
	Right, title, and interest of {PR,"Enter name of person receiving deed.",ST1,1}, under a sheriff’s (judge’s) deed dated {PR,"Enter date of deed.",DT2,2}, and recorded {PR,"Enter date deed was recorded.",DT2,3}, as Document No. {PR,"Enter Document numb...

	Mortgage: Minutes of Foreclosure
	In order that we may insure title after completion of any proceeding brought to foreclose, the lien of the mortgage/trust deed noted at Schedule B No. {PR,"Enter Schedule B foreclosed mortgage ExceptionNo.",IN1,1} and recorded as Document No. {PR,"Ent...
	a. Our policy, when issued, will be subject to direct attack upon the judgments and orders entered in the proceeding.
	b. Our policy, when issued, will be subject to any right or asserted right of a creditor, trustee, or debtor in possession in bankruptcy to avoid a transfer of title by sheriff’s deed or otherwise pursuant to Title 11 U.S.C.(Bankruptcy) or any credito...
	c. Upon the filing of the complaint, a proper Notice of Foreclosure (Lis Pendens) under Section 151503 of the Code of Civil Procedure must be recorded in the Recorder’s Office of {PR,"Enter name of County where property is located.",ST1,3} County, Il...
	d. The following persons are necessary parties to any such proceeding:
	(1) Mortgagor (or successor in interest), the record owner, as a party defendant. If a mortgagor is deceased, the personal representative of the decedent, if one has been appointed, or a special representative appointed on behalf of the decedent pursu...
	(2) Mortgagee (or successor in interest), as party plaintiff. e. The following persons must be made parties defendant to the foreclosure if it is desired that the interests be barred by the proceeding:
	(1) All parties acquiring rights in the premises subsequent to the date of this commitment and prior to a recorded Notice of Foreclosure (Lis Pendens).
	(2) Any person other than those herein named known to the Plaintiff or the Plaintiff’s attorney to have or claim an interest in the premises.
	(3) All persons in possession of any part of the premises in question and all persons whose rights would be disclosed by an inspection of the premises.
	(4) Second mortgagees, judgment lienors, etc., by reason of Exception No. {PR,"Enter Schedule B Exception numbers of other lienors.",IN1,10}.
	(5) United States of America by reason of Exception No. {PR,"Enter Schedule B Exception number for tax lien, if appropriate.",IN1,4}.
	NOTE: Compliance should be had with the provisions of Section 2410 of the Federal Judicial Code, 28 U.S.C.A., and in connection therewith the following information is furnished:
	The Notice of tax lien noted at Exception No. {RP,4} was filed by the District Director of Internal Revenue, at {PR,"Enter name of city where IRS office is located.",ST1,5}, Illinois, against {PR,"Enter name of person against whom tax lien is made.",S...
	NOTE: Attention is directed to the provisions in Section 2410 of the Federal Judicial Code requiring that any action to foreclose a mortgage naming the United States as a party under the Section "must seek a judicial sale." In the event a sale is not ...
	NOTE: If it is known that any of the parties listed herein are deceased, their heirs, or devisees should be made parties by name, if known, and, if unknown, by the name and description of "UNKNOW NHEIRS OR DEVISEES OF" such deceased person or persons....
	NOTE: In the event that there are any persons who are necessary parties to the contemplated proceeding, but the names of such persons are unknown and unascertainable, then, and in that event only, such persons should be made parties under the descript...
	NOTE: The proceeding will not affect the standard exceptions nor the exceptions noted in Schedule B at Nos. *; and our policy, when issued, will be subject to such exceptions unless satisfactory disposition thereof is otherwise made.


	Forgery
	Forgery
	Right, title, and interest of {PR,"grantor of deed recorded",ST1,1}, purported grantor in the deed recorded {PR,"date of recording",ST1,2} as Document Number {PR,"document number",ST1,3}.
	 NOTE: This exception maybe waived only by an ATG Staff Attorney.


	Homestead
	Spouse’s interest
	Rights and interest of the spouse, if any, of title holder or person(s) taking title named in Schedule "A."
	NOTE: The present marital status of the Grantors herein named must be disclosed in any subsequent Deed of conveyance and/or Mortgage ATG is asked to insure, and their spouses, if any, must join in the execution of said Instruments in order to release ...


	Installment Contract
	Contract Terms
	Terms, conditions, and covenants of installment contract (or agreement for Warranty Deed) between {PR,"Enter name of Installment Contract Seller(s).",ST1,1} and {PR,"Enter name(s) of Installment Contract Purchaser.",ST1,2}, dated {PR,"Enter date of In...

	Contract Not Recorded
	Consequences, if any, by reason of the failure to record either the Agreement for Deed or a memorandum thereof.


	Judgments
	Possible Judgments
	We find judgments, liens, and matters of record involving a person or persons whose names are similar to {PR,"Enter name of possible judgment debtor",ST1,1}. Relative thereto, a Personal Information Affidavit (ATG Form 3008) establishing the identity ...

	Recorded Judgment
	[Transcript][Certified copy][Memorandum] of judgment recorded on {PR,"Insert date judgment was recorded here.",DT2,1} as Document No. {PR,"Insert Document number here.",ST1,2}, for judgment rendered on {PR,"Insert date of judgment here.",DT2,5}, in th...


	L.L.C.
	Series L.L.C.
	Terms, provisions, and limitations of the certificate of designation and Operating Agreement of {PR,"Name of series LLC",ST1,1}, a series of an Illinois limited liability company. The Articles of Organization and the Operating Agreement establishing t...

	General (Wisconsin)
	Terms, provisions, and limitations of the Articles of Organization and Operating Agreement for {PR,"Enter name of Limited Liability Company.",ST1,1}, a limited liability company.
	The Articles of Organization and the Operating Agreement establishing the limited liability company of {PR,"Enter name of Limited Liability Company.",ST1,1} together with all amendments thereto, properly identified in writing by all the members as bei...
	A Certificate of Good Standing issued by the Department of Financial Institutions should be produced, and in default thereof, the final policy or policies will contain the following exception:
	"Consequences, if any, that may result by reason of the failure of the party in title to the estate or interest in the land described in Schedule A to comply with the applicable ‘doing business’ laws of the State of Wisconsin."
	Upon a conveyance or mortgage of the land, a certified copy of the proper resolutions authorizing the execution of the deed or mortgage by {PR,"Enter the name of the Limited Liability Company.",ST1,1}, a Wisconsin limited liability company, should be ...

	General (Illinois)
	Terms, provisions and limitations of the Articles of Organization and Operating Agreement for {PR,"name ofLLC",ST1,1}, an Illinois limited liability company.
	The Articles of Organization and the Operating Agreement establishing the limited liability company of {PR,"name of LLC",ST1,2}, together with all amendments thereto, properly identified in writing by all the members as being the terms and provisions ...
	A Certificate of Good Standing issued by the Secretary of State should be produced, and in default thereof, the final policy or policies will contain the following exception:
	"Consequences, if any, that may result by reason of the failure of the party in title to the estate or interest in the land described in Schedule A to comply with the applicable ‘doing business’ laws of the State of Illinois."
	Upon a conveyance or mortgage of the land, a certified copy of the proper resolutions authorizing the execution of the deed or mortgage by {PR,"name of LLC",ST1,3}, an Illinois limited liability company, should be produced to ATG for examination, and ...

	Foreign L.L.C.
	The following exceptions will appear on all policies issued pursuant to this commitment except to the extent the same are cleared to ATG’s satisfaction.
	A certified copy of the Articles of Organization and the Operating Agreement, if any, of {PR,"Enter the Name of the Foreign L.L.C.",ST1,1} should be furnished for examination, and this commitment shall be subject to such further exceptions as may then...
	Terms, provisions, and limitations of the Articles of Organization and the Operating Agreement of {RP,1}, a limited liability company of the state of {PR, "Enter the State where Foreign L.L.C. was formed",ST1,2}.
	Upon a conveyance or mortgage of the land, ATG must be furnished with a certified copy of proper resolutions, passed by the members and managers of the party in title, in conformity with the laws of the State of {RP,2}, authorizing the execution of th...
	The certificate of authority of {RP,1}, to do business in Illinois issued by the Secretary of State must be furnished to ATG for examination, and in default thereof, the final policy or policies will contain the following exception:
	"Consequences, if any, that may result by reason of the failure of the party in title to the estate or interest in the land described in Schedule A to comply with the applicable ‘doing business’ laws of the State of Illinois."


	Leaseholds
	Unrecorded Easements, Covenants, etc.
	Subject to any unrecorded easements, covenants, conditions or restrictions, as well as any building line restrictions not of record.
	NOTE: This exception will be waived by either of the following:
	(a) copy of an existing survey with an affidavit of no new improvements, which shall be submitted to ATG; or
	(b) Affidavit in Lieu of Survey, which shall be submitted to ATG. If neither is submitted to ATG, this exception will not be waived and will remain on the final title policy.

	Recorded Lease
	Memorandum of Lease dated {PR,"Insert date of lease agreement here.",DT2,1} and recorded {PR,"Insert date the lease agreement was recorded here.",DT2,2}, as Document {PR,"Insert Document number here.",ST1,5} by and between {PR,"Insert name(s) of Lesso...

	Subordination of Lease
	Subordination Agreement dated {PR,"Insert date of subordination agreement here.",DT2,1} and recorded {PR,"Insert date the subordination agreement was recorded here.",DT2,2} as Document {PR,"Insert Document number here.",ST1,5}, made by {PR,"Insert nam...

	Unrecorded Leases
	Existing unrecorded leases and tenancies and all rights thereunder of the lessees and tenants and of any person claiming by, through, or under the lessees.


	Library
	MERS
	Mortgage Electronic Registration Systems, Inc., acting solely as nominee for


	Lien/Lis Pendens
	Minutes of Foreclosure - Mechanics’ Lien
	In order that we may insure title after completion of any proceeding brought to foreclose a mechanics’ lien in favor of *, we note the following and this commitment is subject to:
	a. Our policy when issued will be subject to direct attack upon the judgments and orders entered in the proceeding.
	b. Our policy, when issued, will be subject to any right or asserted right of a creditor, trustee, or debtor in possession in bankruptcy to avoid a transfer of title by sheriff’s deed or otherwise pursuant to Title 11 U.S.C.(Bankruptcy) or any credito...
	c. Upon the filing of the complaint, a proper Lis Pendens under Section 2-1901 of the Code of Civil Procedure must be recorded in the Recorder’s Office of * County, Illinois.
	d. The following persons are necessary parties to any such proceeding:
	(1) * (or successor in interest) as party plaintiff.
	(2) *, the record owner(s), as party/ies defendant.
	e. The following persons must be made parties defendant to the foreclosure if it is desired that their interests be barred by the proceeding:
	(1) All parties acquiring rights in the premises subsequent to the date of this commitment and prior to a recorded Lis Pendens.
	(2) Any person other than those herein named known to the Plaintiff or the Plaintiff’s attorney to have or claim an interest in the premises.
	(3) All persons in possession of any part of the premises in question and all persons whose rights would be disclosed by an inspection of the premises.
	(4) * by reason of exceptions *, inclusive.
	(5) All persons in the chain of contracts between the plaintiff and the owner(s), and all persons who have or may assert liens under the Illinois Mechanics’ Lien Act (770 ILCS 60/0.01, et seq.) against the land.
	NOTE: If it is known that any of the parties listed herein are deceased, their heirs or devisees should be made parties by name, if known, and, if unknown, by the name and description of "UNKNOWNHEIRS OR DEVISEES OF" such deceased person or persons. I...
	NOTE: In the event that there are any persons whose claims or interests are not disclosed by a document recorded at the time a proper lis pendens under Section 2-1901 of the Code of Civil Procedure has been recorded, such persons should be named and m...
	NOTE: In the event that there are any persons who are necessary parties to the contemplated proceeding, but the names of such persons are unknown and unascertainable, then, and in that event only, such persons should be made parties under the descript...
	NOTE: The proceeding will not affect the standard exceptions nor the exceptions noted in Schedule B at *, inclusive; and our policy, when issued, will be subject to such exceptions unless satisfactory disposition thereof is otherwise made.

	General Lien Exception
	Notice of {PR,"Liens: Enter the type of lien (e.g., ‘Illinois Income Tax’):",ST1,1} lien in favor of {PR,"Liens: Enter the entity who filed the lien:",ST1,3} and against {PR,"Liens: Enter the entity against whom the lien was filed:",ST1,2} in the sum ...

	Mechanic’s Liens
	Mechanics’ lien filed by {PR,"Insert name of person or company filing the lien here.",ST1,1} against {PR,"Insert the person(s) against whom the lien was filed here.",ST1,2} on {PR,"Insert the date the lien was filed here.",DT2,3}, as Document No. {PR,...

	Proceedings Examination
	NOTE: No examination of these proceedings has been made, and upon examination, this commitment, and any policies committed for thereunder, shall be subject to such other and further exceptions as may then be deemed necessary.

	Proceedings: Lis Pendens
	Lis Pendens Notice dated {PR,"Insert date of lis pendens here.",DT2,1} filed by {PR,"Insert name of person(s) filing the lis pendens here.",ST1,2} against {PR,"Insert name(s) of persons receiving the lis pendens here.",ST1,3} in Case No. {PR,"Insert c...
	NOTE: No examination of these proceedings has been made, and upon examination, this commitment, and any policies committed for thereunder, shall be subject to such other and further exceptions as may then be deemed necessary.

	General Lien Exception (Wisconsin)
	Notice of {PR,"Liens: Enter the type of lien (e.g., ‘Wisconsin Income Tax’):",ST1,1} lien in favor of {PR,"Liens: Enter the entity who filed the lien:",ST1,3} and against {PR,"Liens: Enter the entity against whom the lien was filed:",ST1,2} in the sum...

	Mechanics’ Liens (Wisconsin)
	Mechanics’ lien filed by {PR,"Insert name of person or company filing the lien here.",ST1,1} against {PR,"Insert the person(s) against whom the lien was filed here.",ST1,2} on {PR,"Insert the date the lien was filed here.",DT2,3}, as Document Number {...

	Building Code Violation
	Lis Pendens dated {PR,"Enter date of Lis Pendens notice:",DT2,1}, and recorded {PR,"Enter date Lis Pendens Notice was recorded:",DT2,2}, as Document Number {PR,"Enter document number of recorded Lis Pendens notice",ST1,3}, entitled {PR,"Enter Plaintif...
	Note: We have not made an examination of these proceedings, and this commitment, and any policies committed for thereunder, are subject to such further exceptions as may be deemed necessary.
	The fact, as evidenced by the notice recorded as Document Number {RP,3}, that a violation of any law, ordinance, or governmental regulation (including but not limited to building and zoning laws, ordinances, or regulations) restricting, regulating, pr...

	Proceedings: Lis Pendens (Wisconsin)
	Lis Pendens Notice, dated {PR,"Insert date of lis pendens here.",DT2,1}, filed by {PR,"Insert name of person(s) filing the lis pendens here.",ST1,2} against {PR,"Insert name(s) of persons receiving the lis pendens here.",ST1,3} in Case No. {PR,"Insert...
	NOTE: No examination of these proceedings has been made and, upon examination, this commitment, and any policies committed for thereunder, shall be subject to such other and further exceptions as may then be deemed necessary.


	Metro East Office
	Subdivision Restriction, Building Line, Easement
	Restriction contained, dated*, and recorded* as Document No. *.
	A * foot building line, running along the * line of said lot, as shown in the Plat of Subdivision.
	A * foot easement, running along the * line of said lot, as shown in the Plat of Subdivision.

	Exceptions for Construction Loan Policy
	Rights or claims of parties in possession not shown by the public records.
	Encroachments, overlaps, boundary line disputes, and any matters that would be disclosed by an accurate survey and inspection of the premises. Easements, or claims of easements, not shown by the public records. Taxes or special assessments that are no...

	Deed of Conveyance
	Execution of deed of conveyance from {PR,"Name of Grantor",ST1,1} to {PR,"Name of Grantee",ST1,2},


	Minor’s Estates
	General (Wisconsin)
	Proceedings pending in the Circuit Court of {PR,"Enter name of County.",ST1,1} County entitled Estate of {PR,"Enter name of minor.",ST1,2}, a minor, under Case No. {PR,"Enter minor’s case number.",ST1,3}.
	Any conveyance of the land must be made by the guardian of the Estate of {PR,"Enter name of minor.",ST1,1}, a minor, pursuant to a proper order entered in Case No. {PR,"Enter minor’s case number.",ST1,2} and such conveyance should recite that the same...
	Statutory right, powers, and duties of the guardian of the Estate of {PR,"Enter name of minor.",ST1,1}, a minor.

	General
	Proceedings pending in the Circuit Court of {PR,"Enter name of County.",ST1,1} County entitled Estate of {PR,"Enter name of minor.",ST1,2}, a minor, under Case No. {PR,"Enter minor’s case number.",ST1,3}.
	Any conveyance of the land must be made by the guardian of the Estate of {PR,"Enter name of minor.",ST1,1}, a minor, pursuant to a proper order entered in Case No. {PR,"Enter minor’s case number.",ST1,2} and such conveyance should recite that the same...
	Statutory right, powers, and duties of the guardian of the Estate of {PR,"Enter name of minor.",ST1,1}, a minor.


	Miscellaneous
	1099
	Pursuant to the Tax Reform Act of 1986; Title 1, Subtitle C; Section 1521 requires the Settlement Agent to report real estate transactions. Relative thereto, we note the following and require:
	A. We must be furnished at closing with the tax identification of the recipients of any or all of the net proceeds of the transaction.
	B. Failure to comply will result in a 20 percent holdback to be deposited with the Internal Revenue Service pursuant to the aforesaid act.

	Cover Date
	This commitment should be updated to cover the recording date of the {PR,"Enter name of the recorded document",ST1,1}, and this commitment is subject to such further exceptions as may then be deemed necessary.

	Break in Chain of Title
	{PR,"Enter name of recipient of wild deed.",ST1,1} obtained title by mesne (intervening) conveyances from {PR,"Enter name of grantor in wild deed.",ST1,2}. We find no title in {RP,2}. This should be explained, and this commitment, and any policies com...

	Policy: Duplicate Policy
	This duplicate policy is issued to replace Policy No. {PR,"Insert lost or destroyed policy numberhere.",ST1,1}, that was lost or destroyed. It is understood that this duplicate policy evidences the liability of Attorneys’ Title Guaranty Fund, Inc., un...

	Schedule B Part II
	SCHEDULE B, PART II
	In addition to the matters set forth in Part I of this schedule, the title to the estate or interest described or referred to in Schedule A is subject to the following matters, but ATG insures that such matters are subordinate to the lien or charge of...
	Mortgage dated {PR,"Enter date of mortgage.",DT2,7}, and recorded {PR,"Enter mortgage recording date.",DT2,7}, as Document No. {PR,"Enter recorded mortgage document number.",ST1,6}, executed by {PR,"What are the borrowers name(s)?",ST1,6} and given to...

	Agent Fee
	Effective September 1, 2003, and pursuant to the Amendment to the Title Insurance Act, a Fee of $3.00 will be added to each policy issued and listed on the HUD-1 as an Illinois Title Insurance Agent Registration Fee.

	Section 3607 USC
	(but omitting any such covenant or restriction based on race, color, religion, sex, handicap, familial status or national origin unless and only to the extent that said covenant (A) is exempt under Chapter 42, Section 3607 of the United States Code or...

	Spouse
	Rights and interest of the spouse, if any, of title holder or person(s) taking title named in Schedule A. Note: The present marital status of the grantors herein named must be disclosed in any subsequent deed of conveyance and/or mortgage ATG is asked...

	Policy Tax
	Pursuant to the Illinois Title Insurance Act (215 ILCS 155/1, et seq.), a fee of $3.00 is imposed for each policy issued by a title insurance agent. This fee will be charged to the party or parties ordering the title insurance policy or policies.

	Forgery
	Right, title, and interest of {PR,"Name of Grantor(s) in deed less than 12 months old",ST1,1}, purported grantor in the deed recorded {PR,"Date deed was recorded",DT2,2}, as Document No. {PR,"Document No. of deed",ST1,3}.
	Note: This exception may be waived only with approval from an ATG staff attorney


	Mobile Home
	Mobile Home: Commitment
	ATG must be provided with the following information in order to ascertain if a mobile home or any other component housing unit is an integral part of the land:
	(a) Whether ownership of both the mobile home or component housing unit and the land are in the same person;
	(b) Whether there is an intention to dedicate the mobile home or component housing unit for the exclusive purpose of a permanently located dwelling area;
	(c) Whether the motor vehicle registration of the mobile home or component housing unit has been properly cancelled;
	(d) Whether the mobile home or component housing unit is being taxed in conjunction with the land as a single parcel of real property;
	(e) Whether the permanent affixation of the mobile home or component housing unit to the land has been fully effected. This affixation entails, among other factors, the following actions:
	(1) removal of axles and wheels from the mobile home or component housing unit;
	(2) setting of the mobile home or component housing unit upon a permanent foundation;
	(3) connection of the mobile home or component housing unit to a sewer system and public utilities;
	(4) compliance with any other statutory requirements.
	(f) Whether any lien, security interest, or encumbrance affecting the mobile home or component housing unit and shown in the title registration, bill of sale, or certificate of sale, has been properly cancelled;
	(g) A U.C.C. Financing Statement search;
	(h) The effect of applicable U.C.C. state law in regard to an out-of-state purchase of a mobile home or component housing unit.


	Mortgage
	Assignment of Mortgage
	Assignment of Mortgage from {PR,"Enter name of original lender",ST1,1} to {PR,"Enter name of lender receiving assignment.",ST1,2} dated {PR,"Enter the date of the assignment",DT2,5}, and recorded {PR,"Enter recording date of assignment",DT2,5}, as Doc...

	Assignment of Rents
	Assignment of Rents dated {PR,"Enter date of Assignment of Rents.",DT2,1} and recorded {PR,"Enter date Assignment of Rents was recorded.",DT2,2} as Document No. {PR,"Enter recorded Document number of Assignment of Rents.",ST1,5} executed by {PR,"Enter...

	Financing Statement
	Financing Statement (UCC-1) dated {PR,"Enter date of UCC statement.",DT2,1}, and recorded {PR,"Enter date the UCC statement was recorded.",DT2,2}, as Document No. {PR,"Enter recorded Document number of the UCC statement.",ST1,3}, made by {PR,"Enter na...

	Mortgage Signing
	All parties in title or taking title must execute the mortgage that ATG is being asked to insure. If any party in title does not execute said mortgage, lender will take subject to the outstanding ownership interest of said non-executing party.

	Subordination Agreement
	Subordination Agreement dated {PR,"Enter date of Subordination Agreement.",DT2,1}, and recorded {PR,"Enter date the Subordination Agreement was recorded.",DT2,2}, as Document No. {PR,"Enter recorded Document number of agreement.",ST1,5}, made by {PR,"...

	Trust Deed
	Trust Deed dated {PR,"Enter date of Trust Deed.",DT2,1}, and recorded {PR,"Enter date the Trust Deed was recorded.",DT2,2}, as Document No. {PR,"Enter recorded Document number.",ST1,5} executed by {PR,"Enter name(s) of person granting the Trust Deed."...

	Mortgage (WFAC)
	Mortgage (with future advance clause), dated {PR,"Date of Mortgage",DT2,1} and recorded {PR,"Date ofRecording",DT2,2}, as Document No. {PR,"Recorded Document No.",ST1,3}, executed by {PR,"Names ofMortgagors",ST1,4}, and given to {PR,"Name of Mortgagee...

	Titleholder’s Mortgage
	Mortgage dated {PR,"Enter Date of Mortgage",DT2,1}, and recorded {PR,"Enter date mortgage was recorded",DT2,2}, as Document No. {PR,"Enter Document No. of mortgage",ST1,3}, executed by {DB,CommitPolicy,CurrentHolders,NO}, and given to {PR,"Enter Name ...

	Existing Mortgage
	Mortgage dated {PR,"Enter Date of Mortgage",DT2,1}, and recorded {PR,"Enter date mortgage was recorded",DT2,2}, as Document No. {PR,"Enter Document No. of mortgage",ST1,3}, executed by {PR,"Enter name(s) of Mortgagor(s)",ST1,4}, and given to {PR,"Ente...

	New Mortgage
	Mortgage dated {PR,"Date of Mortgage",DT2,1}, and recorded {PR,"Date of Recording",DT2,2}, as Document No. {PR,"Document Number",ST1,3}, executed by {DB,CommitPolicy,MortBorrower,NO}, and given to {DB,CommitPolicy,MortInsured,NO}, to secure a note in ...

	Revolving Line of Credit
	Revolving Line of Credit Mortgage dated {PR,"Enter Date of Mortgage",DT2,1}, and recorded {PR,"Enter date mortgage was recorded",DT2,2}, as Document No. {PR,"Enter Document No. of mortgage",ST1,3}, executed by {PR,"Enter name(s) of Mortgagor(s)",ST1,4...

	Modification or Extension Agreement
	Subject to a Modification and Extension of Mortgage Agreement dated {PR,"Enter date of Modification or Extension Agreement",DT2,1}, and recorded on {PR,"Enter date Modification or Extension Recorded",DT2,2}, as Document No. {PR,"Type Document Number",...

	New Second Mortgage
	Mortgage dated {PR,"Date of Mortgage",DT2,3}, and recorded {PR,"Date Mortgage was recorded",DT2,3}, as Document No. {PR,"Document number",ST1,3}, executed by {DB,CommitPolicy,MortBorrower,NO}, and given to {DB,CommitPolicy,MortInsured2,NO}, to secure ...
	MERS (Champaign)
	Mortgage Electronic Registration Systems, Inc., acting solely as nominee for MORTGAGE EXCEPT

	Modification
	Modification of Mortgage dated {PR,"Dated",DT2,2} and recorded {PR,"recorded date",DT2,2} as Document No. {PR,"document number",ST1,3}, between {PR,"Morgagee",ST1,4} and {PR,"Bank",ST1,5}, relating to Mortgage Document No. {PR,"Mortgage Document Numbe...


	Municipalities
	Addison
	The Recording of any Deed or other instrument of conveyance of the land is subject to real estate transfer tax levied by THE CITY OF ADDISON. As of the date of this commitment, Addison tax rate is $2.50 per $1,000.00, payable by the Buyer before closi...
	Note: If Property is exempt from stamps, a $25.00 exemption fee is required.

	Aurora
	The Recording of any Deed or other instrument of conveyance of the land is subject to real estate transfer tax levied by THE CITY OF AURORA. As of the date of this commitment, Aurora tax rate is $3.00 per $1,000.00, payable by the Seller before closin...
	Note: If Property is exempt from stamps, a $25.00 exemption fee is required.

	Bartlett
	The Recording of any Deed or other instrument of conveyance of the land is subject to real estate transfer tax levied by the VILLAGE OF BARTLETT. As of the date of this commitment, Bartlett tax rate is $3.00 per $1,000.00, payable by the Seller before...

	Bensenville
	The town of Bensenville requires a property inspection prior to closing.

	Berwyn
	The Recording of any Deed or other instrument of conveyance of the land is subject to real estate transfer tax levied by the TOWN OF BERWYN. As of the date of this commitment, Berwyn tax rate is $10.00 per $1,000.00, payable by the Seller before closi...
	Note: If Property is exempt from stamps, a $25.00 exemption fee is required.

	Bolingbrook
	The Recording of any Deed or other instrument of conveyance of the land is subject to real estate transfer tax levied by the VILLAGE OF BOLINGBROOK. As of the date of this commitment, Bolingbrook tax rate is $3.75 per $1,000.00, payable by the Buyer a...
	Note: If Property is exempt from stamps, a $25.00 exemption fee is required.

	Buffalo Grove
	The Recording of any Deed or other instrument of conveyance of the land is subject to real estate transfer tax levied by the VILLAGE OF BUFFALO GROVE. As of the date of this commitment, Buffalo Grove tax rate is $3.00 per $1,000.00 payable by the Sell...
	Note: If Property is exempt from stamps, a $25.00 exemption fee is required.

	Carol Stream
	The Recording of any Deed or other instrument of conveyance of the land is subject to real estate transfer tax levied by the VILLAGE OF CAROL STREAM. As of the date of this commitment, Carol Stream tax rate is $3.00 per $1,000.00, payable by the Selle...

	Cicero
	The Recording of any Deed or other instrument of conveyance of the land is subject to real estate transfer tax levied by the VILLAGE OF CICERO. As of the date of this commitment, Cicero tax rate is $10.00 per $1,000.00, payable by the Seller before cl...
	NOTE: If property is exempt from stamps, a $25.00 exemption fee is required.

	Des Plaines
	The Recording of any Deed or other instrument of conveyance of the land is subject to real estate transfer tax levied by the VILLAGE OF DES PLAINES. As of the date of this commitment, Des Plaines tax rate is $2.00 per $1,000.00, payable by the Seller ...

	Elgin
	No fee due City of Elgin. All money due City of Elgin must be paid in full before issuance of Elgin Transfer Stamps.

	Elk Grove
	The Recording of any Deed or other instrument of conveyance of the land is subject to real estate transfer tax levied by the VILLAGE OF ELK GROVE. As of the date of this commitment, Elk Grove tax rate is $3.00 per $1,000.00, payable by the Seller befo...

	Elmhurst
	The Recording of any Deed or other instrument of conveyance of the land is subject to real estate transfer tax levied by the CITY OF ELMHURST. As of the date of this commitment, Elmhurst tax rate is $1.50 per $1,000.00, payable by the Seller before cl...

	Elmwood Park
	The Recording of any Deed or other instrument of conveyance of the land is subject to real estate transfer tax levied by the VILLAGE OF ELMWOOD PARK. As of the date of this commitment, Elmwood Park tax rate is $5.00 per $1,000.00, payable by the Selle...
	NOTE: If Property is exempt from stamps, a $25.00 exemption fee is required.
	Elmwood Park also requires a property inspection prior to closing.

	Glen Ellyn
	The Recording of any Deed or other instrument of conveyance of the land is subject to real estate transfer tax levied by the VILLAGE GLEN ELLYN. As of the date of this commitment, Glen Ellyn tax rate is $3.00 per $1,000.00, payable by the Seller befor...
	NOTE: If Property is exempt from stamps, a $25.00 exemption fee is required.

	Evanston
	The Recording of any Deed or other instrument of conveyance of the land is subject to real estate transfer tax levied by the VILLAGE OF EVANSTON. As of the date of this commitment, Evanston tax rate is $5.00 per $1,000.00, payable by the Seller before...
	NOTE: If Property is exempt from stamps, a $25.00 exemption fee is required.

	Franklin Park
	The Recording of any Deed or other instrument of conveyance of the land is subject to real estate transfer tax levied by the TOWN OF FRANKLIN PARK. As of the date of this commitment, Franklin Park is $25.00 or more, depending on type of property, paya...
	NOTE: If property is exempt from stamps, a $25.00 exemption fee is required.

	Hanover Park
	The Recording of any Deed or other instrument of conveyance of the land is subject to real estate transfer tax levied by the VILLAGE OF HANOVER PARK. As of the date of this commitment, Hanover Park tax rate is $3.00 per $1,000.00, payable by the Selle...
	NOTE: If Property is exempt from stamps, a $25.00 exemption fee is required.

	Harwood Heights
	The Recording of any Deed or other instrument of conveyance of the land is subject to real estate transfer tax levied by the VILLAGE OF HARWOOD HEIGHTS. As of the date of this commitment, Harwood Heights’ tax rate is $10.00 per $1,000.00, payable by t...
	NOTE: If Property is exempt from stamps, a $25.00 exemption fee is required.

	Hoffman Estates
	The Recording of any Deed or other instrument of conveyance of the land is subject to real estate transfer tax levied by the VILLAGE OF HOFFMAN ESTATES. As of the date of this commitment, Hoffman Estates tax rate is $3.00 per $1,000.00 payable by the ...
	NOTE: If Property is exempt from stamps, a $10.00 exemption fee is required.

	Joliet
	The Recording of any Deed or other instrument of conveyance of the land is subject to real estate transfer tax levied by THE CITY OF JOLIET. As of the date of this commitment, Joliet tax rate is $3.00 per $1,000.00, payable by the Seller before closin...
	Note: If Property is exempt from stamps, a $25.00 exemption fee is required.

	Maywood
	The Recording of any Deed or other instrument of conveyance of the land is subject to real estate transfer tax levied by the VILLAGE OF MAYWOOD. As of the date of this commitment, Maywood tax rate is $4.00 per $1,000.00, payable by the Seller before c...

	Morton Grove
	The Recording of any Deed or other instrument of conveyance of the land is subject to real estate transfer tax levied by the VILLAGE OF MORTON GROVE. As of the date of this commitment, Morton Grove tax rate is $3.00 per $1,000.00, payable by the Selle...

	Mount Prospect
	The Recording of any Deed or other instrument of conveyance of the land is subject to real estate transfer tax levied by the VILLAGE OF MOUNT PROSPECT. As of the date of this commitment, Mount Prospect tax rate is $3.00 per $1,000.00, payable by the B...
	The City of Mount Prospect also requires any outstanding water bills to be paid prior to closing.

	Naperville
	The Recording of any Deed or other instrument of conveyance of the land is subject to real estate transfer tax levied by the CITY OF NAPERVILLE. As of the date of this commitment, Naperville tax rate is $3.00 per $1,000.00, payable by the Buyer before...
	NOTE: If property is exempt from stamps, a $25.00 exemption fee is required.

	Niles
	The Recording of any Deed or other instrument of conveyance of the land is subject to real estate transfer tax levied by the VILLAGE OF NILES. As of the date of this commitment, Niles tax rate is $3.00 per $1,000.00, payable by the Buyer before closin...
	NOTE: If property is exempt from stamps, a $25.00 exemption fee is required.

	Oak Park
	The Recording of any Deed or other instrument of conveyance of the land is subject to real estate transfer tax levied by the VILLAGE OF OAK PARK. As of the date of this commitment, Oak Park tax rate is $8.00 per $1,000.00, payable by the Seller before...
	NOTE: If property is exempt from stamps, a $25.00 exemption fee is required.

	Park Ridge
	The Recording of any Deed or other instrument of conveyance of the land is subject to real estate transfer tax levied by the City of Park Ridge. As of the date of this commitment, Park Ridge transfer tax is $2.00 per $1,000.00, payable by the Seller b...

	River Forest
	The Recording of any Deed or other instrument of conveyance of the land is subject to real estate transfer tax levied by the VILLAGE OF RIVER FOREST. As of the date of this commitment, River Forest tax rate is $.50 per $1,000.00, payable by the Seller...

	River Grove
	The Recording of any Deed or other instrument of conveyance of the land is subject to real estate transfer tax levied by the VILLAGE OF RIVER GROVE. As of the date of this commitment, River Grove tax rate is $50.00, payable by the Seller before closing.
	The Village of River Grove requires mandatory inspection and review of the original deed or document of transfer regarding property located within the Village. In addition, the Village of River Grove mandates that all title reports reflect the require...

	Rolling Meadows
	The Recording of any Deed or other instrument of conveyance of the land is subject to real estate transfer tax levied by the TOWN OF ROLLING MEADOWS. As of the date of this commitment, Rolling Meadows tax rate is $3.00 per $1,000.00, payable by the Se...
	NOTE: If property is exempt from stamps, a $25.00 exemption fee is required.

	Romeoville
	The Recording of any Deed or other instrument of conveyance of the land is subject to real estate transfer tax levied by THE CITY OF ROMEOVILLE. As of the date of this commitment, Romeoville tax rate is $3.50 per $1,000.00, payable by the Buyer before...
	Note: If Property is exempt from stamps, a $25.00 exemption fee is required.

	Schaumburg
	The Recording of any Deed or other instrument of conveyance of the land is subject to real estate transfer tax levied by the VILLAGE OF SCHAUMBURG. As of the date of this commitment, Schaumburg tax rate is $1.00per $1,000.00 payable by the Seller befo...
	NOTE: If property is exempt from stamps, a $25.00 exemption fee is required.

	Skokie
	The Recording of any Deed or other instrument of conveyance of the land is subject to real estate transfer tax levied by the TOWN OF SKOKIE. As of the date of this commitment, Skokie tax rate is $3.00 per $1,000.00, payable by the Seller before closin...
	NOTE: If property is exempt from stamps, a $25.00 exemption fee is required.

	Stone Park
	By Stone Park Municipal Ordinance, a transfer tax has been imposed upon the sale of real property located within the municipality; therefore, all deeds presented to this company for recording must have the appropriate transfer tax stamps affixed there...
	NOTE: The Stone Park Transfer Tax rate is $2.00 per $500.00.

	Streamwood
	The Recording of any Deed or other instrument of conveyance of the land is subject to real estate transfer tax levied by the VILLAGE OF STREAMWOOD. As of the date of this commitment, Streamwood tax rate is $3.00 per $1,000.00, payable by the Seller be...
	NOTE: If property is exempt from stamps, a $25.00 exemption fee is required.

	Wheaton: General
	Note for Information: The land described in Schedule A lies within the corporate limits of the City of Wheaton. The land is subject to real estate transfer tax of $2.50 per $1,000.00 of consideration. The transfer tax is the responsibility of the Buye...
	Note for Information: Pursuant to City of Wheaton Ordinance 193, the Seller must pay the water bill current to closing in order for Purchaser to obtain the City of Wheaton transfer tax stamp.

	Wheaton Tax
	The Recording of any Deed or other instrument of conveyance of the land is subject to real estate transfer tax levied by THE CITY OF WHEATON. As of the date of this commitment, Wheaton tax rate is $2.50 per $1,000.00, payable by the Buyer before closi...
	Note: If Property is exempt from stamps, a $25.00 exemption fee is required.

	Wheeling Transfer Certificate
	Compliance must be made with Section 15.38 of the Wheeling Municipal Code regarding the issuance of a Real Estate Transfer Certificate prior to the recording of a Deed of Conveyance.

	Woodridge
	The Recording of any Deed or other instrument of conveyance of the land is subject to real estate transfer tax levied by the VILLAGE OF WOODRIDGE. As of the date of this commitment, Woodridge tax rate is $2.50 per $1,000.00, payable by the Seller befo...
	NOTE: If property is exempt from stamps, a $25.00 exemption fee is required.
	Note: If Property is exempt from stamps, a $25.00 exemption fee is required.


	Municipality
	Chicago: Water and Zoning
	By ordinance of the City of Chicago, the recording or filing of any deed or other instrument of conveyance is subject to prior water and zoning certification. Relative thereto, all deeds submitted to ATG for recording must be accompanied by the approp...

	Chicago: Building Registration
	Pursuant to Chapter 13.10 of the Municipal Code of Chicago, if the building on the land contains four or more residential units, a Certificate of Registration, or a receipt from the Department of Buildings, showing that the building being transferred ...

	Inspection
	By ordinance of the City/Village of {DB,Property,City,NO}, the recording or filing of any deed or other instrument of conveyance is subject to prior approval by an appropriate officer of the municipality for property within the municipality limits. Re...

	Tax
	By ordinance of the City/Village of {DB,Property,City,NO}, the recording or filing of any deed or other instrument of conveyance is subject to real estate transfer taxes imposed by the municipality for property located within the municipality imposed....

	Transfer Tax Exemption
	Any instrument conveying the subject property that is exempt from the transfer tax must have the appropriate municipal transfer tax form, transfer tax stamp, if required, and grantor/grantee statement, with the appropriate exemption language, affixed ...


	NLT Belvidere
	Requirements
	a) Warranty Deed from {PR,"seller’s name",ST1,1} to {PR,"buyer’s name",ST1,2}.
	b) Mortgage from {PR,"buyer’s name",ST1,3} to {PR,"lender name",ST1,4} to secure a debt in the amount of {PR,"loan amount",CU1,5}.
	c) Payment and release of the mortgage recorded as Document No. {PR,"doc number",IN1,6}

	Condominium: Commitment 4
	Furnish ATG with a certificate, executed and acknowledged by the Secretary of the Board of Managers, stating that there are no unpaid assessment liens arising by reason of the nonpayment of assessments as per the Condominium Declaration.


	NLT Rockford: Exceptions
	Setback/Easement
	A {PR,"distance in feet of Building setback",ST1,1}-foot building setback line from the {PR,"direction of setbackline",ST1,2} line of the property, and a {PR,"distance in feet of easement",ST1,3}-foot line from the {PR,"direction of easement",ST1,4} l...

	Restrictions/Setback Generic
	Restrictions, set-backs, and easements according to public record.

	Deed of Conveyance
	{PR,"Enter type of Deed (Warranty, Quitclaim, etc.).",ST1,6} Deed, dated {PR,"Enter date of Deed.",DT2,1}, and recorded {PR,"Enter date the Deed was recorded.",DT2,2}, as Document No. {PR,"Enter recorded Document number.",ST1,5}, executed by {PR,"Ente...

	Tract Search Disclaimer
	Disclaimer: This Chain of Title alone may not be used as the basis for the issuance of an ATG commitment or policy. The liability of Attorney’s Title Guaranty Fund, Inc., in connection with this search report is limited to actual damages arising out o...

	Lis Pendens
	Lis Pendens Notice dated {PR,"Insert date of lis pendens here.",DT2,1} filed by {PR,"Insert name of person(s) filing the lis pendens here.",ST1,2} against {PR,"Insert name(s) of persons receiving the lis pendens here.",ST1,3} in Case No. {PR,"Insert c...

	Mortgage
	Mortgage dated {PR,"Date of Mortgage",DT2,7}, and recorded {PR,"Date mortgage was recorded",DT2,6}, as Document No. {PR,"Document No. of mortgage",ST1,3}, from {PR,"Name of borrower(s)",ST1,4}, given to {PR,"Name of lender",ST1,5}, its successors and/...

	Real Estate Taxes
	Taxes for the year {PR,"Year of taxes NOT paid",ST1,1} and thereafter:
	First installment of {PR,"Year of 1st installment ",IN1,8} taxes, in the amount of {PR,"amount of 1st installment",CU1,3}, is {PR,"Current status of 1st installment of taxes: PAID, etc.",ST1,4} and due 6/4/10;
	Second installment of {PR,"Year of 2nd installment",IN1,8} taxes, in the amount of {PR,"amount of 2nd installment",CU1,6}, is {PR,"Current status of 2nd installment: PAID, etc.",ST1,7} and due 9/3/10;
	Totaling {PR,"Total of 1st & 2nd Installment",CU1,8}.
	2008 and prior years taxes appear to be paid in full.
	Taxes for the year 2010 are not yet due or payable.
	PIN: {DB,Property,TaxID,NO}

	Restrictions
	Provisions detailed in Covenants, Conditions, and Restrictions for {PR,"Subdivision name",ST1,1}, which document was dated {PR,"date of restrictions",DT2,2}, and recorded {PR,"date restrictions were recorded",DT2,3}, as Document No. {PR,"Document No. ...

	Judgment: Same Name
	We find judgments, liens, and matters of record involving a person or persons whose names are similar to {PR,"Enter name of possible judgment debtor",ST1,1}. Relative thereto, a Personal Information Affidavit (ATG Form 3008) establishing the identity ...

	Judgment
	Judgment rendered on {PR,"Insert date of judgment here",DT2,1} in the {PR,"Insert name of court (circuit, appellate, etc.) here",ST1,2} Court of {PR,"Insert name of county here",ST1,3} County, in favor of {PR,"insert name(s) of winning person(s) here"...

	Agreement for Deed: New
	Consequences, if any, by reason of failure to record either the Agreement for Deed or a memorandum thereof.

	Agreement for Deed: Close-Out Recorded
	Terms and conditions of that Agreement for Deed, dated {PR,"date of AG D",DT2,1}, and recorded on {PR,"date AGD was recorded",DT2,2}, as Document No. {PR,"Document No. of AG D",ST1,3}.

	Agreement for Deed: Close-Out Unrecorded
	Terms and Conditions of an unrecorded Agreement for Deed, dated {PR,"Date of AG D",DT2,1}, by and between {DB,SellerInfo,Name1First,NO} {DB,SellerInfo,Name1MI,NO} {DB,SellerInfo,Name1Ext,NO} and {DB,SellerInfo,Name2First,NO} {DB,SellerInfo,Name2MI,NO}...

	Real Estate Taxes: Sold
	{PR,"which installment or both are sold",ST1,1} installment(s) of the {PR,"Year of taxes sold",ST1,2} taxes have been sold and are NOT redeemed.

	Memo of Agreement for Deed
	Memorandum for Recording of Agreement for Deed, dated {PR,"Enter date of Deed.",DT2,1}, and recorded {PR,"Enter date the Deed was recorded.",DT2,2}, as Document No. {PR,"Enter recorded Document number.",ST1,5}, executed by {PR,"Enter name(s) of person...

	Later Date Text
	Attached is a list of items filed in the Recorder’s Office as of {PR,"Last effective date",DT2,1}, the date of our last search.

	Dissolution of Marriage Case
	Dissolution of marriage proceedings filed by {PR,"Insert name of Plaintiff here.",ST1,1} against {PR,"Insert name of Defendant here.",ST1,2} in the Circuit Court of {PR,"Insert name of County here.",ST1,3} County as Case No. {PR,"Insert Case number he...
	NOTE: No examination of these proceedings has been made, and upon such examination, this commitment, and any policies committed for thereunder, shall be subject to such other and further exceptions as may then be deemed necessary.

	Corporation Dissolved
	{PR,"Enter name of dissolved Illinois corporation",ST1,1}, an Illinois corporation, was dissolved on {PR,"Enter date of dissolution of Illinois corporation",DT2,2}. We note the following with respect thereto and this Commitment is subject to the follo...
	(1) Rights of the creditors of said corporation, including the United States of America;
	(2) Right, title, and interest of the stockholders/members of said corporation and those claiming under them.
	(3) Franchise tax in favor of the State of Illinois.

	Tax: City Ordinance Transfer Tax
	By {PR,"Name of City",ST1,1} municipal ordinance, a transfer tax has been imposed upon the sale of Real Property located within the municipality. Therefore, all deeds presented to this company for recording must have the appropriate transfer tax stamp...
	NOTE: Certain municipalities have requirements that must be met prior to the issuance of the aforesaid transfer tax stamps. Relative thereto, said municipality must be contacted as to their requirements prior to the purchase of any revenue stamps.

	Condominium Setback/Easement
	Setbacks and Easements according to {PR,"name of original plat",ST1,1}, recorded {PR,"date original plat recorded",DT2,2}, as Document No.{PR,"Document No. of original Plat",ST1,3}.
	Setbacks and Easements according to {PR,"Name of Condo Plat",ST1,4}, recorded {PR,"date condo plat was recorded",DT2,5}, as Document No. {PR,"Document No. of Condo Plat",ST1,6}.

	Environmental Disclosure
	Environmental disclosure document for transfer of real property, dated {PR,"Date of EnvironmentalDisclosure",DT2,1}, and recorded {PR,"Date Environment Disclosure was recorded",DT2,2}, as Document No. {PR,"Doc No. of Environment Disclosure",ST1,3}.

	Construction Commitment Exception
	ATG must be provided with properly executed sworn contractors’ statements, sub-contractors’ statements, and final lien waivers, along with proof of proper disbursements of any loan proceeds used for the improvement of the land, or the policy or polici...
	"(a). Any lien, or right to a lien, for services, labor, or materials, heretofore or hereafter furnished, imposed by law, and not shown by the public records.
	"(b). Consequences of the failure of the lender to pay out properly the whole or any part of the loan secured by the mortgage described in Schedule A as affecting: (i) the validity of the lien of the mortgage; and (ii) the priority of the lien of the ...

	Lake Summerset Rest: Winnebago
	{PR,"Number of feet for Setback",ST1,1} foot Building Setback line from the {PR,"Direction of the setbackline",ST1,2} line of the property, as designated upon said recorded Plat.
	Easement contained in the Corrected Final Plat No. 2 of Lake Summerset reserved for and granted to Commonwealth Edison Company, Illinois Telephone Company, and Mid-Illinois Gas Company and their respective successors and assigns within the area of Lak...
	Provisions contained in the Corrected Final Plat No. 2 of Lake Summerset, dated September 16, 1969, and recorded September 25, 1969, in Book 32 of Plats on page 262. NOTE: A breach violation of the above noted restrictions will not cause a forfeiture ...
	Declaration of covenants and restrictions, dated April 30, 1969, and recorded May 7, 1969, as Document No.1211783, found on Microfilm No. 69-09-0319, together with provisions for assessments and liens.
	Right of First Refusal contained in declaration of covenants and restrictions, dated April 30, 1969, and recorded May 7, 1969, as Document No. 1211783, found on Microfilm No. 1211783, for particulars of which we refer to the public records.
	Easements contained in declarations of covenants and restrictions, dated April 30, 1969, and recorded May 7,1969, as Document No. 1211783, found on Microfilm No. 69-09-0319, for particulars of which we refer to the public records. Assigned to Otter Cr...
	Easement created by grant dated March 29, 1978, and recorded May 10, 1978, as Document No. 1311901, found on Microfilm No. 73-11-0344, made by the Cosmopolitan National Bank of Chicago, as Trustee, under Trust Agreement dated August 1, 1969, and known...
	Interest of Lake Summerset Association, Inc., in all oil, all other minerals of every kind and description, and all air rights in and upon premises in questions under deed dated April 30, 1973, and recorded May 10, 1973, as Document No. 1311906, found...
	Declaration of Restrictions, Lake Summerset Subdivision, Stephenson and Winnebago Counties, Illinois, 1999 amended Declaration of Restrictions, recorded December 18, 1998, as Document No. 9880054.

	Declaration: No Will No Probate
	A satisfactory table of the heirship and proof of the death, testacy or intestacy, and of the value of the estate of {PR,"Name of decedant",ST1,1}, deceased, should be furnished, and this Commitment is subject to such further exceptions, if any, as ma...
	Claims against the estate of {RP,1}, deceased.
	Federal and Illinois Estate Taxes that may be charged against the estate of {RP,1}.
	Statutory rights, powers, and duties of the personal representative of the decedent, if and when appointed.

	Mortgage with Subordination
	Mortgage dated {PR,"Date of Mortgage",DT2,7}, and recorded {PR,"Date mortgage was recorded",DT2,6}, as Document No. {PR,"Document No. of mortgage",ST1,3}, from {PR,"Name of borrower(s)",ST1,4} given to {PR,"Name of lender",ST1,5}, its successors and/o...

	Annexation Agreement
	Provisions detailed in an Annexation Agreement dated {PR,"date of agreement",DT2,2}, and recorded {PR,"date agreement was recorded",DT2,3}, as Document No. {PR,"Document No. of agreement",ST1,4}.

	Power of Attorney
	Power of Attorney, dated {PR,"Date of POA",DT2,1}, and recorded {PR,"Date POA was recorded",DT2,2}, as Document No. {PR,"Doc. No. of POA",ST1,3}, from {PR,"Grantor of POA",ST1,4} to {PR,"Grantee of POA",ST1,5}.

	Assignment of Rents
	Assignment of Rents, dated {PR,"Date of RENTS",DT2,7}, and recorded {PR,"Date RENTS was recorded",DT2,6}, as Document No. {PR,"Document No. of RENTS",ST1,3}, from {PR,"Name of borrower(s)",ST1,4} given to {PR,"Name of lender",ST1,5}, its successors an...

	Flood Letter
	Provisions detailed in a flood letter dated {PR,"date of flood letter",DT2,2}, and recorded {PR,"date flood letter wasrecorded",DT2,3}, as Document No. {PR,"Document No. of flood letter",ST1,4}.

	Restrictions on Warranty Deed
	Covenants, Conditions, and Restrictions for {PR,"Subdivision name",ST1,1}, detailed on Warranty deed dated {PR,"date of deed restrictions",DT2,2}, and recorded {PR,"date deed restrictions were recorded",DT2,3}, as Document No. {PR,"Document No. of dee...

	Name Search
	At the request of the applicant, we have made a search for judgments, liens, and other matters against the following named persons and find none at this date, which would adversely affect title to the premises in question unless shown elsewhere herein:

	Condominium (PUD): Homeowners Association
	We must be furnished a letter from the {PR,"Name of Condo (PUD) association",ST1,1} Homeowner’s Association reciting that there are no outstanding balances nor liens by reason of the non-payment of special and annual assessments. Said letter must incl...

	Notice
	Provisions detailed in a Notice dated {PR,"Date of notice",DT2,1}, and recorded {PR,"Date notice wasrecorded",DT2,2}, as Document No. {PR,"Document No. of Notice",ST1,3}.

	Real Estate Taxes: Ogle
	Taxes for the year {PR,"Year of taxes NOT paid",ST1,1} and thereafter:
	First installment of {PR,"Year of 1st installment ",IN1,8} taxes, in the amount of {PR,"amount of 1st installment",CU1,3}is {PR,"Current status of 1st installment of taxes: PAID, etc.",ST1,4} and due 6/04/10;
	Second inst. of {PR,"Year of 2nd installment",IN1,8} taxes in the amount of {PR,"amount of 2ndinstallment",CU1,6} is {PR,"Current status of 2nd installment: PAID, etc.",ST1,7} and due 9/03/08;
	Totaling {PR,"Total of 1st & 2nd Installment",CU1,8}.
	2008 and prior years taxes appear to be paid in full.
	2010 taxes are not yet due or payable.
	PIN: {DB,Property,TaxID,NO}

	Mortgage with Assignment
	Mortgage dated {PR,"Date of Mortgage",DT2,7}, and recorded {PR,"Date mortgage was recorded",DT2,6}, as Document No. {PR,"Document No. of mortgage",ST1,3} from {PR,"Name of borrower(s)",ST1,4}, given to {PR,"Name of lender",ST1,5}, its successors and/o...

	Easement: Separate Recorded
	Provisions detailed in an easement dated {PR,"Date of Easement",DT2,1}, and recorded {PR,"Date easement was recorded",DT2,2}, as Document No. {PR,"Document No. of easement",ST1,3}, from {PR,"Name of person granting easement",ST1,4} to {PR,"Name of per...

	Forgery Exception
	Right, title, and interest of {PR,"Name of Grantor(s) in deed less than 12 months old",ST1,1}, purported grantor in the deed recorded {PR,"Date deed was recorded",DT2,2}, as Document No. {PR,"Document No. of deed",ST1,3}.

	EPA Disclaimer
	Disclaimer: This Chain of Title alone may not be used as the basis for the issuance of an ATG commitment or policy. The liability of Attorney’s Title Guaranty Fund, Inc. in connection with this search report is limited to actual damages arising out of...
	This report does not make representations as to the presence of hazardous products or conditions on the subject property and in no way has or assumes any liability whatsoever.
	The documents listed in this report are the recorded documents that appear of record to create any fee, land contract interests, leasehold, environmental liens, restrictions, and covenants affecting the land, environmental encumbrances or easements re...

	Deceased: Probate, No Will
	Claims against the estate of {PR,"name of deceased",ST1,1}, deceased.
	Federal estate and Illinois estate taxes, which may be charged against the estate of {RP,1}, deceased.
	Statutory rights, powers, and duties of the Independent Executor/Administrator of the estate of {RP,1}, deceased.

	Decedent Estate Exception
	Subject to the rights of {PR,"name of pers rep",ST1,1}, {PR,"exec. or adm.",ST1,2} of the Estate of {PR,"name of decedent",ST1,3}, deceased, to sell said real estate pursuant to probate proceedings, Case No. {PR,"case#",ST1,4}, Circuit Court of the {P...

	Decedents Probate General
	Proceedings pending in the Circuit Court of {PR,"Enter name of County.",ST1,1} County entitled Estate of {PR,"Enter name of deceased person.",ST1,2}, Deceased, under Case No. {PR,"Enter case number.",ST1,3}.
	Right of any person to demand formal proof of the will or to contest the will of {RP,2}, deceased, within the time provided by the Probate Act.
	Statutory rights of {PR,"Enter name of surviving spouse.",ST1,1}, surviving spouse of the decedent, to renounce the will of deceased and take statutory share.
	Power of sale conferred upon {PR,"Enter name of Executor.",ST1,1}, executor, by terms of the will of {RP,2}, deceased.
	Right, title, and interest of {PR,"Enter names of person(s) taking under the will.",ST1,1}, devisee(s) under the unproven will of {RP,2}, deceased.

	Lien: General
	Claim for lien dated {PR,"Insert date of lien here.",DT2,1}, and recorded {PR,"Insert date the lien was recorded here.",DT2,2}, as Document Number {PR,"Enter recorded document number.",ST1,6} made by {PR,"Insert name of person(s) asserting lien here."...

	Bankruptcy Statutory Powers
	Statutory Rights, powers, and duties of the Trustee in Bankruptcy in the bankruptcy proceeding filed by {PR,"Enter name(s) of person filing bankruptcy",ST1,1} on {PR,"Enter date of bankruptcy filing",DT2,2}, in the Federal District Court for the {PR,"...

	Condominium Declaration
	Terms, provisions, covenants, conditions, and options in, rights and easements established by the Declaration of Condominium Ownership recorded {PR,"Enter date of Condominium Declaration recording",DT2,1}, as Document Number {PR,"Enter Document Number...
	Limitations and conditions imposed by the Illinois Condominium Property Act.

	Corporation: Certificate of Authority
	The Certificate of Authority of {PR,"Enter name of Illinois Corporation",ST1,1} to do business in Illinois issued by the Secretary of State should be produced, and in default thereof, the policy or policies to be issued will contain the following exce...
	"Consequences, if any, that may result because of the failure of the party in title to the estate or interest in the land described in Schedule A to comply with the applicable ‘doing business’ laws of the State of Illinois.

	Lien: Child Support
	Child support judgment filed against {PR,"insert name of person(s) who received judgment",ST1,1}, in Case No. {PR,"Insert Case number",ST1,2}, in the Circuit Court of {PR,"Insert County name",ST1,3} County, Illinois, a memorandum of which was recorded...

	Easements: Dedicated Road
	Rights of the public, the State of Illinois, and the municipality in and to so much of the land dedicated for road purposes by instrument dated {PR,"Insert date of document road dedication",DT2,1}, and recorded {PR,"Insert date road dedication doc was...

	Encroachments: Adjoining Land Lot Line
	A survey discloses an encroachment by {PR,"Describe the building or structure that is encroaching",ST1,1}, located on the property to the {PR,"Enter direction of the encroachment",ST1,2} and adjoining onto the insured premises by approximately {PR,"En...

	Encroachments: Insured Land Building Line
	A survey discloses an encroachment of the {PR,"Describe the encroaching structure",ST1,1} over the {PR,"Enter direction of the encroachment",ST1,2} building line by {PR,"Enter number of feet of encroachment",IN4,3} feet.

	Encroachments: Insured Land Easement
	A survey discloses that the {PR,"Describe the structure that is encroaching",ST1,1} located upon the insured premises encroaches onto the utility easement located on the {PR,"Enter direction of the encroachement",ST1,2} of the land by {PR,"Enter numbe...

	Encroachments: Insured Land Lot Line
	A survey discloses that the {PR,"Describe the structure encroaching",ST1,1} located upon the insured premises encroaches upon the property {PR,"Enter direction of encroachment",ST1,2} and adjoining by {PR,"Enter number of feet of encroachment",IN4,3} ...

	Survey
	Survey reflecting proposed legal description of land to be insured.

	Legal
	Lot {PR,"spell out lot number",ST1,1} ({PR,"numerical lot number",ST1,2}) as designated upon the Plat of {PR,"subdivisionname",ST1,3}, being a Subdivision of part of the {PR,"quarter section etc",ST1,4} of Section {PR,"Section number",ST1,5}, in Towns...

	Plat Notes
	Notes as contained on the recorded Plat of Subdivision, for full particulars of which we refer to the public records.

	Deceased: Will No Probate
	{PR,"Name of deceased",ST1,1}, owner of the premises, died testate {PR,"Date of Death",DT2,2}, leaving a will filed with the {PR,"County Will was filed in",ST1,3} County Circuit Clerk on {PR,"Date will was filed",DT2,4}.
	In connection therewith, the following is noted:
	(A) A satisfactory table of the heirship and of the value of the estate of {RP,1}, deceased, should be furnished; and this commitment is subject to such further exceptions, if any, as may then be deemed necessary.
	(B) Expenses of administration and claims against the estate of {RP,1}, deceased.
	(C) Federal and Illinois Estate Taxes, which may be charged against said estate.
	(D) Statutory rights, powers, and duties of the personal representative of said decedent, if and when appointed.
	(E) Legacies created by the Will;
	(F) If the property is to be conveyed by devisees under the will under the Illinois Small Estate Act, it will be necessary that such grantors execute a Personal Undertaking satisfactory to ATG, a copy of which is furnished herewith.


	NLT Rockford: Requirements
	Deceased: Will No Probate Requirements
	A certified copy of the death certificate of {PR,"Name of deceased",ST1,1}.
	A satisfactory Affidavit of Heirship.
	A Statement of No Claims against the estate of {PR,"Name of deceased",ST1,1}.

	Refinance: Standard
	ALTA Statement to be signed by Borrower(s).
	If any party is required to bring in more than $2,000.00 to close this property, the funds must be in certified form.

	Survey
	Produce accurate survey reflecting proposed legal description of land to be insured.

	Corporation Resolution
	Upon a conveyance or mortgage of the land, provide a certified copy of proper resolutions, passed by the stockholders and directors of the party in title, authorizing the execution of the deed of conveyance or mortgage.
	Standard procedures applicable in open bankruptcy Case No. {PR,"insert bankruptcy case no.",ST1,1}.

	Trust
	Copy of trust showing all signators of trust and authorizing trustee to sell subject property.

	Deceased Joint Tenant
	We should be supplied with satisfactory evidence establishing the death, the testacy or intestacy, the status of tenancy at time of death, and the value of the Estate of {PR,"Insert name of deceased joint tenant",ST1,1}, deceased; and this commitment ...

	Deed: Quit Claim
	Quit Claim Deed from {DB,SellerInfo,Name1First,NO} {DB,SellerInfo,Name1MI,NO} {DB,SellerInfo,Name1Last,NO} and {DB,SellerInfo,Name2First,NO} {DB,SellerInfo,Name2MI,NO} {DB,SellerInfo,Name2Last,NO}, and spouses, if any, vesting fee simple interest of t...

	Release of Mortgage
	Payment and Release of Mortgage recorded as Document No. {PR,"Document No of mortgage to bereleased",ST1,1}.

	Taxes: To Be Paid
	{PR,"which installment or both",ST1,1} installment(s) of the {PR,"year of taxes to be paid",ST1,2} taxes must be paid in FULL.


	Requirements
	Requirements
	Issuer will require the following as conditions precedent to issuance of policy:

	Deed: Agreement for Deed
	Agreement for Deed or Memorandum by and between {DB,SellerInfo,Name1First,NO}{DB,SellerInfo,Name1MI,NO} {DB,SellerInfo,Name1Last,NO} and {DB,SellerInfo,Name2First,NO}{DB,SellerInfo,Name2MI,NO} {DB,SellerInfo,Name2Last,NO}, as contract seller(s) and {D...

	Name Search
	At the request of the applicant, we have made a search for judgments, liens, and other matters against the following named persons and find none at this date that would adversely affect title to the premises in question unless shown elsewhere herein:

	Standard
	ALTA Statement to be signed by Sellers and Buyers.
	Affidavit in Lieu of Survey to be signed by Sellers.
	If any party is required to bring in total more than $50,000.00 to close this property, the funds must be wired into our escrow account.
	If any party is required to bring in total less than $50,000.00 to close this property, the funds must be in certified form.

	New Mortgage
	Mortgage terms from {DB,BuyerInfo,Name1First,NO} {DB,BuyerInfo,Name1MI,NO} {DB,BuyerInfo,Name1Last,NO} and {DB,BuyerInfo,Name2First,NO} {DB,BuyerInfo,Name2MI,NO} {DB,BuyerInfo,Name2Last,NO}, and spouses, if any, given to {DB,Lender,Name,NO}, its succe...

	For Information Only
	For Information Only:
	Township is: {PR,"Enter Township",ST1,1}
	Lot size is: {PR,"Enter Lot size",ST1,2}
	Taxes reflect {PR,"Enter number of exemptions",IN2,3} exemptions:
	General Homestead Exemption = $6,000.00
	Home Improvement Exemption = {PR,"Enter amount of Home Improvement exemption",CU1,4}
	Citizen Homestead Exemption = $4,000.00
	Citizen Assessment Freeze = {PR,"Enter amount of senior assessment freeze",CU1,5}

	Street Address
	Commonly Known As:{DB,Property,Address,NO}{DB,Property,City,NO}, {DB,Property,State,NO} {DB,Property,Zip,NO}

	Deed: Trustee’s
	Trustee’s Deed from {PR,"Name of Trustee",ST1,1}, as Trustee under the Provisions of a Trust agreement dated {PR,"Date of trust",DT3,2}, known as {PR,"Name of Trust",ST1,3}, vesting fee simple interest of the subject property to {DB,BuyerInfo,Name1Fir...

	Deed: Warranty
	Warranty Deed from {DB,SellerInfo,Name1First,NO} {DB,SellerInfo,Name1MI,NO} {DB,SellerInfo,Name1Last,NO} and {DB,SellerInfo,Name2First,NO} {DB,SellerInfo,Name2MI,NO} {DB,SellerInfo,Name2Last,NO}, and spouses, if any, vesting fee simple interest of the...

	Deed: Executor’s
	Executor’s deed from {PR,"name of executor",ST1,1}, executor of {DB,SellerInfo,BusinessName,NO}, conveying fee simple interest of the subject property to {DB,BuyerInfo,Name1First,NO} {DB,BuyerInfo,Name1MI,NO}{DB,BuyerInfo,Name1Last,NO} and {DB,BuyerIn...

	Release of Lien
	Payment and release of lien recorded as Document No. {PR,"Document No. of lien.",ST1,1}.


	Notes for Information
	Variable Rate Mortgage Endorsement
	Variable Rate Mortgage Endorsement has been approved for issuance with the Loan Policy.

	Assumption Certificate
	An Assumption Certificate from First American Title Insurance Company has been approved for the Loan Policy.

	Assumption Certificate
	Comprehensive Endorsement has been approved for issuance with the Loan Policy. Environmental Protection Lien Endorsement has been approved for issuance with the Loan Policy. Location Endorsement has been approved for issuance with the Loan Policy.

	Notes for Information: Standard Loan Policy Endorsements
	Environmental Protection Lien (EPL) Endorsement has been approved for issuance with the Loan Policy for this transaction.
	Comprehensive Endorsement has been approved for issuance with the Loan Policy for this transaction.
	Location Endorsement has been approved for issuance with the Loan Policy for this transaction, if requested.

	Residential: Buy/Sell Endorsements
	Comprehensive Endorsement has been approved for issuance with the Loan Policy . Environmental Protection Lien Endorsement has been approved for issuance with the Loan Policy. Standard Exception Waiver Endorsement will be approved for issuance with the...

	Condominium Endorsement
	Condominium Blanket Endorsement has been approved for issuance with the Loan Policy.

	Planned Unit Development Endorsement
	Planned Unit Development Endorsement has been approved for issuance with the Loan Policy .

	Location Endorsement
	Location Endorsement has been approved for issuance with the Loan Policy.
	PERMANENT INDEX NUMBER:*
	FIRST INSTALLMENT OF THE 2002 TAXES $*.
	SECOND INSTALLMENT 2002 TAXES $*.
	2003 GENERAL REAL ESTATE TAXES ARE NOT YET DUE OR PAYABLE.


	Partnerships
	Agreement: Examination
	The partnership agreement establishing the partnership of {PR,"Enter name of Partnership.",ST1,1} together with all amendments thereto, properly identified in writing by all the partners as being the terms and provisions of the agreement under which t...

	Agreement: Terms
	Terms, provisions, and limitations of the partnership agreement for {PR,"Enter name of Partnership.",ST1,1} partnership.

	Conveyance
	Upon a conveyance or mortgage of the land, we should be supplied with satisfactory proof of compliance with the terms of the agreement governing {PR,"Enter name of Partnership.",ST1,1}, a partnership, and this Commitment is subject to such further exc...

	Rights of Partners
	Rights of {PR,"Enter names of partners in the Partnership.",ST1,1}, partners composing the firm of {PR,"Enter name of Partnership.",ST1,2}, and of all persons claiming thereunder.

	Limited Partnership: Certificate
	The public records do not disclose the existence of a Certificate of Limited Partnership for {PR,"Limited Partnership: Enter the name of the partnership:",ST1,1}.

	Limited Partnership: Partnership Act
	Unless compliance is made with the Uniform Limited Partnership Act, this Commitment and our policy, if and when issued, shall be subject to the consequences of the failure to comply with the Act.

	Wisconsin Limited Partnership Act: Limited Partnership
	Unless compliance is made with the Uniform Limited Partnership Act (Chapter 179 of the Wisconsin statues), this Commitment and our policy, if and when issued, shall be subject to the consequences of the failure to comply with the Act.


	Party Wall
	Party Wall
	Rights of adjoining property owners in and to the {PR,"Direction",ST1,1} wall of the {PR,"Improvement",ST1,2} located on the property described in Schedule A hereof.


	Plat Act
	Plat Act
	We must be furnished a recordable Plat of Subdivision or a Survey and Exemption Affidavit in compliance with the provisions of the "Plat Act", 765 ILCS 205/1, and as required by the Office of Recorder prior to being able to record any conveyance of la...


	Predatory Lending
	Predatory Lending Commitment
	Note for Information: The land lies within the area designated under the predatory lending database program (765ILCS 77/70, et seq.). A Compliance Certificate or an Exempt Certificate must be obtained from the Illinois Department of Financial and Prof...


	Probate Estates
	Standard Exceptions
	Any claims against the {DB,SellerInfo,BusinessName,SN1}, deceased.
	Federal and Illinois estate taxes, which may be charged against the {DB,SellerInfo,BusinessName,SN1}, deceased.
	Statutory rights, powers, and duties of the Executor of the {DB,SellerInfo,BusinessName,SN1}, deceased.
	Power of sale conferred upon {DB,SellerInfo,Name1First,SN1} {DB,SellerInfo,Name1MI,SN1}{DB,SellerInfo,Name1Last,SN1}, by the terms of the Will of {PR,"enter name of deceased",ST1,1}, deceased.
	Any conveyance of the land by the Executor should recite that the same is executed pursuant to the power and authority vested in said representative by the Last Will and Testament of {PR,"enter name of deceased",ST1,1}, deceased, and should recite the...


	Railroads
	Illinois Central: Rights of USA
	Right, title, and interest of the United States of America in and to any portion of the land falling within the mainline right-of-way of the Illinois Central Railroad Company pursuant to an Act of Congress approved September 20, 1850.


	Real Estate Taxes
	Current (Default for All Users)
	Taxes for the year {PR,"Enter the last year that taxes were paid (‘YYYY’).",IN1,1} and thereafter:
	First installment {PR,"Enter the previous year (‘YYYY’).",IN1,1} taxes, in the amount of {PR,"Enter amount of the 1st installment prior year taxes.",CU1,2}, is {PR,"Enter whether ‘PAID,’ ‘UNPAID AND DUE,’ ‘NOTYET DUE AND PAYABLE.’",ST1,3}. Second inst...
	Taxes for the year {PR,"Enter the current year (YYYY).",IN1,6} are not yet due and payable.
	Permanent Index No. {DB,Property,TaxID,NO}

	Forfeited
	{PR,"Enter which installment (1st, 2nd, etc.) is unpaid.",ST1,1} installment {PR,"Enter the year(YYYY) of the forfeited taxes.",IN1,2} taxes of {PR,"Enter the amount of the forfeited taxes.",CU1,3}, not paid and forfeited on {PR,"Enter the date when t...

	Sanitary Sewer District tax
	The land lies within the boundaries of the {PR,"Sanitary Sewer: Enter the name of the SanitaryDistrict:",ST1,1} Sanitary District and is subject to taxes thereunder.

	Sold
	{PR,"Enter which installment (First or Second, etc.) were sold.",ST1,1} installment {PR,"Enter the year(YYYY) of the tax sold.",IN1,2} taxes of {PR,"Enter the amount of the taxes sold.",CU1,3} not paid and sold on {PR,"Enter the date the taxes were so...

	Special Assessments: Special Service Area
	The land is located in Special Service Area Number {PR,"Enter number assigned to Special ServiceArea.",ST1,1} of the City of {PR,"Enter name of municipality.",ST1,2} and is subject to levy and assessment, therefor, as part of the general real estate t...

	Tax Deed: Tax Deed Proceedings
	With respect to the {PR,"Enter annual, forfeiture, or scavenger.",ST1,1} tax sale of the land on {PR,"Enter date of tax sale.",DT2,2}, to {PR,"Enter name(s) of person/entity purchasing taxes.",ST1,3} [by virtue of the non-payment of the * general real...
	(a) The question of the willingness of ATG to insure title derived through the tax deed proceeding should be submitted to an underwriting attorney of ATG.
	(b) A petition in conformity with the provisions of Article 22 of the Property Tax Code (35 ILCS 200/22-5, et seq.) should be filed in the Circuit Court of {PR,"Enter name of County.",ST1,4} County, Illinois, in the proceeding wherein the judgment of ...
	(c) The deed should be issued and filed for record within the time provided by Sections 22-85 and 22-90 of the Property Tax Code (35 ILCS 200/22-85, and 200/22-90).
	(d) The notices and deeds issued pursuant to the proceeding should show the legal description and, where applicable, the permanent real estate index number.
	(e) Notice should be served on the persons set forth below in accordance with sections 22-10, 22-15, 22-20, 22-25, 22-30, and 22-40 of the Property Tax Code (35 ILCS 200/22-10, 200/22-15, 200/22-20, 200/22-25,200/22-30, and 200/22-40), in the manner a...
	(1) Any person, other than those herein named, known to the certificate holder or his or her attorney who may have, or claim to have, some interest in the land.
	(2) Unknown owners or parties interested in the land, generally.
	(3) The County Clerk of {RP,4} County, Illinois.
	(4) All persons in occupancy or actual possession of said land, which persons must be served personally.
	(5) {PR,"Enter name(s) of person holding Certificate of Sale.",ST1,5}, Certificate of Sale holder, as party plaintiff.
	(6) {PR,"Enter name(s) of owners of record, successors, etc.", ST1,6}, owner(s) of record, contract purchaser(s), etc., or successors in interest, as party (ies) defendant.
	(7) {PR,"Enter name(s) of mortgagees, creditors, lienholders, etc.",ST1,7}, mortgagees, judgment creditors, lienholders, etc., by reason of Exception No(s). *.
	(8) The United States of America by reason of Exception No. *. NOTE: Compliance should be made with the provisions of Section 2410 of the Federal Judicial Code (28 U.S.C.) and Section 7425 of the Internal Revenue Code (26 U.S.C.) In connection therewi...
	The Notice of Tax Lien, noted at Exception No. *, was filed by the District Director of Internal Revenue at *, Illinois, against *, in the office of the Recorder of Deeds of * County, Illinois, on *, as Document No. *.
	NOTE: Attention is directed to the provisions in Section 2410 of the Federal Judicial Code requiring that any action to foreclose a lien naming the United States as a party under the Section "must seek a judicial sale." In the event a judicial sale is...
	[(9) The trustee in bankruptcy by reason of Exception No. *.]
	[(10) The right of redemption of the United States of America.]
	[(11) The right of redemption of the State of Illinois.]
	The real estate was last assessed for general real estate taxes to the following taxpayer: *.
	The proceedings will not affect the Standard Exceptions nor the exceptions noted in Schedule B at Nos. *, and the final policy or policies will be subject to such exceptions unless satisfactory disposition thereof is otherwise made.

	Tax Sale: Tax Deed Judgment
	We have examined the proceedings pending in the Circuit Court of {PR,"Enter name of County.",ST1,1} County, Illinois, in Case No. {PR,"Enter court case number.",ST1,2}, on a petition for tax deed pursuant to a tax sale of the land under the provisions...
	(a) The question of the willingness of ATG to insure title derived through the said proceedings should be submitted to an underwriting attorney of ATG, and this commitment, and any policies committed for thereunder, shall be subject to such further ex...
	(b) Right of any interested party by motion, appeal, petition, or other direct proceeding to have modified, set aside, or reversed the orders entered in Case No. {RP,2}, within the time allowed by law.
	(c) Right, by reason of military service, of any person interested in the subject matter of the proceedings in Case No.{RP,2} to redeem within the time permitted by the Soldiers’ and Sailors’ Civil Relief Act.

	Current (Wisconsin)
	The lien of taxes for the year {PR,"Enter Year",IN1,6} and thereafter.
	Parcel Identification Number: {DB,Property,TaxID,NO} Year {PR,"Enter Year",IN1,6} taxes of {PR,"Enter tax amount",CU1,4} are {PR,"Enter status of tax payment (paid in full, not paid, etc.)",ST1,8} {PR,"Enter Year",IN1,6} general real estate taxes are ...
	Remarks: {PR,"Enter any appropriate remarks or none",ST1,7}

	Tax Deed: Tax Deed Proceedings (Wisconsin)
	With respect to the {PR,"Enter annual, forfeiture, or scavenger.",ST1,1} tax sale of the land on {PR,"Enter date of tax sale.",DT2,2}, to {PR,"Enter name(s) of person/entity purchasing taxes.",ST1,3} [by virtue of the non-payment of the * general real...
	(a) The question of the willingness of ATG to insure title derived through the tax deed proceeding should be submitted to an underwriting attorney of ATG.
	(b) A petition in conformity with the provisions of Wisconsin Property Tax Code should be filed in the Circuit Court of {PR,"Enter name of County.",ST1,4} County, Wisconsin, in the proceeding wherein the judgment of sale was entered, and, after due no...
	(c) The deed should be issued and filed for record within the time provided by the Property Tax Code.
	(d) The notices and deeds issued pursuant to the proceeding should show the legal description and, where applicable, the permanent real estate index number.
	(e) Notice should be served on the persons set forth below in accordance with the Property Tax Code in the manner and within the time specified therein. NOTE: In the event that there are any persons who should be served with notices, but the names of ...
	(1) Any person, other than those herein named, known to the certificate holder or his or her attorney who may have or claim to have some interest in the land.
	(2) Unknown owners or parties interested in the land, generally.
	(3) The County Clerk of {RP,4} County, Wisconsin.
	(4) All persons in occupancy or actual possession of said land, which persons must be served personally.
	(5) {PR,"Enter name(s) of person holding Certificate of Sale.",ST1,5}, Certificate of Sale holder, as party plaintiff.
	(6) {PR,"Enter name(s) of owners of record, successors, etc.",ST1,6}, owner(s) of record, contract purchaser(s), etc. or successors in interest, as party(ies) defendant.
	(7) {PR,"Enter name(s) of mortgagees, creditors, lienholders, etc.",ST1,7}, mortgagees, judgment creditors, lienholders, etc., by reason of Exception No(s). *.
	(8) The United States of America by reason of Exception No. *. NOTE: Compliance should be made with the provisions of Section 2410 of the Federal Judicial Code (28 U.S.C.) and Section 7425 of the Internal Revenue Code (26 U.S.C.) In connection therewi...
	The Notice of Tax Lien noted at Exception No. * was filed by the District Director of Internal Revenue at *, Wisconsin, against * in the office of the Register of Deeds of * County, Wisconsin *, as Document No. *.
	NOTE: Attention is directed to the provisions in Section 2410 of the Federal Judicial Code requiring that any action to foreclose a lien naming the United States as a party under the Section "… must seek a judicial sale." In the event a judicial sale ...
	[(9) The trustee in bankruptcy by reason of Exception No. *.]
	[(10) The right of redemption of the United States of America.]
	[(11) The right of redemption of the State of Wisconsin.]
	The real estate was last assessed for general real estate taxes to the following taxpayer: *.
	The proceedings will not affect the Standard Exceptions nor the exceptions noted in Schedule B at Nos. *, and the final policy or policies will be subject to such exceptions unless satisfactory disposition thereof is otherwise made.

	Tax Sale: Tax Deed Judgment (Wisconsin)
	We have examined the proceedings pending in the Circuit Court of {PR,"Enter name of County.",ST1,1} County, Wisconsin, in Case No. {PR,"Enter court case number.",ST1,2}, on a petition for tax deed pursuant to a tax sale of the land under the provision...
	(a) The question of the willingness of ATG to insure title derived through the said proceedings should be submitted to an underwriting attorney of ATG, and this commitment, and any policies committed for thereunder, shall be subject to such further ex...
	(b) Right of any interested party by motion, appeal, petition, or other direct proceeding to have modified, set aside, or reversed the orders entered in Case No. {RP,2}, within the time allowed by law.
	(c) Right, by reason of military service, of any person interested in the subject matter of the proceedings in Case No.{RP,2} to redeem within the time permitted by the Soldiers’ and Sailors’ Civil Relief Act.

	Lake County, Indiana
	The real estate tax information set out above is all that is currently available. As of May 7, 2004, the Lake Superior Court ruled the tax reassessment unconstitutional. This ruling is currently under appeal to the Indiana Supreme Court. ATG is not li...

	Lottery Tax Credit (Wisconsin)
	Any possible charge for reassessment of taxes pursuant to the Lottery Tax Credit.

	Rock Island
	Subject to the lien of any additional taxes for the year 2002 and thereafter, resulting from construction of new or additional improvements in such year, which are assessed in a subsequent year and added to a subsequent year’s tax bill.

	Rock Island County
	Taxes for the year {PR,"Enter the year which taxes are a lien",ST1,1} and thereafter:
	First Installment {PR,"Enter tax lien year here",ST1,2} taxes, in the amount of {PR,"Amount of FirstInstallment",CU1,3}, is {PR,"Enter tax status (i.e., Paid, Sold, Not Yet Due and Payable, ",ST1,4}.Second Installment {PR,"Enter tax lien year here",ST...
	Taxes for the year {PR,"Enter current year",ST1,8} are not yet due and payable.
	Permanent Index No: {DB,Property,TaxID,NO}


	Real Title
	Easements/Covenants/Utilities
	Subject to all Easements, Conditions, and Restrictions of Record.
	Terms, provisions, covenants, conditions and restrictions, easements, charges, assessments and liens provided in the Covenants, Conditions, and Restrictions Indenture, if any, attached to the Plat and made a part thereof, but omitting any Covenant, Co...


	Refinance/Select Service
	Real Estate Taxes: Cook
	Note: Tax Payments should be made payable to: Cook County Collector, 118 North Clark Street, Room 112, Chicago, Illinois 60602; Phone 312-443-5100.

	Real Estate Taxes: DuPage
	Note: Tax Payments should be made payable to: DuPage County Collector, 421 North County Farm Road, P.O. Box 787, Wheaton, Illinois 60189; Phone 630-682-7001; Due 6/1 & 9/1.

	Real Estate Taxes: Lake
	Note: Tax Payments should be made payable to: Lake County Collector, 18 North County Street, Waukegan, Illinois 60085; Phone 847-360-6363; Due 6/1 & 9/1.

	Real Estate Taxes: Kane
	Note: Tax Payments should be made payable to: Kane County Collector, 719 South Batavia Avenue, Geneva, Illinois 60134; Phone 630-232-3565; Due 6/1 & 9/1.

	Real Estate Taxes: McHenry
	Note: Tax Payments should be made payable to: McHenry County Collector, 2200 North Seminary Avenue, Woodstock, Illinois 60098; Phone 815-334-4260; Due 6/1 & 9/1.

	Real Estate Taxes: Will
	Note: Tax Payments should be made payable to: Will County Treasurer, 302 North Chicago Street, Joliet, Illinois 60432; Phone 815-740-4675; Due 6/1 & 9/1.

	Refinance
	Rights and interest of the spouse, if any, of title holder or person(s) taking title named in Schedule "A."
	Note: The present marital status of grantors herein named must be disclosed in any subsequent deed of conveyance and/or mortgage ATG is asked to insure, and their spouses, if any, must join in the execution of said instruments in order to release any ...
	All parties in title or taking title must execute the mortgage ATG is being asked to insure. If all parties in title do not execute said mortgage, the lender will take subject to any ownership interest of the non-executing party in title.
	Subject to any unrecorded easements, covenants, conditions, or restrictions, as well as any building line restrictions not of record.
	Note: This exception will be waived by either of the following:
	(a) copy of an existing survey with an affidavit of no new improvements, which shall be submitted to ATG;
	(b) Affidavit in Lieu of Survey, which shall be submitted to ATG. If neither is submitted to ATG, this exception will not be waived and will remain on the final title policy.


	Sanitary District
	Urbana & Champaign Sanitary District
	Subject property lies within the boundaries of the Urbana & Champaign Sanitary District, the City of {PR,"Cityof/Drainage District",ST1,1}, and is subject to all lawful orders issued and assessments levied in connection therewith.


	Search
	Certificate of Sale (Wisconsin)
	Right, title, and interest of {PR,"Enter name of purchaser.",ST1,1} under a certificate of sale dated {PR,"Insert date of certificate of sale.",DT2,2}, and recorded {PR,"Insert date of recording.",DT2,3}, as Document No. {PR,"Insert Document number.",...

	Dedicated Road (Wisconsin)
	Rights of the public, the State of Wisconsin, and the municipality in and to so much of the land dedicated for road purposes by instrument dated {PR,"Insert date of document.",DT2,1}, and recorded {PR,"Insert date of recording.",DT2,2}, as Document No...

	Environmental Disclosure Document (Wisconsin)
	Environmental disclosure document for transfer of real property dated {PR,"Enter date environmental document was created.",DT2,1}, and recorded {PR,"Enter date environmental document was recorded.",DT2,2}, as Document No. {PR,"Enter environmental Docu...

	Environmental Lien (Wisconsin)
	Environmental lien filed by {PR,"Enter name of entity filing the environmental lien.",ST1,1} against {PR,"Enter name of entity that environmental lien was filed against.",ST1,2} on {PR,"Enter date that environmental lien was filed.",DT2,3}, as Documen...

	Lien: Child Support (Wisconsin)
	Child support judgment filed against {PR,"Insert name of person(s) who received judgment here.",ST1,1}, in Case No. {PR,"Insert Case number here.",ST1,2}, in the Circuit Court of {PR,"Insert name of Countyhere.",ST1,3} County, Wisconsin, memorandum of...

	Lien: Mechanics’ (Wisconsin)
	Mechanics’ lien filed by {PR,"Insert name of person or company filing the lien here.",ST1,1} against {PR,"Insert the person(s) against whom the lien was filed here.",ST1,2} on {PR,"Insert the date the lien was filed here.",DT2,3}, as Document Number {...

	Lis Pendens (Wisconsin)
	Lis Pendens Notice dated {PR,"Insert date of lis pendens here.",DT2,1}, filed by {PR,"Insert name of person (s) filing the lis pendens here.",ST1,2} against {PR,"Insert name(s) of persons receiving the lis pendens here.",ST1,3} in Case No. {PR,"Insert...

	Taxes: Real Estate (Wisconsin)
	The lien of taxes for the year {PR,"Insert current year",IN1,3} and thereafter. Year {PR,"Enter prior year",IN1,4} taxes of {PR,"Enter amount",CU1,5} are {PR,"PAID, UNPAID & DUE, NOT YET DUE & PAYABLE",ST1,6}. Year {PR,"Enter current year",IN1,7} are ...
	PIN No. {PR,"Enter PIN number for property",ST1,7}
	Commonly known as {PR,"Enter street address, city, state, and zip code for property.",ST1,8}

	Release Mortgage
	Release of Mortgage recorded {PR,"Enter Date Release Recorded",DT2,3} as Document No. {PR,"Enter the document number of the recorded release.",ST1,6} releasing the Mortgage recorded as Document No. {PR,"Enter the document number of the recorded mortga...

	Release Lien
	Release of Lien recorded {PR,"Enter Date Release Recorded",DT2,3} as Document No. {PR,"Enter the document number of the recorded release.",ST1,6} releasing the Lien recorded as Document No. {PR,"Enter the document number of the recorded lien.",ST1,6}.

	Release Judgment
	Release of Judgment recorded {PR,"Enter Date Release Recorded",DT2,3} as Document No. {PR,"Enter the document number of the recorded release.",ST1,6} releasing the Judgment recorded as Document No. {PR,"Enter the document number of the recorded judgme...

	Later Date
	THE LATER DATE COVERS THE TIME PERIOD FROM {DB,CommitPolicy,CmtEdate,DT2}, TO {PR,"NEW EFFECTIVE DATE",DT2,2}. THE FOLLOWING INFORMATION APPEARS OF RECORD SUBSEQUENT TO THE ORIGINAL EFFECTIVE DATE OF THIS SEARCH.

	Taxes down
	ST. CLAIR COUNTY TAX INFORMATION SYSTEM CANNOT BE ACCESSED BECAUSE THEY ARE DOWNLOADING 2009 TAX INFORMATION. AS SOON AS THE SYTEM BECOMES AVAILABLE, WE WILL REVISE OUR SEARCH TO INCLUDE TAX INFORMATION.

	Release
	Release of Mortgage/Lien recorded {PR,"Enter Date Release Recorded",DT2,3}, as Document No. {PR,"Enter the document number of the recorded release.",ST1,6}, releasing the Mortgage/Lien recorded as Document No. {PR,"Enter the document number of the rec...

	Affidavit: General
	Affidavit of {PR,"Describe what kind of affidavit this is.",ST1,1} dated {PR,"What date was the affidavit executed?",DT2,2} and recorded on {PR,"What date was the affidavit recorded?",DT2,3}.

	Agreement: General
	Agreement for {PR,"What is the agreement for?",ST1,1} dated {PR,"What is the date of the agreement?",DT2,2}, and recorded {PR,"What is the date the agreement was recorded?",DT2,3}, as Document No. {PR,"What is the document number of the agreement?",ST...

	Assignment of Rents
	Certificate of Sale
	Right, title, and interest of {PR,"Enter name of purchaser.",ST1,1} under a certificate of sale dated {PR,"Insert date of certificate of sale.",DT2,2}, and recorded {PR,"Insert date of recording.",DT2,3}, as Document No. {PR,"Insert Document number.",...

	Condominium Declaration
	Terms, provisions, covenants, conditions, and options in, rights and easements established by the Declaration of Condominium Ownership recorded {PR,"Enter date of Condominium Declaration recording.",DT2,1}, as Document No. {PR,"Enter Document number."...

	Declaration
	Declaration of {PR,"What type of declaration is this?",ST1,1} dated {PR,"What is the date of thedeclaration?",DT2,2}, and recorded {PR,"What is the date the declaration was recorded?",DT2,3}, as Document No. {PR,"What is the Document Number of the dec...

	Dedicated Road
	Rights of the public, the State of Illinois, and the municipality in and to so much of the land dedicated for road purposes by instrument dated {PR,"Insert date of document.",DT2,1}, and recorded {PR,"Insert date of recording.",DT2,2} as Document No. ...

	Deed into Trust without Powers
	The deed from {PR,"Enter name(s) of person giving deed.",ST1,1} to {PR,"Enter name(s) of person receiving deed.",ST1,2}, recorded {PR,"Enter date the deed was recorded.",DT2,3}, as Document No. {PR,"Enter recorded Document number of deed.",ST1,4}, doe...

	Deed of Conveyance
	{PR,"Enter type of Deed (Warranty, Quitclaim, etc.).",ST1,6} Deed dated {PR,"Enter date ofDeed.",DT2,1}, and recorded {PR,"Enter date the Deed was recorded.",DT2,2}, as Document No. {PR,"Enter recorded Document number.",ST1,5}, executed by {PR,"Enter ...

	Deregistration
	Certificate of Deregistration dated {PR,"What was the date of the certificate of deregistration?",DT2,1}, and recorded {PR,"What is the date the certificate of deregistration was recorded?",DT2,2}, as Document No. {PR,"What is the document number of t...

	Disabled Adult Case
	Proceedings pending in the Circuit Court of {PR,"Enter name of County.",ST1,1} County entitled Estate of {PR,"Enter name of disabled adult.",ST1,2}, a disabled adult, under Case No. {PR,"Enter Case number.",ST1,3}.

	Dissolution of Marriage Case
	Dissolution of marriage proceedings filed by {PR,"Insert name of Plaintiff here.",ST1,1} against
	{PR,"Insert name of Defendant here.",ST1,2} in the Circuit Court of {PR,"Insert name of County here.",ST1,3} County as Case No. {PR,"Insert Case number here.",ST1,4}.

	Easement
	Easement for {PR,"Enter the purpose of the easement.",ST1,1} as set forth in {PR,"Describe the document creating the easement.",ST1,2}, dated {PR,"Enter the date of the easement.",DT2,3}, and recorded {PR,"Enter the date the easement was recorded.",DT...

	Environmental Disclosure Document
	Environmental disclosure document for transfer of real property, dated {PR,"Enter date environmental document was created.",DT2,1}, and recorded {PR,"Enter date environmental document was recorded.",DT2,2}, as Document No. {PR,"Enter environmental Doc...

	Environmental Lien
	Environmental lien filed by {PR,"Enter name of entity filing the environmental lien.",ST1,1} against {PR,"Enter name of entity that environmental lien was filed against.",ST1,2} on {PR,"Enter date that environmental lien was filed.",DT2,3}, as Documen...

	Flood Document
	Possible flood risks affecting the land and other land as disclosed by {PR,"Enter what type of recorded document is being reviewed.",ST1,1}, recorded {PR,"Enter date Document was recorded.",DT2,2}, as Document No. {PR,"Enter recorded Document number."...

	Grant: General
	Grant of {PR,"What type of grant is this? Access? Easement? Etc.",ST1,1}, dated {PR,"What is the date of the grant?",DT2,2}, and recorded {PR,"When was the grant recorded?",DT2,3}, as Document No. {PR,"What is the document number of the grant?",ST1,4}.

	Installment Contract for Deed
	Terms, conditions and covenants of installment contract (or agreement for Warranty Deed) between {PR,"Enter name of Installment Contract Seller(s).",ST1,1} and {PR,"Enter name(s) of Installment ContractPurchaser.",ST1,2} dated {PR,"Enter date of Insta...

	Lien: Chicago Transfer Tax
	Notice of lien claimed by the City of Chicago under the provisions of Section 3-33-120 of the Municipal Code against {PR,"Insert name of person(s) who owe the money.",ST1,1} in the sum of {PR,"Insert how much money they owe.",CU1,2}, which notice was ...

	Lien: Child Support
	Child support judgment filed against {PR,"Insert name of person(s) who received judgment here.",ST1,1} in Case No. {PR,"Insert Case number here.",ST1,2}, in the Circuit Court of {PR,"Insert name of County here.",ST1,3} County, Illinois, a memorandum o...

	Lien: Federal
	Notice of lien claimed by the United States of America against {PR,"Insert name of person(s) who owes the money.",ST1,1} in the sum of {PR,"Insert how much money they owe.",CU1,2}, which notice was recorded {PR,"Insert date the lien was recorded.",DT2...

	Lien: General
	Claim for lien, dated {PR,"Insert date of lien here.",DT2,1}, and recorded {PR,"Insert date the lien was recorded here.",DT2,2}, as Document Number {PR,"Enter recorded document number.",ST1,6} made by {PR,"Insert name of person(s) asserting lien here....

	Lien: Judgment
	[Transcript][Certified copy][Memorandum] of judgment, recorded on {PR,"Insert date judgment was recorded here.",DT2,1}, as Document No. {PR,"Insert Document number here.",ST1,2}, for judgment rendered on {PR,"Insert date of judgment here.",DT2,5} in t...

	Lien: Mechanics’
	Mechanics’ lien filed by {PR,"Insert name of person or company filing the lien here.",ST1,1} against {PR,"Insert the person(s) against whom the lien was filed here.",ST1,2} on {PR,"Insert the date the lien was filed here.",DT2,3}, and recorded {PR,"In...

	Lien: Mobile Home Tax
	Notice of Lien claimed by the County of {PR,"Enter name of County claiming the lien.",ST1,1} under the provisions of the Mobile Home Local Services Tax Act against {PR,"Enter name(s) of person who owes themoney.",ST1,2} in the sum of {PR,"Enter amount...

	Lien: Public Aid
	Notice of Lien claimed by the State of Illinois under the provisions of the Public Aid Code against {PR,"Insert name(s) of person who owes the money.",ST1,1}, in the sum of {PR,"Enter the amount of money they owe.",CU1,2}, which notice was recorded {P...

	Lien: State Income Tax
	Notice of lien claimed by the State of Illinois under the provisions of the Illinois Income Tax Act against {PR,"Insert name(s) of person who owes the money.",ST1,1}, in the sum of {PR,"Insert amount of money they owe.",CU1,2}, which notice was record...

	Lien: State Sales Tax
	Notice of Lien claimed by the State of Illinois under the provisions of the Retailer’s Occupation Tax Act against {PR,"Enter name(s) of person who owes the money.",ST1,1}, in the sum of {PR,"Enter the amount of money they owe.",CU1,2}, which Notice wa...

	Lis Pendens
	Lis Pendens Notice, dated {PR,"Insert date of lis pendens here.",DT2,1}, filed by {PR,"Insert name of person(s) filing the lis pendens here.",ST1,2} against {PR,"Insert name(s) of persons receiving the lis pendens here.",ST1,3}, in Case No. {PR,"Inser...

	Minor’s Estate Case
	Proceedings pending in the Circuit Court of {PR,"Enter name of County.",ST1,1} County entitled Estate of {PR,"Enter name of minor.",ST1,2}, a minor, under Case No. {PR,"Enter minor’s case number.",ST1,3}.

	Mortgage
	Mortgage, dated {PR,"Enter date of mortgage.",DT2,7}, and recorded {PR,"Date mortgage recorded",DT2,6}, as Document No. {PR,"Enter recorded mortgage document number.",ST1,6}, executed by {PR,"Enter name(s) of borrower(s).",ST1,4} and given to {PR,"Ent...

	Mortgage: Assignment
	Assignment of the Mortgage, recorded as Document No. {PR,"Enter the recorded document number of the assigned mortgage.",ST1,6}, by {PR,"Enter name of original lender.",ST1,2} to {PR,"Enter name of Assignee, i.e., the new lender.",ST1,3}, dated {PR,"En...

	Plat of Subdivision
	Plat of {DB,Subdivision,Subdivision,NO} Subdivision, recorded {DB,Subdivision,FileDate,DT2}, as Document No. {DB,Subdivision,Plat,NO}.

	Power of Attorney
	Power of Attorney, dated {PR,"What was the date the POA was executed?",DT2,1}, and recorded {PR,"What was the date the POA was recorded?",DT2,2}, as Document No. {PR,"What was the POA document number?",ST1,3}.

	Probate Estate
	Proceedings pending in the Circuit Court of {PR,"Enter name of County.",ST1,1} County, entitled Estate of {PR,"Enter name of deceased person.",ST1,2}, Deceased, under Case No. {PR,"Enter case number.",ST1,3}.

	Real Estate Taxes
	Taxes for the year {PR,"Enter the previous year (YYYY).",IN1,1} and thereafter. First installment {RP,1} taxes, in the amount of {PR,"Enter amount of the 1st installment prior year taxes.",CU1,2}, are {PR,"Enter whether PAID, UNPAID & DUE, NOT YET DUE...
	{PR,"Enter the current year (YYYY).",IN1,6} taxes not yet due and payable.
	PIN No. {PR,"Enter PIN number for property",ST1,7}.

	Rerecording
	Rerecording of {PR,"What kind of document is being rerecorded? ",ST1,1}, originally recorded on {PR,"When was the document originally recorded?",DT2,2}, as Document No. {PR,"What is the Document Number of the original recording?",ST1,3}, rerecorded on...

	Sheriff’s Deed
	Right, title, and interest of {PR,"Enter name of person receiving deed.",ST1,1} under a Sheriff’s (Judge’s) Deed dated {PR,"Enter date of deed.",DT2,2}, and recorded {PR,"Enter date deed was recorded.",DT2,3}, as Document No. {PR,"Enter Document numbe...

	Special Assessments: None
	Special Assessments: None of Record.

	Special Assessments: Specific
	Special Assessments: {PR,"Type Special Assessment Information",ST1,1}.

	Subdivision Covenants
	Covenants, conditions, and restrictions contained in {PR,"Describe the type of document.",ST1,1}, dated {PR,"Enter date of covenants.",DT2,2}, and recorded {PR,"Enter recording date.",DT2,3}, as Document No. {PR,"Enter Document number.",ST1,6}, but om...

	Subordination Agreement
	Subordination Agreement, dated {PR,"Insert date of subordination agreement here.",DT2,1}, and recorded {PR,"Insert date the subordination agreement was recorded here.",DT2,2}, as Document No. {PR,"Insert Document number here.",ST1,5}, made by {PR,"Ins...

	Taxes: Forfeited
	{PR,"Enter which installment (1st, 2nd, etc.) is unpaid.",ST1,1} installment {PR,"Enter the year(YYYY) of the forfeited taxes.",IN1,2} taxes of {PR,"Enter the amount of the forfeited taxes.",CU1,3}, not paid and forfeited on {PR,"Enter the date when t...

	Taxes: Real Estate
	Taxes for the year {PR,"Enter the previous year (YYYY).",IN1,1} and thereafter. First installment {RP,1} taxes, in the amount of {PR,"Enter amount of the 1st installment prior year taxes.",CU1,2}, are {PR,"Enter whether PAID, UNPAID & DUE, NOT YET DUE...
	{PR,"Enter the current year (YYYY).",IN1,6} taxes not yet due and payable.
	PIN No. {PR,"Enter PIN number for property",ST1,7}
	Commonly known as {PR,"Enter street address, city, state, and zip code for property.",ST1,8}

	Taxes: Sold
	{PR,"Enter which installment (1st, 2nd, etc.) were sold.",ST1,1} installment {PR,"Enter the year(YYYY) of the tax sold.",IN1,2} taxes of {PR,"Enter the amount of the taxes sold.",CU1,3} not paid and sold on {PR,"Enter the date the taxes were sold.",DT...

	Township: General
	The property is located in {PR,"What is the name of the township this property is located in?",ST1,1}

	Trust Deed
	Trust Deed, dated {PR,"Enter date of Trust Deed.",DT2,1}, and recorded {PR,"Enter date the Trust Deed was recorded.",DT2,2}, as Document No. {PR,"Enter recorded Document number.",ST1,5}, executed by {PR,"Enter name(s) of person granting the Trust Deed...

	UCC Financing Statement
	Financing Statement (UCC-1), dated {PR,"Enter date of UCC statement.",DT2,1}, and recorded {PR,"Enter date the UCC statement was recorded.",DT2,2}, as Document No. {PR,"Enter recorded Document number of the UCC statement.",ST1,3}, made by {PR,"Enter n...

	Vacated Streets and Alleys
	Reservation of easement contained in the ordinance of vacation, dated {PR,"Enter date of vacating ordinance.",DT2,1}, and recorded {PR,"Enter date vacating ordinance was recorded.",DT2,2}, as Document No. {PR,"Enter recorded Document number of vacatin...

	Wild Deed
	{PR,"Enter name of recipient of wild deed.",ST1,1} obtained title by mesne (intervening) conveyances from {PR,"Enter name of grantor in wild deed.",ST1,2}. We find no title in {RP,2}. This should be explained, and this commitment, and any policies com...
	2005 Tax Information
	2005 Warrant Books are unavailable at this time; therefore, we cannot get updated 2005 tax information until further notice!

	Taxes: (Later Date)
	Taxes for the year {PR,"Enter the last year that taxes were paid (‘YYYY’).",IN1,1} and thereafter:
	First installment {PR,"Enter the previous year (‘YYYY’).",IN1,1} taxes, in the amount of {PR,"Enter amount of the 1st installment prior year taxes.",CU1,2}, is {PR,"Enter whether ‘PAID,’ ‘UNPAID AND DUE,’ ‘NOTYET DUE AND PAYABLE.’",ST1,3}. Second inst...
	Taxes for the year {PR,"Enter the current year (YYYY).",IN1,6} are not yet due and payable.
	Permanent Index No. {DB,Property,TaxID,SN1}
	EXEMPTIONS: {PR,"Enter Type of Exemption & Amount",ST1,6}

	Taxes: Five Years (Madison)
	Taxes for the year {PR,"Enter the last year that taxes were paid (‘YYYY’).",IN1,1} and thereafter:
	First installment 2009 taxes, in the amount of {PR,"Enter the amount of 1st installment of tax",CU1,2}, is {PR,"PAID, UNPAID AND DUE 07/07/2010, OR SOLD",ST1,3}.Second installment 2009 taxes, in the amount of {PR,"Enter the amount of 2nd installment o...
	Taxes for the year 2008, in the amount of {PR,"Enter the 2008 tax amount",CU1,10}, are {PR,"PAID, SOLD OR REDEEMED AND DATE",ST1,11}. Taxes for the year 2007, in the amount of {PR,"Enter the 2007 tax amount",CU1,12}, are {PR,"PAID, SOLD OR REDEEMED AN...
	Taxes for the year {PR,"Enter the current year",ST1,18} are not yet due and payable.
	Permanent Index No. {DB,Property,TaxID,SN1}
	EXEMPTIONS: {PR,"Enter the exemptions on the property",ST1,19}.
	TOWNSHIP: {PR,"Enter the Township",ST1,20}
	LOT SIZE/ACREAGE: {PR,"Enter the lot size or acreage",ST1,21}
	ACCESS: {PR,"Enter the access street or road",ST1,22}

	Taxes: Madison Later Date
	Taxes for the year {PR,"Enter the last year that taxes were paid (‘YYYY’).",IN1,1} and thereafter:
	First installment 2008 taxes, in the amount of {PR,"Enter the amount of 1st installment of tax",CU1,2}, is {PR,"PAID, UNPAID AND DUE 08/06/2009, OR SOLD",ST1,3}. Second installment 2008 taxes, in the amount of {PR,"Enter the amount of 2nd installment ...
	Taxes for the year {PR,"Enter the current year",ST1,10} are not yet due and payable.
	Permanent Index No. {DB,Property,TaxID,SN1}
	EXEMPTIONS: {PR,"Enter the exemptions on the property",ST1,11}

	Letter Report (Effective Date)
	{PR,"Enter name of title company issuing letter teport",ST1,1}, has made a thorough search of the records at the courthouse of {PR,"Type County Name",ST1,2} County, as of {PR,"Type Effective Date of Search",DT2,3}, and we find the following:
	The vested owner(s) of the property is (are) {PR,"Type Name(s) of Vested Owner(s)",ST1,4}.

	Letter Report (Taxes/Assessments)
	The {PR,"Enter the last year the taxes were paid",IN1,1} tax, in the amount of {PR,"Enter full amount of taxes",CU1,2}, is {PR,"Enter ‘PAID’, ‘UNPAID AND DUE’, ‘SOLD’, ‘REDEEMED’",ST1,3}. All previous taxes have been paid.
	There are no special assessments showing open for the property referred to herein.

	Letter Report (Closing)
	This is a copy of our limited search of this title. This is not a title insurance commitment. Our liability for error is limited to the fee paid herefor.


	Streets/Alleys
	Ordinance of Vacation
	Reservation of easement contained in the ordinance of vacation, dated {PR,"Enter date of vacating ordinance.",DT2,1}, and recorded {PR,"Enter date vacating ordinance was recorded.",DT2,2}, as Document No. {PR,"Enter recorded Document number of vacatin...

	Rights of Public
	Rights of the State of Illinois, the municipality, the public, and the adjoining landowners in and to the vacated {PR,"Enter ‘street’ or ‘alley’.",ST1,1} lying {PR,"Enter direction (North, South, etc.) of vacated alley/street.",ST1,2} and adjoining th...

	Not Insured: Vacated Parcel
	This commitment, and any policy issued thereunder, shall not be construed as insuring any part of the vacated {PR,"Enter ‘street’ or ‘alley as appropriate.",ST1,1} lying {PR,"Enter direction (North, South, etc.) of the vacated land.",ST1,2} and adjoin...

	Rights of Utilities
	Rights of public and quasi-public utilities, if any, in the vacated {PR,"Enter ‘street’ or ‘alley’ as the vacated land.",ST1,1} lying {PR,"Enter direction (North, South, etc.) of the vacated land.",ST1,2} and adjoining the insured land for the mainten...

	Roads and Highways
	Rights of the public, the State of {DB,Property,State,NO}, the municipality, the county, and the township in and to that part of the premises in question taken, used, or dedicated for roads, streets, alleys, or highways.

	Rights of Public (Wisconsin)
	Rights of the State of Wisconsin, the municipality, the public, and the adjoining landowners in and to the vacated {PR,"Enter ‘street’ or ‘alley’.",ST1,1} lying {PR,"Enter direction (North, South, etc.) of vacated alley/street.",ST1,2} and adjoining t...


	Subdivisions
	Building Setback
	A {PR,"Enter number of feet of size of setback.",ST1,1} foot building line from the {PR,"Enter direction (North, South, etc.) of the setback.",ST1,2} line of the property as shown on the Plat and recorded {PR,"Enter date of recording of Plat.",DT2,3} ...

	Covenants and Restrictions
	Covenants, conditions, and restrictions contained in {PR,"Describe the type of document.",ST1,1}, dated {PR,"Enter date of covenants.",DT2,2}, and recorded {PR,"Enter recording date.",DT2,3}, as Document No. {PR,"Enter Document number.",ST1,6}, but om...

	Covenants: Restrictions – Forfeiture
	NOTE: Instrument contains a provision for forfeiture or reversion of title in the event of breach thereof.

	Covenants: Restrictions – No Forfeiture
	NOTE: Instrument contains no provision for forfeiture or reversion of title in the event of breach thereof.

	Public Utility: General
	Easement over and upon the {PR,"Enter direction (North, South, etc.) of the easement.",ST1,1} {PR,"Enter number of feet of easement width onto land.",ST1,2} feet of the land for public utilities and drainage as shown on the Plat and recorded {PR,"Ente...

	Public Utility: Specific
	Easement over the {PR,"Enter the direction (North, South, etc.) of the easement.",ST1,1}{PR,"Enter the number of feet of the easement.",ST1,2} feet of the land for the purpose of installing and maintaining all equipment necessary for the purpose of se...


	Survey
	Exceptions
	This company should be furnished a survey of the premises insured and this commitment is subject to such other matters as may then appear.
	Facts that an accurate survey or personal inspection of the property disclosed or would have disclosed.

	Easements
	Easements, or claims of easements, not shown by the Public Records.
	Survey Exception: Policy
	Encroachments, overlaps, boundary line disputes, and any matters that would be disclosed by an accurate survey and inspection of the premises.

	Survey Exception: Commitment
	The company should be furnished a survey of the premises to be insured and this commitment is subject to such matters as may be disclosed.

	Standard Exceptions 1-3
	Rights or claims of parties in possession not shown by the Public Records.
	Any encroachment, encumbrance, violation, or adverse circumstance affecting the Title that would be disclosed by an accurate and complete land survey of the Land. The term "encroachment" includes encroachments of existing improvements located on the L...
	Easements, or claims of easements, not shown by the Public Records.


	Trusts
	Land Trust
	Terms, powers, provisions, and limitations of the trust under which title to the property is held.

	Living Trusts
	A properly certified copy of the original trust agreement, under which title to the land is held, together with a statement in writing by the trustee that it will produce the original agreement upon request, should be furnished, and this commitment is...
	ATG should be advised as to whether the trust under which title to the land is held is still in force and effect, and this commitment is subject to such further exceptions, if any, as may be deemed necessary.
	Terms, powers, provisions, and limitations of the trust under which title to the land is held.


	Unsubdivided/Vacant
	Plat Act
	In the event any future conveyances of the premises in question would divide the subject premises into two or more parts, any part of which is less than five acres, compliance must be made with the Plat Act.

	Right of Way: Roads and Highways
	Rights of the public, State of {DB,Property,State,NO}, and the municipality in and to that part of the premises in question taken, used, or dedicated for roads, streets, alleys, or highways.

	Right of Way: Drainage Tiles
	Rights of way for drainage tiles, ditches, feeders, and laterals.


	Waterways
	Meandered Lake/River
	Rights, if any, of the United States of America, the State of Illinois, the municipality, and the public in and to so much of the land, if any, as may have been formed by means other than natural accretions or may be covered by the waters of {PR,"Ente...

	Flood Risks
	Possible flood risks affecting the land and other land as disclosed by {PR,"Enter what type of recorded document is being reviewed.",ST1,1}, recorded {PR,"Enter date Document was recorded.",DT2,2} as Document No. {PR,"Enter recorded Document number.",...

	Private Rights
	Rights of the adjacent property owners in and to the free and unobstructed flow of the waters of {PR,"Enter name of lake, river, creek or stream.",ST1,1}, a part of which is located adjacent to or within the insured premises.

	Public Rights
	Rights of the United States of America, the State of Illinois, the municipality, and the public in and to that part of the land lying, from time to time, within the bed of {PR,"Enter name of lake, river, creek or stream.",ST1,1}; and the rights of oth...

	Public Rights (Wisconsin)
	Rights of the United States of America, the State of Wisconsin, the municipality, and the public in and to that part of the land lying, from time to time, within the bed of {PR,"Enter name of lake, river, creek or stream.",ST1,1}; and the rights of ot...

	Meandered Lake/River (Wisconsin)
	Rights, if any, of the United States of America, the State of Wisconsin, the municipality, and the public in and to so much of the land, if any, as may have been formed by means other than natural accretions or may be covered by the waters of {PR,"Ent...


	Weller Creek
	Drainage District
	Said premises are subject to Weller Creek Drainage District, Document No. 40014. Satisfied to date, no annual benefit for current year.


	Wisconsin
	Exception: Bankruptcy - Statutory Powers
	Statutory rights, powers, and duties of the Trustee in Bankruptcy in the bankruptcy proceeding filed by {PR,"Enter name(s) of person filing bankruptcy",ST1,1} on {PR,"Enter date of bankruptcy filing",DT2,2}, in the Federal District Court for the {PR,"...

	Exception: Trusts - Terms and Limitations
	Terms, powers, provisions, and limitations of the trust under which title to the land is held.

	Exception: Condominium Conversion Construction Loan Policy Exceptions
	Terms, provisions, covenants, conditions, and options in, rights and easements established by the Declaration of Condominium Ownership recorded as Document No. {PR,"Enter Document Number",IN1,1}, as amended from time to time, its bylaws, and associati...
	Limitations and conditions imposed by Wisconsin Statutes Chapter 703, referred to as the Wisconsin Condominium Ownership Act.
	Any lien, or right to a lien, for services, labor, or material heretofore or hereafter furnished, imposed by law, and not shown by the public records, including, without limiting the generality of the foregoing, liens or rights to a lien arising from ...
	This commitment is subject to the review and approval of the condominium declaration and plat by the Underwriting Department of ATG.
	This commitment is subject to such additional exceptions, if any, as may be disclosed upon a search of the public records covering the period after the effective date of this commitment and through the date of recording of the condominium declaration ...

	Requirement: Condominium Assessment Certificate
	Furnish ATG with a certificate, executed and acknowledged by an officer or agent of the Condominium Association or a Director of the Executive Board, stating that the unit has no unpaid assessments for common area expenses or penalties, there are no c...
	Furnish ATG with a certificate, executed and acknowledged by an officer or agent of the Condominium Association or a Director of the Executive Board stating the Condominium Association has no right of first refusal or the right of first refusal has be...

	Exception: New Condominium – Construction Loan Policy Exceptions
	Terms, provisions, covenants, conditions, and options in, rights and easements established by the Declaration of Condominium Ownership recorded, as Document No. {PR,"Enter Document Number",IN1,1}, as amended from time to time, its bylaws, and associat...
	Limitations and conditions imposed by Wisconsin Statutes Chapter 703, referred to as the Wisconsin Condominium Ownership Act.
	This commitment is subject to the review and approval of the Condominium Declaration and plat by the Underwriting Department of ATG.
	This commitment is subject to such additional exceptions, if any, as may be disclosed upon a search of the public records covering the period after the effective date of this commitment and through the date of recording of the condominium declaration ...

	Exception: Corporation Domestic - Active
	Any delinquent income or franchise taxes that may be due and payable to the State of Wisconsin.

	Exception: Domestic Corporation - Dissolved
	{PR,"Enter name of dissolved Wisconsin corporation.",ST1,3}, a Wisconsin Corporation, was dissolved on {PR,"Enter date of dissolution of Wisconsin corporation.",DT2,4}. We note the following with respect thereto and this Commitment is subject to the f...
	(1) Rights of the creditors of said corporation, including the United States of America;
	(2) Right, title, and interest of the stockholders/members of said corporation and those claiming under them.
	(3) Any delinquent income or franchise taxes that may be due and payable to the State of Wisconsin.

	Exception: Foreign Corporation - Active
	Any delinquent income or franchise taxes that may be due and payable to the State of Wisconsin.

	Exception: Foreign Corporation - Dissolved
	{PR,"Enter name of dissolved foreign corporation.",ST1,1}, a corporation of {PR,"Enter state where dissolved foreign corporation was formed.",ST1,2}, was dissolved by {PR,"Who (i.e., members/stockholders/State) dissolved the foreign corporation?",ST1,...
	(1) Rights of the creditors of said corporation, including the United States of America.
	(2) Statutory conditions and limitations, if any, imposed by the laws of the State of {RP,2} upon conveyances by the successors in title to the real estate of said corporation.
	(3) Any delinquent income or franchise taxes that may be due and payable to the State of Wisconsin.

	Exception: Disabled Person - General
	Proceedings pending in the Circuit Court of {PR,"Enter name of County.",ST1,1} County, entitled Estate of {PR,"Enter name of disabled person.",ST1,2}, a disabled person, under Case No. {PR,"Enter disabled person’s case number.",ST1,3}.
	Any conveyance of the land must be made by the guardian of the Estate of {PR,"Enter name of disabled person.",ST1,1}, a disabled person, pursuant to a proper order entered in Case No. {PR,"Enter minor’s case number.",ST1,2}, and such conveyance should...
	Statutory right, powers, and duties of the guardian of the Estate of {PR,"Enter name of disabled person.",ST1,1}, a disabled person.

	Exception: Decedents - General
	Claims against the estate of {PR,"Enter name(s) of Decedent(s).",ST1,1}, deceased.
	Federal and Wisconsin estate taxes that may be charged against the estate of {PR,"Enter name of deceased person.",ST1,1}.
	Statutory rights, powers, and duties of the personal representative of the decedent if and when appointed.

	Requirement: Environmental Lien
	Environmental lien filed pursuant to Chapter 292 of the Wisconsin Statutes by {PR,"Enter name of entity filing the environmental lien.",ST1,1} against {PR,"Enter name of entity that environmental lien was filed against.",ST1,2} on {PR,"Enter date that...

	Exception: Foreclosure - Post Sheriff’s Deed
	Right, title, and interest of {PR,"Enter name of person receiving deed.",ST1,1} under a sheriff’s (judge’s) deed, dated {PR,"Enter date of deed.",DT2,2}, and recorded {PR,"Enter date deed was recorded.",DT2,3}, as Document No. {PR,"Enter Document numb...

	Requirement: Foreclosure Commitment Amount of Insurance
	The Amount of Insurance shown in paragraph 1 of Schedule A hereof must be increased in an amount equivalent to the full value of the subject premises before the policy will be issued. At such time, an additional charge will be made in conformity with ...

	Requirement: Domestic L.L.C., - Active/Authority
	Furnish ATG with satisfactory evidence that the proposed deed or mortgage has been approved by a majority of the members of {PR,"Enter name of LLC",ST1,1}, a Wisconsin Limited Liability company, which approval should name the member or members authori...
	Furnish ATG with a certificate of status from the Wisconsin Department of Financial Institutions verifying the authority to transact business in Wisconsin. The failure to produce the certificate will result in the policy or policies to be issued to co...

	Requirement: General Lien
	Notice of {PR,"Liens: Enter the type of lien (e.g., ‘Wisconsin Income Tax’):",ST1,1} lien in favor of {PR,"Liens: Enter the entity who filed the lien:",ST1,3} and against {PR,"Liens: Enter the entity against whom the lien was filed:",ST1,2} in the sum...

	Requirement: Mechanics’ Lien
	Mechanics’ lien filed by {PR,"Insert name of person or company filing the lien here.",ST1,1} against {PR,"Insert the person(s) against whom the lien was filed here.",ST1,2} on {PR,"Insert the date the lien was filed here.",DT2,3}, as Document Number {...

	Exception: Lis Pendens Proceedings
	Lis Pendens Notice, dated {PR,"Insert date of lis pendens here.",DT2,1}, filed by {PR,"Insert name of person(s) filing the lis pendens here.",ST1,2} against {PR,"Insert name(s) of persons receiving the lis pendens here.",ST1,3}, in Case No. {PR,"Inser...
	NOTE: No examination of these proceedings has been made and, upon examination, this commitment, and any policies committed for thereunder, shall be subject to such other and further exceptions as may then be deemed necessary.

	Exception: Minor’s Estate - General
	Proceedings pending in the Circuit Court of {PR,"Enter name of County.",ST1,1} County, entitled Estate of {PR,"Enter name of minor.",ST1,2}, a minor, under Case No. {PR,"Enter minor’s case number.",ST1,3}.
	Any conveyance of the land must be made by the guardian of the Estate of {PR,"Enter name of minor.",ST1,1}, a minor, pursuant to a proper order entered in Case No. {PR,"Enter minor’s case number.",ST1,2}, and such conveyance should recite that the sam...
	Statutory right, powers, and duties of the guardian of the Estate of {PR,"Enter name of minor.",ST1,1}, a minor.

	Exception: Schedule B Part II Subordination of Mortgage
	SCHEDULE B-II, PART II
	In addition to the matters set forth in Part B-I of this schedule, the title to the estate or interest described or referred to in Schedule A is subject to the following matters, but ATG insures that such matters are subordinate to the lien or charge ...
	Mortgage, dated {PR,"Enter date of mortgage.",DT2,7}, and recorded {PR,"Enter mortgage recordingdate.",DT2,7}, as Document No. {PR,"Enter recorded mortgage document number.",ST1,6}, executed by {PR,"What are the borrowers name(s)?",ST1,6} and given to...

	Requirement: Assignment of Mortgage
	Assignment of Mortgage from {PR,"Enter name of original lender",ST1,1} to {PR,"Enter name of lender receiving assignment.",ST1,2}, dated {PR,"Enter the date of the assignment",DT2,5}, and recorded {PR,"Enter recording date of assignment",DT2,5}, as Do...

	Exception: Riparian - Meandering Lake/River
	Rights, if any, of the United States of America, the State of Wisconsin, the municipality, and the public in and to so much of the land, if any, as may have been formed by means other than natural accretions or may be covered by the waters of {PR,"Ent...

	Exception: Riparian - Public Rights
	Rights of the United States of America, the State of Wisconsin, the municipality, and the public in and to that part of the land lying, from time to time, within the bed of {PR,"Enter name of lake, river, creek orstream.",ST1,1}; and the rights of oth...

	Exception: Real Estate Taxes- Installment Payments
	Taxes for the year {PR,"Enter the year that taxes are a lien (‘YYYY’).",IN1,1} and thereafter: First installment {PR,"Enter the current or previous year (‘YYYY’).",IN1,1} taxes, in the amount of {PR,"Enter amount of the 1st installment prior year taxe...
	Taxes for the year {PR,"Enter the current year (YYYY).",IN1,6} are not yet due and payable.
	Tax Key No. {DB,Property,TaxID,NO}

	Requirement: B1 - Deed only
	a) {PR,"Enter Type of Deed (Warranty, Personal Representative, etc.)",ST1,1} from {DB,SellerInfo,FormalName,NO} to {DB,BuyerInfo,FormalName,NO}.
	Note: The proposed instrument of conveyance should designate the subject property as non-homestead, identify the grantor/mortgagor as a single person, or be joined in by the grantor’s/mortgagor’s spouse and have their marital status typed thereon.
	Note: The buyer(s) should inform ATG how legal title will be held.
	Note: A Wisconsin Real Estate Transfer Return form will need to be completed by the parties in order to record the conveyance document.

	Exception: Mortgage - New
	Mortgage, dated {PR,"Date of Mortgage",DT2,1}, and recorded {PR,"Date of Recording",DT2,2}, as Document No. {PR,"Document Number",ST1,3}, executed by {DB,CommitPolicy,MortBorrower,NO}, and given to {DB,CommitPolicy,MortInsured,NO}, to secure a note in...

	Requirement: B1- Mortgage Only
	a) Mortgage from {DB,BuyerInfo,FormalName,NO} to {DB,Lender,Name,NO}, in the amount of {DB,Main,LoanAmount,CU1}.

	Exception: Existing Condominium- Construction Loan Policy Exceptions
	Terms, provisions, covenants, conditions, and options in, rights and easements established by the Declaration of Condominium Ownership recorded, *, as Document No. {PR,"Enter Document Number",IN1,1}, as amended from time to time, its bylaws, and assoc...
	Limitations and conditions imposed by Wisconsin Statutes Chapter 703, referred to as the Wisconsin Condominium Ownership Act.

	Requirement: Satisfaction of Existing Mortgage
	Satisfaction of Mortgage, dated {PR,"Enter Date of Mortgage",DT2,1}, and recorded {PR,"Enter date mortgage was recorded",DT2,2}, as Document No. {PR,"Enter Document No. of mortgage",ST1,3}, executed by {PR,"Enter name(s) of Mortgagor(s)",ST1,4}, and g...

	Note: Deed - Homestead Designation
	Note: The proposed instrument of conveyance should designate the subject property as non-homestead, identify the grantor/mortgagor as a single person, or be joined in by the grantor’s/mortgagor’s spouse and have their marital status typed thereon.

	Exception: Foreign Corporation - Not for Profit
	A certified copy of the charter and amendments thereto, if any, and of the bylaws of the corporation in title should be furnished, and this Commitment is subject to such further exceptions, if any, as may then be deemed necessary. Upon a conveyance or...
	The certificate of authority of {PR,"Enter name of foreign Corporation.",ST1,2} to do business in Wisconsin issued by the Department of Financial Institutions should be produced, and in default thereof, our policy will contain the following exception:
	"Consequences, if any that may result because of the failure of the party in title to the estate or interest in the land described in Schedule A to comply with the applicable ‘doing business’ laws of the State of Wisconsin."

	Requirement: Foreign Corporation – Active/Authority
	Furnish ATG with a certified copy of the proper resolutions passed by the stockholders or board of directions authorizing the execution of the deed or mortgage, and this commitment and any policies committed for thereunder, are subject to such further...
	Furnish ATG with a certificate of status from the Wisconsin Department of Financial Institutions verifying the authority to transact business in Wisconsin. The failure to produce the certificate will result in the policy or policies to be issued to co...

	Requirement: Foreign Corporation – Dissolved/Authority
	Furnish ATG with a certified copy of the Articles of Dissolution that was issued by the incorporators or board of directors authorizing the execution of a deed to sell the corporation’s real property or furnish ATG with a certified list of all of the ...

	Exception: Domestic L.L.C. - Active
	Any delinquent income or franchise taxes that may be due and payable to the State of Wisconsin.

	Requirement: Domestic L.L.C. - Dissolved/Authority
	Furnish ATG with a certified copy of the Articles of Dissolution authorizing the manager(s) or member(s) to execute a deed to sell the LLC’s real property or furnish ATG with a certified list of all of the successors in title to the real estate of sai...

	Exception: Foreign L.L.C. – Active
	Any delinquent income or franchise taxes that may be due and payable to the State of Wisconsin.

	Requirement: Foreign L.L.C. - Active/Authority
	Furnish ATG with a certified copy of the proper resolutions passed by the stockholders or board of Directions authorizing the execution of the deed or mortgage, and this commitment, any policies committed for thereunder, are subject to such further ex...
	Furnish ATG with a certificate of status from the Wisconsin Department of Financial Institutions verifying the authority to transact business in Wisconsin. The failure to produce the certificate will result in the policy or policies to be issued to co...

	Note: Deed - Buyer’s Designation of Legal Title
	Note: The buyer(s) should inform ATG how legal title will be held.

	Requirement: Foreign L.L.C. - Dissolved/Authority
	Furnish ATG with a certified copy of the Articles of Dissolution authorizing the manager(s) or member(s) to execute a deed to sell the L.L.C.’s real property or furnish ATG with a certified list of all of the successors in title to the real estate of ...

	Exception: Vacated Streets and Alleys
	Easements, if any, of the public or any school district, utility, municipality, or person, as provided in Section 80.32 (4) of the Statutes, for the continued use and right of entrance, maintenance, construction, and repair of underground structures, ...

	Requirement: Foreclosure Pending - Post Lis Pendens
	An action for mortgage foreclosure is pending in Case No. {PR,"Insert case number",ST1,1}, in the Circuit Court of {PR,"Insert county",ST1,2} County, Wisconsin, to foreclose the lien recorded as Document Number {PR,"Insert documentnumber",IN1,3}. In o...
	1. A discharge of Lis Pendens;
	2. An order dismissing the Circuit Court action;
	3. If a judgment of foreclosure was entered, an order satisfying the judgment;
	4. If a sheriff’s sale was held, an order vacating the sheriff’s sale;
	5. If an order confirming the sheriff’s sale was entered, an order vacating the order.

	Requirement: Domestic Corporation - Active/Authority
	Furnish ATG with a certified copy of the proper resolutions passed by the stockholders or board of directors authorizing the execution of the deed or mortgage, and this commitment, any policies committed for thereunder, are subject to such further exc...
	Furnish ATG with a certificate of status from the Wisconsin Department of Financial Institutions verifying domestic incorporation in the State of Wisconsin. The failure to produce the certificate will result in the policy or policies to be issued to c...

	Requirement: Domestic Corporation - Dissolved/Authority
	Furnish ATG with a certified copy of the Articles of Dissolution that were issued by the incorporators or board of directors authorizing the execution of a deed to sell the corporation’s real property or furnish ATG with a certified list of all the su...

	Exception: Domestic L.L.C. - Dissolved
	{PR,"Enter name of LLC",ST1,1}, a Limited Liability Company, was dissolved by {PR,"Enter name of entity that dissolved this LLC",ST1,2} on {PR,"Enter date this LLC was dissolved",DT2,3}. We note the following with respect thereto and this Commitment i...
	(1) Rights of the creditors of said LLC, including the United States of America.
	(2) Right, title, and interest of the members of said LLC and those claiming under them.
	(3) Any delinquent income or franchise taxes that may be due and payable to the State of Wisconsin.

	Requirement: B1 - Deed and Mortgage
	a) WARRANTY DEED from {DB,SellerInfo,FormalName,NO} to {DB,BuyerInfo,FormalName,NO}.
	Note: The proposed instrument of conveyance should designate the subject property as non-homestead, identify the grantor/mortgagor as a single person, or be joined in by the grantor’s/mortgagor’s spouse and have their marital status typed thereon.
	Note: The buyer(s) should inform ATG how legal title will be held.
	Note: A Wisconsin Real Estate Transfer Return form will need to be completed by the parties in order to record the conveyance document.
	b) MORTGAGE from {DB,BuyerInfo,FormalName,NO} to {DB,Lender,Name,NO}, in the amount of {DB,Main,LoanAmount,CU1}.

	Note: Construction Lien Affidavit
	Note: Full coverage provided by the Loan Policy is conditioned upon the return of an affidavit in a form acceptable to the company as to the construction liens and possession and the submission of satisfactory evidence in regard to existing and future...

	Note: Endorsements - Final Loan Policy
	NOTE: The Loan Policy, when issued, will contain the Easements, Restrictions, and Minerals Endorsement (ALTA Form 9; formerly known as Comprehensive Endorsement), an Environmental Protection Lien Endorsement (EPL; ALTA Form 8.1), and a Location Endors...

	Exception: Real Estate Taxes - Single Payment
	Taxes for the year {PR,"Enter the year that taxes are a lien (‘YYYY’).",IN1,1} and thereafter: {PR,"Enter the current or previous year (‘YYYY’).",IN1,1} taxes in the amount of {PR,"Enter amount of prior year taxes.",CU1,2} are {PR,"Enter whether ‘PAID...
	Taxes for the year {PR,"Enter the current year (YYYY).",IN1,6} are not yet due and payable.
	Tax Key No. {DB,Property,TaxID,NO}

	Exception: Rights of the Public (Roads)
	Rights of the public, State of Wisconsin, and the municipality in and to that part of the premises in question taken, used, or dedicated for roads or highways.

	Exception: Riparian - Highwater Mark
	Rights of the public in any portion of the subject premises lying below the ordinary highwater mark and in the waters of and airspace over {PR,"Name of lake/river, etc.",ST1,1}, Wisconsin.

	Requirement: Lien -Judgment Possible
	We find judgments, liens, and matters of record involving a person or persons whose names are similar to {PR,"Name of person with possible judgments",ST1,1}. Relative thereto, a Personal Information Affidavit establishing the identity of the above des...

	Note: Rental Property
	NOTE: If the property is to be used for rental purposes, compliance with or exemption from the Energy Efficiency Standards of the State of Wisconsin or the municipality must be obtained.

	Requirement: Foreclosure Commitment - General
	In order that we may insure title after completion of any proceeding brought to foreclose the lien of the mortgage noted at Schedule B-II, Exception No. {PR,"Enter Schd B-II Mortgage Exception number",IN1,1}, and recorded as Document No. {PR,"Insert D...
	Our policy, when issued, will be subject to direct attack upon the judgments and orders entered in the proceeding.
	Upon the filing of the complaint, a proper Notice of Foreclosure (Lis Pendens) under Section 840.10(1) of the Wisconsin Statutes must be recorded in the Register of Deeds of {PR,"Enter County Name",ST1,3} County, Wisconsin.
	The following persons are necessary parties to any such parties:
	(1) {PR,"insert name of mortgagor or successor in interest",ST1,4}, the record owner, as a party defendant.
	(2) {PR,"Insert name of spouse or mortgagor or successor in interest",ST1,5}, spouse of the record owner, as a party defendant.
	(3) {PR,"Insert name of mortgagee or successor in interest",ST1,6}, as a party plaintiff.
	d. The following persons must be made parties defendant to the foreclosure if it is desired that their interests be barred by the proceeding:
	(1) All parties acquiring rights in the premises subsequent to the date of this commitment and prior to a complete Notice of Foreclosure (Lis Pendens).
	(2) Any person other than those herein named known to the Plaintiff or the Plaintiff’s attorney to have or claim an interest in the premises.
	(3) All persons in possession of any part of the premises in question and all persons whose rights would be disclosed by an inspection of the premises.
	(4) United States of America by reason of Schedule B-II Exception No. {PR,"Enter Schedule B-II exception number",IN1,7}.
	NOTE: Compliance should be had with the provisions of 28 U.S.C. § and in connection therewith the following information is furnished:
	The Notice of tax lien noted at Schedule B-II Exception No. {PR,"Insert Schedule B-II exception number",IN1,8} was filed by the District Director of Internal Revenue, at {PR,"Insert County where tax lien was filed",ST1,9}, Wisconsin, against {PR,"Inse...
	NOTE: Attention is directed to the provisions in Section 2410 of the Federal Judicial Code requiring that any action to foreclose a mortgage naming the United States as a party under the Section "must seek a judicial sale." In the event a sale is not ...
	(5) Second mortgagees, judgment lienors, etc., by reason of Schedule B-II Exception No. {PR,"Insert Schedule B-II exception No.",ST1,14}.
	NOTE: If it is known that any of the parties listed herein are deceased, their heirs or devises should be made parties by name, if known, and, if unknown, by the name and description of "UNKNOWN HEIRS OR DEVISEES OF" such deceased person or persons. I...
	NOTE: In the event that there are any persons who are necessary parties to the contemplated proceeding, but the names of such persons are unknown and unascertainable, then, and in that event only, such persons should be made parties under the descript...
	NOTE: The proceeding will not affect the standard exceptions nor the exceptions noted in Schedule B-II at No. {PR,"Insert Schedule B-II exception(s)",ST1,15}; and our policy when issued will be subject to such exceptions unless satisfactory dispositio...

	Exception: City of Milwaukee Properties
	This commitment does not insure against charges imposed by the City of Milwaukee Department of Neighborhood Services Residential Rental Inspection (RRI) program. This exception will be removed upon receipt of satisfactory proof that the property is no...
	This commitment does not insure against charges imposed by the City of Milwaukee Department of Neighborhood Services Vacant Building Code Registration and Maintenance program. This exception will be removed upon receipt of satisfactory proof that the ...
	This commitment does not insure against charges imposed by the City of Milwaukee Department of Neighborhood Services (DNS) for special charges pertaining to code compliance, rent withholding, fire inspections, code violations/work orders, and other sp...

	Requirement: Trusts - Authority
	Furnish ATG with a properly certified copy of the original trust agreement under which title to the land is held, together with a statement in writing by the Trustee that it will produce the original agreement upon request, and this Commitment is subj...
	ATG should be advised as to whether the trust under which title to the land is held is still in force and effect, and this Commitment is subject to such further exceptions, if any, as may be deemed necessary.

	Requirement: Lien - Child Support
	Child support judgment filed against {PR,"Insert name of person(s) who received judgment here.",ST1,1}, in Case No. {PR,"Insert Case number here.",ST1,2} in the Circuit Court of {PR,"Insert name of County here.",ST1,3} County, Wisconsin, a memorandum ...

	Requirement: Decedent Estate - Personal Representative’s Authority
	A certified copy of the domiciliary letters issued by a Circuit Court of Wisconsin authorizing {PR,"Enter name of Personal Representative",ST1,1} to act as the personal representative over decedent’s estate with the power to convey decedent’s real pro...

	Requirement: Lien - Judgment Recorded
	[Transcript][Certified copy][Memorandum] of judgment recorded on {PR,"Insert date judgment was recorded here.",DT2,1} as Document No. {PR,"Insert Document number here.",ST1,2} for judgment rendered on {PR,"Insert date of judgment here.",DT2,5} in the ...

	Exception: Mortgage - Existing
	Mortgage dated {PR,"Enter Date of Mortgage",DT2,1}, and recorded {PR,"Enter date mortgage was recorded",DT2,2}, as Document No. {PR,"Enter Document No. of mortgage",ST1,3}, executed by {PR,"Enter name(s) of Mortgagor(s)",ST1,4}, and given to {PR,"Ente...

	Exception: Mortgage - Schedule B, Part II
	SCHEDULE B, PART II
	In addition to the matters set forth in Part I of this schedule, the title to the estate or interest described or referred to in Schedule A is subject to the following matters, but ATG insures that such matters are subordinate to the lien or charge of...
	Mortgage dated {PR,"Enter date of mortgage.",DT2,7}, and recorded {PR,"Enter mortgage recordingdate.",DT2,7}, as Document No. {PR,"Enter recorded mortgage document number.",ST1,6}, executed by {PR,"What are the borrowers name(s)?",ST1,6}, and given to...

	Exception: Mortgage - Assignment
	Assignment of Mortgage from {PR,"Enter name of original lender",ST1,1} to {PR,"Enter name of lender receiving assignment.",ST1,2}, dated {PR,"Enter the date of the assignment",DT2,5}, and recorded {PR,"Enter recording date of assignment",DT2,5}, as Do...

	Exception: Foreign L.L.C. - Dissolved
	{PR,"Enter name of LLC",ST1,1}, a Limited Liability Company, was dissolved by {PR,"Enter name of entity that dissolved this LLC",ST1,2}, on {PR,"Enter date this LLC was dissolved",DT2,3}. We note the following with respect thereto and this Commitment ...
	(1) Rights of the creditors of said LLC, including the United States of America.
	(2) Right, title, and interest of the members of said LLC and those claiming under them.
	(3) Any delinquent income or franchise taxes that may be due and payable to the State of Wisconsin.

	Note: Deed - Transfer Tax Return Form
	Note: A Wisconsin Real Estate Transfer Return form will need to be completed by the parties in order to record the conveyance document.

	Requirement: Bankruptcy Trustee- Authority
	Requirement: Power of Attorney - Authority
	Furnish ATG with an executed and acknowledged Power of Attorney that is in recordable form. Said Power of Attorney must be reviewed by the ATG Underwriting Department prior to the execution of any conveyance documents.

	Exception: Bankruptcy - Creditor Rights
	The right of a creditor, trustee, or debtor in possession to sell the entire property in the event of a bankruptcy of any co-tenant of the land.

	Exception: Riparian -Water/Accretion/Reliction
	This policy does not insure the exact location of any portion of land created by gradual buildup of the shore (accretion) or the lowering of the water level (reliction), the title to land cut off by a change in the course of the water body (avulsion),...
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